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Introduction

Welcome to Word 2010 All-in-One For Dummies, the book written espe-
cially for people who use Word every day and need a handy refer-

ence to all the various and sundry things this mighty program can do. This 
book contains all the basic and not-so-basic information you need to know 
to get the most from Word, whether you use it to compose simple letters or 
write 200-page government grants.

About This Book
Word 2010 All-in-One For Dummies is a big book that’s composed of nine 
smaller books, each of which covers a specific aspect of using Word. You 
find minibooks on such topics as editing documents, formatting pages, cre-
ating mailings, and customizing Word to make it work the way you want.

Word 2010 All-in-One For Dummies doesn’t pretend to be a comprehensive 
reference for every detail of these topics. Instead, this book shows you how 
to get up and running fast so that you have more time to do the things you 
want to do. Designed using the easy-to-follow For Dummies format, this book 
helps you get the information you need without having to labor to find it.

Whenever one big thing is made up of several smaller things, confusion is 
always a possibility. That’s why Word 2010 All-in-One For Dummies is designed 
to have multiple access points (I hear an acronym coming on — MAP!) to help 
you find what you want. At the beginning of the book is a detailed table of 
contents that covers the entire book. Each minibook begins with a miniature 
table of contents that shows you at a glance which chapters are included in 
that minibook. Useful running heads appear at the top of each page to point 
out the topic discussed on that page. And, handy thumb tabs run down the 
sides of the pages to help you quickly find each minibook. Finally, a compre-
hensive index lets you find information anywhere in the entire book.

This book isn’t the kind you have to pick up and read from start to finish, 
as though it were a cheap novel. If I ever see you reading it at the beach, I’ll 
kick sand in your face. This book is more of a reference, the kind of book you 
can pick up, turn to just about any page, and start reading. You don’t have to 
memorize anything in this book. It’s a need-to-know book: You pick it up when 
you need to know something. Need to know how to do a mail merge? Pick up 
the book. Need to know how to crop an image? Pick up the book. After you 
find what you need, put down the book and get on with your life.
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2 How to Use This Book

How to Use This Book
After you find your topic in the table of contents or the index, turn to the 
area of interest and read as much as you need or want. Then close the book 
and get on with it.

This book is loaded with information, of course, so if you want to take a brief 
excursion into your topic, you’re more than welcome. If you want to know 
everything about customizing Word, read Book VIII. But if you just want to 
find out how to create a simple keyboard shortcut to apply a style you use 200 
times a day, just read the section on keyboard shortcuts. You get the idea.

If you need to type something, you see the text you need to type like this: 
Type this stuff. In this example, you type Type this stuff at the keyboard. 
An explanation usually follows, just in case you’re scratching your head and 
grunting, “Huh?”

Whenever I describe a message or information that you see onscreen, I pres-
ent it this way:

A message from your friendly word processor

Note: The names of dialog boxes, menu commands, and options are spelled 
with the first letter of each main word capitalized, even though these letters 
might not be capitalized onscreen. This format makes sentences filled with 
long option names easier for you to read. (Haven’t we thought of everything?)

How This Book Is Organized
Each of the nine minibooks contained in Word 2010 All-in-One For Dummies 
stands alone. The first minibook covers the basics of using Word. The 
remaining minibooks cover a variety of Word topics. Even those minibooks 
that cover familiar ground are packed with techniques and commands you 
might not know about. You can find something useful in every chapter. 
Here’s a brief description of what you find in each minibook.

Book I: What’s in a Word?
This minibook covers the basics you need in order to get going with Word. 
Even if you’ve been using Word for years, you should read these chapters. 
Word 2010 introduces an entirely new user interface in which the familiar 
menus and toolbars are replaced by a gadget named the Ribbon. So, be sure 
to familiarize yourself with this new user interface. You should also take a 
close look at Chapter 3, “Working with Templates.” Many Word users don’t 
realize the power of the lowly template.
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3How This Book Is Organized

Book II: All about Editing
I discuss in Book II the ins and outs of editing and formatting your text. You 
discover basic formatting styles such as bold and italics as well as a variety 
of useful editing techniques. The more you use Word, the more it pays to 
know all the tips and shortcuts I present in this minibook.

Book III: All about Formatting
In Book III, I give you the lowdown on formatting pages. I cover the basics 
of working with pages and sections, using themes to create great-looking 
pages, and creating advanced features such as columns and lists.

Book IV: Inserting Bits and Pieces
The Ribbon has an entire tab devoted to elements you can insert into your 
document, and this minibook covers the most useful of these bits and 
pieces. You find out about inserting graphics such as pictures and clip art; 
using drawing objects such as rectangles and text boxes; and formatting 
visual aids such as charts, diagrams, and tables.

Book V: Publish or Perish
The chapters in Book V are devoted to various ways you can use Word to 
share your work with others. First, you find out how to use Word’s new blog-
ging feature, which lets you use Word as the word processor for your blog 
site. You also read about how to use Word’s collaboration and reviewing 
features, and how to use Word with SharePoint, a server-based collaboration 
program that integrates with Word.

Book VI: Using Reference Features
Book VI covers all the features found on the References tab on the Ribbon, 
including tables of contents, footnotes, and indexes.

Book VII: Mailings
In the chapters in Book VII, I tell you all about creating letters, envelopes, 
and labels in Word, from single letters to mass mailings using the mail merge 
feature. You even see how to use Word to send faxes. If you use Word to 
mail letters to customers, friends, or relatives, you should focus on Chapters 
3 and 4.

Book VIII: Customizing Word
The chapters in Book VIII show you how to customize Word so that it works 
the way you want. You discover how to customize the user interface, set 
options, insert fields, and create custom forms.
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4 Icons Used in This Book

Book IX: Features for Developers
The last minibook is devoted to readers who want to dig deep into the 
depths of Word by writing macros using Word’s powerful programming lan-
guage, Visual Basic for Applications (VBA). The chapters in this minibook 
aren’t for the faint of heart, but if you’re willing to take the plunge, you can 
make Word do things you never thought possible.

Icons Used in This Book
Like any For Dummies book, this book is chock-full of helpful icons that 
draw your attention to items of particular importance. You find these icons 
throughout this book:

 Did I tell you about the memory course I took?

 Hold it — technical stuff is just around the corner. Read on only if you have 
your pocket protector.

 

Pay special attention to this icon; it lets you know that a particularly useful 
tidbit is at hand — perhaps a shortcut or a little-used command that pays 
off big.

 Danger, Will Robinson! This icon highlights information to help you avert 
disaster.

Where to Go from Here
Yes, you can get there from here. With this book in hand, you’re ready to 
plow through the rugged networking terrain. Browse through the table of 
contents and decide where you want to start. Be bold! Be courageous! Be 
adventurous! Above all, have fun!
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Chapter 1: Getting to Know 
Word 2010

In This Chapter
✓ Getting Word started

✓ Making sense of all the stuff onscreen

✓ Dealing with the Ribbon

✓ Entering and editing text

✓ Printing your document

✓ Saving your work

✓ Closing a document and quitting Word

This chapter is an introduction to the basic principles of using Word: 
starting the program; working with its user interface; typing and editing 

text; printing and saving a document; and, perhaps most important, quitting 
Word when you’re done. Have fun!

Starting Word
You can start Word in so many different ways that you can probably use a 
different technique every day for a fortnight. Rather than bore you with the 
details of every possible way to start Word, I show you the most common 
way first. Then I show you a couple of shortcuts that are useful if you use 
Word a lot.

Turn on your computer and then follow these steps to start Word:

 1. Get ready.

  Light some votive candles. Take two Tylenol. Put on a pot of coffee. If 
you’re allergic to banana slugs, take an allergy pill. Sit in the lotus posi-
tion facing Redmond, Washington, and recite the Windows creed three 
times:

  Bill Gates is my friend. Resistance is futile. No beer and no TV make 
Homer something something. . . .
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8 Starting Word

 2. Click the Start button.

  Find the Start button in the lower-left corner of the Windows display. 
In Windows XP, it’s a round-cornered box with the word Start in it. In 
Windows Vista or Windows 7, it’s a round button with a four-colored 
flag. Either way, clicking the Start button summons the Start menu.

 

 You can quickly summon the Start menu by pressing Ctrl+Esc.

 3. Point to All Programs on the Start menu.

  Move the cursor up to All Programs and hold it there a moment. Another 
menu appears, revealing a bevy of commands.

 4. Click Microsoft Office on the Start menu and then click Microsoft 
Word 2010.

  Your computer whirs and clicks and possibly makes other unmention-
able noises while Word comes to life.

The following paragraphs describe some quick ways to start Word. Look into 
these methods if you use Word frequently and you grow weary of trudging 
through the depths of the Start menu:

 ✦ If you use Word frequently, its icon might appear in the Frequently Used 
Programs List, an area of the Start menu. If so, you can start Word by 
clicking it directly from the Start menu.

 

 If you want Word to always appear at the top of the Start menu, choose 
Start➪All Programs➪Microsoft Office. Then right-click Microsoft Word 
2010 and choose the Pin to Start Menu command. This command pins 
Word to the Start menu, above the Frequently Used Programs List.

 ✦ You can create an icon for Word on your desktop. Then you can start 
Word by double-clicking its desktop icon. To create a desktop icon 
for Word, open the Start menu, navigate through All Programs and 
Microsoft Office, and then right-click Microsoft Word 2010 and choose 
Send To➪Desktop.

 ✦ My personal favorite way to start Word is to pin it to the taskbar. To do 
so, while Word is running, right-click it on the taskbar and choose Pin 
This Program to Taskbar. From that point on, an icon for Word appears 
on the taskbar even when Word is not running.

 ✦ Another way to start Word is by using Windows Explorer to browse to a 
folder that contains a document you want to edit. Then, double-click the 
icon for the document. Windows responds by starting Word and open-
ing the document you chose.

 ✦ Here’s one more trick before moving on. If you use Word every day, you 
can set it to start automatically every time you start your computer. 
To do that, navigate your way through the Start menu to the Microsoft 
Word 2010 command. Then drag it into the Startup group under Start➪
All Programs.
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9What Is All This Stuff?

What Is All This Stuff?
When you start Word, it greets you with a screen that’s so cluttered with 
stuff that you’re soon ready to dig out your grandfather’s manual typewriter. 
The center of the screen is mercifully blank and vaguely resembles a piece of 
typing paper, but all around the edges and tucked into every corner are little 
icons, buttons, rulers, menus, and whatnot.

Figure 1-1 shows the basic Word screen, in all its cluttered glory. The follow-
ing list points out the more important parts of the Word screen:

 ✦ Title bar: At the very top of the Word screen is the title bar, which dis-
plays the name of the document you’re working on. The title bar also 
includes the standard Minimize, Restore, and Close buttons present in 
every window as well as the Quick Access toolbar (described later in 
this list).

 

Figure 1-1: 
The 
cluttered 
Word 
screen.

 

File tab

Quick Access toolbar

Ribbon Title bar Ruler

Status bar View buttons Zoom control

05_487662-bk01ch01.indd   905_487662-bk01ch01.indd   9 4/15/10   8:31 PM4/15/10   8:31 PM



10 What Is All This Stuff?

 ✦ The Ribbon: Across the top of the screen, just below the title bar, is 
Word’s main user interface gadget, the Ribbon. If you’ve worked with 
previous versions of Word, you were probably expecting to see a menu 
bar followed by one or more toolbars in this general vicinity. After 
meticulous research, Microsoft gurus decided that menus and toolbars 
are hard to use. So they replaced them with the Ribbon, which combines 
the functions of both. The Ribbon takes some getting used to, but after 
you figure it out, it does become easier to use than the old menus and 
toolbars. The deepest and darkest secrets of Word are hidden on the 
Ribbon. Wear a helmet when exploring it.

  Note that the exact appearance of the Ribbon varies a bit depending on 
the size of your monitor. On smaller monitors, Word might compress 
the Ribbon a bit by using smaller buttons and arranging them differently 
(for example, stacking them on top of one another instead of placing 
them side by side).

  For more information about working with the Ribbon, see the section 
“Unraveling the Ribbon,” later in this chapter.

 

 Although Word 2010 doesn’t have menus, like versions 2003 and earlier 
had, many of the keyboard shortcuts (technically, they’re accelerators) 
that were associated with the Word 2003 and earlier menu commands 
still work. For example, to call up the Open dialog box, press Alt, F, 
and O (for the old File➪Open command). To insert clip art, press Alt, 
I, P, and C (for the old Insert➪Picture➪Clip Art command). To keep 
things simple, this book doesn’t specifically mention these accelerators. 
However, if you remember them from your Word 2003 days, you can 
continue to use them. Keyboard shortcuts with the Alt key are also avail-
able for the 2010 menu system; press the Alt key to display key tips for 
each tab; then type the letter for one of the tabs to see key tips for each 
command on that tab.

 ✦ The File tab: The File tab replaces the Office button from Word 2007. 
You can click it to reveal a major new feature of Word 2010: Backstage 
view. Backstage view is the place to come when you need to open 
or save files, create new documents, print a document, and do other 
file-related chores. For more information, see the section “Taking the 
Backstage Tour,” later in this chapter.

 ✦ Quick Access toolbar: Just above the File tab is the Quick Access toolbar. 
Its sole purpose in life is to provide a convenient resting place for the 
Word commands you use the most often.

  Initially, this toolbar contains just three buttons: Save, Undo, and Redo. 
However, you can add buttons, if you want. To add a button to the Quick 
Access toolbar, right-click the button on the Ribbon and choose Add to 
Quick Access toolbar. You can also find a pull-down menu at the end of 
the toolbar that lists several frequently used commands. You can use 
this menu to add these common commands to it.
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11What Is All This Stuff?

 ✦ Ruler: Word has two rulers: a horizontal ruler and a vertical ruler. The 
horizontal ruler appears just beneath the Ribbon and is used to set 
margins and tab stops. The vertical ruler appears on the left edge of the 
Word window and is used to gauge the vertical position of elements on 
the page. (If the ruler doesn’t appear, you can summon it by clicking the 
View tab on the Ribbon and then selecting the Ruler check box in the 
Show group.)

 ✦ Task pane: Some commands and options open a task pane to the right 
or left of the main editing pane, containing additional controls or fea-
tures. For example, the Clip Art task pane appears on the right when 
inserting clip art, and the Clipboard task pane appears at the left when 
using the Office Clipboard. Figure 1-1 doesn’t show task panes; they 
appear on their own whenever you need them. If a task pane gets in the 
way, you can always get rid of it by clicking its Close button (the X in the 
upper-right corner of the task pane).

 ✦ Status bar: At the bottom of the screen is the status bar, which tells you 
the page that’s displayed (for example, Page 5 of 11).

 

 You can configure the status bar by right-clicking anywhere on it. This 
action reveals a list of options that you can select or deselect to deter-
mine which elements appear on the status bar.

 ✦ View buttons: The group of five buttons located to the left of the Zoom 
control, near the bottom of the screen, lets you switch among Word’s 
various document views. You can find out more about these views in the 
later section “The View from Here Is Great.”

 ✦ Zoom control: In the lower-right corner of the screen is the Zoom con-
trol, which lets you zoom in for a closer look at your text. The zoom 
control consists of a slider that you can slide left or right to zoom in 
or out, – and + buttons you can click to increase or decrease the zoom 
factor, and a number that indicates the current zoom percentage. Note 
that this number consists of a button; if you click it, Word displays a 
dialog box with additional zoom options.

You never get anything done if you feel that you have to understand every 
pixel of the Word screen before you can do anything. Don’t worry about the 
stuff that you don’t understand; just concentrate on what you need to know 
to get the job done and worry about the bells and whistles later.

 

Lots of stuff is crammed onto the Word screen — enough stuff that the pro-
gram works best if you let it run in maximized mode. If Word doesn’t take 
over your entire screen, find the boxy-looking Maximize button on the right 
side of the title bar. (It’s the middle of the three buttons.) Click it to maxi-
mize the Word screen. Click it again to restore Word to its smaller size.
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Unraveling the Ribbon
The Ribbon, first introduced in Word 2007, is the all-in-one user interface 
gadget that replaces the menus and toolbars found in earlier versions 
of Word. The Ribbon is not just for Word 2010 but also for Excel 2010, 
PowerPoint 2010, and Access 2010.

Across the top of the Ribbon is a series of tabs. You can click one of these 
tabs to reveal a set of controls specific to that tab. For example, the Ribbon 
(refer to Figure 1-1) shows the Home tab. Initially, the Ribbon displays these 
seven tabs:

 ✦ Home: Basic commands for creating and formatting documents. You can 
find controls for working with the Clipboard, setting the font, formatting 
paragraphs, applying styles, and using Find and Replace.

 ✦ Insert: Commands for inserting various items into your document, 
including new pages, tables, pictures, shapes, and other types of illus-
trations, headers and footers, specially formatted text, and much more! 
Most of these features are covered in Book IV.

 ✦ Page Layout: Commands that let you tweak the layout of your docu-
ment’s pages. You can apply a theme to your document to set the over-
all look of the document or control details such as the page margins and 
background colors. You find out about these features in Book III.

 ✦ References: Commands that let you create tables of contents, footnotes, 
bibliographies, indexes, and other elements. You discover how to use 
these features in Book VI.

 ✦ Mailings: Commands for creating mail merges. I show you how to use 
this tab in Book VII.

 ✦ Review: Commands for proofing and adding comments to your docu-
ments and tracking changes. For more information, see Chapter 3 of 
Book V.

 ✦ View: Commands that let you change the view. You can use this tab to 
switch to different document views, to show or hide certain types of 
information (such as paragraph marks), and to zoom in for a closer look 
at your document.

Besides these basic tabs, additional tabs appear from time to time. For 
example, if you select a picture, a Picture Tools contextual tab appears 
with commands that let you manipulate the picture. These contextual tabs 
display in a different color to make them easy to spot. Also, sometimes two 
or more contextual tabs appear at the same time. For example, if you select 
a picture within a table, two contextual tabs appear: one for the table, the 
other for the picture.
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 The commands on a tab are organized into groups. Within each group, most 
commands are simple buttons that are similar to toolbar buttons in previous 
versions of Word.

One of the most important differences between Word 2007 and Word 2010 is 
that you can easily customize the Word 2010 user interface. In Word 2007, the 
Ribbon was not customizable; you could only add and remove buttons from 
the Quick Access toolbar. Word 2010 enables you to create your own groups 
and tabs on the Ribbon. For more information, see Chapter 1 of Book VIII.

The View from Here Is Great
On the lower-right edge of the Word screen (just to the left of the Zoom con-
trol) is a series of five View buttons that let you switch among various docu-
ment views. The following paragraphs describe these five views:

  ✦ Print Layout view displays pages exactly as they will appear when 
printed, complete with columns, headers, footers, and all other format-
ting details. This view is the one you’ll work in most often.

  ✦ Full Screen Reading view was designed for easy onscreen reading.

  ✦ Web Layout view shows how a document appears when viewed by a 
Web browser, such as Internet Explorer. Web Layout view is the mode 
you normally work in when you use Word to create HTML documents.

  ✦ Outline view lets you work with outlines established using Word’s stan-
dard heading styles. For more information about using outlines, consult 
Book VI, Chapter 6.

  ✦ Draft view formats text as it appears on the printed page with a few 
exceptions. For example, headers and footers aren’t shown. Most people 
prefer this mode.

Taking the Backstage Tour
Every June I attend the Oregon Shakespeare Festival in Ashland, Oregon. A 
few years ago, I took the special backstage tour, in which I learned all kinds 
of nifty secrets worthy of a Dan Brown novel.

Let’s take a brief tour of Word’s Backstage feature, which provides access to 
document management features previously found on the File menu. When 
you click the File tab in the upper-left corner of the Word window, Word 
switches to Backstage view, shown in Figure 1-2.
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14 Taking the Backstage Tour

 

Figure 1-2: 
Backstage 
view.

 

The information initially displayed in Backstage view depends on whether 
you have an active document open. If no document is open, Backstage view 
displays a list of documents you’ve recently worked with. If a document is 
open, Backstage view displays information about the document.

The menu on the left — which bears a striking resemblance to what we 
used to call the File menu, back in the day when programs had plain menus 
instead of fancy ribbons — provides access to the hidden features of Word 
available only to those who venture backstage.

I briefly introduce you to some of these commands later in this chapter, but I 
take you on a more detailed backstage tour in Chapter 2 of this minibook.

 

At this point, probably the most important thing you need to know about 
Backstage view is how to get out of it. You can close Backstage view and 
return to your document by pressing the Escape key or by clicking the File 
tab again (or any Ribbon tab, for that matter).

 Okay, the only secret I learned on the backstage tour at Ashland that was 
truly worthy of a Dan Brown novel is the one about Psalm 46 in the King 
James translation of the Bible, which was published in 1611 — when William 
Shakespeare turned 46. If you count 46 words from the start of the Psalm, 
you see the word Shake. And, if you count 46 words backward from the end 
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15Typing and Editing Text

of the psalm, you see the word Spear — which clearly means that treasure 
is buried directly beneath the stage in Ashland’s outdoor theater. Next year, 
I’m taking a shovel.

Creating a Basic Document
Creating a basic document in Word 2010 is easy: All you have to do is start 
Word 2010 and a basic document is automatically created for you. This doc-
ument is initially named Document1, but you give it a more meaningful name 
when you save it, as described later in this chapter, in the section “Saving 
Your Work.”

For more information about creating documents, refer to Chapter 2 in this 
minibook.

Typing and Editing Text
I devote all of Book II to the many and sundry techniques for editing your 
documents. In the following paragraphs, I just highlight some basic editing 
techniques to get you started:

 ✦ Any text you type is inserted into the document at the location of the 
insertion point. You can move the insertion point around the screen by 
using the movement keys (the four keys with arrows pointing up, down, 
left, and right) or by simply clicking at the location you want to move 
the insertion point to.

 

✦ In previous versions of Word, you could switch to Overtype mode by 
pressing the Insert key. Then any text you typed replaced the text 
already on the page. Few people switched to Overtype mode on pur-
pose, and it was all too easy to switch to it accidentally. As a result, 
Microsoft wisely disabled the Insert key for this purpose. (You can reac-
tivate this feature from the Word Options dialog box, if you want, but I 
don’t recommend it.)

 ✦ If you make a mistake (never!), press Backspace to back up, erasing text 
as you go. For more efficient ways to correct mistakes, refer to Book II.

 ✦ Press Enter at the end of each paragraph to begin a new paragraph.

  Don’t press Enter at the end of every line. Word automatically wraps 
your text to the next line when it reaches the margin.

 ✦ Press Tab to indent text. Don’t press the spacebar repeatedly to indent 
text; that’s a rookie mistake.
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Printing Your Masterpiece
After you finish your masterpiece, you might want to print it. I have a lot 
more to say about printing in Chapter 4 of this minibook. But for now, here’s 
the quick procedure for printing a document:

 1. Make sure that your printer is turned on and ready to print.

  Check the paper supply while you’re at it.

 2. Click the File tab to open Backstage view and then choose Print from 
the backstage menu.

  This action summons the Backstage Print page, as shown in Figure 1-3. 
The Print page has a myriad of options you can fiddle with to print just 
parts of your document or to print more than one copy. To print a single 
copy of the entire document, you can leave these settings alone.

 3. Click the Print button.

  Make sure that you say “Print” in a knowing manner, pointing at your 
printer as you do so. The secret is to fool your printer into thinking you 
know what you’re doing.

 

Figure 1-3: 
Printing 
from 
Backstage.
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Saving Your Work
After you spend hours creating your document, you have to save your work 
to a file. If you make the rookie mistake of turning off your computer before 
you save your presentation, — poof! — your work vanishes as though the 
eccentric magicians Penn & Teller were in town.

As with everything else in Word, you have at least four ways to save a 
document:

 ✦ Click the Save button on the Quick Access toolbar.

 ✦ Choose File➪Save.

 ✦ Press Ctrl+S.

 ✦ Press Shift+F12.

If you haven’t yet saved the file to your hard drive, the magical Save As 
dialog box appears, as shown in Figure 1-4. Type the name you want to use 
for the file in the File Name text box and click the Save button to save the 
file. After you save the file once, subsequent saves update the hard drive 
file with any changes that you made to the document since the last time you 
saved it.

 

Figure 1-4: 
The Save As 
dialog box.

 

05_487662-bk01ch01.indd   1705_487662-bk01ch01.indd   17 4/15/10   8:31 PM4/15/10   8:31 PM



18 Opening a Document

 

If you somehow miss out on saving your work, such as if the power goes out 
unexpectedly or Word crashes, all is not lost. Word autosaves your work for 
you at defined intervals (by default, it’s every ten minutes), and when you 
restart Word, a Recover Unsaved Documents pane appears listing any recov-
erable temporary saves.

Keep these notes in mind when saving files:

 ✦ Put on your thinking cap when assigning a name to a new file. The file-
name is how you can recognize the file later on, so pick a meaningful 
name that indicates the file’s contents.

 ✦ After you save a file for the first time, the name on the Word title bar 
changes from Document1 to the name of your file. This name is simply 
proof that you saved the file.

 ✦ Don’t work on your file for hours at a time without saving it. Word’s 
Recover Unsaved Documents feature might save you when disaster 
strikes, but it’s not perfect, so don’t count on it. I learned the hard way 
to save my work every few minutes. After all, I live in California, so I 
never know when a rolling blackout will hit my neighborhood. Get into 
the habit of saving every few minutes, especially after making a signifi-
cant change to a document. In fact, I usually save after completing every 
paragraph. You should also save every time you print.

Opening a Document
After you save a document to your hard drive, you can retrieve the docu-
ment later when you want to make additional changes or to print it. As you 
might guess, Word gives you 2,037 ways to accomplish the retrieval. Here 
are the most common:

 ✦ Choose File➪Open.

 ✦ Press Ctrl+O.

 ✦ Press Ctrl+F12.

Each of these methods pops up the Open dialog box, which gives you a list 
of files to choose from, as shown in Figure 1-5. Click the file you want and 
then click the Open button or press Enter.

The Open dialog box has controls that enable you to rummage through the 
various folders on your hard drive in search of your files. If you know how to 
open a file in any Windows application, you know how to do it in Word; the 
Open dialog box is much the same in any Windows program.
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19Closing a Document

 

Figure 1-5: 
The Open 
dialog box.

 

 

The fastest way to open a file from the Open dialog box is to double-click 
the file you want to open. This action spares you from having to click the file 
once and then clicking Open. Double-clicking also exercises the fast-twitch 
muscles in your index finger.

 

Word keeps track of files you’ve recently opened and displays them on 
the right side of the File tab (Recent page). To open a file you’ve recently 
opened, click the File tab, click Recent (if necessary), and inspect the list 
of files that appear on the menu. If the file you want is in the list, click it 
to open it. (Note that in previous versions, Word displayed only the four 
most recent documents you’ve edited. Word 2010 displays 20 recent docu-
ments by default, and you can use the File➪Options command to change the 
number of recent documents displayed.)

Closing a Document
Having finished your document and printed it just right, you have come to 
the time to close it. Closing a document is kind of like gathering up your 
papers, putting them neatly in a file folder, and returning the folder to its 
proper file drawer. The document disappears from your computer screen. 
Don’t worry: It’s tucked safely away on your hard drive, where you can get to 
it later if you need to.

To close a file, choose File➪Close. You also can use the keyboard short-
cut Ctrl+W, but you need a mind like a steel trap to remember that Ctrl+W 
stands for Close.
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You don’t have to close a file before exiting Word. If you exit Word without 
closing a file, Word graciously closes the file for you. The only reason you 
might want to close a file is that you want to work on a different file and you 
don’t want to keep both files open at the same time.

If you made changes since the last time you saved the file, Word offers to 
save the changes for you. Click Save to save the file before closing or click 
Don’t Save to abandon any changes you’ve made to the file.

If you close all open Word documents, you might discover that most Word 
commands are rendered useless. (They’re grayed out on the menu.) Fear 
not. Open a document, or create a new one, and the commands return to life.

Exiting Word
Had enough excitement for one day? Use any of these techniques to shut 
down Word:

 ✦ Choose File➪Exit.

 ✦ Click the X box in the upper-right corner of the Word window.

 ✦ Press Alt+F4.

Bam! Word is history.

You should know a few things about exiting Word (or any application):

 ✦ Word doesn’t let you abandon ship without first considering whether 
you want to save your work. If you made changes to any documents and 
haven’t saved them, Word offers to save the documents for you. Lean 
over and plant a fat kiss right in the middle of your monitor — Word just 
saved you your job.

 ✦ Never turn off your computer while Word or any other program is run-
ning. It’s a bad idea! You might lose whatever work you’ve done since 
the last time you saved, and you run the risk of losing your document 
altogether and perhaps even corrupting other documents. Always prop-
erly exit Word and all other programs that are running before you turn 
off your computer.
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Chapter 2: Your Backstage Pass 
for Managing Documents

In This Chapter
✓ Creating new documents

✓ Opening existing documents

✓ Finding files gone astray

✓ Retrieving files from the Internet

✓ Saving documents and setting the Word file-saving options

✓ Password-protecting your files

The new Backstage view in Word is the central place for managing your 
documents — creating new documents, saving and opening documents, 

printing and sharing documents, and so on. You can’t get far in Word with-
out knowing how to work with the Backstage view. So, this chapter provides 
a quick tour of its features.

Note that one of the major features available from Backstage view — 
printing — is covered in detail in Chapter 4 of this minibook.

Getting to the Backstage feature is easy: Just click the File tab, located in the 
upper-left corner of the Word Ribbon, as shown in the margin. After you’re 
in Backstage view, you can get out by clicking any other tab (Home, for 
example) or by pressing the Esc key.

Getting Information about Your Document
Assuming a document is open when you click the File tab, Word opens 
Backstage view with a display of interesting and useful information about 
the current document, as shown in Figure 2-1.
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22 Getting Information about Your Document

 

Figure 2-1: 
Backstage 
view 
displays 
information 
about the 
current 
document, 
assuming 
that a 
document is 
open.

 

As you can see, the information on the Info page is grouped into categories:

 ✦ Compatibility Mode: If the document is not a native Word 2007/2010 
document, a Convert button appears here, enabling you to easily update 
its format. Otherwise, this category does not appear.

 ✦ Permissions: Indicates whether the document is locked to prevent 
editing or is still being edited. You can use the controls in this group to 
finalize the document so that it can’t be accidentally changed, or you 
can protect the document with a password so that only people who 
know the password can read the document. For more information, see 
Book VI, Chapter 3.

 ✦ Prepare for Sharing: This section highlights important information you 
should know about your document before you send it to others, such as 
a record of the edits you made as you developed the document. You can 
also use the Check for Issues button to find specific issues you might 
want to address or correct before sharing the document. For more infor-
mation, refer to Book V, Chapter 3.

 ✦ Versions: If the document has been saved several times, you may be 
able to access previous versions of it from this section.
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23Creating a New Document

Creating a New Document
Backstage view includes a New command that lets you create a new docu-
ment. However, as I mention in Chapter 1 of this minibook, the easiest way 
to create a new document in Word is to simply start Word from the Start 
menu. Then the program creates a blank document named Document1.

When you create a new document this way, the document is based on the 
template named Normal.dotm. A template is simply a model document from 
which new documents are created. New documents based on the Normal.
dotm template have these characteristics:

 ✦ The margins are set at 1 inch from the top and bottom and 1 inch from 
the left and right. If you want to change these margin settings, turn to 
Book III, Chapter 1.

 ✦ The text is formatted using 11-point Calibri. To change the text format, 
check out Book II, Chapter 2.

 ✦ The document includes a few — and by a few, I mean more than 100 — 
built-in styles you can use to format headings. (You can find 16 as quick 
styles and other types of text.) To discover how to work with these 
styles or to create your own styles, see Book II, Chapter 3.

The Normal.dotm template is adequate for generic types of documents, 
such as book reports and letters to your mom. For more specialized types of 
documents, you can use other templates that come with Word. Or, you can 
create your own templates. For more information about working with tem-
plates, see Chapter 3 of this minibook.

You can create as many such documents as your heart desires without 
having to worry about closing any of your other open documents. If you’ve 
already started Word, you can create a second (or third or fourth) blank 
document based on the Normal template in any of the following ways:

 ✦ Press Ctrl+N. You use this keyboard shortcut to create a new, blank 
document.

 ✦ Click the New button on the Quick Access toolbar. The New button 
doesn’t initially appear on the Quick Access toolbar, but you can easily 
place it there by clicking the Customize Quick Access Toolbar button at 
the right end of the Quick Access toolbar. Then click New from the list of 
buttons that appears.

 ✦ Choose File➪New, and then click the Blank Document icon. (This is 
the long way around, though; if you want a blank document, either of the 
other two methods is easier.)
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24 Creating a New Document

After you create a new document, you can add text and other content and 
edit the document however you want. Then you can save the document as 
described later in this chapter.

If you want to create a document based on a template other than the Normal 
template, click the File tab to open Backstage view and then click New. This 
command summons the New page in Backstage view, shown in Figure 2-2.

The New page provides several alternatives to creating simple blank 
documents:

 ✦ Blank Document: Double-click this icon to create a blank document, the 
same as if you click the New button on the Quick Access toolbar.

 ✦ Blog Post: Double-click this icon to create a new post at a blogging Web 
site. For more information, refer to Book V, Chapter 1.

 ✦ Recent Templates: Click this icon to list the templates you have recently 
used. For more information, see Chapter 3 of this minibook.

 ✦ Sample Templates: Click this option to display a list of templates that 
are available on your computer. For more information about templates, 
see Chapter 3 of this minibook.

 

Figure 2-2: 
The New 
page in 
Backstage 
view.
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25Opening Documents

 ✦ My Templates: Click this option to display a list of templates that you 
have downloaded from the Microsoft Web site and customized for your 
own use. For more information, see Chapter 3 of this minibook.

 ✦ New From Existing: Click this option to create a new document based 
on a copy of an existing document.

 ✦ Office.com Templates: This section of the New page lets you access 
templates from the Microsoft Web site.

Opening Documents
The most direct way to open a saved document is to choose File➪Open. 
Alternatively, you can use the keyboard shortcut Ctrl+O or Ctrl+F12. Or, you 
can click the Open button on the Quick Access toolbar. Although this button 
doesn’t initially appear on the Quick Access toolbar, you can easily place 
it there by clicking the Customize Quick Access Toolbar button at the right 
end of the Quick Access toolbar and then clicking Open from the list of but-
tons that appears.

 Ctrl+O is the more intuitive keyboard shortcut for the File➪Open command 
(O is for Open, of course), but Ctrl+F12 is left over from the early days of 
Windows, before Microsoft programmers decided that keyboard shortcuts 
make more sense. Rather than drop an antiquated and senseless keyboard 
shortcut in favor of one that makes sense and is consistent across all 
Windows applications (or at least is supposed to be), the Word developers 
at Microsoft decided to leave both keyboard shortcuts in place.

No matter which method you choose, the Open dialog box appears, as 
shown in Figure 2-3.

 

Figure 2-3: 
The Open 
dialog box.
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One quick way to access different locations is by using the Folders pane, on 
the left side of the dialog box. It lists shortcuts to many common locations, 
including the Documents library (the default save location in Word 2010) 
and Computer, which you can select to browse the entire content of your 
system. You can also browse and navigate locations by using the Address 
bar, along the top of the dialog box. Click the right-pointing arrows in the 
path on that bar to open menus of locations, or click the left-pointing arrows 
(<<) at the beginning of the path to view the top level of the path.

The folder navigation method on your system may be somewhat different 
from the one shown and described here if you’re using Windows XP. In 
Windows XP, you see a Look In drop-down list, as well as an Up One Level 
button for navigation control.

 

You can open more than one document at a time by selecting several files 
and clicking the Open button. Use one of these techniques to select several 
files:

 ✦ Hold down the Ctrl key while clicking the files you want to select.

 ✦ To select a range of files, click the first file in the range, hold down the 
Shift key, and click the last file in the range.

Changing views
The Open dialog box lets you switch among several different views of your 
documents. A Views button near the top of the dialog box displays a menu 
that lets you choose the view you want.

The views available to you depend on your Windows version. (Word takes 
many of its settings for saving, opening, and viewing files directly from 
Windows.)

The available views in Windows Vista and Windows 7 are described in this 
list:

 ✦ Icons (Extra Large, Large, Medium, or Small): Shows each file as an 
icon, with the size of the icon dictated by the view you choose.

 ✦ List: Displays a list of folders and documents with small icons.

 ✦ Details: Displays a list of folders and documents with details, including 
the filename, type, size, and creation date. Headers at the top of columns 
are buttons; you can sort the list on any column by simply clicking the 
column’s button.

 ✦ Tiles: Displays medium-size icons with filenames and file information to 
the right.

 ✦ Content: Displays a horizontal bar for each figure, including an icon and 
a name and file size information.
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27Opening Documents

In Windows Vista and Windows 7, you can use the Preview button to toggle 
on or off a Preview pane in the dialog box, regardless of the chosen view.

If you have Windows XP, these views are available:

 ✦ Thumbnails: Displays a large icon that represents the contents of each 
file. For an image file, the thumbnail displays a small view of the image 
contained in the file. For Windows XP, Word documents don’t display 
useful thumbnails by default, but in Windows Vista, they do.

 ✦ Tiles: Displays each document using large icons, with descriptive infor-
mation listed to the right of each icon.

 ✦ Icons: Displays each document with a medium-size icon and descriptive 
information listed below each icon.

 ✦ List: Displays a list of folders and documents with small icons.

 ✦ Details: Displays a list of folders and documents with details, including 
the name, date modified, type, and size. Headers at the top of columns 
are buttons; you can sort the list on any column by simply clicking the 
column’s button.

 ✦ Properties: Displays a panel showing various properties for the selected 
file, including the title, author, template, word count, and other useful 
information.

 ✦ Preview: Displays a preview of the selected file in a separate pane.

Deleting and renaming documents and folders
You can delete and rename files and folders from the Open dialog box. 
Here’s how:

 ✦ To delete a file or folder, select the file or folder and press Delete.

 ✦ To rename a file or folder, select it by clicking it once and then click the 
filename again. A text-editing box appears around the file or folder name, 
allowing you to edit the name. (Don’t click it too quickly or else Word 
thinks that you double-clicked and the file or folder opens.)

Setting the default document location
When you call up the Open dialog box, Word initially displays the contents 
of the folder indicated by the default Document File Location option set-
ting. When you install Word, this option is initially set to the My Documents 
folder on your computer’s local hard drive. However, you can change that 
location, if you want. For example, you might want to set up Word so that 
the default document location is on a network drive. To do so, follow these 
steps:
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28 Opening Documents

 1. Click the File tab to open Backstage view and then click Options.

  The Word Options dialog box appears.

 2. Click the Advanced tab on the left side of the Word Options 
dialog box.

 3. Use the scroll bar to scroll all the way to the bottom of the 
Advanced tab.

 4. Click the File Locations button.

  The File Locations dialog box appears, as shown in Figure 2-4.

 

Figure 2-4: 
The File 
Locations 
dialog box.

 

 5. Click Documents and then click the Modify button.

  This step opens the Modify Location dialog box.

 6. Use the Modify Location dialog box to select the new location for your 
documents.

  You can either type the complete path (drive letter and folder) of the 
location where you want to store documents in the Folder Name box 
or use the controls in the Modify Location dialog box to navigate to the 
folder.

 7. Click OK to return to the File Locations dialog box.

 8. Click OK again to return to the Word Options dialog box.

 9. Click OK one more time to dismiss the Word Options dialog box.
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29Opening Documents

Using the Organize menu in Vista and 
Windows 7 (or the Tools menu in XP)
If you’re using Windows Vista or Windows 7, the Open dialog box contains 
an Organize button that opens a menu of actions and options. A Tools 
button near the bottom of the dialog box also opens a menu of additional 
options.

If you’re using Windows XP, you don’t have an Organize button or menu, but 
you have the Tools button, and some of the options that the Organize button 
would provide are on your Tools menu.

The commands on the Organize menu (or the Tools menu) include the ones 
described in this list:

 ✦ Cut, Copy, and Paste: Use the Clipboard to move and copy files. For 
example, you might cut a file from one location and then display another 
location and paste it. 

 ✦ Undo and Redo: Undo (or redo) a file operation that you have per-
formed since opening the dialog box, such as cutting or pasting.

 ✦ Select All: Select all files and folders in the displayed location. Ctrl+A is 
this shortcut.

 ✦ Layout: Open a fly-out menu from which you can fine-tune how the 
dialog box appears. For example, you can display or hide certain panes 
in it.

 ✦ Delete: Delete the document or folder. You can achieve the same result 
by selecting a document or folder and pressing Delete.

 ✦ Rename: Change the document’s name.

 ✦ Remove Properties: Remove any personally identifiable information 
stored in the file’s properties.

 ✦ Properties: Display the document’s properties, the same as though you 
opened the document and chose Properties➪Advanced Properties on 
the Info tab in Backstage view. I cover file properties in more detail later 
in this chapter.

 ✦ Map Network Drive: Associate a drive letter with a network folder. Don’t 
mess with this command unless you know something about networks. 
This command is on the Tools menu in all Windows versions.

Using the Navigation pane (Favorites bar)
The Navigation pane (in Windows 7) or Favorites bar (in Windows Vista) 
is the list of locations that runs down the left side of the Open dialog box. 
In Windows 7, it’s one big pane, with expandable sections for Favorites, 
Libraries, Homegroup (if enabled), Computer, and Network. In Windows 
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Vista, the Navigation pane has a Favorite Links section at the top, followed 
by a Folders section from which you can browse all locations on your com-
puter. You can also add your own favorite places to the listing (in either 
version).

In Windows 7, these shortcuts are available by default:

 ✦ Desktop: The folder that stores data directly on the Windows desktop

 ✦ Downloads: A folder specified for downloads within your personal 
folder set (for the logged-in user)

 ✦ Recent Places: A list of recently accessed locations

 ✦ Libraries: Shortcuts to the Documents, Pictures, Music, and Videos 
libraries that Windows 7 maintains (more on these in a minute)

 ✦ Homegroup: Shared locations on any computers that are part of your 
Homegroup network (a home networking feature in Windows 7), if 
enabled

 ✦ Computer: All drives on your local PC

 ✦ Network: All shared network locations available to you (not just your 
Homegroup)

In Windows Vista, these shortcuts are available:

 ✦ Templates: Templates stored on your computer

 ✦ Recently Changed: A list of recently used documents

 ✦ Documents: Your Documents folder, which is the normal location for 
storing documents

 ✦ More: Displays a menu with several additional locations

You can quickly access any of these document locations by clicking the icon 
on the Favorite Links bar.

 

You can add your own locations to the Favorites section (in Windows 7) or 
Favorite Links bar (in Windows Vista). To do so, summon the Open dialog 
box (Ctrl+O is one way) and navigate to the folder you want to add a short-
cut to. Then drag the folder to the Favorites list or Favorite Links bar.

Using the Save As Command
The Save As command saves a new file or an existing file under a different 
name. You can summon this command in two ways:

 ✦ Choose File➪Save As.

 ✦ Press F12.
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31Using the Save As Command

You can also invoke the Save As command by using the Save command for 
any document that isn’t yet saved to your hard drive.

Figure 2-5 shows the Save As dialog box, displayed when you invoke the 
Save As command. As you can see, this dialog box shares many features and 
controls with the Open dialog box: the Organize button, the address bar, 
the navigation bar, and so on. And just like in the Open dialog box, you can 
change views, manage files with the commands on the Organize and Tools 
button menus, and so on.

 

Figure 2-5: 
The Save As 
dialog box.

 

In the Save As dialog box, navigate to the folder where you want to save the 
document, type a new name for the document, and click the Save button.

If you want to replace an existing document with the current document, 
double-click the document you want replaced. Word displays a dialog box 
asking whether you truly want to replace the document. Your choices are

 ✦ Replace existing file.

 ✦ Save changes with a different name.

 ✦ Merge changes into existing file.

You can also click Cancel to abort the entire process.

When you first call up the Save As dialog box, Word takes a wild guess that 
you want the text in the first paragraph of the document to be the filename. 
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This guess makes sense if the first paragraph is the title of the document, 
but in most cases, you want to type a more sensible document name.

To navigate to a different save location, use the address bar at the top of the 
dialog box (just like using the Open dialog box) or use the Favorites bar along 
the left side (again, just like with Open). Click the New Folder (or Create New 
Folder) button if you want to create a new folder in the current location.

Notice that the Save As dialog box also includes a Save As Type drop-down 
list. Normally, this field is set to Word Document (*.docx) so that docu-
ments are stored in Word format. You can change this setting to save a 
document in another format. For example, if you’re exchanging work with 
someone who has only Word 2003, use the Word 97-2003 format (*.doc).

Not all file types support all Word formatting features. Any special format-
ting not supported by the file type is lost when you save the file. So, if you 
want to save your masterpiece in one of these formats, you might want to 
keep a version in Word format, too.

Save Options
You can set several options that affect how files are saved by clicking the 
File tab to summon Backstage view and then clicking Options to open the 
Word Options dialog box. Then click the Save tab to show the Save options, 
as shown in Figure 2-6.

 

Figure 2-6: 
Setting 
the Save 
options.
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33Save Options

The following paragraphs describe what you can do by choosing each of 
these options:

 ✦ Save Files in This Format: Specify the default format for saving files.

 ✦ Save AutoRecover Info Every n Minutes: Automatically save recovery 
information at regular intervals. The default setting is to save the recov-
ery information every ten minutes, but you can change the time interval, 
if you want.

 ✦ AutoRecover File Location: Using this option, set the location where 
you want the AutoRecover files saved.

 ✦ Default File Location: Set the default location for Word documents.

 ✦ Save Checked-Out Files To: If you’re working with a document-
management system such as SharePoint, use this option to specify 
where files should be saved when you check them out.

 ✦ Embed Fonts in the File: Have Word save TrueType fonts in the docu-
ment file. This option increases the size of the document file but enables 
you to copy the file to another system without worrying about whether 
the other system has the fonts used in the document.

Amazingly, even though Microsoft created a separate tab for Save options, 
it didn’t put all its Save options on the Save tab. If you switch over to 
the Advanced tab and scroll down a bit, you can find a Save section that 
includes more saving options:

 ✦ Prompt Before Saving Normal Template: Force Word to ask for your 
permission before saving changes to the Normal.dotm template. If 
you’re concerned about proliferating changes to this template, select 
this option.

 ✦ Always Create Backup Copy: If you select this option, Word always 
saves the previous version of the document as a backup copy every time 
it saves the document. The backup copy uses the extension BAK.

  Don’t rely on the Always Create Backup Copy option as your only 
backup of important documents. The backup copy created by this 
option resides on the same drive and in the same folder as the docu-
ment itself. As a result, if a hard drive failure or another type of problem 
renders the drive or folder inaccessible, the backup copy is inaccessible 
as well. Always back up important documents to a separate hard drive, 
flash drive, or writable CD or DVD.

 ✦ Copy Remotely Stored Files onto Your Computer, and Update the 
Remote File When Saving: Create a local copy of documents stored on 
network or removable drives so that they can be recovered in case you 
lose access to the network or removable drive.
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 ✦ Allow Background Saves: Saves documents while allowing you to con-
tinue working. This option is activated by default. Don’t change it. Just 
know that it’s there and go about your business.

Password-Protecting Your Files
Word allows you to protect your sensitive files from snooping eyes by using 
passwords. You can apply two types of passwords to your documents:

 ✦ A Password to Open password prevents users who don’t know the pass-
word from opening the file. Use this password for files you don’t want 
unauthorized users to examine.

 ✦ A Password to Modify password prevents users who don’t know the 
password from saving the file. Use this password for files you don’t want 
unauthorized users to modify.

To password-protect a document, follow these steps:

 1. Open the document.

 2. Choose File➪Save As.

  This step opens the Save As dialog box.

 3. Click the Tools button and then click General Options from the drop-
down menu that appears.

  The General Options dialog box, shown in Figure 2-7, appears.

 

Figure 2-7: 
Setting a 
password.
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35Password-Protecting Your Files

 4. Type a password in the Password to Open field or the Password to 
Modify field (or both, if you want to provide a different password for 
each type of access).

  Word displays asterisks as you type the password, which prevents 
looky-loos from seeing your password as you type it.

 5. Click OK.

 6. When Word prompts you to reenter the password, type it again, 
exactly as you did the first time.

 7. Click OK.

 8. Save the file.

If you attempt, or anyone else attempts, to open a file that’s password pro-
tected, Word displays a dialog box demanding the password. No password, 
no access.

 Here are some cautionary tips for working with passwords:

 ✦ Don’t forget your password! If you forget, you can’t access your 
document.

 ✦ Don’t use different passwords for every document. You’ll never remem-
ber them all. Instead, use the same password for all your documents.

 ✦ Don’t write down your password on a sticky note and stick it on your 
computer monitor.

 ✦ Don’t use obvious passwords, such as your kids’ names, your spouse’s 
name, your dog’s name, or the name of your boat.

 

To remove password protection from a file, open the file (you have to supply 
the password to do it), choose File➪Save As, click Tools, click General Options, 
and then highlight and delete the password. Click OK and save the file.
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Chapter 3: Working 
with Templates

In This Chapter
✓ Discovering templates

✓ Enabling default settings for Word documents

✓ Creating documents based on a template

✓ Building your own templates

✓ Using global templates properly

✓ Working with the Organizer

Including an entire chapter on Word templates near the front of a book 
might seem premature, but I want to impress on you from the start that 

understanding templates is one key to using Word as efficiently as possible. 
You can use Word for years without even knowing what a template is, but 
either your documents all look the same or you spend way too much time 
fiddling repeatedly with the same formatting options. Besides, the topic of 
the proper use of templates comes up again and again throughout this book, 
so I might as well get the subject of templates out in the open.

Note that the themes feature lets you easily change the appearance of docu-
ments without changing templates. For more information about working 
with themes, turn to Chapter 2 of Book III. However, templates still play a 
crucial role in the efficient use of Word because they store much more than 
just formatting information. And, somewhat in contrast to themes, one main 
strength of templates is that they help you easily create multiple documents 
that have a similar, if not identical, appearance.

Understanding How Templates Work
A template is a special type of document file used as the basis for format-
ting your documents. Whenever you create a new document, a template file 
is the starting point for the new document. The following items are copied 
from a template into the new document:

 ✦ Styles: Apply paragraph and character formatting quickly. For more 
information about working with styles, see Book II, Chapter 3.
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 ✦ Default theme: The theme used for the document is copied from the 
template. For more information, see Book III, Chapter 2.

 ✦ Margins and other page layout information: You can use settings such 
as paper size, orientation, headers, and footers.

 ✦ Text and graphics: A template can contain document content (text and 
graphics) so that every time you start a new document with that tem-
plate, the content is already there. A template can be useful if you have 
to start every report with your company name and logo, for example.

 ✦ Building Block entries: Quickly insert these sections of text into your 
documents by simply typing a few keystrokes.

 ✦ Macros: Use these miniprograms to automate routine chores. For more 
information, see Book IX.

 

Each document has only one template attached to it. If you don’t specify a 
template to attach to a new document, Word attaches the generic Normal.
dotm template, which contains such standard styles as Normal, Heading 1, 
Heading 2, and Heading 3, plus default margins, keyboard shortcuts, and 
others. You can attach a different template to a document later, and you can 
copy the styles from the new template into the existing document, if you 
want. Then you have access to the styles from the new template as well as 
from the existing document.

 A template is basically the same as a normal document, except that it has 
the extension DOTX or DOTM rather than DOCX, as normal documents do. 
The difference between DOTX and DOTM templates is that DOTM templates 
allow macros and DOTX templates don’t.

 

Word permits you to open and edit templates as though they’re documents, 
and you can easily convert a document to a template by saving it as a tem-
plate rather than as a document. The real difference between documents 
and templates lies in how you use them.

Getting to Know the Normal.dotm Template
When you create a new, blank document, Word attaches the Normal.dotm 
template to it. Word obtains the default document format, margins, and 
page orientation and standard styles such as Normal, Heading 1, Heading 2, 
and Heading 3 from the Normal.dotm template. In other words, Normal.
dotm is where Word stores its default settings for any feature controlled by 
templates.

Computer nerds call Normal.dotm a global template, which means that it’s 
always available in Word, whether or not the document you’re working with 
is attached to it. (We computer nerds love to use the term global because 
we dream of dominating the world someday.) Even if you attach a different 

07_487662-bk01ch03.indd   3807_487662-bk01ch03.indd   38 4/15/10   8:32 PM4/15/10   8:32 PM



Book I

Chapter 3

W
o

rk
in

g
 w

ith
 

T
e

m
p

la
te

s

39Creating a Document from an Online Template

template to a document, the settings in Normal.dotm are still available 
because Normal.dotm is a global template.

Any changes you make to Normal.dotm effectively change Word’s default 
behavior. For example, if you don’t like the default style for Heading 1 para-
graphs, you can change the Heading 1 style in Normal.dotm. Or, you can 
add keyboard shortcuts to Normal.dotm. By making careful changes to 
Normal.dotm, you can change Word’s behavior to suit your own working 
style. In effect, you can create your own, individualized version of Word.

 

You can restore your Normal.dotm template to its pristine condition by 
quitting Word and deleting the template. Then, when you restart Word, 
Word regenerates a standard Normal.dotm template. You can find the 
template in this folder:

C:\Users\user\AppData\Roaming\Microsoft\Templates

If Word discovers that the Normal.dotm template is missing, it reverts to its 
original default settings and creates a new Normal.dotm template. Be aware 
that when you delete the template, you lose everything you added to it.

Creating a Document from an Online Template
Microsoft maintains the Office Online Web site, which has a large collection 
of templates you can use to create your documents. To use one of these tem-
plates, just follow these steps:

 1. Click the File tab to summon Backstage view and then click New.

  The New page of Backstage view, shown in Figure 3-1, appears.

 2. Select a category listed under Office.com Templates.

  The list of templates available in the category you select is displayed, as 
shown in Figure 3-2.

 3. Click the template you want to use and then click the Download button.

  The template is downloaded to your computer and automatically cre-
ates a new document based on it.

 4. You’re done.

  A new document is created from the template you selected.

When you create a new document based on a template, any text and graph-
ics contained in the template are automatically copied into the new docu-
ment. People often use templates for this purpose to supply text or graphics 
that always appear in certain types of documents. Many of the templates 
available in Office Online include this type of text and graphics.

07_487662-bk01ch03.indd   3907_487662-bk01ch03.indd   39 4/15/10   8:32 PM4/15/10   8:32 PM



40 Creating a Document from an Online Template

 

Figure 3-1: 
Creating 
a new 
document 
from an 
online 
template.

 

 

Figure 3-2: 
Selecting 
a template 
from a 
category.
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41Changing the Template Attached to a Document

Creating a New Document Based 
on a Recently Used Template

Word 2010 keeps track of the templates you use and makes it easy to reuse 
them. To reuse a template you have recently used, click the File tab to open 
Backstage view, click New, and then click Recent Templates. A list of tem-
plates you have used recently appears; just double-click the template you 
want to use to create a new document based on the template.

Using a Sample Template
Word 2010 also comes with a collection of approximately 30 templates you 
can use. To create a document based on one of these templates, click the File 
tab to open Backstage view, click New, and then click Sample Templates. A list 
of the sample templates appears. Double-click the template you want to use.

Changing the Template Attached to a Document
You can change the template attached to a document at any time. When 
you do, all the macros, keyboard shortcuts, as well as Building Block entries 
from the new template, automatically copy into the document. No boilerplate 
text or graphics that may be in the template are copied into the document. 
Styles from the template are copied into the document only if you select the 
Automatically Update Document Styles option when you attach the template.

Changing the template attached to a document 
is one of the few Word actions that you cannot 
undo with the Undo command. As a result, if 
you inadvertently attach the wrong template to 
a document, correcting your error can be dif-
ficult. That’s because when you attach a new 
template, Word copies elements from the new 
template into the document but doesn’t remove 
elements from the document derived from the 
previous template.

To illustrate the type of problem this situation can 
cause, suppose that you’re working on a docu-
ment that has a handful of custom styles and you 
mistakenly attach a template that has 50 custom 
styles. Because you used the Automatically 

Update Document Styles option, those 50 styles 
are copied into your document. The problem 
arises: How can you get rid of them? You can use 
the Templates and Add-Ins dialog box to attach 
the correct template, but the 50 styles copied in 
from the incorrect template remain in your docu-
ment! And you can’t remove them easily.

To avoid this type of problem, save your docu-
ment immediately before changing templates. 
Then, if you’re not satisfied with the results 
after attaching the new template, you can 
revert to the previously saved version of the 
document if necessary by closing the docu-
ment without saving changes and reopening 
the previously saved copy of the document.

You can’t go back
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42 Changing the Template Attached to a Document

To change the template attached to a document, follow these steps:

 1. Click the File tab to open Backstage view and then click Options.

  The Word Options dialog box appears.

 2. Select Add-Ins from the list of categories on the left side of the Word 
Options dialog box.

  The Add-Ins options screen appears.

 3. Select Templates in the Manage drop-down list and then click the Go 
button (found near the lower-left corner of the dialog box).

  This step opens the Templates and Add-Ins dialog box, shown in Figure 3-3.

 

 If the Developer tab on the Ribbon is visible, you can skip Steps 1 through 
3. Instead, just click the Document Template button on the Developer tab 
to display the Templates and Add-Ins dialog box. For more information, 
see the later section “Activating the Developer Tab on the Ribbon.”

 

Figure 3-3: 
The 
Templates 
and Add-Ins 
dialog box.

 

 4. Click the Attach button.

  This step opens the Attach Template dialog box, shown in Figure 3-4.

 5. Select the template you want to attach to the document and then click 
Open.

  You might have to look in various folders to find the template you want 
to attach. When you click Open, you return to the Templates and Add-
Ins dialog box.
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43Activating the Developer Tab on the Ribbon

 

Figure 3-4: 
Attaching a 
template.

 

 6. If you want the styles from the template you’re attaching to replace 
the styles in your document, make sure that the Automatically Update 
Document Styles check box is selected.

  You usually want to select this check box because the most common 
reason to change templates is to switch to the styles offered by the 
other template.

 7. Click OK to attach the template.

If you update styles and your document uses styles to control its formatting, 
the effects of the new template are immediately visible.

Activating the Developer Tab on the Ribbon
If you plan to work much with templates, you can simplify your life by 
revealing the Developer tab on the Ribbon. This tab includes a Document 
Template button, which provides direct access to the Templates and Add-
Ins dialog box, eliminating the need to wade through the Word Options 
dialog box as described in the preceding section.

To display the Developer tab, choose File➪Options, click Customize Ribbon, 
and from the list of tabs on the right side, select the Developer check box. 
Then click OK. Figure 3-5 shows Word with the Developer tab open.
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Figure 3-5: 
The 
Developer 
tab.  

Creating Your Own Templates
Word comes with a collection of templates that let you create a wide variety 
of document types, but sooner or later you’ll almost certainly want to create 
your own templates. The sections that follow explain everything you need to 
know about creating and using your own templates.

Converting a document to a template
Suppose that you’ve been working on a document for hours, toiling over its 
formats until they’re just the way you want them, and you realize that you 
might want to create other documents using the same formats. Creating a 
template from this document is a simple matter.

Open the document you want to use to create the template and choose 
File➪Save As to open the Save As dialog box. At the bottom of the Save As 
dialog box is a Save As Type drop-down list. The default setting is Word 
Document. Change this field to Word Template or Word Macro-Enabled 
Template, depending on whether you want to include macros in the tem-
plate. Type a name for your template, navigate to the folder where you want 
to save the template, and click Save to save the document as a template.

 Before you save your document as a template, take a few moments to 
improve the template’s usefulness. Follow this list of guidelines:

 ✦ Remove unnecessary text. Any text you leave in the template appears in 
any new documents you create with the template.

 ✦ Perfect boilerplate text. Leave only true boilerplate text that you want 
to appear in every document based on the template, and make sure that 
this boilerplate text is exactly as you want it.

 

 To delete all text from the document, press Ctrl+A to select the entire 
document and then press Delete.

 ✦ Remove any unnecessary styles or macros or other elements that 
aren’t template-worthy. Leave only the elements you want to be 
included in documents created from your template.
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45Creating Your Own Templates

 You might be tempted to open the document, delete text and other un-
necessary elements, and then save the document. I caution you against 
this strategy, though, because you can easily delete an entire document’s 
worth of text and accidentally using Save rather than Save As! To avoid this 
disaster, save the document as a template before you begin deleting mas-
sive amounts of text.

Creating a new template from scratch
To create a new template from scratch, choose File➪New and select My 
Templates. Select the template you want use as the starting point for your 
new template. In the lower-right corner of the dialog box, you can see a set 
of radio buttons that let you indicate whether you want to create a new doc-
ument or a new template. Select the Template option and then click OK.

Your new template inherits the styles, text, and other elements contained 
in the template you based it on. Now is the time to add any more styles, 
macros, or other new elements to the template or to change existing tem-
plate elements. In addition, you can add boilerplate text and graphics. When 
you’re ready, use the Save command to save the template, assigning it an 
appropriate name and placing it in the correct folder.

By default, Word stores its templates in the 
folder named C:\Users\user\AppData\
Roaming\Microsoft\Templates. But 
you can change the location where templates 
are stored by choosing File➪Options, clicking 
the Advanced tab, and then clicking the File 
Locations button. Then double-click the User 
Templates option.

You can also specify a location for workgroup 
templates, which are templates you access 
via a network. Workgroup templates come in 
handy if you and other network users need to 
share a set of common templates. In that case, 
place the common templates on a network file 
server and then use the Workgroup Templates 
option on the File Locations tab to indicate the 
location of the shared templates.

When you create your own templates, you 
usually store them in the C:\Users\
username\AppData\Roaming\

Microsoft\Templates folder, and they 
appear on the default Personal Folders tab 
when you create a new document based on 
a template with the My Templates option. You 
can create new folders within that location, 
and place templates into them, to create addi-
tional tabs in that dialog box. This strategy is 
helpful if you have a lot of templates to keep 
organized.

The Trusted Locations feature in Word 2010 
lets you designate certain folders as trusted, 
which means that documents and templates 
opened from those locations are considered 
safe by Word. You may want to designate your 
user template folder as a trusted location. To 
do so, choose File➪Options, click the Trust 
Center tab, and click the Trust Center Settings 
button. This action opens a dialog box that lets 
you designate a folder as a trusted location.

Boring details about where to store templates
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Modifying an existing template
To modify an existing template, choose File➪Open to call up the Open 
dialog box. Change the Files of Type list box from Word Documents to 
Word Templates (or All Word Templates, if you want to include templates 
from Word 97-2003) and locate and select the template you want to modify. 
Click Open to open the template, make any changes you want to make, and 
choose File➪Save to save the changes. That’s all there is to it.

Another way to modify an existing template is to open a document based on 
the template and change those elements of the document stored in the tem-
plate rather than in the document. This method is a bit confusing, however: 
Some elements of a document are stored only in the template, whereas other 
elements are copied from the template at the time the template is attached 
and subsequently stored in the document.

The following list indicates how changes to various elements of a document 
affect the template attached to the document:

 ✦ Text: No text you add to the document affects the template. The only 
way to change boilerplate text in a template is to edit the template 
directly.

 ✦ Direct formatting: Any direct formatting you apply to the document 
affects only the document and isn’t copied back to the template.

 ✦ Styles: When you modify a style, you have the option to apply the 
change to styles in the current document or to styles in the template. If 
you apply the change only to the document, the change doesn’t affect 
other documents created from the template.

 ✦ Macros: Macros are always stored in a template, so any macros you 
create or modify are stored in the template, not in the document itself. 
When you create a macro, you must indicate whether you want the 
macro stored in Normal.dotm, the attached template, or another global 
template.

 ✦ Customizations: Changes to custom keyboard shortcuts are stored in 
the template. You must specify whether you want the change stored in 
Normal.dotm, the attached template, or a global template.

 ✦ Building Blocks: Changes to Building Blocks are also stored in the tem-
plate, either Normal.dotm, the attached template, or a global template.

Using Global Templates
A global template is a template with macros, Building Blocks, and custom-
ized keyboard shortcut elements available to all open documents regardless 
of which template is attached to the document. Normal.dotm is a global 
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47Using Global Templates

template, which means that its elements are available even in documents 
attached to another template. You can add your own templates to the list 
of global templates, if you want, so that their elements also are available 
globally.

Note that only the macros, Building Blocks, and customization settings in a 
global template are available to other documents. Styles and boilerplate text 
contained in global templates aren’t available (unless the document happens 
to be attached to the template).

 

A global template is a helpful way to create a library of customized macros. 
You can place all your macros in the Normal.dotm template, but placing 
them in a separate template for global macros gives you some added flexibil-
ity. For example, you can exchange your global macro template with other 
users without worrying about overwriting their Normal.dotm templates. 
And, you can quickly remove all custom macros by removing the global 
macro template without losing other custom items in your Normal.dotm.

Follow these steps to activate a global template:

 1. Choose File➪Options.

  The Word Options dialog box appears.

 2. Select Add-Ins from the list of categories on the left side of the Word 
Options dialog box.

  The Add-Ins options screen appears.

 3. Select Templates from the Manage drop-down list and then click the 
Go button.

  This step opens the Templates and Add-Ins dialog box (refer to Figure 3-3).

 

 If the Developer tab is open, you can skip Steps 1 through 3 and just 
click the Document Template button on the Developer tab.

 4. Locate the Global Templates and Add-Ins list box.

  It contains a list of all available global templates, along with buttons to 
add or remove global templates.

 5. Click the Add button.

  The Add Templates dialog box appears.

 6. Select the template that you want to make global and then click OK.

  When you return to the Templates and Add-Ins dialog box, the template 
you chose appears in the Global Templates and Add-Ins list box.

 7. Click OK.

  You’re done.
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Check out these tidbits about global templates:

 ✦ To disable a global template temporarily, open the Templates and 
Add-Ins dialog box and deselect the template’s check box in the Global 
Templates and Add-Ins list box. To remove the template from the list, 
select it and click the Remove button.

 ✦ After you make a template global, it remains global until you quit 
Word. The next time you start Word, the template is included in the 
Global Templates and Add-Ins list box, but its check box is deselected 
so that it isn’t active. To activate the template to make it global, open 
the Templates and Add-Ins dialog box and select the template’s check 
box. See the earlier sidebar “Stop me before I tell you about the Startup 
folder” to find out how to set up a global template that’s active every 
time you start Word.

Stop me before I tell you about the Startup folder
When you add a template to the Global 
Templates and Add-Ins list, the template 
remains in the list every time you start Word. 
However, you must use the Templates and 
Add-Ins dialog box and select the check box 
next to the template in the list to make the tem-
plate global. If you don’t want to do that every 
time you start Word, follow these steps:

 1. Close Word.

 2. Open a Computer window (choose Start➪
Computer in Windows Vista or 7; Start➪
My Computer in Windows XP). Navigate to 
the folder that contains the template you 
want to make global.

 3. Open a second Computer window. In it, 
double-click the C drive and then navi-
gate to the C:\Program Files\
Microsoft Office\Office 14\
Startup folder.

 4. Drag any templates that you want to be 
global from the template folder to the 
Startup folder. Use the right mouse button 
to drag the template.

  When you release the right mouse button, 
a pop-up menu appears.

 5. Choose the Create Shortcuts Here 
command.

 6. Close both Computer windows and then 
start Word.

Any template files in the C:\Program Files\
Microsoft Office\Office 14\
Startup folder automatically load and are 
made global. If you previously added the tem-
plate to the Global Templates and Add-Ins list, 
remove it before following this procedure.
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49Using the Organizer

How Word Resolves Duplicate Template Elements
When you use global templates, you face the possibility of creating dupli-
cate template elements. For example, a global template might have a macro 
named CopyStyle and the template attached to the document might also 
have a macro named CopyStyle. Which one takes precedence?

The following order of precedence (from highest to lowest) determines 
which template elements to use when name conflicts occur:

 ✦ The document itself always has first priority. Any element defined 
directly in the document supersedes any like-named elements in any 
templates.

 ✦ The template attached to the document is second. Any element defined 
in the attached template supersedes any like-named elements in Normal.
dotm or a global template.

 ✦ The Normal.dotm template is next. Any element that exists in Normal.
dotm takes precedence over a like-named element in another global 
template.

 ✦ Global templates are last. Elements from global templates are used 
only if the attached template and Normal.dotm don’t have a like-named 
element.

If two or more global templates have identically named elements, Word 
uses the one that’s first alphabetically. For example, if both Global Template 
and My Global Macros are loaded as global templates and contain a macro 
named CopyStyle, Word uses the one from Global Template.

Using the Organizer
If you want to move styles en masse from one document or template to 
another, the easiest way is to use the Organizer — the tenacious Word tool 
for taming templates. The Organizer is especially useful when you create 
several new styles in a document and you want to copy those files to the 
document’s template.

To copy styles from your document to a template, follow these steps:

 1. Open the Templates and Add-Ins dialog box.

  You can do that by choosing File➪Options, clicking the Add-Ins tab, 
choosing Templates in the Manage drop-down list, and clicking Go. Or, 
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if the Developer tab is visible on the Ribbon, click the Developer tab and 
then click the Document Template button in the Templates group. The 
Templates and Add-Ins dialog box appears. Refer to Figure 3-3.

 2. Click the Organizer button.

  The Organizer dialog box, shown in Figure 3-6, appears.

 

Figure 3-6: 
The 
Organizer 
dialog box.

 

 3. (Optional) If you want to copy styles to a template other than Normal.
dotm, click the right Close File button, click the Open File button, 
select the template file, and click Open.

 4. Choose the styles you want to copy in the left style list (the In list box).

  To choose several styles, hold down the Ctrl key while clicking style 
names. To choose a block of styles, click the first style in the block and 
then hold down the Shift key and click the last style.

 5. Click the Copy button.

  The styles copy from the document to the template.

 6. Click the Close button.

 

The Organizer dialog box is a helpful beast:

 ✦ You can copy styles from either list in the Organizer dialog box. If you 
select styles in the right box, the In and To designations switch and the 
arrows on the Copy button change to indicate that styles copy from the 
right list to the left list.

 ✦ To move styles from the current document to Normal.dotm, skip Step 3 
in the preceding step list.
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51Using the Organizer

 ✦ Click the down arrow next to the Styles Available In list box on the left 
side of the Organizer dialog box to reveal a list of style sources that 
includes the current document, the attached template, and Normal.
dotm. To move styles from the attached template to Normal.dotm, 
select the template from the Styles Available In list.

 

✦ You can also use the Organizer to delete or rename styles. To delete 
styles, select them in either the left or right list; then click the Delete 
button. If you’ve been good, Word asks for confirmation before it deletes 
the styles. To rename a style, select it and click the Rename button. 
When Word asks for a new name, start typing. (Notice that you can 
rename only one style at a time.)
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Chapter 4: Printing 
Your Documents

In This Chapter
✓ Printing a document

✓ Playing with print options

✓ Previewing your output

The Print command. The Printmeister. Big document comin’ up. Printin’ 
some pages. The Printorama. The Mentor of de Printor. Captain Toner 

of the Good Ship Laseroo.

Don’t worry — when you print a Word document, no one’s waiting to ambush 
you with annoying nicknames such as the ones doled out by Rich the copy 
guy in the old Saturday Night Live skit. You see just a handful of boring dialog 
boxes with boring check boxes. Point-point, click-click, print-print.

 

Note that many printing features described in this chapter — such as col-
lating or scaling — duplicate features provided directly by some printers. 
If your printer has a feature that duplicates a feature in Word, you should 
almost always use your printer’s feature rather than Word’s. That’s because 
your printer can provide these features more efficiently than Word can. To 
find out which features your printer has, click the Printer Properties link on 
the Print page in Backstage view.

Printing the Quick Way
Back in the good old days, before Microsoft replaced menus and toolbars 
with the Ribbon, a handy Print button lived right on the Standard toolbar. It 
was the quickest way to print a single copy of your document on your favor-
ite printer.

Now that the menus and toolbars of old have been supplanted by the 
Ribbon, you can’t find a handy Print button sitting in plain view. But wait! 
A Print button is lying in wait on the Customize menu of the Quick Access 
toolbar, waiting for you to bring it to the top. I suggest that you do so imme-
diately, by following these steps:
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54 Printing from Backstage View

 1. Click the Customize Quick Access Toolbar button, on the far right end 
of the Quick Access toolbar.

  This step reveals a menu of commonly used commands.

  2. Click the Quick Print button, shown in the margin.

   This step adds the Quick Print button to your Quick Access toolbar.

Now the Quick Access toolbar contains the Quick Print button, which prints 
your document using the current print settings and which I explain in the 
remaining sections of this chapter. Usually, this action results in printing a 
single copy of every page in your document. But if you alter print settings, 
clicking the Quick Print button uses the altered settings automatically.

Printing from Backstage View
For precise control over how your document prints, you must conjure up 
the Print page in Backstage view, as shown in Figure 4-1. To summon this 
page, choose File➪Print or press Ctrl+P.

 

Figure 4-1: 
The Print 
page in 
Backstage 
view.
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55Printing from Backstage View

After you call up the Print page, click the big Print button to print a single 
copy of your entire document. Fiddle with the settings to print just certain 
pages, to print more than one copy, or to change other aspects of how your 
document prints. This section shows you the treasures that lie hidden in 
this page.

 

Printing can be es-el-oh-double-you, so don’t panic if your document doesn’t 
start printing right away. Word printouts sometimes demand a great deal 
from the printer, so the printer may have to work for a while before it can 
produce a finished page. Be patient. The Print page has every intention of 
granting your request.

Changing printers
If you’re lucky enough to have two or more printers at your disposal, you 
can use the Printer drop-down list on the Print page of Backstage view to 
pick which printer you want to use. (Click the current printer’s name under 
the Printer heading to see the list.) You must first successfully install each 
printer in Windows — a topic beyond the reach of this humble book but one 
that you can find plenty of information about in the appropriate version of 
Andy Rathbone’s Windows For Dummies.

Printing more than one copy
The Copies box on the Print page lets you print more than one copy of your 
document. You can click one of the arrows next to this field to increase or 
decrease the number of copies, or you can type directly in the box to specify 
the number of copies.

A ways down the Print page is the Collate setting, which lets you choose 
between collated and uncollated printing. If you chose collated printing (the 
default setting), Word prints each copy of your document one at a time. In 
other words, if your document consists of ten pages and you select three 
copies and select collated printing, Word first prints all ten pages of the 
first copy of the document, and then all ten pages of the second copy, and 
then all ten pages of the third copy. If you choose uncollated printing, Word 
prints three copies of the first page, followed by three copies of the second 
page, followed by three copies of the third page, and so on.

 

The Collated option saves you from the chore of manually sorting your 
copies. If your document takes forever to print because it’s laden with 
heavy-duty graphics, however, you can probably save time in the long run 
by using uncollated printing. Why? Because many printers are fast when 
printing a second or third copy of a page. The printer may spend ten min-
utes determining how to print a particularly complicated page, but after it 
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figures it out, the printer can print additional copies in ten seconds each. If 
you print collated copies, the printer must labor over each page separately 
for each copy of the document that it prints.

Printing part of a document
The Print All Pages drop-down list lets you choose how much of (or what 
part of) your document you want to print. When you first access the Print 
page in Backstage view, the Print All Pages option is selected so that your 
entire document prints. You use the other options in the Print All Pages 
drop-down list, as well as the Pages box just below it, to tell Word to print 
distinct portions of your document:

 ✦ Print Selection: Print just the portion of the document you selected 
before entering Backstage view. First, select the pages you want to print. 
Then choose File➪Print, select Print Selection from the Print All Pages 
drop-down list, and click Print.

 ✦ Print Current Page: Print just the current page. Before you display the 
Print page, move to the page in your document that you want to print. 
Then select this option in the Print page of Backstage view and click 
Print. This option is handy when you make a change to one page and 
don’t want to reprint the entire document.

 ✦ Print Range: Select specific pages for printing. You can print a range 
of pages by typing the beginning and ending page numbers, separated 
by a hyphen, as in 5-8 to print pages 5, 6, 7, and 8. Or, you can list indi-
vidual pages, separated by commas, as in 4,8,11 to print pages 4, 8, and 
11. And, you can combine ranges and individual pages, as in 4,9-11,13 to 
print pages 4, 9, 10, 11, and 13. Use the Pages box to specify the pages 
you want to print. Entering page numbers in the Pages box automatically 
changes the drop-down list setting to Print Range if it wasn’t already so.

 ✦ Document Properties: Print information about your document.

 ✦ List of Markup: Print a list of revisions made to the document.

 ✦ Styles: Print the styles in the document.

 ✦ AutoText Entries: Print any AutoText entries in the document.

 ✦ Key Assignments: Print any custom shortcut keys that are assigned.

 ✦ Print Markup: You can enable the Track Changes feature and then use 
this option to print your document along with any revision marks.

 ✦ Only Print Odd Pages: Print pages 1, 3, 5, and so on.

 ✦ Only Print Even Pages: Print pages 2, 4, 6, and so on.
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57Printing from Backstage View

Select the type of output you want to print and then click Print or press 
Enter. Off you go!

Other settings
The Print page of Backstage view has several other options worth 
considering:

 ✦ Print One Sided: Most printers print on only one side of the paper. This 
option lets you manually print on both sides of the paper, if you want. If 
you choose to print manually on both sides of the paper, Word prompts 
you to reinsert each page to print the next page on its backside.

 ✦ Collated: As described earlier in this chapter, this option is useful when 
printing multiple copies of a document.

 ✦ Portrait Orientation: Portrait orientation refers to printing on the paper 
so that the longest side of the paper is the height and the shorter side is 
the width. Landscape orientation flips the page so that the long side is 
the width and the short side is the height.

 ✦ Letter: Change the paper size. The default is usually Letter (8.5 x 11), but 
you can select different paper sizes.

 ✦ Margins: You can change the margin settings from the Print page.

 ✦ 1 Page Per Sheet: Print more than one page on each sheet of paper. 
This option is especially useful for creating quick proof pages to ensure 
that your document is laid out properly. This option is also useful if 
your document consists mostly of large text that’s still readable when 
reduced 50 percent or more. You can also select Scale to Paper Size to 
adjust the size of the printed output to fit the paper in the printer.

 ✦ Page Setup: This unobtrusive hyperlink near the bottom of the page 
opens the Page Setup dialog box, from which you can adjust the docu-
ment margins again before you print.

Playing with print options
Several options that affect printing are found in the Options dialog box, 
which you can reach from Backstage view by clicking the Options button. 
Printing options are on both the Display tab and the Advanced tab of the 
Options dialog box.

Figure 4-2 shows the Display tab of the Options dialog box, which contains a 
section of printing options.

08_487662-bk01ch04.indd   5708_487662-bk01ch04.indd   57 4/15/10   8:32 PM4/15/10   8:32 PM



58 Printing from Backstage View

 

Figure 4-2: 
The basic 
print 
options.

 

The following options are listed in the Printing Options section of the 
Display tab:

 ✦ Print Drawings Created in Word: Prints drawing objects.

 ✦ Print Background Colors and Images: Prints background colors and 
images. These options are disabled by default because using colored 
paper is easier and cheaper than printing color backgrounds.

 ✦ Print Document Properties: Prints document properties on a separate 
page following the document.

 ✦ Print Hidden Text: Prints all hidden text.

 ✦ Update Fields Before Printing: Updates all document fields before print-
ing the document.

 ✦ Update Linked Data Before Printing: Updates any linked information in 
the document before printing it.

You can find additional printing options in the Print and When Printing This 
Document sections of the Advanced tab in the Word Options dialog box, 
shown in Figure 4-3.
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59Printing from Backstage View

 

Figure 4-3: 
Advanced 
printing 
options.

 

The following list describes what you can do by using the options you can 
find in the Print section of the Advanced tab:

 ✦ Use Draft Quality: Prints the document in draft format with little format-
ting. This option might result in slightly faster printing. But if you’re 
concerned with print speed, I recommend that you use your printer’s 
built-in draft mode instead. Most ink-jet printers have a draft mode 
feature that prints dramatically faster than normal mode. You can find 
this option by clicking the Printer Properties link on the Print page in 
Backstage view.

 ✦ Print in Background: Prints documents in the background so that you 
can continue working while the document prints. This option is acti-
vated by default, so you don’t need to worry about it. If you turn off this 
option, Word refuses to do anything else while it’s printing.

 ✦ Print in Reverse Order: Prints the document backward, starting with 
the last page in your document. This option is useful for printers that 
stack pages backward in the output tray. By printing the document back-
ward, the pages stack in the correct order.

 ✦ Print XML Tags: Prints any XML tags in the document.

 ✦ Print Field Codes Instead of Their Values: Prints field codes rather than 
field results. Use this option only if your document is filled with fields 
and you’re trying to figure out why they aren’t working right.
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60 Using the Print Preview Feature

 ✦ Allow Fields Containing Tracked Changes to Update before Printing: 
Allows fields to be updated before printing. If you’re using revision 
marks to track changes and have changed the content of a field, you 
might want to show the new value in that field rather than in the old 
(tracked) one. 

 ✦ Print on Front of the Sheet for Duplex Printing: Sets the order of pages 
on the front of each sheet. Normally, the odd-numbered pages are 
printed in order at the top of each page. Select this option to reverse the 
print order of the odd-numbered pages.

 ✦ Print on Back of the Sheet for Duplex Printing: Reverses the print 
order of even-numbered pages. Normally, even-numbered pages are 
printed in order on the back of each page. 

 ✦ Scale Content for A4 or 8.5 x 11” Paper Size: Automatically adjusts 
your document to fit the paper size.

 ✦ Default Tray: Tells the printer to use its default tray.

You can also find two options listed in the When Printing This Document 
section:

 ✦ Print PostScript Over Text: An option that’s important only if you’re 
converting documents from Macintosh Word format.

 ✦ Print Only the Data From a Form: Prints the data entered into a form 
but not the form itself.

Using the Print Preview Feature
The Print Preview feature lets you see how your pages will appear before 
committing them to paper. To use the Print Preview feature, just choose the 
File➪Print command. Your previewed pages display on the Print page of 
Backstage view. Refer to Figure 4-1 if you don’t believe me.

Beneath the print preview area are a couple of controls for manipulating the 
preview. Specifically, you find a set of navigation controls that let you scroll 
forward or backward through the document one page at a time. And you find 
a zoom control that lets you zoom in to see more detail or zoom out to see 
the big picture.

Note that if you zoom out far enough, Word displays multiple pages in the 
preview area. For example, Figure 4-4 shows a print preview of this chapter 
zoomed out far enough to see all ten of its pages.
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61Using the Print Preview Feature

 

Figure 4-4: 
The Print 
Preview 
feature 
can show 
multiple 
pages at a 
time.
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Chapter 5: Help!

In This Chapter
✓ Accessing help

✓ Finding help that holds your hand

✓ Searching for specific help topics

✓ Getting help on the Internet

The ideal way to use Word is to have an expert sit patiently at your side 
and answer your every question with a straightforward answer, gently 

correcting you when you make silly mistakes and otherwise minding his 
own business. All you have to do is occasionally toss the expert a Twinkie 
and let him go outside once a day.

Short of that, the next best method is to find out how to coax Word itself 
into giving you the answers you need. Fortunately, Word includes a nice 
built-in help feature that can provide the answers you’re looking for. No 
matter how deeply you’re lost in the Word jungle, help is never more than a 
few clicks or keystrokes away.

Several Ways to Get Help
As with everything else in Office, more than one method is available for call-
ing up help when you need it. The easiest thing to do is yell “Ski-i-pper!” in 
your best Gilligan voice. Otherwise, you have these options:

 ✦ Press F1 at any time. If you press F1 when you’re in the midst of doing 
something, odds are good that Word offers suggestions for help with 
just the task you’re trying to accomplish. This slick little bit of wizardry 
is its context-sensitive help.

 ✦ Click the Help button located just above the right edge of the Ribbon. 
This action activates Word’s main Help system, shown in Figure 5-1.

 ✦ Click the question mark button in the upper-right corner of any dialog 
box. You receive help that’s specific to the dialog box.
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Figure 5-1: 
Help!

 

 ✦ Hover the cursor over an item on the Ribbon. A ScreenTip bubble 
appears and explains what the item does. Many ScreenTips include the 
phrase “Press F1 for more help.” In that case, you can press F1 to find 
help specifically about that item.

 ✦ Choose File➪Help. This command opens a page in Backstage view from 
which you can access the main Help system (by clicking Microsoft Office 
Help), find product support options, and more.

Finding Your Way around the Help System
The Word Help window (refer to Figure 5-1) offers several ways to access the 
help you need. The following list describes the various ways you can work 
your way through Word’s Help feature:

 ✦ Word Help window links: You can click any links that appear in the 
Word Help window to display help on a particular topic. For example, 
if you click the Getting Started with Word 2010 link, you find a page of 
useful information about the basic features of Word 2010.
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  ✦ Show Table of Contents button: You can click the Show Table of 
Contents button (shown in the margin) to display the table of contents, 
which gives you an organized overview of the various help topics. (See 
Figure 5-2.) You can then use the table of contents to access specific 
topic pages.

 

Figure 5-2: 
Displaying 
the table of 
contents.

 

 ✦ Search feature: If you can’t find what you’re looking for, try entering a 
word or phrase in the Search text box and clicking the Search button. A 
list of topics pertaining to the word or phrase you entered appears. For 
example, Figure 5-3 shows the results of a search for the word save.

 ✦ Pushpin icon: By default, the Help window is always displayed on top 
of other windows. In many cases, this “helpful” feature obscures your 
access to the Word window. If you don’t want the Help window to 
always stay on top, you can click the pushpin icon. Then the Word Help 
window minimizes like any other window.

 ✦ Back button: You can retrace your steps by clicking the Word Help win-
dow’s Back button. You can use the Back button repeatedly, retracing 
all your steps if necessary.

 ✦ Forward button: If you have used the Back button, you can then use the 
Forward button to return to where you were before you clicked Back.
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Figure 5-3: 
Search 
results.

 

Getting Help on the Internet
When you access the Help system in Word while your computer has an 
active Internet connection, Help information is automatically pulled in from 
the Web, with no extra effort on your part. Just enjoy it. Even more infor-
mation about Word is available from the Microsoft Web site at http://
office.microsoft.com. Point your Web browser to the site and explore.

Word itself also has some links and pointers to specific online content and 
services. Check out some of them at your leisure:

 ✦ Check for Updates: Choose File➪Help➪Check for Updates to allow Word 
to use Windows Update on your system (if you’re using Windows Vista 
or Windows 7) to look for updates to Office. If you’re using Windows XP, 
this command points you to a Web page that helps you locate and install 
Word updates.

 ✦ Get Training: Choose File➪Help➪Getting Started to open a Web page 
containing basic information about Word. From there, click the Microsoft 
Office Training link to access training videos and courses online.

 ✦ Contact Microsoft. Choose File➪Help➪Contact Us to open a Web page 
listing ways to contact Microsoft for product support.
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Chapter 1: Getting Around 
in Your Documents

In This Chapter
✓ Moving the insertion point

✓ Navigating a document

✓ Returning to your last edit

✓ Browsing with the Navigation pane

Maybe you remember the Beach Boys tune “I Get Around.” If you do, 
it’s probably stuck in your head now that I’ve mentioned it, so you 

can sing it to yourself as you read this chapter and find out the many ways 
you can zip from one part of your document to another.

The Most Basic Way to Move Around in a Document
The most basic way to move around a document is to press the arrow keys 
to move the insertion point one character at a time. The four arrow keys 
move the insertion point as listed here:

Keystroke Where the Insertion Point Moves

← Back one character

→ Forward one character

↑ Up one line

↓ Down one line

Admittedly, one character at a time can be a tedious mode of transporta-
tion when dealing with a content-heavy document. To speed things up, hold 
down the Ctrl key while pressing an arrow key, which moves the insertion 
point as described here:

Key Combo Where the Insertion Point Moves

Ctrl+← To the previous word

Ctrl+→ To the next word

Ctrl+↑ To the start of the previous paragraph

Ctrl+↓ To the start of the next paragraph
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70 Using the Scroll Bar

To take even bigger leaps over the useful information you have entered in 
your document, use the following additional navigation keys, generally found 
above the arrow keys on your keyboard:

Key or Key Combination Where the Insertion Point Moves

PageUp To the previous screen

PageDown To the next screen

Home To the beginning of the current line

End To the end of the current line

Ctrl+PageUp To the previous browse object

Ctrl+PageDown To the next browse object

Ctrl+Home To the beginning of the document

Ctrl+End To the end of the document

If you’re confused by the Ctrl+PageUp and Ctrl+PageDown shortcuts, join the 
club. These keys work differently depending on the browse object you’ve 
selected for use with Word’s Go To feature. For more information, see the 
section “Just Browsing,” later in this chapter, where I help you a bit more 
with that topic.

Using the Scroll Bar
If you’ve ever used a Windows program, you’re certainly acquainted with the 
scroll bar. The scroll bar in Word is the same all over again. Here are a few 
things you can do with the scroll bar:

 ✦ Click the arrow buttons at the top or bottom of the scroll bar to scroll 
the document up or down. The document continues scrolling as long as 
you hold down the button.

 ✦ Drag the scroll box (sometimes called the thumb) to scroll the document 
up or down. As you drag the scroll box, a balloon appears, indicating the 
current page number as well as textual information such as the current 
heading.

 ✦ Click the scroll bar above or below the scroll box to scroll up or down 
one screen at a time. Pressing PageUp or PageDown does the same 
thing.

 ✦ Just below the scroll bar is the browse control. This set of three buttons 
consists of a double arrow pointing up, a button that looks like a marble, 
and a double arrow pointed down. The browse control isn’t part of the 
scroll bar, but you can use it for navigation. For more information, see 
the section “Just Browsing,” later in this chapter.
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71Using the Go To Command

 ✦ The horizontal scroll bar appears toward the bottom of the screen 
when, for whatever reason, the screen can’t display the entire width of 
the document (for example, when the document is at a high zoom level 
or the Clipboard or Research pane is open). Nonetheless, you won’t use 
the horizontal scroll bar much, except perhaps when you’re working 
with Word’s drawing features.

Rolling Around with the Mouse Wheel
Most mice have a cool little wheel between the mouse buttons. You can roll 
the wheel forward or backward or click it as though it were a third mouse 
button. Word supports these functions in the mouse wheel control:

 ✦ Scroll your document by rolling its wheel, which is equivalent to clicking 
the up- or down-arrow buttons in the scroll bar.

 ✦ Pan the document by pressing and holding the wheel and then drag-
ging the mouse up or down. When you do so, the document scrolls in 
the direction you slide the mouse. The farther you drag the mouse, the 
faster the document scrolls.

 ✦ Autoscroll the document by clicking the mouse wheel once and then 
moving the mouse slightly. The document starts to slowly scroll down 
and continues to scroll down until you click any mouse button (includ-
ing the wheel) or press any key. (As with panning, you can increase the 
speed of autoscrolling by dragging the mouse. The farther you drag the 
mouse, the faster the document scrolls. You can also reverse the auto-
scroll direction by dragging the mouse up.)

 

✦ You can zoom in or out by holding down the Ctrl key while rotating the 
mouse wheel. For fun, hold down the Ctrl key and roll the mouse wheel 
back and forth to watch your document zoom in and out.

Using the Go To Command
Don’t need directions and just want to get there? The Go To command 
allows you to move where you want when you want. Ironically, you have 
several ways to find the Go To command:

 ✦ Click the Find button arrow in the Editing group of the Home tab. Then 
select Go To.

 ✦ Press F5.

 ✦ Press Ctrl+G.

The Find and Replace dialog box (more on this topic in Chapter 4 of this 
minibook) appears with the Go To tab selected, as shown in Figure 1-1.
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Figure 1-1: 
The Go To 
tab of the 
Find and 
Replace 
dialog box.

 

In the Go to What list box, the Page option is automatically selected because 
it’s the most common use of this feature. Simply type the page number in the 
Enter Page Number text box and click Go To (the Next button changes to a 
Go To button the moment you type a page number) or press Enter. Click the 
Close button or press Esc to dismiss the Find and Replace dialog box.

 

Besides going to a specific page, you can go forward or backward a cer-
tain number of pages. To go forward, type a plus sign (+) in the Enter Page 
Number text box followed by the number of pages you want to skip. For 
example, to go 3 pages forward, type +3. To go backward, type a minus sign 
(–) rather than a plus sign. For example, type -20 to go backward 20 pages.

In addition to going to a specific page, the Go To command enables you to go 
to a particular section or line or any of several types of goodies that might 
reside in your document, such as bookmarks, annotations, and footnotes. To 
go to something other than a page, just change the setting in the Go to What 
list box.

Just Browsing
Just below the vertical scroll bar is a set of three buttons that comprise 
the browse control. Normally, you use the top and bottom double arrows to 
scroll through your document one page at a time. However, by using the cir-
cular Select Browse Object button in the middle, you can train those arrows 
to do your bidding.

Clicking the Select Browse Object button (or pressing Alt+Ctrl+Home) opens 
the Browse menu, shown in Figure 1-2.

 

Figure 1-2: 
The Select 
Browse 
Object 
menu.
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73Just Browsing

The first two buttons on the second row of this menu invoke the familiar Go 
To and Find commands. The ten remaining buttons change the unit by which 
Word browses the document when you click the double-up or double-down 
arrow control. Table 1-1 describes the function of each of the 12 buttons on 
the Browse menu.

Table 1-1 Options on the Select Browse Object Menu

Button What It Does

Browse by page

Browse by section

Browse by comment

Browse by footnote

Browse by endnote

Browse by fields

Browse by table

Browse by graphic

Browse by heading (as indicated by standard heading styles)

Browse by edits (works in conjunction with revision tracking)

Find

Go To
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Going Back. . . .
I can’t tell you how many times I’ve pressed Ctrl+Z (Undo) to try to undo the 
effect of an errant navigation command. For example, I accidentally press 
Ctrl+End and find myself at the end of the document. Then I press Ctrl+Z, 
thinking that it takes me back to where I was. Unfortunately, Undo doesn’t 
apply to navigation commands. So what happens instead is that the last 
editing operation I did gets undone. Sure, you can correct your mistake by 
pressing Ctrl+Y, the magic Redo command, to reinstate the editing undone 
by your inadvertent use of Ctrl+Z. But there’s a better way.

The Go Back command is a little-known command that isn’t accessible 
from the Ribbon. You can access this command only by using its keyboard 
shortcut, Shift+F5. Word remembers the last five revisions you made in your 
document, and each press of Shift+F5 returns the insertion point to one of 
those previous locations. So if you inadvertently use or misuse one of the 
navigation commands presented in this chapter and find yourself where you 
don’t want to be, press Shift+F5 to go back to where you were.

 

When you first open a previously saved document, pressing Shift+F5 takes 
you to the location you were working on when the document was last 
closed. That’s a useful piece of computing!

Using Bookmarks
A bookmark identifies a location or a selection of text that you name so that 
you can call on it as you would your faithful pup.

To create a bookmark, follow these steps:

 1. Select the text or item to which you want to assign the bookmark.

  You can select a specific point or a selection of text.

 2. On the Insert tab in the Links group, click the Bookmark button or 
press Ctrl+Shift+F5.

  This step opens the Bookmark dialog box, shown in Figure 1-3.

 3. Enter a name for your selection in the Bookmark Name text box.

  Bookmark names can contain letters and numbers, but they must begin 
with a letter. No spaces or special characters are allowed. Use an under-
score (_) to separate words in the bookmark name. If you try to use 
inappropriate characters, Word keeps the Add button grayed out until 
you change your wayward ways.

 4. Click Add.

  The Bookmark dialog box closes.
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75Using the Navigation Pane

 

Figure 1-3: 
The 
Bookmark 
dialog box.

 

To return to a place you have bookmarked, simply reopen the Bookmark 
dialog box by using a method from Step 2, select the location you want to 
travel to, and press Enter or click the Go To button. Note that you can sort 
the Bookmark Name list by name or location by using the Sort By radio 
buttons.

 

You can also use the Go To dialog box to find a bookmark. Open the dialog 
box by clicking the Select Browse Object button or by pressing Ctrl+G. In the 
Enter Page Number text box, type the name of the bookmark. You don’t even 
need to change the Go to What option; Word is smart enough to figure out 
that you’re looking for a bookmark.

Deleting a bookmark is as simple as opening the Bookmark dialog box, 
selecting the bookmark to be deleted in the Bookmark Name list box, and 
clicking the Delete button. Note: You cannot undo this action.

Using the Navigation Pane
When you’re working with a document that has a lot of headings, the 
Navigation pane is a quick way to navigate. Use this feature to move from 
heading to heading at a click of the mouse button.

To open the Navigation pane, select the Navigation Pane check box in the 
Show group on the View tab. As you can see in Figure 1-4, a separate pane 
opens to the left of the document’s text with a list of all the headings. Simply 
click the heading you want to work with to have your insertion point moved 
there.

When you’re done with the pane, you can close it by clicking the Close box 
in the upper-right corner of the pane or by deselecting the Navigation Pane 
check box in the Show group on the View tab.
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Figure 1-4: 
The 
Navigation 
pane.

 

Using Thumbnails
Thumbnails are most useful when you’re using graphics to navigate your way. 
To see the thumbnails, select the Navigation Pane check box in the Show 
group on the View tab and then click the middle tab in the Navigation pane.

As you can see in Figure 1-5, thumbnails are small images of the pages in a 
document. You can click any thumbnail to open that page. If the document 
has more than just a few pages, a scroll bar appears in the Navigation pane 
so that you can scroll through the thumbnails.

 

Figure 1-5: 
Thumbnails.
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Chapter 2: Basic Text Formatting

In This Chapter
✓ Fiddling with fonts

✓ Playing with paragraphs

✓ Typing with tabs

Word offers an unbelievable number of formatting options and some 
nifty new features to help your document appear shiny, new, and 

attractive. When a document looks nice, people are more inclined to assume 
that the information contained within is accurate and smart. (Unfortunately, 
sometimes looks can be deceiving.) So, to keep you from presenting a docu-
ment that looks like your dog ate it, use the formatting techniques and tricks 
in this chapter.

Understanding Formatting
Digging right in, you can format these three basic elements:

 ✦ Character: The smallest element you can format in Word. You can make 
a character bold, italic, or underlined; change its font size; and more. 
If you’re deranged, you can format every character of your document 
differently. Doing so gives your documents a ransom note appearance, 
which is probably something to avoid.

 ✦ Paragraph: The next biggest element you can format in Word. You can 
format each paragraph so that it has its own tab stops, line spacing, 
extra space before or after the paragraph, indentation, alignment (left, 
right, centered, or justified), and more. Every paragraph in Word has a 
paragraph style, which includes some character formatting. So the only 
time you need to apply a character format is when you want characters 
to vary from the paragraph’s default character format, such as when 
you italicize or bold a word.

 ✦ Section: Word also enables you to control the layout of sections. You 
can format each page by setting its top, bottom, left, and right margins, 
specifying the number of columns and their sizes, picking a paper size, 
controlling the placement of headers and footers, and more. You can 
format your document so that all pages have the same layout, or you 
can divide your document into sections, each with a different page 
layout. That’s why Word refers to these formats as section formats.
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78 Understanding Formatting

You have not only numerous formatting options to apply but also various 
ways to apply them. You can use the tools in the Font and Paragraph groups 
on the Home tab on the Ribbon or on the Mini toolbar or by using keyboard 
shortcuts. And, if you still can’t find what you’re looking for, you can open 
the Font dialog box.

You can apply formatting either before or after you type the text you want to 
format. To apply formatting before you type the text, follow these steps:

 1. Type text to the point where you want to apply a format.

 2. Turn on the special character formatting by using one of the keyboard 
shortcuts or the buttons on the Ribbon listed in Table 2-1.

 3. Type away.

  Any text you type now assumes the format you applied in Step 2.

 4. After you type all the text that needs special formatting, use the same 
Ribbon button or keyboard shortcut you used in Step 2 to turn off the 
formatting.

  That way, you can continue typing the rest of your document using 
normal formatting.

Table 2-1 Character Formatting the Easy Way

Toolbar Button Keyboard Shortcut What It Does

Ctrl+B Applies bold

Ctrl+I Applies italic

If you use more than one page layout in a docu-
ment, the document is divided into two or more 
sections. Each section except the last one ends 
with a section break, displayed as a double 
line that spans the width of the page. Section 
breaks work much like paragraph marks: If you 
delete one, the text before the section break 
assumes the page layout of the section follow-
ing the break.

Every document has at least one section, but 
you see section breaks only if you divide the 
document into two or more sections. Where’s 
the section break for the last section of a docu-
ment? The document has none. The formatting 
information for the last section of a document 
is stored in the last paragraph mark in the 
document.

A word about sections
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79Understanding Formatting

Toolbar Button Keyboard Shortcut What It Does

Ctrl+U

Ctrl+Shift+W

Ctrl+Shift+D

Applies underline (continuous)

Applies Word underline

Applies double underline

Ctrl+Shift+A

Ctrl+Shift+K

Shift+F3

Changes to all caps

Changes to small caps

Toggles case

Ctrl+= Applies subscript

Ctrl+Shift+= Applies superscript

Ctrl+Shift+F Changes font

Ctrl+Shift+P

Ctrl+]

Ctrl+[

Changes point size

Increases size one point

Decreases size one point

Ctrl+Shift+> Increases size to next available 
size

Ctrl+Shift+<

Ctrl+Shift+Q

Decreases size to previous 
available size

Switches to Symbol font

Ctrl+Shift+Z or 
Ctrl+spacebar

Removes character formatting

To apply a character format to text you already typed, follow these steps:

 1. Highlight the text you want to format.

  To highlight a single word, double-click anywhere in the word. To high-
light an entire paragraph, triple-click anywhere in the paragraph. If you 
want to make a specific selection that doesn’t fall into one of those two 
categories, highlight the text you want to format by clicking and drag-
ging the mouse over it or by using the arrow keys to move the insertion 
point while holding down the Shift key.

 

 If you enabled Word’s Automatic Word Selection option, you don’t have 
to double-click to select a word; Word automatically applies a formatting 
change to the entire word if the insertion point is anywhere in the word. 
To activate this option (or to deactivate it if it’s already activated), 
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80 Formatting Text

choose File➪Options to open the Word Options dialog box. Select 
the Advanced tab and then, under Editing Options, select the When 
Selecting, Automatically Select Entire Word check box. Click OK or press 
Enter to close the Word Options dialog box.

 2. Apply the format by using one of the keyboard shortcuts or buttons 
(refer toTable 2-1).

  The effects of your formatting are immediately apparent.

 3. That is all.

  Disperse. There’s nothing more to see here. Return to your homes.

Here are some other tidbits on character formatting:

 ✦ You can gang-tackle text with formats, if you want. For example, you can 
format text as bold italic double-underlined if you’re truly desperate 
for attention. (Can you hear the applause?)

  ✦ To remove all character formatting, highlight the text that you want to 
restore to normal. Then select the Clear Formatting button in the Font 
group of the Home tab on the Ribbon or press Ctrl+spacebar.

 ✦ To remove a specific character format, such as bold or italic, but leave 
other character formats intact, highlight the text and press the keyboard 
shortcut or click the button on the Ribbon for the format you want to 
remove.

Formatting Text
The following sections show you how to apply various formats to charac-
ters. The easiest way is to use keyboard shortcuts (if you can remember 
them) or the various tools in the Font group on the Home tab on the Ribbon. 
Table 2-1, earlier in this chapter, is an overview of the Font group and those 
handy keyboard commands.

Setting the font and size
Okay, so you know you want to see your name in Goudy Stout, 28 point, 
bold, italicized, double underlined, green font. I want to show you how to do 
just that, starting by setting that Goudy Stout font and size.

When you create a new document, Word automagically selects the Calibri 
size 11 font. Here’s how to change the font and size:

 1. Select the text you want to change, or if you just want to format one 
word, place the insertion somewhere in that word.
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81Formatting Text

 2. In the Font group on the Home tab on the Ribbon, select the Font 
drop-down list and scroll (or “arrow down” if you have time to burn) 
to Goudy Stout and click it.

  The Font drop-down list now shows Goudy Stout.

 

 Did you notice that when you pointed to different fonts in the Font 
drop-down list, the selected text in your document temporarily changed 
to that font? This nifty feature, Live Preview, is a fun way to see what 
your text will look like with different fonts before you apply the font. Go 
ahead — I know you want to play with this feature.

  Note that the drop-down list is divided into sections: Theme Fonts, 
Recently Used Fonts, and All Fonts. If you regularly need to swap 
between fonts, don’t waste time scrolling to search — just check the 
Recently Used Fonts section.

 3. Select the Font Size drop-down list (next to the Font drop-down list) 
and then select 28, or select the text box and type 28.

  Yes, Live Preview is at work again. I’m waiting. Go play.

 

If you want only to increase the font size, you can click the Grow Font button 
to the right of the Font Size drop-down list. Use the Shrink Font button next 
to it to, well, shrink the font.

 

If you don’t particularly care for Calibri 11-point font, go ahead and change 
the default font for all new documents you create. Click the Font dialog box 
launcher in the lower-right corner of the Font group on the Home tab. Then, 
from the Font tab in the dialog box, select the options you want as part 
of your font and then click the Set As Default button. If you’re certain that 
you want to change your font, click Yes in the window that appears. You’re 
asked whether you want this change to affect all new documents, thereby 
changing the NORMAL template. Otherwise, click No or Cancel.

Applying bold, italics, and other goodies
In addition to the Font and Size controls, the Font group on the Home tab 
on the Ribbon also contains buttons you can use to apply special formatting 
like bold or italics to individual bits of text.

Along with the default options on the Ribbon mentioned previously, the Font 
dialog box has options to further modify text. Double Strikethrough, Shadow, 
Outline, Emboss, Engrave, and the mysterious Hidden are the remaining 
options.

You can open the Font dialog box by clicking the dialog box launcher in the 
Font group, in its lower-right corner.

12_487662-bk02ch02.indd   8112_487662-bk02ch02.indd   81 4/15/10   8:33 PM4/15/10   8:33 PM



82 Formatting Text

Using text effects
  The Text Effects button (shown in the margin) is the key to creating fancy 

logos, such as text that wraps around circles or text that has a three-dimen-
sional look. When you click this button, a menu with various text formatting 
options appears. That menu includes a gallery of predefined text effects, as 
well as the individual formatting options described in Table 2-2.

Table 2-2 Formatting Options on the Text Effects Menu

Control Name What It Does

Outline Sets text outline

Shadow Adds shadow text

Reflection Creates faint reflection on invisible surface 
beneath text

Glow Adds glowing effect to text

Clear Text Effects Removes text effects you have applied

Using the highlighter
Need to make something obvious? Afraid that Goudy Stout in green won’t 
hold the attention of your audience? Highlight the information this way:

 1. Click the Text Highlight Color button in the Font group on the Home 
tab on the Ribbon.

  You can select the drop-down list and choose from the color palette a 
color other than the standard yellow.

  The cursor becomes an insertion pointer with a marker slanted across it.

 2. Click and drag in the document to select and highlight.

  The mouse continues to act as a highlighter, enabling you to select mul-
tiple portions of text until you tell it to go away.

 3. Tell the highlighter to go away by clicking the drop-down list on the 
Text Highlight Color button and choosing Stop Highlighting.

To remove highlighting, select the text involved and then select No Color 
from the Text Highlight Color drop-down list.
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To avoid having the highlighter take over your mouse indefinitely, select the 
text you want highlighted before clicking the Text Highlight Color button.

Playing with text colors
The drop-down list attached to the Font Color button has two color palettes: 
Theme Colors and Standard Colors. (For a discussion of themes, see Chapter 3 
of this minibook.)

If none of those colors is quite what you’re looking for, select More Colors at 
the bottom to open the Colors dialog box. You then choose from two tabs: 
Standard and Custom. Simply select a color block somewhere in either of the 
color palettes and click OK.

Using the Font dialog box
The character formatting options you’re likely to use most often — bold, 
italics, underlining, font, and point size — are all readily accessible in the 
Font group on the Home tab on the Ribbon or by using keyboard shortcuts. 
Microsoft has now added some of the less often used options to the Ribbon, 
such as Strikethrough and Change Case. Follow the steps in this section if 
for some reason you need to apply another formatting option, such as one 
of these:

 ✦ Character spacing

 ✦ Double strikethrough

 ✦ Emboss

 ✦ Engrave

 ✦ Hidden

 ✦ Outline

 ✦ Shadow

To apply one of these formatting options, follow these steps:

 1. Highlight the text you want to format (or “to mangle with oddball for-
matting,” as I like to say).

 2. Open the Font dialog box by clicking the dialog box launcher in the 
lower-right corner of the Font group or by pressing Ctrl+D.

 3. Play with the options shown in Figure 2-1.

  Fiddle with the various controls to set the font, font style (bold or italic, 
for example), and size. Click the effects you want (strikethrough, super-
script). Use the drop-down lists to set the underline and color. (Live 
Preview can’t help you here.)
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 4. Click OK when you’ve had enough.

  The dialog box vanishes and your text magically transforms with the 
formats you selected.

 

Figure 2-1: 
The Font 
dialog box.

 

I have a few more tips for using the Font dialog box:

 ✦ If you haven’t yet typed the text you want to mangle, use the Font dialog 
box, select the formats you want, click OK, and then start typing. When 
you’re done, press Ctrl+spacebar to resume normal typing.

 ✦ Do you see the Advanced tab at the top of the Font dialog box? If you 
click the Advanced tab, you see options to control the spacing between 
characters, raise or lower characters from the baseline, and apply the 
spiffy desktop publishing feature named kerning. These options are in 
the realm of desktop publishing, so you can safely ignore them unless 
you’re self-publishing a Pulitzer Prize–winning novel.

 ✦ If you find that you frequently use a formatting option that doesn’t have 
a place on the Ribbon or a keyboard shortcut, you can create your own 
keyboard shortcut or add the icon to the Ribbon, which I describe in 
Book VIII, Chapter 1.

  To get rid of all formatting and return your content to its default settings, 
click the Clear Formatting button in the Font group on the Ribbon. The 
button looks like a piece of paper above a white eraser.
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Formatting Paragraphs
The Paragraph group on the Home tab on the Ribbon is shown in Figure 2-2 
and is your first ally in formatting paragraphs.

 

Figure 2-2: 
Paragraph 
group.  

To format a paragraph, first click anywhere in the paragraph you want to 
format. (Where you click in the paragraph doesn’t matter.) Then use one of 
the keyboard shortcuts or buttons on the Ribbon that I describe in the fol-
lowing sections. The effect of your formatting is immediately obvious.

 

To remove all paragraph formatting, press Ctrl+Q.

Justification
You can set the paragraph alignment to Align Left, Align Right, Center, or 
Justify by using the first four buttons at the bottom of the Paragraph group 
on the Home tab on the Ribbon. Table 2-3 shows the different ways you can 
align text using the Ribbon.

Table 2-3 Alignment Commands on the Ribbon

Toolbar Button Keyboard Shortcut Alignment

Ctrl+L Left

Ctrl+E Center

Ctrl+R Right

Ctrl+J Justify
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Line spacing
  In the Paragraph group on the Home tab on the Ribbon, you find the Line 

and Paragraph Spacing button, which you use to add space between the 
lines of text in a paragraph. By default, lines are single spaces, with slightly 
more than that amount below a paragraph. In the Line and Paragraph 
Spacing drop-down list (in the Paragraph group on the Home tab), you can 
select several options for the paragraph’s line spacing. The ones you use 
most are 1.0, 1.5, and 2.0. Click the dialog box launcher to open the 
Paragraph dialog box, where you can select one of these options from the 
Line Spacing drop-down list:

 ✦ At Least: Specify a minimum measurement for the line spacing, such as 
At Least 14 Points.

 ✦ Exactly: Set an exact measurement.

 ✦ Multiple: Set other amounts of line spacing, such as 3 Lines.

The following keyboard shortcuts can help you quickly format paragraph 
spacing:

Keyboard Shortcut Effect on Paragraph

Ctrl+1 Single-space

Ctrl+2 Double-space

Ctrl+5 1.5 line spacing

 A paragraph format is stored in the paragraph mark at the end of the para-
graph. Don’t make the mistake of spending hours polishing a paragraph’s 
appearance and then deleting the paragraph mark to merge the text into the 
following paragraph. If you do, you lose all the formatting you so carefully 
applied. (If that happens, quickly press Ctrl+Z to undo the deletion.)

Simple bullet and number lists
If you’re a lover of lists, I have good news and bad news. The good news is 
that I cover how to create bullet lists and number lists in this book! The bad 
news is that I don’t cover that topic in this chapter. Instead, make your way 
to Book III, Chapter 3. Then cross that task off your to-do list.

Indenting
Some publications require that you indent the first line of every paragraph. 
Others require that you indent all lines by moving them to the right — useful 
for nested paragraphs (a paragraph within a paragraph) or block quote (a 
quote that’s set off from the margins to give it more space on the sides). As 
with most formatting, your first line of defense is the Ribbon.

12_487662-bk02ch02.indd   8612_487662-bk02ch02.indd   86 4/15/10   8:33 PM4/15/10   8:33 PM



Book II

Chapter 2

B
a

sic
 T

e
x

t 
Fo

rm
a

ttin
g

87Formatting Paragraphs

  Place the insertion point somewhere in the paragraph you want nested and 
click the Increase Indent button in the Paragraph group on the Home tab. 
This button isn’t a toggle, so if you continue to click it, you increase the 
indent.

  Gone too far? To unindent an indented paragraph, use the Decrease Indent 
button.

To indent both sides of a paragraph, summon the Paragraph dialog box (by 
clicking the dialog box launcher in the lower-left corner of the Paragraph 
Group) and set the left and right indents to the same value.

You can have Word automatically indent the first line of every paragraph 
you type, rather than try to press the spacebar exactly eight times every 
time. Here’s how:

 1. Open the Paragraph dialog box by using the dialog box launcher in 
the Paragraph group on the Home tab on the Ribbon.

 2. In the Indentation area, select the First Line option from the Special 
drop-down list.

 3. (Optional) If you want, change the amount in the By box.

  The box automatically says 0.5” and can be changed by typing over the 
figure or using the spinner buttons to the right of the text.

 4. Click OK.

To indent everything except the first line of a paragraph, select Hanging 
Indent from the drop-down list in Step 2.

Sorting
You know how it is: You’re quickly dumping a list of information (which has 
turned into a 32-item list) when you realize how much easier it would be to 
work from if it were in alphabetical order. Fortunately, you can do that to a 
one-level bulleted or numbered list. Follow these steps:

  1. Place the insertion point somewhere in the list and click the Sort 
button in the Paragraph group on the Home tab on the Ribbon.

  This step opens the Sort Text dialog box, shown in Figure 2-3. When the 
dialog box opens, the first drop-down list under Sort By has Paragraphs 
selected and the Type drop-down list is set to Text — exactly what 
you’re trying to do.

 2. Select either the Ascending or Descending option.

 3. Click OK.
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Figure 2-3: 
The Sort 
Text dialog 
box.

 

You can also use the Sort Text dialog box to sort tables, which I discuss in 
Book IV, Chapter 4.

Paragraph marks
Paragraph formatting is contained with the paragraph mark at the end of the 
paragraph. The mark looks like a backward letter P. If you want to perma-
nently see the paragraph marks on your screen, follow these steps:

 1. Choose File➪Options to open the Word Options dialog box.

 2. Click the Display tab.

 3. Select the Paragraph Marks check box under the heading Always 
Show These Formatting Marks on the Screen.

 4. Click OK.

If you decide that you don’t want to see the paragraph marks, simply go 
back through the steps and deselect the check box.

  To see paragraph marks and all other hidden formatting symbols, use the 
Show/Hide button in the Paragraph group on the Home tab on the Ribbon. 
This button acts as a toggle switch, allowing you to display the symbols 
or not.

Background colors
The Shading tab in the Borders and Shading dialog box lets you apply shad-
ing to a paragraph or a selection of text. Shading is a useful way to draw 
attention to key parts of your document. For example, Figure 2-4 shows a 
document with a block of shaded text.
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89Formatting Paragraphs

 

Figure 2-4: 
A shaded 
paragraph.

 

To apply shading to your text, follow these steps:

 1. Select the text you want to shade.

  You can select individual characters, a single word or group of words, or 
a single paragraph or even a group of paragraphs.

  2. Click the drop-down list on the Shading button in the Paragraph group 
on the Home tab on the Ribbon.

  The color palette appears, as shown in Figure 2-5.

 

Figure 2-5: 
The Shading 
color 
palette.
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 3. Select the color you want to use to shade the text.

  Your text now has a box of that color behind it.

  If you’re picky and don’t find the color you like, you can click the More 
Colors option to open a dialog box that lists even more colors.

  Notice that the first three columns of the Theme Colors palette list vari-
ous shades of gray. The remaining columns list other theme colors. 
Standard colors are at the bottom.

Here are a few points to keep in mind when shading your text:

 ✦ Make sure that you can still read the shaded text. For darker shades, 
you might need to change the font color to keep the text readable. You 
can use the Font Color button in the Font section of the Home tab to 
do that.

 ✦ A common text effect creates white text on a black background. To do 
that, first use the Shading drop-down list in the Paragraph Group on 
the Home tab to set the background to black. Then use the Font Color 
button in the Font group on the Home tab to set the font color to white.

 ✦ You must have a color printer to print colors other than black or gray.

Borders
  The Paragraph group on the Home tab on the Ribbon has a handy Border 

button you can use to apply basic borders. You can click the button to apply 
the current border type to whatever text you select or click the arrow next 
to the button to reveal a palette of border types, as shown in Figure 2-6.

 

Figure 2-6: 
Palette 
of border 
types.

 

To draw a simple box around some text and choose a border, follow these 
simple steps:
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 1. Select the text you want to draw a border around.

  You can select individual characters, a single word, a group of words, a 
single paragraph, or even a group of paragraphs.

  If you don’t select any text, Word draws a border around the entire para-
graph that the insertion point happens to be sitting in. As a result, if you 
want to draw a box around an entire paragraph, just click anywhere in 
the paragraph and proceed to the next step.

 2. Click the down arrow on the Borders button in the Paragraph group 
in the Home tab on the Ribbon and select the Outside Borders option.

  The list disappears and your text is bordered.

 3. (Optional) To change the border’s style, color, or width, select the 
Borders and Shading option at the bottom of the Border buttons drop-
down list. Otherwise, skip to Step 5.

  This step opens the Borders tab in the Borders and Shading dialog box.

 4. Make your selections in the Borders and Shading dialog box.

 • In addition to the Box border style, the Borders and Shading dialog 
box, shown in Figure 2-7, offers two other preset border styles: 
Shadow and 3-D. You can experiment with these settings to see the 
effects they have.

 

Figure 2-7: 
The Borders 
and Shading 
dialog box.

 

 • You can build a custom border one line at a time by clicking the but-
tons around the various edges of the paragraphs represented in the 
Preview area to indicate where you want a border to appear. These 
buttons control whether a border appears above or below or to the 
left or right of the selection. If you select more than one paragraph, 
you also see a button that lets you add or remove lines between the 
paragraphs.
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 • The Style list lets you choose a fancy style for every line of the 
border. Various styles, such as double lines and dashed lines, are 
available. Note that you can change line styles as you apply indi-
vidual borders so that a paragraph can have a thin border at the top 
and a thick border at the bottom.

 • The Color drop-down list lets you specify the color for your border. 
You can select a standard or theme color that appears in the palette 
or click More Colors at the bottom of the palette to open a dialog box 
that lets you select any color you want.

 • The Width drop-down list lets you select a width for each segment of 
the border.

 5. Click OK.

By default, the borders are placed one point from the top and bottom and 
four points from the left and right of the text they surround. If that place-
ment is too tight for you, you can adjust it by clicking the Options button 
in the Borders and Shading dialog box. The Borders and Shading Options 
dialog box opens, as shown in Figure 2-8.

 

Figure 2-8: 
The Borders 
and Shading 
Options 
dialog box.

 

If you select more than one adjacent paragraph of text and format them 
by using one of the preset border styles, all the paragraphs are contained 
within a single box, as shown in Figure 2-9.

To box each paragraph separately, place an unboxed paragraph mark 
between each boxed paragraph by simply pressing Enter to add a blank line, 
as shown in Figure 2-10. These spacer paragraphs need not contain any text, 
and you might want to vary their Before or After spacing so that the boxed 
paragraphs are spaced the way you want.
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Figure 2-9: 
Paragraph 
borders.

 

 

Figure 2-10: 
Adjacent 
paragraphs 
showing the 
unboxed 
paragraph 
marker.
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94 Formatting Paragraphs

Keep these points in mind when playing around with borders:

 ✦ The Borders button applies borders to one or more edges of the selected 
text or paragraph. The Borders and Shading dialog box controls the style, 
color, and width of those borders. You have to summon the Borders 
and Shading dialog box by using the Borders and Shading option on the 
Borders drop-down list if you want to change those settings.

 ✦ Click the Borders button once to apply a border. To remove a border, 
click the Borders button again.

The Format Paragraph dialog box
If you find yourself in the unenviable pickle of needing to use a formatting 
option that isn’t on the Home tab and you can’t remember its keyboard short-
cut, you can always conjure up the Paragraph dialog box and pick and choose 
your paragraph formats from a palette of delightful formatting treasures.

Here’s the procedure for using the Paragraph dialog box:

 1. Click anywhere in the paragraph you want to format.

  Where you click in the paragraph doesn’t matter as long as the insertion 
point is somewhere in the paragraph.

 2. Click the dialog box launcher on the Paragraph tab on the Ribbon.

  The Paragraph dialog box appears, as shown in Figure 2-11.

 

Figure 2-11: 
The 
Paragraph 
dialog box.
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 3. Play with the controls.

  You can set the paragraph alignment (Left, Right, Centered, or Justified) 
from the Alignment drop-down list. You can increase the Left or Right 
Indentation or choose a First Line or Hanging indent style from the 
Special drop-down list. You can also increase or decrease the amount of 
spacing before and after the paragraph and set the line spacing.

  As you play with the controls, keep an eye on the Preview box to see the 
effect of your changes.

 4. Click OK when you’re done.

  Prest-o change-o! You’re done.

 

You can set left and right indentation as well as first-line and hanging indents 
by playing with the ruler. See the section “Setting tabs by using the ruler,” 
later in this chapter, for details.

The Format Painter
You can use the Format Painter to quickly copy character and paragraph for-
matting from one bit of text to another. The Format Painter works only if you 
already have some text formatted the way you like. Follow these steps to use 
the Format Painter:

 1. Highlight the text that has the format you want to copy.

 2. Click the Format Painter button in the Clipboard group on the Home 
tab on the Ribbon.

  The button looks like a paintbrush.

 3. Click and drag the cursor over the text you want to copy the format to.

  Word formats the new text to look just like the already formatted text.

If you want to use the Format Painter to format two or more sections of text, 
highlight the text you want to use as your template and then double-click the 
Format Painter button. The Format Painter then continuously formats the 
text you highlight until you press the Escape key or click the Format Painter 
button again.

Using the secret formatting toolbar
One of the more obscure formatting features in Word is the (my term) float-
ing format toolbar, which appears when you select text and hover the mouse 
over the selection for a moment. The floating format toolbar looks like this:
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As you can see, the Mini toolbar lets you quickly access many of the font and 
paragraph formatting commands discussed in this chapter: Font, Font Size, 
Bold, Italics, and many more.

Note that the floating format toolbar initially appears in semitransparent 
form when you hover the mouse over selected text, kind of like a ghostly 
specter that might make you think you’re being haunted by the spirits of 
departed formatting options. When the specter appears, move the mouse 
toward it to solidify the toolbar.

All about Tabs
In Word, you can create seven types of tab stops: left, center, right, decimal, 
bar, first line indent, and hanging indent. You can set tab stops in one of 
two ways: by dropping them directly on the ruler or by ditzing around with 
the Tabs dialog box. Dropping tabs directly on the ruler is far and away the 
easier method of the two. Get involved with the Tabs dialog box only when 
you want to use leaders, the little rows of dots that run across the page.

Setting tabs by using the ruler
The easiest way to set tabs is to use the ruler. Here’s the procedure for set-
ting tabs with the ruler:

 1. If the ruler isn’t visible, click the View Ruler button at the top of the 
vertical scroll bar.

 2. Type some text that you want to line up with tab stops.

  Type several paragraphs, if you want. Press the Tab key only once 
between each column of information you to want to line up. Don’t worry 
if everything doesn’t line up at first. You can fix it later.

 3. Select the paragraph or paragraphs whose tabs you want to set.

  If you’re setting tabs for just one paragraph, click anywhere in the para-
graph. If you’re setting tabs for more than one paragraph, click and drag 
to select at least some text in each paragraph.

 4. Click the ruler at every spot where you want to insert a new tab stop.

  Watch as the text you selected in Step 2 lines up under the tabs you 
create. Add one tab stop to the ruler for each column of information you 
want to align.

 5. Adjust.

  Nothing works quite right the first time. If you dropped a tab at 11⁄2 
inches and want to move it to 13⁄4 inches, just click and drag the tab 
marker and slide it to the new location. When you release the mouse 
button, text in the selected paragraphs adjusts in the new tab position.
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97All about Tabs

Here’s more fascinating information about tabs:

 ✦ Default tab stops are placed every half-inch. However, every time you 
create a new tab stop, any default tab stops to the left of the new tab 
stops are deleted. In other words, default tab stops exist only to the 
right of tab stops you create.

 ✦ To change the type of tab that’s created when you click the ruler, click 
the Tab Alignment button at the far left edge of the ruler. Every time you 
click the button, its picture changes to indicate the tab type, as shown in 
Table 2-4.

Table 2-4 Tab Types

Tab Alignment 
Button

Tab Type What It Does

Left Left-aligns text at tab stop 
(and is default tab style)

Center Centers text over tab stop

Right Right-aligns text at tab stop

Decimal Aligns numbers at decimal 
point over tab stop

First Line Indent Sets indentation for first line 
of paragraph

Hanging Indent Creates hanging indent

Using the Tabs dialog box
If you have an unexplainable aversion to the Word ruler, you can set tab 
stops by using the Tabs dialog box instead. Just follow these steps:

 1. Click the dialog box launcher in the Paragraph group of the Home tab 
on the Ribbon.

  The Paragraph dialog box appears (refer to Figure 2-11).

 2. Click the Tabs button in the lower-left corner.

  The Tabs dialog box opens, as shown in Figure 2-12.
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98 All about Tabs

 3. In the Tab Stop Position field, type the position where you want the 
new tab stop to appear.

 4. Select the Alignment option you want for the new tab stop (Left, 
Center, Right, Decimal, or Bar).

  For more information about bar tabs, see the later section “Running a 
bar tab.”

 

Figure 2-12: 
The Tabs 
dialog box.

 

 5. Select the tab leader type for the tab stop. If you don’t want leaders, 
select 1 None.

  I explain leaders later, in the section “Using tab leaders.”

 6. Click Set.

 7. Repeat Steps 3 through 6 for any other tab stops you want to create.

 8. Click OK to dismiss the Tabs dialog box.

 

You can quickly summon the Tabs dialog box by double-clicking the lower 
half of the ruler.

Removing all tabs
To remove a single tab stop by using the ruler, click the tab stop you want to 
remove and drag it straight down, off the ruler. When you release the mouse 
button, the tab stop is deleted.

To remove all tab stops, highlight the paragraphs you want to remove the 
tab stops from. Then complete one of these two actions:

 ✦ Use the dialog box launcher in the Paragraph group on the Home tab 
on the Ribbon to open the Paragraph dialog box. Then click the Tabs 
button to open the Tabs dialog box.
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99All about Tabs

 ✦ Double-click the bottom half of the ruler to summon the Tabs dialog box.

Click the Clear All button to remove the tabs and click OK to return to the 
document.

Using tab leaders
A tab leader is a row of dots or dashes or a solid line that precedes the tab, 
similar to the one you often find on a restaurant menu. Dots and dashes are 
the leader type you use for lists; solid lines are typical for forms. Just look at 
the table of contents in the front of this book to see an excellent example of 
this type of tab leader.

The easiest way to create a tab leader is to first create the tab stop by drop-
ping it on the ruler. Then double-click the bottom of the ruler to open the 
Tabs dialog box, choose the tab stop you want to add the leader to, and 
select a leader type (dots, dashes, or solid line). Then click OK and check 
the results.

If you want the tab leader to end at a certain location, create a left-aligned 
tab at that location by using the leader type of your choice. This technique 
is commonly used to create fill-in-the-blank forms. For example, Figure 2-13 
shows two left-aligned tab stops with solid-line leaders, one at 2½   inches and 
the other at 5 inches.

 

Figure 2-13: 
Solid-line 
leaders.

 

If you’re going to use dot or dash leaders to connect items in a list, you usu-
ally use right- or decimal-aligned tabs. For example, I formatted the docu-
ment in Figure 2-14 with a single, right-aligned, dot-leader tab stop at 4.5 
inches.
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Figure 2-14: 
Dot leaders.

 

Running a bar tab
You must be 21 to use this feature in most states.

One of the more unusual things you can do with tabs is create vertical bars 
between columns of information, like the ones shown here:

Hawkeye James T. Kirk Gilligan

B.J. Mr. Spock The Skipper

Charles Dr. McCoy The Professor

Hot Lips Mr. Chekov Mary Ann

Radar Mr. Sulu Ginger

Col. Potter Lt. Uhura Mr. Howell

Father Mulcahy Nurse Chapel Mrs. Howell

In this table, the vertical bars between columns are special deviant versions 
of tab stops. Bar tabs aren’t like regular tab stops in that the Tab key doesn’t 
stop at them. As a result, you use only one tab character between each 
column. To set bar tabs, first create a left tab for each column. Then click 
the tab type button to the left of the ruler until the Bar Tab button appears. 
Then add a bar tab a little to the left of each left tab you created.

 

Bar tabs are a crude way of making tables. A far better way to create tables 
with ruled lines is to use Word’s Table feature, which I cover in Book IV, 
Chapter 4.
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101The Ten Commandments of Formatting

The Ten Commandments of Formatting
When Bill Gates came down from the mountain, he originally had 15 format-
ting commandments. But he dropped one of the three tablets, shattering it 
to pieces, so now we have only ten.

I. Thou shalt learn thy way around the Ribbon 
while continuing to use keyboard shortcuts
The Ribbon displays many more handy tools than ever in an easily acces-
sible manner. However, keyboard shortcuts are rarely inadvisable. Don’t 
bother memorizing the keyboard shortcuts for formats you rarely or never 
use. But be sure to memorize the shortcuts for the formats you use fre-
quently. Pressing Ctrl+B for bold is much faster than clicking the mouse 
button or contending with the Ribbon and dialog boxes. Make a short list of 
the shortcuts you want to memorize and tape it to your computer or some-
where within eyesight.

II. Thou shalt not press Enter at the end of every line
You defeat the whole purpose of word processing if you press Enter at the 
end of every line you type. Let Word figure out where to break each line. Use 
Enter to end paragraphs.

III. Thou shalt not create empty paragraphs
Don’t press Enter twice to leave extra space between paragraphs. Instead, 
format the paragraph with 11⁄2 or 2 blank lines in front of the first line.

IV. Thou shalt not use extraneous spaces
On a typewriter, you’re supposed to press the spacebar twice between sen-
tences. With proportional fonts, use only one space following the period at 
the end of a sentence. Also, don’t use spaces to align text in columns. Use 
tabs instead.

V. Thou shalt not use extraneous tabs
Don’t press Tab two or three times to move text across the page. Instead, 
press Tab once and then set a tab stop where you want to align the text.

VI. Thou shalt not underline when italicizing will do
Underlining is for typewriters. Italics is for computers. You paid lots of hard-
earned money for your computer, so you might as well get your money’s 
worth.
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VII. Thou shalt use no more than 
three fonts on a page
Avoid the ransom note look at all costs. Use one font for your text, a second 
font for headings, and maybe a third font for emphasis. But no more than 
three fonts altogether, please.

VIII. Thou shalt not use exact line spacing
The Exact Line Spacing option (find it by clicking the dialog box launcher 
on the Paragraph group on the Home tab) is a source of much trouble. Use 
Single, 1.5 lines, or Double instead.

IX. Thou shalt use the AutoCorrect feature
The AutoCorrect feature can correct typos on the fly as well as help with 
simple formatting chores, such as ensuring that sentences start with capital 
letters and using “curly quotes” properly.

To further define this feature, choose File➪Options to open the Word 
Options dialog box. Then click the Proofing tab and click the AutoCorrect 
Options button at the top of the dialog box. When the AutoCorrect dialog 
box appears, select the things you want Word to automatically correct; then 
click OK twice to close the two dialog boxes.

X. Thou shalt use styles
The best way to deal with all this formatting nonsense is to put all the for-
matting you ever need into styles. Then you don’t have to worry about line 
spacing, hanging indents, fonts and font sizes, or anything else. Just apply 
the correct style and everything is taken care of. (I discuss styles in detail in 
Chapter 3 of this minibook. Aren’t you lucky?)
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Chapter 3: Working with Styles

In This Chapter
✓ Understanding why styles are important

✓ Formatting with styles by using the Styles gallery

✓ Changing the document look with style sets and themes

✓ Setting the look of new documents you create

✓ Exploring other ways of applying styles

✓ Finding and clearing the layers of formatting

✓ Setting advanced style features

Styles are what Tiggers like best. Using styles is the secret to freeing 
yourself from the tyranny of using a sequence of formatting commands. 

With styles, you toil at formatting text until you get the look just right; 
then you provide a name by which Word remembers all the formatting you 
applied. From then on, you can apply the same formatting to other text by 
simply using the style — no more hunting and pecking your way through 
the various formatting commands, trying to recall how you made the para-
graph look so good.

If you aren’t yet using styles, I suggest that you find out how to use them 
right away. Although the concept of styles might be confusing at first, they 
aren’t hard to figure out. An hour or so invested in becoming familiar with 
how styles work pays off in many saved hours of unnecessary formatting 
time later.

Understanding Styles
The basic idea behind styles is to store all formatting information for a para-
graph under a single name. That way, you can quickly apply saved formats 
to other paragraphs by simply referring to the style’s name. Suppose that 
you want to format headings in 16-point Arial Bold, with 18 points of space 
above the heading and 6 points below, and with a line drawn beneath the 
paragraph. You have to bounce the mouse all over the place to format this 
heading manually. But if you store the formats in a style, you can apply all 
formats with a single click or a keyboard shortcut.
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Styles can contain any type, or all these types, of formatting:

 ✦ Paragraph: Includes left and right indentation, first line indentation and 
hanging indents, line spacing, before and after spacing, and text flow 
(widow/orphan control or keep with next, for example).

 ✦ Tabs: Includes tab stop positions, tab types, leader tabs, and bar tabs.

 ✦ Bullets or Numbering: Enables you to set up numbered or bulleted lists. 
(See Book III, Chapter 3 for more information about bullets and numbers.)

 ✦ Borders and Shading: Includes borders and line styles as well as fill 
shades.

 ✦ Font: Includes the font name, style (regular, bold, italic, or bold italic), 
and special character attributes such as small caps or superscripts, the 
font color, and character spacing (including whether kerning is auto-
matically done for some letter pairs).

 ✦ Language: Enables you to use an alternative dictionary for spelling and 
hyphenation or to tell Word to skip a paragraph specified with this style 
when the document is spell-checked.

With all these formats stored together under one name, you can imagine 
how much time styles can save you.

Styles are an integral part of the way Word works. Even if you think you 
don’t use styles, you do: Word documents start off using several predefined 
styles, including the ubiquitous Normal style. It governs the default appear-
ance of paragraphs in your document.

Here are some other benefits of using styles:

 ✦ Changing the style definition changes all text using that style. The real 
beauty of styles emerges when you decide that the headings in your 200-
page report are too small. Without styles, you have to adjust the size of 
each heading separately. With styles, you simply change the style and — 
voilà! — all paragraphs assigned to that style automatically adjust.

 ✦ You can update the overall document look by changing the style set. 
Styles let you take advantage of style sets that let you store collections 
of styles that you can swap with a single command. For example, you 
might have one set that defines all styles for a draft format (for example, 
double-spaced with the headers boxed with a border to make them 
stand out), another that’s used for reviews (with single-spaced format-
ting but in a larger font), and, finally, one that formats the document 
into its final form. Word comes with a collection of style sets that let you 
change the overall look of your document easily — but only if you’re 
using styles to format your text. For more information about style sets, 
see the section “Switching style sets and themes,” later in this chapter.
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 ✦ Styles are part of the document. Styles are stored along with your text 
in the document file. Thus, each document can have its own collection 
of styles, and styles with the same name can have different formatting 
characteristics in different documents. For example, a style named 
Bullet List might have ordinary round bullets in one document but check 
marks or pointy index fingers in another.

 ✦ Styles can be defined in a template. When you create a new document, 
the new document inherits its styles from the template you base the 
document on. For more information about templates, turn to Book I, 
Chapter 3.

 ✦ Styles can be created by others for your use. Suppose that you don’t 
know how to drop a line three points beneath the paragraph and you 
don’t want to learn how. No problemo. Just bribe a friendly Word guru 
into creating the style for you. After the style is created, you don’t have 
to know how to use the formatting instructions contained in the style. 
All you have to know is how to apply the style, and that’s as easy as 
clicking the mouse button.

 

✦ Some Word features work better if you use styles. Another benefit of 
using styles is that some Word features, most notably Table of Contents 
and Outline view, work best when you use styles for headings and body 
text. Don’t even attempt to use these features if you don’t use styles.

  For more information about tables of contents, see Book VI, Chapter 1. 
To find out more about Outline view, see Book VI, Chapter 6.

The various controls discussed in this chapter contain three types of styles:

 ✦ Character styles, such as Emphasis, Strong, and Subtle Reference, which 
apply to only selected text and can contain only font formatting and lan-
guage information.

 ✦ Linked styles, such as Heading 1 and Title, which can apply to either the 
entire paragraph or selected text.

 ✦ Paragraph styles, such as Quote, which can apply only to paragraphs — 
even if you select only part of the paragraph, the style is applied to the 
entire paragraph. Paragraph styles are identified by the special pilcrow 
symbol (¶) in front of the style name in the Styles gallery.

 Word has five types of styles, but two are so important that they have their 
own galleries: table styles and list styles. Table styles are discussed in Book 
IV, Chapter 4, and list styles (used for numbering) are discussed in Book III, 
Chapter 3.
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Applying Styles with the Styles Gallery
Sitting in the Styles group on the Home tab on the Ribbon is the Styles gal-
lery. It contains the styles that the template designer has decided are most 
useful for working with the document. Of course, it’s your document, so you 
can add or remove styles as you like. The Styles gallery, shown in Figure 3-1, 
is the easiest way to work with styles.

 

Figure 3-1: 
Styles 
gallery.

 
More button

To apply a style to a paragraph, follow these steps:

 1. Click anywhere in the paragraph you want to format.

  For all styles except character styles, you don’t have to select the entire 
paragraph; just move the insertion point anywhere in it.

 2. Choose the style you want from the Styles gallery.

  Click the More button next to the Styles gallery to reveal more styles 
(refer to Figure 3-1). If the text you’re formatting is covered by the gal-
lery, thereby preventing the full benefit of Live Preview, use the arrows 
to scroll additional styles into view without expanding the gallery. Find 
the one you want and click it. The formatting contained in the style 
applies to the paragraph.

  If the style you want to use isn’t showing in the gallery, you can use 
the Styles pane to find it (see the section “Using the Styles pane,” later 
in this chapter) or, if you know the name of the style, you can use the 
Apply Styles dialog box (see the section “Using the Apply Styles dialog 
box,” later in this chapter).

To apply a style to two or more adjacent paragraphs, select a range of text 
that includes all paragraphs you want formatted. Then choose the style. When 
you press Enter to create a new paragraph, the new paragraph normally 
assumes the same style as the preceding paragraph. See the section “Setting 
the style of the next paragraph,” later in this chapter, for an important — and 
useful — exception.

  As you work with your document, you might decide that you want to remove 
the style from a particular paragraph. The best way to remove the style and 
any formatting is to use the Clear Formatting button, shown in the margin. 
Even though it’s often used when working with styles, the Clear Formatting 
button prefers to hang out with the font formatting commands and can be 
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107Applying Styles with the Styles Gallery

found in the Font group rather than in the Styles group. However, the Clear 
Formatting command on the bottom of the Styles gallery does the same 
thing (but you have to show the entire Styles gallery to find this command).

The standard Styles gallery includes several character styles that are 
intended to be used to format text within your paragraphs. This includes 
three Emphasis styles, two Reference styles (for indicating text that refers 
to an element such as a book title), and a style named Strong, used to pro-
vide strong emphasis. (The name Strong comes from HTML, where it usually 
means bold text and Emphasis usually means italic text.) The advantage to 
using the character styles becomes most obvious when you change themes 
or style sets and the character styles update so that your document keeps a 
consistent look.

 A paragraph always has a style associated with it (even if it’s just the Normal 
style that Word applies automatically). You can layer a character style on 
top of the paragraph style, if you want. For example, you can highlight text 
within a paragraph and assign it the Emphasis style to make it stand out 
from the rest of the text.

To apply a style to just a portion of text rather than to entire paragraphs, 
follow these steps:

 1. Select the text you want to format.

  When applying a character style, you can select text in more than one 
paragraph. When applying a linked style to selected text, all the selected 
text must be in the same paragraph. You cannot apply a paragraph style 
to selected text.

 2. Select the style you want from the Styles gallery.

  When you apply a character style, it sticks to the text you’ve selected. 
If you move that text to a new paragraph, the character style remains 
on that text. To remove the character style, use the Clear Formatting 
button.

 

Here are some helpful hints to using styles effectively:

 ✦ The name of each style in the Styles gallery is formatted according to 
the style. This name gives you a hint of how your text will look before 
you apply the style. What’s more, Live Preview shows you exactly what 
you will see.

 ✦ To quickly return a paragraph to Normal style, press Ctrl+Shift+N.

 ✦ To assign the built-in Heading 1, Heading 2, or Heading 3 styles, press 
Ctrl+Alt+1, Ctrl+Alt+2, or Ctrl+Alt+3, respectively.

 ✦ You can create keyboard shortcuts for any style you create. See the sec-
tion “Assigning shortcut keys,” later in this chapter.
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Finding Your Own Style
The styles included in the Styles gallery are the ones that Microsoft believes 
most people need for creating most types of documents. But perhaps you’re 
not like most people and want some different ones. Or, perhaps you don’t 
like the way the standard styles look.

Fear not! You’re about to find out how to tailor the styles in the gallery to 
your needs, rather than have to use the ones Microsoft gave you.

Switching style sets and themes
Next to the Styles gallery on the Home tab is a button labeled Change Styles 
that reveals the hundreds of combinations of looks available for the Styles gal-
lery. Clicking the Change Style button reveals controls for changing the main 
elements that define the look of the Styles gallery. As shown in Figure 3-2, 
they’re Style Set, Colors, Fonts, and Paragraph Spacing.

 

Figure 3-2: 
The Change 
Styles 
control.

 

 If your current document is saved in the Word 2003 format, you can’t update 
the Font and Color aspects for your styles. To gain access to this powerful 
feature, you need to upgrade your document by selecting the Convert com-
mand from the File tab.

The style sets in the Change Styles control update the definitions of the 
styles used in your document and the Styles gallery. Microsoft ships 11 style 
sets, but you can also create your own. Figure 3-3 shows the same document 
with two different style sets applied — the one on the left uses the Word 
2010 set, and the one on the right uses the Modern set.

 

Figure 3-3: 
Setting the 
Word 2010 
style set 
(left) and 
Modern 
(right).
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109Finding Your Own Style

The Font and Color controls refine the current theme. A theme provides 
consistent formatting for not only the text in your document but also objects 
you might insert, such as tables, charts, and SmartArt diagrams. Each theme 
has three components: fonts, colors, and effects. Effects are most important 
when working with charts and diagrams.

You can change the entire theme by using the controls on the Page Layout 
tab, shown in Figure 3-4. The Font and Color controls are available on the 
Change Styles control on the Home tab and in the Themes group on the Page 
Layout tab. PowerPoint and Excel share themes with Word, making it easier 
to create a collection of documents with quite a similar look.

 

Figure 3-4: 
Use the 
Themes 
control on 
the Page 
Layout tab 
to change 
all theme 
settings at 
one time.

 

To change the look of the styles in the Styles gallery and in your document, 
follow these steps:

 1. Make sure your document includes some text formatted with styles 
from the Styles gallery.

  Generally, you want to have used Heading 1 and Heading 2 as well as 
the Normal style and perhaps some character styles. Although you can 
change the look of the styles in the Styles gallery without having text in 
your document, styled text makes it much easier to see the various looks.

 2. Click the Change Styles button on the Home tab, point to the Style Set 
command, and then select a style set from the list.

  As you move over the various style sets, the text in your document 
updates to preview the change. However, the styles in the Styles gallery 
don’t change until you commit to your choice.
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 One major difference among the style sets is the spacing of Normal para-
graphs in your document. If you don’t like the more open spacing of the 
Word 2010 default settings, you might prefer the Traditional set. If you 
want to create a document that’s similar to the Word 2003 documents 
that you have, select the Word 2003 style set.

 3. Click the Themes button on the Page Layout tab and then select a 
theme from the list.

  When you move your cursor over various themes, the text in your docu-
ment updates with new fonts and colors. As with style sets, the themes 
in the Themes gallery update only after you commit to your selection.

 4. To fine-tune the look of the theme used in your document, click the 
Change Styles button on the Home tab, point to the Fonts command, 
and then select a font set from the list.

 

 If you want a document that looks like your old Word 2003 documents, 
select the Word 2003 style set and the Office Classic font set.

When you find a combination of style set and theme that you want to use 
for all your documents, you can tell Word to use it for all new documents, as 
described in the section “Storing the look of your styles,” later in this chapter.

Changing a style
You might or might not be able to teach an old dog a new trick, but you can 
teach Word to use your definitions for any style in the Styles gallery. To do 
so, follow these steps:

 1. Apply the style you want to update to a paragraph in your document.

  You can just type a temporary paragraph, use it as a sample for the 
style, and then delete the paragraph. After the style is updated, the para-
graph is no longer necessary for Word to remember the style definition.

 2. Make whatever formatting changes you want to the formatting of the 
paragraph.

  If the style you’re updating is a character style, Word ignores the para-
graph formatting you apply.

 3. Right-click the paragraph and select the Styles submenu, as shown in 
Figure 3-5.

  If the menu that appears doesn’t have the Styles submenu, try right-
clicking somewhere else in the paragraph. For example, if you right-click 
over an unrecognized word, you see the Spelling menu, which doesn’t 
allow you to update the style definition.
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111Finding Your Own Style

 

Figure 3-5: 
The Styles 
submenu.

 

 4. Select Update <style> to Match Selection.

  Well, it doesn’t say <style> in the command. Instead, the name of the 
style you applied in Step 1 shows up here. Ensure that you’re updating 
the right style — if the text that your cursor was over when you right-
clicked in Step 3 has a character style applied, that character style is 
updated rather than the paragraph style.

You can also right-click the style in either the Styles gallery or the Styles 
pane to make the command update it to match the selection. Using those 
methods, you can be certain that you’re updating the style you want to 
change.

 When Word updates the style, it uses the formatting from the start of the 
paragraph to update the character information stored in the style. So be 
sure that that part of the paragraph looks the way you want the style to look.

 

Because the Normal style is so important, Word offers another way to 
update Normal. One reason that the Normal style is so important is that 
Word uses it for most paragraphs in your document. Another is that many 
other styles in your document use its settings as a base. The best method 
for updating the Normal style is to use the Set As Default buttons found in 
the Font and Paragraph dialog boxes. For more information about working 
with these dialog boxes, see Chapter 2 in this minibook.
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Creating your own style
You might find that the styles available in the Styles gallery aren’t enough 
for you. And by golly, you want to add your own style! To do so, follow these 
steps:

 1. Format a paragraph with the look you want to store in a style.

  You might want to look back at the list at the beginning of this chapter 
(in the “Understanding Styles” section) to remind yourself of all the 
things you can store in a style. The most important ones are the charac-
ter formatting and paragraph indents and whether the paragraph has a 
number or bullet.

 

 In general, you want to make sure that the paragraph has the Normal 
style applied before you begin formatting it. If it has another style, it’s 
used as the “Based on” style for the new style, as described in the sec-
tion “Basing one style on another,” later in this chapter.

 2. Right-click the paragraph and choose Styles➪Save Selection As a New 
Quick Style.

  The dialog box shown in Figure 3-6 appears.

  Quick Style is the term Word uses to identify styles that appear in the 
Styles gallery.

 

Figure 3-6: 
Creating a 
new style.

 

 3. Enter a name for the style and click OK.

  The style now appears in the Styles gallery, near whichever style was 
previously applied to the paragraph. (It’s usually the Normal style, and 
the new style appears near the start of the Styles gallery.)

Only linked styles can be created by using this method. To create paragraph 
and character styles, you click the Modify button to open the Modify Style 
dialog box, shown in Figure 3-7. If you’re changing an existing style, you can 
open the same dialog box by right-clicking the style in either the Styles gal-
lery or the Styles pane and choosing Modify. In the first approach, the dialog 
box is named Create New Style from Formatting, but if you open the dialog 
box by using the other steps, it’s named Modify Style. It’s the same dialog 
box either way, so try not to worry about why Microsoft had to make this 
feature just a bit more confusing to use.
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113Finding Your Own Style

 

Figure 3-7: 
The Create 
New 
Style from 
Formatting 
dialog box.

 

The Create New Style from Formatting (or Modify Style) dialog box gives 
you complete control over the settings used in the style’s definition. The 
controls within the “face” of the dialog box are the most commonly used, 
but you can use the Format button at the lower left to open additional dialog 
boxes with even more settings. All the power comes with a price — the 
Modify Style dialog box is one of the most complex in Word. If you have to 
use it, try to find a friend to help.

Adding and removing styles from the gallery
You might find that you never use some of the styles in the Styles gallery. 
You can remove any style from the gallery by right-clicking the style and 
choosing Remove from Quick Style Gallery.

To add a style back into the Styles gallery, you have to open the Styles pane 
(press Ctrl+Alt+Shift+S or click the dialog box launcher in the lower-right 
corner of the Styles group), locate the style, and then right-click the style. 
From the menu that appears, choose Add to Quick Style Gallery. The Styles 
pane is shown later in this chapter, in Figure 3-8.

The other thing you might want to do with the items in the Styles gallery is 
change their order. If you just want to list them alphabetically, you can open 
the Styles pane, click the Options link, set the Select How List Is Sorted drop-
down list to Alphabetical, and click OK.
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 For more control over the order of the items in the Styles gallery and the 
Styles pane, you need to use the Styles Management dialog box — arguably 
the most complex dialog box in all of Word. You can open the Manage Styles 
dialog box by clicking the Manage Styles button at the bottom of the Styles 
pane. The Recommend tab lets you specify the order in which styles should 
appear when the various styles lists are set to show in the As Recommended 
order (set using the Options link on the Styles pane).

Storing the look of your styles
After the Styles gallery looks exactly the way you want, you might be so 
happy with what you’ve done that you want any new document you create 
to use those exact same settings. Not too surprisingly, Word offers an easy 
way to do that.

To set the styles that show in the Styles gallery for new documents, follow 
these steps:

 1. Update the Styles gallery to have the styles you want.

  This step might involve changing the style set, changing the theme, 
modifying the styles in the set, adding or removing styles, and even cre-
ating your own styles. (I cover all these tasks earlier in this chapter.)

 2. Click the Change Styles button and then select the Set As Default 
command.

  That’s all there is to it. Go ahead. Try it. Press Ctrl+N and see whether 
your new document has the right settings. If not, ensure that the docu-
ment you’re working with truly has what you want to store.

  In some cases, the command name might have changed to identify a 
specific template. When that happens, it means that rather than update 
the settings for all new documents created by using Ctrl+N or any other 
method that starts with a plain, blank document, you’re changing the 
settings only for documents created with that template.

When you set the look for new documents, you don’t create a separate style 
set or theme. Instead, you update the settings used in the Normal template. 
If you’re working on a document and want to return to your custom default 
settings, use the Reset to Quick Styles from Template command on the Style 
Set menu and the Reset to Theme from Template command on the Themes 
gallery.

You can also update and save just the contents of the Styles gallery as a 
style set. The command to store a style set is found on the Style Set menu, 
which you access by clicking the Change Styles button and then selecting 
Style Set➪Save As Quick Style Set. When you save a style set, Word prompts 
you to provide a name for the new style set. After you name and save the 
style set, it becomes available on the Style Set menu, and you can use it 
in any of your Word documents. You can save the current font, color, and 
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115Stepping Beyond the Styles Gallery

effects setting as a theme by using the Save Current Theme command on the 
Themes gallery on the Page Layout tab. This command works in the same 
fashion as saving a style set, with the newly saved theme becoming available 
in the Themes gallery. One big difference between style sets and themes is 
that themes become available in PowerPoint and Excel as well as in Word.

 When you switch style sets, the styles in both sets are updated. Any style that’s 
in use in your document but not in the new style set is left in the Styles gallery. 
Any style that’s in the new style that wasn’t showing previously is added.

Stepping Beyond the Styles Gallery
For most situations, the Styles gallery provides access to the styles you need 
and the commands to work with them. However, some situations require a 
larger list of styles, or you might want to work with your styles in ways not 
offered by the Styles gallery.

Using the Styles pane
One of the most common needs when working with styles is to be able 
to choose from more styles than the number that can conveniently be 
displayed in the Styles gallery. For that task, you can use the Styles pane 
(shown in Figure 3-8), which you can open by clicking the dialog box 
launcher in the lower-right corner of the Styles group.

 

Figure 3-8: 
The Styles 
pane.

 
New Style

Style Inspector

Manage Styles
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Rather than your having to search the Styles gallery to find which style is 
highlighted for the particular paragraph you’re curious about, the Styles 
pane gives you the details on every style you have used in a document.

You apply a style from the Styles pane the same way as from the Styles gal-
lery. To apply paragraph styles, place your cursor in the paragraph or select 
either the entire paragraph or parts of more than one paragraph and click 
the style you want to apply. To apply character styles, select the text and 
then click the style you want to apply.

The Styles pane is set to show as many styles as possible. If you make the 
pane wide enough, it even shows two or more columns of styles. As part of 
that, the style names are shown in the same font that’s used for labels on the 
Ribbon. If you would rather see the styles formatted to preview the way they 
format text, select the Show Preview option.

 The icon to the right of the Styles pane identifies the style type for each 
style — character (the a character), paragraph (the pilcrow, or paragraph 
mark, also shown in the Styles gallery next to paragraph styles), or linked 
(with both an a and a pilcrow). I cover the difference among these three 
types of styles in the section “Understanding Styles,” earlier in this chapter.

 

If you often end up applying linked styles to part of a paragraph when you 
meant to apply them to the entire paragraph, select the Disable Linked 
Styles option.

Hovering the cursor over a style displays a description of the style’s format-
ting. Right-clicking a style displays a menu, including an option to select all 
text using that style.

The three buttons at the bottom of the Styles pane provide you with the 
ability to (from left to right) create a new style using the Create New Style 
from Formatting dialog box, gather more information about the current para-
graph (see the later section “Using the Style Inspector”), or open the scariest 
dialog box in Word — Manage Styles.

Exploring the Styles Pane Options dialog box
You can control which styles appear in the Styles pane and how the styles 
are sorted for both the Styles pane and the Styles gallery by using the 
Options link (in the lower-right corner). When you click the Options link, the 
Style Pane Options dialog box appears, as shown in Figure 3-9.

Microsoft certainly recommends that you set both the Select Styles to Show 
and Select How List Is Sorted drop-down menus to show the recommended 
styles. The recommended setting for Select Styles to Show is Recommended 
and for Select How List Is Sorted is As Recommended. (Maybe Microsoft 
is planning to trademark the word recommended.) The reason that these 
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117Stepping Beyond the Styles Gallery

settings are preferred in most cases is that they tell the controls that list 
styles to organize the information the way in which the template designer 
intended. However, you might have a different work style and want to 
change these settings. Most commonly, folks prefer setting Select Styles to 
display a listing of all styles in the current document, whether or not the 
template designer recommended each, and to sort the styles alphabetically.

 

Figure 3-9: 
The Style 
Pane 
Options 
dialog box.

 

 

Previous versions of Word kept track of the font and paragraph formatting 
you had applied. Word 2003 displayed your applied formatting in the Styles 
and Formatting pane. With that information in hand, you could treat the for-
matting as though it were a style. This feature is most useful for tasks such 
as selecting all text with that formatting and changing it. In Word 2010, if you 
want to display the same information, you click the Options link in the Styles 
pane and then select the Font Formatting and Paragraph Level formatting 
check boxes (under Select Formatting to Show As Styles).

Using the Apply Styles dialog box
If you’re the sort of user who prefers to keep your hands on the keyboard, you 
might prefer working with the Apply Styles dialog box, shown in Figure 3-10. 
The advantage to using this approach is that you can display the dialog box 
by pressing Ctrl+Shift+S, typing the style name, and then pressing Enter to 
apply the style — all without moving your hands from the keyboard to your 
mouse.

 

Figure 3-10: 
Apply Styles 
dialog box.
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As you type a style name, Word provides possible matches from the list 
of styles defined in the current document. If you don’t like Word trying 
to guess what you’re doing, you can turn off this feature by clearing the 
AutoComplete Style Names check box.

The Apply Styles dialog box also lets you create a new linked style by typing 
an unused name. If the style name you type isn’t already defined, the Apply 
button becomes the New button. If you want to further refine the definition 
of the style before creating it, you can click the Modify button to open the 
Modify Style dialog box, shown earlier (refer to Figure 3-7).

If you’ve applied character or paragraph formatting and now want to clear 
the formatting and reapply the paragraph style, you can do it by using the 
Apply Styles dialog box. Just type the style name for the paragraph and the 
Apply button becomes Reapply to let you know that you can clear the for-
matting and reapply the “pure” style.

Another control in the Apply Styles dialog box is the button with the double 
letter A on it. Click this button to open the Styles pane.

Using the Style Inspector
As you work with styles, you might wonder which styles are applied to the 
current text. You might even want to know about any formatting that’s hang-
ing out in addition to the styles. To view these various levels of formatting, 
open the Styles pane and then click the Style Inspector button (labeled in 
Figure 3-8). This action opens the Style Inspector pane, shown in Figure 3-11.

 

Figure 3-11: 
The Style 
Inspector 
pane.

 

Reveal Formatting

New Style

As described in the section “Understanding Styles,” earlier in this chapter, 
all text derives its basic paragraph formatting from its paragraph style 
and might have additional direct paragraph formatting, formatting from a 
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119Stepping Beyond the Styles Gallery

character style, and additional direct character formatting. The magic of 
the Style Inspector is that it reveals each of these levels of formatting and 
allows you to remove them one level at a time. Here are your options:

 ✦ Paragraph Formatting: The large, white box in this section displays the 
current style for the paragraph. The button to the right resets the para-
graph style to Normal. (Remember that all paragraphs in Word must 
have a paragraph style applied.)

  Under this box but still in the Paragraph Formatting section is a list of 
any paragraph formatting that’s applied to the entire paragraph. The 
button to the right clears all paragraph formatting that isn’t part of the 
paragraph’s style. Sometimes, character formatting also appears here if 
it’s applied to the entire paragraph; the button on the right doesn’t clear 
this character formatting but resets it so that it’s shown correctly in the 
Text Level Formatting section.

 ✦ Text Level Formatting: The large box in this section reports the cur-
rent character style. If the text has no character style applied, the text 
Default Paragraph Font is displayed. The button to the right clears 
the current character style.

  As with the Paragraph Formatting section, any additional character 
formatting is shown in the box below. The button to the right clears the 
character formatting that comes from neither the paragraph nor charac-
ter style.

To clear all formatting and reset the paragraph to the Normal style, you 
can use the Clear All button on the Style Inspector or the Clear Formatting 
button in the Font group on the Home tab.

 The Reveal Formatting pane provides much greater detail about the for-
matting applied to the selected text. You can open the Reveal Formatting 
pane by clicking the leftmost button in the group at the bottom of the Style 
Inspector pane or by pressing Shift+F1.

Using the Word 2003 Styles drop-down list
Previous versions of Word used a drop-down list on the Formatting toolbar 
to list the current style and to let you select which style to apply by either 
typing the style name (as you now can do in the Apply Styles dialog box) or 
selecting from a list. The Word 2010 Styles gallery and Styles pane both high-
light the current style if it already appears in the list of displayed styles, but 
neither automatically scrolls to make that style visible. Therefore, you often 
can’t tell at a glance which style is applied.

You can show the current style and provide yourself with an additional way 
to apply styles by adding the Word 2003 Styles drop-down list to your Quick 
Access toolbar by following these steps:
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 1. Open the Word Options dialog box from the File tab.

  For more information about the Word Options dialog box, see Book I, 
Chapter 3.

 2. From the list of options on the left side of the dialog box, select Quick 
Access Toolbar.

  You can see the options for modifying it in the main window.

 3. With the Popular Commands list visible, scroll down and select Style.

  Note that two commands have similar names. You want the one that 
says Style, not Styles. The Styles entry adds a button to open the Styles 
pane.

 4. Click the Add button to move the Style control into the list of com-
mands on the Quick Access toolbar.

  If you want, you can use the two arrows at the right of the dialog box to 
change the order of the commands on the Quick Access toolbar.

 5. Click OK.

  That’s it. You can now see the current style with a quick glance at your 
Quick Access toolbar.

Better Living through Styles
The use of styles is one key to using Word effectively. This list contains the 
best tips for simplifying your life by using styles correctly:

 ✦ Always use styles. This advice is somewhat redundant because, in 
Word, you have to use styles. Whether you realize it or not, every para-
graph in Word is based on a style. If you don’t use styles, the paragraphs 
are based on the utilitarian Normal style.

  My point here is that for all except the simplest documents, create and 
apply styles rather than apply direct formatting to your paragraphs. In 
the long run, using styles rather than direct formatting saves you a great 
deal of time and grief. You might curse the computer while you climb the 
sometimes steep learning curve that comes along with using styles, but 
when you reach the top, you’ll say to yourself, “That wasn’t so hard.”

 ✦ Use the built-in Heading 1, Heading 2, and Heading 3 styles for your 
headings. Word has three predefined heading styles. If you don’t like 
the way they look, redefine them. By using Heading 1, Heading 2, and 
Heading 3, you can work with your headings in Outline view (see Book 
VI, Chapter 6) or create a table of contents (see Book VI, Chapter 1).
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121Better Living through Styles

 ✦ Whenever possible, create styles by example. Just format a paragraph 
to have the look you want, right-click, and select Styles➪Save Selection 
As a New Quick Style. Use the Modify Style dialog box only when you 
must.

 ✦ Check out the style sets, themes, and templates that come with Word. 
Microsoft has already done much of the hard work of creating styles for 
you. When you start to create a new document, check out the various 
templates available on Office Online (http://office.microsoft.
com) to see whether any of them is suitable. If not, pick one that’s close 
and modify it to suit your needs. For information on using templates, 
check out Book I, Chapter 3.

 ✦ Use keyboard shortcuts to assign styles quickly. The second fastest 
way to assign styles is to use keyboard shortcuts. Assign a keyboard 
shortcut to every style you use frequently. Don’t bother with the ones 
you use infrequently, though — remembering the keyboard shortcuts 
you use frequently is hard enough. For information about assigning key-
board shortcuts, see the section “Assigning shortcut keys,” later in this 
chapter.

 ✦ Base all text variants on the Normal style. Most documents have sev-
eral different types of paragraphs that are minor variations on normal 
text. For example, the bullet list paragraphs in this book are variations 
of the book’s normal text paragraphs: They have the same typeface, 
point size, and line spacing, but their margins are different and they 
have bullets. Paragraphs such as bulleted lists should be formatted 
with styles based on the Normal style. That way, if you decide to make a 
sweeping change, such as move from 10- to 11-point type or switch from 
Times New Roman to Palatino, you can change the Normal style rather 
than change each style individually. For more information, see the sec-
tion “Basing one style on another,” later in this chapter.

 ✦ Use the Style for Following Paragraph field to automate your format-
ting. The fastest way to assign styles is to have Word do it automati-
cally. Set the Style for Following Paragraph field in the Modify Style or 
New Style dialog box. Then when you press Enter to create a new para-
graph, Word automatically assigns the style. For more information, 
see the section “Setting the style of the next paragraph,” later in this 
chapter.

 ✦ Use Space Before or Space After, but not both. When you create para-
graph styles, decide in advance whether you prefer to add extra space 
before or after the paragraphs. As much as possible, stick to your deci-
sion. If you have two adjacent paragraphs, the first with extra space 
after and the second with space before, you might end up with more 
space than you intend between paragraphs.
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Neat Things to Do with Styles
You can do much more with styles than create and apply them. The sections 
that follow chronicle some of the more interesting things you can do with 
styles. They’re not only interesting but also somewhat more complex than 
the topics discussed earlier in this chapter. If you’re not feeling technically 
minded, you might want to stop reading now.

Assigning shortcut keys
Word enables you to assign keyboard shortcuts to your favorite styles. Then 
you can apply those styles by simply pressing the keyboard shortcut. To 
assign a shortcut key, follow these steps:

 1. Display the Styles pane.

  Press Ctrl+Shift+Alt+S or click the dialog box launcher in the lower-right 
corner of the Styles group on the Home tab.

 2. Point the cursor at the style you want to modify.

  Don’t click the style; just point the cursor at it.

 3. Click the down arrow that appears next to the style and then choose 
Modify from the menu that appears.

  The Modify Style dialog box appears.

 4. Click the Format button and then choose Shortcut Key.

  The Customize Keyboard dialog box appears, ready for you to assign a 
keyboard shortcut for the style. (See Figure 3-12.)

 

Figure 3-12: 
The 
Customize 
Keyboard 
dialog box.
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123Neat Things to Do with Styles

 5. Click in the Press New Shortcut Key text box and then press the key 
combination that you want to assign to the style.

  When you press the keys, Word writes out the key combination for you. 
The plus sign indicates that the keys must be held down together.

 6. Verify that the shortcut isn’t already in use.

  If you choose a command that’s already in use, an “underwhelming” 
line appears under the Current Keys box to indicate that it’s assigned 
and which command is using it. You can then decide whether you want 
to find a different shortcut to use or remove it from the command that 
already has it.

 7. Click Assign to assign the keyboard shortcut.

 8. Click Close; then click OK to get all the way out of there.

Keep these tidbits in mind when using keyboard shortcuts for styles:

 ✦ To remove a keyboard assignment you previously assigned, select it in 
the Current Keys list in the Customize Keyboard dialog box and then 
click the Remove button.

 ✦ The predefined heading styles already have keyboard shortcuts associ-
ated with them:

 Ctrl+Alt+1 Heading 1

 Ctrl+Alt+2 Heading 2

 Ctrl+Alt+3 Heading 3

 ✦ You can create keyboard shortcuts by using virtually any combination 
of keys on the keyboard. The shortcuts can use the Shift, Ctrl, and Alt 
keys, either alone or in combination. For example, you can assign Ctrl+K, 
Alt+K, Ctrl+Shift+K, Ctrl+Alt+K, or even Ctrl+Alt+Shift+K.

 ✦ You also can create prefix keyboard shortcuts, such as Ctrl+Shift+I, 1. 
To activate this shortcut, you must press Ctrl+Shift+I and then release 
those keys and press the 1 key. Using this approach, you can create one 
prefix key to access a group of styles. To enter this style of shortcut, 
press the combination of keys you want to use as the prefix and then the 
specific key you want to use for the style.

Basing one style on another
Suppose that you create 20 different styles for various types of paragraphs 
in a complicated document, only to discover that your boss wants the entire 
document to have single line spacing rather than the 1⁄2 lines that was speci-
fied last week. Do you have to change all 20 styles to reflect the new spac-
ing? Not if you set up your styles using base styles.
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A base style provides formatting information for other styles. For example, 
you might have a style named Bullet List and you want to create a similar 
style named Bullet List Last that you use for the last paragraph in a series 
of bulleted paragraphs. The only difference between Bullet List and Bullet 
List Last is that Bullet List Last has additional space after the paragraph. 
Otherwise, the styles are identical. Base styles enable you to do this. In this 
case, Bullet List Last consists of all the formatting from its base style, Bullet 
List, plus six points of space afterward.

A style inherits all formats specified in its base style. If the base style 
changes, the changes are inherited, too. Any styles based on the style you 
change automatically reflect any changes you make to the base style.

However, a style can override the formats it inherits from the base style. For 
example, if a style doesn’t specify a point size, any paragraphs formatted 
with the style inherits the point size from the base style. However, if a style 
specifies a point size, the point size of the base style is ignored.

Thus, if all 20 of your paragraph styles are based on the Normal style, you 
can change the font for all 20 styles by simply changing the font for the 
Normal style. (The exception is any style based on Normal that specifies its 
own font to override the font picked up from the Normal style. In that case, 
the style retains its own font.)

Here’s the procedure for creating a style that’s based on another style:

 1. Choose the paragraph you want to format.

 2. Apply to the paragraph you selected the style you want to use as the 
base style.

 3. Change the formatting of the paragraph.

  Add whichever extra formats you want applied to the new style. These 
formats are added to the base style’s formats.

 4. Create the new style.

  The new style is based on the style originally applied to the paragraph. 
(For detailed steps, refer to the earlier section “Creating your own style.”)

 

You can also set the base style in the Create New Style from Formatting 
dialog box, which opens when you click the New Style button on the Styles 
pane.

A style that serves as a base style may itself have a base style. For example, 
Bullet List Last may be based on Bullet List, which in turn may be based on 
Normal. In that case, the formats from Normal, Bullet List, and Bullet List 
Last are merged whenever you apply the style.
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125Neat Things to Do with Styles

Setting the style of the next paragraph
When you press Enter to create a new paragraph, the new paragraph nor-
mally assumes the same style as the previous paragraph. In some cases, you 
want to do exactly that. However, for some styles, the style of the follow-
ing paragraph is almost always a different style. For example, a paragraph 
formatted with the Heading 1 style is rarely followed by another Heading 1 
paragraph. Instead, a Heading 1 paragraph is usually followed by a Normal 
paragraph.

Rather than always change the style assigned to a new paragraph in these 
situations, you can specify the style you want assigned to the next para-
graph by using the Modify Style dialog box. Then when you press Enter, the 
new paragraph is assigned the style you specified. This little trick can almost 
completely automate the chore of formatting your documents.

You can set the style for the following paragraph when you’re creating a 
new style by using the New Style button on the Styles pane. In the Styles 
pane, click the New Style button at the bottom left of the pane to display the 
Create New Style from Formatting dialog box.

For existing styles, to set the style for the following paragraph, you use the 
Modify Style dialog box. Click the drop-down list next to the style you want 
to change and select the Modify option.

 

Examine the Style for Following Paragraph setting for each of your styles to 
see whether you can save yourself some work. Heading styles should specify 
Normal for the following paragraph, as should any other type of paragraph 
that usually occurs in singles. You might find other styles that should have 
this field set, too. For example, I have a Chapter Number style that specifies 
Chapter Title As Style for Following Paragraph.

Showing the Style area
Adding the Word 2003 Style drop-down list to the Quick Access toolbar (as 
described earlier in the chapter) provides a way of seeing the style of your 
current selection at a glance. But wouldn’t it be cool to be able to see, all 
at one time, which paragraph style was assigned to each paragraph? Well, I 
wouldn’t have mentioned it if it weren’t possible. Figure 3-13 shows a docu-
ment in Draft view with the Style area displayed.

To show the current paragraph style in the Style area, follow these steps:

 1. Make sure that you’re in Draft view by checking the View tab.

  If you aren’t in Draft view, switch to it by clicking the Draft button.
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 2. Select Options from the File tab to display the Word Options dialog box.

 3. Select the Advanced option from the list on the left.

 4. In the Display section of the long list of advanced options, type the 
width you want to use for the Style area in the text box labeled Style 
Area Pane Width in Draft and Outline Views.

  A width of an inch generally works well.

 5. Click OK.

  The paragraph style for each paragraph now displays to the left of the 
text aligned with the first line of text in the paragraph.

 

Figure 3-13: 
A document 
with the 
Style area 
displayed.

 

After the Style area is visible, you can adjust its width by grabbing with the 
cursor the vertical line that separates the Style area from the document. You 
can omit the Style area by dragging this line all the way to the left. Or, you 
can follow the preceding steps and enter 0 as the width.

Storing styles in a template
The easiest way to store styles in a template is to open the template directly 
and edit the styles within it. You can also save any style you’re modifying by 
selecting the New Documents Based on This Template option in the Modify 
Style dialog box and then clicking OK. If you want to save all your style set-
tings, follow these steps:

 1. Open the Styles pane by pressing Ctrl+Shift+Alt+S or using the dialog 
box launcher for the Styles group on the Home tab.

 2. Click the Manage Styles button (refer to Figure 3-8, where the button 
is labeled).
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127Neat Things to Do with Styles

  The Manage Styles dialog box appears. (You may recall that I consider it 
the scariest dialog box in all of Word. It’s so scary that I don’t even show 
you a picture of it.)

 3. Select the New Documents Based on This Template option.

 4. Click OK.

Styles stored in the template are available to any document that is created 
starting from that template. To make styles available for a variety of docu-
ments, consider storing them as a style set, as described in the earlier sec-
tion “Storing the look of your styles.”
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Chapter 4: Editing Techniques

In This Chapter
✓ Selecting and deleting text

✓ Copying and pasting text

✓ Using the Undo and Repeat commands

✓ Finding and replacing text

At its heart, Word is editing software. They call it processing software, 
but it doesn’t process much. It’s for editing. It offers a lot of features 

that are involved with the editing of documents.

You would think that this topic is what the entire book is about. Not so fast, 
my friend — a special set of tools relates directly to the technique of editing. 
That is what I cover here — the good, the bad, and the ugly of the editing 
tools of Microsoft Word.

Selecting Text
One basic editing skill is selecting text. After you select some text, you can 
delete it, copy it, move it, apply formatting to it, change its capitalization, 
and do all sorts of other neat stuff to it.

The easiest way to select text is to click and drag the mouse over the text you 
want to select. You can also use one of these mouse actions to select text:

 ✦ To select all text between two points: Click at the start of the block of 
text, hold down Shift, and click at the end of the block.

 ✦ To select a single word: Double-click anywhere on the word. Click, click.

 ✦ To select an entire paragraph: Triple-click anywhere on the paragraph. 
Click, click, click.

 ✦ To select an entire sentence: Hold down Ctrl and click anywhere in the 
sentence.

 ✦ To select a column of text: Hold down Alt, click and hold the mouse 
button, and drag. Drag the mouse left or right to increase or decrease 
the width of the column selected, and drag the mouse up or down to 
extend the column up or down. (This technique is especially useful if 
you arrange text into columns by using tabs and you want to rearrange 
the columns.)
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130 Selecting Text

Note that after you select some text, a miniature formatting toolbar appears 
to the upper right of the cursor, as shown in Figure 4-1. You can use the 
toolbar to quickly format a selection with some of the basic formatting tools 
discussed in Chapter 2 of this minibook.

 

Figure 4-1: 
Mini toolbar.

 

Using the invisible selection bar
Way off to the left of your text is an invisible, secret region of the Word 
screen that’s officially named the selection bar. To find it, slide the mouse 
over toward the left edge of the screen (within the left margin area in Print 
Layout view) until the cursor turns into a rightward-pointing arrow. When 
the cursor changes, say “Gotcha!” quickly so that Word knows you’re on to 
its game.

Here are a few selection tricks that use the selection bar:

 ✦ To select an entire line of text: Click the selection bar once. Click.

 ✦ To select an entire paragraph: Double-click the selection bar. Click, 
click.

 ✦ To select the entire document: Triple-click the selection bar. Click, 
click, click.

 ✦ To select several paragraphs: Double-click the selection bar to select 
the first paragraph, hold down the mouse button after the second click, 
and drag the mouse up or down the selection bar to select additional 
paragraphs.

Selecting with the keyboard
If you’re allergic to the mouse, you can use the keyboard shortcuts summa-
rized in Table 4-1 to select text.

Table 4-1 Keyboard Shortcuts for Selecting Text

Keyboard Shortcut What It Does

Ctrl+A Selects the entire document

Ctrl+Num Pad 5 Selects the entire document

Alt+Num Pad 5 Selects the entire table (NumLock must be off for this 
shortcut to work.)
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131Deleting Text

Keyboard Shortcut What It Does

Shift Extends the selection (if you hold down the Shift key) as 
you move the insertion point by using the arrow keys

F8 Places Word in Extend mode, which lets you extend the 
selection by using the arrow keys without holding down 
the Shift key

Ctrl+Shift+F8 Extends a column selection; similar to using the Alt key 
with the mouse

 

After you press F8 to enter Extend mode, you can press it again to select 
the current word (similar to double-clicking). Press F8 a third time to select 
a sentence. Press it a fourth time to select the entire paragraph, and a fifth 
time to select the entire document. To turn off Extend mode, press Esc.

Selecting cells in a table
If you create a table, you can use these tricks to select individual cells, col-
umns, or rows:

 ✦ To select several cells: Click in the cell that is your starting point, and 
then click and drag across the cells you want to select.

 ✦ To select an entire column: Click the top gridline of the column. The 
cursor changes to a down arrow when it’s in position to select the 
column. You can select several columns by dragging the mouse in this 
position.

 ✦ To select an entire row: Click the selection bar to the left of the row. To 
select several rows, drag the mouse in the selection bar.

For the scoop on how to build a table, talk to a carpenter — or see Book IV, 
Chapter 4.

 

To delete a table or cells within a table, highlight the selection to be deleted 
and press Backspace. To delete all text within a table or within selected 
cells, highlight the selection to be deleted and press Delete.

Deleting Text
Deleting text is one of the basic skills of good editing. Some people think 
they’re such good writers that they shouldn’t have to delete anything. Not 
me. I delete about half of what I write. And that’s probably not enough.

Word has many ways to delete text. The most basic deletion technique is to 
delete characters one at a time by pressing one of these two keys:
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 ✦ Backspace: Deletes the character to the left of the insertion point

 ✦ Delete: Deletes the character to the right of the insertion point

If you immediately catch a typing mistake, press the Backspace key to oblit-
erate it and then type the correct text. Using the Delete key is more appro-
priate when you discover your mistake a few moments after the fact. Then 
you can move the insertion point to the beginning of the text in error, use 
the Delete key to erase the mistake, and then type the correct text.

 

You can also use the Backspace and Delete keys in combination with the Ctrl 
key to delete whole words. The same distinction between Backspace and 
Delete applies when you use the Ctrl key: pressing Ctrl+Backspace deletes 
the previous word; Ctrl+Delete deletes the next word.

Note: Ctrl+Backspace and Ctrl+Delete work best when the insertion point is 
positioned between words. If the insertion point is in the middle of a word, 
Ctrl+Backspace and Ctrl+Delete delete only part of the word. Ctrl+Backspace 
deletes everything from the insertion point to the beginning of the word, and 
Ctrl+Delete deletes everything from the insertion point to the end of the word.

 

If you select text before you use the Backspace or Delete key, the forward 
and backward distinction between these two keys fades into the distance. 
With text selected, the Backspace and Delete keys simply delete the selected 
text. You can use this ability to delete large amounts of text with one blow. 
For example:

 ✦ To delete a sentence: Hold down the Ctrl key and click in the sentence 
to select it, and then press Delete or Backspace.

 ✦ To delete a paragraph: Triple-click the paragraph to select it and then 
press Delete or Backspace.

 ✦ To delete the entire document: (This must be an act of extreme des-
peration, I would think.) Press Ctrl+A to select the entire document and 
then press Delete or Backspace.

 

If you become overzealous with the Delete or Backspace key, you can restore 
your smitten text by pressing Ctrl+Z to summon the Undo command. For 
more information, see the section “Undo and Repeat,” later in this chapter.

Using the Clipboard
The nifty Clipboard task pane feature lets you gather as many as 24 different 
items of text or graphics from Word or any other Office application (such as 
Excel or PowerPoint) and then selectively paste them into your document. 
Figure 4-2 shows the Clipboard task pane in action.
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133Using the Clipboard

 

Figure 4-2: 
The 
Clipboard 
task pane.

 

You can summon the Clipboard task pane in a couple ways so that you can 
work with the items you add to the Clipboard:

 ✦ Click the dialog box launcher in the Clipboard group on the Home tab on 
the Ribbon.

 ✦ In the Clipboard task pane, click the Options button and then select the 
option labeled Show Office Clipboard When Ctrl+C Pressed Twice. Then 
you can press Ctrl+C twice to launch the task pane.

To paste an item from the Clipboard task pane, first click to mark the loca-
tion in the document where you want to insert the item and then click the 
item in the Clipboard that you want to insert.

If you like everything you copied to the Clipboard, you can paste it all into 
your document in one fell swoop by clicking the Paste All button. This 
button lurks near the top of the Clipboard task pane.

To remove an item from the Office Clipboard, point to the item, click the 
drop-down list arrow, and choose Delete from the menu that appears. 
To clear everything from the Clipboard, click the Clear All button, which 
appears near the top of the Clipboard task pane.
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For the Clipboard to collect items while it isn’t displayed, you must open the 
Clipboard task pane, click the Options button, and then select the Collect 
without Showing Office Clipboard option.

Dragging and Dropping
Drag-and-drop editing (or dragon dropping) helps you to move text from one 
location in a document to another by using only the mouse, without using the 
Clipboard. You simply highlight the text you want to move and use the mouse 
to drag the text to a new location. When you release the mouse button, the 
text is cut from its original location and pasted to the new location.

 

If you hold down the Ctrl key while dragging text, you can copy the text to 
the new location rather than move it. In other words, the text isn’t deleted 
from its original location.

You can drag and drop text between two open documents, which is easier 
if both documents are visible onscreen. To ensure that both documents are 
visible, click the Arrange All button on the View tab on the Ribbon. To drag 
text from one open document to another without rearranging your windows, 
try this technique:

 1. Select the text you want to drag to another document.

 2. Click within the selected text and hold the mouse button.

 3. While still holding down the mouse button, press Alt+Tab to switch to 
the document in which you want to drop the text.

  Note: Continue to hold down the Alt key and press Tab as many times as 
necessary to switch to the right document.

 4. While still holding down the mouse button, drag the text to the loca-
tion where you want to drop it.

 5. Release the mouse button to drop the text.

By my reckoning, this method is more trouble than it’s worth. I’d put my 
money on simple copy and paste (Ctrl+C and Ctrl+V) any day.

 

If you don’t like this feature — and you may well find that you don’t — you 
can disable it by choosing File➪Options and then clicking the Advanced tab. 
Deselect the Allow Text to Be Dragged and Dropped check box and click OK.

Undoing and Repeating
Using the Undo command is one of the best ways to become a Word guru. 
Without the Undo command, you would be afraid of experimenting with 
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135Undoing and Repeating

Word for fear of losing your document. But with this command at hand, you 
can try anything you want, knowing that the worst that can happen is that 
you might have to use the Undo command to undo a mistake.

You can access the Undo command from the Quick Access toolbar, but 
Undo is useful enough that you should simply memorize its keyboard short-
cut: Ctrl+Z. While you’re at it, go ahead and memorize Ctrl+Y, the keyboard 
shortcut for an almost equally useful command: Repeat. The following minit-
able summarizes these shortcuts for your reference:

Keyboard Shortcut What It Does

Ctrl+Z Undoes the previous action.

Ctrl+Y Repeats the previous action. If the previous action 
was Undo, Ctrl+Y redoes the undone action.

The Repeat command, as its name implies, repeats the last action. If you just 
used the Font dialog box (by using the dialog box launcher in the Font group 
on the Home tab on the Ribbon) to make a bevy of formatting changes all at 
one time, select some other text that you want similarly formatted and then 
press Ctrl+Y. By using this Repeat command, you can apply the same for-
mats to the other text.

The Repeat command repeats just about any action you can complete in 
Word. But when the most recent command is Undo, the Repeat command 
becomes the Redo command: It redoes the action undone by the Undo com-
mand. Undo and Redo are a perfect combination for people who can’t decide 
whether they like something.

Word keeps track of more than one recent action. In fact, you can undo hun-
dreds of recent actions. I don’t think undoing more than one or two at a time 
is a good idea, but who am I to second-guess what you do with Word? To 
undo more than one action at a time, click the drop-down list of the Quick 
Access toolbar’s Undo button to reveal all undoable actions. Drag the mouse 
to select the actions you want to undo, as shown in Figure 4-3. Then release 
the mouse button to undo them all. The Redo button on the Quick Access 
toolbar has a similar capability to redo multiple undone actions.

 

Figure 4-3: 
The Undo 
drop-down 
list.
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Finding and Replacing
The Find command enables you to locate specific text in your document. 
For example, you might remember that somewhere in your 200-page report 
you discussed the famous Bandersnatch, but you can’t recall exactly where. 
So you fire up the Find command and ask it to find the first mention of 
Bandersnatch in your document.

You might then decide that whenever you mention the Bandersnatch, you 
should add the word Frumious. So you then summon the Replace command 
to replace all occurrences of Bandersnatch with Frumious Bandersnatch.

 

In previous versions of Word, you used the Find and Replace dialog box 
to find and replace text. In Word 2010, the Find function is now a part of 
the Navigation pane, which appears on the left side of the screen. Using 
the familiar Ctrl+F keyboard combination or clicking the Find button in the 
Ribbon now summons the Navigation pane rather than the Find and Replace 
dialog box. If you want to use the old-style Find command, see the section 
“Searching, the old-fashioned way,” later in this chapter.

Finding text
You can use the Find command to find text anywhere in a document. Just 
follow these steps:

 1. Choose the Find button in the Editing group on the Home tab or press 
Ctrl+F to summon the Navigation pane.

  See Figure 4-4 for a glimpse of this pane.

 

Figure 4-4: 
Using the 
Navigation 
pane to find 
text.

 

 2. Type the text you want to find in the Search Document field.

  For example, type Bandersnatch.
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137Searching the Old-Fashioned Way

 3. Wait a moment.

  No need to click anything. As soon as you finish typing, Word searches 
for the text you entered and displays the results in the Navigation pane, 
as shown in Figure 4-5.

 

Figure 4-5: 
The 
Navigation 
pane 
displays 
search 
results.

 

 4. Click a search result to move to that part of the document.

 

Here are a couple of hints to keep in mind:

 ✦ If Word doesn’t find the search text, check your spelling. You might have 
spelled it wrong in the Search Document field.

 ✦ You can bail out of the Navigation pane at any time by clicking the Close 
button in the upper-right corner of the pane.

Searching the Old-Fashioned Way
If you prefer to search the old way, you can bring up the old-style Find and 
Replace dialog box by clicking the down arrow that appears to the right of 
the magnifying glass button in the Navigation pane. Alternatively, you can 
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138 Searching the Old-Fashioned Way

click the Replace button in the Ribbon and then click the Find tab in the Find 
and Replace dialog box. The Find tab has several advanced search options 
that initially aren’t displayed, but you can reveal them by clicking the More 
button, shown in Figure 4-6. The following sections describe these advanced 
search features.

 

Figure 4-6: 
The Find 
and Replace 
dialog box.

 

Changing direction
You can change the direction of Word’s search by changing the setting in 
the Search drop-down list. Three choices are available when choosing a 
search direction:

 ✦ All: Searches the entire document without regard to the position of the 
insertion point.

 ✦ Down: Starts the search at the position of the insertion point and 
searches forward toward the end of the document.

 ✦ Up: Searches backward from the insertion point, toward the beginning of 
the document.

  Both the Down and Up options search until they reach the bottom or top 
of the document; then they ask whether you want to continue searching 
the rest of the document.

 

To hide the Search Options section, click the Less button (which was previ-
ously the More button).
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139Searching the Old-Fashioned Way

Refining your findings
The check boxes at the bottom of the expanded Find and Replace dialog box 
let you refine your searches in sometimes helpful ways, as described in the 
following sections.

Matching case
Select the Match Case check box before beginning the search if it matters 
whether the text appears in upper- or lowercase letters. This option is handy 
when you have, for example, a document about Mr. Mathers the math teacher.

Finding whole words
Speaking of Mr. Mathers the math teacher, select the Find Whole Words 
Only check box to find your text only when it appears as a whole word. If 
you want to find the text where you talk about math teachers in general for 
example, type math in the Find What text box and select the Find Whole 
Words Only check box. That way, the Find command looks for math as a 
separate word and doesn’t show you the math in Mathers.

Using wildcards
Select the Use Wildcards check box if you want to include wildcard charac-
ters or other search operators in the Find What field. Table 4-2 summarizes 
the search operators you can use if you select this option.

Table 4-2 Advanced Search Operators for the Find Command

Operator What It Does

? Finds a single occurrence of any character. For example, f?t finds fat 
or fit.

* Finds any combination of characters. For example, b*t finds any com-
bination of characters that begins with b and ends with t, such as bat, 
bait, ballast, or bacteriologist.

# Finds any numerical digit.

[abc] Finds any character enclosed in the brackets. For example, b[ai]t finds 
bat or bit but not bet or but.

[a-c] Finds any character in the range of characters enclosed in the brack-
ets. For example, b[a-e]t finds bat or bet but not bit or but.

[!abc] Finds any character except the ones enclosed in the brackets. For 
example, b[!ai]t finds bet or but but not bat or bit.

@ Finds one or more occurrences of the preceding character. For exam-
ple, 10@ finds 10, 100, or 1000.

(continued)
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140 Searching the Old-Fashioned Way

Table 4-2 (continued)

Operator What It Does

{n} Specifies that the preceding character must be repeated exactly n 
times. For example, 10{2} finds 100 but not 10 or 1000.

{n,} Specifies that the preceding character must be repeated at least n 
times. For example, 10{2,} finds 100 or 1000 but not 10.

{n,m} Specifies that the preceding character must be repeated from n to m 
times. For example, 10{2,3} finds 100 or 1000 but not 10 or 10000.

< Finds the following text only if it appears at the beginning of a word. For 
example, <pre finds predestined and prefabricated but not 
appreciate or apprehend.

> Finds the preceding text only if it appears at the end of a word. For exam-
ple, ing> finds interesting and domineering but not ingenious or ingest.

First word, short, sounds like. . . .
Select the Sounds Like check box if you aren’t sure exactly how to spell 
the text for which you’re searching. Word can search for words that are 
pronounced the same as the word you’re searching for. For example, if you 
search for your with the Sounds Like option on, Word stops when it finds 
you’re. Don’t expect much from this option, however.

Finding all word forms
If you select the Find All Word Forms check box, Word looks for alternative 
forms of most verbs. For example, if you search for run, Word finds runs, run-
ning, and ran. And, the program is smart enough to know about certain oddball 
words, such as go: If you search for go, Word finds not only goes, going, and 
gone but also went. Searching for be finds is, was, am, were, being, and been.

Don’t expect miracles, however. Find All Word Forms doesn’t pick up every 
imaginable word form, especially where nouns are concerned. For example, 
a search for introduction doesn’t pick up introductory, and religion doesn’t 
catch religious. The Find All Word Forms option is more adept at finding 
alternative word forms for verbs than for nouns.

Ignorance is not bliss
Ignoring punctuation or white spaces can be bliss:

 ✦ The Ignore Punctuation Characters check box is useful to find out 
whether you were online or on-line at the click of the mouse.

 ✦ The Ignore White-Space Characters check box is useful to find out 
whether you typed white-space or white space, or cell phone or cellphone.
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141Searching the Old-Fashioned Way

Finding formats
The Format button at the bottom of the Find and Replace dialog box (refer 
to Figure 4-6) lets you choose the type of format you want to search for from 
the pop-up menu. The following options are available:

 ✦ Font: Search for specific font formatting. You can search for specific 
fonts or for font formatting, such as bold, italics, and font size.

 ✦ Paragraph: Search for specific paragraph formatting, such as indenta-
tion and alignment.

 ✦ Tabs: Search for paragraphs with specific tab settings.

 ✦ Language: Search for paragraphs formatted for a particular language.

 ✦ Frame: Search for specific frame formatting.

 ✦ Style: Search for paragraphs formatted with a particular style.

 ✦ Highlight: Search for highlighted text.

 Make sure that the Find What field itself is blank; otherwise, the Find com-
mand searches for specific text formatted with the style you specify.

Finding special characters
The Special button at the bottom of the Find and Replace dialog box (refer 
to Figure 4-6) lets you search for special characters such as em-dashes and 
annotation marks. When you click this button, a list of special characters 
you can search for appears, as shown in Figure 4-7. Select the character you 
want to search for and click Find Next to begin the search.

 

Figure 4-7: 
The Special 
button drop-
down list.
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142 Searching the Old-Fashioned Way

When you select a special character, Word inserts a code into the Find What 
text box. If you know the code, you can bypass the Special button and its 
huge menu by typing the code directly into the Find What field. Table 4-3 
summarizes the codes.

Table 4-3 Search Codes for Special Characters

Character Code

Paragraph mark ^p

Tab character ^t

Any character ^?

Any digit ^#

Any letter ^$

Section character ^%

Paragraph character ^v

Caret character ^^

Column break ^n

Em dash ^+

En dash ^=

Endnote mark ^e

Field ^d

Footnote mark ^f

Graphic ^g

Manual line break ^l

Manual page break ^m

Nonbreaking hyphen ^~

Nonbreaking space ^s

Optional hyphen ^-

Section break ^b

White space ^w

Replacing text
You can use the Replace command in the Editing group on the Home tab to 
replace all occurrences of one bit of text with other text. The following steps 
show you the procedure:
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143Searching the Old-Fashioned Way

 1. Choose the Replace command in the Editing group on the Home tab 
or press Ctrl+H.

  The Find and Replace dialog box appears with the Replace tab selected, 
as shown in Figure 4-8.

 

Figure 4-8: 
The Replace 
tab of the 
Find and 
Replace 
dialog box.

 

 2. Type in the Find What text box the text you want to find.

  For example, type Bandersnatch.

 3. Type the text you want to substitute for the Find What text in the 
Replace With text box.

  For example, type Fruminous Bandersnatch.

 4. Click the Find Next button.

  When Word finds the text, it highlights it onscreen.

 5. Click the Replace button to replace the text.

 6. Repeat the Find Next and Replace sequence until you finish.

If you’re absolutely positive that you want to replace all occurrences of 
your Find What text with the Replace With text, click the Replace All button. 
Taking this step automatically replaces all remaining occurrences of the text.

 Replace All can be hazardous to the health of your document. You’re bound 
to encounter at least one spot where you don’t want the replacement to 
occur. Replacing the word mitt with glove, for example, changes committee to 
comgloveee. (Imagine the confusion that could cause.) So be cautious before 
you click that Replace All button and use the More options.
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144 Searching the Old-Fashioned Way

As with the Find command, you can click the More button to expand the 
dialog box so that additional options are visible (refer to Figure 4-5). You can 
then use the Match Case, Find Whole Words Only, Use Wildcards, Sounds 
Like, and Find All Word Forms options. The last option is even smart enough 
to properly replace alternative word forms with the correct version of the 
replacement text. For example, if you replace run with walk, Word replaces 
running with walking and ran with walked.

 Because Word is not 100 percent confident in its capability to properly 
replace all alternative word forms, you see a warning message if you select 
the Find All Word Forms option and click Replace All. Find All Word Forms is 
tricky enough that you should verify each replacement.

Word has the evil editing feature Overtype 
mode. When you’re in Overtype mode, any 
text you type obliterates the text onscreen. In 
Overtype mode, typing a character replaces 
the character to the right of the insertion point 
with the character you type. Fortunately, turn-
ing on this feature is no longer as easy as acci-
dentally pressing the Insert key.

Now you have to enable the Insert key to 
toggle Overtype mode on and off by follow-
ing the steps in this sidebar. If you prefer to 
use Overtype mode, obliterating all text in 
your path, you need to tell the status bar to let 
you know when Word is in Overtype or Insert 
Mode. Here’s the information you need:

 1. Choose File➪Options and then click the 
Advanced tab.

  This step opens the Advanced tab of the 
Word Options dialog box.

 2. To enable the Insert key to be the Overtype 
toggle key, select the Use the Insert Key to 
Control Overtype Mode check box.

 3. Click OK.

 4. To turn on the status bar notification, 
right-click the status bar at the bottom of 
the window and choose Overtype from the 
menu that appears.

Now the word Insert appears on your status 
bar. When you press the Insert key to use 
Overtype mode, the word Insert changes to 
Overtype, indicating that Overtype mode is on.

To turn off Overtype mode, deselect the Use 
the Insert Key to Control Overtype Mode check 
box on the Advanced tab of the Word Options 
dialog box, which you can find by following 
Step 1 in this list.

Avoiding Overtype mode
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Chapter 5: All about AutoCorrect 
and Its Siblings

In This Chapter
✓ Using AutoCorrect

✓ Formatting with AutoFormat

✓ AutoFormatting as you type

✓ Inserting AutoText

This chapter covers several related features in Word that attempt to 
automate the process of creating documents. AutoCorrect automatically 

corrects common spelling errors, and AutoFormat applies formatting auto-
matically as you type. Another feature, AutoText, lets you store common 
words or complete paragraphs (or even several pages) that you can insert 
into your document with just a click of the mouse.

Using AutoCorrect
The AutoCorrect feature in Word monitors your typing, carefully watching 
for common typing mistakes and fixing them quicker than you can say “Bob’s 
your uncle.” For example, if you type adn, AutoCorrect changes it to and. A 
misspelled teh becomes the, and recieve becomes receive. You get the idea. 
AutoCorrect has other features as well: It corrects capitalization, including 
accidental use of the Caps Lock key, and it lets you insert special symbols.

If you don’t like a change made by AutoCorrect, press Ctrl+Z or click the Undo 
button on the Quick Access toolbar to undo the change. Alternatively, you can 
play with the AutoCorrect Options button, as I describe in the following steps:

 1. When Word automatically makes a correction to your text, move the 
insertion point to the changed word.

   Click in the word or use the arrow keys to move the insertion point to it. 
When you reach the changed word, a little blue rectangle appears 
beneath the modified text, as shown in the margin.

 2. Point directly at the blue rectangle until the insertion point changes 
to an arrow pointer.

   The AutoCorrect Options button magically appears in place of the blue 
rectangle, as shown in the margin.
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146 Using AutoFormat

 3. Click to reveal a menu.

  The menu includes these commands:

 • Undo Automatic Corrections That I Don’t Want You to Do: This option 
is the same as pressing Ctrl+Z or clicking the Undo button on the 
Quick Access toolbar. Because both these alternatives are easier 
than hunting for the AutoCorrect Options menu, I doubt you’ll use 
this command often.

 • Stop Doing That: This menu command doesn’t actually say, “Stop 
Doing That.” Instead, it offers to stop making whichever type of 
AutoCorrect change you just made. For example, if AutoCorrect auto-
matically capitalizes the first letter of a sentence, this command is 
named Stop Automatically Capitalizing the First Letter of a Sentence. 
You can choose this command to disable the particular AutoCorrect 
action that led you to find the AutoCorrect Options menu.

 • Control AutoCorrect Options: Opens the AutoCorrect Options dialog 
box so that you can further customize the AutoCorrect options.

 4. Choose the command you want to apply and be done with it.

If you find the AutoCorrect Options button to be more of an annoyance than 
a help, you can turn it off by choosing File➪Options and then clicking the 
Proofing tab. Next, click the Autocorrect Options button and then deselect 
the Show AutoCorrect Options Buttons check box on the AutoCorrect tab.

Using AutoFormat
The AutoFormat feature as it was known in the past is no longer available. 
Word’s AutoFormat feature cleans up your document and fixes common 
formatting problems. AutoFormat tries to deduce such information as which 
paragraphs in your document should be formatted as headings or which 
paragraphs should be bulleted or numbered lists. It doesn’t always get it 
right, so you need to carefully review the changes it makes.

You can, however, add the AutoFormat button to the Quick Access toolbar:

 1. Choose File➪Options.

 2. Click the Quick Access Toolbar tab.

 3. In the Choose Commands From drop-down list, select All Commands.

 4. Find AutoFormat in the All Commands list and then click Add.

 You can adjust the button’s position on the toolbar by using the up and 
down arrows. Also, you can place separators between commands to help 
organize your Quick Access toolbar.

15_487662-bk02ch05.indd   14615_487662-bk02ch05.indd   146 4/15/10   8:34 PM4/15/10   8:34 PM



Book II

Chapter 5

A
ll a

b
o

u
t 

A
u

to
C

o
rre

c
t a

n
d

 
Its S

ib
lin

g
s

147Setting AutoFormat Options

After you have added the AutoFormat button to the Quick Access toolbar, 
you can use the button by following these steps:

 1. Save your document.

  AutoFormat performs drastic surgery on your document, so you should 
save it first. That way, if you don’t like what AutoFormat does, you have 
a saved copy to fall back on.

 2. Click the AutoFormat button on the Quick Access toolbar.

  The AutoFormat dialog box opens, as shown in Figure 5-1.

 

Figure 5-1: 
The 
AutoFormat 
dialog box.

 

 3. Click OK.

  AutoFormat reviews your entire document and makes whatever changes 
it deems necessary to spiff it up.

 4. Review the changes.

  Look over your document carefully to make sure you like the way it looks.

If AutoFormat makes a complete mess of your document, use the Undo com-
mand (click the Undo button on the Quick Access toolbar or press Ctrl+Z) to 
restore your document to its previous condition.

 

If you don’t trust AutoFormat, select the AutoFormat and Review Each 
Change option in the AutoFormat dialog box. Then AutoFormat gives you an 
opportunity to review each change.

Setting AutoFormat Options
You can control the changes made by AutoFormat by calling up the 
AutoCorrect dialog box, shown in Figure 5-2. To display this dialog box, 
choose File➪Options and then click the Proofing tab. Then click the 
AutoCorrect Options button and select the AutoFormat tab. (Alternatively, 
if you’ve added the AutoFormat button to the Quick Access toolbar, you can 
choose it and then click the Options button.)
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Figure 5-2: 
The 
AutoCorrect 
dialog box 
with the 
AutoCorrect 
tab 
selected.

 

You can find most of the AutoFormat options on the AutoFormat tab or the 
AutoFormat As You Type tab of the AutoCorrect dialog box, which I describe 
in the next section. Because AutoFormat As You Type is a more interesting 
and useful feature, I describe the options in the next section rather than here.

Using AutoFormat As You Type
The Word AutoFormat As You Type feature automatically improves the 
formatting of documents written with little concern for appearance. This 
feature applies document formatting as you type, so it’s closely related 
to the AutoCorrect feature. In fact, you find the options for controlling 
AutoFormat As You Type in the same dialog box as the options for control-
ling AutoCorrect. Choose File➪Options and then click the Proofing tab. 
Then click the AutoCorrect Options button. (Alternatively, if you’ve added 
the AutoFormat button to the Quick Access toolbar, you can choose it and 
then click the Options button.)

Click the AutoFormat As You Type tab to display the options shown in 
Figure 5-3. I describe the options in detail in the following sections.

Replace as you type
The first section of the AutoFormat As You Type tab hosts items that are 
automatically replaced as you type them. These items work essentially the 
same as AutoCorrect items: When you type a particular bit of text, Word 
steps in and replaces the text with other, more appropriate text.
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149Using AutoFormat As You Type

The following sections summarize the Replace As You Type options.

 

Figure 5-3: 
AutoCorrect 
dialog box 
with the 
AutoFormat 
As You 
Type tab 
selected.

 

"Straight quotes" with “smart quotes”
This option tells Word to replace ordinary apostrophes and quotation marks 
automatically with curly apostrophes and quotes. The trick of using quotes 
is figuring out whether to use the left or right variety of curly quote or 
apostrophe. The left quote appears to the left of quoted material; the right 
quote or apostrophe appears on the right. Word does its best to figure out 
which to use and usually gets it right. If a character immediately follows the 
apostrophe or quote, Word replaces it with a left quote or apostrophe. If a 
nonspace character is immediately before the quote or apostrophe, Word 
replaces it with a right quote or apostrophe. Verdict: Thumbs up, with the 
following caveats.

The Smart Quotes feature works most of the time, but it bombs when you 
want to use a simple curly apostrophe. For example, try typing Stop ’n 
Go. You can’t do it: Word insists on turning the apostrophe the other way 
’round. (See, I did it again: Bet you can’t!)

 

Okay, here’s the secret to getting these apostrophes right: Simply type two 
apostrophes in a row. Word curls them both, the first one left and the 
second one right: ‘’. Now go back and delete the first one.

Another way to do it is to hold down Ctrl and press the apostrophe key 
twice. This trick omits the left apostrophe.
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Smart Quotes is such a useful feature that you have little reason to turn it 
off. If you need to type an ordinary, noncurled apostrophe or quote once in a 
while, just type the apostrophe or quote and press Ctrl+Z (Undo).

Ordinals (1st) with superscript
This option replaces ordinal numbers, such as 1st, 2nd, and 3rd with properly 
formatted superscripts: 1st, 2nd, and 3rd. AutoCorrect can also accomplish ordi-
nals, but the AutoFormat option is convenient. For most people, ordinals are 
one of the main reasons to use superscripts (the other being footnotes), so 
automatically converting them in this way is a true convenience.

Replace fractions (1/2) with fraction characters (1⁄2)
The standard Windows character set, which most fonts adhere to, includes 
three fraction characters: 1⁄2, 1⁄4, and 3⁄4. When you enable this option, Word 
automatically converts 1/2, 1/4, and 3/4 to their fraction equivalents.

Too bad the Windows character set doesn’t include a few other fractions — 
at least 1/3 and 2/3. Sigh.

Two hyphens (--) with a dash (—)
This option does two things:

 ✦ Replace two hyphens with a typographical dash, or em dash, named 
because it’s about as wide as a capital letter M. For example, the — 
character is an em dash.

 ✦ Replaces two hyphens preceded and followed by a space with an en 
dash, named because it’s about the width of a capital letter N, such as in 
June – July or Aug – Sep.

*Bold* and _italic_ with real formatting
This option applies bold formatting whenever you precede and follow a 
word or phrase with asterisks, and it applies italic formatting whenever you 
precede and follow a phrase with underscores. This option is turned off by 
default because few people use this archaic typing convention to indicate 
that they mean bold or italics.

Internet and network paths with hyperlinks
This option watches for text that looks like an Internet address, such as 
www.wiley.com or Gomez@Addams.com, or network paths, such as \\
SERVER01\ADMIN. It then formats these items as hyperlinks so that you 
can Ctrl+click them in Word to open the Web page or network location they 
point to in a browser window.
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151Using AutoFormat As You Type

Apply as you type
The Apply As You Type section of the AutoFormat As You Type tab lets you 
select various formatting options that apply to text as you type. The follow-
ing sections describe each of these options.

Automatic bulleted lists
If you start a paragraph with a character that resembles a bullet, such as 
an asterisk (*), a hyphen (-), the letter o, or the > symbol, followed by a 
space or tab, Word removes the bullet character and the space or tab and 
instead formats the paragraph as a bullet list. Automatic bullets are conve-
nient for users who haven’t yet learned how to use the Bullets button in the 
Paragraph group on the Home tab on the Ribbon.

Automatic numbered lists
If you start a paragraph with a number followed by a period, space, tab, or 
parenthesis, Word removes the number and instead formats the paragraph 
as a numbered list. This option works for users who haven’t yet learned how 
to use the Numbering button in the Paragraph group on the Home tab on the 
Ribbon, but it drives me batty. Usually, if I start a paragraph with a number 
followed by a tab, I’m creating a numbered list in a format that is too compli-
cated for the Numbering button to handle, and I don’t want to take the time 
to mess with Word’s multilevel numbered list feature. For simple numbered 
lists, I just click the Numbering button anyway.

Border lines
If you type three or more hyphens, underscores, or equal signs in a row and 
press Enter with the Border Lines option selected, Word deletes the charac-
ters and instead applies a border to the bottom of the paragraph: a thin line 
for dashes, a thick line for underscores, or a double line for equal signs. This 
feature is neat.

Tables
This feature is the strangest of all the AutoFormat As You Type features. It 
automatically creates a table whenever you type a plus sign followed by one 
or more hyphens, another plus sign, and (optional) another set of hyphens 
and plus signs. For example, to create a table with four columns, you could 
type this line:

+----+----+----+----+

The number of hyphens you type between the plus signs determines the 
width of each column.
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If you ask me, using the Table button in the Tables group on the Insert tab is 
easier. You can look to Book IV, Chapter 4 for all the delights about tables.

Built-in heading styles
Whenever you type a line that starts with a capital letter, has no ending 
punctuation, and is at least 20 percent shorter than the maximum line 
length, Word makes the paragraph a heading if you select this option. 
Frankly, the rules for AutoFormatting headings as you type are too restric-
tive. What if the heading needs to be more than one line long? (Some do.) 
What if the heading ends with a question mark? What if you need to use two 
or more levels of headings? Memorizing the keyboard shortcuts for applying 
the built-in Word heading styles is much easier: Ctrl+Alt+1 for a Heading 1 or 
Ctrl+Alt+2 for a Heading 2, for example.

Automatically as you type
Another group of AutoFormat As You Type options applies the formatting 
described in the following sections.

Format beginning of list item like the one before it
This feature attempts to apply consistent formatting to the first portion of 
every item in a list. For example, if the first list item begins with boldface 
text and switches to normal after a colon, Word automatically applies that 
formatting to subsequent list items.

Set left and first indents with tabs and backspaces
When you select this feature, pressing the Tab key sets the indentation for 
paragraphs. For example, if you press Tab at the beginning of a new para-
graph, Word automatically increases the paragraph indentation by half an 
inch. Press Backspace to decrease the indentation by half an inch. If you 
press Tab when the insertion point is at the beginning of an existing para-
graph, Word increases the first line indent by half an inch.

Personally, I’d rather use styles to set indentation so that it’s consistent 
throughout the document. See Chapter 3 of this minibook for more on styles.

Define styles based on your formatting
This option automatically creates styles based on AutoFormat formatting. 
Normally, this option is turned off, and I recommend that you leave it off. 
Using styles is the best way to apply formatting consistently throughout a 
document, but you have much more control if you create and apply styles 
yourself rather than let Word automatically create them. Chapter 3 of this 
minibook tells you much more about styles.

15_487662-bk02ch05.indd   15215_487662-bk02ch05.indd   152 4/15/10   8:34 PM4/15/10   8:34 PM



Book II

Chapter 5

A
ll a

b
o

u
t 

A
u

to
C

o
rre

c
t a

n
d

 
Its S

ib
lin

g
s

153Using AutoText

Using AutoText
The AutoText feature lets you store words or phrases or longer portions of 
text and graphics under a user-defined name. Then, to recall stored text, you 
simply type the AutoText name and press F3, the AutoText key. For example, 
you might store your address in an AutoText entry named addr. To include 
your address in a document, you just type addr and press F3.

An AutoText entry can contain more than text: It can contain complete for-
matting information as well as graphics. In essence, an AutoText entry can 
contain any part of a Word document that you can select.

 

Another way to insert AutoText entries is to use the Quick Parts button on 
the Insert tab of the Ribbon. Click Quick Parts and then click AutoText and 
select the AutoText item you want to insert from the gallery that appears.

Creating an AutoText entry
To create an AutoText entry, follow these simple steps:

 1. Type and format the text exactly as you want to store it.

 2. Select the text.

 3. On the Insert tab, click the Quick Parts button and then click AutoText 
and then click Save Selection to AutoText Gallery.

  The Create New Building Block dialog box, shown in Figure 5-4, opens.

 4. Type a name for the AutoText entry.

  Word suggests the text itself as the AutoText name, but you should 
change it to a more succinct name. For example, I typed ta for the name 
shown in Figure 5-4.

 

Figure 5-4: 
Creating an 
AutoText 
entry.
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 5. Set the Options control to indicate how to insert the text.

  The three options are self-explanatory:

 • Insert content only

 • Insert content in its own paragraph

 • Insert content in its own page

 6. Click OK to create the AutoText entry.

Editing an AutoText entry
You cannot directly edit an AutoText entry. You have to follow a roundabout 
procedure, such as this one:

 1. Switch to a new document.

 2. Insert the AutoText entry by typing its name and pressing F3.

 3. Edit the entry however you want.

 4. Select the entire entry.

 5. Use the procedure described in the previous section to re-create the 
AutoText entry using the same name.

The Word AutoCorrect and AutoText features 
are similar enough that you can easily become 
confused about which is which, and which 

feature you use in a given situation. The fol-
lowing table should help clarify the difference 
between AutoCorrect and AutoText.

Comparing AutoCorrect and AutoText

AutoCorrect AutoText

Associates a name with stored text, 
formatting, and graphics

Associates a name with stored text, 
formatting, and graphics.

Automatically recalls entries when you 
type the entry name followed by a space 
or punctuation

Manually recalls entries when you type 
the entry name and press the AutoText 
key (F3)

Intended for correcting simple spelling 
errors or typing special symbols

Intended for storing commonly used text 
for quick recall

Stores AutoCorrect entries (always 
available) with Word options

Stores entries in templates; entries avail-
able only when the template is open

Provides other typing-related features, 
such as smart quotes and capitalization 
correction

Simply AutoText
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Chapter 6: Spell-Checking 
and the Thesaurus

In This Chapter
✓ Spell-checking your document with the spell checker

✓ Correcting your grammar with the grammar checker

✓ Using the thesaurus

✓ Employing the dictionary

This chapter shows you how to tap into several Word features designed to 
help you improve your writing. The spell checker automatically detects 

and offers to correct spelling mistakes. The grammar checker can help you 
avoid embarrassing gaffes such as using it’s rather than its or your rather than 
you’re. The thesaurus can help you find just the right word — the correct, 
true, accurate, and precise word. And the Word Research feature can help 
you look up words or topics in online dictionaries and encyclopedias.

Using the Spelling and Grammar Checker
I was voted Worst Speler in the sixth grade. Not that being Worst Speler 
qualifies me to run for president or anything, but it shows how much I 
appreciate computer spell checkers. Spelling makes no sense to me. Many 
years ago, I saw on public television the program The Story of English. It 
made me feel better. Now at least I know whom to blame for all the pecu-
liarities of English spelling: the Anglos, the Norms (including the guy from 
Cheers), and the Saxophones.

Fortunately, Word has a decent spell checker. In fact, the spell checker in 
Word is so smart that it knows that you made a spelling mistake almost 
before you make it. The spell checker watches over your shoulder as you 
type and helps you correct your spelling errors as you work.

By default, Word also checks for grammatical errors as you type. When it 
spots what it thinks is an error, it underlines the suspected text with a wavy 
green underline. You can right-click the underlined text to display a menu 
of suggested changes. If you choose Grammar from the menu that appears 
when you right-click the underlined text, the Grammar dialog box appears 
(see Figure 6-1).
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156 Using the Spelling and Grammar Checker

 

Figure 6-1: 
The 
Grammar 
dialog box.

 

You can use the spelling and grammar checker in two basic ways:

 ✦ Let it do its work, as you type your document, of pointing out and cor-
recting mistakes as you make them.

 ✦ Wait until you finish typing your document and then check it for spelling 
mistakes all at one time.

You can use whichever of these two techniques best fits your style. If you’re 
an especially bad speler and “grammerer,” you might want to use both fea-
tures for good measure.

Checking spelling as you go
Word’s on-the-fly spell checker watches over your shoulder as you type, 
politely pointing out spelling mistakes as you make them. The spell checker 
looks up in its dictionary every word you type, to ensure that you spelled it 
right. If you type something it can’t find in its dictionary, the spell checker 
underlines the mistake with a wavy red line, as shown in Figure 6-2.

 

Figure 6-2: 
The wavy 
red line. 
(Truly, it’s 
red.)

 

I tried to persuade the good people at John Wiley & Sons to spring for an 
expensive four-color printing process for this book so that you could see the 
red line shown in the figure. They informed me that they would be happy to 
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157Using the Spelling and Grammar Checker

oblige and that the added cost would be deducted from my royalty check. 
That’s when I realized that you could probably just pretend that the wavy 
black line shown in the figure is a wavy red line.

 

Word doesn’t beep, chime, or yell at you when you misspell a word. As a 
result, unless you watch the screen as you type, you might not immediately 
notice a spelling error. Periodically checking the screen is a good idea, even 
if you’re a 90-word-per-minute touch typist who never looks up.

In Figure 6-2, the word Speler is marked as misspelled. When you see the tell-
tale wavy red line (trust me, it’s red), you have these options:

 ✦ Make the correction: You can press Backspace to delete the word and 
then retype it with the correct spelling. After you do that, Word removes 
the wavy red underline.

 ✦ Let Word help: You can right-click the word to open a menu that lists 
suggested spellings for the word. In most cases, Word makes guesses 
about what you meant to type and suggests correctly spelled words. For 
example, when you right-click Spellor, these suggestions appear:

  Speller

  Spell or

  Spiller

  Spellers

  To replace the misspelled word with the correct spelling, just choose 
the correctly spelled word from the menu.

The quick menu that appears when you right-click a misspelled word also 
shows these commands:

 ✦ Ignore: Sometimes, you want to misspell a word on purpose. For exam-
ple, you might be writing a chapter about how to use the spell checker 
and you want to spell the word Spellor on purpose. In that case, you 
want to just ignore the misspelling. To do that, right-click the word and 
choose Ignore All. Then the spell checker ignores the word throughout 
the document.

 ✦ Ignore All: Like Ignore, but ignores all occurrences of the same misspell-
ing, not just this one.

 ✦ Add to Dictionary: In some cases, the underlined word is spelled cor-
rectly, after all; it just happens that the Word dictionary doesn’t recog-
nize it. Right-click the word and choose Add to Dictionary to add the 
word to the Word spelling dictionary. That way, Word won’t flag the 
word as misspelled in the future.
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 ✦ AutoCorrect: This command reveals a menu that lists the correct spell-
ing suggestions for the misspelled word. When you select a suggestion, 
Word creates an AutoCorrect entry that automatically corrects this 
spelling error from now on. Choose this option only for words you fre-
quently misspell that aren’t already in the AutoCorrect list.

  If you accidentally use this feature and then you want to remove the 
AutoCorrect entry it creates, don’t rely on the Undo command. The 
Undo command undoes the correction, but it doesn’t remove the 
AutoCorrect entry. To remove the AutoCorrect entry, choose File➪
Options and click the Proofing tab. Then click the AutoCorrect Options 
button, select the entry you want to remove from the list, and click 
Delete. Another way to reach the AutoCorrect Options dialog box is 
to right-click the wavy red line, select AutoCorrect, and then select 
AutoCorrect Options from the drop-down list.

 ✦ Language: This command lets you open the Language dialog box, shown 
in Figure 6-3. You use this dialog box to specify the language dictionary 
that Word uses to check your spelling. You can also use it to suspend 
spell-checking for the entire paragraph.

 

Figure 6-3: 
The 
Language 
dialog box.

 

 The spell checker can’t tell you when you use the wrong word if you spell it 
correctly. For example, you might type dime navels when you mean dime 
novels. Cheap literature may be a bad thing, but cheap citrus certainly is not.

Checking for grammatical errors
By default, Word checks for grammatical errors as you type. When it spots 
what it thinks is an error, it underlines the suspected text with a wavy green 
underline. You can right-click the underlined text to display a menu of sug-
gested changes. If you choose Grammar from the menu, the Grammar dialog 
box appears (refer to Figure 6-1).
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159Using the Spelling and Grammar Checker

You can ignore your mistake or ask the Grammar dialog box to help you 
understand the errors of your ways by clicking the Explain button. This 
action opens the Word Help dialog box, which attempts to instruct you to a 
better grammar way. You can also access this option when you right-click 
the underlined text by choosing About This Sentence.

Spell and grammar checking after the fact
If you prefer to ignore the constant nagging by Word about your spelling, 
you can always check your spelling and grammar the old-fashioned way: Run 
the spell checker after you finish your document. The spell checker works 
its way through your entire document, looking up every word in its massive 
list of correctly spelled words and calling to your attention any misspelled 
words. It performs this task without giggling or snickering. As a bonus, the 
spell checker even gives you the opportunity to tell it that you’re right and 
it’s wrong and that it should discern how to spell words the way you do.

These steps show you how to check the spelling for an entire document:

 1. If the document you want to check isn’t already open, open it.

 2. Fire up the spelling and grammar checker.

  Click the Spelling & Grammar button in the Proofing group on the 
Review tab on the Ribbon, or press F7.

 3. Don’t be startled if Word finds a spelling or grammatical error, or 
both.

  If Word finds a spelling error, it displays the misspelled word along with 
a suggested correction, as shown in Figure 6-4.

  If Word finds a grammatical error, it displays the error word (or words) 
along with a suggested correction, as shown in Figure 6-5.

 

Figure 6-4: 
The Spelling 
and 
Grammar 
dialog box, 
on spelling.
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Figure 6-5: 
The Spelling 
and 
Grammar 
dialog box, 
on grammar.

 

 4. Select the correct spelling or laugh in Word’s face.

  If you agree that the word is misspelled (or your grammar is off), skim 
the list of corrections that Word offers and select the one you like. Then 
click the Change button. Other options at your disposal include

 • Ignore Once: Choose this option to tell the Spelling and Grammar 
checker to ignore the alleged error. You click this button nine times 
out of ten (with the possible exception of Cancel).

 • Ignore Rule: The grammar checker ignores the rule that caused it to 
flag the text. After Word incorrectly accuses you of using sentence 
fragments 10 or 12 times in a row, you might want to click this button 
to make it stop.

 • Next Sentence: Many times, the grammar checker reports multiple 
errors for a single sentence. You can often tell when the grammar 
checker is making neither heads nor tails out of a sentence. For 
example, the grammar checker usually has trouble with headings 
and captions and other bits of text that aren’t complete sentences. 
Rather than wade through message after message for these non-sen-
tences, you can click Next Sentence to direct the grammar checker to 
skip ahead to the next sentence.

 • Change: Click this button to edit the word or sentence directly in the 
Grammar dialog box and then record your change in the document.

 • Explain: The grammar checker displays a description of the rule that 
caused the sentence to be flagged as a possible error. Some explana-
tions are brief; others are elaborate grammar lessons.

 • Options: Opens the Word Options dialog box so that you can change 
the behavior of the grammar checker or spelling options.

 • Undo: Undoes the last grammar checker action.

 • Cancel: This button is my favorite one in the Grammar dialog box.

 5. Repeat Step 4 until Word gives up.
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161Using the Thesaurus

 6. Click OK when you see this message:

The spelling and grammar check is complete.

  You’re finished.

If Word detects a repeated word (that is, the same word twice in a row), it 
displays a variation of the Spelling and Grammar dialog box that gives you 
two choices: Ignore Once or Delete. To repeat the word, click Ignore. To 
delete the second occurrence of the repeated word, click Delete.

 

If Word can’t come up with a suggestion or if none of its suggestions is cor-
rect, you can type your own correction directly in the box showing the text 
with the error and click the Change button. If the word that you type isn’t in 
the dictionary, Word asks whether you’re sure you know what you’re doing. 
Double-check and click Yes if you mean it.

If you grow tired of Word’s running complaint about a word that isn’t in its 
standard dictionary, click Add to Dictionary to add the word to the custom 
dictionary. If you can’t sleep at night until you know more about the custom 
dictionary, see the earlier section “Checking spelling as you go.”

 

The speller can’t tell the difference between pairs of words: your and you’re, 
ours and hours, and angel and angle, for example. In other words, if the word 
is in the dictionary, Word passes it by regardless of whether you used the 
word correctly. The Word spell checker, therefore, is no substitute for good, 
old-fashioned proofreading. Print your document, sit down with a cup of tea 
(or bourbon), and read it.

If you’re interested only in checking the spelling of your document after 
opening the Spelling and Grammar dialog box, select the Spelling & Grammar 
button in the Proofing group on the Review tab on the Ribbon, or press F7. 
Then deselect the Check Grammar check box in the lower-left corner of the 
dialog box.

Using the Thesaurus
One nifty Word feature is a built-in thesaurus that can quickly show you syn-
onyms for a word you type. Using it is easy:

 1. Right-click a word you typed and choose Synonyms from the menu 
that appears.

  A menu that lists synonyms for the word appears. (Sometimes, Word 
throws an antonym into the list, just to be contrary.)

 2. Click the word that you want to replace your word.

  Word replaces the original word with your selection.
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If you choose Thesaurus from the Synonyms menu, the Thesaurus section 
of the Research task pane appears with synonyms listed, as shown in Figure 
6-6. You can also summon this task pane by clicking the Thesaurus button in 
the Proofing group on the Review tab on the Ribbon or by pressing Shift+F7. 
Use the Thesaurus task pane to look up words to find even more synonyms.

 

Figure 6-6: 
The 
Thesaurus 
task pane.

 

For example, if you type sometimes in the Search For text box and click the 
Start Searching button (the arrow pointing to the right in the green square) 
or press Enter, the results of your search are displayed in the window below. 
One replacement option is on occasion. If you then select that phrase, a 
whole new list of words is presented. You can keep clicking words to find 
other synonyms as long as you like, until you’re ready to get back to real 
work. Use the Back button above the results window to navigate back to an 
earlier results pane. After you go back, the Forward arrow becomes avail-
able. Use the drop-down lists attached to either button to quickly navigate to 
a specific results list.

As you hover the mouse over the results list of synonyms, a drop-down 
button appears to the right of the word and lets you insert the word into 
your document, copy it to the Clipboard, or look up its definition. If you want 
to show results from, say, a French thesaurus, use the drop-down list under 
the Search For text box to specify which resources are used for your search.

 

Use the Research Options link at the bottom of the Research task pane to 
open the Research Options dialog box. You can then add or remove reference 
books and online resources by selecting or deselecting their check boxes.
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163Using Other Proofing Tools

Using Other Proofing Tools
In addition to the Spelling & Grammar button and the Thesaurus button, 
the Proofing and Language groups on the Review tab on the Ribbon contain 
more buttons to assist you:

 ✦ Research: Opens the Research task pane with the Bing search option 
initially selected. Simply enter your criteria in the Search For text box. 
Alternatively, you can highlight the text you’re working on before you 
click the Research button.

 ✦ Translate: Translates your text into a different language. Choose from 
these three options: Translate Document, Translate Selected Text, and 
Mini Translator, which translates just a single word or phrase. You can 
also choose the Choose Translation Language option to specify the lan-
guage you want to translate to. 

 ✦ Language: Reveals a menu with two choices. The first, Set Proofing 
Language, lets you change the language used to check the spelling 
and grammar of a particular portion of text. The second, Language 
Preferences, lets you change the language used by Word’s user interface.

 ✦ Word Count: Open the Word Count dialog box to display “vital statis-
tics” about a document. To find out how many words are in a particular 
paragraph or sentence of your document, for example, select the text 
you want to count and click this button. Figure 6-7 shows the vital statis-
tics for this paragraph.

 

Figure 6-7: 
Word Count 
in action.

 

 

The status bar displays the total number of words in your document at all 
times. If you’re solely interested in the number of words in a selection of text 
and not all the various information that’s shown when using the Word Count 
button, select the text and glance at the status bar, which tells you how 
many words in the entire document you have selected.
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Chapter 1: Basic Page Formatting 
and Sections

In This Chapter
✓ Setting margins and page size and other basic page formats

✓ Adding page numbers to document pages

✓ Creating headers and footers

✓ Understanding the relationship between sections and page layout

✓ Creating section breaks

Although character and paragraph formatting determine how text looks, 
page formatting provides the container to hold all your beautiful con-

tent. Tall pages, wide pages, pages with wide margins to make four pages of 
text meet your teacher’s five-page requirement — you can set up all these 
options with page formatting.

Word doesn’t restrict you to using only one page format in a document. You 
can have as many different page formats as you want as long as you keep 
each one in its own section. Each section can have its own page number and 
text that appears at the top of each page (a header) or the bottom (a footer). 
Sections can even have different margins or different paper sizes.

Of course, you don’t have to have more than one section in a document; 
in fact, most often a document is just one big, happy section all by itself. 
But that’s okay, and the information in this chapter applies to one section 
just as well as to many, including such important tasks as setting up page 
margins, flipping pages from portrait to landscape orientation, and creating 
headers or footers at the top or bottom of every page.

Formatting the Page
The Page Layout tab on the Ribbon provides controls for the various page 
layout formats. The Page Layout tab has five groups, but only one of them 
has much to do with the way you arrange the available space on a page. It’s 
the Page Setup group on the Page Layout tab that’s most useful when you 
want to arrange the way text fits on a page.
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168 Formatting the Page

I also talk about the Page Background group in this chapter because it fits 
well with the rest of the material. But the Paragraph group is covered in 
Book II, Chapter 2; themes are in Book II, Chapter 3; and the Arrange group is 
in Book IV.

Setting margins
The margins of your document determine the part of the pages that Word 
uses to position your text. For example, when you start typing on a page, 
the text starts at the top margin, and when you center text, it’s centered 
between the left and right margins.

 

You can control whether the top and bottom margins are displayed in Print 
Layout view by double-clicking the lines that mark the top and bottom page 
boundaries. You can also change this setting by using the Show White Space 
between Pages in Print Layout View option on the Display tab of the Word 
Options dialog box. (For more on views, turn to Chapter 2 of Book I.)

Selecting a preset page margin
To change the margins of your page, select the Page Layout tab on the 
Ribbon and then click the Margins button to display the gallery shown in 
Figure 1-1.

 

Figure 1-1: 
The gallery 
of page 
margin 
choices.

 

The choices in the gallery include the new standard settings for Word 2010 
(1 inch on each of the four sides) as well as the old Word 2003 standard (1.25 
inches on the left and right sides). Select a preset page margin to quickly 
specify the top, bottom, left, and right margins of your page. Here are some 
more options on the list:
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 ✦ Narrow: Lets you squeeze more text on your page but makes the mar-
gins quite small (only half an inch).

 ✦ Moderate: Helps you squeeze just a little more text on your pages.

 ✦ Wide: Leaves hardly any room for text.

 ✦ Mirrored: Makes your left and right pages behave differently and then 
sets the inner margin to be slightly wider than the outer margin (which 
is useful if you’re printing double-sided and planning to staple your 
pages together along the inner edge).

Using Page Setup to control margins
If the choices in the gallery aren’t enough for you, you can display the 
Margins tab of the Page Setup dialog box by selecting Custom Margins from 
the bottom of the gallery. Figure 1-2 shows the Margins tab of the Page Setup 
dialog box.

 

Figure 1-2: 
The Margins 
tab of the 
Page Setup 
dialog box.

 

Normally, this dialog box contains these options for setting margins:

 ✦ Top: Sets the distance from the top of the page to the first line of text. 
The default is 1".

 ✦ Bottom: Sets the distance from the bottom of the page to the last line of 
text. The default is 1".
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170 Formatting the Page

 ✦ Left: Sets the distance from the left edge of the page to the start of the 
text. The default is 1".

 ✦ Right: Sets the distance from the right edge of the page to the end of the 
text. The default is 1".

 ✦ Gutter: Sets an additional amount of margin space for pages that are to 
be bound. The space is added to the left or top margin, depending on 
the Gutter Position setting, unless you select Mirror Margins, 2 Pages 
Per Sheet, or Book Fold for the Multiple Pages option.

When working with the gallery from the Ribbon, the margins you set are 
applied to the current section (which is usually the same as your entire 
document). You can apply the settings to the entire document by pressing 
Ctrl+A to select the document and then selecting from the gallery. The Page 
Setup dialog box gives you more precise control of the Apply To drop-down 
list. You use this control to decide whether to apply the settings

 ✦ To the Whole Document

 ✦ From This Point Forward (which inserts a section break)

 ✦ To This Section (the current section)

 ✦ To Selected Sections (multiple sections if you’ve selected across a sec-
tion break)

For more on sections, see “Understanding Sections,” later in this chapter.

The Multiple Pages drop-down list lets you control how pages are laid out on 
the sheets of paper that the printer spits out. The options are

 ✦ Normal: You see one page per sheet.

 ✦ Mirror Margins: The left and right margins switch places every other 
page.

 ✦ 2 Pages Per Sheet: You see two pages per sheet.

 ✦ Book Fold: You can print booklets. For more information, see the follow-
ing sidebar, “Printing booklets.”

If you select the Mirror Margins option from the Multiple Pages drop-down 
list, the Margins tab changes, as shown in Figure 1-3. The Left and Right 
options change to Inside and Outside, and the Gutter Position option 
becomes unavailable. This setting allows the margins on each page to 
alternate: On odd-numbered pages, the inside margin is on the left; on even-
numbered pages, the inside margin is on the right. Any additional space pro-
vided for by the Gutter field is added to the inside margin.
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Figure 1-3: 
The Margins 
tab with 
Mirror 
Margins 
selected.

 

Setting orientation
The Orientation button on the Page Layout tab on the Ribbon displays a 
gallery with two choices:

 ✦ Portrait: Orients the paper in an upright position, where the height is 
greater than the width.

 ✦ Landscape: Orients the paper sideways so that the width is greater 
than the height. When you switch from Portrait to Landscape (and vice 
versa), the Height and Width values are automatically swapped.

Choosing a paper size
The Size gallery on the Page Layout tab on the Ribbon contains a list of avail-
able paper sizes for your computer and printer, which are probably more 
choices than you have paper in your house. Fortunately, the most commonly 
used size (Letter) is at the top, and the slightly longer Legal option is just an 
item away. Select the paper size you want to use for the current section and 
you’re done with this gallery.

If you want greater control, select the More Paper Sizes option from the 
bottom of the gallery to display the Paper tab of the Page Setup dialog box, 
shown in Figure 1-4.
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172 Formatting the Page

 

Figure 1-4: 
The Paper 
tab of the 
Page Setup 
dialog box.

 

The Paper tab includes these options for setting the paper size:

 ✦ Paper Size: Sets the paper size. You can pick from a variety of sizes in 
the drop-down list, including Letter and Legal and other envelope sizes.

 ✦ Width: Sets the width of the paper. This field is automatically set when 
you choose a paper size. If you change the value of this field, the name 
of the Paper Size field changes to Custom Size.

 ✦ Height: Sets the height of the paper. This field is also set automatically 
according to the paper size you select, and changing the height auto-
matically changes the Paper Size field to Custom Size.

The Paper tab also has the following controls for telling your printer which 
paper to use for the pages in your document (controls that are quite useful if 
your document is supposed to use letterhead only on the first page):

 ✦ Paper Source — First Page: Specifies which paper tray the printer uses 
for the first page of your document

 ✦ Paper Source — Other Pages: Specifies which paper tray the printer 
uses for the second and subsequent pages of your document

18_487662-bk03ch01.indd   17218_487662-bk03ch01.indd   172 4/15/10   8:35 PM4/15/10   8:35 PM



Book III

Chapter 1

B
a

sic
 P

a
g

e
 

Fo
rm

a
ttin

g
 a

n
d

 
S

e
c

tio
n

s
173Formatting the Page

As with the other tabs in the Page Setup dialog box, you can use the Apply 
To control to specify which parts of your document are formatted with the 
new settings. For more on sections, see “Understanding Sections,” later in 
this chapter.

 

In most cases, you use the same paper source for all pages (both First Page 
and Other Pages). However, using a different paper source for the first page 
of business letters is common.

The Paper tab also has a Print Options button that opens a dialog box filled 
with options to control how Word displays text and works with your printer.

Choosing layout options
The third tab of the Page Setup dialog box is named Layout, which sounds 
more exciting than it is. (You can open this dialog box by clicking the dialog 
box launcher, a little square control, in the lower-right corner of the Page 
Setup group, as shown in Figure 1-5.) The word layout conjures up hopes of 
an all-encompassing dialog box in which you can control at least the major 
aspects of your document’s layout. Alas, the lowly Layout tab should have 
been named Leftovers because it contains nothing but a few obscure layout 
options that apparently didn’t seem to fit anywhere else. The Layout tab is 
shown in Figure 1-6.

The Book Fold option in the Multiple Pages 
drop-down list on the Margins tab of the Page 
Setup dialog box (wow, that’s a mouthful) lets 
you create booklets from pages you fold in half 
and staple in the middle. If you’ve ever assem-
bled that type of booklet, you know that you 
can’t just print the pages in order. Instead, the 
first sheet of paper must have the first and last 
page on one side, and the second and next-to-
last page on the other. Each additional sheet 
must have pages that alternate from the front 
of the booklet to the back. The only sheet that 
has two consecutive pages side by side is the 
sheet in the middle.

If you select the Book Fold option, Word auto-
matically shuffles the pages correctly when 
you print your document so that they come out 
ready to be folded in half and stapled together. 
This option is an enormous timesaver if you 
want to create religious tracts or company 
songbooks or any other kind of booklet.

If you have no fancy printer that can automati-
cally print on both sides of the page, choose 
the Manually Print on Both Sides option on the 
Print page in Backstage view when you print 
your booklet. Word prints the front side of each 
page of the booklet and then tells you to take 
out the pages and reinsert them into the print-
er’s paper tray to print the backsides.

Printing booklets
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174 Formatting the Page

 

Figure 1-5: 
The magic 
spot for 
launching 
the Page 
Setup dialog 
box.

 

Dialog box launcher

 

Figure 1-6: 
The Layout 
tab of the 
Page Setup 
dialog box.

 

Counting the lines in your document
The Line Numbers control must be the most important command on the 
Layout tab because it has its own gallery control on the Page Layout tab on 
the Ribbon. Line numbers appear in the margin of your document to count 
the lines. Figure 1-7 shows an example of a document with line numbers.

The Line Numbers gallery, shown in Figure 1-8, lets you turn line number-
ing on or off for the current section and also control when the numbering 
restarts. (Continuous on the menu means that the numbering never restarts 
until you move to another document.) This gallery is perhaps most useful 
because it includes the Suppress for Current Paragraph command, which 
lets you skip the current paragraph in the count.
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Figure 1-7: 
A document 
with line 
numbers.

 

 

Figure 1-8: 
The Line 
Numbers 
gallery.

 

The Line Numbering Options command opens the Layout tab of the Page 
Setup dialog box, where you have to click the Line Numbers button to open 
the Line Numbers dialog box, shown in Figure 1-9. This dialog box gives you 
more control over the formatting of line numbers. (Microsoft wanted to give 
you a little more exercise rather than open the dialog box for you.)

 

Figure 1-9: 
The Line 
Numbers 
dialog box.

 

The most useful part of this dialog box is the setting to control which incre-
ment of lines is printed. (The values most commonly used are 5 and 10.) 
Each line is still counted, but the numbers between the increment values are 
hidden. You can also set a starting value for the line numbers as well as the 
same options that are in the gallery — whether line numbering restarts for 
each page or section or is continuous for the entire document.
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176 Hyphenating Your Text

Formatting sections
The only other command on the Layout tab of the Page Setup dialog box 
that relates to a button on the Ribbon is the one for controlling how sections 
start. The Breaks button on the Ribbon includes several different types of 
separators that you can insert into your text, including the standard page 
break (Ctrl+Enter), a column break, and the various forms of the section 
break. You can use the Breaks gallery to insert section breaks, but you need 
to use the Section Starts drop-down list on the Layout tab of the Page Setup 
dialog box to change a section after it’s inserted.

Use the following commands (found on the Layout tab of the Page Setup 
dialog box; refer to Figure 1-5) to control section breaks and format a page in 
general:

 ✦ Section Start: This drop-down list offers essentially the same options 
that are available from the Breaks gallery in the Page Setup group on the 
Page Layout tab. Section Start lets you change the section break type for 
the current section. For example, if you create the section and originally 
specify Odd Page but now you want to change it to New Page, you make 
the change with this option. (For more about different types of section 
breaks, see “Creating section breaks,” later in this chapter.)

 ✦ Vertical Alignment: Top is the default setting. (Center, Justified, and 
Bottom are the others.) Use Center if you want to center a title in the 
middle of the page and don’t want to press Enter a dozen times to center 
it. (I’ve never found a use for Justified or Bottom.)

 ✦ Borders: Open the Page Border tab of the Borders and Shading dialog 
box, where you can add a border to every page of the document.

 ✦ Different Odd and Even and Different First Page: These two options let 
you set up different headers and footers for even and odd pages or for 
the first page in a section. This option is useful if you’re printing on both 
sides of the page or if you don’t want the header to appear on the first 
page. Read the section “Working with Headers and Footers,” later in this 
chapter, for more on headers and footers.

 ✦ Header: Specify the distance from the top of the page to the header 
area. The default is 0.5".

 ✦ Footer: Specify the distance from the bottom of the page to the footer 
area. The default is 0.5".

Hyphenating Your Text
Word can automatically hyphenate words rather than break lines between 
words. Hyphenating words results in less empty space on each line, which 
is important when using justified alignment or working with columns. You 
can set up hyphenation so that Word hyphenates your words as you type 
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them, or you can wait until after you type your text and then let Word auto-
matically hyphenate the document. Hyphenating as you type can slow down 
Word, especially if you don’t have a blazingly fast computer. I suggest that 
you type your document first and then hyphenate it. Here’s how:

 1. Type your text.

  Don’t worry about hyphens during this step.

 2. Select Automatic from the Hyphenation gallery, located in the Page 
Setup group on the Page Layout tab.

  Word hyphenates the document.

 3. Check the results.

  You might not be happy with the Word hyphenations. Always check the 
results and make any necessary corrections.

If you aren’t happy with the way Word hyphenates your document, you 
can click the Hyphenation Options command to gain greater control over 
Word (or at least over the way it’s hyphenating your document). Using the 
Hyphenation dialog box, shown in Figure 1-10, you can

 ✦ Deselect the Hyphenate Words in CAPS check box if you don’t want to 
hyphenate words made entirely of capital letters. This option is useful 
if your writing includes specialized jargon that appears in all capital let-
ters and shouldn’t be hyphenated. For example, if you use terms such 
as TECHNOBABBLE VOCABULATOR that must not, under any circum-
stances, be hyphenated, you’ll love this option.

 ✦ Adjust the hyphenation zone if you’re picky. This zone is the area in 
which Word tries to end each line. If necessary, Word hyphenates words 
that cross into this zone. If you make this zone larger, Word hyphenates 
more words, but sometimes it results in lines that look too spaced out (for 
justified text) or right margins that are too ragged (for left-aligned text).

 ✦ Set the Limit Consecutive Hyphens To list box to 3 or 4. Having two 
hyphens in a row isn’t wrong, and three is okay once in a while. But the 
default Word setting for this field places no limit on the number of con-
secutive lines that Word can hyphenate. You don’t want to see a page of 
20 hyphenated lines, do you?

 

Figure 1-10: 
The 
Hyphenation 
dialog box.
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178 Inserting Page Numbers

Here are some hyphenation pointers to keep in mind:

 ✦ Word uses its dictionary to determine where to hyphenate words. It 
probably spells better than you do. (I know it spells better than I do!)

 ✦ If you want to cause Word to hyphenate a word at a particular spot, 
place the cursor wherever you want the word hyphenated and press 
Ctrl+– (the hyphen). Pressing this shortcut creates an optional hyphen, 
which is displayed only when the word falls at the end of a line.

 ✦ Do not hyphenate a broken word at the end of a line simply by typing 
a hyphen. It might work for now, but if you later edit the text so that 
the hyphenated word no longer falls at the end of a line, the hyphen 
still appears, now in the middle of the line where it doesn’t belong. Use 
Ctrl+– instead.

 ✦ Sometimes you want to insert a hyphen in a compound word but you 
don’t want the word to be split at the end of the line, because it might 
look funny — for example, G-Men (a movie title). In that case, press 
Ctrl+Shift+–, rather than the hyphen key alone, to create the hyphen. 
Word displays the hyphen but doesn’t break the word at the hyphen.

 

✦ If you click the Manual option in the Hyphenation gallery, Word leads 
you through the entire document, asking you about each word it wants 
to hyphenate, which is tiresome beyond belief. Just hyphenate the docu-
ment and then review it and remove any hyphens you don’t like.

Inserting Page Numbers
Headers and footers, which I describe in detail in the next section, are useful 
for inserting information at the top or bottom of every page. The most 
common type of information in a header or footer is the page number. If 
the only information you want to appear in your header or footer is a page 
number, you don’t even have to mess with headers and footers. Instead, just 
use the Page Numbers gallery from the Insert tab by following these steps:

 1. Click the Page Number button on the Insert tab.

  The Page Number gallery appears. It lets you decide where you want the 
page numbers to be located.

 2. Set the page number position by selecting from the gallery.

  The choices are Top of Page, Bottom of Page, Page Margins, and Current 
Position. Each position displays a collection of preformatted page num-
bering. The display for the Bottom of Page option is shown in Figure 1-11.

 3. Select the format you want to use for your page numbers.

  Word updates your document to show the selected page numbers.
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Figure 1-11: 
The 
choices for 
numbering 
your pages 
at the 
bottom of 
the page.

 

For greater control, you can click the Format Page Numbers command at 
the bottom of the gallery. The Page Number Format dialog box appears, as 
shown in Figure 1-12.

 

Figure 1-12: 
The Page 
Number 
Format 
dialog box.

 

This dialog box lets you control several aspects of page numbering. For 
starters, you can change the page number format by selecting an option 
from the Number Format drop-down list. You can choose normal Arabic 
numbering (for example, 1, 2, 3), upper- or lowercase letters (A, B, C or a, b, 
c), or upper- or lowercase roman numbering (I, II, III or i, ii, iii).

You can select the Include Chapter Number option to create compound page 
numbers that include a number drawn from a heading paragraph, such as 
1-1, 1-2, and so on. Follow these steps:
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180 Working with Headers and Footers

 1. Format the chapter headings by using one of the built-in Word head-
ing styles.

  In most cases, you should use the Heading 1 style.

 2. Choose a list format that numbers the headings. (For more informa-
tion about working with numbering, see Chapter 3 in this minibook.)

 3. Click the Page Number button on the Insert tab.

  The Page Number gallery shows up.

 4. Select the Format Page Numbers command to summon the Page 
Number Format dialog box.

 5. Select the Include Chapter Number check box and then indicate which 
style to use for the chapter titles and which character you want to use 
as a separator between the chapter number and the page number.

  You can use a hyphen, period, colon, or dash as the separator.

 6. Click OK to insert the page numbers into the document.

The Page Number Format command also lets you set a starting page number 
for the document or section. Usually, you use Continue from Previous 
Section in the Page Numbering section of the Page Number Format dialog 
box so that page numbers are continuous throughout the document. 
However, if you created a separate section for front matter (such as a title 
page or table of contents, for example), restarting the page numbers at page 
1 for the first chapter of the document is customary.

Working with Headers and Footers
The Page Number command is useful if the only element you want to 
appear at the top or bottom of a page is a plain, unadorned page number. 
Fortunately, Word provides two other galleries in the Header & Footer group 
(on the Insert tab) to give you more options. To add a header to the top of 
your pages, select from the Header gallery. To add a footer to the bottom of 
your pages, select from the Footer gallery. When you add a header or footer, 
Word activates the Header and Footer area and displays, on the Ribbon, the 
Header & Footer Tools tabs with the Design tab active. The body of your 
document remains visible but is dimmed to indicate that you cannot edit it. 
See Figure 1-13.

 

You can activate the header or footer area by double-clicking over the 
header or footer. Be careful not to double-click between the pages in Print 
Layout view (see Chapter 2 of Book I for more on views), or else you hide the 
space between the pages rather than activate the header or footer area.
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Figure 1-13: 
Document 
text dims 
while you 
work with 
a header or 
footer.

 

The Design tab (on the Header & Footer Tools context tab) provides the 
same three galleries that are in the Header & Footer group of the Insert tab 
along with commands for creating your own headers and footers. Table 1-1 
describes the function of the buttons on this Design tab.

Table 1-1 Header & Footer Tools Design Tab Buttons

Button What You Can Do with It

Insert a variety of predefined headers.

Insert a variety of predefined footers.

Insert a variety of predefined page numbers, which can be in the 
header or footer.

Insert a marker to be replaced by the current date or time or both.

(continued)
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Table 1-1 (continued)

Button What You Can Do with It

Insert document properties or fields.

Insert a picture.

Insert ClipArt.

Switch from the footer to the header area.

Switch from the header to the footer area.

If the document has more than one section, move to the header 
of the previous section.

If the document has more than one section, move to the header 
of the following section.

Make a header or footer identical to the one in the preceding 
section.

Insert a different header and footer on page 1. (You can also set 
this option on the Layout tab of the Page Setup dialog box.)

Insert a different header and footer on even and odd pages. (You 
can also set this on the Layout tab of the Page Setup dialog box.)

Control whether the document text is dimmed or not even shown.

Set the position of the beginning of the header area. (You can also 
set this option on the Layout tab of the Page Setup dialog box.)

Set the position of the end of the footer area. (You can also set 
this option on the Layout tab of the Page Setup dialog box.)

Insert a special tab character that aligns the text following it 
relative to the margins. Unlike tabs that rely on tab stops to 
determine position, these alignment tabs change position as the 
margin changes. This option is most useful for positioning ele-
ments at the right margin. If you change the margin using a tra-
ditional tab and tab stop, you also have to move the tab stop. But 
by using an alignment tab, the position is automatically updated.

Return the focus to the document so that the document text is 
shown normally and the header and footer are dimmed.
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You can type anything you want in the header or footer areas, and you can 
apply any type of formatting you want. By default, Word creates a centered 
tab stop set dead in the middle of the page and a right-aligned tab stop at 
the right margin. As a result, you can use the Tab key to create a header that 
has some text flush against the left margin, some more text centered on the 
page, and still more text flush against the right margin.

 

You can often spruce up the appearance of a page by adding a border line 
beneath the header or above the footer. Just use the Borders gallery on the 
Home tab.

Understanding Sections
The section is the basis of Word’s page layout formatting. Most documents 
consist of only a single section, so all pages in the document receive the 
same formatting. If some pages require different formatting, you can break 
the document into two or more sections, each with its own page format.

Sections control the following formatting information:

 ✦ The size of the paper

 ✦ The left, right, top, and bottom margins

Adding a button to show headers
If you create a lot of documents that have head-
ers and footers, you might want a more conve-
nient way to access them. Unfortunately, the 
standard Word setup doesn’t have a Header 
and Footer button, though you can create one 
yourself easily enough. Just follow these steps:

 1. Choose File➪Options and click the Quick 
Access Toolbar entry.

  You see the Customize view of your options.

 2. In the Categories list, select All Commands.

 3. Select the Edit Header command from the 
list on the left.

  It’s listed in alphabetical order, so it’s easy 
to find.

 4. Click the Add button.

  This step adds the button to the ones on 
your Quick Access toolbar. You can use 
the up and down arrows on the right side 
of the list to change the order in which the 
buttons appear.

 5. Click OK to dismiss the Word Options 
dialog box.

  The Edit Header is added to the Quick 
Access toolbar, making it quite easy to find.
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 ✦ The orientation of the paper — that is, whether the document is printed 
in portrait mode (height is larger than width) or landscape mode (width 
is larger than height)

 ✦ The number and spacing of columns

 ✦ Header and footer information, including the positioning of the header 
or footer as well as its appearance

 ✦ Footnotes and endnotes, again including the positioning and appearance 
of the footnotes and endnotes

 ✦ Page numbering

 ✦ Line numbering

One of the most confusing aspects of working with sections is that a single 
page can contain more than one section. For example, a page might start 
off with a single-column layout, and then switch to two columns, and then 
switch back to a single column. Such a page has three sections.

Unfortunately, Word doesn’t include one convenient command that allows 
you to set all these formats from one location. In fact, you don’t even set 
most of the section formats from the same tab. Instead, section formatting is 
scattered about the Ribbon tabs:

 ✦ The Page Layout tab: The commands on this tab let you set basic page 
formatting information such as margins, the position of headers and 
footers, and paper size and orientation. It’s also where you find the 
Breaks gallery, which lets you insert new sections. You can specify the 
number of columns and the size and spacing of each column. (For more 
information about columns, see Chapter 2 of this minibook.)

 ✦ The Header & Footer group on the Insert tab: These commands let you 
add a page number to your pages or add even more complex headers 
or footers. All settings relating to headers or footers can be set indepen-
dently for each section.

 

 The Design tab (on the Header & Footer Tools context tab) also relates 
to sections and lets you vary the page numbering style and set the start-
ing page number for the section.

 ✦ The References tab: These commands let you create footnotes or end-
notes and control their appearance and position. (I cover this topic in 
Book VI, Chapter 2.)

All documents contain at least one section. In documents with only one sec-
tion, the section formatting information is stored in the last paragraph mark 
of the document along with the last paragraph’s paragraph formats. If a doc-
ument contains two or more sections, the end of each section (except the 
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185Understanding Sections

last one) is indicated by a section break, as shown in Figure 1-14. To see the 
section break, you must be viewing the paragraph marks; use the Show/Hide 
Paragraphs button on the Home tab to specify whether they’re showing.

 

Figure 1-14: 
The section 
mark.

 

The section break contains the section formatting information, just as a 
paragraph mark contains paragraph formatting. As a result, if you delete a 
section break, the sections before and after the break combine and use the 
formatting information from the section that followed the break. The text in 
parentheses shows you how the start of the section is set (Continuous, Next 
Page, Even Page, or Odd Page).

The one thing that the commands relating to sections usually have in 
common is the Apply To drop-down list (like the one in the Page Setup 
dialog box). The settings on this list let you decide which sections within the 
document receive the formatting you selected. The choices are

 ✦ Whole Document: The formatting is applied to the entire document, 
including any existing sections.

 ✦ This Point Forward: Word adds a section break at the cursor position 
and applies the formatting to the new section. Thus, text that follows the 
cursor is formatted but text in front of it is not. If your document already 
contains sections, the formatting is applied only from the current point 
to the end of the current section.

 ✦ This Section: This option is available only if your document has more 
than one section and your current selection is entirely within the same 
section; compare this option with the one in the following bullet. The 
changes are applied only to the current section.

 ✦ Selected Sections: This option is available only if your document has 
more than one section and your current selection is in more than one 
section; compare this option to the one in the previous bullet. The 
changes are applied to all sections that include any part of the selec-
tion. So if your selection is from the middle of the first section to the 
middle of the third section, the changes are applied to the first, second, 
and third sections because a part of each one was included in the selec-
tion. (Section and selection sound much the same when you’re trying to 
understand this concept — how annoying.)

 ✦ Selected Text: This option is available only if you selected some text 
before setting the formatting. When you select this option, a section 
break is inserted before and after the selected text.
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186 Understanding Sections

Creating section breaks
You can create a new section in several ways. One is to use the Breaks gal-
lery from the Page Layout tab on the Ribbon. You can use this method to 
create a new section that inherits the formatting of the previous section. You 
can then make whatever formatting changes you want to the new section. To 
create a new section in this manner, follow these steps:

 1. Position the cursor at the spot where you want the new section to 
begin.

 2. Click the Breaks button on the Page Layout tab.

  The Breaks gallery appears, as shown in Figure 1-15.

 

Figure 1-15: 
The Breaks 
gallery lists 
section 
breaks in 
its bottom 
portion.

 

 3. Select one of these four section break types:

 • Next Page: Creates a new section that begins at the top of the 
following page.

 • Continuous: Creates a new section that begins on the next line of the 
same page. This type of section break is commonly used in changing 
the number of columns on a page.

 • Even Page: Creates a new section that begins on the next even-
numbered page.

 • Odd Page: Creates a new section that begins on the next odd-
numbered page.
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187Understanding Sections

 

You can also use the Breaks gallery to create a page break or a column break. 
A page break simply “skips” the text to the top of the next page without start-
ing a new section. A column break skips to the top of the next column. For 
more information about column breaks, see Chapter 2 of this minibook.

Creating sections with different page numbers
Many documents require sections that have different page number formats. 
For example, many documents require that the first page or two — a cover 
page and perhaps an inside title page — have no page numbers. Then a 
section of front matter begins, including a table of contents, an acknowledg-
ments page, and perhaps a preface, foreword, or introduction, which can be 
numbered with roman numerals (i, ii, iii). Then the body of the document 
begins, numbered with Arabic numerals starting with 1.

To create a document of this sort, you must use sections to format groups of 
pages with different numbering schemes. You don’t have to perform a spe-
cial action for the first group of pages — the ones with no page numbers.

To create the proper page numbering for the front matter, follow these steps:

 1. Place the cursor at the beginning of the front matter.

  If you already inserted a page break so that the first page of the front 
matter begins at the top of a new page, delete the page break. You’ll 
insert a section break that forces the front matter to start atop a new 
page later in this procedure.

 2. Click the Breaks button on the Page Layout tab to display the Breaks 
gallery.

 3. Choose Next Page.

  This action inserts the section break that forces the front matter to start 
at the top of the next page.

 4. (Optional) Choose Edit Footer from the Footer gallery on the Insert tab 
if you want the page numbers to appear at the bottom of the page.

  Use Edit Header from the Header gallery if you want the numbers to 
appear at the top of the page.

 5. Click the Link to Previous button to detach the footer from the previ-
ous section’s footer.

 6. Open the Page Number gallery by clicking the Page Number button on 
the Insert tab.

 7. Select the formatting you want to use from the Page Number gallery.

  If you’re working with the footer, you should select from the Bottom of 
Page gallery. If you’re working with the header, select from the Top of 
Page gallery.
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188 Understanding Sections

 8. Choose the Format Page Numbers command from the Page Number 
gallery on the Insert tab.

  The Page Number Format dialog box appears. (Refer to Figure 1-12.)

 9. For the front matter, choose the roman numeral number format (i, ii, 
iii) in the Number Format list box.

 10. Click the Start At option and select 1.

 11. Click OK.

  The Page Number Format dialog box disappears.

You can follow a similar procedure to begin a new section of page number-
ing for the body of the document, using Arabic rather than roman numerals.
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Chapter 2: Formatting 
Fancy Pages

In This Chapter
✓ Creating columns

✓ Adjusting column width

✓ Forcing a column break

✓ Adding a cover page

✓ Inserting a background

✓ Adding a page border

If you use Word to create newsletters and brochures and other docu-
ments for which you should be using a desktop publishing program such 

as Adobe InDesign, you’ll be happy to know that Word enables you to create 
beautiful two- or three-column layouts. (You can create as many as ten col-
umns on an 81⁄2-x-11-inch page in portrait orientation, but the columns are so 
narrow they are virtually useless.)

Word refers to two- and three-column layouts as newspaper-style columns, 
but that term is a bit misleading. To implement a true newspaper-style 
column feature, Word would have to edit your prose automatically as you 
type so that it focused on bad news and added a distinct left- or right-wing 
slant to your text.

This chapter jumps headfirst into setting up newspaper-style columns in 
Word, so get ready to slice your page into columns of text.

Creating Columns
When you create multiple columns, the column layout applies to the entire 
section. If the entire document consists of just one section, the column 
layout applies to the entire document. If you want part of the document to 
have one column and another part to have two or three columns, you have 
to create two or more sections to accommodate the different column lay-
outs. (Chapter 1 in this minibook talks about working with sections.)
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190 Creating Columns

Creating columns the easy way
Here’s the easiest way to create multiple columns in your document:

 1. Click the Columns button on the Page Layout tab on the Ribbon.

  The Columns menu, shown in Figure 2-1, appears. This menu lets you 
format the page with one, two, or three evenly spaced columns. You can 
also format the page with two columns in which either the left column is 
narrower than the right or the right column is narrower than the left.

 

Figure 2-1: 
The 
Columns 
menu.

 

 2. Select the number of columns you want.

  Voilà! The document is formatted with the number of columns you 
chose.

If you want more than three columns, take a nice, long walk to clear your head 
of such nonsense. If you still want four or more columns when you return, use 
the More Columns option to specify the number of columns you want. For 
more details, see “Creating columns the hard way,” later in this chapter.

When you create a multicolumn layout, Word ensures that you’re using Print 
Layout view so that the columns are visible side by side onscreen. If you 
switch to Draft view (on the View tab, click the Draft command), the text is 
formatted according to the width of the column, but the columns aren’t dis-
played side by side onscreen.

I hope that you didn’t choke when you saw the look of your document in 
columns. You can revert to single-column mode by pressing Ctrl+Z (the 
magic Undo command) or by using the Columns button to set the layout to 
one column.

 

For a quick glimpse of how the columns appear when printed, choose File➪
Print and look at the right side of your screen. Word shows you how the 
printed document will appear. When you’ve seen enough, press Esc or click 
any Ribbon tab to return to your document.
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Creating columns the hard way
For more control over the appearance of columns, use the Columns com-
mand. Grab a cup of coffee and follow these steps:

 1. Move the insertion point to the location in the document where you 
want the columns to begin.

  If you want to apply columns to the entire document, the location of the 
insertion point doesn’t matter.

 2. Click the Columns button on the Page Layout tab, but rather than pick 
one of the easy preset selections from the drop-down menu, choose 
the More Columns command at the bottom of the menu.

  You’re greeted by the Columns dialog box, shown in Figure 2-2.

 

Figure 2-2: 
The 
Columns 
dialog box.

 

 3. Click one of the five preset column layouts.

  These choices are the same ones from the drop-down menu. If you want 
even more columns, you can tell Word how many to create by entering a 
number in the Number of Columns control.

 4. Change the Width or Spacing fields, if you must.

  To change the width of the columns, change the Width field. To change 
the amount of space between columns, change the Spacing field.

 

 Word wants to make all columns the same width, so when you change 
one, Word insists on changing all the others. If you want to make Word 
stop doing that, deselect the Equal Column Width check box.

 5. Click the Line Between button if you want a line to appear between 
columns.

  This line falls between the stuff you read, not the stuff you read between 
the lines.
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192 Adjusting the Column Width

 6. Periodically peer at the preview box to see whether you like the 
column layout.

 7. Here’s the tricky part: You have to decide which parts of your docu-
ment to turn into columns.

 • If you choose This Point Forward, Word adds a section break at the 
cursor position and applies the column layout to the new section. 
Thus, text that follows the cursor is formatted in columns, but text 
that comes before the cursor isn’t. When you have more than one 
section, however, the behavior of This Point Forward changes a bit — 
it formats only to the next section break.

 • If you choose Whole Document, the column layout applies to the 
entire document.

 • If you selected some text before opening the Columns dialog box, 
you can use the Selected Text option to change the columns for only 
that text. When you select this option, a section break is inserted 
both before and after the selected text.

 • If your document already has more than one section, choosing This 
Section applies the changes to the text in the current section. (If 
you have text selection from more than one section, the option is 
Selected Sections and the text in all sections changes.) For more 
about sections, see Chapter 1 in this minibook.

 8. Click OK.

  Excellent!

Here are some things to remember as you twiddle with the Columns dialog 
box:

 ✦ If you select the Equal Column Width check box, Word balances the col-
umns evenly. If you deselect this check box, you can create columns of 
uneven width.

 

✦ Select the Apply to This Point Forward option to create a headline or 
title that spans the width of two or three columns. Start by creating the 
headline, using a large font and centering it. Position the cursor at the 
beginning of the line after the heading and then use the Columns com-
mand to create a two- or three-column layout. Set the Select Apply To 
field to This Point Forward to throw the columns into a new section so 
that the headline remains in a single column.

Adjusting the Column Width
If you don’t like the width of columns you create, you can change them at 
any time, in one of these two ways:
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 ✦ Click the More Columns button in the Columns group on the Page 
Layout tab and experiment with the Width and Spacing fields.

 ✦ Click and drag the column marker, the box-like separator between col-
umns on the Ruler. If you selected the Equal Column Width check box in 
the Columns dialog box, all column markers move in concert to preserve 
the equal column widths. Otherwise, you can adjust column markers 
individually.

Here are some things to remember when you adjust column width:

 ✦ Even if you use unequal column widths, try to maintain the same width 
between columns. Otherwise, you create an unbalanced look.

 

✦ When adjusting column width by dragging the column marker, hold 
down the Alt key before clicking. Doing so causes Word to display mea-
surements that show the width of each column and the size of the space 
between columns.

 ✦ Any formatting applied to paragraphs in columns is still in effect. If you 
specified a ½  -inch left indent in a paragraph, the paragraph is indented 
half an inch from the left column margin. This indentation reduces the 
column width.

Forcing a Column Break
Left to its own devices, Word decides when to “jump” text from the bottom 
of one column to the top of the next column. Sometimes, however, you want 
to intervene and insert a column break of your own.

Follow these steps to force a column break:

 1. Place the insertion point where you want the new column to begin.

 2. Press Ctrl+Shift+Enter.

  Or, click the Breaks button on the Page Layout tab (which displays a 
variety of breaks to choose from) and choose Column Break

In Draft view, a column break is indicated in the text by a solid line running 
all the way across the screen. In Page Layout view, the column break is obvi-
ous when you see the text jump to the next column.

 

Don’t try to create two or three columns of equal length by inserting column 
breaks where you think the bottom of each column should fall. Instead, 
insert a continuous section break at the end of the last column. A continu-
ous section break balances all columns in the section so that they’re of equal 
length and then starts a new section without forcing a page break. To insert 
a continuous section break, click the Breaks button on the Page Layout tab 
and then choose Continuous.
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194 Adding a Cover Page

Adding a Cover Page
Many documents have an attractive first page that includes the document 
title and perhaps the author’s name. That information is frequently repeated 
in the header or footer on each page. Word 2010 provides an easy way to 
add a cover page.

To add a cover page to your document, follow these steps:

 1. Click the Cover Page button on the Insert tab.

  The Cover Page gallery, shown in Figure 2-3, appears.

 2. Click the cover page that you want to add to your document.

  Word knows to put the cover page at the start of your document. If you 
want to place it elsewhere, right-click the cover page in the gallery and 
select the location you want from the menu that appears.

 

Figure 2-3: 
The Cover 
Page 
gallery.

 

Word offers an alternative to the Columns 
command for creating complex, multicolumn 
layouts: the linked text box. A linked text box 
is a drawing object that contains text. You can 
link a series of text boxes so that if the first text 
box isn’t large enough to contain all the text, 

the text spills over to the second text box. If the 
second text box isn’t large enough to show all 
the text, Word adds a third text box to the link. 
Turn to Book IV, Chapter 5 if you want to know 
more about using text boxes.

Using linked text boxes to create columns
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Most cover pages have areas where you can type the title of your document 
and the author’s name. If you complete this information on the title page, 
the headers and footers that include the title or author name or both also 
display the correct information. Many cover pages also have areas for the 
subtitle and an abstract.

Creating a Background
Word provides several commands for adding a background to your document. 
The background might be a watermark (a faint image behind the text of your 
document), a background color, a background image, or a border around your 
text. A watermark is commonly added to a printed document to provide a 
reminder to the reader about the status of the document (such as confidential 
or draft). Backgrounds are most often used online because you can use col-
ored paper in your printer rather than use lots of ink to color the paper.

Adding a watermark
Watermarks are most useful for printed documents because they aren’t dis-
played in Web Layout view. And, although a watermark can let readers know 
that a document is confidential, it isn’t as good at protection as the features 
discussed in Book V, Chapter 3. You must use the same watermark for all 
pages in your document.

To add a watermark, follow these steps:

 1. Click the Watermark button on the Page Layout tab.

  The Watermark gallery, shown in Figure 2-4, appears.

 

Figure 2-4: 
The 
Watermark 
gallery.
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196 Creating a Background

 2. Click a watermark to insert it or select Custom Watermark from the 
bottom of the gallery.

  If you elect to add a custom watermark, the Printed Watermark dialog 
box, shown in Figure 2-5, appears. You can select a picture to be used 
for the watermark by selecting the Picture Watermark option and 
then using the Select Picture button to find the file that contains the 
image you want to use. For most images, you leave the Washout option 
selected, which makes the image look faded and therefore makes the 
text on top of the image easier to read.

 

Figure 2-5: 
The Printed 
Watermark 
dialog box.

 

  You can add text to your watermark by selecting the Text Watermark 
option in the Printed Watermark dialog box. You can then use the con-
trols to select the language for the watermark and the text to be used. 
You can format the text by using the remaining controls, including 
deciding whether the text should be diagonal or horizontal.

To remove a watermark from your document, select the Remove Watermark 
command from the bottom of the Watermark gallery.

Adding a background
Page backgrounds are intended to be used primarily for online documents. 
By default, Word doesn’t print the page background, so if you want it to 
print, go to the Display tab of the Word Options dialog box and select the 
Print Background Colors and Images check box.

To add a solid color as a background to your entire document, select a color 
from the Page Color control on the Page Layout tab on the Ribbon, as shown 
in Figure 2-6.
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Figure 2-6: 
The Page 
Color 
gallery.

 

To add a gradient, pattern, texture, or picture, select the Fill Effects com-
mand from the bottom of the Page Color control. The Fill Effects dialog box 
puts in an appearance on your screen. On each tab of the Fill Effects dialog 
box, you can add a different type of background. Both the Texture tab and 
the Picture tab let you select an image file to use for the background. The 
Texture tab repeats the picture to fill the entire background, whereas the 
Picture tab centers the image.

Note that a document can have only one background for all pages in the 
document.

Adding a page border
Unlike a watermark or background, a page border is assigned to a section. 
Therefore, different sections in your document can have different borders. 
For more information about sections, see Chapter 1 in this minibook.

To add a page border, follow these steps:

 1. Click the Page Borders button on the Page Layout tab.

  The Borders and Shading dialog box opens to the Page Border tab, 
shown in Figure 2-7.

 2. Select either a line or an art object to use as the border.

  You can select either a style and color for the line by using the top two 
drop-down lists in the center of the dialog box or a repeated image from 
the Art drop-down list at the bottom of the dialog box.

 3. Select the border width.

  The border must fit within the margins of the page, and you want to 
keep some space between the border and your text.

 4. Decide which sides of the page will have the border.

  You can use the preset Box, Shadow, or 3D options on the left side of the 
dialog box or select the Custom option on the left and use the controls 
on the right to select the sides that have the border.
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Figure 2-7: 
The Page 
Border 
tab of the 
Borders and 
Shading 
dialog box.

 

 5. If you want different sections to have different borders, use the Apply 
To drop-down list.

  For more on working with sections, see Chapter 1 of this minibook.

 6. Click OK.

  The border is displayed only in Print Layout view on the Print page in 
Backstage view.

To remove the border from a section, follow the same steps but select the 
None option in Step 4.

Although the same document can have a watermark, a page background, and 
a page border, that combination is generally appropriate only for a docu-
ment such as a certificate or an award.
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Chapter 3: Creating Lists

In This Chapter
✓ Creating bulleted lists and numbered lists the easy way

✓ Formatting a list

✓ Using different bullets and number formats

✓ Creating your own bullets and number formats

✓ Working with lists that have more than one level

Bulleted lists and numbered lists are useful ways to add emphasis to a 
series of important points or to add a sense of order to items that fall 

into a natural sequence. Glance through this book to see what I mean. It’s 
loaded with bulleted and numbered lists.

In Word, you can add a bullet or a line number to each paragraph. The bullet 
or number is a part of the paragraph format, and Word adds the bullet char-
acter or the number so that you don’t have to. Word even keeps the numbers 
in a numbered list in sequence so that if you add or delete a paragraph or 
rearrange paragraphs in the list, the numbers reorder automatically.

Several examples in this chapter walk you through the steps for using bul-
lets, but almost anything you can do with bullets can also be done with 
number formats, and the steps are basically the same.

Creating a List Automatically
The AutoFormat feature in Word can create bulleted and numbered lists 
automatically whenever Word determines that you’re trying to create a bul-
leted or numbered list. In previous versions, this feature was a somewhat 
hit-and-miss proposition, but it seems to be working much better in Word 
2010. I suggest giving it a try and then deciding whether you prefer another 
approach (such as using the buttons on the Ribbon, as I describe later in 
this chapter).

One minor change from previous versions of Word is that Word recognizes 
your list as soon as you type a space or a tab. No more waiting around for 
the end of the paragraph — talk about your instant gratification.
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 ✦ Word automatically formats text as a bulleted list whenever you begin a 
paragraph with a character that it matches to one of its rules. You can 
use any special character described in Table 3-1 to start a list.

 ✦ Word automatically formats text as a numbered list whenever you type a 
number followed by a period, hyphen, right parenthesis, or greater-than 
sign (>) and a space or tab. Word also starts a lettered list if you type 
the letter a (either upper- or lowercase) followed by a period, hyphen, 
right parenthesis, or greater-than sign and a space or tab; or a list num-
bered with roman numerals if you type the letter i (either upper- or low-
ercase) followed by a period, hyphen, right parenthesis, or greater-than 
sign and a space or tab.

Table 3-1 Bullet Codes That Word Recognizes

Type This To Create This Bullet

* <Insert character 183 from the Symbol font>

> <Insert character 216 from the Wingdings font>

<> <Insert character 168 from the Symbol font>

-> <Insert character 232 from the Wingdings font>

- <Insert a hyphen from the current font>

 

If you want to insert in the middle of your list a paragraph that doesn’t have 
a bullet on it but lines up with the list item text, just press Backspace once to 
remove the bullet or number. If you want the text to line up with the bullets 
or numbers, press Backspace again.

 If you don’t want this automatic formatting to occur, open the Word Options 
dialog box by choosing File➪Options and then selecting Proofing view. Click 
the AutoCorrect Options button, click the AutoFormat As You Type tab, 
and deselect the Automatic Bulleted Lists and Automatic Numbered Lists 
options.

Creating a List the Button Way
Aside from creating lists automatically, no task is easier than clicking a 
button, and that’s about all you have to do to create a simple bulleted or 
numbered list in Word. With the click of a button, you can create a bulleted 
list like this one:

 ✦ Cheery disposition

 ✦ Rosy cheeks
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 ✦ No warts

 ✦ Plays games, all sorts

Click another button, and you transform the whole thing into a numbered 
list:

 1. Cheery disposition

 2. Rosy cheeks

 3. No warts

 4. Plays games, all sorts

One advantage to using the buttons to create lists is that the buttons remem-
ber the last format you used. So, if you use a fancy bullet in one part of your 
document, when you apply bullets by clicking the button elsewhere in your 
document, the same bullet is applied. But the buttons have only short-term 
memory — if the insertion point is next to or within a list, the format of that 
list is used. Otherwise, the last format you applied is used.

Creating a bulleted list
To create a bulleted list, follow this procedure:

 1. Type the first item on your list.

  Don’t press Enter yet.

  2. Click the Bullets button on the Home tab.

  A bullet is added to the paragraph.

 3. Press Enter to begin the next item.

  A new paragraph with a bullet is created.

 4. Type the rest of the list.

  Press Enter after you type each item in the list. Word automatically adds 
bullets to each new paragraph.

 5. When you’re done, press Enter twice.

  Pressing Enter the second time removes the bullet from the last item in 
the list.

When you create a bulleted list this way, Word uses a default bullet character 
(normally a small dot) and creates a 1⁄4-inch hanging indent. (If the paragraphs 
already have hanging indents, the original indentation settings are preserved.) 
To discover how to use oddball bullets, find the section “Using a different 
bullet or number format,” later in this chapter.
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Here are a few additional tricks for bulleting your lists:

 ✦ To add more items to a bulleted list, position the insertion point at the 
end of a bulleted paragraph and press Enter. The bullet, because it’s 
part of the paragraph format, is carried over to the new paragraph.

 ✦ You can add bullets to existing text. Just select the paragraph or para-
graphs you want to riddle with bullets and then click the Bullets button.

 ✦ You can remove bullets as easily as you add them. The Bullets button 
works like a toggle: Click it once to add bullets; click it again to remove 
them. To remove bullets from an entire list, select all paragraphs in the 
list and click the Bullets button.

 ✦ Ever notice how the good guys in the movies never run out of bullets? 
Well, try not to be like the good guys. The old notion of the six-shooter 
is a good one: Placing more than six bullets in a row pushes the limits of 
just about any reader’s patience. (Of course, I routinely disregard that 
advice throughout this book, but what are you going to do — shoot me?)

 ✦ Oh, and by the way, you probably shouldn’t leave one bullet standing by 
itself. Bullets are used to mark items in a list, and you need more than 
one item to make a list. (“Army of One” is a good slogan for the military, 
but “List of One” is a lousy slogan for any document.)

Creating a numbered list
To create a numbered list, follow this procedure:

 1. Type the first item on your list.

  Don’t press Enter yet.

  2. Click the Numbering button on the Home tab.

  A number is added to the paragraph.

 3. Press Enter to begin the next item.

  A new paragraph with the next number in sequence is created.

 4. Type the rest of the list.

  Press Enter after you type each item on the list. Word automatically 
adds numbers to each new paragraph.

 5. When you’re done, press Enter twice.

  Pressing Enter the second time removes the number of the last item in 
the list.

When you click the Numbering button to create a numbered list, Word uses 
a default numbering format and establishes a 1⁄4-inch hanging indent for each 
paragraph. (If the paragraphs are already formatted with hanging indents, 

20_487662-bk03ch03.indd   20220_487662-bk03ch03.indd   202 4/15/10   9:09 PM4/15/10   9:09 PM



Book III

Chapter 3

C
re

a
tin

g
 Lists

203Creating a List the Button Way

Word maintains the original indentation settings.) You can use all sorts of 
crazy numbering schemes, if you want; to find out how, skip to the section 
“Creating Crazy Numbering Schemes.”

 

If you want to insert in the middle of your list a paragraph that doesn’t have 
a number on it but lines up with the text of the numbered items, place the 
insertion point at the beginning of the paragraph and just press Backspace 
once to remove the number. If you want the text to line up with the num-
bers, press Backspace again.

Word is cool about keeping the list in order. If you add or delete a paragraph 
in the middle of the list, Word renumbers the paragraphs to preserve their 
order. If you add a paragraph to the end of the list, Word assigns the next 
number in sequence to the new paragraph.

You can also apply numbering to existing text. Just select the paragraph or 
paragraphs you want to number and then click the Numbering button on the 
Home tab.

 

The Numbering button works like a toggle: Click it once to add numbers to 
paragraphs; click it again to remove them. To remove numbering from a 
numbered paragraph, select the paragraph and click the Numbering button. 
To remove numbering from an entire list, select all paragraphs in the list and 
click the Numbering button.

Using a different bullet or number format
Word 2010 includes nifty little arrows next to the Bullets and Numbering but-
tons. Well, the little arrows aren’t that neat, but the galleries they reveal are 
cool. When you click the arrow next to the Bullets button, the gallery shown 
in Figure 3-1 is revealed.

 

Figure 3-1: 
The Bullet 
Library 
shows your 
collection of 
bullets.
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The Bullet Library in the gallery lets you store a collection of your favorite 
bullets. You can store a couple hundred, but most people don’t use more 
than a few dozen. Don’t be greedy.

After you start working with bullets in your document, additional items may 
appear in the gallery. For example, the Document Bullets section initially 
includes just a single bullet type, but additional types will appear here if you 
use additional bullet types in your document. And a Recently Used Bullets sec-
tion will appear, listing the last few bullets you’ve applied by using the button.

What’s useful is that you can add a bullet from either of these sections to 
your Bullet Library by following these steps:

 1. Display the Bullets gallery by clicking the down arrow next to the 
Bullets button.

  You should see the bullet you want to add. If not, find a document that 
already uses that bullet (or add the bullet to a document) and try again.

 2. Right-click the bullet you want to add to your Bullet Library and 
choose Add to Library.

  That’s all you need to do. The bullet is now available for all your 
documents.

Of course, if you grow tired of a bullet, you might want to throw it out of the 
library. To remove a bullet from the Bullet Library, right-click the bullet and 
choose Remove. Note that this command doesn’t remove the bullet from the 
lists in your document.

If Word offered this feature only for bullets, the numbers would sulk and 
refuse to work. If you click the down arrow next to the Numbering button, 
you discover that the same type of gallery exists for numbers, as shown in 
Figure 3-2. Even better, everything I just described for bullets works as well 
for numbers.

 

Figure 3-2: 
The 
Numbering 
Library 
shows your 
collection 
of number 
formats.
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Formatting a List
Two of the most interesting ways you can format a list are by changing the 
font formatting used for the list character (the bullet or number format) 
and by changing the indent of the list. When you click a bullet used in a list, 
the bullets for all paragraphs in that list are lightly highlighted, as shown in 
Figure 3-3.

 

Figure 3-3: 
Click one 
bullet to 
select 
others.

 

The same technique works for selecting all numbers in a numbered list. And 
although the following step list describes working with a bulleted list, you 
can do exactly the same thing with a numbered list.

With the bullets selected, you can use any font formatting control on the 
Home tab to change the formatting of the character used as the bullet 
symbol. Using this technique, you can change the size or color of any indi-
vidual list without creating your own bullet. However, if you want to use that 
format frequently, you might want to have that bullet in your Bullet Library, 
which is described in the following section.

You can also change the position of the bullet and the text in the list by fol-
lowing these steps:

 1. Click a bullet in the list to ensure that the entire list is selected.

 

 You must select the list rather than one or more of the items in the list. 
If you select the paragraph before performing these steps, only the 
selected paragraph changes, not the entire list.

 2. Right-click a bullet in the list and choose Adjust List Indents.

  The Adjust List Indents dialog box appears, as shown in Figure 3-4.

 3. Change the value of the Text Indent option to control where the text is 
positioned.

  By default, Word positions the text at a half-inch indent.

 4. Change the Bullet Position option to specify how far to place the 
bullet from the left margin.

  The greater this value, the closer the bullet is to the text.
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Figure 3-4: 
The Adjust 
List Indents 
dialog box.

 

 5. If you’re creating lists in which you want the bullet to be part of the 
text rather than separated by a tab, change the selected element in 
the Follow Number With drop-down list.

  Try to ignore the Number wording when you’re working with bullets. 
Even Microsoft makes mistakes.

 6. If you want to insert a tab on each line in the list, select the Add Tab 
Stop At option.

  The primary reason to complete this step is to match the way in which 
lists were created in previous versions of Word. When this option is 
active, you can specify the location of the tab stop to be inserted.

 7. Click OK.

  Ensure that your list is now neatly lined up where you want it. If it isn’t, 
make further adjustments by following these steps again.

 

Word 2010 now uses a special List Paragraph style for formatting lists. This 
paragraph style determines the initial font formatting used for the text in 
your list and for the spacing between paragraphs and between lines in the 
paragraphs. See Book II, Chapter 3 for more information about modifying 
the formatting used by a style.

Creating Deviant Bullets
If you don’t like any of the choices available in your Bullet Library and you 
want to create a new one of your very own, here’s how to do it:

 1. Click the arrow next to the Bullets button on the Home tab.

  Behold! The Bullets gallery appears.

 2. Choose the Define New Bullet command from the bottom of the Bullet 
gallery.

  The Define New Bullet dialog box appears, as shown in Figure 3-5.
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Figure 3-5: 
Formatting 
your own 
bullets.

 

 3. If you want to use a character for the bullet, click the Symbol button.

  The Symbol dialog box, shown in Figure 3-6, appears.

 

Figure 3-6: 
Pick a 
symbol to 
use for your 
bullet.

 

 4. Pick the bullet character you want; then click OK.

 

 You can change the characters displayed by choosing a different font 
from the Font drop-down list. Find the character you want to use, click 
it, and then click OK.

 5. (Optional) If you want to control the color or size of the character 
you’re using, click the Font button to select formatting.

  The formatting you apply appears when the bullet is used for normal text.

 6. Click the OK button repeatedly to work your way back to the document.

  Keep clicking OK until you return to your document so that you can see 
the results of your bullet formatting efforts. Note that the bullet you just 
created is automatically added to your Bullet Library.
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Keep these points in mind when changing your bullets:

 ✦ The Wingdings font (which comes with Windows) is filled with useful 
bullet characters: Select a pointing finger, smiley face, grumpy face, 
thumbs-up symbol, thumbs-down symbol, peace sign (if you were at 
Woodstock), time bomb, or a skull-and-crossbones. (“Yo ho, yo ho, a 
pirate’s life for me!” I love that song more than Johnny Depp does!)

 ✦ When you’re defining your bullet and you want to use a picture for it 
rather than a symbol, click the Picture button (rather than the Symbol 
button) in Step 3, select the image you want to use, and then click OK. 
Figure 3-7 shows the Picture Bullet dialog box, which helps you choose a 
nice picture to use for your bullets. You cannot apply font formatting to 
picture bullets.

 

Figure 3-7: 
From the 
Picture 
Bullet dialog 
box, you 
pick an 
image to 
use for your 
bullet.

 

Creating Crazy Numbering Schemes
Most people like to count 1, 2, 3, and so on. But some people count A, B, C or 
maybe I, II, III, like a Roman. Not to fear. In Word, you can count just about 
any way you like.

Follow these prudent steps to create your own crazy numbering schemes:

 1. Click the arrow next to the Number button on the Home tab.

  The Numbering gallery appears. It dutifully awaits your command.

 2. Choose the Define New Number Format command from the bottom of 
the Numbering gallery.

  The Define New Number Format dialog box appears, as shown in 
Figure 3-8.
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Figure 3-8: 
The Define 
New 
Number 
Format 
dialog box.

 

 3. Modify the numbering scheme to suit your fancy.

  You can change the number format and change the alignment of the 
numbers within the list. You can also type text to include before or after 
the number or both. The most common type of text that’s included 
with a number is punctuation following the number. So when you want 
a number format to look like 1), the closing parenthesis is included as 
text after the number — you just type it directly into the Number Format 
text box. A common type of text included before a number is a label 
such as Chapter or Section, particularly when the numbering is used 
with the heading styles, as described later in this chapter in the section 
“Numbering your headings.”

  By default, Word aligns most numbered lists to the left of the number 
(so that when 10 appears under 9, the 1 is lined up under the 9). If you 
want your 10 to line up under your 9 with the 0 under the 9, select the 
Right option in the Alignment drop-down list. Figure 3-9 shows an exam-
ple of a list with the numbers right-aligned.

 

Figure 3-9: 
A list with 
numbers 
that are 
right-
aligned.
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 If you want to specify a different font for the numbers, click the Font 
button when the Define New Number Format dialog box appears. The 
font applies not only to the number but also to any text that appears 
before or after the number.

 4. Click OK.

  Happy numbering! The number format is now stored in your Numbering 
Library.

Keep these points in mind when using numbered lists:

 ✦ You can specify, in addition to normal number formats (such as 1, 2, 3 
or A, B, C), One, Two, Three; 1st, 2nd, 3rd; or even First, Second, Third 
as the number format. Believe it or not, these oddball formats work even 
with unreasonably long lists. Try it and see for yourself: Word knows 
how to spell one-thousand one-hundred eighty-seventh. It also knows 
that the Roman numeral equivalent is MCLXXXVII. Isn’t that amazing?

 ✦ You can add text that appears before or after the number by typing the 
text into the Number Format text box. Note that the number is shown in 
the Number Format text box with a gray background.

Breaking and Continuing a Numbered List
The menu you see when you right-click a number in a numbered list includes 
two options that are useful in two situations:

 ✦ Restart at 1: Use this option when you want to begin a new numbered 
list, even if the paragraph is in the middle of an existing numbered list. 
You can also use this option to work with two or more numbered lists 
that are adjacent to one another.

 ✦ Continue Numbering: Use this option when you want to insert a nonnum-
bered paragraph in the middle of a numbered list but you want the list 
numbering to continue in sequence across the unnumbered paragraph.

Here are a couple of troubleshooting tips:

 ✦ If you’re trying to create a new numbered list but the number for the 
first paragraph in the list refuses to start at 1, right-click the number and 
select the Restart at 1 command.

 ✦ On the other hand, if a paragraph in the middle of a list insists on start-
ing with the number 1, try selecting the Continue Numbering option.

The Set Numbering Value command, found on the menu that appears when 
you click the arrow next to the Numbering button on the Home tab, lets you 
do both these tasks and lets you set a starting value for the list if you want 
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it to start at a value other than 1. Such lists are useful in some cases, but be 
careful. You can easily set a starting value and then forget and wonder why 
it now has such strange numbering.

Working with Lists with Two or More Levels
Not all lists are simple one-level lists, like the ones I’ve been describing. In 
some cases, you want to have a second level with a different format. Figure 
3-10 shows an example.

 

Figure 3-10: 
This list has 
two levels.

 

Some people go completely crazy making lists with three or four levels. 
Word doesn’t mind because it can manage lists with as many as nine levels. 
Beyond that, you’re on your own.

To create a list at an indent level, you can just press Tab at the start of the 
paragraph. If you’re on the first item of your list, the indent position for 
the list changes so that more white space appears to the left of the list. But 
if you’re within a list, every time you press Tab, the numbering moves to 
the next level of the list. If you’re more of a button person, you can use the 
Increase Indent button on the Home tab.

To move an item up a level in the list (for example, from the second level 
to the first level) while creating a list, you can press Enter. However, this 
shortcut works only before you start typing text on the line. After you create 
the paragraph, you can press Shift+Tab at the start of the paragraph or the 
Decrease Indent button on the Home tab.

 

When you’re at the end of a list, pressing Enter removes the number and 
returns the insertion point to the left margin. If you want to remove the number 
but not change the position of the text (at any level), press Backspace.

Changing the Look of a List with Many Levels
You can create compulsive outline lists that can satisfy even the most rigid 
anthropology professor by using Word’s numbering feature. I wouldn’t wish 
this task on anyone, but if you must create these types of lists, this feature is 
a godsend.
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Next door to the traditional Bullets and Numbering buttons on the Home tab 
is a button Multilevel List. When you click this button, the gallery shown in 
Figure 3-11 appears.

 

Figure 3-11: 
The 
Multilevel 
List gallery.

 

When the gallery appears, all paragraphs associated with the current list are 
selected. This selection is similar to the one you see when you click a bullet 
or number, but it extends to all levels within the list. You can select an entry 
on the gallery to change the formatting of the entire list.

 

If you hover the cursor over an entry in the List Library section of the 
Multilevel List gallery, a sample showing all nine levels of the list is 
displayed.

 The entries on the Multilevel List gallery are of two types: traditional, old-
fashioned, multilevel lists and new, improved list styles. The differences 
between the two are that list styles have names and can be modified. 
Traditional multilevel lists can’t be modified, so to change a list, you have to 
create a new multilevel list and replace the old one you were using. The 
problem with that approach is that your document can become cluttered 
with unused list definitions. But the advantage to multilevel lists is that they 
can be added to your List Library and are available for any document you 
create; list styles occupy their own section of the Multilevel List gallery and 
have to be copied from document to document.
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Crafting your own multilevel list
Suppose that you don’t have a multilevel list that you like. Well, just as with 
bullets and numbers for single-level lists, you can create your own. Here’s an 
outline of the procedure for creating a multilevel list:

 1. Click the Define New Multilevel List link at the bottom of the 
Multilevel List gallery.

  The Define New Multilevel List dialog box appears, as shown in Figure 
3-12. You use this dialog box to customize each level of an outline list.

 

Figure 3-12: 
The Define 
New 
Multilevel 
List dialog 
box.

 

 2. Select the level you want to work with.

  Start with the first level and work your way down. You can select other 
levels by clicking either the number or the preview of that level number 
in the Click Level to Modify section of the dialog box.

 3. Select the number format you want to use for that level.

  When working with a number format, you can add text, such as punctua-
tion, to be used with the number by typing in the Enter Formatting for 
Number text box.

  Most multilevel lists involve numbers, so the dialog box is set up to 
make adding number formats easier. You can add bullets to a level by 
selecting a Bullet option from the bottom of the Number Style for This 
Level drop-down list. You can even define your own bullet or use a pic-
ture bullet with the New Bullet and New Picture commands at the very 
end of the drop-down list.
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 4. Adjust the formatting to be used for the level, including adding any 
text, setting the font, and setting the indent position for the list.

  For more information, see the section “Formatting a List,” earlier in this 
chapter.

 

 If you want all levels to be indented equally with the bullet or number 
the same distance from the text, click the Set for All Levels button to dis-
play its dialog box, shown in Figure 3-13. You can specify the position of 
the text for the first line, the distance that the bullet should be from the 
left indent for the first line, and then the amount of space that each addi-
tional level should be indented. When you’re done, click OK to return to 
the Define New Multilevel List dialog box.

 

Figure 3-13: 
The Set for 
All Levels 
dialog box.

 

 5. (Optional) If you want to use legal or technical numbers (such as 1-1), 
use the Include Level Number From drop-down list to select which 
level is included as part of the number format.

  When you select a level from the drop-down list, a placeholder represent-
ing the numbering from that level is inserted into the Enter Formatting 
for Number text box. Ensure that your insertion point is where you want 
the placeholder inserted before selecting a level (usually at the start of 
the number format). You probably want to add punctuation between the 
placeholders for the current level and any other levels you’ve included.

  This command is available only for levels 2 through 9.

 6. Repeat Steps 2 through 5 for each level.

  You don’t need to define all nine levels.

 7. Click OK.

  Your new list is now part of your List Library and is ready to go.

 Defining a list style follows a similar process but starts with the Define New 
List Style command. The major differences are that the Define New List 
Style dialog box, shown in Figure 3-14, lets you give the list style a name 
and has only some of the controls shown in the Define New Multilevel List 
dialog box. To open the entire set of controls used for defining multilevel 
lists, click the Format button in the lower-left corner of the Create New Style 
from Formatting dialog box and then select Numbering. You can modify an 
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existing list style by right-clicking it and choosing Modify from the menu. 
Remember that a list style you create doesn’t become part of your List 
Library.

 

Figure 3-14: 
The Define 
New List 
Style dialog 
box.

 

Numbering your headings
If you want to add numbers to a document’s headings, you can do so by cre-
ating a multilevel list that uses the standard heading styles. Then when you 
apply heading styles to your document’s headings, the heading paragraphs 
are numbered automatically according to the numbering scheme you created.

Here’s the procedure for adding heading styles to a multilevel list:

 1. Create the list by following the steps described previously in the sec-
tion “Crafting your own multilevel list” but don’t close the Define New 
Multilevel List dialog box.

  If you prefer, you can add the heading for each level as you define it, 
but it’s somewhat easier to separate the task of creating the numbering 
levels from associating them with the headings.

 2. Click the More button to expand the dialog box to the version shown 
in Figure 3-15.

  Try not to be scared. This dialog box is one of the most complex in all of 
Word, if not the universe.
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Figure 3-15: 
The 
complete 
Define New 
Multilevel 
List dialog 
box.

 

 3. Select a level of your list and then, from the Link Level to Style drop-
down list, select the heading style you want to associate with it.

  You can associate the level with any style, but the heading styles are 
most commonly used.

 4. Repeat for each level in your list.

  You don’t have to assign Heading 1 to level 1 and Heading 2 to level 2 
and so on, but it surely makes the most sense.

 5. Adjust any other advanced settings you want to work with.

  Most of these settings have already been discussed and aren’t difficult 
to use. They’re hidden from normal use because they aren’t needed 
most of the time.

 6. Click OK.

  The multilevel list now appears in your List Library, and the heading 
styles in your document have been updated to use that numbering 
pattern. As you apply heading styles, Word automatically applies the 
number formatting.

  You can also change an existing list to use this formatting by selecting it 
from the List Library.

Heading numbering always applies to all paragraphs in a document format-
ted with a given heading style. As a result, you can’t selectively apply it to 
some heading paragraphs but not to others.
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Using Fields to Create Sequence Numbers
Word’s numbered lists are helpful when you have a series of consecutive 
paragraphs that need sequence numbers. But many documents have lists 
spread out through the entire document. For example, every chapter in this 
book has figures numbered consecutively starting with 1. Word’s numbered 
list feature can’t help you with this type of list.

Fortunately, the Word field codes feature has a special field named seq 
that’s designed just for this purpose. Read Book VIII, Chapter 3 to find 
detailed information about this Word field code and others.
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Chapter 1: Drawing Shapes 
on Your Document

In This Chapter
✓ Using the Word drawing tools

✓ Using predefined shapes

✓ Drawing polygons or curved lines

✓ Changing colors and line types

✓ Creating 3D objects

✓ Flipping and rotating objects

✓ Understanding layers and groups

✓ Using advanced techniques

Chim-chiminey, chim-chiminey, chim-chim cheroo,
I draws what I likes and I likes what I drew. . . .

Art time! Gather your crayons and glue and don an old paint shirt. You’ll 
cut out some simple shapes and paste them into your document so 

that people either believe that you’re a wonderful artist or scoff at you for 
not using clip art.

This chapter covers the drawing features of Word 2010. One of the best 
things about Word is its array of cool drawing tools. Once upon a time, 
Word had only rudimentary drawing tools — the equivalent of a box of 
crayons — but Word now has powerful drawing tools that are sufficient 
for all except the most sophisticated aspiring artist.

Some General Drawing Tips
Before getting into the specifics of using each Word drawing tool, in the fol-
lowing sections I describe a handful of general tips for drawing pictures.

Zoom in
When you work with the Word drawing tools, you can increase the zoom 
factor so that you can draw with greater precision. I often work at 200, 300, 
or even 400 or 500 percent when I’m drawing. To change the zoom factor, 
use the Zoom Slider located in the lower-right corner of the screen.
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Before you change the zoom factor to edit an object, select the object that 
you want to edit. This way, Word zooms in on that area of the page. If you 
don’t select an object before you zoom in, you might need to scroll around 
to find the right location.

Save frequently
Drawing is tedious work. You don’t want to spend two hours working on a 
particularly important drawing only to lose it all just because a comet strikes 
your building or an errant Scud lands in your backyard. You can prevent cat-
astrophic loss from incidents such as these by frequently pressing Ctrl+S or 
clicking the Save button as you work. And always wear protective eyewear.

Remember to use Ctrl+Z
In my opinion, Ctrl+Z — the ubiquitous Undo command — is the most impor-
tant keyboard shortcut in any Windows program, and Word is no exception. 
Remember that you’re never more than one keystroke away from erasing a 
boo-boo. If you do something silly, such as forget to group a complex picture 
before trying to move it (see “Drawing a Complicated Picture,” later in this 
chapter), you can always press Ctrl+Z to undo your last action. Ctrl+Z is my 
favorite and most frequently used Word key combination. (For left-handed 
mouse users, Alt+Backspace does the same thing.) And, if you aren’t ready 
to climb shrieking on a chair at the first sign of a mouse, try clicking the 
handy Undo button on the Quick Access toolbar.

Drawing Simple Objects
The basic element of every drawing is an object. To draw an object, first 
open the Insert tab on the Ribbon. Then click the Shapes button to reveal 
the Shapes gallery, shown in Figure 1-1.

You find in the following sections detailed instructions for drawing with the 
more important tools.

 

Before I get to them, though, I give you some pointers to keep in mind:

 ✦ Choose a location: Before you draw an object, move to the page on 
which you want to draw the object.

 ✦ Fix your mistakes: You can delete the object you just drew by selecting 
it and pressing the Delete key.

 ✦ Hold down the Shift key: If you hold down the Shift key while drawing 
a shape, Word forces the shape to be regular: Rectangles are squares, 
ellipses are circles, and lines are either horizontal or vertical.
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223Drawing Simple Objects

 

Figure 1-1: 
The Shapes 
gallery.

 

Drawing straight lines
You can use the Line button to draw straight lines on your pages. Here’s the 
procedure:

  1. Click the Shapes button in the Illustrations group of the Insert tab, and 
then click the Line button (shown in the margin).

 2. Point the cursor to where you want the line to start.

 3. Click and drag the cursor to where you want the line to end.

 4. Release the mouse button when you reach your destination.

After you draw the shape, the Ribbon displays the Drawing Tools Format 
tab, as shown in Figure 1-2. You can then use the controls in the Shape Styles 
group to change the fill, outline, and effects applied to the line.

 

After you draw a line, you can adjust it by clicking it and then dragging the 
handles that appear on each end of the line.

 

Figure 1-2: 
Drawing 
Tools 
Format tab.
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224 Creating Other Shapes

Remember that you can force a line to be perfectly horizontal or vertical or 
45 degrees by holding down the Shift key while you draw. If you hold the 
Shift key and drag diagonally while you draw the line, the line is constrained 
to perfect 45-degree angles.

Drawing rectangles, squares, ovals, and circles
To draw a rectangle, follow these steps:

  1. On the Insert tab, click the Shapes button (in the Illustrations group), 
and then click the Rectangle button (shown in the margin).

 2. Point the cursor so that one corner of the rectangle is positioned 
where you want the object to be located.

 3. Click and drag to where you want the opposite corner of the rectangle 
to be positioned.

 4. Release the mouse button.

The steps for drawing an oval are the same as the steps for drawing a rect-
angle except that you click the Oval button rather than the Rectangle button. 
To draw a square or perfectly round circle, select the Rectangle button or 
the Oval button, respectively, but hold down the Shift key while you draw.

 You can adjust the size or shape of a rectangle or an oval by clicking it and 
dragging any of its “love handles.”

Creating Other Shapes
Rectangles and ovals aren’t the only two shapes that Word can draw auto-
matically. The Shapes gallery includes many other types of shapes you can 
draw, such as pentagon and stars and flowchart symbols. (To reach the 
Shapes gallery, click the Shapes button in the Illustrations group on the 
Insert tab.)

The Shapes gallery organizes shapes into these categories:

 ✦ Recently Used Shapes: The top section of the gallery; it lists the 18 
shapes you’ve used most recently. The shapes found in this section 
change every time you draw a new shape.

 ✦ Lines: Straight lines, curved lines, lines with arrowheads, scribbly lines, 
and free-form shapes that can become polygons, if you want. The free-
form shape is useful enough to merit its own section, later in this chap-
ter, “Drawing a Polygon or Free-Form Shape.”
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225Creating Other Shapes

 ✦ Rectangles: Various types of roughly rectangular shapes.

 ✦ Basic Shapes: Squares, rectangles, triangles, crosses, happy faces, light-
ning bolts, hearts, clouds, and more.

 ✦ Block Arrows: Fat arrows pointing in various directions.

 ✦ Equation Shapes: Shapes that look like mathematical symbols such as 
plus and minus signs.

 ✦ Flowchart: Various flowcharting symbols.

 ✦ Stars and Banners: Shapes that add sparkle to your presentations.

 ✦ Callouts: Text boxes and speech bubbles similar to the ones used in 
comic strips.

The following steps explain how to draw a shape:

 1. Click the Shapes button in the Illustrations group on the Insert tab.

  The Shapes gallery appears.

 2. Select the shape you want to insert.

  The gallery disappears.

 3. Click the page where you want the shape to appear and then drag the 
shape to the size you want.

  Hold down the Shift key while drawing the shape to create a regular 
shape.

  When you release the mouse button, the Shape object takes on the cur-
rent fill color and line style.

 4. (Optional) Start typing if you want the shape to contain text.

  After you type some text, you can use the Word formatting features to 
change its typeface, size, color, and other attributes.

In addition to the standard resizing handles, many shape buttons have one 
or more extra handles shaped like yellow diamonds; you use this handle to 
adjust aspects of the object’s shape. For example, the block arrows have 
a handle you can use to increase or decrease the size of the arrowhead. 
The location of these handles varies depending on the shape you’re work-
ing with. Figure 1-3 shows how you can use these extra handles to vary the 
proportions and other aspects of six different shapes. For each of the six 
shapes, the first object shows how the shape is initially drawn; the other 
two objects drawn with each shape show how you can change the shape by 
dragging the extra handle.
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Figure 1-3: 
Variations 
on basic 
shapes.

 

Drawing a Polygon or Free-Form Shape
Mr. Arnold, my seventh grade math teacher, taught me that a polygon is a 
shape that has many sides and has nothing to do with having more than 
one spouse. (One is certainly enough for most people.) Triangles, squares, 
and rectangles are polygons, but so are hexagons and pentagons and any 
unusual shapes whose sides all consist of straight lines. Politicians are con-
tinually inventing new polygons when they revise the boundaries of congres-
sional districts.

One of the most useful shapes in the Shapes gallery is the Freeform Shape 
tool. It’s designed to create polygons, with a twist: Not all its sides have 
to be straight lines. You can use the Freeform Shape tool to build a shape 
whose sides are a mixture of straight lines and free-form curves. Figure 1-4 
shows three examples of shapes I created by using the Freeform Shape tool.

 

Figure 1-4: 
Three 
free-form 
shapes.

 

Follow these steps to create a polygon or free-form shape:

  1. Click the Shapes button in the Illustrations group on the Insert tab to 
reveal the Shapes gallery (refer to Figure 1-1), and then click the 
Freeform Shape tool (shown in the margin).
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227Drawing a Polygon or Free-Form Shape

 2. Click where you want to position the first corner of the object.

 3. Click where you want to position the second corner of the object.

 4. Keep clicking wherever you want to position a corner.

 5. (Optional) To draw a free-form side on the shape, hold down the 
mouse button when you click a corner and then drag to draw the free-
form shape. When you reach the end of the free-form side, release the 
mouse button.

  You can then click again to add more corners.

 6. To finish the shape, click near the first corner — the one you created 
in Step 2.

  You don’t have to be exact: If you click anywhere near the first corner 
you put down, Word assumes that the shape is finished.

You’re finished!

I remember when I took my first computer pro-
gramming class. The year was 1976. I had to 
buy a plastic template with flowcharting sym-
bols cut into it so that I could learn how to draw 
proper flowcharts in my COBOL programs.

Word 2010 has flowcharting symbols — a 
very good thing. Now I can throw away that 
old plastic template. You never know when 
you might need one of these symbols, just for 
old-time’s sake:

Flowcharting, 1970s style

Card Most modern computer users have never even seen 
one. It was already considered old-fashioned before 
the first version of Windows was released.

Delay Back in the 1970s, computers were so fast that some-
times you had to program in delays so that users 
wouldn’t get spoiled.

Punched Tape I once used a computer that worked with punched 
tape. The paper tape always broke, but I could easily 
mend it with Scotch tape.

Summing Junction This popular TV series was a spinoff from Petticoat 
Junction.

Tape Few PCs have reel-to-reel tape drives. But if you 
want to see one, tune into the SyFy channel late at 
night. You can usually spot an old-fashioned reel-
to-reel tape drive against the wall in the evil mad 
scientist’s secret lair.
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 You can reshape a polygon or free-form shape by double-clicking it and then 
dragging any of the handles that appear on the corners.

If you hold down the Shift key while you draw a polygon, its sides are 
constrained to 45-degree angles. (How about a constitutional amendment 
requiring Congress to use the Shift key when it redraws congressional 
boundaries?)

You also can use the Freeform Shape tool to draw a multisegmented line, or 
an open shape. To draw an open shape, you can follow the steps in this sec-
tion, except that you skip Step 6. Instead, double-click or press Esc when you 
finish.

Drawing a Curved Line or Shape
The useful Curve tool in Word 2010 lets you draw curved lines or shapes. 
Figure 1-5 shows examples of curved lines and shapes drawn using the 
Curve tool.

 

Figure 1-5: 
Examples of 
curved lines 
and shapes.

 

Here’s the procedure for drawing a curved line or shape:

  1. Click Shapes in the Illustrations group on the Insert tab and then 
choose the Curve tool (shown in the margin).

 2. Click where you want the curved line or shape to begin.

 3. Click where you want the first turn in the curve to appear.

  The straight line turns to a curved line, bent around the point where you 
clicked. As you move the mouse, the bend of the curve changes.

 4. Click to add turns to the curve.

  Each time you click, you add a new bend to the line. Keep clicking until 
the line is as twisty as you want.

 5. To finish a line, double-click where you want the end of the curved 
line to appear. To create a closed shape, double-click over the starting 
point (created in Step 2).
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229Setting the Shape Fill

Styling Your Shapes
The center section of the Drawing Tools Format tab is named Shape Styles. 
This tab lets you control various stylistic features of your shapes. For exam-
ple, you can set a fill color, set the outline, and add effects such as shadows 
or reflections.

You can set these styles individually or choose a preselected shape style 
that appears in the Shape Styles group. Note that the styles that appear in 
the Shape Styles group vary depending on the type of shape you select. For 
example, if you select a line, various predefined line styles are displayed. But 
if you select a rectangle, the styles appropriate for rectangles are displayed.

Setting the Shape Fill
Control how shapes are filled by using the Shape Fill control (in the Shape 
Styles group of the Drawing Tools Format tab). The simplest type of fill is a 
solid color. But you can also use a picture, gradient fill, texture, or pattern to 
fill the shape. Figure 1-6 shows examples of these types of fills, and the fol-
lowing sections explain how to apply them.

 

Figure 1-6: 
Four types 
of fill 
effects.

 

Filling an object with a solid color
The easiest type of fill is a simple solid color. You can set a solid color by 
clicking the Shape Fill button and then choosing a color from the palette. 
The Shape Fill palette includes two groups of colors:

 ✦ Theme: Colors that are a part of the current document theme

 ✦ Standard: Basic colors such as red, blue, yellow, and green

If you want to use a color that isn’t visible on the menu, click More Fill 
Colors; clicking this option displays the Colors dialog box, shown in Figure 
1-7, which resembles a tie-dyed version of Chinese checkers. You can choose 
any color you want from this dialog box.
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230 Setting the Shape Fill

 

Figure 1-7: 
Choose a 
color.

 

 The Standard tab of the Colors dialog box (refer to Figure 1-7) shows 127 
popular colors, plus white and black and shades of gray. If you want to use a 
color that doesn’t appear in the dialog box, click the Custom tab. This step 
summons the custom color controls, shown in Figure 1-8. You can construct 
any of the 16 million colors that are theoretically possible with Word. You 
need a PhD in physics to figure out how to adjust the Red, Green, and Blue 
controls, though. Experiment, if you want, but be careful: You can create 
some truly ugly colors if you aren’t careful.

 

Figure 1-8: 
Even more 
colors!

 

22_487662-bk04ch01.indd   23022_487662-bk04ch01.indd   230 4/15/10   9:10 PM4/15/10   9:10 PM



Book IV

Chapter 1

D
ra

w
in

g
 S

h
a

p
e

s 
o

n
 Y

o
u

r D
o

c
u

m
e

n
t

231Setting the Shape Fill

Filling an object with a picture
If you choose Picture from the Shape Fill menu (click the Shape Fill button 
on the Drawing Tools Format tab on the Ribbon), the Insert Picture dialog 
box appears, as shown in Figure 1-9. You can use this dialog box to select a 
picture to be used as a drawing object’s fill.

 

Figure 1-9: 
Filling an 
object with 
a picture.

 

Making the gradient
A gradient fill is a fill effect that smoothly blends two or more colors. 
Gradient effects can be subtle or bold, depending on how similar the 
blended colors are. For example, if you blend a bright shade of yellow into 
a not-so-bright shade of yellow, the effect is subtle. But if you blend a bright 
shade of yellow into a bright shade of red, the effect is bold.

To apply a gradient fill, click the Shape Fill button and point to Gradient. 
This action reveals a gallery of gradient options, shown in Figure 1-10. Then 
you can select the gradient you want to use.

If none of the gradient fills in the gallery suits your fancy, you can create a 
custom gradient fill by clicking More Gradients and selecting Gradient Fill. 
This action summons the dialog box shown in Figure 1-11. You can then cus-
tomize the gradient fill to your liking. As you can see, you can choose single- 
or two-color gradients, and you can control the level of transparency and 
the direction of the gradient.
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Figure 1-10: 
Creating a 
gradient fill.

 

 

Figure 1-11: 
Customizing 
a gradient 
fill.
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233Setting the Shape Fill

Applying a texture
A texture is a photo-quality bitmap image designed so that it can be repeated 
throughout with no noticeable tiling. Textures let you create objects that 
look like they’re made of wood, stone, or parchment, for example.

To apply a texture, click the Shape Fill button and select Texture. The gallery 
is revealed, as shown in Figure 1-12. Choose one of several textures to give 
your illustration a polished Formica look.

 

Figure 1-12: 
The Formica 
gallery (just 
kidding).

 

For more texture choices, click the More Textures option at the bottom of 
the gallery. This brings up the dialog box shown in Figure 1-13. Here you can 
choose one of the textures provided with Word, or you can click the File 
button to bring up a dialog box that lets you open an image file of your own 
to use as a texture.

Using a pattern
If you click the Pattern Fill radio button in the More Textures dialog box, you 
can select a pattern from the Format Shape dialog box, shown in Figure 1-14. 
This dialog box lists 48 different patterns and lets you specify your choice of 
foreground and background colors.
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Figure 1-13: 
Choosing 
a custom 
texture.

 

 

Figure 1-14: 
Filling an 
object with 
a pattern.

 

My personal favorites are the patterns that resemble bricks and cobblestones.

Note: You can change the background and foreground colors used to draw 
the pattern. You can create a nice brick pattern by setting the foreground 
color to a light gray and the background color to a deep red.
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235Applying Shape Effects

Setting the Shape Outline
Using the Shape Outline control (on the Drawing Tools Format tab), you can 
change the style of line objects or the border for solid shape objects. You 
can change these settings for the outline:

 ✦ Color: The color used for the outline.

 ✦ Weight: The thickness of the line.

 ✦ Dashes: The dashing pattern used for the lines that outline the object. 
The default uses a solid line, but different patterns are available to 
create dashed lines.

 ✦ Arrows: An arrowhead that can appear on either or both ends of a line.

Applying Shape Effects
The Shape Effects button on the Drawing Tools tab on the Ribbon lets you 
apply several interesting types of effects to your shapes. When you click this 
button, a menu with the following effect options is displayed:

 ✦ Preset: Lets you select from several popular combinations of shape 
effects.

 ✦ Shadow: Applies a shadow to the picture. You can select one of several 
predefined shadow effects, or you can call up a dialog box that lets you 
customize the shadow.

My only beef with Word’s pattern fill feature is 
that you can’t control the scale of the pattern. 
No matter how large or small the object being 
filled, the pattern always remains the same 
size. And the patterns are generally too small. 
In fact, the brick pattern is so small that when 
you print it, you almost have to use a magnify-
ing glass to see the individual bricks.

Even weirder is that the patterns are all dis-
played at the same size onscreen regardless 

of the zoom factor. For example, if you draw a 
1-inch square and fill it with bricks, each row 
of bricks has about 12 bricks in it. If you zoom 
in to 200 percent, the bricks don’t get bigger. 
Instead, each row now has 24 bricks. Likewise, 
if you zoom down to 50 percent, each row now 
has 6 bricks. When I print the rectangle on my 
printer, each row has 18 bricks!

The problem with patterns

22_487662-bk04ch01.indd   23522_487662-bk04ch01.indd   235 4/15/10   9:10 PM4/15/10   9:10 PM



236 Applying Shape Effects

 ✦ Reflection: Creates a reflected image of the picture beneath the original 
picture.

 ✦ Glow: Adds a glowing effect around the edges of the picture.

 ✦ Soft Edges: Softens the edges of the picture.

 ✦ Bevel: Creates a beveled effect.

 ✦ 3-D Rotation: Rotates the picture in a way that creates a three-
dimensional effect.

 

The best way to discover how to use these effects is to experiment with 
them to see how they work.

Applying a shadow
To apply a shadow effect to an object, select the object, click the Shape 
Effects button, click Shadow, and then select one of the preset shadow 
effects that appears in the gallery that is displayed.

If you want more control over the shadow that is applied, you can choose 
Shadow Options from the bottom of the Shape Effects➪Shadow menu. This 
opens the Format Shape dialog box, shown in Figure 1-15. It gives you pre-
cise control over such factors as the color, amount of transparency, size, 
blurriness, angle, distance of the shadow.

 

Figure 1-15: 
Setting the 
Shadow 
options.
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237Applying Shape Effects

Applying a reflection
A Reflection effect displays a reflected version of the main shape, creating 
the impression that the shape is floating above a reflective surface such as 
glass or water. To apply a reflection to a shape, select the shape, click the 
Shape Effects button, click Reflection, and then choose one of the preset 
reflection effects from the gallery.

For more control over the reflection, choose Reflection Options at the 
bottom of the gallery. This action summons the dialog box shown in Figure 
1-16, which lets you adjust the transparency, size, distance, and blur of the 
reflection.

 

Figure 1-16: 
Setting 
Reflection 
options.

 

Applying Glow and Soft Edges
The Glow and Soft Edges effects both manipulate the edges of a shape to 
create a glowing effect or to simply soften the edges. You can apply these 
effects to a shape by selecting the shape, clicking the Shape Effects button, 
and then clicking either Glow or Soft Edges and choosing an effect from the 
gallery that appears.

If you want more exact control over either of these effects, choose Glow 
Options or Soft Edges Options from the bottom of the gallery to summon the 
dialog box shown in Figure 1-17. Then you can adjust the factors that create 
the glowing or softening effect.
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238 Applying Shape Effects

 

Figure 1-17: 
Setting 
Glow or 
Soft Edges 
options.

 

Applying a bevel
The Bevel effect lets you chisel away at the edge of a shape to create an 
interesting three-dimensional effect. The easiest way to apply a bevel is to 
select the shape, click the Shape Effects button, click Bevel, and then choose 
one of the bevel effects from the gallery that appears.

Alternatively, you can choose 3-D Options from the bottom of the gallery to 
open the dialog box shown in Figure 1-18. From this dialog box, you can con-
trol the amount and type of beveling on the top and bottom of the shape, the 
apparent depth and contour of the bevel, and the type of surface and light-
ing effects used to create the bevel.

Adding 3-D Rotation
The 3-D Rotation effect lets you spin a shape around as though it were a 
three-dimensional object. You can apply a preset 3D rotation to an object by 
choosing one of the options from the gallery that appears when you choose 
Shape Effects➪3-D Rotation. Or, you can choose 3-D Rotation Options from 
the bottom of the gallery to summon the dialog box shown in Figure 1-19. 
Then, you can play with the X, Y, Z, and Perspective settings to create an 
almost endless variety of three-dimensional rotations.
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239Flipping and Rotating Objects

 

Figure 1-18: 
Setting 
3-D Format 
(Bevel) 
options.

 

 

Figure 1-19: 
Setting 3-D 
Rotation 
options.

 

Flipping and Rotating Objects
To flip an object means to create a mirror image of it. To rotate an object 
means to turn it from its center. Word lets you flip objects horizontally or 
vertically, rotate objects in 90-degree increments, or freely rotate an object 
to any angle.
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240 Flipping and Rotating Objects

 

Rotation works for text boxes and Shape text. Thus, you can use rotation to 
create vertical text or text skewed to any angle you want. However, flipping 
an object doesn’t affect the object’s text.

Flipping an object
Word enables you to flip an object vertically or horizontally to create a 
mirror image of the object. To flip an object, follow these steps:

 1. Choose the object you want to flip.

 2. On the Drawing Tools Format tab, click the Rotate button in the 
Arrange group and then choose Flip Horizontal or Flip Vertical.

Rotating an object 90 degrees
You can rotate an object in 90-degree increments by following these steps:

 1. Choose the object you want to rotate.

 2. On the Drawing Tools Format tab, click the Rotate button in the 
Arrange group, and then choose Rotate Right or Rotate Left.

 3. To rotate the object 180 degrees, click the appropriate Rotate button 
again.

Using the rotate handle
Remember how all the bad guys’ hideouts were slanted in the old Batman TV 
show? The rotate handle lets you give your drawings that same kind of slant. 
Using the rotate handle, you can rotate an object to any arbitrary angle by 
just dragging it with the mouse.

The green rotate handle appears above the object, connected to the object by 
a line, as shown in Figure 1-20. You can rotate an object to any arbitrary angle 
by simply dragging the rotate handle either clockwise or counterclockwise.

The following steps show you how to use the rotate handle:

 1. Click the object you want to rotate.

 2. Drag the rotate handle in the direction you want to rotate the object.

  As you drag, an outline of the object rotates around. When the object’s 
outline is at the angle you want, release the mouse button and the object 
is redrawn at the new angle.

 

To restrict the rotation angle to 15-degree increments, hold the Shift key 
while dragging around the rotate handle.
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241Drawing a Complicated Picture

 

Figure 1-20: 
You use 
the rotate 
handle to 
rotate an 
object.

 

Rotate handle

Drawing a Complicated Picture
When you add more than one object to a page, you might start having lots of 
questions: What happens when objects overlap? How do you line up objects 
so that they don’t look like they were thrown at the page from a moving car? 
And, how do you keep together objects that belong together?

This section shows you how to use Word features to handle overlapped 
objects and how to align and group objects.

Changing layers
Whenever you have more than one object on a page, the potential exists for 
objects to overlap one another. Like most drawing programs, Word handles 
this problem by layering objects like a stack of plates. The first object you 
draw is at the bottom of the stack, the second object is on top of the first, 
the third is atop the second, and so on. If two objects overlap, the one that’s 
at the highest layer wins; objects below it are partially covered. So far, so 
good — unless you don’t remember to draw the objects in the correct order. 
You might draw a shape that you want to tuck behind a shape you’ve already 
drawn, or you might want to bring an existing shape to the top of the pecking 
order. No problem. In Word, you can change the stacking order by moving 
objects toward the front or back so that they overlap just the way you want.
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242 Drawing a Complicated Picture

 Word layers aren’t nearly as powerful as layers in programs such as Adobe 
Illustrator or AutoCAD. All they do is set the stacking order when objects are 
placed on top of one another.

The Drawing Tools Format tab provides two controls that let you move an 
object forward or backward in the layer order:

 ✦ Bring Forward: Moves the chosen object forward in the stack. Note that 
this button has a down arrow next to it. Click it to reveal a menu with 
three commands for moving the selected object:

 • Bring Forward: One step closer to the top of the heap

 • Bring to Front: To the top of the stack

 • Bring in Front of Text: In front of any text

 ✦ Send Backward: Sends the chosen object back in the stack. Again, this 
button has a down arrow next to it. Click the arrow to determine where 
to send the selected object:

 • Send Backward: Down one level in the layer order

 • Send to Back: To the back of the stack

 • Send Behind Text: Behind any text

Layering problems are most obvious when objects have fill colors. If an 
object has no fill color, objects behind it are allowed to show through. In 
these cases, the layering doesn’t much affect the appearance of the final 
drawing because the lack of fill allows all objects to be visible.

To bring an object to the top of another, you might have to use the Bring 
Forward command several times. The reason is that even though the two 
objects appear to be adjacent, other objects might occupy the layers 
between them.

Line ’em up
Nothing looks more amateurish than objects dropped randomly on a page 
with no apparent concern for how they line up with each other. The Drawing 
Tools Format tab includes the Align button, which opens a menu with these 
commands on it:

 ✦ Align Left

 ✦ Align Center

 ✦ Align Right

 ✦ Align Top

22_487662-bk04ch01.indd   24222_487662-bk04ch01.indd   242 4/15/10   9:10 PM4/15/10   9:10 PM



Book IV

Chapter 1

D
ra

w
in

g
 S

h
a

p
e

s 
o

n
 Y

o
u

r D
o

c
u

m
e

n
t

243Drawing a Complicated Picture

 ✦ Align Middle

 ✦ Align Bottom

 ✦ Distribute Horizontally

 ✦ Distribute Vertically

The first three commands align items horizontally, and the next three align 
items vertically. The last two commands distribute the objects evenly either 
horizontally or vertically. Select the items you want to distribute, click the 
Align button on the Drawing Tools Format tab, and then choose Distribute 
Horizontally or Distribute Vertically.

Using gridlines
To help you create well-ordered pages, Word lets you display a grid of 
evenly spaced lines over the page. These lines aren’t a part of the page, so 
your audience doesn’t see them when you give your presentation. The lines 
exist simply to make the task of lining things up a bit easier.

To display the grid or change its size, click the Align button on the Drawing 
Tools Format tab and then choose Grid Settings. The Drawing Grid dialog 
box, shown in Figure 1-21, is summoned.

 

Figure 1-21: 
The 
Drawing 
Grid dialog 
box.

 

To activate the grid, select the Snap Objects to Grid When the Gridlines Are 
Not Displayed check box and then adjust the grid spacing to your satisfac-
tion. If you want to see the grid on the screen, select the Display Gridlines on 
Screen check box.
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244 Drawing a Complicated Picture

Group therapy
A group is a collection of objects that Word treats as though it were one 
object. Using groups properly is one key to putting together simple shapes 
to make complex pictures without becoming so frustrated that you have to 
join a therapy group. (“Hello, my name is Doug, and Word drives me crazy.”)

To create a group, follow these steps:

 1. Choose all objects that you want to include in the group.

  Hold down the Shift key and click each item.

 2. Right-click a selected object and then choose Group➪Group from the 
menu that appears.

You can also find the Group command on the Drawing Tools Format tab, but 
it’s much easier to find by right-clicking.

To take apart a group so that Word treats the objects as individuals again, 
follow these steps:

 1. Right-click the group you want to break up.

 2. Choose Group➪Ungroup.

In Word, you can create groups of groups. This capability is useful for work-
ing with complex pictures because you can work on one part of the picture, 
group it, and then work on the next part of the picture without worrying 
about accidentally disturbing the part you already grouped. After you have 
several such groups, select them and group them. You can create groups of 
groups of groups, and so on, ad nauseam.
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Chapter 2: Inserting Pictures 
and Clip Art

In This Chapter
✓ Using free pictures

✓ Finding a picture you like

✓ Moving, sizing, cropping, and stretching pictures

✓ Adding special effects such as borders, shadows, and reflections

✓ Wrapping text around pictures

Face it: Most of us weren’t born with even an ounce of artistic ability. 
Someday (soon, I hope), the genetic researchers combing through 

the billions of genes strung out on those twisty DNA helixes will discover 
the Artist Gene. Then, despite protests from the daVincis, van Goghs, and 
Monets among us (who fear that their NEA grants will be threatened), doc-
tors will splice the little gene into our DNA strands so that we can all be art-
ists. Of course, this procedure won’t be without side effects: Some people 
will develop an insatiable craving for croissants, and others will inexplicably 
develop French accents and whack off their ears. But artists we shall be.

Until then, we have to rely on clip art or on pictures found on the Internet, 
scanned into the computer, or taken with a digital camera.

Exploring the Many Types of Pictures
The world is awash with many different picture file formats. Fortunately, 
Word works with almost all these formats. The following sections describe 
the two basic types of pictures you can work with in Word: bitmap pictures 
and vector drawings.

Bitmap pictures
A bitmap picture is a collection of small dots that comprise an image. Bitmap 
pictures are most often used for photographs and for icons and other but-
tons used on Web pages. You can create your own bitmap pictures with 
a scanner, a digital camera, or a picture-drawing program such as Adobe 
Photoshop. You can even create crude bitmap pictures using Microsoft 
Paint, the free painting program that comes with Windows.
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246 Exploring the Many Types of Pictures

The dots that make up a bitmap picture are pixels. The number of pixels in 
a given picture depends on two factors: the picture’s resolution and its size. 
Resolution refers to the number of pixels per inch, measured in dots per inch 
(dpi). Most computer monitors (and projectors) display 72 dpi in their stan-
dard resolutions. At this resolution, a 1-inch-square picture requires 5,184 
pixels (72 x 72). A photograph to be printed on an inkjet printer or a laser 
printer usually has a much higher resolution, usually at least 300 pixels per 
inch or more. At 300 dpi, a 4-x-6-inch photograph requires more than 2 mil-
lion pixels.

The amount of color information stored for the picture — also referred 
to as the picture’s color depth — affects the number of bytes of computer 
memory the picture requires. The color depth determines how many dif-
ferent colors the picture can contain. Most pictures have one of two color 
depths: 256 colors or 16.7 million colors. Most simple charts, diagrams, 
cartoons, and other types of clip art look fine with 256 colors. Photographs 
usually use 16.7 million colors.

 Pictures with 16.7 million colors are also known as true-color pictures, or 
24-bit color pictures. True-color also has a 32-bit color version, but the addi-
tional bits aren’t used for extra color. Instead, the extra 8 bits (the alpha 
channel) are used for other purposes, such as transparency control.

A typical 4-x-6-inch photograph, which has more than 2 million pixels at 300 
dpi, requires about 2MB to store with 256 colors. With true-color, the size of 
this typical picture jumps to a whopping 6.4MB. Fortunately, bitmap pictures 
can be compressed to reduce their sizes without noticeably distorting their 
images. Depending on the contents of the picture, a 6MB picture might be 
reduced to 250KB or smaller.

Bitmap picture files usually have filename extensions such as .bmp, .gif, 
.jpg, .pcx, or .png. Table 2-1 describes the bitmap file formats that Word 
supports.

 

I recommend that you use (if you have a choice) JPEG format images for 
photographs you want to include in Word documents, because JPEG’s built-
in compression saves hard drive space. (The JPEG compression method 
loses detail in the image, but the loss isn’t usually apparent.)

Table 2-1 Word’s Bitmap Picture File Formats

Format Type of File It Represents

BMP Garden-variety Windows bitmap file, used by Windows Paint and 
many other programs

GIF Graphics Interchange Format, a format commonly used for small 
Internet pictures
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247Using Clip Art

Format Type of File It Represents

JPEG A common photographic format that includes built-in compression; 
the extension JPG is sometimes used rather than JPEG, and variants 
of this format use the extensions JFEF and JPE

PCT Macintosh PICT

PNG Portable Network Graphics, an image format designed for Internet 
graphics

TIFF or 
TIF

Tagged Image Format, another bitmap program most often used for 
high-quality photographs

Victor, give me a vector
In addition to using bitmap pictures in Word, you can use vector drawings. 
A vector drawing is a picture file that contains a detailed definition of each 
shape that makes up the image. Vector drawings are usually created by 
using a high-powered drawing program such as Adobe Illustrator.

Word supports all the most popular vector drawing formats, as described in 
Table 2-2.

Table 2-2 Word’s Vector File Formats

Format Type of File It Represents

CDR CorelDRAW, a popular, upper-crust drawing program

CGM Computer Graphics Metafiles, a nondenominational file format that 
has been around since the mid-1980s.

EMF Enhanced Windows MetaFile, an enhanced version of WMF

EPS Encapsulated PostScript, used by some high-end drawing programs

WMF Windows MetaFile, a format that many programs recognize

WPG WordPerfect, a format popularized by the WordPerfect word-
processing program

Using Clip Art
Whether you buy Word by itself or as part of Microsoft Office, you also get 
a collection of thousands of pictures, sound clips, and motion clips that you 
can pop directly into your documents.
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248 Inserting Pictures

Word lets you access clip art from a special Clip Art task pane, where you 
can search for clip art by keyword. The Clip Art task pane helps you easily 
find just the right picture to embellish your document.

The first time you access the clip art, a dialog box appears, offering to 
search your entire hard drive and create a catalog of all the pictures it con-
tains. I suggest that you accept this offer so that you can use the Clip Art 
task pane to access your own picture files in addition to the clip art files that 
come with Word.

 

Be prepared to spend a few minutes waiting for this initial search to finish. 
Now would be a good time to take a walk.

If you don’t like the pictures that come with Word, you can scour the 
Internet for other pictures to use. Beware, though, that copyright restric-
tions usually apply to pictures you find on the Internet. You can’t legally 
point your browser to an Internet site, download any old picture, and use it 
in your documents without permission from the picture’s copyright owner. 
For more information about finding clip art pictures on the Internet, see the 
section “Getting clip art from the Internet,” later in this chapter.

Inserting Pictures
The following sections show you how to insert clip art and other types of 
pictures into your documents.

Inserting clip art
The following steps explain how to drop clip art into your document:

 1. Move to the page on which you want to plaster the clip art.

 2. Click the Insert tab on the Ribbon and then click the Clip Art button 
in the Illustrations group.

  After a brief moment’s hesitation, the Clip Art task pane pops up in all 
its splendor, as shown in Figure 2-1.

 3. Type a keyword in the Search For text box and then click the Go 
button.

  For example, to search for pictures of animals, type animal in the Search 
For text box and then click Go. Word then searches the Clip Organizer to 
locate clip art that depicts animals, and then it displays, in the Clip Art 
task pane, thumbnails of the pictures it finds.
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249Inserting Pictures

 

Figure 2-1: 
The Clip Art 
task pane.

 

 4. Click the picture you want to use.

  The picture is inserted on the current page, as shown in Figure 2-2. 
Notice that a special Ribbon Format tab with tools for working with pic-
tures has appeared. This Picture Tools Format tab appears whenever 
you select a picture object.

 5. If you’re finished inserting pictures, click the Clip Art task pane’s 
Close button (the X in the upper-right corner of the task pane).

  The task pane vanishes.

You probably want to move the picture and change its size. To find out how, 
see the section “Sizing and stretching a picture,” later in this chapter.

Getting clip art from the Internet
As though the vast collection of clip art that comes with Office and Word 
isn’t enough, Microsoft also maintains on the Internet a clip art library you 
can use. Assuming that you have a working Internet connection, you can 
access this additional clip art library by clicking the Find More at Office.com 
link at the bottom of the Clip Art task pane. A separate Internet Explorer 
window opens, which you can then use to search for additional clip art 
images. See Figure 2-3.
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Figure 2-2: 
Word 
inserts the 
picture on 
the page.

 

 

Figure 2-3: 
Getting clip 
art from the 
Internet.

 

If you find a clip art image you want, you can mark it for later download. 
Then, after you find all the images you want to download, you can choose 
an option to download the images directly into Clip Organizer. You can then 
view the images by using the Clip Art task pane as described earlier in this 
chapter, in the section “Using Clip Art.”
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251Inserting a Picture from a File

Inserting a Picture from a File
If you happen to already have on your computer an image file that you want 
to insert in a document, Word lets you insert the file. Follow these steps:

 1. Move to the page on which you want to splash a picture.

 2. Select the Insert tab on the Ribbon and then click the Picture button 
in the Illustrations group.

  This step summons the Insert Picture dialog box, shown in Figure 2-4.

 

Figure 2-4: 
The Insert 
Picture 
dialog box.

 

 3. Dig through your hard drive until you find the file you want.

  The picture you want might be anywhere. Fortunately, the Insert Picture 
dialog box has all the controls you need to search high and low until you 
find the file.

 4. Click the file and then click Insert.

  You’re done! Figure 2-5 shows how a picture appears when it has been 
inserted on a page.

As you can see in Figure 2-5, Word scales your pictures so that they fill as 
much of the page as possible. You need to resize the picture if you want it to 
be smaller. Just select the picture and then drag a size handle in the corner 
of the picture.

 

You also can paste a picture directly into Word by way of the Clipboard. 
Anything you can copy to the Clipboard, you can paste into Word. For 
example, you can doodle a sketch in Paintbrush, copy it, and then zap over 
to Word and paste it. Voilà — instant picture!
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Figure 2-5: 
Making a 
splash with 
pictures.

 

Playing with Your Pictures
After you transfer a picture into Word, you’ll have an irresistible urge to play 
with it. You’ll want to make it bigger, make it smaller, make it taller, make it 
skinnier, move it here, move it there, make it brighter, make it darker, and so 
on. With luck, you can play with the picture the entire afternoon and every-
one will think that you’re working hard.

Sizing and stretching a picture
In most cases, you need to resize your picture after you insert it. To do so, 
click the picture to select it. Notice the eight handles that appear around 
it. You can drag any or all of these handles to resize the picture. When you 
click a corner handle, the proportion of the picture stays the same as you 
change its size. When you drag an edge handle (top, bottom, left, or right) to 
change the size of the picture in just one dimension, you distort the picture’s 
outlook as you go.
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Stretching a picture by dragging an edge handle can dramatically change a 
picture’s appearance. For example, you can stretch an object vertically to 
make it look tall and thin or horizontally to make it look short and fat. I usu-
ally like to stretch pictures of myself vertically.

Cropping a picture
Sometimes, you want to cut off the edges of a picture so that you can include 
just part of the picture in your document. For example, you might have a pic-
ture of two people, only one of whom you like. You can use Word’s cropping 
feature to cut off the other person.

To crop a picture, select the picture and click the Crop button located near 
the right side of the Picture Tools Format tab on the Ribbon, in the Size 
group. The selection handles change to special crop marks. You can then 
drag the crop marks around to cut off part of the picture. When you’re satis-
fied, just click outside the picture.

Adding Style to Your Pictures
Word helps you draw attention to your pictures by adding stylistic features 
such as borders, shadows, and reflections. Figure 2-6 shows a page with sev-
eral copies of a picture, each with a different style applied.

To add a style effect to a picture, select the picture. Word automatically 
displays the Picture Tools Format tab on the Ribbon. Then simply select the 
picture style you want to apply in the Picture Styles group.

Word has 28 predefined picture styles, as shown in the gallery in Figure 2-7. 
This gallery appears in the Picture Styles group on the Picture Tools Format 
tab. Each style is simply a combination of three types of formatting you can 
apply to pictures: Border, Effects, and Layout. If you want, you can apply 
these formats individually as described in the following sections.

 

Figure 2-6: 
Pictures 
with style.

 

23_487662-bk04ch02.indd   25323_487662-bk04ch02.indd   253 4/15/10   9:11 PM4/15/10   9:11 PM



254 Adding Style to Your Pictures

 

Figure 2-7: 
Picture 
styles.

 

Applying a picture border
You can apply a border to a picture by choosing the Picture Border button in 
the Picture Styles group on the Picture Tools Format tab. This action reveals 
the Picture Border menu, which lets you choose the border color, weight (the 
width of the border lines), and pattern of dashes you want to use.

Applying picture effects
The Picture Effects button in the Picture Styles group on the Picture Tools 
Format tab lets you apply several interesting types of effects to your pictures. 
When you click this button, a menu with these effect options is displayed:

 ✦ Preset: Lets you choose from several predefined picture effects.

 ✦ Shadow: Applies a shadow to the picture. You can select a predefined 
shadow effect or open a dialog box that lets you customize the shadow.

 ✦ Reflection: Creates a reflected image of the picture beneath the original 
picture.

 ✦ Glow: Adds a glowing effect around the edges of the picture.

 ✦ Soft Edges: Softens the edges of the picture.

 ✦ Bevel: Creates a carved bevel effect around the edge of your picture.

 ✦ 3-D Rotation: Rotates the picture in a way that creates a three-dimen-
sional effect.

 

These picture effects work essentially the same way as the Shape Effects, 
described in Chapter 1 of this minibook. Feel free to see that chapter if you 
want more information about picture effects.
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Converting a picture to SmartArt
Beneath the Picture Effects button in the Picture Styles group is a button 
named Picture Layout. You can use this button to convert a picture to a 
SmartArt diagram. For more information about working with SmartArt dia-
grams, refer to Chapter 3 of this minibook.

Adjusting the Color and Such
The Adjust section of the Picture Tools Format tab includes several addi-
tional controls that let you manipulate pictures in fun ways. The Corrections 
drop-down menu lets you modify the picture in the following manner:

 ✦ Sharpen and Soften: Changes the sharpness of the picture

 ✦ Brightness and Contrast: Changes the image contrast and brightness 
settings

The Color drop-down menu lets you change the color of the picture in sev-
eral ways:

 ✦ Color Saturation: Changes the saturation of colors in the picture

 ✦ Color Tone: Changes the tone of the colors in the picture

 ✦ Recolor: Changes the picture to a different overall color

Use the Artistic Effects drop-down menu to add one or more effects such as 
chalk, light screen, watercolor, brush, or marker strokes to the picture.

Wrapping Text around a Picture
When you first insert a picture, Word places it in line with the text, just 
like the figures in this book. Any text that appears before or after the pic-
ture lines up with the bottom of the picture; no text appears alongside the 
picture. For example, have a look at the text in the top half of Figure 2-8: I 
inserted the picture of the whale in front of the first word of the paragraph.

In many cases, you want the text to wrap around the picture. The text in the 
bottom half of Figure 2-8 shows one way to do it. Tight wrapping causes the 
text to hug the picture as tightly as possible. To switch to tight wrapping, 
select the picture, click the Wrap Text button in the Arrange group on the 
Picture Tools Format tab, and choose Tight from the menu that appears.
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Figure 2-8: 
Wrapping 
text around 
a picture.

 

The Text Wrapping button includes several options:

 ✦ In Line with Text: The default wrapping option, and the one you’re least 
likely to use. It places the picture inline with your text. The height of the 
line on which the picture appears is adjusted to match the height of the 
picture. In most cases, this wrapping doesn’t look right.

 ✦ Square: Wraps the text squarely around the picture.

 ✦ Tight: Snuggles the text as closely as possible after Word determines 
where the edges of the picture are.

 ✦ Behind Text: “Spills” text right over the top of the picture, as though the 
picture weren’t even there. The picture appears behind the text.

 ✦ In Front of Text: Places the picture on top of the text. The picture might 
obscure some of the text, so use this option only if that’s what you want.

 ✦ Top and Bottom: Places text above and below the picture, but doesn’t 
allow any text to appear beside the picture.

 ✦ Through: Resembles the Tight option but results in an even tighter fit. If 
Word finds blank spaces within the picture, it fills the spaces with text.

 ✦ Edit Wrap Points: Lets you design your own wrapping shape around 
your picture by dragging little handles on a wrapping outline.
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When you choose Tight wrapping (or any other type of wrapping besides In 
Line with Text), the picture becomes a free-floating object and is no longer 
tied to a specific position within the text. You can drag the picture around to 
any location you want. You can even put it right in the middle of a para-
graph, and Word wraps the text around both sides. See Figure 2-9 for an 
example. Here, I set the wrapping style to Tight, and then I dragged the pic-
ture to the middle of the paragraph.

 

Figure 2-9: 
Plopping 
a picture 
into the 
middle of a 
paragraph.

 

 Another concept you need to know about how pictures work in Word is the 
anchors. An anchor is a location in the document’s text that’s associated 
with the picture. By default, pictures move with text based on their anchors. 
For example, if you insert a picture and then back up a bit and type addi-
tional text in front of the picture, the picture moves with the text. If that isn’t 
the action you want, right-click the picture and choose Wrap Text➪More 
Layout Options. Then deselect the Move Object with Text option on the 
Position tab of the Layout dialog box that appears.

23_487662-bk04ch02.indd   25723_487662-bk04ch02.indd   257 4/15/10   9:11 PM4/15/10   9:11 PM



Book IV: Inserting Bits and Pieces258

23_487662-bk04ch02.indd   25823_487662-bk04ch02.indd   258 4/15/10   9:11 PM4/15/10   9:11 PM



Chapter 3: Creating Charts 
and Diagrams

In This Chapter
✓ Adding a chart to your document

✓ Getting data from other programs

✓ Changing a chart’s layout and style

✓ Getting smart about SmartArt

✓ Creating a diagram or an organization chart

One of the best ways to prove a point is by using numbers, and one of 
the best ways to present numbers is in a chart. Adding a chart to a 

Word document is easy. Making the chart look the way you want is usually 
easy, too. Making charts look the way you want them to may take some 
pointing and clicking, but the result works and looks great. This chapter 
shows you how.

In addition to letting you create good old-fashioned charts, Word lets you 
create special types of diagrams known as SmartArt. I discuss standard 
charts first in this chapter, and then I dive into a discussion of SmartArt dia-
grams and organization charts.

Understanding Charts
If you’ve never attempted to add a chart to a Word document, the process 
can be a little confusing. A chart is simply a series of numbers rendered as 
a graph. You can supply the numbers yourself or copy them from a sepa-
rate file, such as an Excel spreadsheet. You can create all kinds of different 
charts, ranging from simple bar charts and pie charts to exotic doughnut 
charts and radar charts.

The following list details some terms you have to contend with when you’re 
working with charts:

 ✦ Chart (or graph): A bunch of numbers turned into a picture. After all, 
a picture is worth a thousand numbers. The words chart and graph are 
interchangeable.
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260 Understanding Charts

 ✦ Microsoft Graph: A program used in earlier versions of Word (but no 
longer) to create charts. For more information, read the later sidebar 
“Whatever happened to Microsoft Graph?”

 ✦ Chart type: Word supports several chart types: area, bar, column, dough-
nut, line, pie, radar, scatter, and others. You can even create cone charts 
that look like they fell off a fembot in an Austin Powers movie. Different 
types of charts are better suited to displaying different types of data.

 ✦ Chart layout: A predefined combination of chart elements such as head-
ings and legends that you use to easily create a common chart type.

 ✦ Chart style: A predefined combination of formatting elements that con-
trols the visual appearance of a chart.

 ✦ Datasheet: The origin of the numbers you’re using as chart data. After 
all, a chart is nothing more than a bunch of numbers made into a pic-
ture. Those numbers come from the datasheet. In some earlier versions 
of Word, the datasheet was a miniature spreadsheet that resembled 
Excel. In Word 2010, Microsoft gave up on the mini spreadsheet. Now 
the datasheet is an Excel spreadsheet. Thus, when you create a chart, 
Word automatically starts Excel (if it isn’t already running) and uses it to 
hold the numbers in the datasheet.

 ✦ Series: A collection of related numbers. For example, a chart of quar-
terly sales by region might have a series for each region. Each series has 
four sales totals, one for each quarter. Each series is usually represented 
by a row on the datasheet, but you can change the datasheet so that 
each column represents a series. Most chart types can plot more than 
one series. Pie charts can plot only one series at a time, however. The 
name of each series can be displayed in a legend.

 ✦ Axes: The lines along the edges of a chart:

 • x-axis: The line along the bottom of the chart that usually indicates 
categories

 • y-axis: The line along the left edge of the chart that plots data values

  Excel automatically provides labels for the x- and y-axes, but you can 
change them.

 ✦ Legend: A box used to identify the various series plotted on a chart. 
Word can create a legend automatically, if you want.

 The most interesting facet of charting tools in Word 2010 is their close 
integration with Excel 2010. When you insert a chart in Word, Excel auto-
matically launches and the data you chart is placed in an Excel workbook. 
However, the workbook isn’t stored as a separate document. Instead, the 
chart and the datasheet workbook are stored within the Word document. If 
you don’t have Excel 2007, don’t worry: You can still create charts in Word. 
(See the nearby sidebar “Whatever happened to Microsoft Graph?” for more 
information.)
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261Adding a Chart to a Document

Adding a Chart to a Document
The following procedure shows how to insert a chart on a page:

 1. Move the insertion point to the spot where you want the chart to 
appear.

 2. Click the Insert tab and then click the Chart button in the Illustrations 
group.

  The Insert Chart dialog box, shown in Figure 3-1, opens.

 

Figure 3-1: 
The Insert 
Chart dialog 
box.

 

 3. Select the type of chart you want to create.

  You can select any of these chart types:

 • Column: Displays data in vertical columns displayed side by side or 
stacked. You can pick various column shapes, including simple bars, 
3D blocks, cylinders, cones, and pyramids.

 • Line: Shows data as individual points linked by various types of 
lines.

 • Pie: Displayed data as slices in a circular pie.

 • Bar: Resembles a column chart except that its columns are laid out 
horizontally rather than vertically.

 • Area: Resembles a line chart except that areas beneath the lines are 
shaded.

 • X Y (Scatter): Plots individual points by using two values to repre-
sent the X, Y coordinates.

 • Stock: Plots high/low/close values.
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262 Adding a Chart to a Document

 • Surface: Resembles a line chart but represents the data as a three-
dimensional surface.

 • Doughnut: Resembles a pie chart but has a hole in the middle.

 • Bubble: Resembles a scatter chart but uses a third value to deter-
mine bubble size.

 • Radar: Plots data relative to a central point rather than x- and y-axes.

 4. Click OK.

  Word whirs and grinds for a moment and then inserts the chart into 
the page, shown in Figure 3-2. The reason for all the commotion is that 
in order to insert the chart, Word must determine whether Excel is 
already running. If it isn’t, Word launches Excel and rearranges your 
screen so that the two programs are displayed side by side, as you can 
see in the figure.

 

Figure 3-2: 
A chart, 
after it 
has been 
inserted into 
Word.

 

 5. Change the sample data to something more realistic.

  The data for the chart is shown in Excel, tiled alongside Word (refer to 
Figure 3-2). To find the data you want to chart, you have to change this 
worksheet. Notice that the chart itself changes to reflect the new data as 
soon as you return to Word (by clicking anywhere in the Word window).
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263Pasting a Chart from Excel

  For more information, see the section “Working with Chart Data,” later 
in this chapter.

 6. Customize the chart any way you want.

  For example, you can change the chart layout or style, as described later 
in this chapter. Figure 3-3 shows a finished chart.

 

Figure 3-3: 
A finished 
chart.

 

Pasting a Chart from Excel
If the data you want to chart already exists in an Excel workbook, the easi-
est way to chart it in Word is to first create the chart in Excel. Then copy 
the chart to the Clipboard, switch over to Word, and paste the chart in the 
appropriate page. When you do so, the chart appears in Word exactly as it 
did in Excel.

When you paste an Excel chart into Word, a Paste Options button appears 
next to the chart. You can click this button to reveal a menu with icons for 
these choices:
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264 Changing the Chart Type

 ✦ Keep Source Formatting and Embed Workbook: Maintains all format-
ting you applied in the original Excel chart. Thus the Word chart looks 
exactly like the Excel chart.

 ✦ Use Destination Theme and Embed Workbook: Reformats the chart 
according to the document theme used in the Word document. Your fin-
ished chart is formatted consistently with the rest of your document.

 ✦ Use Destination Theme and Link Data: Copies the chart into the Word 
document and creates a link to the data in the original Excel workbook. 
Any changes you make to the data in the original Excel workbook are 
reflected in the chart (and vice versa). In addition, the chart is trans-
lated into the destination Word document’s theme.

 ✦ Keep Source Formatting and Link Data: Links the Word chart to the 
data from the Excel sheet and preserves the original formatting of the 
chart (rather than make it fit in with the Word document).

 ✦ Picture: Converts the chart to a collection of Word shape objects with 
no linkage to the original Excel chart or data.

Changing the Chart Type
In Word, you can create 14 basic types of charts, each of which conveys 
information with a different emphasis. Sales data plotted in a column chart 
might emphasize the relative performance of different regions, for example, 
and the same data plotted as a line chart might emphasize an increase or 
decrease in sales over time. The type of chart that works best for your 
data depends on the nature of the data and which aspects of it you want to 
emphasize.

Fortunately, Word doesn’t force you to choose a final chart type immedi-
ately. You can easily change the chart type at any time without changing the 
chart data. These steps show you how:

 1. Click the chart to select it.

  The Chart Tools contextual tabs appear on the Ribbon, as shown in 
Figure 3-4.

 2. Click the Chart Tools Design tab and then click the Change Chart Type 
button in the Type group.

  Word displays a gallery of chart types.

 3. Click the chart type you want.

 4. Click OK and you’re done.
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265Working with Chart Data

 

Figure 3-4: 
The Chart 
Tools 
contextual 
tabs on the 
Ribbon.

 

Working with Chart Data
The data that provides the numbers plotted in a Word chart is stored in an 
Excel workbook. Depending on how you created the chart, this Excel work-
book can be either a separate workbook document or one that’s embedded 
within your Word document. Either way, you work with Excel whenever you 
want to modify the chart data.

To change the data on which a chart is based, select the chart to display 
the Chart Tools contextual tabs on the Ribbon. Click the Design tab if it isn’t 
already selected. The Chart Tools Design tab has a group named Data that 
has four controls you use to perform various tricks on the data, as described 
in the following sections.

Switching rows and columns
The first control in the Data group is Switch Row/Column. It changes the ori-
entation of your chart in a way that can be difficult to describe but easy to 
visualize. Refer to the chart shown earlier, in Figure 3-3. The chart is based 
on the data in this table:
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266 Working with Chart Data

River City Pixley Hooterville

Instruments 255 210 155

Music 60 52 43

Uniforms 190 150 130

As you can see in the figure, rows are used to determine data categories. 
Thus the chart displays instrument, music, and uniform data along the hori-
zontal axis.

If you click the Switch Row/Column button, the chart changes, as shown in 
Figure 3-5. Here, the chart categorizes the data by city, so sales for River 
City, Pixley, and Hooterville are shown along the horizontal axis.

 

Figure 3-5: 
Swapping 
the row-
and-column 
orientation.

 

Changing the data selection
You use the Select Data button in the Data group of the Chart Tools Design 
tab to change the selection of data on which your chart is based. When you 
click this button, Excel launches and the Select Data Source dialog box, 
shown in Figure 3-6, is displayed.

 

Figure 3-6: 
The Select 
Data Source 
dialog box.

 

24_487662-bk04ch03.indd   26624_487662-bk04ch03.indd   266 4/15/10   9:11 PM4/15/10   9:11 PM



Book IV

Chapter 3

C
re

a
tin

g
 C

h
a

rts 
a

n
d

 D
ia

g
ra

m
s

267Changing the Chart Layout

You can complete three basic tasks in this dialog box:

 ✦ Change the range of data used for the chart. You use the Chart Data 
Range text box.

 ✦ Switch rows and columns by clicking the Switch Row/Column button. 
This option has the same effect as clicking the Switch Row/Column 
button on the Ribbon.

 ✦ Experiment with the individual ranges that contain the data for each 
series. You can add a new series, edit the range used for an existing 
series, delete a series, or change the order in which the series are 
presented.

Editing the source data
To change the data values on which a chart is based, click the Edit Data 
button in the Chart Tools Design tab on the Ribbon. Excel launches and 
displays the chart data. You can then make any changes you want. After 
you return to Word (by clicking anywhere in the Word window), the chart is 
updated to reflect your changes.

Refreshing a chart
If a chart is linked to a separate Excel workbook, you can update the chart 
to reflect any changes that have been made to the underlying data. To do so, 
follow these steps:

 1. Click the chart to select it.

  Word adds the Chart Tools tabs to the Ribbon.

 2. Click the Chart Tools Design tab, if it isn’t already selected.

  Refer to Figure 3-4 to see what this tab looks like.

 3. Click the Refresh Data button in the Data group.

  The chart is updated with the data from the underlying Excel workbook.

Changing the Chart Layout
A chart layout is a predefined combination of chart elements such as legends 
and titles. Microsoft studied thousands of charts and talked to chart experts 
to create galleries of the most common layouts for each chart type. For 
example, Figure 3-7 shows the Layout gallery for column charts.
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268 Changing the Chart Style

 

Figure 3-7: 
The Chart 
Layout 
gallery for 
column 
charts.

 

To change the layout for a chart, follow these steps:

 1. Click the chart to select it.

  Word adds the Chart Tools tabs to the Ribbon.

 2. If it isn’t already selected, click the Chart Tools Design tab on the 
Ribbon.

  Refer to Figure 3-4 to see what this tab looks like.

 3. Select the layout you want to use from the Chart Layouts group.

  The Chart Layouts group displays the most commonly used layouts 
for the chart type. If the layout you want to use isn’t visible, you can 
click the More button (the down arrow in the lower-right corner of the 
chart layout icons) to display a gallery of available layouts.

Changing the Chart Style
A chart style is a predefined combination of formatting elements such as 
colors and shape effects. Microsoft provides a large assortment of chart 
styles to choose from. For example, Figure 3-8 shows the Chart Style gallery 
for column charts.

 

Figure 3-8: 
The Chart 
Style gallery 
for column 
charts.
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269Using the Layout Tab to Embellish Your Chart

To change the style for a chart, follow these steps:

 1. Click the chart to select it.

  Word displays the Chart Tools tabs on the Ribbon.

 2. If it isn’t already open, click the Chart Tools Design tab on the Ribbon.

  See Figure 3-4 if you need a refresher.

 3. Select the style you want to use from the Chart Styles group.

  The Chart Styles group displays the most commonly used styles for the 
chart type. If the style you want to use isn’t visible in this group, you can 
click the More button (the down arrow in the lower-right corner of the 
chart layout icons) to display a gallery of available styles.

Using the Layout Tab to Embellish Your Chart
You can embellish a chart in Word in many ways: Add titles, labels, legends, 
and just about anything else. The easiest way to add these elements is by 
selecting a chart layout, as described in the earlier section “Changing the 
Chart Layout.” However, you can create your own, unique chart layout by 
adding these elements individually.

To do it, select the chart and open the Chart Tools Layout tab. Figure 3-9 
shows you what this tab looks like.

 

Figure 3-9: 
The Layout 
tab.

 

The Insert group
The Insert group on the Layout tab lets you insert a picture, shape, or text 
box. For more information about working with these elements, see Chapters 
1 (shapes), 2 (pictures), and 5 (text boxes) of this minibook.

The Labels group
You can use the Labels group on the Layout tab to add various types of 
labels to your chart:

 ✦ Chart title: Describes the chart’s contents. The title usually appears at 
the top of the chart, but you can drag it to any location you want.
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270 Using the Layout Tab to Embellish Your Chart

 ✦ Axis title: Describes the meaning of each chart axis. Most charts use two 
axes titles:

 • Primary horizontal axis

 • Primary vertical axis

 ✦ Legend: Identifies the data series that appears in the chart. When you 
click the Legend button, a menu with several choices for the placement 
of the legend appears. You can also choose More Legend Options to 
display the Format Legend dialog box, shown in Figure 3-10. From this 
dialog box, you can set the position of the legend and control various 
formatting options for the legend, such as the fill and border style.

 

Figure 3-10: 
The Format 
Legend 
dialog box.

 

  You can create a legend in Word, but you’re on your own if you need a 
myth or fable.

 ✦ Data label: Describes the data points on the chart. For maximum control 
over data labels, choose More Data Label Options to display the Format 
Data Labels dialog box, shown in Figure 3-11.

 

 For most page types, data labels add unnecessary clutter without adding 
much useful information. Use labels only if you must back up your chart 
with exact numbers.
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Figure 3-11: 
The Format 
Data Labels 
dialog box.

 

 ✦ Data table: Shows the data used to create a chart. Most charts don’t 
include data tables, but you can add one if you believe that your audi-
ence will benefit from seeing raw numbers. For example, Figure 3-12 
shows a chart with a data table.

 

Figure 3-12: 
A chart with 
a data table.
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The Axes group
The Axes group on the Layout tab includes just two controls:

 ✦ Axes: The x- and y-axes on which chart data is plotted. The x-axis is 
the horizontal axis of the chart, and the y-axis is the vertical axis. In 3D 
charts, a third axis (z) is also used. You use the Axes control to show or 
hide the labels used for each chart axis.

 ✦ Gridlines: Light lines drawn behind a chart to make it easier to judge 
the position of each dot, bar, or line plotted by the chart. You can turn 
gridlines on or off by using the Gridlines button.

The Background group
The Background group on the Layout tab includes the following useful con-
trols for formatting various parts of the chart background:

 ✦ Plot area: Formats the background of the main area of the chart

 ✦ Chart wall: Controls the wall format (if your chart format has a wall)

 ✦ Chart floor: Controls the floor format (if your chart format has a floor)

 ✦ 3-D Rotation: Controls the rotation and other aspects of the 3D display 
(if your chart has a 3D format)

Understanding SmartArt
The nifty little SmartArt feature in Word lets you add several different types 
of useful diagrams to your document, all of which are described in Table 3-1.

Table 3-1 Diagram Types You Can Create

Icon Diagram Type What Is Shown

Cycle A process that repeats in a continuous 
cycle

Hierarchy Hierarchical relationships, such as 
organization charts

List A simple list, with information that either 
has no particular organization or implies 
a sequential progression, such as steps 
in a task

Matrix Four items arranged into quadrants
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273Understanding SmartArt

Icon Diagram Type What Is Shown

Process A process in which steps flow in a 
sequential fashion

Pyramid Elements building on each other to form 
a foundation

Relationship Items’ conceptual relationships, includ-
ing various types of radial and Venn 
diagrams

Picture SmartArt diagrams that feature pictures 
in each individual element

The idea behind SmartArt diagrams is to represent bullet lists as a diagram 
of interconnected shapes. Although many different types of SmartArt dia-
grams are available, they all work the same way. The only true differences 
among the various SmartArt diagram types pertain to how they graphically 
represent the bullets.

For example, the following bullet list represents activities related to my day. 
Though the list is vague, it structures activities in the order in which they 
occur, which makes it a rough approximation of the process of going to work:

 ✦ Arrive

 ✦ Work

 ✦ Lunch

 ✦ More work

 ✦ Leave

Figure 3-13 shows this list represented by two different types of SmartArt. 
The only difference between these two SmartArt objects is the type of 
SmartArt diagram I selected to create them.

Note that many SmartArt diagram types can display two or more outline 
levels in a bullet list. Suppose that you create this list:

 ✦ Arrive

 • Stop for coffee on the way

 • Try not to be late
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Figure 3-13: 
Two 
examples 
of SmartArt 
diagrams.

 

 ✦ Work

 • Coffee break at 10:00

 • Look smart!

 ✦ Lunch

 • Best part of the day!

 ✦ More work

 • Coffee break at 2:00

 • Try to stay awake at 4:00

 ✦ Leave

 • Leave early today?

Figure 3-14 shows how this list appears when formatted as a horizontal 
process chart. As you can see, second-level bullets are incorporated as text 
within the diagram.

One of the most useful aspects of SmartArt is that you can easily change 
from one type of diagram to another. Thus, if you decide that a diagram 
doesn’t convey the message you intend, you can change the diagram type to 
see whether another type makes the message clear.
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275Creating a SmartArt Diagram

 

Figure 3-14: 
Second-
level text 
displayed in 
a horizontal 
process 
chart.

 

Creating a SmartArt Diagram
The following steps outline the procedure for creating a SmartArt diagram:

 1. Move the insertion point to the spot where you want to create the 
SmartArt diagram.

 2. Click the Insert tab on the Ribbon and then click SmartArt.

  This step summons the dialog box shown in Figure 3-15.

 

Figure 3-15: 
Creating a 
SmartArt 
diagram.

 

 3. Choose the SmartArt diagram type you want to insert.

 4. Click OK.

  The SmartArt diagram is inserted into the document, as shown in 
Figure 3-16.
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Figure 3-16: 
A SmartArt 
diagram 
immediately 
after it 
has been 
inserted.

 

 5. Type the bullet list items to use for the diagram.

  Use the Text pane provided for this purpose. (If the Text pane isn’t vis-
ible, click the arrow that appears to the left of the SmartArt diagram. 
This will summon the Text pane.)

 6. Modify the diagram however you see fit.

  For more information, see the next section.

You’re done!

If you’re not done because you want to perfect your diagram, you can con-
tinue tweaking it until the end of time. But at some point you have to say 
“Enough is enough.”

Tweaking a SmartArt Diagram
After you create a SmartArt diagram, you can adjust its appearance in many 
ways. The easiest way is to change the SmartArt Style applied to the dia-
gram. A SmartArt Style is simply a collection of formatting elements, such 
as colors and shape effects, that are assigned to the various elements of a 
SmartArt diagram.

Microsoft provides a large assortment of SmartArt Styles to choose from. For 
example, Figure 3-17 shows the SmartArt Styles gallery for pyramid diagrams.

 

Figure 3-17: 
Pyramid 
SmartArt 
styles.
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277Working with Organization Charts

To change the SmartArt for a SmartArt diagram, follow these steps:

 1. Click the diagram to select it.

  Word adds the SmartArt Tools tab to the Ribbon.

  Figure 3-18 depicts the SmartArt Tools Design tab.

 

Figure 3-18: 
The 
SmartArt 
Tools 
Design tab.

 

 2. Select the style you want to use from the SmartArt Styles group.

  The SmartArt Styles group, shown in Figure 3-18, displays the most com-
monly used styles for the diagram type. If the style you want to use isn’t 
visible in this group, click the More button (the down arrow to the lower 
right of the Quick Style icons) to display a gallery of available styles.

Working with Organization Charts
An organization chart — you know, the box-and-line chart that shows who 
reports to whom, where the buck stops, and who got the lateral arabesque — 
is an essential part of many documents.
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Hierarchical SmartArt diagrams are ideal for creating organization charts. 
You can create diagrams that show bosses, subordinates, coworkers, and 
assistants, and you can easily rearrange the chain of command and add or 
delete boxes. Figure 3-19 shows a finished organization chart.

 

Figure 3-19: 
A finished 
organization 
chart.

 

The organization chart shown in the figure is based on this bulleted list:

 ✦ Doc

 • Sneezy

 • Grumpy

 • Sleepy

 • Happy

 • Bashful

Notice that Dopey is missing from this list — he’s in a special Assistant box 
on the chart. You find out how to add Assistant boxes later in this chapter.

 

Organization charts are useful for more than showing employee relation-
ships — you can use this chart type to show any kind of hierarchical struc-
ture. For example, back when I wrote computer programs for a living, I used 
organization charts to plan the programs’ structure. This chart type is also 
useful for recording family genealogies, though it has no way to indicate that 
Aunt Milly hasn’t spoken to Aunt Beatrice in the past 30 years.
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279Working with Organization Charts

Earlier versions of Word used the clumsy program Microsoft Organization 
Chart to handle organization charts. The new SmartArt feature is easier to 
use, though it isn’t quite as adept at creating complicated charts.

Adding a box to a chart
You can add a box to an organization chart by opening the Text pane and 
editing the outline text that appears in the Text pane. Alternatively, you can 
use the controls in the SmartArt Tools on the Ribbon to add boxes. One 
benefit of using these controls is that you can add an Assistant, a box that 
appears outside the hierarchical chain of command.

To add a box to an organization chart, follow these steps:

 1. Click the box that you want the new box to be below or next to.

 2. In the Create Graphic group on the SmartArt Tools Design tab, click 
the Add Shape button to reveal a menu of choices. Then select one of 
these options:

 • Add Shape Before: Inserts a new box at the same level as the selected 
box, immediately to its left.

 • Add Shape After: Inserts a new box at the same level as the selected 
box, immediately to its right.

 • Add Shape Above: Inserts a new box above the selected box.

 • Add Shape Below: Inserts a new box beneath the selected box.

 • Add Assistant: Inserts a new box beneath the selected box, though 
the new box is connected by a special elbow connector to indicate 
that the box is an Assistant and not a subordinate.

 3. Click the new box and then type whatever text you want to appear in 
the box.

 4. If necessary, drag the box to adjust its location.

Deleting chart boxes
To delete a box from an organization chart, select the box and press Delete. 
Word automatically adjusts the chart to compensate for the lost box.

When you delete a box from an organization chart, you should observe a 
moment of somber silence — or throw a party, depending on whose name 
was in the box, I suppose.
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Changing the organization chart layout
Choose from these four methods to arrange subordinates in an organization 
chart branch in Word:

 ✦ Standard: Placed at the same level beneath the superior shape

 ✦ Both: Placed two per level beneath the superior with the connecting line 
between them

 ✦ Left Hanging: Stacked vertically beneath the superior, to the left of the 
connecting line

 ✦ Right Hanging: Stacked vertically beneath the superior, to the right of 
the connecting line

You can set up a typical organization chart using all four layouts. For 
example, the first layer of shapes beneath the top level might use the 
Standard layout, and beneath the first shape on this layer you could add two 
shapes using the Both layout. You could then add two more shapes (each 
one having three subordinate shapes) by using the Left Hanging and Right 
Hanging layout.

To change the layout of a branch of your chart, first click the shape at the top 
of the branch and click SmartArt Tools Design tab on the Ribbon. Then click 
the Layout button in the Create Graphic group and choose a layout type.
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Chapter 4: Working with Tables

In This Chapter
✓ Setting up and using Word tables

✓ Editing table cells, columns, and rows

✓ Formatting table cells

✓ Using advanced table features

I couldn’t figure out what to title this chapter (though “Setting the Table,” 
“Turning the Tables,” “Sliding Under the Table,” “Dancing on the Table,” 

“Tabling the Motion,” “The Periodic Table,” and “Table for Two” all came to 
mind), so I gave up and named it simply “Working with Tables.”

This chapter describes the ins and outs of formatting text and graphics into 
tables. The Word table feature is remarkably versatile, so figuring out how it 
works pays off.

If you’re going to sit at my table, you have to uphold the same table man-
ners I’ve been trying to teach my kids for years: No talking with your mouth 
open, and no eating with your mouth full.

Understanding and Creating Tables
You can think of a table as a miniature spreadsheet within a Word docu-
ment. The table consists of rows and columns, with a cell at every intersec-
tion. Each cell can contain text or graphics, and you can format the table in 
any way you want. Figure 4-1 shows a simple Word table.

 

Figure 4-1: 
A simple 
table.

 

Each table cell can contain one or more paragraph of text, and text automat-
ically wraps within its cell. Whenever text wraps to a new line, Word auto-
matically increases the height of the row, if necessary, to accommodate the 
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282 Understanding and Creating Tables

new line of text. Now the versatility of tables becomes apparent. I can create 
the table shown in Figure 4-1 by using tabs rather than the Table feature; in 
fact, that method is probably easier. Consider the table shown in Figure 4-2, 
however. To use tabs to create a table like that one, you have to manually 
break the lines for each column, using the Tab key to separate columns.

 

Figure 4-2: 
A more 
complex 
table.

 

Figure 4-3 shows how the table looks in Word when it’s being edited. 
Notice that each table column has its own margins and indentation settings 
on the Ruler. (The Ruler’s indentation indicators are visible only in the 
column where the insertion point rests; in this example, the third column is 
selected.)

 

Figure 4-3: 
How a table 
that’s being 
edited looks 
in Word.
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283Understanding and Creating Tables

  If you don’t see gridlines when you work with tables, select the table and 
then, on the Table Tools Layout tab on the Ribbon, click the View Gridlines 
option (in the Table group).

A Word table can contain as many as 63 (narrow) columns. The number of 
rows is unlimited. When you create a table, Word adjusts the size of each 
column so that the table fits between the left and right margins. Each column 
is initially set to the same size, but you can adjust the size of individual col-
umns later, and you can adjust the width of the entire table.

The following sections describe several methods for creating tables.

Creating a table by using the Table button
The Table button, which resides on the Insert tab, is the fastest way to 
create a simple table. When you click this button, a drop-down grid appears, 
as shown in Figure 4-4. Drag the mouse down and across the grid until the 
correct number of columns and rows is selected and then release the mouse 
button to create the table at the insertion point. (Naturally, you must first 
place the insertion point where you want the table inserted.)

 

Figure 4-4: 
Using 
the Table 
button.

 

Using the Insert Table command
If you prefer the dialog box approach to creating a table, you can use the 
Insert Table command instead. Using this command, you pick an arbitrary 
number of rows and columns for your table. (The Table button is limited to 
eight rows and ten columns.)
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284 Understanding and Creating Tables

Follow these steps to create a formatted table by using the Insert Table 
command:

 1. Position the insertion point where you want to insert the new table.

 2. Select the Insert tab, click the Table button in the Tables group, and 
then choose the Insert Table command.

  The Insert Table dialog box appears, as shown in Figure 4-5.

 

Figure 4-5: 
The Insert 
Table dialog 
box.

 

 3. Adjust the Number of Columns and Number of Rows fields to specify 
the number of rows and columns you want to create.

 

 If you create the same type of table regularly, select the Remember 
Dimensions for New Tables check box.

 4. Click OK to insert the table.

Drawing a table
You can use a simple set of tools in the Draw Table command to draw com-
plicated tables onscreen. This command is ideal for creating tables that are, 
rather than just simple grids of rows and columns, complex conglomerations 
in which some cells span more than one row and other cells span more than 
one column.

To create a table by using the Draw Table tool, follow this procedure:

 1. Select the Insert tab, click the Table button in the Tables group, and 
then choose the Draw Table command.

  The cursor changes to a small pencil shape.

 2. Draw the overall shape of the table by dragging the pencil pointer 
diagonally to create a rectangular boundary.

  When you release the mouse button, a table consisting of a single cell 
is created, as shown in Figure 4-6. In addition, the Ribbon displays the 
Table Tools Design tab.
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285Understanding and Creating Tables

 

Figure 4-6: 
First draw 
a rectangle 
as the table 
outline.

 

 3. “Carve” the table into smaller cells.

  For example, to split the table into two rows, point the cursor some-
where along the left edge of the table and then click and drag a line 
across the table to the right edge. When you release the mouse button, 
the table splits into two rows.

  You can continue to carve the table into increasingly smaller cells. For 
each slice, point the cursor at one edge of the cell where you want the 
new cell to begin and then click and drag to the other edge.

 4. If you want to change the line size or style that’s drawn for a particu-
lar segment, use the Line Style and Line Weight drop-down controls in 
the Draw Borders group on the Table Tools Design tab.

  You can change the style of a line you’ve already drawn by tracing over 
the line with a new style.

  5. If you make a mistake while drawing a table cell, click the Eraser 
button (shown in the margin) and erase the line segment.

  Click the Draw Table button if you want to draw additional segments 
after using the Eraser tool.

 6. When you’re done, click anywhere outside the table.

Figure 4-7 shows a table carved into several cells, with various types of line 
styles and line weights.
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Figure 4-7: 
A mishmash 
of line styles 
and line 
weights in a 
table.

 

Using the Table Tools Tabs
When you work with tables, two tabs appear on the Table Tools context 
menu: Design and Layout. You find out how to use many of the tools on 
these tabs later in this chapter. Tables 4-1 and 4-2 helpfully summarize the 
controls you can find on these tabs.

Table 4-1 The Design Tab

Control Name What It Does

Header Row Applies different formatting to first row 
of table

Total Row Applies different formatting to last row 
of table

Banded Rows Alternates row shading

First Column Applies different formatting to first column 
of table

Last Column Applies different formatting to last column 
of table

Banded 
Columns

Alternates column shading

Shading Applies table shading

Borders Applies table borders

Draw Table Draws table outline and then line segments 
to create new cells within table
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287Using the Table Tools Tabs

Control Name What It Does

Eraser Erases line segments to remove cells from 
table

Line Style Sets line style for line segments drawn with 
Draw Table tool

Line Weight Sets width of line segments drawn with 
Draw Table tool

Pen Color Sets color of line segments drawn with 
Draw Table tool

Table 4-2 The Layout Tab

Control Name What It Does

Select Drop-down control; lets you select table 
cells, rows, or even entire tables

View Gridlines Shows or hides table gridlines

Properties Displays Table Properties dialog box

Delete Delete rows, columns, cells, or entire 
tables

Insert Above Inserts row above selection

Insert Below Inserts row below selection

Insert Left Inserts column to left of selection

Insert Right Inserts column to right of selection

Merge Cells Merges selected adjacent cells to create 
one large cell

Split Cells Splits merged cell into separate cells

(continued)
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Table 4-2 (continued)

Control Name What It Does

Split Table Splits table into two tables

AutoFit Adjusts table layout to fit page

Height Sets row height

Width Sets column width

Distribute 
Rows

Adjusts height of selected rows to distrib-
ute rows evenly

Distribute 
Columns

Adjusts width of selected columns to 
distribute columns evenly

Align Top Left Sets Top vertical alignment and Left 
horizontal alignment

Align Top 
Center

Sets Top vertical alignment and Center 
horizontal alignment

Align Top Right Sets Top vertical alignment and Right 
horizontal alignment

Align Center 
Left

Sets Center vertical alignment and Left 
horizontal alignment

Align Center Sets Center vertical and horizontal 
alignment

Align Center 
Right

Sets Center vertical alignment and Right 
horizontal alignment

Align Bottom 
Left

Sets Bottom vertical alignment and Left 
horizontal alignment

Align Bottom 
Center

Sets Bottom vertical alignment to Center 
horizontal alignment

Align Bottom 
Right

Sets Bottom vertical alignment and Right 
horizontal alignment

Text Direction Changes direction of text in cell
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289Editing Tables

Control Name What It Does

Cell Margins Sets margins for individual cells

Sort Sorts selected cells

Repeat Header 
Rows

Repeats header rows when table spans 
multiple pages

Convert to Text Converts table to text

Formula Enters calculated formula

Editing Tables
After you create a table, you may discover that you need to make a few 
changes. Don’t just delete the whole table and start from scratch. As the fol-
lowing sections describe, you can follow a few procedures to perform basic 
table-editing tasks. Find out how to select cells, add and delete rows and col-
umns, and change column widths.

 

As you experiment with tables in your Word documents, don’t forget to 
do a little right-clicking. Just about everything you can do to a table cell is 
accessible from the shortcut menu that appears when you right-click the 
cell. Different combinations of commands appear depending on whether you 
select a single cell, a range of cells including an entire column or row, or an 
entire table.

Moving and selecting in tables
You can move from cell to cell in a table by using any keyboard shortcut 
listed in Table 4-3.

Table 4-3 Table-Navigation Keyboard Shortcuts

To Move to This Cell Use This Keyboard Shortcut

Next cell in row Tab

Previous cell in row Shift+Tab

First cell in row Alt+Home

First cell in column Alt+PgUp
(continued)
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Table 4-3 (continued)

To Move to This Cell Use This Keyboard Shortcut

Last cell in row Alt+End

Last cell in column Alt+PgDn

Previous row Up arrow

Next row Down arrow

You can combine the Shift key with a keyboard shortcut listed in Table 4-3 to 
extend a selection over a range of cells. In addition, you can select the entire 
table by placing the insertion point anywhere in the table and pressing 
Alt+Numeric 5 (the 5 on the numeric keypad, not the 5 key on the row that 
runs across the top of the keyboard).

You can also select various portions of a table by using the mouse actions 
listed in Table 4-4.

Table 4-4 Mouse Actions for Selecting Cells in a Table

To Select This Use This Mouse Action

A single cell Move the cursor over the left edge of the cell until the cursor 
becomes a right-pointing arrow, and then click.

An entire row Move the cursor just past the left edge of the leftmost cell in 
the row until the cursor changes to a right-pointing arrow, 
and then click.

An entire column Move the cursor just above the topmost cell in the row until 
the cursor changes to a down-pointing arrow, and then click.

A range of cells Drag the cursor across the rectangular area of cells you 
want to select.

The entire table Click the icon that appears just outside of the top-left corner 
of the table.

Adding rows and columns
To add a new row or column to a table, you can use one of the Insert com-
mands on the Table Tools Layout tab.

To add new rows to a table, follow one of these procedures:
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291Editing Tables

 ✦ To insert a new row within the body of a table, place the cursor inside 
the row adjacent to the cell where you want to insert the new row. Then 
click either Insert Above or Insert Below in the Rows & Columns group. 
The new row is inserted above or below the selected row.

 ✦ To insert multiple rows, select the number of rows you want to insert and 
then choose Insert Above or Insert Below in the Rows & Columns group.

 ✦ To insert a new row at the bottom of the table, move the insertion 
point to the last cell in the last row of the table and press the Tab key.

To add new columns to a table, follow one of these procedures:

 ✦ To insert a new column within the body of the table, click anywhere 
in the column where you want to insert the new column and choose 
either Insert Left or Insert Right in the Rows & Columns group. The new 
column is inserted to the left or right of the selected column.

 ✦ To insert several columns, select the number of columns you want 
to insert and choose either Insert Left or Insert Right in the Rows & 
Columns group.

Inserting cells
You can insert individual cells within a Word table. Start by highlighting the 
cell or cells where you want to insert the new cells. Then click the dialog 
box launcher that appears in the lower-right corner of the Rows & Columns 
group on the Table Tools Layout tab. The Insert Cells dialog box appears, as 
shown in Figure 4-8.

 

Figure 4-8: 
Inserting 
cells.

 

If you want to add new cells above selected cells and shift down unselected 
cells in the same rows, select the Shift Cells Down option. If you want to 
insert the new cells to the left of the selected cells, with extra cells added to 
the affected rows, select the Shift Cells Right option. Then click OK.

Deleting cells
If you want to delete the contents of one or more cells, you can start by 
selecting the cells and pressing Delete. Unfortunately, even though the 
contents of the cells are deleted, the cells themselves remain in place. This 
result may not be what you want.
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To remove one or more rows or columns from the table, select the rows or 
columns you want to delete and click the Delete button on the Table Tools 
Layout tab. This action reveals a menu with these choices:

 ✦ Delete Cells

 ✦ Delete Columns

 ✦ Delete Rows

 ✦ Delete Table

To remove a range of cells in the table, follow these steps:

 1. Select the cells you want to remove.

  2. Click the Delete button on the Layout tab on the Table Tools context 
menu and choose Delete Cells from the menu that appears.

  The Delete Cells dialog box appears, as shown in Figure 4-9.

 

Figure 4-9: 
The Delete 
Cells dialog 
box.

 

 3. Select whether you want to shift the surrounding cells up or to the left 
to fill the void left by the deleted cells or to just delete entire rows or 
columns.

 4. Click OK.

Adjusting column width
When Word creates a table, it initially makes each column the same width. 
Having equal columns isn’t appropriate for many tables, however, because 
the data in each column is rarely uniform in size. For example, the first 
column of a table might contain the names of famous composers, and the 
second column might list their three most famous concertos. Obviously, the 
second column is wider than the first.

Fortunately, Word doesn’t impose uniform column widths. You can manually 
adjust the width of each column individually or let Word adjust the width of 
each column automatically based on the contents of the column.

To adjust the width of an individual column manually, you have a few 
options:
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293Editing Tables

 ✦ Drag the gridline to the right of the column to increase or decrease 
the column width. Grabbing the gridline so that you can move it is a 
little tricky, but if you hold the mouse cursor directly over the line, 
the cursor changes into a double-beam thingy indicating that you’ve 
grabbed the gridline.

 ✦ Drag the column marker that appears on the Ruler.

  Either way, the widths of the columns to the right of the one you adjust 
automatically adjust so that the width of the entire table remains the 
same.

 

 If you hold down the Alt key while adjusting column width, the width of 
each column is shown on the Ruler, to help you more precisely size the 
columns. (If the Ruler isn’t visible, you can display it by selecting the 
Ruler check box in the Show group on the View tab.)

 ✦ Click the Properties button on the Layout tab to open the Table 
Properties dialog box. Then click the Column tab, shown in Figure 4-10.

 

Figure 4-10: 
Setting the 
column 
width with 
the Table 
Properties 
dialog box.

 

  From this dialog box, you can set the width of every column to a precise 
measurement. The Table Properties dialog box shows the column width 
for one column at a time. Use the Previous Column and Next Column 
buttons to move from column to column.

Using the AutoFit command
  The AutoFit command, which lives near the middle of the Layout tab, auto-

matically adjusts the size of a table’s columns and rows so that you don’t 
have to mess with each column and row separately. The AutoFit command 
has three variations:

25_487662-bk04ch04.indd   29325_487662-bk04ch04.indd   293 4/15/10   9:12 PM4/15/10   9:12 PM



294 Using Tabs in a Table

 ✦ AutoFit Contents: Adjusts the size of the cells based on their contents

 ✦ AutoFit Window: Resizes tables on Web pages so that they fit in the 
browser window

 ✦ Fixed Column Width: Prevents the table from resizing itself as you type 
text in cells

Using Tabs in a Table
You can set tab stops for individual cells or a range of table cells. Tabs in 
tables work much the way they do outside of tables, with two important 
exceptions:

 ✦ To insert a tab character into a cell, you must press Ctrl+Tab. Simply 
pressing the Tab key moves the cursor to the next cell without inserting 
a tab.

 ✦ If you add a decimal tab to a table cell, the text in the cell aligns auto-
matically over the decimal tab. (A decimal tab aligns numbers on the 
decimal point.) You don’t have to press Ctrl+Tab to move the data to the 
tab stop.

Using Table Styles
You can apply many different formatting elements to tables. The easiest way 
to format a table is to assign a predefined style that appears on the Table 
Tools Design tab. Several predefined styles appear directly on the Design 
tab. You can display the entire gallery by clicking the More button (the down 
arrow near the lower-right corner of the Table Styles group). See Figure 4-11.

The six check boxes on the left of the Table Tools Design tab govern which 
aspects of the table the style formatting is applied to. The options are

 ✦ Header Row

 ✦ Total Row

 ✦ First Column

 ✦ Last Column

 ✦ Banded Columns

 ✦ Banded Rows

To modify a table style that appears in the Table Styles gallery, click the 
Modify Table Style option. The Modify Style dialog box opens, as shown in 
Figure 4-12. From this dialog box, you can change nearly every aspect of the 
table’s formatting.
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295Using Table Styles

 

Figure 4-11: 
The Table 
Styles 
gallery.

 

 

Figure 4-12: 
The Modify 
Style dialog 
box.

 

You can set the formatting for several different elements of the table by 
choosing the element you want to format from the Apply Formatting To 
drop-down list. This drop-down list lets you select various table elements.
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Merging Cells to Create Headings
If your table requires a heading that spans more than one column, you can 
use the Merge Cells command, found on the Table Tools Layout tab. For 
example, Figure 4-13 shows a table in which the cell that contains the Survey 
Results heading is merged so that it spans four columns.

 

Figure 4-13: 
A table with 
merged 
cells.

 

To create a multicolumn heading, such as the one shown in Figure 4-13, 
follow these steps:

 1. Create the table as usual.

  For a heading that will span several columns, type the text into the cell 
above the first column that you want the heading to span.

 2. Highlight the cells in the row where you want to create a multicolumn 
heading.

  3. Click the Merge Cells button in the Merge group on the Layout tab.

  The cells merge into one gigantic cell that spans several columns.

 4. If you want the heading centered over the cells, click the Center 
button on the Home tab or press Ctrl+E.

To separate cells you merged, select the merged cell and click the Split Cells 
button in the Merge group. When Word asks for the number of columns to 
split the cell into, specify the number that the merged cell spans.

Designating Header Rows That 
Repeat from Page to Page

If you have an unusually long table that spans more than one page, you can 
designate the top row or rows of the table to serve as header rows, which 
repeat automatically at the top of each page. To do so, follow these steps:
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 1. Select the row or rows you want to use for headers (include the top 
row of the table in the selection).

  2. Click the Properties button (on the Table Tools Layout tab) and select 
the Row tab of the Table Properties dialog box.

  See Figure 4-14.

 3. Select the Repeat As Header Row at the Top of Each Page option and 
click OK.

  Word duplicates the selected rows at the top of each page where the 
table appears.

 

Figure 4-14: 
The Row tab 
of the Table 
Properties 
dialog box.

 

Splitting a Table
  Suppose that you create a large table and decide to drop a paragraph of 

normal text in the middle of the table, between two of the rows. In other 
words, you want to divide the table into two smaller tables. To do that, just 
select the row where you want to divide the table and click the Split Table 
button in the Merge group on the Table Tools Layout tab. Word divides the 
table into two and inserts a blank paragraph between the two tables.

 

Though you can’t create two side-by-side tables in Word by splitting a table 
vertically (which is unfortunate), you can simulate two side-by-side tables 
by making an empty table column create empty space between two sepa-
rately bordered areas of the table (see Figure 4-15). Here, what appears to be 
two tables is actually a single table: The space between them is an unused 
column with no borders or shading.
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Figure 4-15: 
Creating the 
appearance 
of two side-
by-side 
tables.

 

Sorting a Table
Some tables contain rows of data that should be presented in sequence. For 
example, you might want to show a table that lists employees in order by 
employee name. Fortunately, the Sort button in Word lets you do just that. 
Here’s the procedure:

 1. Select the rows you want to sort.

  For the best results, select entire rows and leave out any heading rows 
you don’t want sorted. Usually, you want to sort the entire table except 
for headings.

  2. Click the Sort button, found in the Data group on the Table Tools 
Layout tab.

  The Sort dialog box opens, as shown in Figure 4-16.

 

Figure 4-16: 
The Sort 
dialog box.

 

 3. Specify the column you want to use to sort the table and select a sort 
type.

  By default, the Sort dialog box sorts data into ascending sequence based 
on the first selected column. But you can pick a different column to 
sort by or choose to sort in descending sequence and then tell Word 
whether the column contains text, numbers, or dates. You can also sort 
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299Using Table Formulas

as many as three columns. (This setting tells Word which columns to 
use to determine the sort order. Keep in mind that Word keeps rows 
together when it sorts them.)

 4. If your selection includes a header row that you don’t want sorted, 
select the Header Row option.

 5. Click OK.

Using Table Formulas
If you can’t afford a real spreadsheet program, you can use Word tables as 
sort of a poor man’s spreadsheet. Like spreadsheets, Word tables let you 
enter data into rows, columns, and cells. It even lets you perform simple cal-
culations on cells by using formulas similar to spreadsheet formulas.

The most common use for formulas in a Word table is to add up the values 
in a row or column of cells. Here’s the procedure:

 1. Select the cell where you want the total to appear.

  2. Click the Formula button, found in the Data group on the Table Tools 
Layout tab.

  The Formula dialog box is displayed, as shown in Figure 4-17.

 

Figure 4-17: 
The Formula 
dialog box.

 

 3. Double-check the formula proposed by Word.

  Word takes its best guess at the cells you want to add. If you insert a 
formula to the right of a row of numbers, Word assumes that you want 
to add up the numbers to the left. If you place the formula beneath a 
column of numbers, Word assumes that you want to add up the num-
bers in the cells above.

 4. Click OK.

 5. Double-check the result to ensure that the numbers are calculated 
correctly.

  Yes, your computer knows how to add and subtract, but the formula 
might be set up to calculate the total differently from the way you expect.
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Besides adding a range of numbers, Word can perform a whole list of other 
functions. Table 4-5 summarizes the most common ones. In the Formula 
dialog box, you can use the Paste Function drop-down list to select functions 
other than Sum.

Table 4-5 Formulas Most Commonly Used in Tables

Formula Explanation

AVERAGE( ) The average of a list of cells

COUNT( ) The number of items in a list of cells

MAX( ) The largest value in a list of cells

MIN( ) The smallest value in a list of cells

PRODUCT( ) The product of a list of cells (all cell values multiplied together)

SUM( ) The sum of a list of cells

 Just like formulas in a spreadsheet program (such as Excel), Word formu-
las use a reference system to refer to individual table cells. Each column is 
identified by a letter, starting with A for the first column, B for the second 
column, and so on. After the letter comes the row number. Thus, the first 
cell in the first row is A1, the third cell in the fourth row is C4, and so on. 
You can construct these types of cell references in formulas:

 ✦ A single cell reference, such as B3 or F7

 ✦ A range of cells, such as A2:A7 or B3:B13

 ✦ A series of individual cells, such as A3,B4,C5

 ✦ ABOVE or BELOW, referring to all cells in the column above or below the 
current cell

 ✦ LEFT or RIGHT, referring to all cells in the row to the left or right of the 
current cell

You can also construct simple math expressions, such as C3+C5*100. You 
can use any of the standard mathematical operators:

+ Addition

– Subtraction

* Multiplication

/ Division

% Percent
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301Converting Text to a Table (and Vice Versa)

 You can control the format of numbers that appear in formulas by editing 
the Number Format field in the Formula dialog box. The Number Format 
drop-down list includes several predefined formats. If you want, you can 
create your own number formats by using the characters listed in Table 4-6.

Table 4-6 Characters for Building Number Formats

Character What It Does

0 (zero) Displays single digit of result. If the result digit is zero, for 
example, it displays 0. Use this setting to ensure the display 
of a minimum number of digits; for example, 00.00 displays 
the value 1.01 as 01.01.

# Displays single significant digit of result but doesn’t display 
leading zeros.

x Serves as rightmost digit on right side of decimal point to 
round result value at this digit. Use this setting in the right-
most decimal position to display a rounded result.

. (decimal point) Displays a decimal point.

, (digit grouping 
symbol)

Separates a series of three digits; for example, ##,##,0.00.

– (minus sign) Adds minus sign to negative result or adds space if result is 
positive or 0 (zero).

+ (plus sign) Adds plus sign to positive result, minus sign to negative 
result, or space if result is 0 (zero).

%, $, *, and others Displays specified character.

‘text’ Adds text to result and encloses text in single quotation 
marks.

 

You can provide separate number formats for positive, negative, and zero 
values by separating the number formats with semicolons. For example, 
##,##0.00;(##,##0.00) encloses negative numbers in parentheses, and 
##,##0.00;(##,##0.00);n/a displays negative numbers in parentheses and zero 
values as n/a.

Converting Text to a Table (and Vice Versa)
If you have tabular information that you didn’t originally enter as a table, 
you can use the Convert Text to Table command to convert the text to a 
table. Word automatically creates a table for you, making its best guess at 
how many rows and columns the table contains based on the format of the 
data you highlighted. This guess is especially useful if the information was 
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originally created outside of Word (for example, as a simple text file that 
used tabs to align information into columns).

To convert text to a table, first highlight the text you want to convert. Then 
open the Insert tab, click the Table button in the Tables group, and choose 
Convert Text to Table from the menu that appears. The dialog box shown in 
Figure 4-18 is displayed.

 

Figure 4-18: 
Converting 
text to a 
table.

 

The main thing to pay attention to here is the character Word uses to deter-
mine which text goes into each cell: tab, paragraph mark, comma, or any 
arbitrary character you want to use. Word usually deduces the proper char-
acter based on the text you highlight, but double-checking it is worth your 
time. If your table conversion doesn’t work out as you expect, don’t forget to 
press Ctrl+Z to undo your changes.

  You can also convert an existing table to text. Select the table you want to 
convert and then click Convert to Text in the Data group on the Table Tools 
Layout tab. This action summons the Convert Table to Text dialog box, 
shown in Figure 4-19.

 

Figure 4-19: 
Converting 
a table to 
text.

 

Choose whether you want to use a paragraph mark, tab, comma, or another 
character to separate the text for each table cell. Then click OK to convert 
the table to text.
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Chapter 5: Inserting Fancy Text

In This Chapter
✓ Creating text boxes

✓ Using captions

✓ Inserting WordArt

✓ Employing callouts

Bet you thought that text was text and graphics were graphics. Wrong! 
This chapter describes several Word features that let you incorporate 

text into your drawings. For example, you can add captions to pictures. You 
can also add text to most shape objects. And, you can use a special type of 
drawing object, WordArt, to create fancy logos.

Have fun!

Using Text Boxes
A text box is a special type of shape designed to place text on your document 
without regard to the normal margins of the page. The most common use of 
text boxes is to add little bits of text to drawings. However, text boxes are 
also sometimes used to create interesting desktop publishing effects, such as 
pull quotes or sidebars. For example, Figure 5-1 shows a document with a pull 
quote — a floating text box that highlights a quote from the document.

The following sections describe the ins and outs of working with text boxes.

Creating a text box
To create a text box, follow these steps:

 1. Click the Text Box button, located in the Text group on the Insert tab.

 2. Choose Draw Text Box from the menu that appears.

 3. Click where you want one corner of the text box to appear and drag 
to where you want the opposite corner.

  Drawing a text box is similar to drawing a rectangle.

 4. Release the mouse button and then type your text.

  The insertion pointer is automatically positioned in the text box, so you 
can immediately start typing text after you draw the text box.
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Figure 5-1: 
A document 
with a text 
box.

 

 The default wrapping style for a text box is In Front of Text. With this setting, 
the text box obscures any other text in the document that happens to fall 
behind the text box. In most cases you change this setting to a more appro-
priate one, such as Tight or Square. To do that, click inside the text box, dis-
play the Drawing Tools Format tab, and change the Wrap Text setting. (For 
more information about what the different wrapping styles do, see Chapter 2 
of this minibook.)

 

In Chapter 1 of this minibook, I discuss shape objects. Well, shapes can 
also function as text boxes. If you want to add text to a shape, just click the 
shape and start typing. The text appears centered over the shape. (The only 
shapes that don’t accept text are lines. But you probably guessed that.)

 

You can also insert a text box into your document by using one of the 
sample text boxes that appear in the gallery when you click the Text Box 
button in the Insert tab.

Formatting a text box
After your text box is in place, you want to apply some formatting. To start, 
you can format the text in the text box by highlighting the text and using the 
text formatting controls on the Home tab. For more information about for-
matting text, turn to Book II, Chapter 2.

You can format the text box itself by using any of the formatting controls on 
the Drawing Tools Format tab. These controls are the same ones that appear 
on the Format tab for any shape object. For more information, see Chapter 1 
of this minibook.
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305Using Text Boxes

By default, the text in a text box is indented 1⁄10-inch from the left and right 
sides of the text box and 5⁄100-inch from the top and bottom. If you want to 
change this indentation (I often set it to zero), click the WordArt Styles 
dialog box launcher on the Drawing Tools Format tab and click the Text Box 
tab, as shown in Figure 5-2. Then you can set the top, left, right, and bottom 
margins.

 

Figure 5-2: 
The Text 
Box tab of 
the Format 
Text Effects 
dialog box.

 

In addition, you can set these two options:

 ✦ Resize Shape to Fit Text: This option automatically adjusts the size of 
the text box to fit the text you type in it. You usually leave this option 
turned off. You can always adjust the size of the text box manually by 
dragging any of the text box’s corner handles.

 ✦ Wrap Text in Shape: You almost always leave this option turned on. If 
you turn it off and the text box isn’t wide enough, the text may be cut off.

Rotating text
Previous versions of Word did not allow you to rotate the text in a text box, 
but with Word 2010 you can! Just select the text box, grab the green rotation 
handle that appears above the text box, and drag to rotate the box.

Using linked text boxes
If a text box isn’t big enough to display all its text, Word lets you continue 
the text into another text box. For example, you might use text boxes to 
create a sidebar that has text related to the main topic of your document. If 
the sidebar is particularly long, you can continue it in another text box.
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306 Adding Captions to Your Pictures

Just follow these steps to create a set of nicely linked text boxes:

 1. Type the text you want to place in a series of text boxes.

  Linked text boxes work best if you first create the text they contain. You 
can even type the text in a separate document, if you want.

 2. Create two or more text boxes to hold the text.

  Position the text boxes where you want them to appear in your docu-
ment. They don’t have to be on the same page.

 3. Select the text you typed in Step 1 and press Ctrl+C.

  The text is copied to the Clipboard.

 4. Select the first text box and press Ctrl+V.

  The text from the Clipboard is pasted into the first text box. The text 
box displays as much of the text as it can; the rest is hidden.

 5. Click the Create Link button in the Text section of the Drawing Tools 
Format tab.

  The cursor changes to a weird-looking coffee cup.

 6. Click the second text box.

  This action spills the coffee into the second text box. In other words, the 
overflow text from the first text box continues into the second.

 7. If you want to spill text into additional text boxes, repeat Steps 5 and 6.

  You can link as many text boxes together as you want.

 

To break the link between two text boxes, click inside the first text box and 
then click the Break Link button in the Text group on the Drawing Tools 
Format tab.

Adding Captions to Your Pictures
A caption is a bit of text that identifies a figure, table, chart, or other visual 
element you include in a document. Captions usually include a reference 
number (for example, Figure 58 or Table 293). Figure 5-3 shows a picture 
with a caption.

If you want, you can create captions by simply creating a text box to hold 
the caption. (I cover text boxes earlier in this chapter.) But the Word 
Caption feature automatically numbers your captions when you insert them, 
keeps the numbers in order, and lets you create a table of figures, tables, 
charts, or whatever when you’re all done. You paid for this program, so you 
might as well know how to use as much of it as possible.
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307Adding Captions to Your Pictures

 

Figure 5-3: 
A picture 
with a 
caption.

 

To add a caption to a picture, table, chart, or another graphical goodie, 
follow these steps:

 1. If you haven’t done so already, insert the picture you want to apply 
the caption to.

  For more information, see Chapter 2 of this minibook.

 2. Select the picture that you want the caption attached to.

 3. Click the References tab on the Ribbon and then click the Insert 
Caption button in the Captions group.

  You see the Caption dialog box, shown in Figure 5-4.

 

Figure 5-4: 
The Caption 
dialog box.

 

 4. Type the caption.

  Word starts the caption for you by providing the reference number. 
Type whatever text you want to describe the figure, table, chart, or 
whatever.
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 5. Change the Label field if it’s incorrect.

  Word keeps track of caption numbers separately for figures, tables, and 
equations. When you insert a caption, make sure the Label field is set to 
the type of caption you want to create.

 6. Change the Position field if you want to change the positioning.

  The two options are Above or Below the selected item.

 7. Click OK.

  Word inserts the caption.

Here are a few rapid-fire thoughts designed to inspire your use of captions:

 ✦ If you want to create captions for something other than figures, tables, 
and equations, click the New Label button and type a label for whatever 
you want to create captions for; for example, a limerick. Click OK, and 
from then on Limerick appears as one of the Label types.

 

✦ When you create a caption, Word automatically applies the Caption 
style to the caption paragraph. You can control the format of all cap-
tions in a document by modifying the Caption style. (For more informa-
tion about styles, see Book II, Chapter 3.)

 ✦ You can create a table of figures, tables, equations, or limericks by 
using the Insert Table of Figures command on the References tab on the 
Ribbon. (For more detailed information about this feature, see Book VI, 
Chapter 1.)

 

✦ At various and sundry times, caption numbers stray out of sequence. 
Fear not! Word can put the caption numbers back into sequence when 
you print the document. If you’re tired of looking at out-of-sequence 
numbers, press Ctrl+A to select the entire document and then press F9 
to recompute the caption numbers.

 ✦ If you want Word to always create a caption whenever you insert a par-
ticular type of object into your document, click the AutoCaption button 
in the Caption dialog box. A dialog box lists all the various types of 
objects you can insert into a Word document. Select the ones you want 
to automatically create captions for and then click OK.

Creating Fancy Text with WordArt
The nifty little WordArt feature transforms a snippet of ordinary text into 
something that looks like you paid an ad agency an arm and a leg to design. 
Figure 5-5 is an example of what you can do with WordArt in just a couple of 
minutes.
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Figure 5-5: 
You, too, 
can create 
fancy text 
effects like 
this one 
by using 
WordArt.

 

Follow these steps to transform mundane text into something worth 
looking at:

 1. Click the WordArt button in the Text group on the Insert tab.

  This step opens the WordArt gallery, shown in Figure 5-6.

 

Figure 5-6: 
The 
WordArt 
gallery 
offers a 
choice of 
WordArt 
styles.

 

 2. Click the WordArt style that most closely resembles the WordArt you 
want to create.

  The WordArt text box appears in your document along with the Drawing 
Tools Format tab on the Ribbon, as shown in Figure 5-7.

 3. Type in the text box the text you want to use for your WordArt.

 4. Fool around with the WordArt controls and formatting options on the 
Drawing Tools Format tab on the Ribbon.

  When you create a WordArt object, the Ribbon displays the Drawing 
Tools Format tab. Experiment with these controls as much as you want 
until you make the text look just right.
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Figure 5-7: 
The 
WordArt 
text box.

 

 

The Transform command on the Text Effects menu (in the WordArt Styles 
group) is the key to creating fancy logos, such as text that wraps around 
circles. Figure 5-8 shows the menu that appears when you point to this com-
mand. Experiment with these shapes to see how they work. If you want to 
edit the text in WordArt shapes, just click the box and make your correc-
tions. The text straightens out to let you make your changes, and it reverts 
to your chosen shape when you’re finished and click out of the box.

 

Figure 5-8: 
The 
Transform 
gallery.
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Drawing a Callout
A callout is a special type of shape that resembles a text box but has a line or 
series of bubbles connecting it to another object, as shown in Figure 5-9. In 
the figure, the callouts illustrate the rabbit’s thoughts.

 

Figure 5-9: 
The proper 
use of 
callouts.

 

Follow these steps to create callouts to contain your own thoughts:

 1. Select the Insert tab and then click the Shapes button.

  A gallery showing about a million different shapes appears. Within it is 
a group of more than a dozen different callout styles under the Callouts 
heading.

 2. Select the callout type you want to use.

 3. Click where you want the upper-left corner of the callout to appear 
and then drag out the shape of the callout.

  After you release the mouse button, the callout box appears.

 4. Drag the little yellow dot that appears at the end of the connecting 
line (or bubbles, if you choose the thought bubble callout type — 
refer to Figure 5-9) to the spot where you want the callout.

  As you drag the little yellow dot, the shape of the callout changes.

 5. Click in the callout, and then type some callout text.

  Word inserts the text into the callout. Presto! You’re finished.
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Keep these points in mind when you work with callouts:

 ✦ If the text doesn’t fit inside the callout, try dragging the callout by one 
of its handles to increase the size. Or, right-click the callout and choose 
Format Shape from the menu that appears. Then click the Text Box tab 
and reduce the margins for the callout. Smaller margins allow the text to 
creep closer to the inside boundaries of the callout.

 ✦ Think cheerful thoughts, if you can.
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Chapter 6: Other Things You Can 
Insert in Your Documents

In This Chapter
✓ Adding a cover page to your document

✓ Using drop caps

✓ Dealing with symbols

✓ Adding equations for fun and profit

✓ Inserting a screenshot in your document

This chapter covers a variety of items that live on the Insert tab on the 
Ribbon but aren’t covered in other chapters. I tell you how to insert ele-

ments such as cover pages, drop caps, and special symbols into your docu-
ments. Happy inserting!

Inserting a Cover Page
The Cover Page drop-down menu provides a simple way to add a profes-
sionally designed cover page to a Word document. Figure 6-1 shows the 
type of cover page you can create with just a wave of your mouse. All you 
have to do to create a cover page like this one is select the design and type 
the text.

To create a cover page, follow these steps:

 1. Don’t worry about moving to the first page in your document.

  I realize that this step isn’t truly a step because it tells you not to do 
something. But when I first saw the Cover Page feature, I wondered 
whether you had to navigate your way to the beginning of the document 
to insert a cover page. It turns out that you don’t. No matter where the 
insertion point is in the document, the cover page is inserted at the 
beginning of the document, before the document’s first page.

  2. Open the Insert tab on the Ribbon and click the Cover Page button.

   The Cover Page gallery appears, as shown in Figure 6-2.
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Figure 6-1: 
Word 2010 
can easily 
add cover 
pages like 
this one 
to your 
documents.

 

 

Figure 6-2: 
The Cover 
Page 
gallery.

 

 3. Click the cover page style you want to use.

  Word inserts the cover page at the beginning of the document. Initially, 
the cover page includes placeholder text for the document title, subtitle, 
and cover page copy.
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 4. Type the title, subtitle, and cover page copy for the cover page.

  If you don’t want to include a subtitle or additional copy on the cover 
page, you can use the Delete key to delete those elements.

  That’s all! You can now admire your beautiful cover page.

Ponder these additional points as you lie awake tonight, marveling at this 
useful new feature:

 ✦ You can delete a cover page by clicking the Cover Page button and 
choosing the Remove Current Cover Page command.

 ✦ If you modify the design of the cover page, you can add your customized 
page to the Cover Page gallery by clicking the Cover Page button and 
choosing the Save Selection to Cover Page Gallery command. A dialog 
box appears, asking for a name and other descriptive information. Then 
your custom page is added to the gallery.

 ✦ You can insert a cover page somewhere in the middle of your document 
(suppose that you want to start a section). Simply right-click the Cover 
Page in the gallery. This contextual menu reveals several other interest-
ing options.

Inserting a Drop Cap
A drop cap is a specially formatted letter that appears at the beginning of a 
paragraph. Figure 6-3 shows two types of drop caps. Desktop publishing pro-
grams (such as Microsoft Publisher) have been able to create drop caps for 
years. You can also create them easily in Word.

 

Figure 6-3: 
A drop cap.

 

As you can see in the figure, Word offers two drop cap styles. The first, and 
most common, begins the paragraph with a large letter that spills down into 
the text. Thus, the first few lines of the paragraph are displaced by the drop 
cap. The second style places the large first letter in the margin adjacent to 
the paragraph.
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316 Inserting a Drop Cap

To create a drop cap, follow these steps:

 1. Type the paragraph as you normally would, without worrying about 
any special formatting for the first letter.

  When you use the Drop Cap command, the special formatting for the 
first letter is taken care of.

  2. Open the Insert tab on the Ribbon and click the Drop Cap drop-down 
menu (shown in the margin).

  A menu that lists the two drop cap styles appears.

 3. Choose the drop cap style you want to use.

  The first letter of the paragraph is converted to an object that’s properly 
positioned for the drop cap.

 4. Adjust the drop cap, if you want to.

  Because the drop cap consists simply of text placed inside a text box, 
you can use any Word formatting feature to format the drop cap to your 
liking. Change its size, switch colors, or add a shadow, if you want.

  You’re done!

If you want to remove the drop cap, click the Drop Cap button on the Insert 
tab and choose None.

For greater control over the drop cap, click the Drop Cap drop-down menu 
and choose Drop Cap Options. The Drop Cap dialog box, shown in Figure 6-4, 
opens and lets you set several additional drop cap options. In particular, you 
can specify the number of lines to drop the first letter and the distance to dis-
place the drop cap from the rest of the text.

 

Figure 6-4: 
The Drop 
Cap dialog 
box.
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317Inserting a Symbol

Inserting a Symbol
  The Insert tab’s Symbol drop-down menu (shown in the margin) lets you 

insert a special symbol into your document. The most commonly used sym-
bols appear in a Symbol gallery that’s displayed when you click this button. 
To insert one of these symbols, simply click the symbol you want to insert.

If the symbol you want to insert isn’t in the gallery, choose the More 
Symbols command to open the Symbol dialog box, shown in Figure 6-5. 
You can insert a symbol from this dialog box by double-clicking the symbol 
or selecting the symbol and clicking Insert. Then click Close to close the 
Symbol dialog box.

 

Figure 6-5: 
The Symbol 
dialog box.

 

 

You can also insert certain symbols by using the predefined keyboard short-
cuts shown in Table 6-1.

Table 6-1 Keyboard Shortcuts for Special Symbols

Symbol Name Shortcut

© Copyright Ctrl+Alt+C

— Em dash Ctrl+Alt+- (minus sign on numeric keypad)

– En dash Ctrl+- (minus sign on numeric keypad)

... Ellipsis Ctrl+Alt+. (period)

® Registered mark Ctrl+Alt+R

™ Trademark Ctrl+Alt+T
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The following concepts can help you in your quest for special characters:

 ✦ You can add a keyboard shortcut to any special character by summon-
ing the Symbol dialog box (refer to Figure 6-5). Then click the Symbols 
tab or the Special Characters tab in the dialog box and click the Shortcut 
Key button.

 

✦ An em dash is a dash the width of the letter M. An en dash is as wide as the 
letter N. If you’re using a dash as a punctuation mark — like this — use an 
em dash rather than two hyphens. The old double-hyphen treatment is 
a carryover from the days of manual typewriters. (The AutoCorrect fea-
ture can insert these characters for you. Just type a pair of hyphens and 
AutoCorrect automatically converts them to an em dash.)

 ✦ The minus sign required for the em dash and en dash shortcuts is the 
minus sign on the numeric keypad, way off to the far right side of the 
keyboard. (This key would probably be Rush Limbaugh’s favorite key if 
he used a PC, but he’s a Mac fanatic.) The shortcut doesn’t work if you 
use the hyphen that’s between the zero (0) and the equal sign (=) at the 
top of the keyboard.

 ✦ Notice also that the Special Characters tab lets you select the most com-
monly used special symbols from a list.

Inserting an Equation
Steven Hawking wrote in the preface to his book A Brief History of Time that 
his editor warned him that every mathematical equation he included in the 
book would cut the book’s sales in half. So he included just one: the classic 
e=mc2. See how easily you can type that equation? The only trick is remem-
bering how to format the little superscript 2.

My editor promised me that every equation I included in this book would 
double its sales, but I didn’t believe her; not even for a nanosecond. But just 
in case, Figure 6-6 shows some examples of the equations you can create by 
using Word’s handy-dandy Equation feature. You wouldn’t even consider 
trying to create these equations by using ordinary text, but they took me 
only a few seconds to create by using Equation Editor. Aren’t they cool? Tell 
all your friends about the cool equations in this book so that they’ll all rush 
out and buy copies for themselves. Or, better, read this section to find out 
how to create your own knock-’em-dead equations, and then try to convince 
your friends that you understand what they mean.

  To add an equation to a document, open the Insert tab on the Ribbon and 
click the arrow on the Equation button (shown in the margin). This action dis-
plays the Equation gallery, shown in Figure 6-7. Pick the equation you want to 
use from this gallery and Word inserts the equation into the document.
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Figure 6-6: 
Eight 
equations 
that likely 
won’t affect 
sales of this 
book either 
way.

 

 

Figure 6-7: 
The 
Equation 
gallery.

 

The Equation gallery offers several popular types of equations, but odds are 
good that the equation you need for your document isn’t in the gallery. In 
that case, select an equation that’s close to what you want and then modify 
it as needed. Or, if you prefer, choose Insert New Equation to start an equa-
tion from scratch.
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When you select an equation, a special Equation Tools Design tab appears 
on the Ribbon with tools that let you edit the equation. I leave it to you to 
experiment with the controls on this tab.

Note that the AutoCorrect feature also includes shortcuts for creating equa-
tions. Choose File➪Options. Then select the Proofing tab and click the 
AutoCorrect Options button. Then click the Math AutoCorrect tab. This 
action displays a list of the equation shortcuts you can use. For example, 
you can type \alpha to insert a Greek letter alpha (α).

Inserting a Screenshot
A screenshot is a picture that represents the contents of your computer 
display — either the entire display or just a single dialog box. Screenshots 
are especially useful when you’re preparing instructions for using computer 
software. In fact, most of the figures in this and other For Dummies books are 
screenshots.

Word 2010 includes an Insert Screenshot feature that makes it easy to insert 
a screenshot into your document. To use this feature, first open the program 
you want to illustrate in your screen shot. Then switch over to Word, click 
the Insert tab, and then click the Insert Screenshot button (found in the 
Illustrations group). Word displays a gallery that includes every window that 
is currently open on your computer, as shown in Figure 6-8. Click the one 
you want, and Word inserts it as a picture in your document.

 

Figure 6-8: 
Inserting a 
screenshot.
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If you want to insert a part of your Windows screen that doesn’t appear in 
the gallery, choose the Screen Clipping option that appears at the bottom of 
the gallery. When you choose this option, your entire Windows display fades 
to a light color, and the mouse pointer changes to a selection tool. Click and 
drag the mouse pointer to select the part of the Windows display that you 
want to insert into your document. When you release the mouse, the screen 
area you selected is inserted as a picture.
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Chapter 1: Blogging with Word

In This Chapter
✓ Linking your existing blog with Word 2010

✓ Writing, editing, and publishing blog entries

Having a Web log, or blog, is the latest thing. You know that this thing 
has become mainstream when the Washington Post starts referencing 

blogs as critical sources. You know that this thing is here to stay when the 
most popular word-processing software in the world adds the capability to 
publish a Word document as a blog entry.

A blog is a diary of sorts that is published online and characterized by ease 
of editing, the ability of readers to add comments about entries, and syndi-
cation of some kind. Jorn Barger coined the term Web log in 1997, though 
people were making daily updates to their sites before then.

The world of blogging uses three types of software:

 ✦ Authoring: Used to create the blog entry

 ✦ Hosting: Organizes the blogs, syndicates them, and provides for 
comments

 ✦ Reader: Consumes the syndication

In this chapter, I’m concerned only about the creation of blogs (hence the 
chapter title), but in order for that process to be of any use to you, you need 
a general understanding of blogging. Therefore, I throw tips and sugges-
tions your way as I go. In the meantime, I recommend that you reference the 
Wikipedia entry on blog (http://en.wikipedia.org/wiki/Blog). I also 
suggest that you check out Blogging For Dummies, by Susannah Gardner and 
Shane Birley.

Introducing Word’s Blogging Features
What Word provides is the ability to create a blog entry by using the word 
processor. Then you can move the entry seamlessly to your blog without 
having to copy and paste into a form or directly upload a document or even 
open your Web browser.
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326 Introducing Word’s Blogging Features

I don’t get into a big discussion of what a blog is here, but — for the record — 
Figure 1-1 shows what a typical blog looks like on the Web. It’s just a Web page 
with diary entries.

 

Figure 1-1: 
A blog entry.

 

Word lets you avoid what is usually a Web-based entry screen for your blog 
so that you can use the familiar Word interface instead. The blogging feature 
is, in a sense, all of Word.

Word provides all this capability in the Publish As Blog Post command, 
under the Share section of the File tab (see Figure 1-2). This command starts 
a process that moves your blog entry to your blog. As part of that process, 
the command transfers your document to HTML, uses the blog’s Upload API 
(application programming interface) to move the document, and sets up the 
document for display.

To use the Word blogging features, you need a couple of items:

 ✦ Content: Content should be easy enough to come up with. If you have 
something to say, it’s worth blogging about. I don’t know you (though if 
we happen to meet, I hope you’ll introduce yourself), but I’m certain that 
what you have to say is better than most of what is out there.

 ✦ A blog host: Word is set up to use Blogger.com, SharePoint, the Telligent 
Community Server, Windows Live Spaces, WordPress, and several other 
blog hosts.

Of course, the best way to get the gist of working with Word’s blogging 
features is to blog with Word. The following section shows you how to put 
together a blog entry.
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327Creating and Editing Blog Posts

 

Figure 1-2: 
The Publish 
As Blog 
Post 
command.

 

Creating and Editing Blog Posts
Creating a blog post is remarkably easy: Just make a document. In fact, I 
have been using this chapter’s Word file as my test case for the blogging 
tools, and I’m surprised at how well Word handles creating blog posts.

Working from a blank entry
Word seems to give you a couple of creation options: You can start with an 
existing document or an empty one. The New command provides an option 
to create the new blog entry:

 1. Choose File➪New.

  The New page is displayed in Backstage view.

 2. Select Blog Post from the New page and click Create.

  As shown in Figure 1-3, you have the option to create a new blog entry 
from a template.

Word creates an empty blog post for you, as shown in Figure 1-4.
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Figure 1-3: 
Selecting a 
blank blog 
entry.

 

 

Figure 1-4: 
The default 
blogging 
template.

 

 

If this is your first time creating a blog post, a dialog box appears, asking 
whether you want to register a blog account. For more information, see the 
later section “Registering a Blog Account.”

You can start here and work from a blank document, if you like. You might 
notice that the blog entry template adds a neat Blog Post tab on the Ribbon 
with publishing-specific features and editing tools that every blogger needs 
in these groups:
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329Creating and Editing Blog Posts

 ✦ Blog

 ✦ Clipboard

 ✦ Basic Text

 ✦ Styles

 ✦ Proofing

The Insert tab is also specific to blogging, but I describe that tab later, in the 
section “Inserting Hyperlinks and Stuff.” For now, I stick with formatting.

If you’re starting with a blank entry, format it as you would any other Word 
document. Tabs, lines, color, whatever — it all works. You must understand 
some of the constraints of Web development, but the Styles gallery on the 
Blog Post tab helps out. (See Book II, Chapter 3 for the lowdown on styles.) 
Just stick with the tasks that Word allows and you’ll be fine — no special 
knowledge necessary.

To see an example, just create a sample chunk of text with a few headings 
and use the mouse to scroll through the styles provided as part of the blog 
entry template. As shown in Figure 1-5, you have just a few simple choices 
for formatting text.

 

Figure 1-5: 
Styles 
available for 
blogs.

 

 Word offers many fewer options for blogs than it does for Office documents. 
That’s because, frankly, you just can’t do as much with a blog entry because 
it’s eventually being posted on the Web.

Don’t forget to fill out the Post Title field, shown in Figure 1-6. You’re filling 
out a form here, with two fields. You put the title in the Post Title field and 
everything else is considered the entry.
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Figure 1-6: 
The Post 
Title field.  

Editing blog entries
You edit a blog post in about the same way as you edit any other document. 
You have the usual access to the spelling dictionary, Research task pane, 
thesaurus, and Language settings. You can’t find those on the average Web-
based blog-editing screen.

However, after you publish a blog entry (which you find out about later, in 
“Publishing Blog Posts”), your fate is sealed. If you want to edit the docu-
ment, you have to do it by using the built-in tools of the blogging engine.

Why? Because the post mechanism moves the content of your post from 
the Word document into a database on the host side of the process. After 
you publish, the data is disconnected from the Word document and your 
changes are discarded.

Compare this process to e-mailing a copy of a letter: If you create a docu-
ment and e-mail it, and then you make changes to the original document 
a month later, the person you mailed the original message to a month ago 
doesn’t see the changes. You have to e-mail a new document or ask the 
recipient to let you see the original so that you can make changes. The same 
concept applies to editing a blog entry.

Registering a Blog Account
You must have an existing blog account in order to use Word to publish to 
your blog. Word helps you register your account so that you can publish, 
but registering the blog is up to you.

 The instructions I present assume that you’re registering your blog with 
Windows Live Spaces. The exact procedures for other blog hosts may be 
slightly different. For that matter, Windows Live Spaces may also change its 
registration procedures by the time you read this section. So pay close atten-
tion to the instructions on the Web site as you register your blog account.

To use Windows Live Spaces, you must first set up a free Windows Live 
account. Setting up the account is easy: Just open your Web browser and go 
to http://spaces.live.com, as shown in Figure 1-7. Then click the Sign 
Up button to create your account.
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Figure 1-7: 
Going to 
Windows 
Live.

 

After you sign up for Windows Live, click the Create Your Space link to set 
up your space, as shown in Figure 1-8. This page lets you customize the 
appearance and content of your Windows Live Space.

 

Figure 1-8: 
Setting 
up your 
Windows 
Live Space.

 

On this page, you can click Options (near the upper-right corner) and choose 
E-Mail Publishing to configure your space for e-mail publishing, which is 
required in order to create and edit blog posts from Word. Figure 1-9 shows 
the page that’s displayed when you choose Email Publishing from the Options 
menu.
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Figure 1-9: 
Setting 
up e-mail 
publishing.

 

To configure e-mail publishing, just follow the steps on the E-Mail Publishing 
page. You’re asked to enter your e-mail address and to create a secret word. 
Then click Save.

Next, you should create a Web address for your space. To do that, click 
Choose Web Address on the Welcome to Your Space page. A page opens 
that lets you enter a word to be used as a name for your space. When you 
find a name you like that hasn’t already been used by another Windows Live 
user, click Save.

With all these steps behind you, you can now register your Windows Live 
space with Word. Create a new document using the Blog Post template. 
Then follow these steps:

 1. Click the Manage Accounts button in the Blog group on the Blog 
Post tab.

  The Blog Accounts dialog box appears.

 2. Click New to open the New Blog Account dialog box.

 3. Select Windows Live Spaces.

 4. Click Next.

  The New Windows Live Spaces Account dialog box appears.
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333Registering a Blog Account

 5. Type the name of your space — the one you used in the Choose Web 
Address page — in the Space Name dialog box.

  The name of your space is the word in front of the first dot in the URL 
of your space. So, if your Spaces URL is http://thebestblogever.
spaces.live.com/, its name is thebestblogever.

 6. Type the secret word you set up in the Secret Word field.

  The finished form looks a lot like the one shown in Figure 1-10.

 7. Click OK.

 

Figure 1-10: 
Setting up 
a new blog 
account.

 

 You’re also asked whether you want to upload pictures. You can skip this 
step for now. You can always upload pictures later.

If you did everything right, Word lets you know. If you messed up, you see 
a message box stating that Word cannot register your account. (Click the 
More Information button for details.) Figure 1-11 shows the Blog Accounts 
dialog box with an account properly set up.

 

Figure 1-11: 
The Blog 
Accounts 
dialog box.
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Publishing Blog Posts
  After you have some edited content and a blog account, you’re ready to pub-

lish a blog post. You can publish your blog entry by clicking the Publish 
button on the Blog Post tab on the Ribbon, as shown in the margin.

If your blog host allows you to post to a draft, you can click the little arrow 
at the bottom of the Publish button and select Publish As Draft.

 If you highlight some text and click the Publish button, only the highlighted 
text is made into the blog entry.

After you click Publish, a message appears on the document, informing you 
of the success or failure of the post.

Magic? I don’t think so. I’m sure it just sent an e-mail from the Word applica-
tion (which you know it can do) to the Spaces site, and an existing protocol 
handles that process. It seems like it just magically happens, though, 
doesn’t it?

Inserting Hyperlinks and Stuff
Blogs get their own, cool Insert tab on the Ribbon. At last count, you have 
the option to add these blog-ready items:

 ✦ Clip art

 ✦ Charts

 ✦ Hyperlinks

 ✦ Pictures

 ✦ Screen shots

 ✦ Shapes

 ✦ SmartArt

 ✦ Symbols

 ✦ Tables

 ✦ WordArt

None of this is new — you can find helpful instructions for using all these 
useful features elsewhere in this book.

 

Hyperlinks are especially useful when dealing with blog entries because of 
the general interlinking nature of blogs and Web pages.

29_487662-bk05ch01.indd   33429_487662-bk05ch01.indd   334 4/15/10   9:13 PM4/15/10   9:13 PM



Book V

Chapter 1

B
lo

g
g

in
g

 w
ith

 W
o

rd

335Inserting Hyperlinks and Stuff

The Insert Hyperlink dialog box looks the same as when it’s used in a regu-
lar Word document, but it brings special significance to a blog entry. The 
Browse the Web button (the little magnifying glass with a globe in it) allows 
you to open a Web browser and begin visiting sites. The URL of whichever 
page you visit appears in the Hyperlink field.

To use the Hyperlink function, follow these steps:

 1. On the page, type some text that you want to appear as a link.

 2. Select the text with your mouse.

 3. Click the Hyperlink button in the Links group on the Insert tab.

  The Insert Hyperlink dialog box appears.

 4. Click the Browse the Web button.

  Your default browser opens.

 5. Browse to the site that you want the text to link to in the browser.

 6. Press Alt+Tab to return to Word.

 7. Click the OK button in the Insert Hyperlink dialog box.

When you publish the page, the hyperlink appears on the blog entry, with 
whatever style is set in the blog for hyperlinks (such as in blue underlined 
text).
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Chapter 2: Working 
with SharePoint

In This Chapter
✓ Opening and editing SharePoint documents

✓ Integrating Word and SharePoint

Put down this book and walk over to your refrigerator. If your fridge 
is anything like mine, stuck to it are a calendar, a few pictures, and 

several “essential” papers dotted with what might be spaghetti sauce. The 
items on your fridge might be different from the ones on mine, but cer-
tainly yours are important to you and your family. Microsoft Word uses 
SharePoint the same way you use your fridge: It sticks important stuff on it 
so that anyone who needs it can easily access it.

SharePoint is the Microsoft platform that enables members of a team to 
share projects, track the history of all changes made to projects, schedule 
meetings, and work together in other ways. SharePoint is essentially a Web 
application that runs on Windows Server (a version of Windows for large 
organizations), providing a number of services to Internet Explorer and 
Office users. Although SharePoint is designed for the workplace, any collec-
tion of users on a network who are sharing documents can benefit from it, 
even users who don’t have Office installed. SharePoint is highly customiz-
able, so it’s likely to function any way you want.

 This chapter serves as a brief introduction to the Microsoft collaboration 
platform. For more SharePoint-related information, I recommend Microsoft 
SharePoint 2010 For Dummies by Vanessa L. Williams. This well-thought-out 
and highly readable book covers a somewhat sophisticated topic. Give it a try.

Understanding How SharePoint 
Documents Are Organized

Out of the box, SharePoint offers many benefits to groups. Its features are 
compartmentalized into WebParts, which are separate groups of functions, 
available in several flavors:

 ✦ Communications: All communications functions, such as announce-
ments, contacts, and discussions
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 ✦ Custom Pages: All SharePoint spreadsheets, data grids, Web pages, and 
workspaces

 ✦ Libraries: All documents, forms, wikis, and pictures

 ✦ Tracking: Tools that help you track projects and activities — links, 
calendars, tasks, issues, and surveys

Integrating SharePoint with Office isn’t a trivial activity. This chapter helps 
you integrate your documents with SharePoint, but getting SharePoint to run 
is the responsibility of your network administrator.

Working with SharePoint Document Libraries
SharePoint lets you organize files into libraries, which are roughly equiva-
lent to folders on your own computer. After you have logged in to your 
SharePoint site, you can view the available document libraries by clicking 
Documents on the site’s home page. SharePoint shows a list of the available 
document libraries, as shown in Figure 2-1.

 

Figure 2-1: 
SharePoint 
document 
libraries.

 

From this page, you can easily create a new SharePoint library by clicking 
Create.
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339Saving a Document to SharePoint

You can click any of the document libraries to display the library’s contents. 
For example, Figure 2-2 shows that the Shared Documents library contains 
two Word documents.

 

Figure 2-2: 
A library 
with two 
documents.

 

Saving a Document to SharePoint
You can save a document to SharePoint directly from Word by following 
these steps:

 1. Choose File➪Save & Send➪Save to SharePoint.

  The Save to SharePoint settings are displayed, as shown in Figure 2-3.

 2. Click the Browse for a Location button under the SharePoint Locations 
heading.

  The Save As dialog box appears.

 3. Type the URL for your SharePoint site in the location field at the top 
of the Save As dialog box.

  The Save As dialog box displays the SharePoint site, as shown in 
Figure 2-4.

 4. Click the library you want to save the document to.

 5. Click Save.

  The document is saved to the SharePoint site.
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Figure 2-3: 
The Save to 
SharePoint 
settings.

 

 

Figure 2-4: 
The Save 
As dialog 
box for a 
SharePoint 
site.
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Uploading a Document to SharePoint
You can upload an existing Word document (or any other type of file, for 
that matter) to SharePoint by following these steps:

 1. In Internet Explorer, browse to your SharePoint site.

 2. Open the document library you want to upload the file to.

 3. Click Add New Document.

  The Upload Document dialog box appears, as shown in Figure 2-5.

 

Figure 2-5: 
Uploading 
a new 
document.

 

 4. Click the Browse button.

 5. In the dialog box that appears, select the file you want to upload and 
then click Open.

 6. Click OK.

  The file is uploaded to the SharePoint site. Note that this may take a 
while, depending on the size of the file and the speed of your connection 
to the SharePoint site.

Opening a Document from SharePoint
The best way to open a document stored on a SharePoint server is to open 
the file directly from SharePoint. Here are the steps:

 1. Open Internet Explorer.

 2. Go to the SharePoint home page.

 3. Click Documents on the Home page to display the list of document 
libraries.

 4. Click the library that contains the document you want to open.
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 5. Hover the mouse over the document you want to open to display the 
down-arrow button, and then click this button to reveal a pull-down 
menu, as shown in Figure 2-6.

 

Figure 2-6: 
The 
document 
pull-down 
menu.

 

 6. Choose the Edit in Microsoft Office Word option.

  The file is opened in Word.

 7. Edit the document as usual.

 8. Save the document as usual.

  When you save the document, it’s saved back to SharePoint.
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Chapter 3: Collaborating 
with the Review Tab

In This Chapter
✓ Commenting on text

✓ Tracking editorial changes

✓ Comparing documents

✓ Protecting documents

In writing documents, one of the most significant tasks an author has to 
perform is to complete the Rite of Review, where people who are gener-

ally uninformed about the content of the document change it at will. The 
Review tab is all about making that process as painless as possible.

The importance of review is accentuated by its having a whole tab all to 
itself. Buttons for proofing, comment creation and management, change 
tracking, comparison, and protection all live on the Review tab. The goal 
is to make easier for everyone involved the process of passing a document 
through a workflow.

Reviewing isn’t new. Word 2003 was riddled with toolbars and commands 
for reviewing. In Word 2010, all reviewing features are combined on a single 
Review tab to make them easier to use.

In this chapter, I describe how to manage comments from collaborators, 
track changes that other people make to your documents, compare two or 
more documents, and protect documents from accidental changes.

Reviewing Documents
The document review process is one that most organizations don’t per-
form well. Word has a lot of tools that help documents progress through 
any review process, but in order for them to be effective, you must imple-
ment them as part of the process. For instance, a chain of editing for the 
company newsletter will be much more effective if its editors use the 
Word reviewing tools.
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For editing, you can use these two effective tools:

 ✦ Comments: Commentary inserted in a document by reviewers without 
changing its content (which is less intrusive than using track-changes). 
Think of comments as little notes that editors place in documents. Using 
this tool is as easy as highlighting a word or sentence or any other 
object in a document and clicking the New Comment button on the 
Ribbon. Comments are tracked by user (using initials entered during the 
setup process) and easily managed by the author.

 ✦ Track-changes: Keeps a record of all changes made to a document, 
allowing you to view the document with all changes highlighted. It’s 
somewhat like taking a red pencil to a printed copy of the document: 
You can still see the original text, and any changes are highlighted. You 
can also accept or reject each change, and you can even use built-in 
tools to view and compare various versions of the document.

Usually comments and track-changes are used in tandem. Comments are 
used to suggest changes in tone or content, whereas track-changes are used 
for editorial changes or directly altering text. I recommend using both at the 
same time.

Working with Comments
Comments are little notes that reviewers can add to your document without 
disturbing its content. A reviewer can highlight a letter, a word, or a phrase — 
even an image or an object — and add a box with his initials, a color specific 
to his comments, and some text, as shown in Figure 3-1.

Comments are clear to read but aren’t damaging to the document. They 
print, and you can save them in a document. Comments don’t upset your 
formatting, and they go all the way back to Word 97, so even if everyone isn’t 
using the same version of Word, they’re still useful.

The key to reviewing tools is agreement — 
not on the content of the document per se 
but, rather, on the use of tools. Organizations 
can effectively route documents by using 
SharePoint (described in Book V, Chapter 2) 

and then manage changes by using comments 
and track-changes, as long as people agree on 
using the tools. To get a good start, read this 
chapter and have your reviewers do the same.

Reviewing the agreement
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Figure 3-1: 
A comment.

 

Creating a comment
To create a comment, follow these steps:

 1. Highlight a letter, a word, a phrase, an image, or an object.

 2. Click the New Comment button in the Comments group on the Review 
tab, as shown in Figure 3-2.

 3. Type the comment in the comment box that appears to the right.

 4. Click elsewhere in the document or continue reading.

 

Figure 3-2: 
The New 
Comment 
button.  

To edit a comment, you can just click inside the comment box and start 
typing. Comments can’t be added to the comment text — though if you click 
inside the comment text and add a new comment, it’s added with the same 
text selected as the original comment. It’s an effective way to make a com-
ment about a comment.

Note that not only are the initials of the reviewer added but the comments 
are automatically numbered as well. The numbering is helpful for tracking 
comments, but it’s also rather depressing when you scroll to the bottom of 
the document and notice that a reviewer inserted 134 comments. (I hope 
you have some caffeine handy.)

 

If you hover the mouse over a comment, the reviewer’s full name (not just 
initials) and the date and time the comment was created are displayed.
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Deleting a comment
Deleting a comment is a simple, rather fun procedure. After you handle a 
comment, simply right-click it and choose Delete Comment from the menu, 
as shown in Figure 3-3.

 

Figure 3-3: 
Deleting a 
comment.

 

For the record, when you click a comment to select it, the color becomes 
darker so that you can see the characters you’re deleting.

Additionally, you can use the Delete button on the Review tab on the Ribbon, 
shown in Figure 3-4. A drop-down menu is available if you click the little 
black triangle under the Delete button, which allows you to delete all view-
able comments or delete all comments.

 

Figure 3-4: 
Using the 
Ribbon 
to delete 
comments.
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Viewing comments
At first blush, viewing a comment seems straightforward. However, even a 
feature as simple as this one has a few options.

Comments appear to the right of their associated text. If you can’t see com-
ments, the view mode might be set improperly for viewing.

In the Tracking group on the Review tab on the Ribbon, you can use a drop-
down list to set the view mode (see Figure 3-5). By default, it’s set to Final: 
Show Markup, which allows you to see tracked changes. More importantly, 
this mode shows comments. If the document is set to Final, comments don’t 
appear.

 

Figure 3-5: 
Pay 
attention 
to the view 
mode.  

There’s a lot more to viewing comments, however. For instance, you can 
move from one comment to another by clicking the Previous and Next but-
tons in the Comments group on the Ribbon — as long as comments aren’t 
hidden by the current view mode (refer to Figure 3-5).

Word has four view modes:

 ✦ Final: Show Markup: This is the working mode for reviewing. If your 
document is in Print Layout view, insertions appear inline and deletions 
are shown in balloons.

 ✦ Final: This view mode shows the document as it will look if you accept 
all changes.

 ✦ Original: Show Markup: If your document is in Print view, deletions 
appear inline and insertions show up in balloons.

 ✦ Original: This mode shows the unchanged document as it will be if you 
reject all changes.

Why use these different modes? Because you can then use the Delete button 
on the Ribbon or the Delete key on your keyboard to delete the comment. 
Also, clicking the Ribbon buttons moves the insertion point through the 
whole document from comment to comment so that you can see the context.
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If Word is in Draft view, comments appear differently and the Previous and 
Next buttons become more important. Comments appear not as notes in 
Draft view but, rather, as the reviewer’s initials in the document, and you 
have to mouse over them to see comments, as shown in Figure 3-6.

 

Figure 3-6: 
Viewing a 
comment in 
Draft view.

 

You can also display commands and document changes in the Reviewing 
pane. To open it, click the Reviewing Pane button on the Review tab. This 
command displays the Review pane, allowing you as the author to easily 
change the content of the comments, as shown in Figure 3-7.

 

Figure 3-7: 
The 
Reviewing 
pane.
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Tracking Changes
More intrusive than comments, track-changes can sometimes be more effec-
tive. This feature allows an editor (or several editors) to alter a document 
while maintaining the integrity of the original.

If Word is in Print Layout view, shown in Figure 3-8, the look of deleted 
text includes a change of color and added strike-through, and added text 
includes a change of color and underlining. You can switch to Print Layout 
view by clicking the Print Layout button on the View tab on the Ribbon.

 

Figure 3-8: 
Tracked 
changes in 
Print view.

 

The text looks much the same if Word is in Draft view (see Figure 3-9). Each 
editor’s changes have a different color.

 

Figure 3-9: 
Tracking 
changes in 
Draft view.

 

Notice that when you hover the mouse over the change, you see a box with 
the editor’s name, the date and time of the edit, and the edit itself.

All the view options are, well, optional. I go over how to make changes in the 
“Viewing changes” section, later in this chapter.

 All the track-changes functions you will ever need can be found in the 
Tracking group on the Review tab of the Ribbon.

Turning track changes on and off
Track-changes is like a light switch — it’s on or off for the entire document. 
You can use the Track Changes button, shown in Figure 3-10, in the Tracking 
group on the Ribbon to toggle the status of track-changes.
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Figure 3-10: 
The Track 
Changes 
button.  

You can also press Ctrl+Shift+E to toggle track changes on and off, as it says 
in the ScreenTip when you point to the Track Changes button. I think I’ll just 
stick with clicking the button.

Viewing changes
You have a lot of options for viewing changes. The default options, which I 
describe in the previous section, are fine for most uses, but sometimes you 
need to have a touch more control.

If you click the drop-down button (the little black triangle) under the Track 
Changes button, you see three options:

 ✦ Track Changes turns change tracking on and off.

 ✦ Change Tracking Options opens the Track Changes Options dialog box, 
shown in Figure 3-11.

 ✦ Change User Name opens the Word Options dialog box for you to 
change your username.

Most options in the Track Changes Options dialog box are self-explanatory. 
You have the opportunity to have shocking control over the exact color, 
placement, and positioning of just about every part of the track-changes 
feature.

More useful is the Show Markup➪Balloons command in the Tracking group 
on the Ribbon. This command brings up a list that allows you to toggle the 
viewing of changes between inline view or balloons without changing the 
document view mode.

Additionally, you can view only comments and formatting changes in the bal-
loons. That way, the edits show as edits within the document, like an editor 
would do to a paper document. Comments show as notes on the side of the 
document, which doesn’t interfere with readability.
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351Tracking Changes

 

Figure 3-11: 
View 
options for 
tracking 
changes.

 

Accepting or rejecting changes
Tracking changes isn’t enough for the people at Microsoft — they even give 
you the ability to do something about the changes! Accepting or rejecting 
changes is part of the last step of reviewing: rewrite. After you as the author 
have received your marked-up document, you can accept or reject changes 
made by others or yourself.

To accept or reject a change, right-click the change (as either a balloon or an 
inline change) and you’ll see the Accept Change and Reject Change options 
on the contextual menu, as shown in Figure 3-12.

 

Figure 3-12: 
The 
Tracking 
contextual 
menu.
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Now you can accept or reject the change. Accepting the change allows what-
ever changes the editor made to stand, permanently altering the document. 
Rejecting a change removes it from the document completely.

 Comments can’t be accepted or rejected. They can only be deleted.

Another slick way to handle changes is by using the Changes group on the 
Review tab of the Ribbon, shown in Figure 3-13. In that group, you can click 
the Next and Previous buttons to move between changes in your document. 
When the change is highlighted, you then click the Accept button or the 
Reject button, as appropriate. Word then automatically moves to the next 
change in the document and you repeat the process until you’re done.

You can also accept (or reject) all changes in a document by clicking the 
drop-down list below the buttons. This technique is useful for showing your 
favorite editors what you really think of them!

 

Figure 3-13: 
The 
Changes 
group.  

Comparing Documents
Compare Documents is a rarely used and truly cool feature that can help in 
those situations when reviewing wasn’t used and now you have two copies 
of the document. Simply put, you can pick two documents and this feature 
marks all the differences for you. The dialog box that holds all the options is 
shown in Figure 3-14.

 

Figure 3-14: 
The 
Compare 
Documents 
dialog box.
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Say for the sake of argument that you have two different documents and you 
need to see their differences. Here’s what you do with them:

 1. Click the Compare button on the Review tab on the Ribbon and 
choose Compare from the drop-down list.

  The Compare Documents dialog box appears (refer to Figure 3-14).

 2. Use the Browse button (it looks like a little folder with an arrow on 
top of it) to select the original document in the Original Document 
field.

 3. Use the Browse button next to the Revised Document drop-down list 
to find the document that was edited.

 4. Pick the options you want to compare.

  You might have to click the More button to see this part of the 
dialog box.

 5. Click OK.

 

When you click the Compare button on the Review tab, the drop-down menu 
that appears also has a Combine command. This command is similar to the 
Compare feature, but rather than just compare two versions, it merges edits 
from both versions into a single document.

Protecting a Document
Throughout this chapter, I assume that you, the author, are accepting edits 
made by someone else, the editor. In reality, anyone can change a docu-
ment, turn track changes on and off, delete comments, or accept and reject 
changes — unless you have document protection enabled.

Document protection is a suite of tools you use to prevent the document from 
being used in unauthorized ways. For the purposes of reviewing, it ensures 
that you have the right to author, and someone else has the right to edit, 
and that’s it.

To protect a document so that it cannot be edited, click the Restrict Editing 
button in the Protect group on the Review tab. This action displays the 
Restrict Formatting and Editing tab, as shown in Figure 3-15. On this page 
you can set the following options:

 ✦ You can set the styles to a limited set by selecting the Limit Formatting 
to a Selection of Styles check box.

 ✦ You can allow only certain kinds of changes by a certain set of users by 
selecting the corresponding check box.

 ✦ You can enforce those restrictions with either your Windows Login or a 
document password after you click Yes, Start Enforcing Protection.
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Figure 3-15: 
Protecting a 
document.
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Chapter 1: Creating a Table of 
Contents or Table of Figures

In This Chapter
✓ Understanding tables of contents

✓ Creating a table of contents

✓ Using other styles to create a table of contents

✓ Creating a table of figures or other similar tables

✓ Updating a table of contents or table of figures

In the old days, creating a table of contents for a book or manual or 
another long document was a two-step affair. First you created the table 

of contents, leaving blank spaces or Xs where the page numbers eventually 
would be placed. Then after the pages of the document were in their final 
form, you browsed the entire document, made a list of the page numbers for 
each chapter, and reopened the table of contents to replace the Xs with the 
correct page numbers.

Now, assuming that you format your document properly, creating a table 
of contents is a matter of clicking the mouse button a few times. Word 
assembles the table of contents for you by using the headings you cleverly 
placed throughout your document. And Word takes care of the drudgery of 
counting pages and even adjusts the table of contents for you if you make 
changes to the document that affect page numbers in the table.

This chapter shows you all the ins and outs of making a table of contents. It 
also shows you how to create a table of figures or other types of similar tables.

 The term table of contents is a little cumbersome to use repeatedly through-
out this chapter. As a bit of a computer nerd myself, I like using three-letter 
acronyms (TLAs), so I frequently use TOC to stand for table of contents in 
this chapter, if for no other reason than to save ink and paper.

Understanding Tables of Contents
A table of contents is simply a list of the headings that appear in a document, 
typically with the page number for each heading, as shown in Figure 1-1. 
Word can create a TOC for you automatically based on the heading para-
graphs in your document.
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358 Creating a Table of Contents

 

Figure 1-1: 
A simple 
table of 
contents.

 

The Table of Contents feature is one of several Word features that depend 
on the proper use of styles for trouble-free operation. When you create a 
TOC, Word searches through your document and looks for heading para-
graphs to include in the table. How on earth does Word know which para-
graphs are supposed to be headings? By looking at the style you assign to 
each paragraph: You format the heading paragraphs by using heading styles, 
such as Heading 1, Heading 2, and Heading 3.

If you plan to create a table of contents, make sure that you use heading 
styles to format your document’s headings, especially the headings that you 
want to appear in the TOC. You should do this anyway, of course, because 
styles help you format your headings consistently.

Word provides three shortcut keys for applying heading styles:

Shortcut Key Description

Ctrl+Alt+1 Heading 1

Ctrl+Alt+2 Heading 2

Ctrl+Alt+3 Heading 3

If you want, you can tell Word to use different styles to create a TOC. If you 
format your chapter titles with the Chapter Title style, for example, you can 
tell Word to include in the TOC any paragraphs formatted with the Chapter 
Title style. For more information, see the section “Beyond Heading Styles,” 
later in this chapter.

Creating a Table of Contents
If you assign heading styles to your document’s headings, creating a table of 
contents is easy. Just follow these simple steps:
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359Creating a Table of Contents

 1. Move the insertion point to the place where you want the table of con-
tents to appear.

  The TOC generally appears on its own page near the beginning of a doc-
ument. Press Ctrl+Enter to create a new page if necessary, and then click 
to position the insertion point on the empty page.

 2. Open the References tab on the Ribbon and then click the Table of 
Contents button in the Table of Contents group.

  A menu that lists several Table of Contents styles is displayed.

 3. Click the Table of Contents style you want to use.

  The TOC is added to the document, as shown in Figure 1-2. Note that the 
shaded frame that’s drawn around the table of contents is visible only 
when you hover the cursor over the table. This frame doesn’t appear 
when you print the document.

  You’re done!

If you don’t like any predefined tables of contents, you can create a custom-
ized TOC by clicking the Table of Contents button in the Table of Contents 
group of the References tab on the Ribbon and then choosing Insert Table of 
Contents. This action summons the Table of Contents dialog box, shown in 
Figure 1-3, from which you can manually choose the options for your table.

 

Figure 1-2: 
A TOC after 
it has been 
inserted into 
a document.
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Figure 1-3: 
The Table 
of Contents 
dialog box.

 

The Table of Contents dialog box lets you (among other things) select these 
options:

 ✦ Show Page Numbers: Deselect this check box if you want the TOC to 
show the document’s outline but not page numbers.

 ✦ Right Align Page Numbers: Deselect this check box if you want the page 
numbers placed next to the corresponding text rather than at the right 
margin.

 ✦ Tab Leader: Use this drop-down list to change or remove the dotted line 
that connects each TOC entry to its page number.

 ✦ Formats: Use this drop-down list to select one of several predefined for-
mats for the table of contents.

 ✦ Show Levels: Use this control to specify which heading levels to include 
in the table.

 ✦ Use Hyperlinks Instead of Page Numbers: Toggle on/off this option to 
switch between including page numbers in the TOC (useful for printed 
documents) and making each TOC entry a live hyperlink to the page of 
the document being referenced (useful for onscreen documents).

Here are some additional techniques to remember when you compile a TOC:

 ✦ You can make changes directly to a TOC by clicking in the table and 
typing. However, this idea is a bad one because any changes you make 
are lost the next time you regenerate the table of contents. See the later 
section “Updating a Table of Contents” for more information.
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361Updating a Table of Contents

 

✦ Unfortunately, Word doesn’t add Chapter 1 in front of the TOC entry for 
Chapter 1. If you want chapter numbers to appear in your TOC, you 
must include them in the paragraphs formatted with a style that is 
included in the TOC (such as Heading 1).

 ✦ To delete a TOC, select the entire table and press Delete. Or, click the 
Table of Contents button on the References tab on the Ribbon. From the 
menu that appears, choose Remove Table of Contents.

 ✦ Word formats entries in a TOC with a set of standard styles named 
TOC 1, TOC 2, TOC 3, and so on. If you don’t like any of the predefined 
formats in the Formats list in the Table of Contents dialog box (refer 
to Figure 1-3), select From Template from the list and click the Modify 
button. A special version of the Style dialog box, showing only the stan-
dard TOC styles, appears. You can then change the appearance of your 
table by modifying the various TOC styles.

Updating a Table of Contents
When you create a TOC, Word scans the entire document to determine 
which entries should be included in the table and which page numbers 
should be used for each entry. However, after you create the TOC, none 
of the changes you make to the document are reflected in the TOC. So, if 
you create a TOC before you’re done with the document, the TOC quickly 
becomes out of date.

To rebuild a TOC after you make changes, follow these steps:

 1. Select the table and click the Update Table button in the Table of 
Contents group on the References tab.

  The Update Table of Contents dialog box, shown in Figure 1-4, appears.

 2. Choose whether to rebuild the entire table or update only the page 
numbers.

 3. Click OK to update the table.

 

Figure 1-4: 
Updating 
a table of 
contents.
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Here are a few other ways to update a table of contents:

 ✦ Click anywhere in the table and press F9.

 ✦ Right-click the table and choose Update Field from the shortcut menu.

 ✦ Press Ctrl+A to select the entire document and then press F9. Pressing 
this key updates all tables of contents in the document, in case you have 
more than one.

 Don’t forget to save your file after you update the tables.

Adding Text
Sometimes you want a table of contents to include a bit of arbitrary text that 
hasn’t been formatted with a heading style. For example, you might want 
to add a pointer in the TOC to an important sidebar with a title that isn’t 
styled as a heading. To do so, just highlight the text you want to include in 
the table and click the Add Text button in the Table of Contents group on 
the References tab. A menu appears that allows you to select the level where 
you want the text to appear in the table.

 

After you add the text, you need to update the table before the text will 
appear in the table. For more information, see the preceding section, 
“Updating a Table of Contents.”

Beyond Heading Styles
Using the standard heading styles to create a table of contents is convenient 
but not always your first choice. For example, you might create a docu-
ment that consists of several chapters and mark the title of each one with 
a Chapter Title style. Fortunately, Word lets you create a table of contents 
based on paragraphs formatted with any style you want, not just the stan-
dard heading styles.

To create a table of contents by using styles other than the standard head-
ing styles, follow these steps:

 1. Click the Table of Contents button in the Table of Contents group on 
the References tab and then choose Insert Table of Contents.

  The Table of Contents dialog box appears. (Refer to Figure 1-3.)

 2. Click the Options button.

  The Table of Contents Options dialog box appears, as shown in Figure 
1-5. This dialog box lists all available styles in the document and lets you 
assign a table of contents level to each style.
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363Beyond Heading Styles

 

Figure 1-5: 
The Table 
of Contents 
Options 
dialog box.

 

 3. Adjust the TOC level fields to reflect the styles you want to include in 
your table of contents.

  The TOC level fields initially are set to include standard heading styles, 
but that setting is easy to change. To exclude a style from the table of 
contents, select the style’s TOC level field and delete the number in the 
field. To add a style to the table of contents, choose the style’s TOC level 
field and type the outline level you want that style to represent.

 4. Click OK to return to the Table of Contents dialog box.

 5. Click OK again to insert the table of contents.

  Voilà! You’re finished.

 

Keep in mind the following guidelines when using styles other than the stan-
dard style to create a table of contents:

 ✦ The initial settings for the TOC level fields reflect the Show Levels set-
ting in the Table of Contents dialog box (refer to Figure 1-3). If you plan 
to exclude the standard heading levels from your table of contents, 
set the Show Levels drop-down list to 1 before opening the Table of 
Contents Options dialog box. Then you have to clear only the TOC level 
field for the Heading 1 style.

 ✦ If you mess up the table of contents options, you can click the Reset 
button to restore the default settings.

 ✦ No rule says that the styles you include in the table of contents all have 
to appear at different levels. Suppose that you want to include para-
graphs formatted with the Chapter Title, Preface Title, Foreword Title, 
and Appendix Title styles in the table of contents at its top level. No 
problem. Just type 1 in the TOC level field for each of these styles in the 
Table of Contents Options dialog box.
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Creating a Table of Figures or Other Similar Tables
Tables of contents aren’t the only kind of tables you can create by using the 
References tab. You can also compile tables of figures, tables of tables, tables 
of equations, and other, similar collectibles. Chapter 3 of this minibook shows 
how to use this command to create an index, and Chapter 5 of this minibook 
shows how to create a table of authorities for legal documents.

Only a crazy person would use fields 
to create a table of contents

Because of styles, compiling a table of con-
tents in Word is as easy as pie — as easy as 
popping a frozen pie in the oven, that is. The 
table of contents equivalent of baking a pie 
from scratch is using fields rather than styles 
to create the TOC. The only real reason to use 
fields is if you want the text that appears in the 
TOC to vary slightly from the document text on 
which you base the TOC. You might want to add 
the text Chapter 1 in front of the title for Chap-
ter 1, for example.

To create a TOC from fields rather than from 
styles, you first must insert special TC fields 
throughout your document wherever you want 
a TOC entry created. These TC fields are Word 
field codes marking the text that will be assem-
bled to create the table of contents.

Here are the painful steps for inserting these 
fields:

 1. Place the insertion point where you want 
to insert the TC field.

  For example, place a TC field at the start of 
each heading in the document.

 2. Click Quick Parts➪Field in the Text group 
of the Insert tab.

  The Field dialog box appears.

 3. Select Index and Tables from the 
Categories list.

 4. Select TC from the Field Names list.

 5. To include text in your TOC, type it in quo-
tation marks in the Text Entry field imme-
diately after the TC field code, as shown in 
this example:

Chapter 1: I Am Born

 6. Click OK or press Enter.

The field is inserted in the document at the 
insertion point location. It looks something like 
this:

{ TC “Chapter 1: I Am Born” }

Word formats it as hidden text, so you might 
not be able to see it. If you can’t, choose 
File➪Options➪Display, select the Hidden Text 
check box, and then click OK.

After you insert all the TC fields, you create 
the TOC by choosing Table of Contents➪Insert 
Table of Contents in the Table of Contents 
group on the References tab. Click the Options 
button and then check the Table Entry Fields 
check box in the Table of Contents Options 
dialog box. Click OK to return to the Table of 
Contents dialog box and then click OK again to 
compile the table.
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365Creating a Table of Figures or Other Similar Tables

The process of creating a table of figures is the same as for creating a table 
of tables or equations. Follow these steps to create any of these kinds of 
tables:

 1. Select the item to caption, and then on the References tab in the 
Captions group, click the Insert Caption button.

  Figure 1-6 shows the Caption dialog box.

 2. Select the type of caption you want to create (Figure, Table, or 
Equation) in the Label field. Then type the caption in the Caption 
field. After you finish, click OK.

  Repeat Steps 1 and 2 for every caption you want to insert.

 3. Move the insertion point to where you want to insert the table.

 4. On the References tab in the Captions group, click the Insert Table of 
Figures button.

  Figure 1-7 shows the resulting dialog box.

 5. Select from the Caption Label drop-down list the type of table you 
want to create.

  The Caption Label setting corresponds to the Label setting in the 
Caption dialog box. To create a table of all figure captions, for example, 
select Figure from the Caption Label drop-down list.

 

Figure 1-6: 
The Caption 
dialog box.
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Figure 1-7: 
The Table 
of Figures 
dialog box.

 

 6. Select the style you want from the Formats drop-down list.

  As you click the various formats, the Print Preview and Web Preview 
windows show how the resulting table appears.

 7. Fiddle with the other controls to fine-tune the table’s appearance.

 • Show Page Numbers: Deselect this check box if you want the table to 
list the captions but not page numbers.

 • Right Align Page Numbers: Deselect this check box if you want the 
page numbers placed next to the corresponding text rather than at 
the right margin.

 • Tab Leader: Use this drop-down list to add or remove the dotted line 
that connects each table entry with its page number.

 • Formats: Use this drop-down list to choose one of several predefined 
formats for the table of figures.

 • Caption Label: Use this drop-down list to choose whether to build a 
table of figures, a table of equations, or a table of tables.

 • Include Label and Number: Deselect this check box if you want the 
table to include the caption text (for example, A Heffalump and a 
Woozle or Ratio of Red M&Ms) but not the number (for example, 
Figure 1 or Table 3).

 8. Click OK.

  The table is inserted into the document.
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367Creating a Table of Figures or Other Similar Tables

 Word is set up to create captions and tables for equations, figures, and 
tables. If you want to create other types of captions and tables — for limer-
icks or cartoons, for example — you can add items to the list of labels that 
appears in the Caption and Table of Figures dialog box. On the References 
tab in the Captions group, click the Insert button. Then click the New Label 
button. Type a new label (such as Limerick or Cartoon) and click OK. Type 
the caption text and click OK to insert the first caption of the new type. 
Later, when you insert the table of figures, the label you created appears in 
the Caption Label list.

To delete a table of figures, select the entire table and press Delete.

The entries in a table of figures are formatted using a standard Table of 
Figures style. If you don’t like any predefined formats in the Formats list in 
the Table of Figures dialog box, select From Template and click the Modify 
button. A special version of the Style dialog box appears, showing only the 
standard Table of Figures style. You can then change the appearance of your 
table by modifying the Table of Figures style.
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Chapter 2: Working with Footnotes 
and Endnotes

In This Chapter
✓ Adding footnotes

✓ Changing the appearance of footnotes

✓ Modifying reference marks

✓ Changing footnote separators

✓ Finding a footnote reference

Footnotes. Back when I was in college, typing them was a major pain in 
the derriere1. You had to count out the lines just right to make sure that 

you left enough room for the footnote at the bottom of the page. And then 
you had to figure out how to deal with footnote references that fell too close 
to the margin to place the note on the same page.

Being able to add footnotes is one of the neatest benefits of word proces-
sors, at least if you’re in college. After that, the footnote is a useless append-
age, unless you happen to work at the college, in which case the footnote 
feature becomes a source of resentment — just one among many examples 
of how easy kids have it today. Hmph.

Adding a Footnote
Using footnotes is a snap, unless you want to make them look fancy. Here’s 
the down-and-dirty procedure for adding plain-vanilla footnotes:

 1. Place the insertion point where you want the little footnote reference 
number to appear in your text.

 2. On the References tab in the Footnotes group, click the Insert 
Footnote button.

  The footnote reference is added to the text, and the footnote itself is 
placed at the bottom of the page.

 3. Type the footnote.

  Figure 2-1 shows what a completed footnote looks like.

1 Hind part; rear appendage; stern.
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370 Adding a Footnote

 

Figure 2-1: 
A footnote.

 

Word automatically numbers footnotes for you. Heck, that’s the point. When 
you insert a footnote, Word adds a little footnote reference number in the 
text and pairs it with a number in the footnote itself. If you go back later and 
insert a new footnote in front of an existing one, Word automatically juggles 
the footnote numbers to keep everything in sync.

 

Here are a few tips for working with footnotes:

 ✦ For an extra-quick way to create a footnote, use the keyboard short-
cut Ctrl+Alt+F. It says “Go directly to the footnote. Do not display the 
Footnote and Endnote dialog box; do not collect $200.”

 ✦ To create an endnote instead of a footnote, click the Insert Endnote 
button instead of the Insert Footnote button. Endnotes are similar to 
footnotes, but appear all together at the end of the document (or sec-
tion, if the document has multiple sections) instead of at the bottom of 
each page.

 ✦ For more control over endnotes and footnotes, open the Footnote and 
Endnote dialog box by clicking the dialog box launcher in the lower-right 
corner of the Footnotes group on the References tab. See Figure 2-2.

34_487662-bk06ch02.indd   37034_487662-bk06ch02.indd   370 4/15/10   9:14 PM4/15/10   9:14 PM



Book VI

Chapter 2

W
o

rk
in

g
 w

ith
 

Fo
o

tn
o

te
s a

n
d

 
E

n
d

n
o

te
s

371Changing the Footnote Format

 

Figure 2-2: 
The 
Footnote 
and Endnote 
dialog box.

 

 ✦ If you start with endnotes but then decide that you want to convert 
them to footnotes (or vice versa), fear not. Just open the Footnote and 
Endnote dialog box and click the Convert button. The Convert Notes 
dialog box opens, as shown in Figure 2-3. Then click OK to convert your 
footnotes to endnotes. Click Close to dismiss the Footnote and Endnote 
dialog box.

 ✦ To delete a footnote, select its footnote reference number in the text and 
press Delete.

 

Figure 2-3: 
The Convert 
Notes dialog 
box.

 

Changing the Footnote Format
The formatting of footnotes is governed by the Footnote Text style. You can 
change the appearance of all footnotes in your document by simply modi-
fying the Footnote Text style. (Refer to Book II, Chapter 3 for information 
about modifying styles.)

Similarly, you can format footnote reference numbers by using the Footnote 
Reference style. It’s a character style, so it doesn’t affect formatting for the 
entire paragraph.

The initial setting for footnote text is Normal + 10 point. Therefore, foot-
notes are formatted in the same font that’s in Normal paragraphs except 
that they’re 10-point regardless of the Normal text size. If you want your 
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footnotes to appear in a different font or size from the rest of the document, 
change the font or size for the Footnote Text style.

The initial setting for footnote references is Default Character Format + 
Superscript. As a result, footnote reference numbers print using the same 
font as the rest of the text in the paragraph, except that the superscript attri-
bute applies. If you want to see footnote references in a different font, all you 
have to do is change the Footnote Reference style.

Both footnote text and footnote references automatically apply when you 
create footnotes, so you should have no reason to apply these formats 
directly.

Changing the Reference Marks
Most footnotes are numbered 1, 2, 3, and so on, but Word enables you to 
change this standard numbering format to use letters, Roman numerals, or 
the special reference symbols *, †, ‡, and §.

Follow these steps to change reference marks:

 1. Summon the Footnote and Endnote dialog box by clicking the dialog 
box launcher in the lower-right corner of the Footnotes group on the 
References tab.

  The Footnote and Endnote dialog box is shown earlier in this chapter, in 
Figure 2-2.

 2. Select a number format.

  This list shows your choices:

  1, 2, 3 . . .

  a, b, c . . .

  A, B, C . . .

  i, ii, iii . . .

  I, II, III . . .

  *, †, ‡, § . . .

 3. Click Apply.

 All footnotes in a section must use the same numbering scheme. You can’t 
mix and match.

If you choose the special symbols *, †, ‡, and § for your reference marks, 
Word doubles them, if necessary, to create unique reference marks. The first 
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373Finding a Footnote Reference

four footnotes use the symbols singly. The mark for the fifth through eighth 
notes are **, ††, ‡‡, and §§. After that, the symbols are tripled.

To keep this doubling and tripling of symbols in check, select the Restart 
Each Page option in the Note Options dialog box. That way, the mark for the 
first note on each page is always an asterisk (*). Otherwise, you end up with 
reference marks such as §§§§§§§§§§, which look silly.

 

To keep this doubling and tripling of symbols in check, select the Restart 
Each Page option in the Numbering drop-down list of the Footnote and 
Endnote dialog box. For example, you can specify that an asterisk (*) mark 
all footnotes. If you want to enter a symbol that’s not readily available from 
the keyboard, click the Symbol button and select the symbol you want from 
the resulting Symbol dialog box.

Finding a Footnote Reference
To quickly find the reference mark for a particular footnote or endnote, 
follow these steps:

 1. Click the Home tab, and in the Editing group, choose Find➪Go To.

  Or, press Ctrl+G. You see a dialog box that isn’t worthy of a separate 
figure.

 2. In the Go To What list box, select Footnote or Endnote.

 3. In the Enter Footnote Number text box, type the number of the foot-
note you want to go to.

  If the notes are numbered with reference symbols (*, †, ‡, and §), type 
the corresponding number (1, 2, 3, and so on).

 4. Click Go To and then click Close.

  There it is.

 

Or, for an even easier method, click the Select Browse Object button, located 
near the bottom of the scroll bar on the right edge of the document window. 
Then choose one of these buttons from the pop-up menu that appears:

  ✦ Browse by endnote

  ✦ Browse by footnote

The double-headed up- and down-arrow buttons that appear above and 
below the Select Browse Object button change so that they go to the previ-
ous and next footnote or endnote, respectively.
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Chapter 3: Indexing Your 
Masterpiece

In This Chapter
✓ Marking index entries

✓ Creating an index

✓ Updating an index

✓ Marking a range of pages

✓ Creating subentries

✓ Creating cross-references

If all you ever use Word for is to create one- and two-page memos on 
mundane subjects such as how to clean the coffeemaker, you can skip 

this chapter. After all, you don’t need an index for a two-page memo on cof-
feemaker cleaning unless you work at the Pentagon. If, on the other hand, 
your memo turns into a 200-page policy manual on appliance maintenance, 
an index may well be in order.

As luck has it, Word just happens to have a most excellent indexing feature 
that can help you with the tedious task of indexing. It doesn’t create the 
index for you automatically, but it does help you identify which words to 
include in the index, and, without much complaining, Word compiles and 
formats the index from the words you mark.

Creating an index is a three-stage affair. First, you must mark all phrases within 
your document that you want to appear in the index. Second, you go to the 
Index group on the References tab and click the Insert Index button to create 
the index. This command sorts alphabetically all the words and phrases you 
mark and then combines identical entries. Third, you carefully review the 
index, lament that Word didn’t do a better job, and fix what you can.

 

I’ve indexed quite a few books in my day, and I have yet to find a word pro-
cessor with an indexing feature that truly does the trick. Word is no excep-
tion. It can gather index entries for you, but it can’t organize them or make 
sure that you create your index entries with any degree of consistency. It 
does a better job than any other word processor I’ve had the pleasure of 
working with, but you should still be prepared to do a ton of work yourself.
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You can mark the words you want to include in an index in two ways: manu-
ally, marking each word one by one; or automatically, giving Word a list of 
words you want in the index and letting it mark the words in the document. 
First I show you the manual way and then, later in the chapter, I show you 
the automatic way (in the section, “Isn’t There an Easier Way?”).

Mark Those Index Entries
The first — and most important — task in creating an index is to mark the 
words or phrases you want to include in the index. The most common way 
to do that is to insert an index marker in the document at each occurrence 
of each item you want to appear in the index.

To mark index entries manually, follow these steps as long as you can stay 
awake:

 1. Open the document you want to index.

 2. Select the word or phrase you want in the index by using the mouse 
or the keyboard.

 3. Press the keyboard shortcut Alt+Shift+X.

  Alt+Shift+X is one of Word’s more memorable keyboard shortcuts, to be 
sure. It opens the Mark Index Entry dialog box, shown in Figure 3-1.

 

Figure 3-1: 
The Mark 
Index Entry 
dialog box.

 

 4. Double-check the content in the Main Entry field. If it’s correct, click 
the Mark button. If not, correct it and then click Mark.

  The text doesn’t have to appear in the index exactly as it appears in the 
document. You may highlight an abbreviation to include in the index, for 
example, but then edit the Main Entry field so that the full spelling of the 
word, rather than its abbreviation, appears in the index.

35_487662-bk06ch03.indd   37635_487662-bk06ch03.indd   376 4/15/10   9:14 PM4/15/10   9:14 PM



Book VI

Chapter 3

In
d

e
x

in
g

 Y
o

u
r 

M
a

ste
rp

ie
c

e

377Mark Those Index Entries

 5. To index an entry under a different word, type the alternative entry in 
the Main Entry field and click the Mark button again.

  For example, you might want to create an entry for “mutt, mangy” in 
addition to “mangy mutt.”

 6. Mark any additional index entries by highlighting them in the docu-
ment and clicking the Mark button.

  The Mark Index Entry dialog box works somewhat like the Spelling 
dialog box in the way it stays onscreen so that you can efficiently mark 
additional index entries. So, while the Mark Index Entry dialog box 
remains visible, you can select the text for another index entry and then 
click Mark to mark it. You can keep indexing for as long as you have the 
energy.

 7. After you mark each of the index entries you want, click the Close 
button in the Mark Index Entry dialog box.

The index entries are marked with special codes formatted as hidden text so 
that you can’t normally see them and they don’t print. They are there, how-
ever, waiting to be counted when you create the index.

 

Here are some timely tips for preparing index entries:

 ✦ The most efficient way to create an index is after you write and edit your 
document. Set aside some time to work through the document by using 
the Mark Index Entry dialog box. Don’t bother to create index entries as 
you write your document; it just slows you down and distracts you from 
your primary task: writing.

  ✦ Another way to summon the Mark Index Entry dialog box is to open the 
References tab on the Ribbon and then click the Mark Entry button in 
the Index group. (This button is shown in the margin.)

 ✦ If, while marking index entries, you come across a word or phrase that 
you know occurs elsewhere in your document, click the Mark All button 
in the Mark Index Entry dialog box. By clicking the Mark All button, you 
create an index entry for not only the selected text but also any other 
occurrence of the selected text within the document.

  ✦ Each time you mark an index entry, Word activates the Show All 
Formatting Marks option, which reveals not only the hidden text used to 
mark index entries but also other characters normally hidden from view, 
such as field codes, tab characters, spaces, and so on. This behavior is 
normal, so don’t be surprised when it happens. To return your display 
to normal, just click the Show/Hide button in the Paragraph group of the 
Home tab (shown in the margin).

 ✦ Index entries look something like this: { XE “mangy mutt” }, format-
ted as hidden text. You can edit the index entry text (the part between 
quotation marks) if you want to change an index entry after you create it.
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Creating an Index
After you mark the index entries, the process of generating the index is rela-
tively easy. Here are the steps:

 1. Move the insertion point to the place where you want the index to 
appear.

  The index generally begins on a new page near the end of the document. 
Press Ctrl+Enter to create a new page if necessary, and click to position 
the insertion point on the empty page. You might want to add a heading, 
such as Index, at the top of the page.

  2. Open the References tab on the Ribbon and then click the Insert 
Index button found in the Index group. (This button is shown in the 
margin.)

  The Index dialog box appears, as shown in Figure 3-2.

 

Figure 3-2: 
The Index 
dialog box.

 

 3. Select the index style you want from the Formats drop-down list.

  As you click the various formats, the Print Preview area shows how the 
resulting index will appear.

 4. Play with the other controls on the Index tab to fine-tune the index.

 • Type: Place index subentries on separate indented lines (Indented) 
or run together (Run-in).

 • Columns: Set the number of columns you want in the index. Two is 
the norm.
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 • Language: If you have multiple language options installed in Word, 
you can select the language to use in this drop-down list.

 • Right Align Page Numbers: Select this check box if you want the page 
numbers placed at the right edge of the index.

 • Tab Leader: Change or remove the dotted line that connects each 
index entry to its page number. You can remove the dotted line only 
when you select the Right Align Page Numbers option.

 • Formats: Choose one of several preset formats for the index. Or, you 
can specify From Template to use styles in the document’s template 
to determine the formatting for the index.

 5. Click OK.

  The index is inserted into the document.

 

If you see the index’s field code ({ INDEX \r \h “A” \c “2” }) rather 
than the index itself, right-click the index field code and choose Toggle Field 
Codes.

To delete an index, select the entire index and then press Delete.

The entries in an index are formatted with a set of standard styles named 
Index 1, Index 2, Index 3, and so on. If you don’t like any predefined formats 
listed in the Formats list in the Index dialog box, select From Template in the 
Formats drop-down list and then click the Modify button. A special version 
of the Style dialog box appears, listing only standard Index styles. You can 
then change the appearance of your index by modifying the various Index 
styles.

Updating an Index
Whenever you edit your document, you run the risk of messing up the index. 
Even a slight change can push text from the bottom of one page to the top 
of the next and possibly invalidate the index. Fortunately, this section gives 
you several ways to keep your index up-to-date.

Choose File➪Options to open the Word Options dialog box. Select the 
Display tab and then check the Update Fields Before Printing in the Printing 
Options section and click OK. Word automatically updates the index every 
time you print your document.

 

To update an index without printing the document, click inside the index 
and press F9. If you point to the index and right-click, the shortcut menu 
that appears includes an Update Field command. Using this command 
works the same as pressing F9 or clicking the Update Index button on the 
References tab.
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Marking a Range of Pages
If a particular topic is discussed for several pages in your document, you 
might want to create an index entry that marks a range of pages (for exam-
ple, 26–29) rather than each page individually (26, 27, 28, 29).

Unfortunately, the procedure for marking page ranges isn’t as slick as it 
could be. You have to mess around with the Word doohickey known as a 
bookmark. A bookmark is a name you can assign to a selection of text. You 
usually use bookmarks to mark locations in your document so that you 
can return to them later, but they have all sorts of more interesting uses. 
Marking a range of pages for an index is just one.

To use a bookmark to create a range of pages in an index, follow these steps 
(this process gets tricky, so hang on to your hat):

 1. Highlight the entire range of text you want included in the index 
entry’s page range.

  A long discussion of a single topic could go on for pages, so be prepared.

  2. Open the Insert tab on the Ribbon and click the Bookmark button, 
found in the Links group. (This button is shown in the margin.)

   The Bookmark dialog box appears, as shown in Figure 3-3.

 

Figure 3-3: 
The 
Bookmark 
dialog box.

 

 3. Type a bookmark name to identify the bookmark.

  Bookmark names can be as long as 40 characters and can consist of any 
combination of letters and numbers. Spaces aren’t allowed, but you can 
use an underscore to double as a space.

 4. Click Add to create the bookmark.
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381Creating Subentries

 5. Position the insertion point at the beginning of the bookmark and 
press Alt+Shift+X.

  The Mark Index Entry dialog box appears.

 6. Type the text you want to appear in the index in the Main Entry field.

 7. Select the Page Range option.

 8. Select the bookmark you just created from the Bookmark drop-down 
list box.

  All bookmarks in the current document appear in this drop-down list.

 9. Click the Mark button to create the index entry.

After you create the bookmark and an index entry naming the bookmark, the 
index includes the range of page numbers for the entry.

The location of various bookmarks in your document can be indicated by 
large brackets in the text. To activate these brackets, open the Word Options 
dialog box by clicking File➪Options. Then select the Show Bookmarks 
option in the Show Document Content section of the Advanced tab.

 

Make the bookmark name as close to identical to the index entry text as you 
can. Use underscore characters rather than spaces: master_document for 
master document, for example.

Creating Subentries
You include a subentry when a word is used for two different meanings or 
serves as a category organizer for several related words. For example, you 
might want to create an index entry that looks like this:

crew

      Kirk, James T., 15

      McCoy, Leonard H., 16

      Scott, Montgomery, 16

      Spock, Mr., 17

Here, the index entries for Kirk, McCoy, Scott, and Spock are all subentries of 
the main entry: crew.

To create index subentries, you follow the procedure for marking index 
entries, which I explain earlier in this chapter. You type text for both the 
main entry and the subentry, however, in the Mark Index Entry dialog box. 
Each of the preceding index entries, for example, has crew for the Main 
Entry field and the individual crew member’s name as the subentry.
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You can create a subentry directly in the Main Entry field by typing the main 
entry, a colon, and the subentry. For example, type crew:Kirk, James T. to 
create Kirk, James T. as a subentry of crew.

See Also
A cross-reference is one of those annoying messages signaling that you’re 
about to embark on a wild goose chase:

crew, see cast.

To create a cross-reference, begin by marking an index entry as you normally 
do. On the Mark Index Entry dialog box, select the Cross-Reference option 
and then type some text in the accompanying text box. Word automatically 
merges the cross-reference with other index entries for the same text.

Isn’t There an Easier Way?
Yet another way to create index entries is to use an AutoMark file, which is 
simply a list of the words that you want Word to include in the index. Word 
then creates an index entry for each occurrence of each word in the list. 
Sounds like a great timesaver, eh? It is, sometimes — if you do a good job of 
creating the AutoMark file in the first place.

Here are the steps:

 1. Create a new document for the word list.

 2. Type the list of words you want to index, each on its own line.

  For example:

 Kirk

 Spock

 McCoy

 Scotty

 3. (Optional) If you want the text in the index to be different from the 
text in the document, press the Tab key and then type the text exactly 
as you want it to appear in the index.

  For example:

 Kirk Kirk, James T.

 Spock Spock, Mr.

 McCoy McCoy, Leonard H.

 Scotty Scott, Montgomery
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383Isn’t There an Easier Way?

  Note: You can have more than one line referring to the same index 
entry. For example:

 McCoy McCoy, Leonard H.

 Bones McCoy, Leonard H.

 4. Save the word list document by clicking the Save button on the Quick 
Access toolbar.

 5. Close the word list document.

 6. Open the document you want to index.

 7. Click the Insert Index button in the Index group of the References tab.

  The Index dialog box pushes its way to the front.

 8. Click the AutoMark button.

  A dialog box similar to the Open dialog box appears.

 9. Find the file you saved in Step 4, choose it, and click Open.

 10. Hold your breath while Word adds the index entries.

  If your word list or the document is long, adding the index may take a 
while. Be patient.

 11. Select the index and press F9 to update your index with the marks 
added in Step 10.

  It’s done.

After you create the automatic index entries, you probably want to work 
your way through the document by creating additional index entries.

Unfortunately, the AutoMark option doesn’t account for running discussions 
of a single topic that span several pages. It results in index entries such as 
Vogons, 14, 15, 16, 17, 18 that should read Vogons, 14-18. So you have to man-
ually fix this type of problem.

 When you use tabs to separate the keywords used to locate the items to 
index and the text you want inserted in the index for those items, keep in 
mind that the tab stop positions in the word list document don’t matter.

If you want, you can use Word’s Table feature to create the word list. Create 
a two-column table and use the first column for the text to find in the docu-
ment and the second column for the text to include in the index.

 Word sometimes refers to the word list as a concordance. Just thought you’d 
want to know.
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Chapter 4: Citations 
and Bibliographies

In This Chapter
✓ Creating reference citations

✓ Working with sources

✓ Creating a bibliography

If you’re a student or an academic, you’ll love the new Citations and 
Bibliography feature of Word 2010. This feature lets you create a list of 

sources, add references to those sources throughout your document, and 
automatically generate a bibliography that lists all sources referenced in the 
document.

Best of all, these tools can generate the references and the bibliography in 
one of ten different standard formats, including most commonly used for-
mats such as APA, Chicago, and MLA, as well as more obscure formats such 
as GOST and Turabian.

And — get this — if you copy a citation from a document that uses MLA 
and paste it into a document that uses Chicago, the citation automatically 
changes to Chicago! (Where was this program when I was in college? Kids 
these days don’t appreciate anything.)

The bad news — or good news, if you’re a teacher — is that Word still can’t 
do your research for you. You still have to scour stacks and stacks of books 
to find the perfect source. But when you find it, Word helps you cite it in the 
correct format.

Creating References and Sources
The first time you create a reference from a particular source, you can 
create a citation and enter the source data so that Word remembers it for 
future use. To create a citation for a new source, follow these steps:

 1. Click at the location where you want to insert the citation.

  Usually, this location is at the end of the sentence that refers to the 
source.
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  2. Use the Style drop-down list in the Citations & Bibliography group of 
the References tab to select the bibliography format. (This control is 
shown in the margin.)

  You can select one of these formats:

 • APA

 • Chicago

 • GB7714

 • GOST — Name Sort

 • GOST — Title Sort

 • ISO 690 — First Element and Date

 • ISO 690 — Numerical Reference

 • MLA

 • SIST02

 • Turabian

  Wow! Can you believe Word has so many formats? The most commonly 
used formats on college campuses in the United States are APA, Chicago, 
and MLA.

  3. Click the Insert Citation button in the Citations & Bibliography group 
on the References tab (shown in the margin).

   This step reveals a drop-down menu with the following options:

 • Add New Source

 • Add New Placeholder

 4. Choose Add New Source.

  The Create Source dialog box, shown in Figure 4-1, appears.

 

Figure 4-1: 
The Create 
Source 
dialog box.
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 5. Use the Type of Source drop-down list to select the source type.

  You can enter bibliographic information for these types of sources:

 • Art

 • Article in a Periodical

 • Book

 • Book Section

 • Case

 • Conference Proceedings

 • Document from Web Site

 • Electronic Source

 • Film

 • Interview

 • Journal Article

 • Miscellaneous

 • Patent

 • Performance

 • Report

 • Sound Recording

 • Web Site

 

 The fields that appear in the Create Source dialog box change depend-
ing on the source type you select. For example, the Create Source dialog 
box for a book includes fields for the book’s author and publisher. For a 
film, fields for the performer’s and director’s names are included.

 6. Enter the bibliographic information in the dialog box.

  For a book, you enter the author, title, year, city, and publisher. You 
probably want to have the book with you to enter this information 
correctly.

 

 You can select the Show All Bibliography Fields check box to expand 
the Create Source dialog box to include additional fields. For most 
bibliographies, the basic fields are sufficient, so you can safely ignore 
this check box.

 7. Click OK.

  The source information is added to Word’s database of bibliographic 
sources, and a reference to the source is added to the document.
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  You’re done! At least for this source. If you have other references and 
sources, repeat this procedure. And when you’re ready, you can create 
the bibliography as described in the section “Creating a Bibliography,” 
later in this chapter.

 

Here are a few additional pointers for creating references and sources:

 ✦ After you have created a source, that source appears on the drop-down 
menu for the Insert Citation button. To create another reference to the 
same source, just click the Insert Citation button and choose the source 
you want to cite.

 ✦ If you want to create a reference but you don’t yet know the details, click 
the Insert Citation button and choose Add New Placeholder. Enter a 
name for the placeholder and click OK. You can then enter the details, as 
described in the section “Managing Your Sources,” later in this chapter.

 ✦ When you insert a citation, the citation itself becomes an object that you 
can select and edit. When you select (or click inside) a citation, an arrow 
appears next to the citation; you can click this arrow to reveal a menu 
that lets you edit the citation itself or edit the source information. On 
that same menu, you can convert the citation to static text and update 
the citation field. You can also delete the citation by selecting it and 
pressing Delete.

Creating a Bibliography
After you mark all citations in your document, you can easily create a bibliog-
raphy that references the citations in the correct format. Here are the steps:

 1. Click at the location where you want to insert the bibliography.

  It’s usually at the end of the document.

  2. Click the Bibliography button in the Citations & Bibliography group of 
the References tab (shown in the margin) and then choose Insert 
Bibliography.

  The bibliography is inserted. That’s it!

The bibliography is formatted according to the style selected from the Style 
drop-down list in the Citations & Bibliography group of the References tab.

Managing Your Sources
Word keeps a list of all the sources you create, for not just the current 
document but, rather, all documents. You can manage this list by clicking 
the Manage Sources button in the Citations & Bibliography group on the 
References tab. This action opens the dialog box shown in Figure 4-2.
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Figure 4-2: 
The Source 
Manager 
dialog box.

 

As you can see, this dialog box presents two lists of sources. The list on the 
left is the master list of all sources you have created, in any document. The 
list on the right is the list of sources to include in the bibliography for the 
current document. Any sources you have referenced in the current docu-
ment are included in the current list.

Here are a few interesting things you can do with this dialog box:

 ✦ Add a source to the bibliography for the current document even if the 
source isn’t referenced in the document. To do that, select the source in 
the master list and click Copy.

 ✦ You can search for sources by using the Search text box.

 ✦ To edit the information for a source, select the source and click the Edit 
button.

 ✦ Click the New button to create a new source.

 ✦ The Browse button lets you open a different list.
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Chapter 5: I Object! (To Tables 
of Authorities, That Is)

In This Chapter
✓ Marking citations

✓ Creating a table of authorities

✓ Updating a table of authorities

✓ Adding your own categories

Inasmuch as you, hereinafter referred to as the reader, have deemed it 
necessary, appropriate, and befitting to create, prepare, and otherwise 

compile a table, list, or enumeration of various and sundry citations, refer-
ences, and quotations from legal authorities and other sources, including, 
but not limited to, cases, statutes, rules, treatises, regulations, consti-
tutional provisions, and other authorities occurring within and among 
documents, files, and other materials prepared with the word-processing 
software known as Microsoft Word 2010, hereinafter referred to as Word, 
now therefore and thereupon I, hereinafter referred to as I, agree to provide 
within this chapter a thorough and comprehensive description, discussion, 
and presentation of the techniques, methods, and procedures required to 
prepare such aforementioned tables, lists, or enumerations. In consider-
ation hitherto, so let it be written, so let it be done.

In other words, this chapter shows you how to use Word’s Table of 
Authorities feature. If you’re a lawyer or legal secretary, you already know 
what a table of authorities is. If you aren’t, turn to another chapter before 
it’s too late.

Creating a table of authorities is much like creating an index (see Chapter 3 
of this minibook). First you mark the citations where they appear within the 
document. Then you use the Insert Table of Authorities button (in the Table 
of Authorities group on the References tab) to compile the table of authori-
ties based on the citations you marked. If necessary, you can then edit the 
table or adjust its formatting. You can also update the table to ensure that 
all entries are up-to-date.
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Marking Citations
The first step in creating a table of authorities is reviewing the entire docu-
ment and marking any citations you want to include in the table. Follow 
these steps:

 1. Find a citation you want to mark.

  Start at the beginning of the document and work through the whole 
thing, marking citations as you go. 

 2. Highlight the citation with the mouse or keyboard and press 
Alt+Shift+I.

  The Mark Citation dialog box appears, as shown in Figure 5-1.

 

Figure 5-1: 
The Mark 
Citation 
dialog box.

 

 3. Edit the Selected Text field so that it’s exactly the way you want the 
citation to appear in the table of authorities.

  The Selected Text field initially contains the text you selected when you 
pressed Alt+Shift+I. If the citation in the document doesn’t look the way 
you want it to appear in the table of authorities, click in the Selected 
Text field and type away. If you want to split the citation into two lines, 
just position the insertion point where you want the line to split and 
press Enter.

 4. Edit the Short Citation field so that it exactly matches the way the 
short version of the citation is used in subsequent references through-
out the document.

  The first time you cite an authority, you must provide a complete cita-
tion, such as “Kringle v. New York, 28 NY 2d 312 (1938),” but thereafter 
you use the short form, “Kringle v. New York.” Edit the Short Citation 
field to match the short form of the citation. That way, Word can auto-
matically locate subsequent citations and mark them.
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393Marking Citations

 5. Select the type of authority being cited from the Category drop-down 
list.

  Word comes equipped with several common categories: Cases, Statutes, 
Other Authorities, Rules, Treatises, Regulations, and Constitutional 
Provisions. You can also create your own categories, as described later 
in this chapter.

 6. Click the Mark button to mark the citation.

  Word inserts a hidden field code to mark the citation. The Mark Citation 
dialog box stays open onscreen so that you can mark additional citations.

 7. Click the Next Citation button to find the next citation.

  The Next Citation button searches for the next citation in the document 
by looking for text that’s commonly found in legal citations, such as v.

 8. Highlight the complete text of the citation found by the Next Citation 
button.

  The Next Citation button doesn’t highlight the complete citation — only 
the text it finds that convinces it to stop because a citation is probably 
nearby. Use the mouse to select the citation in the document. (The Mark 
Citation dialog box patiently stays onscreen while you mark the citation.)

 9. Repeat Steps 3 through 8 until you mark all the citations you can 
stand.

 10. After you finish marking citations, click the Close button.

Word marks citations with field codes formatted as hidden text so that they 
are normally invisible. These codes jump to life, however, when you compile 
a table of authorities. See the next section for the steps.

  Another way to summon the Mark Citation dialog box is to click the Mark 
Citation button (shown in the margin). You can find this button located in 
the Table of Authorities group on the References tab.

 

If the screen suddenly changes to Print Preview mode when you try to 
mark a citation, don’t panic. You probably pressed Ctrl+Alt+I rather than 
Alt+Shift+I. Ctrl+Alt+I is the keyboard shortcut for toggling Print Preview on 
and off. These two keyboard shortcuts are perilously close to one another. If 
you press the wrong keys, just press Esc to return to Normal view and then 
start over.

Every time you stumble over a citation that you know occurs later in your 
document, click the Mark All button. It creates a citation for not only the 
selected text but also any subsequent occurrences of the citation.
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  Every time you mark a citation, Word activates the Show All Formatting Marks 
option. To return your display to normal, click the Show/Hide button (shown 
in the margin) in the Paragraph group on the Home tab of the Ribbon.

The field codes for citations look like this example:

{ TA \l “Kringle v. New York
28 NY 2d 312 (1938)” \s “Kringle v. New York” \c 1 }

The preceding codes are formatted as hidden text, so you don’t normally see 
them. You can edit the long citation text (the part between quotes following 
\l) or the short citation text (the quoted text that follows \s) if you want to 
change a citation after you create it.

Creating a Table of Authorities
After you mark all citations in your document, follow these steps to create 
the table of authorities:

 1. Move the insertion point to the place where you want the table of 
authorities to appear.

  You can place the table of authorities at the beginning or end of the doc-
ument. If you want the table to appear on its own page, press Ctrl+Enter 
to create a page break. You might also want to type a heading, such as 
Table of Authorities.

 2. Click the Insert Table of Authorities button in the Table of Authorities 
group on the References tab.

  The Table of Authorities dialog box appears, as shown in Figure 5-2.

 

Figure 5-2: 
The Table of 
Authorities 
dialog box.
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395Creating a Table of Authorities

 3. Pick the style you want from the Formats drop-down list.

  As you click the various formats, the Print Preview area shows how the 
resulting table of authorities appears.

 4. Play with the other controls to fine-tune the table of authorities.

 • Use Passim: Select this check box if you want Word to use the word 
passim whenever a citation occurs on five or more pages. (The Latin 
word passim means either “scattered throughout,” or “an ugly, over-
grown, rat-like creature that hangs upside down by its tail.”)

 • Keep Original Formatting: Select this check box if you want the char-
acter formatting (such as underline and italics) that Word applies to 
the document’s citation to carry over into the table of authorities.

 • Tab Leader: Use this drop-down list to add or remove the dotted line 
that connects each table entry with its page number.

 • Formats: Use this drop-down list to select one of several predefined 
formats for the table of authorities.

 • Category: Use this list box to choose the citation category you want 
compiled. Usually, you leave the category set to All, the default. If 
you want to compile a table of one category (cases, rules, and regula-
tions, for example), select the category from the drop-down list.

 5. Click OK.

  The table of authorities is created.

Here are some things to remember when you compile a table of authorities:

 ✦ If the table of authorities looks like { TOA \h \c “1” \p }, right-click 
it and choose Toggle Field Codes. Alternately, call up the Word Options 
dialog box (choose File➪Options), click the Advanced tab, and deselect 
the Show Field Codes Instead of Their Values check box (found in the 
Show Document Content section). Click OK, and the table appears 
correctly.

 ✦ To delete a table of authorities, select the entire table and then press 
Delete.

 ✦ Word formats the entries in a table of authorities in a standard Table of 
Authorities style, and the category headings are formatted in the TOA 
Heading style. If none of the predefined formats in the Formats list tick-
les your fancy, select From Template and click the Modify button. A spe-
cial version of the Style dialog box appears, showing only the standard 
styles used in a table of authorities. You can customize the appearance 
of your table by modifying the Table of Authorities and TOA Heading 
styles.
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Updating a Table of Authorities
If you edit a document after creating a table of authorities, the table might 
become out-of-date. To ensure that the table is up-to-date, use one of these 
techniques:

 ✦ Use the Word Options dialog box. In the Word Options dialog box 
(choose File➪Options), click the Display tab, select the Update Fields 
before Printing check box (in the Printing Options section), and then 
click OK. Then the table of authorities automatically updates every time 
you print your document.

 

✦ Press F9. To update a table of authorities without printing the docu-
ment, select (or click inside) the table and press F9.

 ✦ Use the right-click context-sensitive menu. If you point to a table of 
authorities and right-click, the shortcut menu that appears includes an 
Update Field command. Using the Update Field command works the 
same as pressing F9.

 ✦ Click Update Table. The Update Table button is in the Table of 
Authorities group on the References tab. 

Adding Your Own Categories
Word comes with seven predefined table of authorities categories: Cases, 
Statutes, Other Authorities, Rules, Treatises, Regulations, and Constitutional 
Provisions. If these categories aren’t sufficient for your needs, you can add 
your own. Word has room for as many as 16 categories, and you can either 
add new categories or replace existing categories with new categories of 
your choosing.

To create your own categories, follow these steps:

 1. Open the Mark Citation dialog box by pressing Alt+Shift+I. Then click 
the Category button.

  The Edit Category dialog box appears, as shown in Figure 5-3.

 

Figure 5-3: 
Creating 
a custom 
category.
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397Disclaimer of Warranties and Limit of Liability

 2. If you want to replace a category, select it in the Category list. If you 
want to create a new category, scroll past the predefined categories 
and select one of the dummy categories numbered 8 through 16.

 3. Type in the Replace With field the name you want to use for the new 
category and click the Replace button. Click OK.

When you add your own categories, they appear in the Category drop-down 
list box in the Mark Citation dialog box. Then you can assign citations to the 
new category as you mark them.

Note that the categories you create are stored on your computer and not as 
part of the document. As a result, if you use custom categories, be sure to 
create them consistently on all computers in your office.

Disclaimer of Warranties and Limit of Liability
The author, Doug Lowe, and the publisher, Wiley Publishing, Inc., make no 
representations or warranties with respect to the accuracy or completeness 
of the contents of this chapter and specifically disclaim any implied war-
ranties or merchantability or fitness for any particular purpose and shall 
in no event be held liable for any loss of profit or any other commercial 
damage, including, but not limited to, such damages as losing a big case 
because of a key citation being omitted from a pleading or a brief; tripping, 
falling, or stumbling over this book; or the cost of medical treatment and/
or hospitalization, pain and suffering, lost wages, or emotional anguish due 
to stress inflicted or sustained while using or attempting to use the Table of 
Authorities feature in the Word 2010 software program. Et cetera, et cetera, 
et cetera.
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Chapter 6: Working with Outlines 
and Master Documents

In This Chapter
✓ Switching to Outline view

✓ Understanding Outline view

✓ Collapsing and expanding an outline

✓ Promoting and demoting paragraphs

✓ Editing in Outline view

✓ Printing an outline

✓ Working with master documents

Some writers have the outlining gene — others don’t. Some writers 
manage to concoct at least a rudimentary outline only by completing 

an extraordinary act of self-will. Other writers spend days polishing the 
world’s perfect outline before they write a word. Their outlines are so good 
that they can write with their eyes closed after finishing the outline. Hmph. 
I fall somewhere between those two extremes. I spin a fairly decent outline 
upfront, but I’m not compulsive about it. I rarely write with my eyes closed 
and usually revise the outline substantially as I go, sometimes beyond the 
point of recognition.

In this chapter I discuss outlines and how to use them to your advantage. 
Then I describe how to put the chapters in your Great American Novel all 
together in continuity and harmony with the Master Document feature.

Working with Outlines
Word has built-in outlining tools that are handy whether you like to create 
detailed outlines in advance or you just want to check occasionally on the 
overall structure of your document to see how it’s evolving. I use outlin-
ing all the time, even though I’m not an outline fanatic. If you use Word to 
create reports or proposals or other types of documents that have a sense 
of structure to them, you owe it to yourself to find out the basics of working 
with outlines.
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Switching to Outline view
You have two ways to switch to Outline view. You can

 ✦ Click the Outline button in the Document Views group on the View tab 
on the Ribbon.

 ✦ Click the Outline button that’s second from the right in the group of but-
tons next to the Zoom slider in the lower-right area of the screen.

Either way you go about it, you summon the Outlining tab, as shown in 
Figure 6-1, to a place of honor before the Home tab on the Ribbon.

 

Figure 6-1: 
The 
Outlining 
tab.

 

Understanding Outline view
The key to understanding Word’s Outline view is realizing that an outline 
is just another way of looking at a document. The outline isn’t a separate 
entity from the document. Instead, when you switch to Outline view, Word 
presents the headings from your document in the form of an outline. Any 
changes you make to your document while in Outline view automatically 
reflect in the document when you return to Print Layout view, and any 
changes you make in Print Layout view automatically appear when you 
switch to Outline view. The reason is that Print Layout and Outline view are 
merely two ways of displaying the contents of your document.

Note some important concepts about Outline view:

 ✦ The outline is made up of the headings and body text of the document. 
Any paragraph formatted with a built-in heading style (Heading 1, 
Heading 2, or Heading 3, for example) is considered to be a heading; any 
other paragraph is considered body text.

 ✦ When you switch to Outline view, a new tab appears on the Ribbon, 
and the ruler (which isn’t needed in Outline view) disappears. This tab, 
appropriately named the Outlining tab, contains buttons for performing 
routine outlining tasks. Refer to Figure 6-1 to see the Outlining tab and 
its groups; I list the buttons used for working with outlines in Table 6-1.

 ✦ When you first switch to Outline view, your document may not appear 
dramatically different from the way it does in Print Layout view. In the 
following sections, you see how you view your document quite differ-
ently in Outline view from the way you view it in Print Layout view.

Working with Outlines
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 ✦ While Word is in Outline view, you can type new text or edit existing text 
just as you do in Print Layout view. You can also apply character for-
matting, such as bold or italic, and you can apply styles to paragraphs. 
However, it’s best not to apply direct paragraph formats, such as inden-
tation, tab stops, and alignment in Outline view, because you can’t see 
the results of those changes there. (They show up when you switch back 
to Print Layout view.)

 ✦ Outline view has its own set of keyboard shortcuts (which I summarize 
in Table 6-2) to help you move things along.

Table 6-1 Buttons in the Outline Tools Group

Button Button Name What It Does

Promote to Heading 1 Promotes selected text to 
Heading 1

Promote Promotes selected text to the 
next higher heading level

Outline Level Sets heading level of selected 
text

Demote Demotes selected text to next 
lower heading level

Demote to Body Text Demotes selected text to body 
text

Move Up Moves selected text up in out-
line

Move Down Moves selected text down in 
outline

Expand Expands selection

Collapse Collapses selection

Show Level Selects level to be shown

Show Text Formatting Shows or hides text formatting

Show First Line Only Displays only first line of each 
paragraph

Working with Outlines
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Table 6-2 Keyboard Shortcuts for Outline View

Keyboard Shortcut What It Does

Ctrl+Alt+O Switches to Outline view

Ctrl+Alt+P Switches back to Print Layout view

Ctrl+Alt+N Switches back to Draft view

Alt+Shift+A Collapses or expands all text

Alt+Shift+- (hyphen) Collapses the selection

Alt+Shift++ (plus) Expands the selection

Alt+Shift+1 Collapses or expands to Heading 1

Alt+Shift+(number) Collapses or expands to specified heading level

/ (on numeric keypad) Hides or shows formatting

Shift+Tab Promotes selection

Alt+Shift+← Promotes selection

Tab Demotes selection

Alt+Shift+→ Demotes the selection

Ctrl+Shift+N Demotes selection to body text

Alt+Shift+↑ Moves selection up, similar to cutting and pasting it

Alt+Shift+↓ Moves selection down, similar to cutting and pasting it

Showing and hiding formatting
Before you spend too much time working in Outline view, you may want 
to hide the formatting from the outline so that you can concentrate more 
closely on the document’s structure. Hiding the formatting in Outline view 
doesn’t remove the formatting from your text; it just temporarily hides it. 
The formatting in the outline shown in Figure 6-2 is hidden.

To show the text formatting in the outline, select the Show Text Formatting 
check box.

Keep these tips in mind when using the Show Text Formatting check box:

 ✦ To hide formatting, deselect the Show Text Formatting check box.

 ✦ You need no formatting to distinguish among heading levels because the 
headings are indented for you. I usually work in Outline view with for-
matting turned off.

 ✦ When you hide formatting, you’re doing just that — hiding it. You’re not 
removing it. When you deselect the Show Text Formatting check box or 
return to Print Layout or Draft view, all the formatting you so carefully 
applied to your document is restored.

Working with Outlines
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Figure 6-2: 
Hidden 
formatting.

 

Collapsing and expanding the outline
One main reason for working in Outline view rather than in Print Layout or 
Draft view is so that you can get a handle on the overall structure of your 
documents. The secret is in collapsing a document’s outline so that the por-
tions of your document you’re not interested in are hidden.

  The Outline Tools group includes a Show Level drop-down list that lets you 
collapse or expand the entire outline to a specific heading level. For exam-
ple, if you want to see just the top two heading levels (paragraphs formatted 
with the Heading 1 or Heading 2 style), select Level 2 in the Show Level drop-
down list. Figure 6-3 shows what the document from Figure 6-2 looks like 
when Level 2 is selected.

Here are some important features to note about working with collapsed text 
in Outline view:

 ✦ Some headings have fuzzy lines under them, to represent collapsed 
body text.

 ✦ Each heading in Outline view has a large plus sign or minus sign next to 
it. Headings with plus signs have other headings or body text subordi-
nate to them. Headings with minus signs do not.

Working with Outlines
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 You can double-click the plus and minus signs to show and hide text.

 ✦ If you’re good with keyboard shortcuts, keep in mind that pressing 
Alt+Shift+A quickly toggles between Show Level 9 and Show All Levels. 
This handy shortcut quickly shows or hides all body text in an outline.

 

Figure 6-3: 
Level 2 
view of an 
outline.

 

Promoting and demoting paragraphs
  To promote a paragraph means to move it up one level in the outline. If you 

promote a Heading 2 heading, it becomes a Heading 1 heading. You do this 
by placing the insertion point on the line you want to promote and clicking 
the Promote button in the Outline Tools group on the Outlining tab on the 
Ribbon. You can’t promote a Heading 1 paragraph; it’s already as high as it 
can get. If you promote a body text paragraph, it becomes a heading para-
graph at the same level as the heading it is subordinate to. Thus, if you pro-
mote a body text paragraph that follows a Heading 2, the body text 
paragraph becomes a Heading 2.

  To demote a paragraph is to move the paragraph down one level in the out-
line. You demote a paragraph by placing the insertion point on the line you 
want to demote and clicking the Demote button in the Outline Tools group 
on the Outlining tab on the Ribbon. If you demote a Heading 1 heading, it 
becomes a Heading 2 heading. Demote the heading again, and it becomes 
Heading 3. You cannot demote a body text paragraph, but you can demote 
any heading to a body text paragraph.

 

You can drag and drop collapsed sections in Outline view to rearrange them. 
The body text paragraphs that fall under the heading always go along for the 
ride. You don’t need to worry about losing a heading’s body text. 

Printing an outline
You can’t directly print an outline from Word. You can display the outline 
onscreen, and it seems like it might print, but when you print it, the entire 

Working with Outlines
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document prints, not just the Outline view. (Here’s a clue: when you choose 
File➪Print and check out the preview, it shows the entire document.) That’s 
because Word prints based on the document itself, not based on the view 
you are using.

Here’s a workaround: Generate a table of contents that includes all the head-
ing levels, and then print just the page(s) of the document that contain the 
TOC. See Chapter 1 of this book for information about TOC creation.

Working with Master Documents
Suppose that a great honor is bestowed on you: serving as the moderator 
of this year’s Neat Freaks Convention. As moderator, one of your jobs is 
assembling a little 1,200-page book titled Neat Freaks 2010: Proceedings of the 
Annual Neat Freaks Trade Show and Conference. Notable Neat Freaks from all 
across the globe will present papers, and your job is to assemble all these 
documents into one huge book. Fortunately for you, the International Neat 
Freak Association (INFA) has adopted Word 2010 as its standard word pro-
cessor, so each neat freak of note will send you a document on disk. All you 
have to do is combine the files into a single document and print it.

This job is definitely for Word’s Master Document feature. You can use it 
to create long documents by piecing them together from small documents. 
Master documents are all confusing and worth figuring out only if you have 
to do this sort of thing often. If you find yourself needing to read this part of 
the chapter, I offer my sincerest condolences.

 You probably shouldn’t tackle master documents until you have a good 
understanding of Word’s Outline view because the Master Document feature 
is sort of an advanced form of outlining.

Understanding the master document
A master document contains special links to other documents, which are 
subdocuments. If you’re putting together a book that consists of 30 chapters, 
for example, you probably won’t put the entire book into one document. 
Instead, you probably will create a separate document for each chapter. 
That’s all well and good, but you might want to print the whole thing with 
page numbers that begin at page 1 and run through the end of the book 
rather than restart at page 1 at the beginning of each chapter. Or, you might 
want to print a table of contents for the book or create an index.

That’s where master documents come in. Using a master document, you 
create each chapter as a separate document. Then you create a master doc-
ument for the entire book. In the master document, you create links to each 
of the chapters or subdocuments and format the text using the style defini-
tions in the master document rather than from the individual documents. 

Working with Master Documents
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This method provides consistent formatting for the entire final document. 
Then you can print the entire book, and Word takes care of numbering the 
pages for you. You can also create a table of contents or index in the master 
document, and the page numbers automatically adjust.

Word has a separate view for working with master documents (drum roll, 
please): Master Document view. This view is a variation of Outline view. In 
Master Document view, little icons indicate the portions of the master docu-
ments that are subdocuments. You can double-click one of these icons to 
open a subdocument in a separate window to edit it.

For the most part, you use Master Document view to create a new master 
document, to change the order in which individual subdocuments appear 
in the master document, or to add or remove subdocuments. If all you want 
to do is edit an individual chapter in your book, you just open the chapter 
document as you normally do, without worrying about it being a subdocu-
ment in a master document.

If you open a master document and switch to Draft view or Print Layout 
view, Word treats the master document and all its subdocuments as though 
they’re a part of one large document. You can scroll through the master 
document all the way to Chapter 12 and begin typing, for example, or you 
can choose File➪Print to print the entire book, or you can use the Replace 
button in the Editing group on the Home tab on the Ribbon to replace all 
occurrences of WordPerfect with Word throughout the entire document.

You can assemble a master document in three ways:

 ✦ From scratch: If you know that you need a master document beforehand, 
you can create the master document and all its subdocuments from 
scratch. This technique results in a master document and a collection of 
empty subdocuments, which you can then open and edit as you see fit. 
See the section “Whipping up a master document,” later in this chapter.

 ✦ By breaking up: If you get part of the way into a project and realize, 
“Hey! This document is way too long! I should have used a master docu-
ment,” it’s not too late. You can bust a big document into several smaller 
subdocuments. See the later section “Break it up!”

 ✦ By power of assembly: If you already have a bunch of Word documents 
that you want to assemble into a master document, you can create a 
master document by using the existing documents as the subdocu-
ments. See the section “Putting an existing file into a master document,” 
later in this chapter.

All this talk about master documents is confusing, I’m sure, but it makes 
more sense when you begin to use them. (I promise.) Just to muddy the 
waters a little more, the following list shows you some additional notes you 
need to know about master documents before I jump into the steps for creat-
ing and using them:

Working with Master Documents
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 ✦ In the master document, each subdocument is contained within its own 
section. Each subdocument, therefore, can have its own page layout and 
column arrangement and any of the other niceties that go along with 
being in your own section.

 ✦ When you click the Show Document button in the Master Document 
group on the Outlining tab on the Ribbon, the Master Document 
group expands to display additional buttons specially designed to 
work with master documents. Table 6-3 summarizes each button’s 
function.

 

✦ Basing the master document and all its subdocuments on the same 
template works best. Otherwise, trying to figure out which styles, 
macros, and other template goodies are available is a nightmare.

Table 6-3 Buttons in the Master Document Group

Button Name What It Does

Show Document Switches to Master Document view

Collapse/Expand 
Subdocuments

Acts as a toggle to collapse or 
expand a subdocument

Create Creates a new subdocument to be 
fleshed out later

Insert Inserts an existing file as a 
subdocument

Unlink Deletes the link to the selected 
subdocument

Merge Combines two subdocument files into 
one subdocument file

Split Splits a subdocument into two 
subdocuments

Lock Document Locks or unlocks a subdocument

You can open a subdocument in two ways. The first way is to open the 
master document. Word displays any subdocuments contained in the 
master document as hyperlinks. To open a subdocument, all you have 
to do is Ctrl+click the subdocument’s hyperlink. Alternatively, you can 
ignore the master document and open the subdocument file the way you 
open any other Word document: Choose File➪Open to browse for the 
document.

Working with Master Documents
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  If you have a network and more than one person is involved with the cre-
ation of your documents, Word keeps track of who owns which subdocu-
ment, based on the Author Name field of the subdocuments. Before you can 
edit a subdocument that someone else created, you must unlock it by click-
ing the Lock/Unlock Document button in the Master Document group on the 
Outlining tab on the Ribbon.

 

You can spread the master document and its subdocuments across different 
folders, and they can even live on different computers if you have a network. 
Life is much easier, however, if you create a separate folder for just the 
master document and all its subdocuments. If more than one person is work-
ing on the project, place this folder on a shared network hard drive so that 
everyone involved in the project can access it.

Whipping up a master document
If none of the documents you want to combine by using a master document 
are created yet, the best way to begin is to create the master document and 
all its subdocuments at the same time. Then you can open each subdocu-
ment individually to fill in the missing chapters of your book.

These steps show you the procedure for creating a master document and its 
subdocuments from scratch:

 1. Start Word if it isn’t already open and choose File➪New➪
Blank Document➪Create. Or, press Ctrl+N.

 2. On the View tab in the Document Views group, click the Outline button.

  The Outlining tab appears on the Ribbon. You can also open Outline 
view by clicking the Outline button in the lower-right corner of the 
status bar (it’s second to the left of the Zoom slider) or by pressing 
Ctrl+Alt+O.

 3. Click the Show Document button in the Master Document group on 
the Outlining tab.

  The Master Document group of the Outlining tab expands.

 4. Create a Heading 1 paragraph for the title of the master document.

  If you’re creating a book, for example, type the book’s title as a Heading 
1 paragraph.

 5. Create a Heading 2 paragraph for each subdocument you want to create.

  If each subdocument represents a chapter, type the chapter titles as 
Heading 2 paragraphs.

Working with Master Documents
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  Figure 6-4 shows an example of a master document with a Heading 1 
paragraph for the master document title and a Heading 2 paragraph for 
each subdocument title.

 

Figure 6-4: 
The outline 
for a master 
document.

 

 6. Select the Heading 2 paragraphs.

  Select them by dragging the mouse over them or by holding down the 
Shift key while you move the cursor with the arrow keys. Each Heading 
2 paragraph you select converts to a separate subdocument in the next 
step. (Make sure not to select any part of the Heading 1 paragraph at the 
beginning of the document.)

  7. Click the Create button in the Master Document group on the 
Outlining tab.

  Clicking this button tells Word to break the selected heading paragraphs 
into smaller subdocuments.

 8. Admire your handiwork.

  Figure 6-5 shows a document that’s been broken up. Notice how Word 
draws a box around each subdocument and adds a little subdocument 
icon in the upper-left corner of the box.

 9. Save the files by choosing File➪Save, pressing Ctrl+S, or clicking the 
Save button on the Quick Access toolbar.

  You have to provide the name and location of the master document. 
Word makes up names for all subdocuments, using the first heading 
paragraph if possible.

 10. You’re finished.

  Well, not quite. All you have is the outline of a book with a bunch of 
empty subdocuments. You still have to write the chapters!

Working with Master Documents
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Figure 6-5: 
All busted 
up.

 

Keep a few thoughts in mind when you’re creating a master document from 
scratch:

 ✦ You don’t have to use the Heading 1 style for the master document title 
and Heading 2 for the subdocument titles. But doing so makes sense. 
Word examines the text you selected before you click the Create button 
to find the first Heading paragraph. Then it creates a separate subdocu-
ment for each paragraph in the selected text that’s formatted with the 
same heading style as the first heading. If the first heading paragraph is 
formatted with the Heading 3 style, Word creates a separate subdocu-
ment for each Heading 3 paragraph. Most of the time, using Heading 1 
for the master document title and Heading 2 for each subdocument title 
makes sense. Alternatively, you can use the Title style for the document 
and then have Heading 1 paragraphs for each subdocument.

 ✦ The subdocuments aren’t saved until you save the master document. 
Then Word automatically saves all subdocuments in the same folder as 
the master document.

 ✦ After you create a subdocument, you can edit it by double-clicking the 
little subdocument icon next to the subdocument heading. This action 
opens the subdocument in a separate window and leaves the master 
document open in its own window, too. After you finish editing the sub-
document, save it and close the window to return to the master docu-
ment window.

Working with Master Documents
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 ✦ When you open an existing master document, subdocuments are shown 
as hyperlinks, as shown in Figure 6-6. Then, to edit a subdocument, 
press Ctrl while clicking the link to the subdocument you want to edit.

 

Figure 6-6: 
Hyperlinks.

 

Putting an existing file into a master document
If you (or your buddies) have already created a bunch of smaller files that 
you want to combine into one larger publication, you can plug each file 
into a master document as a subdocument. Then you can create a table of 
contents or an index for the whole publication or print the publication with 
uninterrupted page numbers.

Follow these steps to create a master document and insert existing docu-
ments into it as subdocuments:

 1. (Optional) Using the My Computer window or Windows Explorer, copy 
the various files you need into a single folder.

  This step isn’t strictly necessary; creating a master document from subdoc-
uments spread throughout your hard drive is acceptable. But life is simpler 
if the master document and all its subdocuments live together in harmony.

 2. Start Word if it isn’t already open and then choose File➪New➪
Blank Document➪Create or press Ctrl+N.

Working with Master Documents
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 3. On the View tab in the Document Views group, click the Outline 
button. Alternatively, press Ctrl+Alt+O.

  The Outlining tab shows up on the Ribbon. You can also open Outline 
view by clicking the Outline button in the lower-right corner of the 
status bar. The button is second to the left of the Zoom slider.

 4. Click the Insert button in the Master Document group on the 
Outlining tab.

  An Insert Subdocument dialog box appears. This dialog box is identical 
to the Open dialog box except for its name.

 5. Find the file you want to insert as a subdocument, choose it, and click 
Open.

  The file is inserted into the master document as a subdocument. Word 
creates section breaks before and after it.

 6. Repeat Steps 4 and 5 for any other subdocuments you want to insert.

 7. Save the master document by clicking the Save button on the Quick 
Access toolbar.

 8. You’re finished.

Here are a few points to ponder when you insert subdocuments into a 
master document:

 ✦ Inserting a subdocument doesn’t change the subdocument file’s name or 
folder location.

 ✦ When you click the Insert Subdocument button, the subdocument is 
inserted at the position of the insertion point. Make sure that the inser-
tion point is either at the beginning or end of the master document or 
between two previously inserted subdocuments. If the insertion point is 
within a subdocument when you click the Insert Subdocument button, 
the subdocument you select is inserted within the subdocument, not 
within the master document. If you’re not careful, you can create sub-
documents within subdocuments within subdocuments, kind of like 
those fancy Russian nesting dolls.

 The contents of the subdocument file don’t copy into the master document. 
Instead, a link to the subdocument file is created so that whenever you open 
the master document, you access the subdocument file also. You can still 
open the subdocument file separately, apart from the master document.

Break it up!
Sometimes a project just gets out of hand. It starts out as a half-page 
memo about where to keep spare pencils and ends up as a 300-page office-
procedures manual. You obviously wouldn’t use a master document for the 

Working with Master Documents
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half-page memo (unless you’re bored), but somewhere around page 100 
you might wish that you had. No problem! Just bust up the big document 
into two or more subdocuments.

Follow these steps to break a large document into smaller subdocuments:

 1. Open the document.

 2. On the View tab in the Document Views group, click the Outline 
button or press Ctrl+Alt+O to add the Outlining tab to the Ribbon.

 3. Change the headings to make each section of text that you want to 
become a subdocument begin with a Heading 2 style.

  The most logical thing is to format the document title as Heading 1 and 
each subdocument as Heading 2. You might have to use the Promote 
and Demote buttons to accomplish this task. The buttons are in the 
Outline Tools group on the Outlining tab on the Ribbon. Bother.

 4. Select the range of text you want to convert into subdocuments, begin-
ning with the heading for the first subdocument and ending with the 
last paragraph of the last subdocument.

  5. Click the Create button in the Master Document group on the 
Outlining tab on the Ribbon.

  Word breaks the document into smaller subdocuments based on the 
heading paragraphs and inserts section breaks before and after each 
subdocument.

 6. Save your work by using one of the many options (Quick Access tool-
bar, File➪Save, Ctrl+S, or whatever).

  Word saves the master document and all subdocuments. Word retains 
the name of the original file for the master document and makes up 
names for the subdocuments, using the text from the first heading in 
each subdocument if possible.

 7. You’re finished!

  Celebrate by taking the rest of the day off.

 

You can promote or demote all headings in a document by selecting the 
entire document (press Ctrl+A) and then clicking the Promote or Demote 
buttons in the Outline Tools group on the Outlining tab on the Ribbon.

 

One problem that people run into with master-subdocument relationships 
is that they put section formatting into the master document — you want all 
content placed in subdocuments and certainly no special formatting in the 
master document.

Working with Master Documents
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Numbering pages in subdocuments
When you use a master document, you can number all pages of your publi-
cation consecutively. In other words, the first page of a subdocument is one 
greater than the last page of the subdocument that precedes it.

These steps show you the procedure:

 1. Open the master document.

  You can work in Print Layout view or Outline view, but you have to be 
working with the master document, not with an individual subdocument.

 2. To add the page numbers to the header, click the Header button in 
the Header & Footer group on the Insert tab on the Ribbon and then 
select Edit Header from the drop-down list.

  Word temporarily switches to Page Layout view and adds the Header & 
Footer Tools Design contextual tab to the Ribbon.

  To add page numbers to the footer, choose the Edit Footer option from 
the drop-down list of the Footer button in the Header & Footer group on 
the Insert tab on the Ribbon.

 3. Format the header or footer to include a page number.

  Add or change whatever text you want to include in the header or 
footer. To add a page number, click the Page Number button in the 
Header & Footer group (located on the Header & Footer Tools Design 
contextual tab) and use the options in the drop-down list. Book III, 
Chapter 1 describes headers and footers in detail.

 4. Click the Close Header and Footer button in the Close group on the 
Header & Footer Tools Design contextual tab when you’re happy with 
the header or footer.

  Word returns you to Print Layout or Outline view.

 5. Print the master document and check its page numbers.

  Pretty cool, eh?

 

If you want each subdocument to begin on a new page, add a page break to 
the Heading 2 style’s Paragraph format (or whichever style you use for the 
title of each subdocument). You can find the Breaks drop-down list in the 
Page Setup group on the Page Layout tab on the Ribbon. 

Working with Master Documents

38_487662-bk06ch06.indd   41438_487662-bk06ch06.indd   414 4/15/10   9:15 PM4/15/10   9:15 PM



Book VII

Mailings

39_487662-pp07.indd   41539_487662-pp07.indd   415 4/15/10   9:15 PM4/15/10   9:15 PM



Contents at a Glance

Chapter 1: Creating Envelopes and Labels  . . . . . . . . . . . . . . . . . . . . . .417

Printing an Envelope ................................................................................... 417
Printing Labels ............................................................................................. 419
Creating Custom Labels .............................................................................. 422

Chapter 2: Faxing and E-Mailing Documents  . . . . . . . . . . . . . . . . . . . .425

Sending a Fax ................................................................................................ 425
Sending a Document via E-Mail .................................................................. 427

Chapter 3: Using the Mail Merge Wizard  . . . . . . . . . . . . . . . . . . . . . . .429

Understanding Mail Merge ......................................................................... 429
Using the Mail Merge Wizard ..................................................................... 430
Using the Mailings Tab on the Ribbon ...................................................... 440

Chapter 4: Advanced Mail-Merge Tricks  . . . . . . . . . . . . . . . . . . . . . . .443

Other Types of Merges ............................................................................... 443
Fun Things to Do with the Data Source .................................................... 449

39_487662-pp07.indd   41639_487662-pp07.indd   416 4/15/10   9:15 PM4/15/10   9:15 PM



Chapter 1: Creating Envelopes 
and Labels

In This Chapter
✓ Printing on envelopes

✓ Creating labels

✓ Printing return-address labels

✓ Creating a custom label for odd-size labels

Word has a sophisticated mail-merge feature that you can use to print 
envelopes, labels, and personalized letters from a list of recipient 

names.

That’s not what this chapter is about. If you want to find out how to do mail 
merges, skip to Chapter 3 of this minibook.

In this chapter, I show you how to use a few relatively simple features of 
Word 2010. The Envelopes and Labels commands let you create a single 
envelope or label or an entire page full of labels that are all the same.

Printing an Envelope
Word includes a special Envelopes command that can quickly and profes-
sionally print a mailing address (and your return address) on an envelope 
so that you can stuff your letter into it. You can send the envelope directly 
to your printer without ever creating a document, or you can add an enve-
lope to an existing document so that you can print your letter and envelope 
together.

To add an envelope to a letter you already created, open the letter (if it isn’t 
already open) and follow these steps:

  1. Open the Mailings tab on the Ribbon and then click the Envelopes 
button (shown in the margin) in the Create group.

  The Envelopes and Labels dialog box appears, as shown in Figure 1-1.
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Figure 1-1:

The 
Envelopes 
and Labels 
dialog box.

 

  If the current document contains an address, Word sniffs it out and 
stuffs it into the Delivery Address field automatically. So you might not 
need to enter the address. Sometimes Word gets lost and can’t find the 
address, so you have to type it yourself.

 

 If the Envelopes and Labels dialog box appears without the delivery 
address filled in, you can click Cancel to dismiss the dialog box. Then 
select the recipient’s address in the letter and click the Envelopes 
button again. This time, the address is filled in.

 2. If you want your return address to print on the label, type it in the 
Return Address text box.

 3. Click the Add to Document button to add the envelope to the letter.

  The envelope is added to your document as a separate page that 
appears before the first page of your letter.

When you print the letter, the envelope prints first. So you have to be prepared 
to insert an envelope into the printer. The exact steps for inserting an envelope 
depend on your printer. But most printers prompt you to insert an envelope 
when it wants to print one. Be an obedient printer user and do as you’re told.

 

To print an envelope directly without adding it to a document, click the Print 
button instead of the Add to Document button in Step 3. 

 

If your envelope prints upside down, you might need to configure Word so 
that it knows how your printer handles envelopes. From the Envelopes and 
Labels dialog box, click the Options button. When the Envelope Options 
dialog box appears, click the Printing Options tab to reveal the printing 
options, as shown in Figure 1-2. Then select the Feed Method options that 

Printing an Envelope
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correspond to the way your printer accepts envelopes. Click OK to dismiss 
this dialog box when you’re done. Word memorizes these options, so you 
have to set them only once.

 

Figure 1-2: 
The Printing 
Options 
tab of the 
Envelope 
Options 
dialog box.

 

Printing Labels
Word also lets you quickly print labels rather than envelopes. You can use 
labels in Word in three ways. You can print

 ✦ Just one label: You can even tell Word which label on a sheet of blank 
labels you should print. That way, you don’t have to waste an entire 
sheet of labels just to print one label.

 ✦ An entire sheet of the same label: This option is useful for printing 
return-address labels. I do this approximately once a year, when I send 
out a few hundred Christmas cards to my inner circle of close and dear 
friends.

 ✦ Labels from a database: This option is a mail-merge topic, so you have 
to skip to Chapters 3 and 4 of this minibook to find out more about how 
to do it.

Here are the steps for printing a full sheet of the same label:

 1. Get some labels.

  You can find a huge assortment of labels at your handy office supply 
store. Pick whichever ones you like, but make sure to get labels that 
work with your printer.

Printing Labels

40_487662-bk07ch01.indd   41940_487662-bk07ch01.indd   419 4/15/10   9:16 PM4/15/10   9:16 PM



420

 

 Word works best with Avery labels, but you can buy a cheaper brand, if 
you want. Most generic labels list the Avery equivalent on the package.

  2. Display the Mailings tab on the Ribbon and then click the Labels 
button (shown in the margin) in the Create group.

  The Envelopes and Labels dialog box, shown in Figure 1-3, appears.

 

Figure 1-3: 
The Labels 
tab of the 
Envelopes 
and Labels 
dialog box.

 

 3. Type the address you want to print in the label in the Address 
text box.

  Naturally, if you’re printing labels for something other than addresses 
(for example, name tags or file folders), you don’t actually type an 
address. Instead, type in this text box whatever you want to appear on 
each label.

 

 If you have stored your address in Word, you can mark the Use Return 
Address check box to transfer it automatically into the label. To store 
your address in Word, choose File➪Options➪Advanced and enter it in 
the Mailing Address box. This is handy if you want to create your own 
return address labels, for example.

 4. Make sure the right labels are selected.

  The label brand and model number appear in the lower-right corner 
of the dialog box, in the Label area. If this number doesn’t match the 
number you’re using, click the Options button and select the right label 
type from the Label Options dialog box, shown in Figure 1-4. Then click 
OK to return to the Envelopes and Labels dialog box.

Printing Labels
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Figure 1-4: 
Selecting 
the label 
type.

 

 5. Click New Document.

  A new document is created with an entire page of labels, all lined up in a 
nice table.

 6. (Optional) If you want to format the labels differently, press Ctrl+A to 
select the entire document and then apply any formatting you want 
to use.

  For example, you might want to change the font and size to make your 
text fit better in the space available in the label.

 7. Insert a sheet of labels in the printer.

 

 Be sure to insert the label with the correct orientation. If you’re not 
sure, try this time-honored trick: Draw an arrow on a plain sheet of 
paper indicating the direction in which you feed the paper, and then test 
print the labels on that page. When the page comes out of the printer, 
make a note of whether labels print on the same side of the page as 
the arrow or on the opposite side. That helps you determine whether 
to insert the labels face up or face down. (Printing a test page on plain 
paper is a good idea before using a sheet of labels anyway.)

 8. Choose File➪Print and then click the Print button to print the labels.

  That’s it; you’re done.

 

To print a single label, select the Single Label option button after Step 4, and 
then use the Row and Column controls to specify which label on the page 
you want to print. For example, to print on the first label in the upper-left 
corner of a sheet of labels, choose Row 1 and Column 1. Then click Print 
to print the label. (You can’t generate a new document, as in Step 5, when 
printing only a single label.)

To send the label or labels directly to the printer rather than to a document, 
click Print instead of New Document in Step 5.

Printing Labels
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Creating Custom Labels
If your labels don’t appear in the list of predefined labels, you have to create 
a custom label format. To do so, select a label type that’s close in size to the 
labels you want to create and click the New Label button in the Label Options 
dialog box. The Label Details dialog box appears, as shown in Figure 1-5.

 

Figure 1-5: 
The Label 
Details 
dialog box.

 

To set up your custom label, enter appropriate values for each of the fields 
in this dialog box:

 ✦ Label Name: The name for your custom label type.

 ✦ Top Margin: The distance between the top of the sheet and the top of 
the first label.

 ✦ Side Margin: The distance between the left edge of the sheet and the left 
edge of the first margin.

 ✦ Vertical Pitch: The distance between the top of one label and the top of 
the label beneath it.

 ✦ Horizontal Pitch: The distance between the left edge of one label and 
the left edge of the label to its right.

 ✦ Label Height: The height of each label.

 ✦ Label Width: The width of each label.

 ✦ Number Across: The number of labels in each row.

 ✦ Number Down: The number of labels in each column.

Creating Custom Labels
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 ✦ Page Size: The size of each sheet of labels, usually 81⁄2 x 11 inches.

 ✦ Page Width: The width of the label paper on which you are printing. 
This will be different than the label width if there are multiple labels 
per row.

 ✦ Page Height: The height of the label paper on which you are printing. 
This will be different than the label height if there are multiple labels 
per column.

 As you change these values, the diagram in the Preview window changes to 
reflect the settings you enter. When you’re satisfied with the layout, click OK 
two times to return to the Envelopes and Labels dialog box and then print 
your labels. Word asks whether you’re sure you want to change the label 
format; click Yes to proceed.

Creating Custom Labels
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Chapter 2: Faxing and E-Mailing 
Documents

In This Chapter
✓ Faxing a document the old-fashioned way

✓ Faxing a document with an Internet fax service

✓ Sending a document via e-mail

✓ Sending a document as an e-mail attachment

This chapter covers two features in Word that let you send documents to 
other people. First you find out how to send a Word document as a fax 

to anyone who has a fax machine. Then you discover how to e-mail a Word 
document directly to anyone who has an e-mail address.

Given the choice, e-mailing a document is usually the better solution: The 
user who receives a document via fax gets a pile of paper, crudely printed on 
a low-resolution fax machine. But if you e-mail the document, the recipient 
gets an actual copy of your Word document file, which she can then save to 
disk, print, and perhaps even modify and send back. The choice is yours.

Sending a Fax
Betcha didn’t know that the first patent for a workable fax machine was issued 
in England in 1843, and that by the 1920s, AT&T offered a fax service that could 
send copies of photographs over telephone lines for use in newspapers.

Faxing is obviously a fairly old technology. And Word has supported docu-
ment faxing almost from the beginning. You can fax a Word document in 
three basic ways:

 ✦ Print and fax the document. The easiest way is to print the document 
and then use a separate fax machine to send the fax. I know it doesn’t 
sound elegant, but if you send only occasional faxes and you have a fax 
machine at your disposal, this technique saves you the hassle of figur-
ing out how to deal with Word’s built-in faxing features.
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 ✦ Use a fax modem. If you have a fax modem installed in your computer 
and the modem is plugged in to a telephone line, you can send the docu-
ment to a fax recipient by printing the document, specifying “Fax” as the 
printer name. I describe this technique in the upcoming section “Using a 
fax modem.”

 ✦ Use a fax service. If you have no fax modem but have a connection to 
the Internet, you can send a fax by using one of the many Internet-based 
faxing services. For more information, see the section “Using a fax ser-
vice,” later in this chapter.

Using a fax modem
To send a fax by using a built-in fax modem, you must properly install the 
modem in your computer and plug it in to a phone line. In addition, your com-
puter must have Windows Fax and Scan (Windows Vista or 7) or Windows Fax 
Services (Windows XP) installed. Either of those services installs a fax driver 
as a printer. You then “print” to that driver to send the fax.

Windows Vista and Windows 7 (Business and Ultimate editions) come with 
Windows Fax and Scan preinstalled. If Windows Fax and Scan is not installed, 
you probably have the Home or Basic edition of Windows, which doesn’t 
include it. Not sure? Click Start and then type fax; if you have the program, 
it appears at the top of the start menu. You can also check the Devices and 
Printers folder (from the Control Panel) to see if a fax driver is installed.

In Windows XP, you need Windows Fax Services, which may or may not 
already be installed. If it isn’t, choose Start➪Control Panel to open the 
Control Panel folder. Double-click the Add/Remove Programs icon and then 
click Add/Remove Windows Components. When the Windows Components 
Wizard appears, select Fax Services, click Next, and follow any other instruc-
tions Windows throws in your face.

To send a document by using your fax modem, after ensuring that you have 
some faxing software available as just described, follow these steps:

 1. Open the document you want to send.

 2. Choose File➪Print. 

  The Print page of Backstage view appears.

 3. Select Fax from the drop-down list of printers.

 4. Follow the prompts that appear to send the fax.

  The prompts are different depending on your Windows version and 
whether you have faxed something before (and therefore gone through 
the fax setup process).
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427Sending a Document via E-Mail

Using a fax service
If you don’t have a fax modem installed on your computer but do have an 
Internet connection, you can use an Internet faxing service to send a fax. 
Unfortunately, these services aren’t free. Fees range from $5 to $20 or more 
per month, depending on the features you sign up for. In addition, you must 
have Outlook installed on your computer to use a fax service.

To send a document via a fax service, choose File➪Save and Send➪Send 
Using E-Mail➪Send as Internet Fax. The first time you do this, a dialog box 
appears, telling you that you have to first sign up for a faxing service. When 
you click OK, Word launches an Internet Explorer window that opens a 
Microsoft Web page that lists Internet fax services. You can then follow the 
links to sign up for a service.

After you properly sign up, choosing File➪Save and Send➪Send Using 
E-Mail➪Send as Internet Fax adds a special header at the top of the docu-
ment that lets you specify the subject and recipient information. Fill in this 
information and then click Send to send your fax.

Sending a Document via E-Mail
If your computer is connected to a network or to the Internet, you can send 
a copy of the document you’re working on to a friend or coworker via e-mail. 
Start by clicking the File tab and then choosing Save and Send➪Send Using 
Email. This action displays the e-mail options shown in Figure 2-1.

As you can see, the Send Using E-mail command gives you five options for 
sending the document as an e-mail:

 ✦ Send as Attachment: Creates an e-mail message with the saved copy of 
the document attached.

 ✦ Send a Link: Creates an e-mail message with a link to the document. 
Note that this option is available only if you have first saved the docu-
ment to a Web server.

 ✦ Send as PDF: Saves a PDF version of the document and then creates an 
e-mail with the PDF copy attached.

 ✦ Send as XPS: Saves an XPS version of the document and then creates an 
e-mail with the XPS copy attached. (The XPS document format is similar 
to PDF, but not as widely used.)

 ✦ Send as Internet Fax: If you have a service set up, sends the document 
to that service for faxing. Otherwise, it opens a Web page from which 
you can browse and sign up for a service.
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Figure 2-1: 
Five ways 
to send an 
e-mail in 
Word 2010.
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Chapter 3: Using the Mail 
Merge Wizard

In This Chapter
✓ Understanding how mail merge works

✓ Getting started with the Mail Merge Wizard

✓ Following the Mail Merge Wizard’s instructions

✓ Working with the Mailings tab

Mail merge. Just the sound of those two words is enough to drive even 
veteran Word users into a state of utter and complete panic. Just 

when you think that you’ve figured out enough about mail merge to put out 
a simple form letter, along comes Word with a bunch of additional mail-
merge features. Arghhhh! What next?

This chapter shows you how to use Word’s Mail Merge Wizard to perform 
basic mail merges. After you master the basics, you might also want to read 
the next chapter, which presents some more advanced mail-merge features 
that come in handy from time to time.

Understanding Mail Merge
Mail merge refers to the process of merging a file that contains a list of 
names and addresses with another file that contains a model letter to pro-
duce a bunch of personalized form letters. Suppose that you decide to do 
some volunteer work for the local public library and the library decides 
to put you in charge of getting deadbeats to return long overdue books. A 
personalized letter is the ideal way to communicate your message to these 
good-for-nothings. And Word’s mail-merge feature is ideal for preparing this 
type of personalized letter.

The beauty of the whole thing is that you can keep the names and addresses 
in a separate file and use them again. After all, you know that these same 
people will probably have overdue books again soon.

Mail merge involves three basic steps:
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 1. Create the main document.

  The main document contains the letter you want to send. It includes the 
text that’s printed for each letter plus special merge fields that indicate 
exactly where to place in each letter the information from your mailing 
list, such as the recipient’s name and address.

 2. Create the data source.

  The data source is just a fancy name for the list of names and addresses 
that’s used to create the form letters. The data source can be a Word 
document, in which case the information is stored in a table, with 
one row for each name and address. Individual fields, such as name, 
address, city, state, and zip code are stored in separate columns. Or, the 
data source can be a list of contacts maintained by Outlook, a database 
created by a program such as Access, or another type of file. The data 
source must list the data in a consistent format.

 3. Merge the main document with the data source.

  This step creates a form letter for each row in the data source table. You 
can create the form letters as a separate document, with one letter on 
each page, or send the merged letters directly to the printer. You can 
also send the merged letters to e-mail or to a fax machine.

 

You can use mail merge to produce more than form letters. You can also use 
it to print envelopes or mailing labels or even documents that have noth-
ing to do with mailing, such as a directory or a catalog. In short, mail merge 
is useful for any application in which a list of consistently formatted and 
repeating data must be converted into a document in which each record in 
the data source is formatted in a similar way.

Using the Mail Merge Wizard
To start the Mail Merge Wizard, first create a new, blank document or open 
an existing letter. Then click the Mailings tab on the Ribbon, click Start Mail 
Merge in the Start Mail Merge group, and choose Step By Step Mail Merge 
Wizard from the menu that appears. The wizard appears in the task pane on 
the right side of the document window, as shown in Figure 3-1.

After you open the wizard, you can follow the steps I outline in the following 
sections.

Creating the main document
The first mail-merge task the wizard helps you accomplish is setting up your 
main document. Here are the steps:

 1. Select the type of documents you want to create for your mailing.

Using the Mail Merge Wizard
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  The choices are

 • Letters

 • E-Mail Messages

 • Envelopes

 • Labels

 • Directory

  For normal, run-of-the-mill mass mailings, select Letters.

 2. Click Next at the bottom of the Mail Merge Wizard.

  Step 2 of the Mail Merge Wizard appears, as shown in Figure 3-2.

 3. Click the Use the Current Document option, if it isn’t already selected.

  If you prefer to start a new document based on a template rather than 
use the current document, choose Start from a Template. Then click the 
Select Template link and select the template you want to use.

 4. Type the body of your letter.

  Leave out the address block and greeting line. You will add them later.

 5. Choose File➪Save to save the file when you’re done.

  Your letter looks something like the one shown in Figure 3-3.

 

Figure 3-1: 
The Mail 
Merge 
Wizard in 
action.

 

Using the Mail Merge Wizard
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Figure 3-2: 
Select the 
starting 
document.

 

 

Figure 3-3: 
A letter 
ready to use 
as a main 
document.

 

Using the Mail Merge Wizard
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Creating an address list
The next big step in the Mail Merge Wizard is to select the recipients who 
will receive your letters. This step is usually the hardest part of the entire 
procedure because it often involves creating an address list with the names 
and addresses of your recipients. Here are the bothersome steps:

 1. If you haven’t already done so, click Next at the bottom of the wizard 
to proceed to the Select Recipients step.

  Step 3 of the wizard makes its appearance, as shown in Figure 3-4.

 

 If you already created the address list, you can open it by selecting the 
Use an Existing List option instead of the Type a New List option. Then 
click Browse. When the Select Data Source dialog box appears, locate 
the file you previously saved as the address list and click Open. Then the 
Mail Merge Recipients dialog box appears and you can skip to Step 8.

  You can also use data from Outlook or from an Access database. To use 
names and addresses from Outlook, choose the Select from Outlook 
Contacts option in Step 2 and then click Choose Contacts Folder. To use 
an Access database (or any other database), select Use an Existing List 
in Step 2, click the Browse button, and then locate the database in the 
dialog box that appears.

 

Figure 3-4:

Select 
the lucky 
recipients.

 

Using the Mail Merge Wizard
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 2. Select the Type a New List radio button and then click the Create link.

  The New Address List dialog box appears, shown in Figure 3-5.

 

Figure 3-5: 
The New 
Address List 
dialog box.

 

 3. Type the information for a person you want to add to the address list.

  Press Tab to move from field to field or to skip over fields in which you 
don’t want to enter any data. (You don’t need to enter a value for every 
field.)

 4. After you type all the data for the person, click the New Entry button 
to add that person’s data to the address list.

 5. Repeat Steps 3 and 4 for each person you want to add to the data 
source.

  To delete a record, move to the record that you want to delete and then 
click the Delete Entry button.

 6. After you add all the names you want, click OK.

  A Save Address List dialog box appears.

 7. Type a name for your address list and then click Save.

  The file is saved to your computer’s hard drive. Then the Mail Merge 
Recipients dialog box appears, as shown in Figure 3-6.

 

 From the Mail Merge Recipients dialog box, you can edit the records 
in the data source by selecting the data source in the Data Source list 
(in the lower-left corner of the dialog box) and then clicking the Edit 
button.

Using the Mail Merge Wizard
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Figure 3-6: 
The Mail 
Merge 
Recipients 
dialog box.

 

 8. Click the column heading for the column you want to sort the list by.

  For example, if you want the letters to print in zip code sequence, click 
the heading for the Zip Code column. (You have to scroll the list to the 
right to see the Zip Code column.)

 9. Deselect any records that you don’t want to include in the mailing.

  The mailing will be sent to every record that’s selected, and the records 
are all initially selected, so you can manually remove people from the 
list by deselecting them.

  If the mailing will be sent to only a few people on the list, click the Clear 
All button to remove all check marks. Then review the list and select the 
ones you want to send the mailing to.

Inserting the address block and greeting line
After you add names and addresses to the data source, finish your letter by 
adding placeholders for the address block, greeting line, and any other infor-
mation you want to insert from the address list. In Wordspeak, these place-
holders are merge fields.

Display the main document (your letter) and then follow these steps:

 1. Click Next at the bottom of the wizard to bring up Step 4 of the 
wizard.

  As the Mail Merge Wizard in Figure 3-7 shows, this step allows you to 
add the address block and other merge fields to your letter.

Using the Mail Merge Wizard
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Figure 3-7: 
Completing 
the letter.

 

 2. Position the insertion point where you want to insert the address block.

 3. Click the Address Block link in the Mail Merge Wizard.

  The Insert Address Block dialog box appears, as shown in Figure 3-8.

 

Figure 3-8: 
The Insert 
Address 
Block 
dialog box.

 

 4. Select the options you want to use for the address block and then 
click OK.

  You can select the format to use for the recipient’s name and whether 
to use the company name and country and region information in the 
address.

Using the Mail Merge Wizard
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  If one of the fields is missing from the sample, such as State, click Match 
Fields and make sure that Word is matching up the fields from the data 
source correctly with the fields for the address block.

  When you click OK, the Insert Address Block dialog box is dismissed and 
the address block is inserted.

 5. Position the insertion point where you want to insert the greeting line 
and click the Greeting Line link in the Mail Merge Wizard.

  The Insert Greeting Line dialog box appears, as shown in Figure 3-9.

 

Figure 3-9: 
The Insert 
Greeting 
Line dialog 
box.

 

 6. Select the options you want to use for the greeting line and then click OK.

  The Insert Greeting Line dialog box lets you select several options for 
creating casual or formal greeting lines. When you click OK, the greeting 
line is inserted into the document.

 7. If you want to insert a field from the address list into the body of the 
letter, move the insertion point to where you want to insert the field 
and click the More Items link in the Mail Merge Wizard.

  The Insert Merge Field dialog box opens, as shown in Figure 3-10.

 

Figure 3-10: 
The Insert 
Merge Field 
dialog box.

 

Using the Mail Merge Wizard
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 8. Select the field you want to insert and click Insert.

  The field is inserted into the document. The Insert Merge Field dialog box 
remains onscreen so that you can insert other fields, if you’re so inclined.

 9. Repeat Step 8 for any other fields you want to insert and then click 
Close.

  When you click Close, the Insert Merge Field dialog box is dismissed.

Figure 3-11 shows how a letter appears after you insert the Address Block, 
and First and Last Name fields in the body of the document. Notice that 
merge fields display within special chevron characters — for example, 
«AddressBlock» and «First_Name».

 

Figure 3-11: 
A letter 
with fields 
inserted.

 

Merging the documents
After you set up the main document and the address list, you’re ready for 
the show. Follow these simple steps to merge the main document with the 
data source to produce form letters:

 1. Click Next for the next step of the wizard — Preview Your Letters.

  The first letter in your mail merge appears onscreen, as shown in 
Figure 3-12.

Using the Mail Merge Wizard
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 If there is extra vertical space in the address block, there are a couple of 
workarounds. One is to go back and insert individual fields instead of 
the «Address Block» code, and press Shift+Enter instead of Enter to end 
each line of the address. Another is to choose Home➪Change Styles➪
Style Set➪Word 2003 to switch to a style set that does not include the 
extra spacing.

 

Figure 3-12: 
Previewing 
the mail 
merge.

 

 2. Review each letter in the merge.

  You can click the >> or << button in the Mail Merge Wizard to move for-
ward or backward through the letters. If you find a mistake in a name or 
address, correct the mistake directly on the letter.

  If you find a letter that you don’t want to include, click the Exclude This 
Recipient button in the wizard.

  If you review the first few letters and they look okay, you can skip ahead 
to the next step without reviewing them all.

 3. After you review the entire mailing, click Next at the bottom of the 
wizard.

  The final step of the wizard appears, as shown in Figure 3-13.

Using the Mail Merge Wizard
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Figure 3-13: 
Completing 
the mail 
merge.

 

 4. Click the Print link to print your letters or click the Edit Individual 
Letters link to merge the letters to a new document.

 

 If you click Edit Individual Letters, the merged letters move to a new 
document, which you can then edit and save.

Using the Mailings Tab on the Ribbon
If you’re an experienced mail-merge user, you can save time by skipping the 
Mail Merge Wizard and just using the controls on the Mailings tab on the 
Ribbon to complete your mail-merge tasks. Table 3-1 lists the Mailings tab 
controls used to complete a mail merge. In general, you use these buttons in 
sequence from left to right to complete a mail merge.

Table 3-1 Controls on the Mailings Tab

Button Name What You Can Do with It

Start Mail 
Merge

Choose Letters, E-Mail Messages, Envelopes, 
Labels, or a Directory for the main document type, 
and start the Mail Merge Wizard

Using the Mailings Tab on the Ribbon
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Button Name What You Can Do with It

Select 
Recipients

Select the data source by typing a new list, select-
ing an existing list, or using Outlook contacts

Edit Recipient 
List

Edit the recipient list and select which recipients 
in the list to include in the merge

Highlight 
Merge Fields

Highlight the merge fields in the merge document 
so that they’re easy to spot

Address 
Block

Insert an address block

Greeting Line Insert a greeting line

Insert Merge 
Field

Insert a merge field, which lets you add more 
information from the data source

Rules Add more fields that control which records to 
include in the merge field

Match Fields Specify which fields in a database to use for 
certain mail-merge functions

Update 
Labels

Copy the contents of the first label on the page to 
all subsequent labels

Preview 
Results

Preview the merge operation

First Record Move to the first record in the data source

Previous 
Record

Move to the previous record in the data source

Next Record Move to the next record in the data source

Last Record Move to the last record in the data source

Find 
Recipient

Search for records

Auto Check 
for Errors

Check for merge errors

Finish & 
Merge

Merge the main document and data source

Using the Mailings Tab on the Ribbon
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Chapter 4: Advanced 
Mail-Merge Tricks

In This Chapter
✓ Doing an e-mail merge

✓ Printing envelopes or labels from an address list

✓ Creating a directory

✓ Sorting and filtering data

✓ Pondering a computer science lesson that tastes like chicken

✓ Eliminating duplicate records

This chapter covers some of the more interesting things you can do with 
Word’s mail-merge feature, such as print mailing labels, choose only 

certain names to print letters for, use data from sources other than Word, 
and create an address directory.

 This chapter assumes that you already know the basics of performing a mail 
merge. If you’re completely new to the topic, stop where you are. Back up 
very slowly, make no sudden moves, and read Chapter 3 of this minibook. 
Only after that should you return to this chapter.

Other Types of Merges
Although creating form letters is the most popular use for mail merge, the 
Mail Merge Wizard can also send e-mail, create personalized envelopes, 
print address labels, and even create a directory. The following sections 
show you how to do all these tasks.

Merging to e-mail
If you want to send your letters by e-mail rather than by snail mail, you can 
use the Mail Merge Wizard to merge your letters and then send them to 
e-mail addresses rather than print them. For this merge to work, your com-
puter must have an e-mail program such as Microsoft Outlook installed.

 Don’t be a spammer! You should send e-mail merges only to people you 
know or to customers you’ve done business with and who have agreed to 
let you send them e-mail.
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All you have to do is select E-Mail Messages rather than Letters as the docu-
ment type in the first step of the Mail Merge Wizard. Then you follow the 
normal steps for using the Mail Merge Wizard as I describe in Chapter 3 of 
this minibook, until you reach the last step. Rather than have the normal 
choices (Print and Edit Individual Letters), you have only one choice: 
Electronic Mail. Click this link to summon the Merge to E-Mail dialog box, 
shown in Figure 4-1.

 

Figure 4-1: 
The Merge 
to E-Mail 
dialog box.

 

Use this dialog box to specify the options you want to use for the e-mail 
merge. The options are

 ✦ To: Use this drop-down list to choose the field in the data source that 
contains the recipients’ e-mail addresses.

 ✦ Subject Line: Type the subject line you want to appear in the e-mail 
messages.

  Unfortunately, Word doesn’t let you personalize the subject line for 
each recipient. Each recipient in your mailing sees exactly the same 
subject line.

 ✦ Mail Format: This drop-down list lets you select one of three ways 
to send e-mail. You can format messages as Plain Text, HTML, or 
Attachments. Choose HTML if you applied text formats or included 
images in the message. Otherwise, choose Plain Text.

 ✦ Send Records: Use these radio buttons to choose whether to send 
messages to all recipients in the merge, just the current recipient, or a 
range of recipients.

Merging envelopes
Ever spend 30 minutes printing 50 personalized letters by using mail merge 
and then another 30 minutes hand-addressing envelopes? Never again! Word 
can easily transform a mail-merge address list into a set of nicely printed 
envelopes.

Other Types of Merges
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For business mail, a good alternative to printing addresses on envelopes is 
to simply use window envelopes. That way, the address on the letters inside 
the envelope shows through the window. This feature has two advantages:

 ✦ You don’t have to mess around with printing envelopes.

 ✦ You eliminate the risk of mixing the letters and envelopes and inadver-
tently sending Mr. Smith’s overdue notice to Mr. Jones.

If you still insist on merging envelopes, follow the normal Mail Merge Wizard 
procedure, with these variations:

 ✦ In Step 1 of the Mail Merge Wizard: Select the Envelopes option rather 
than Letters as the document type.

 ✦ In Step 2 of the Mail Merge Wizard: Click Envelope Options to open the 
Envelope Options dialog box, shown in Figure 4-2. Use this dialog box to 
select the envelope size and to format the font used for the delivery and 
return addresses. You can also click the Printing Options tab to adjust 
Word’s envelope layout to match the way envelopes feed into your par-
ticular printer. You might need to fiddle with these settings in case your 
envelopes print upside down or on the wrong side.

 

Figure 4-2: 
The 
Envelope 
Options 
dialog box.

 

 ✦ In Step 4 of the Mail Merge Wizard: Click in the recipient’s address area 
in the center of the envelope and then click the Address Block link to 
insert a standard address block. Then click in the return address area 
in the upper-left corner of the envelope and type your return address 
(unless it already appears there, or unless you are using preprinted 
envelopes). Figure 4-3 shows how the envelope appears when it has 
been set up properly.

Other Types of Merges
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Figure 4-3: 
An envelope 
all ready to 
be merged.

 

  You can also use this step of the Mail Merge Wizard to add a postal bar 
code to the envelope. And, if you subscribe to an electronic postage ser-
vice such as Stamps.com, you can print e-postage directly on the enve-
lope so that you don’t have to use stamps.

 

 The postal bar code isn’t a secret password that gets you into pubs 
where mail carriers hang out — it’s a bar code that speeds mail delivery. 
If you do bulk mailing and have the proper permits, using this bar code 
can earn postage discounts. 

You can complete the rest of the Mail Merge Wizard steps as you do for a 
printed letter.

Merging to labels
If you want to create mailing labels instead of envelopes, choose Labels as 
the document type in the first step of the Mail Merge Wizard. Then follow 
the normal Mail Merge Wizard steps, with these exceptions:

 ✦ In Step 2 of the wizard, click Label Options to open the Label Options 
dialog box, shown in Figure 4-4. Use this dialog box to specify the type 
of labels you’re using.

Other Types of Merges

43_487662-bk07ch04.indd   44643_487662-bk07ch04.indd   446 4/15/10   9:16 PM4/15/10   9:16 PM



Book VII

Chapter 4

A
d

va
n

c
e

d
 M

a
il-

M
e

rg
e

 T
ric

k
s

447

 

Figure 4-4: 
The Label 
Options 
dialog box.

 

 ✦ In Step 4 of the wizard, you format the labels. To do that, click in the 
first label and then click the Address Block link to insert an address 
block in the label. If you want, change the font or size of the address 
block. Then click the Update All Labels button at the bottom of the Mail 
Merge Wizard. The contents of the first label are copied to all other 
labels on the page. A Next Record field appears in each label except the 
first, to tell Word to skip to the next recipient. When you’re done, your 
main document resembles Figure 4-5.

 

Figure 4-5: 
A label main 
document.

 

Other Types of Merges
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You can complete the rest of the Mail Merge Wizard in the usual way.

 

If the addresses don’t fit properly in the labels, first ensure that you selected 
the correct label type in the Label Options dialog box. If the labels are cor-
rect and the addresses still don’t fit, return to Step 4 and try reducing the 
font size for the address block. You can do this by changing the size for the 
first label. Then click the Update All Labels button to propagate the change 
to all other labels.

Creating a directory
You can use the Mail Merge Wizard to create a directory that lists all addresses 
in a data source by choosing Directory as the document type in Step 1 of the 
wizard. Then follow the wizard’s normal steps with these variations:

 ✦ In Step 4, add the merge fields you want to appear for each item in the 
directory. For a simple address listing, you can just click the Address 
Block link. Or, you can create a more customized directory by clicking 
the More Items link to open the Insert Merge Field dialog box, shown in 
Figure 4-6.

 

Figure 4-6: 
The Insert 
Merge Field 
dialog box.

 

  For example, here’s one way to format an address listing that lists 
people in alphabetical order, with last name first:

«LastName», «FirstName»
    «Address_Line_1»
    «Address_Line_2»
    «City», «State» «ZIP_Code»
    «HomePhone»

 ✦ When the preview of the document appears in Step 5, only the first record 
is shown. Don’t panic. All records appear when you complete the merge.

 ✦ In Step 6, click the To New Document link. A new document is created 
for your directory. Then choose File➪Save to save the directory to a file.

Other Types of Merges
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Fun Things to Do with the Data Source
Mail merge is useful enough if all you do with the data source is store names 
and addresses. But Word data sources have more tricks up their sleeves 
than meet the eye. With a little chutzpah and a bit of wrestling with the 
dialog boxes, you can do several cute and moderately useful tricks with the 
data source. The following sections explain these amazing feats.

Sorting records
Suppose that you enter all names in whatever sequence they were sitting in 
the pile but you want to print the letters in alphabetical order. No problem! 
Just sort the data source.

Sorting is controlled from the Sort Records tab in the Filter and Sort dialog 
box. To open this dialog box and sort your merge records, follow these 
steps:

 1. Start a mail merge as usual. In Step 3 of the Mail Merge Wizard, click 
Edit Recipient List.

  The dialog box that opens lets you edit recipient addresses, as shown in 
Figure 4-7.

 

Figure 4-7: 
Editing the 
recipient 
list.

 

 2. Click the Sort link.

  The Filter and Sort dialog box opens, as shown in Figure 4-8.

Fun Things to Do with the Data Source
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Figure 4-8: 
Sorting the 
recipient 
list.

 

 3. From the Sort By drop-down list, select the merge field by which you 
want to sort the data source.

  Click the down arrow in the Sort By drop-down list to reveal a list of all 
merge fields in the data source and then select the one by which you want 
to sort the data. (In Figure 4-8, I chose Last Name for the first sort field.)

 

 If you want to sort records in reverse order, select the appropriate 
Descending option. Records are then sorted on that field in reverse 
order, beginning with the z’s and working back up to the a’s.

 4. If you want a second or third sort field, set them in the two Then By 
fields.

  The Then By field is used as a tiebreaker when two or more records 
have the same main Sort By field. For example, in Figure 4-8, I chose First 
Name as the second sort field. Then if the data source has more than 
one record with the same Last Name, they sort into sequence by their 
first names, like this:

King   Larry
King   Martin Luther
King   Stephen

  If you have a third field you can use as a tiebreaker, set it in the next 
Then By field.

 5. Click OK twice.

  You return to the Mail Merge Wizard.

 6. Finish the merge.

  Your letters (or envelopes or labels or whatever) now print in the 
proper sequence.

Filtering records
Filtering lets you automatically select certain names from your database 
based on arbitrary criteria. For example, you might want to send letters only 
to bald-headed starship captains of French descent. Sending letters to this 

Fun Things to Do with the Data Source
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group is possible if you have fields in your data source for Starfleet rank, 
degree of baldness, and country of origin.

 

Unlike the filters in your car, mail merge filters don’t fill up with gunk, so 
you don’t have to change them every 5,000 miles. You do have to be care-
ful about how you set them up, though, to be sure that they choose just the 
records you want to include in your mail merge.

To mail letters to only a lucky few recipients, follow these steps:

 1. Start a mail merge as usual. When you reach Step 3 of the Mail Merge 
Wizard, click Edit Recipient List.

  The Mail Merge Recipients dialog box appears. (If you already have chosen 
a recipient list, click Edit Recipient List to summon this dialog box.)

 2. Click the Filter link.

  The dialog box shown in Figure 4-9 appears.

 

Figure 4-9: 
Filtering the 
recipient 
list.

 

 3. Set the criteria for including records in the mail merge by specifying a 
Field, Comparison, and Compare To value for each criteria.

  To create a letter only for people who live in the 93711 zip code, for 
example, set the first Field to Zip Code, the first Comparison to Equal To, 
and the Compare To field to 93711. This filter means that the mail merge 
includes only the records whose Zip Code field is equal to 93711. (That’s 
how the filter shown in Figure 4-9 is set up.)

  The following section contains an explanation of the options in the 
Comparison fields.

 4. Click OK twice.

  You return to the Mail Merge Wizard.

 5. Finish the mail merge.

  Now only the records that match the filter criteria are included in the 
merge.

Fun Things to Do with the Data Source
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Understanding relationships
You can set up ten different kinds of tests in the Comparison fields. 
Computerniks call these tests relational tests because they test the relationship 
between two items (in this case, a merge field and a specific value). You can use 
the following relational tests to create different kinds of selection filters:

Be careful when you set up a query that uses 
three or more field tests and mixes And and Or. 
You’re confronted with the issue of precedence, 
which means, in layperson’s terms, “The chicken 
or the egg?” You might suppose that Word tests 
the conditions you list in the Filter and Sort dialog 
box in the order in which you list them. Not nec-
essarily. Word groups any condition tests linked 
by And and then checks them out before combin-
ing the results with tests linked by Or.

Confused? So am I. The following example 
shows how it works. Suppose that you open a 
restaurant menu and see that the fried chicken 
dinner comes with a “leg or wing and thigh.” 
Which of the following statements represents 
the two possible chicken dinner combinations 
you can order?

 ✓ You can order a meal with a leg and a thigh 
or a meal with a wing and a thigh.

 ✓ You can order a meal with a leg or a meal 
with a wing and thigh.

According to the way Word processes queries, 
the answer is the second one. Word lumps 
together as a group the two options linked by 
And.

If you want the first example to be the right 
answer, you have to state the menu choice as 
“leg and thigh or wing and thigh.”

For a more realistic Microsoft Word example, 
suppose that you want to mail to everyone who 
lives in Olympia, Washington, just across the 
way in Aberdeen. You might be tempted to set 
the query up like this:

  State Equal To WA

  And City Equal To Olympia

  Or City Equal To Aberdeen

Unfortunately, this example doesn’t work. You 
end up with everyone who lives in Olympia, 
Washington, plus anyone who lives in any town 
named Aberdeen, regardless of the state. (You 
can find Aberdeen in Maryland and in South 
Dakota too.)

You can just petition the federal government 
to make Aberdeen, Maryland, and Aberdeen, 
South Dakota, change their names. But the 
better way is to set up the filter like this:

  State Equal To WA

  And City Equal To Olympia

  Or State Equal To WA

  And City Equal to Aberdeen

Unprecedented stuff about precedence

Fun Things to Do with the Data Source
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 ✦ Equal To: Selects records if the field matches the Compare To value 
exactly.

 ✦ Not Equal To: Selects records if the field doesn’t match the Compare To 
value exactly.

 ✦ Less Than: Selects records if the field is less than the Compare To value.

 ✦ Greater Than: Selects records if the field is greater than the Compare To 
value.

 ✦ Less Than or Equal: Selects records if the field is less than or equal to 
the Compare To value.

 ✦ Greater Than or Equal: Selects records if the field is greater than or 
equal to the Compare To value.

 ✦ Is Blank: Selects records in which the field is blank.

 ✦ Is Not Blank: Selects records in which the field isn’t blank.

 ✦ Contains: Selects records if the field contains the Compare To value.

 ✦ Does Not Contain: Selects records if the field doesn’t contain the 
Compare To value.

You can set up complicated queries that check the contents of several fields. 
You might want to mail letters only to people who live in a particular city 
and state, for example. You set up the query like this:

City Equal to Bakersfield
And State Equal to CA

In this query, the merge includes only records whose City field is equal to 
Bakersfield and whose State field is equal to CA.

You can also set up queries that test the same field twice. To mail to 
addresses with the zip codes 93711 or 93722, for example, set up the query 
like this:

Zip Code Equal to 93711
Or Zip Code Equal to 93722

Notice that I change the And/Or field from And to Or. That way, a record is 
selected if its Zip Code field is 93711 or 93722. If you test the same field for 
two or more specific values, don’t leave the And/Or field set to And. If I were 
to leave the And/Or field set to And in the preceding example, a record is 
selected only if its Zip Code field is equal to 93711 and if it’s also equal to 
93722. Obviously, this situation isn’t possible: The zip code may be 93711 

Fun Things to Do with the Data Source
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or 93722, but it can’t be both at the same time. Leaving the And/Or field set to 
And is natural because you want to “mail letters to everyone in the 93711 and 
93722 zip codes.” But when in this situation, you have to specify Or, not And.

On the other hand, suppose that you want to mail to anyone whose zip code 
is 93711 or 93722 or any value between the two. In that case, you use two 
condition tests linked by And, as shown in this example:

Zip Code Greater Than or Equal to 93711
And Zip Code Less Than or Equal to 93722

For an even more interesting twist concerning And/Or, see the earlier side-
bar “Unprecedented stuff about precedence.”

Weeding out duplicates
The bigger your recipient list gets, the more difficult it is to keep track of 
who’s already entered into the list. Over time, you’re bound to end up with 
duplicate entries.

To save postage costs, you can use the Find Duplicates feature to spot 
potential duplicate records. Follow these steps:

 1. Start a mail merge as usual. When you reach Step 3 of the Mail Merge 
Wizard, click Edit Recipient List.

  The Mail Merge Recipients dialog box appears. (If you already have 
chosen a recipient list, click Edit Recipient List to summon this 
dialog box.)

 2. Click the Find Duplicates link.

  The Find Duplicates dialog box, shown in Figure 4-10, appears. This 
dialog box lists records that might be duplicates.

 3. Deselect the records you don’t want to include in the merge.

  You have to double-check every group of records in the Find Duplicates 
dialog box. If you find a true duplicate, you should deselect the record 
or records you don’t want to send mail to.

 4. Click OK and then click OK again.

 5. Finish the mail merge.

  Now the merge doesn’t include duplicate records.

Fun Things to Do with the Data Source
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Figure 4-10: 
The Find 
Duplicates 
dialog box.

 

Fun Things to Do with the Data Source
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Chapter 1: Customizing the 
User Interface

In This Chapter
✓ Playing with the Quick Access toolbar

✓ Dealing with old custom toolbars

✓ Adding custom keyboard shortcuts

One great strength of previous versions of Word — up to and includ-
ing Word 2003 — has been that the menus, toolbars, and keyboard 

shortcuts that make up the user interface have been almost completely cus-
tomizable. If you didn’t like the way the toolbars were arranged, you could 
rearrange them to your liking. Need a new menu command? You could write 
a macro to carry out the command and then assign the macro to a new 
menu item. You could even create entirely new toolbars or menus.

Unfortunately, the menus and toolbars were a little too easy to customize. 
In its studies before developing Word 2010, Microsoft found that far more 
people accidentally customized Word’s user interface than did it on pur-
pose. It was all too easy to accidentally drag a toolbar to a weird location or 
make it disappear altogether.

Thus, when Microsoft introduced the new Ribbon interface in Word 2007, 
it decided (in its infinite wisdom) to make the Ribbon almost impossible to 
customize. In Word 2007, you could customize the Quick Access toolbar, 
but nothing else.

That turned out to be one of the biggest complaints about Word 2007. So, 
with Word 2010, Microsoft reversed course and decided to once again let 
you customize the user interface. But this time it was done right, nearly 
eliminating the possibility of accidentally doing something goofy.

In this chapter, you find out how to customize the Quick Access toolbar and 
the Ribbon. And, as a bonus, you find out how to create your own custom 
keyboard shortcuts too.
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Customizing the Quick Access Toolbar
The Quick Access toolbar is the closest thing Word 2010 has to a customiz-
able toolbar. You don’t have the same options for customizing it as you did 
with ordinary toolbars in previous versions of Word. But you can choose 
one of two positions for it, and you can choose which buttons you want it to 
contain. I describe these simple customizations in the following sections.

Relocating the Quick Access toolbar
By default, the Quick Access toolbar appears above the Ribbon near the docu-
ment title. Most users find this to be the most convenient location. However, 
Word lets you position it beneath the Ribbon, as shown in Figure 1-1.

 

Figure 1-1: 
The Quick 
Access 
toolbar can 
live above 
the Ribbon 
as well as 
below it.

 

You have two ways to change the Quick Access toolbar location. The easiest 
is to click the arrow that appears to the right of any buttons on the toolbar. 
This action reveals a menu that includes two commands. The second of these 
commands moves the Quick Access toolbar. If the toolbar is below the Ribbon, 
the command is named Show Above the Ribbon. If the Quick Access toolbar is 
already above the Ribbon, the command is named Show Below the Ribbon.

The second way to move the Quick Access toolbar is to follow these steps:

Customizing the Quick Access Toolbar
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 1. Choose File➪Options.

  This step opens the Word Options dialog box.

 2. Click the Quick Access Toolbar tab on the left side of the dialog box.

  The Quick Access Toolbar tab appears, as shown in Figure 1-2.

 

Figure 1-2: 
The Quick 
Access 
Toolbar tab 
of the Word 
Options 
dialog box.

 

 3. Deselect the Show Quick Access Toolbar Below the Ribbon check box 
to place the Quick Access toolbar above the Ribbon.

  Or, if you’ve already deselected the box, select it to move the Quick 
Access toolbar below the Ribbon.

 4. Click OK.

  The Quick Access toolbar moves to its new location.

Here are a few points to ponder concerning the position of the Quick Access 
toolbar:

 ✦ You can move the Quick Access toolbar, but you can’t remove it. In 
other words, there’s no option to hide it.

 ✦ If you’ve used previous versions of Word, your first instinct for relocat-
ing the Quick Access toolbar is to simply grab it with the mouse and 
drag it to a new location. Microsoft has completely disabled this feature.

Customizing the Quick Access Toolbar

45_487662-bk08ch01.indd   46145_487662-bk08ch01.indd   461 4/15/10   9:17 PM4/15/10   9:17 PM



462

Adding and removing buttons
By default, the Quick Access toolbar includes these three buttons:

 ✦ Save

 ✦ Undo

 ✦ Redo

This collection of buttons is minimalist. You don’t have to think hard to 
come up with some other buttons that would be useful here, such as Open, 
Save As, New Document, or Print.

Fortunately, Word 2010 lets you add any number of buttons to the Quick 
Access toolbar. To add a button, just follow these simple steps:

 1. Click the arrow that appears to the right of the Quick Access toolbar.

  This step displays a menu that includes some of the most popular 
choices to include on the Quick Access toolbar.

 2. If the command you want to add appears in the menu, click it and skip 
the rest of this procedure.

  The command is added to the Quick Access toolbar, and you’re done.

 3. If the command you want to add isn’t on the menu, choose More 
Commands.

  This step selects the Quick Access Toolbar tab of the Word Options 
dialog box (refer to Figure 1-2).

 4. Choose a category from the Choose Commands From drop-down list 
that appears above the list of available buttons.

  This drop-down list lets you select buttons from any of several catego-
ries, including Popular Commands, Commands Not in the Ribbon, All 
Commands, and Macros.

 5. Select the button you want to add to the Quick Access toolbar.

 6. Click the Add button and then click OK.

  The button is added to the Quick Access toolbar.

Here are a few additional tips for customizing the Quick Access toolbar:

 ✦ To remove a button from the Quick Access toolbar, right-click the 
button and choose the Remove from Quick Access Toolbar option.

 ✦ Another way to remove a button is to select the Quick Access Toolbar 
tab of the Word Options dialog box, select the button you want to 
remove in the list of buttons on the Quick Access toolbar, and click the 
Remove button.

Customizing the Quick Access Toolbar
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 ✦ You can change the order of buttons on the Quick Access toolbar from 
the Quick Access Toolbar tab of the Word Options dialog box. First 
select a button from the list of buttons on the Quick Access toolbar, on 
the right side of the dialog box. Then use the Move Up and Move Down 
buttons (they’re on the right side) to change the location of the selected 
button.

 ✦ The Popular Commands category includes the most commonly used but-
tons. You probably want to add several commands from this category to 
your Quick Access toolbar, including New, Open, and Quick Print.

 ✦ The Commands Not in the Ribbon category lists a variety of Word com-
mands that don’t appear on any Ribbon tabs. You can find more than a 
hundred interesting commands in this category.

 ✦ If you’re not sure which category a command is in, you can choose the 
All Commands category.

 ✦ You can also assign a macro to a Quick Access toolbar button by choos-
ing the Macros category. For more information about creating macros, 
see Book IX, Chapter 1.

  As you scroll through the Choose Commands From drop-down list, you 
might notice that the buttons shown in the Commands section of the 
dialog box are context sensitive: They change to indicate which but-
tons are available in a category. As you examine the categories, you see 
familiar buttons, such as New, Open, and Save. But you also find many 
unfamiliar buttons. These represent Word commands you didn’t know 
existed because they aren’t on any menus or toolbars by default.

Customizing the Ribbon
When Microsoft abandoned its traditional menus and toolbars in favor of 
the Ribbon in Office 2007, one feature I missed the most was the ability to 
customize the user interface by creating my own toolbars and menus or 
by adding new commands to the existing toolbars and menus. Fortunately, 
Microsoft has remedied this deficiency in Word 2010: You can now custom-
ize the Ribbon interface by creating new tabs or by adding new groups to 
the existing tabs.

For example, Figure 1-3 shows a customized Home tab that includes a new 
group named Headings. This group includes three commands, which simply 
apply the Heading 1, Heading 2, and Heading 3 styles to the selected 
paragraph.

Customizing the Ribbon
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Figure 1-3: 
Customized 
Headings 
group.

 

To add to an existing Ribbon tab a new group such as the Headings group 
shown in the figure, follow these steps:

 1. Choose File➪Options.

  The Word Options dialog box appears.

 2. Select the Customize Ribbon tab on the left side of the dialog box.

  The Customize Ribbon tab appears, as shown in Figure 1-4. As you can 
see, this tab is similar to the Quick Access Toolbar tab but includes a 
few additional buttons.

 

Figure 1-4: 
The 
Customize 
Ribbon tab 
of the Word 
Options 
dialog box.

 

 3. In the list box on the right side of the dialog box, select the Ribbon 
tab you want to add a group to and click New Group.

  A new group is added to the list. The new group is given the inspiring 
name New Group (Custom).

 4. Click the Rename button.

  The Rename dialog box appears, as shown in Figure 1-5.

Customizing the Ribbon
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Figure 1-5: 
Renaming 
a Ribbon 
group.

 

 5. Ignore all the colorful symbols that appear in the Rename dialog box.

  The symbols don’t apply to groups. The only thing you’re interested 
in on the Rename dialog box is the Display Name text box and the OK 
button.

 6. Type an appropriate name for the new group in the Display Name text 
box and then click OK.

  The Rename dialog box is whisked away, and the generic New Group 
(Custom) group is renamed to the name you typed.

 

 Don’t worry about the (Custom) designation. It serves only to distin-
guish your custom groups from Word’s built-in groups and isn’t part of 
the name.

 7. If you don’t like the location at which the group was inserted into the 
tab, click the up- or down-arrow buttons to move the new group up or 
down.

  After you name and position the new group properly, you can add but-
tons to it.

 8. Choose a category from the Choose Commands From drop-down list 
that appears above the list of available buttons.

  This drop-down list lets you select buttons from any of several catego-
ries. These categories include Popular Commands, Commands Not In 
the Ribbon, All Commands, and Macros.

 9. Select the button you want to add to your custom group and click the 
Add button.

  The button is added to the custom group.

 10. Repeat Steps 8 and 9 to add more buttons to the group.

 11. Stop repeating Steps 8 and 9 when you’re done adding buttons to the 
group.

Customizing the Ribbon
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 12. Click OK to apply your changes.

  The Word Options dialog box disappears, and your changes to the 
Ribbon are immediately visible.

Here are a few additional points to ponder regarding customizing the 
Ribbon:

 ✦ Word lets you customize only new groups you have added to Ribbon 
tabs. You cannot add new commands to built-in groups.

 ✦ You can use the Remove button to remove a button from a custom 
group or to remove an entire custom group.

 ✦ You can use the up- or down-arrow buttons on the right side of the 
Customize Ribbon dialog box to change the position of buttons (and 
groups) on a custom tab.

 ✦ You can create an entirely new tab by clicking the New Tab button. 
The new tab, initially named New Tab, includes one group named New 
Group. You should use the Rename button to rename both the tab and 
the group. You can then use the up- and down-arrow buttons to change 
the position of your new tab on the Ribbon, and you can use the New 
Group button to create additional groups on your custom Ribbon.

 ✦ You can use the Import/Export button to export your Ribbon custom-
izations to a file. Then you can use this same Import/Export button to 
import saved customizations to a different computer.

 ✦ You can also use the Reset button to restore a single tab or the entire 
Ribbon to their out-of-the-box default settings.

Dealing with Old-Style, Custom Toolbars
Word 2003 and previous versions let you create custom toolbars. Although 
Word 2010 doesn’t use toolbars in the same way as those versions did, it 
provides a way for you to access the custom toolbars you created for docu-
ments and templates in previous versions of Word. Old-style custom tool-
bars are displayed on the Add-Ins tab, as shown in Figure 1-6. In the figure, 
I’ve opened a document I created in Word 2003 that contains a custom tool-
bar with a single button, named Wizard.

 

Figure 1-6: 
Custom 
toolbar.

 

Dealing with Old-Style, Custom Toolbars
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All custom toolbars in an old-style Word document are displayed together in 
a single group named Toolbar Commands. You have no way to turn the indi-
vidual toolbars on or off and no way to drag them to a new location or dock 
them to the side. But at least the custom toolbars are accessible.

Creating Custom Keyboard Shortcuts
If you’re a keyboard shortcut junkie (as I am), you probably want to create 
your own keyboard shortcuts. Then you can assign to handy keyboard 
shortcuts the styles, macros, and other goodies you use most often.

Follow these steps to assign a new keyboard shortcut:

 1. Open the Customize Ribbon tab in the Word Options dialog box.

  To open the dialog box, choose File➪Options. Then click the Customize 
Ribbon tab. Refer to Figure 1-4 to see what this dialog box looks like.

 2. Click the Customize button.

  The Customize Keyboard dialog box appears, as shown in Figure 1-7.

 

Figure 1-7:

The 
Customize 
Keyboard 
dialog box.

 

 3. Click a Category and then select the command, style, macro, or font or 
another item for which you want to create a keyboard shortcut.

  Spend some time exploring these lists. Lots of useful commands are 
buried amongst a bunch of strange-looking gobbledygook. You can 
create a shortcut for any command, style, macro, font, or just about any 
other item.

Creating Custom Keyboard Shortcuts
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 4. Click in the Press New Shortcut Key text box and then type the new 
keyboard shortcut.

  When you type the shortcut, Word lets you know whether the key is 
already assigned to another command.

 5. Click Assign to assign the keyboard shortcut. Then click Close.

  You’re finished! Try the shortcut to see whether it works.

 

You can also assign a keyboard shortcut to a style. Open the Styles window 
by clicking the Styles button in the lower-right corner of the Styles group on 
the Home tab on the Ribbon. Select the style you want to assign a keyboard 
shortcut to and then click the down arrow to reveal its shortcut menu. 
Choose Modify and then click the Format button to reveal the formatting 
shortcut menu for the style. Then choose the Shortcut Key command to 
create your keyboard shortcut.

Resetting keyboard shortcuts
You can erase all keyboard shortcuts stored in a template by following these 
steps:

 1. Open the Customize Keyboard dialog box.

  For the steps on how to open this dialog box, refer to the preceding 
section.

 2. Click the Reset All button.

 3. When the confirmation dialog box appears, click Yes.

 4. Click the Close button.

If you have keyboard shortcuts saved in both Normal.dotm and the tem-
plate attached to the current document, you need to use Reset All for both 
templates to revert completely to Word’s default keyboard shortcuts. And, 
to make the return to default shortcuts permanent, you must save the tem-
plate file as well. (See Book I, Chapter 3 for more on templates.)

Printing your keyboard shortcuts
If you lose track of your custom keyboard shortcuts, you can print a com-
plete list of them for the current document by following these steps:

 1. Open a document that’s attached to the template with the keyboard 
shortcuts you want to print, or open the template itself.

 2. Choose File➪Print to display the Print page in Backstage view.

Creating Custom Keyboard Shortcuts
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 3. In the first drop-down list in the Settings section, select Key 
Assignments.

 4. Click Print.

Keyboard assignments are printed, starting first with the keyboard assign-
ments derived from the template attached to the document and listing 
the global keyboard assignments taken from the Normal.dotm template. 
Word’s built-in keyboard shortcuts aren’t printed; if they were, the listing 
would go on for many pages.

Creating Custom Keyboard Shortcuts
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Chapter 2: Opting for Options

In This Chapter
✓ Finding out what’s up with all the Word options

✓ Personalizing Word

✓ Dealing with Display options

✓ Perusing the Proofing options

✓ Setting the Save options

✓ Adjusting the Advanced options

✓ Looking at other Word options

Sometimes I long for the old pre-Windows days, when my favorite word 
processor was WordPerfect 4.2 and the only real options I had to worry 

about were whether to change its screen colors or take the afternoon off 
and catch a quick round of golf. My golf game fell all to pieces after I began 
using Word. Now I spend all my free time playing with the options in the 
Word Options dialog box, so I don’t have any time left over for such luxuries 
as golf.

You should read this chapter when you finally decide to give in to the Word 
Options dialog box and you want to know what all those options do. This chap-
ter describes the most useful options and, more importantly, tells you which 
options you can safely ignore so that you (unlike some people I know — me, for 
example) can catch up on your golf.

I’m aware, of course, that for many people, golf is a more frustrating game 
than playing with Word. And, for some, golf is more boring than reading 
Word’s online help resources. If you’re one of those poor, unenlightened 
souls, feel free to substitute your favorite nongolf pastime in the preceding 
paragraphs.

What’s with All the Options?
The Word Options dialog box is one of the most heavily laden dialog boxes 
of all time. It has so many options that it earned Microsoft the Lifetime 
Achievement Award from the American Society of Windows Programmers.
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Like many other dialog boxes in Word, the Word Options dialog box (choose 
File➪Options) organizes its settings into tabs. Each tab has its own set of 
option controls. To switch from one tab to another, just click the tab label 
on the left side of the dialog box. (Unlike many other Word dialog boxes, the 
tabs for the Word Options dialog box appear on the left side of the dialog 
box rather than at the top.)

Most Word dialog boxes that use tabs have two or three tab labels, but the 
Word Options dialog box has ten — that’s right, ten — tabs, as shown in 
Figure 2-1.

 

Figure 2-1: 
The General 
tab of 
the Word 
Options 
dialog box.

 

 ✦ General: The most popular options for working with Word.

 ✦ Display: Contains options that control the way your document is dis-
played onscreen and how your documents print.

 ✦ Proofing: Controls the proofing tools such as the spell checker and the 
AutoCorrect feature.

 ✦ Save: Has important options that control the way Word saves your 
documents.

 ✦ Language: Lets you choose your editing language.

 ✦ Advanced: Contains a hodgepodge of options that control features 
Microsoft considers to fit in the Advanced category. Unfortunately, 
Microsoft has inexplicably placed options there that it considers 
advanced even if the option would more logically be placed on one of 

What’s with All the Options?
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the other tabs. For example, you can find on this tab (rather than on 
the Display tab) options that affect the way documents are displayed or 
printed. And several options that affect how files are saved are set here 
rather than on the Save tab. Go figure.

 ✦ Customize Ribbon: Lets you customize the Ribbon, as described in 
Chapter 1 of this minibook.

 ✦ Quick Access Toolbar: Where you customize the Quick Access toolbar. 
For more information, turn to Chapter 1 of this minibook.

 ✦ Add-Ins: Lets you activate a variety of cool add-in features.

 ✦ Trust Center: Contains security information and lets you access the Trust 
Center dialog box, where you can change various security settings.

To set options in Word, follow these steps:

 1. Choose File➪Options.

  The Word Options dialog box opens (refer to Figure 2-1).

 2. Click the tab that contains an option you want to change.

  If you’re unsure which tab contains the option you’re looking for, just 
cycle through the tabs until you find the option.

 3. Set the option however you want.

  Most options are simple check boxes that you click to select or deselect. 
Some require you to select a choice from a drop-down list, and some 
have the audacity to require that you type a filename or otherwise dem-
onstrate your keyboard proficiency.

 4. Repeat Steps 2 and 3 until you exhaust your options or until you’re 
just plain exhausted.

 5. Click OK.

  You’re done!

 

As you fritter away your day playing with these tabs, keep the following 
points in mind:

 ✦ Several of the Word Options tabs have more than one road that leads 
to them. You can reach the Print Options section of the Display tab, for 
example, by choosing File➪Print, clicking the Page Setup link, and then 
clicking the Print Options button on the Paper tab.

 ✦ As big as the Word Options dialog box is, it still isn’t big enough to hold 
all Word options. As a result, some Options tabs have buttons that open 
additional dialog boxes that have additional tabs. Sheesh!

 ✦ To move to a tab, just click the tab label. You can also move from tab 
to tab by pressing the arrow keys. To move from the General tab to the 
Display tab, for example, press the down-arrow key.

What’s with All the Options?
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 Some settings that a normal person would consider options are located else-
where on the Ribbon. For example, the option that controls whether the 
Ruler is displayed is found on the View tab on the Ribbon, not in the Word 
Options dialog box.

The General Tab
The General tab (refer to Figure 2-1) features the most popular options for 
working with Word. These options are described in the following sections.

Direct from the home office in sunny Fresno, 
California, here are my top ten favorite options:

 1. Save AutoRecover Information (Save tab): 
This option can be a lifesaver. Set it to save 
your work every five minutes or so, and you 
don’t have to worry about losing an entire 
day’s work because of a power failure.

 2. Use Smart Cut and Paste (Advanced 
tab): No more worrying about whether 
the space is before or after the text cut 
to the Clipboard. This option handles that 
worry for you. In fact, the good people at 
Microsoft turn this option on by default.

 3. Paragraphs Marks and Tab Characters 
(Display tab): Display paragraph marks and 
tab characters.

 4. When Selecting, Automatically Select 
Entire Word (Advanced tab): Without this 
option, you have to select an entire word 
and then press Ctrl+B or Ctrl+I to make the 
word bold or italicized. With this option 
set, you can just put the cursor anywhere 
in the word (or select portions of two or 
more words), and any formatting you apply 
is applied to the entire word (or all words).

 5. Show This Number of Recent Documents 
(Advanced tab): Avoid navigating the Open 

dialog box. Set it to as high a number as 
you can tolerate.

 6. Print in Background (Advanced tab): Why 
wait for the computer while it prints? With 
this option turned on (which it is by default), 
Word prints in the background while you 
do other work.

 7. Embed Fonts in the File (Save tab): Save 
fonts with the file so that another user who 
doesn’t have the font installed can use the 
document. Of course, this option works 
only if the license for the fonts permits 
sharing.

 8. File Locations (Advanced tab): Open a 
dialog box that lets you set the locations of 
various Word files, including the location 
where documents are stored by default 
and a network location where users of the 
network can share templates.

 9. Update Fields Before Printing (Display 
tab): Use this option to ensure that fields 
(such as dates) are always updated when-
ever the document is printed.

 10. Eighteen holes of golf: Better than the 
other nine options put together.

The ten best options in Word

The General Tab
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User interface options
This group of options controls the appearance of the Word user interface.

 ✦ Show Mini Toolbar on Selection: When this option is selected, a special 
toolbar (the Mini toolbar) is displayed whenever you select text. This 
toolbar lets you set the most common formatting options, such as the 
font, size, bold, italic, and color.

 ✦ Enable Live Preview: Show a preview of how various Word features will 
affect your document when you hover the cursor over different choices.

 ✦ Color scheme: Lets you choose one of several different color schemes. 
The color schemes affect the colors used to display the Ribbon, dialog 
box borders, and other elements of the Word user interface.

 ✦ ScreenTip Style: Control whether ScreenTips are displayed. (A 
ScreenTip is the little help box that appears whenever you hover the 
mouse for a moment over an item on the Ribbon.)

Personalize your copy of Microsoft Office
This section of the General tab lets you personalize your copy of Office by 
supplying your name and initials and the language you want to work with. 
This information is used in several ways:

 ✦ In the document properties when you save a document

 ✦ In comments and in revision marks when you track changes

 ✦ On envelopes, labels, and letters

Start-up options
The General tab has only one start-up option:

 ✦ Open E-Mail Attachments in Full Screen Reading View: When this 
option is enabled, Word documents sent as e-mail attachments open in 
Reading view. Personally, I’m not a fan of Reading view, so I usually dis-
able this option.

The Display Tab
The options on the Display tab, shown in Figure 2-2, let you customize the 
appearance of the humble Word display.

The Display Tab
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Figure 2-2: 
The Display 
tab.

 

The Display options are arranged in three groups:

 ✦ Page Display Options

 ✦ Always Show These Formatting Marks on the Screen

 ✦ Printing Options

Page Display Options
The Display options grouped under the Page Display Options heading con-
trol the amount of detail displayed in the document window. The following 
list gives you the lowdown on each of the options you can set from this tab:

 ✦ Show White Space between Pages in Print Layout View: This option 
displays the space between pages in Print Layout view. Otherwise, you 
don’t see the white space created by margins.

 ✦ Show Highlighter Marks: Deselect this option to turn off the highlight-
ing made by Word’s Highlight feature. Note that the highlighting isn’t 
removed — it just isn’t shown. This option can be helpful if you want to 
highlight something onscreen but not in the printout.

 ✦ Show Document Tooltips on Hover: Select this option to enable tips 
that appear when you hover the cursor over certain Word items, such as 
comments or hyperlinks.

The Display Tab
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Always Show These Formatting Marks on the Screen
This group of options lets you control which special characters are dis-
played in the document window:

 ✦ Tab Characters: Displays tab characters as an arrow. I usually leave this 
option selected so that I can keep track of tabs.

 ✦ Spaces: Displays spaces as little dots. I usually leave this option dese-
lected, but some people like to see the little dots so that they can tell 
where they type spaces.

 ✦ Paragraph Marks: Displays paragraph marks. I usually leave this option 
selected so that I can quickly find extraneous paragraphs.

 ✦ Hidden Text: Displays hidden text, or text in your document that isn’t 
printed. It’s marked as hidden via the Font dialog box. (For more infor-
mation, see Book II, Chapter 2.)

 ✦ Optional Hyphens: Displays optional hyphens, which are helpful when 
you want precise control over hyphenation.

 ✦ Object Anchors: Shows the anchors that tie objects to a specific loca-
tion in your document.

 ✦ Show All Formatting Marks: Displays all hidden characters. Selecting 
this option is the same as clicking the Show/Hide button on the Home 
tab on the Ribbon.

 

When you press the Show/Hide button on the Ribbon, all nonprinting char-
acters are displayed. When the button isn’t depressed, only those nonprint-
ing characters specified on the View tab are displayed. Set the options on 
the View tab so that only those nonprinting characters you always want to 
display — such as tab characters and paragraph marks — are selected. You 
can display the other nonprinting characters at any time by simply clicking 
the Show/Hide button.

Printing Options
This section describes several options that affect how documents are 
printed. Specifically:

 ✦ Print Drawings Created in Word: If you turn off this option, the docu-
ment’s text is printed, but any graphics are not printed.

 ✦ Print Background Colors and Images: Turn on this option if you want to 
print the page background color or image. Leave this option off if you’re 
printing on colored or preprinted paper.

 ✦ Print Document Properties: If you want document properties to print as 
a separate page, select this option.

The Display Tab
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 ✦ Print Hidden Text: Select this option to print text that has been marked 
as hidden.

 ✦ Update Fields before Printing: Updates the contents of fields before 
printing. I recommend turning on this option. (For more information, see 
Chapter 3 of this minibook.)

 ✦ Update Linked Data before Printing: Likewise, this option should also 
be turned on. For instance, if you link a table in Word to an Excel spread-
sheet, leaving this option turned on ensures that the most up-to-date 
information in the Excel spreadsheet is included in your Word table.

The Proofing Tab
Figure 2-3 shows the Proofing tab of the Word Options dialog box, which 
lets you control the way the various Office proofing tools work. Because the 
settings on this tab are covered elsewhere in this book, I don’t belabor them 
here. For more information about setting AutoCorrect options, please see 
Book II, Chapter 5. For more information about the spelling and grammar 
options, please see Book II, Chapter 6.

 

Figure 2-3: 
The 
Proofing 
tab.

 

The Proofing Tab
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The Save Tab
Figure 2-4 shows the Save tab, which lets you specify how you want docu-
ments to be saved. The following sections describe the options on this tab.

 

Figure 2-4: 
The Save 
tab.

 

Save Documents
This section contains basic options for how files are saved:

 ✦ Save Files in This Format: Specifies the default format for saving Word 
files. This option is initially set to Word Document (*.docx) to save files 
in the new Word 2010 format.

 ✦ Save AutoRecover Information Every N Minutes: Automatically saves 
recovery information at regular intervals. The default setting is to save 
the recovery information every 10 minutes, but you can change the time 
interval if you want. I like to set it for 5 minutes.

 ✦ Keep the Last AutoRecovered File If I Close without Saving: Comes 
into play if you close Word without saving your document. If the option 
is set, the most recent AutoRecover file is automatically saved. Leave 
this option turned on.

The Save Tab
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 ✦ AutoRecover File Location: Specifies the hard drive folder where 
AutoRecover files are stored. Rarely do you have a reason to change this 
option.

 ✦ Default File Location: This option sets the initial location for files when 
you use the Save command. It defaults to Documents, but you can 
change it to another location if you want.

Offline Editing Options for Document 
Management Server Files
If your company uses a document management server (such as SharePoint), 
you can use these options to configure how it works. Usually, you should 
leave these options unchanged.

Preserve Fidelity When Sharing This Document
The lone option in this section, Embed Fonts in the File, lets you specify 
whether to include TrueType font files in your documents. Embedding the 
fonts in the document increases the size of the document file, so this option 
is usually left deselected. However, if you intend to share the file with other 
users and you use uncommon fonts in the document, you should select this 
option. (As for the two check boxes beneath this option, leave them set as 
they are.)

The Language Tab
On the Language tab, shown in Figure 2-5, you can specify the language you 
want to use when you work in Word. As you can see, you can specify three 
settings on this tab:

 ✦ Choose Editing Languages: Choose the language your document is writ-
ten in. The default choice is English, but you can use the drop-down list 
to add editing languages.

 ✦ Choose Display and Help Languages: Choose the language used by 
Word’s user interface, which is helpful if you’re working on a document 
in a language other than your own, native language.

 ✦ Choose ScreenTip Language: Select an alternative language for 
ScreenTips, those little boxes of helpful information that pop up when 
you hover the mouse over a user interface element. 

The Advanced Tab
The Advanced tab, shown in Figure 2-6, is the catch-all tab of the Word 
Options dialog box. It contains a plethora of options — so many, in fact, 

The Language Tab
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that Figure 2-6 shows only about one fourth of them. The following sections 
describe all the options on the Advanced tab.

 

Figure 2-5: 
The 
Language 
tab.

 

 

Figure 2-6: 
The 
Advanced 
tab.

 

The Advanced Tab
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Editing Options
The Editing Options section contains the following options that affect the 
way you can edit documents:

 ✦ Typing Replaces Selected Text: If you highlight text by dragging the cursor 
over it or by holding down the Shift key while moving the cursor and then 
type something, the whatever-it-was-you-typed obliterates the whatever-it-
was-you-highlighted. If this behavior drives you bonkers, you can turn it off 
by deselecting the Typing Replaces Selected Text check box.

 ✦ When Selecting, Automatically Select Entire Word: This option is one of 
the niftiest features in Word. It causes Word to assume that you meant to 
select an entire word. This tool can be disconcerting at first, though, so be 
prepared. If it’s against your religion, you can turn it off by deselecting the 
When Selecting, Automatically Select Entire Word check box.

 ✦ Allow Text to Be Dragged and Dropped: More commonly known as 
“dragon dropping,” this option lets you move text by selecting it and 
then dragging it with the mouse. If it annoys you, turn it off by deselect-
ing this check box.

 ✦ Use Ctrl+Click to Follow Hyperlink: If you select this option, the usual 
clicking action doesn’t automatically activate a hyperlink.

 ✦ Automatically Create Drawing Canvas When Inserting AutoShapes: If 
this option is on, Word automatically creates a Drawing Canvas object 
whenever you insert a shape into your documents. This option is off by 
default and should be left off.

 ✦ Use Smart Paragraph Selection: Keep paragraph formatting intact when 
you cut and paste paragraphs.

 ✦ Use Smart Cursoring: This option automatically moves the insertion 
point as you scroll your document by using the scrolling keys (such as 
Page Up or Page Down).

 ✦ Use the Insert Key to Control Overtype Mode: If this option is selected, 
the Insert key switches from Overtype mode to Insert mode. In Overtype 
mode, anything you type replaces text that’s already on the screen. If 
you want to insert content in the middle of a paragraph and you care 
whether the text that’s already there stays in your document, you want 
Word in Insert mode as much as possible.

 ✦ Use Overtype Mode: Speaking of Overtype mode, sneak into someone’s 
office late at night, click File➪Options, and then select this option. Then 
let out an evil laugh when he shouts obscenities every time he starts up 
Word and doesn’t discover until it’s too late that it’s in Overtype mode.

The Advanced Tab
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  I don’t know what got into me. Don’t, under any circumstances, do this. 
Please. Playing with other people’s computers isn’t nice.

 ✦ Prompt to Update Style: If this option is on, Word asks what you want 
to do if you modify the format of some text and then reapply the previ-
ously applied style. The prompt asks whether you want to revert to the 
formatting specified by the style or to update the style to reflect the new 
formatting.

 ✦ Use Normal Style for Bulleted or Numbered Lists: If this option is 
selected, bulleted or numbered lists are formatted using the Normal 
paragraph style. Best leave this one at its default.

 ✦ Keep Track of Formatting: This option tells Word to automatically create 
a style every time you apply formatting. This feature is cool because you 
can then modify the style to make consistent changes to your document. 
On the other hand, Word can go a little overboard in creating styles. You 
might find that your style list fills up with dozens of styles that Word cre-
ated as it tracked every little formatting change you made.

 ✦ Mark Formatting Inconsistencies: If this option is selected, text that’s 
formatted similar to but not exactly like other text in the document is 
marked with a wavy blue underline.

 ✦ Updating Style to Match Selection: Controls the behavior of bullet and 
numbering patterns when you update a style to match the selection. 
(For more information on styles, see Book II, Chapter 3; for more infor-
mation on bullets and numbered lists, see Book III, Chapter 3.) 

 ✦ Enable Click and Type: This option enables the Click and Type feature, 
which lets you place text anywhere on a page by double-clicking where 
you want to place the text and typing. Word automatically adds para-
graphs or tabs necessary to position the text at the right place.

 ✦ Default Paragraph Style: Sets the default paragraph style for new para-
graphs created with the Click and Type feature. Best to leave it set to 
Normal.

 ✦ Show AutoComplete Suggestions: Deselect this option to turn off the 
AutoComplete feature.

Cut, Copy, and Paste
The Cut, Copy, and Paste options affect the way the Clipboard works:

 ✦ Pasting within the Same Document: Lets you pick one of three behav-
iors for pasting text that’s cut or copied from one location of a docu-
ment and pasted to another location within the same document. The 
three choices are

The Advanced Tab
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 • Keep Source Formatting: Retains the formatting applied to the original 
text.

 • Merge Formatting: Matches the formatting of the pasted text to the 
formatting of text where it is pasted but retains certain formatting 
elements, such as bold and italic.

 • Keep Text Only: Applies no formatting to the pasted text.

 ✦ Pasting between Documents: The same three choices exist for copying 
or cutting text from one document and pasting it into another.

 ✦ Pasting between Documents When Style Definitions Conflict: 
Determines how style formatting is handled when text is copied or cut 
from one document and pasted into another and the styles in the two 
documents specify different formatting.

 ✦ Pasting from Other Programs: Specifies how formatting is handled 
when text is copied or pasted from a program other than Word.

 ✦ Insert/Paste Pictures As: Specifies the default layout option to use for 
pasted pictures.

 ✦ Keep Bullets and Numbers When Pasting Text with Keep Text Only 
Option: Hmm. This one is obscure. If you specify Keep Text Only for one 
of the previous pasting options, this option determines whether bul-
lets or numbers are considered part of the text or just formatting. If you 
select this option, the bullet or number is pasted. If this option is dese-
lected, bullets or numbers aren’t pasted.

 ✦ Use the Insert Key for Paste: If you select this option, the Insert key 
serves as a handy shortcut for the Paste command.

 ✦ Show Paste Options Button When Content Is Pasted: This option dis-
plays a Paste Options button at the bottom corner of text you paste into 
your document. You can click this button to reveal a menu of options for 
formatting the pasted text.

 ✦ Use Smart Cut and Paste: Adjusts spaces before and after text you 
cut and paste so that you don’t end up with two spaces between some 
words and no spaces between others. Leave this option selected; it’s too 
good to turn off.

Image size and quality
This section contains options that affect how images are saved in your docu-
ments. There are three such options:

 ✦ Discard Editing Data: If this option is selected, any information about 
how the image was previously edited is discarded when you save the 
document.

The Advanced Tab
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 ✦ Do Not Compress Images in File: If this option is deselected, images are 
automatically compressed when you save the document. This process 
reduces the document’s file size, which is especially important if the 
document contains a large number of images.

 ✦ Set Default Target Output To: This option sets the resolution of your 
document’s intended output device. The default setting is 220 pixels per 
inch (ppi). You can increase this setting if you want your images to print 
in higher quality, but doing so increases the file size. 

Show Document Content 
The following options, located in the Show Document Content section, let 
you refine the way Word documents are displayed:

 ✦ Show Background Colors and Images in Print Layout View: If you want 
to see page backgrounds in Print Layout view, leave this option selected.

 ✦ Show Text Wrapped within the Document Window: You should leave 
this option deselected if you want the text wrap to reflect the way the 
document will print (which you probably do). If page count is an issue in 
the work you do, selecting this option will give you a migraine.

 ✦ Show Picture Placeholders: If you insert a picture into a document, you 
notice that Word hesitates a little when you scroll the picture into the 
document window. If you add 200 pictures to a document, the hesita-
tions might come so often that you want to scream. Selecting this option 
causes Word to display a simple rectangle where the picture will be 
placed. This step eliminates the hesitation but of course hides the pic-
tures so that you can’t see what they look like until you print the 
document.

 ✦ Show Drawings and Text Boxes on Screen: You can deselect this option 
to hide any drawings or text boxes in your document. I don’t know why 
you would, though, unless you’re using a slow computer that’s barely 
able to display the drawings and text boxes in your document.

 ✦ Show Text Animation: This option enables text animation effects.

 ✦ Show Bookmarks: Sandwich between gray brackets the text referred to 
in a bookmark.

 ✦ Show Text Boundaries: Display faint lines that indicate the boundaries 
within which text will be placed. This option is often very helpful.

 ✦ Show Crop Marks: This option has nothing to do with cropping pictures. 
Instead, crop marks are little lines that print in the corners of the page to 
indicate where the page should be physically cut to fit the margins.

The Advanced Tab
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 ✦ Show Field Codes instead of Their Values: Shows the codes inserted 
for each field rather than the results of the field. Use this option when 
you’re struggling with a maniacal mail merge. For more information, see 
Chapter 3 of this minibook.

 ✦ Field Shading: You might apply shades to a field to draw attention to 
them. You can set this option to

 • Never: Never shades field results

 • Always: Always shades field results

 • When Selected: Shades field results only when some (or all) of the 
field is selected

 ✦ Use Draft Font in Draft and Outline Views: Choose this option if you 
want to display text in a standard font (usually Courier New) when the 
document is viewed in Draft or Outline view. The main reason for this 
feature is to help you focus on your document’s content rather than on 
its appearance. You should consider using this option if you spend most 
of your time playing with fonts instead of improving your prose.

 ✦ Font Substitution: Opens a dialog box that lets you assign fonts to use 
whenever a document refers to a font that isn’t present on your com-
puter. You can usually just ignore this setting and let Word decide how 
to substitute missing fonts on its own.

Display
The options in the Display section control various aspects of Word’s display:

 ✦ Show This Number of Recent Documents: Tell Word how many files to 
list in Backstage view. The default is 20.

 ✦ Show Measurements in Units Of: In case you don’t like inches, you can 
change Word’s measurements to centimeters, millimeters, points, picas, 
fathoms, leagues, cubits, or parsecs.

 ✦ Style Area Pane Width in Draft and Outline Views: The style area pane 
appears at the left side of the screen in Draft and Outline view and indi-
cates the style assigned to each paragraph. You can adjust its width by 
dragging its border, or you can use this option to set the width. Set this 
option to 0 if you want to hide the style area pane.

 ✦ Show Pixels for HTML Features: Make pixel the default choice for the 
measurement unit for Web documents.

 ✦ Show All Windows in the Taskbar: Specify that each document should 
get its own icon in the taskbar.

 ✦ Show Shortcut Keys in ScreenTips: Specify that ScreenTips should 
show shortcut keys whenever appropriate.

The Advanced Tab
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 ✦ Show Horizontal Scroll Bar: Show the scroll bar at the bottom of the 
screen. If you discover one day that you’ve been using Word for two 
years and didn’t know that a horizontal scroll bar was available, deselect 
this option to free up more space to display your document.

 ✦ Show Vertical Scroll Bar: If your text is just a wee bit wide for the 
screen, consider deselecting the Show Vertical Scroll Bar option, at the 
right edge of the window, to remove the scroll bar. This action frees up 
a little space, and you can still press the Page Up and Page Down keys to 
scroll through your document.

 ✦ Show Vertical Ruler in Print Layout View: Indicate whether a vertical 
ruler should be displayed when you’re working in Print Layout view. 
This option is on by default.

 ✦ Optimize Character Positioning for Layout Rather Than Readability: 
Specify how Word decides the exact positioning of characters. 

 ✦ Disable Hardware Graphics Acceleration: If you’re having odd prob-
lems with your screen display, checking this option might improve the 
situation.

Chart
The two options in the Chart section control how charts are handled:

 ✦ Insert Charts Using Draft Mode: If you check this option, charts are 
inserted in draft mode. For more information about working with charts, 
refer to Book IV, Chapter 3.

 ✦ Hide Draft Mode Notification on Charts: Hide the icon that lets you 
know the chart is displayed in Draft mode.

Print
The Print section of the Advanced tab displays several options that let you 
control printing. To wit:

 ✦ Use Draft Quality: Prints the document in draft format, with little 
formatting. This option can result in faster printing and can save ink 
because draft quality usually uses less ink than final quality.

 ✦ Print in Background: Speeds printing and allows you to continue work-
ing while a long document is printing. I suggest that you leave this 
option on.

 ✦ Print Pages in Reverse Order: Prints the document backward, starting 
with the last page in your document. This option is useful if your printer 
stacks printed pages in the wrong order.

The Advanced Tab
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 ✦ Print XML Tags: Prints any XML codes in your document if this option 
is set.

 ✦ Print Field Codes Instead of Their Values: Prints field codes rather than 
field results. Use this option only if your document is filled with fields 
and you’re trying to figure out why they aren’t working right.

 ✦ Allow Fields Containing Tracked Changes to Update Before Printing: 
Controls whether fields are automatically updated when editing changes 
are tracked.

 ✦ Print on Front of the Sheet for Duplex Printing: Sets the order of pages 
on the front of each sheet. Normally, odd-numbered pages are printed 
in order on the top of each page. Select this option to reverse the print 
order of odd-numbered pages.

 ✦ Print on Back of the Sheet for Duplex Printing: Normally, prints in 
order on the back of each page.

 ✦ Scale Content for A4 or 8.5 x 11” Paper Sizes: Automatically adjusts 
the document to fit these paper sizes if this option is selected.

 ✦ Default Tray: Lets you specify the default tray to use.

 ✦ Print PostScript Over Text: An option that’s important only if you’re 
converting documents from Macintosh Word format. In that case, turn 
this option on.

 ✦ Print Only the Data from a Form: If your document contains a form and 
you’re printing on preprinted form paper, prints just the data rather 
than the form itself.

Save
This section contains a few options that aren’t on the Save tab:

 ✦ Prompt before Saving Normal Template: If you select this option, Word 
asks your permission before it saves any changes to the Normal 
template.

 ✦ Always Create Backup Copy: This option isn’t nearly as useful as you 
might think, especially if you frequently save your documents, which 
you should. Still, it’s a good safety net, so I recommend it.

 ✦ Copy Remotely Stored Files onto Your Computer, and Update the 
Remote File When Saving: This option can improve performance 
when you’re working over a network. In some cases, the performance 
improvement is significant. So I recommend leaving this option selected.

 ✦ Allow Background Saves: Use this option if you work on large docu-
ments that take a long time to save. Avoid it if your documents are small 
and save quickly.

The Advanced Tab
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Preserve Fidelity When Sharing This Document
These options provide additional control over data that’s stored with the 
document. Specifically, you can choose to save the following information 
with the document:

 ✦ Smart tags in XML format

 ✦ Form data as a delimited text file

 ✦ Linguistic data

 ✦ Embedded smart tags

General
Finding a section of General options in the middle of a huge collection of 
Advanced options seems a little backward to me, but here they are 
nevertheless:

 ✦ Provide Feedback with Sound: Causes Word to beep, boop, and other-
wise chortle whenever it needs to get your attention. Turn this option 
on if you want to constantly remind your neighbors that you haven’t yet 
mastered Word.

 ✦ Provide Feedback with Animation: Lets Word show off by displaying 
clever animations when you perform certain actions, such as saving files 
or printing.

 ✦ Confirm File Format Conversion on Open: Not a religious awakening; 
instead, merely instructs Word to ask for your consent before opening a 
document created by another program.

 ✦ Update Automatic Links at Open: Automatically updates any files that 
are linked to a document when you open the document. Leaving this 
option on is usually best.

 ✦ Allow Opening a Document in Draft View: Displays documents in Draft 
view when you open them.

 ✦ Enable Background Repagination: Ever notice that when you take a 
breather from your sustained typing rate of 90 words per minute, Word 
sometimes causes page breaks to dance about? This dance is Word’s 
Background Repagination feature at work, constantly surveying the 
length of your document and inserting page breaks where they rightfully 
belong. If you deselect this check box, Word repaginates the document 
only when you print it; when you create a table of contents, an index, or 
another table; or when you work in Print Layout or Print Preview view.

The Advanced Tab
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  Turning off Background Repagination might make your computer 
run a little faster, but you’ll always wonder whether you’re at the 
top or bottom of the page. I don’t recommend it. (You can’t turn off 
Background Repagination when you’re in Page Layout view because that 
view requires page breaks to always be up-to-date.)

 ✦ Show Add-In User Interface Errors: Alerts you to errors in an add-in 
template’s attempt to customize the user interface. 

 ✦ Show Customer Submitted Office.com Content: An option you can 
leave deselected if you want to see only official Microsoft information 
when you browse the Microsoft Office.com Web site. 

 ✦ Mailing Address: The spot where you enter your mailing address.

At the bottom of the General section, you find two buttons that open addi-
tional dialog boxes stuffed with options:

 ✦ File Locations: Opens the dialog box shown in Figure 2-7. This dialog 
box lets you change the location of various Word files, including

 • Documents: Change the default folder for the Open and Save As 
commands.

 • Clipart Pictures: If you have your own collection of clip art, you might 
want to modify this file location to make your clip art easier to find.

 • User Templates: Leave this option alone. It tells Word where it can 
retrieve templates.

 • Workgroup Templates: This option lets you set up a secondary loca-
tion for template files.

 • All the rest: Leave the rest of the options alone.

 ✦ Web Options: Opens the dialog box shown in Figure 2-8, which lets you 
set various options related to how Word accesses the Web.

Compatibility Options
The last section on the Advanced tab lets you set backward compatibility for 
previous versions of Word or other word processing programs. You can set 
these compatibility options:

 ✦ Microsoft Word 2010

 ✦ Microsoft Office Word 2007

 ✦ Microsoft Office Word 2003

 ✦ Microsoft Word 2002

 ✦ Microsoft Word 2000

The Advanced Tab
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 ✦ Microsoft Word 97

 ✦ Microsoft Word 6.0/95

 ✦ Word for Windows 1.0

 ✦ Word for Windows 2.0

 ✦ Word for Macintosh 5.x

 ✦ Word for MS-DOS

 ✦ WordPerfect 5.x

 ✦ WordPerfect 6.x for Windows

 ✦ WordPerfect 6.0 for DOS

 

Figure 2-7: 
The File 
Locations 
dialog box.

 

 

Figure 2-8: 
The Web 
Options 
dialog box.

 

The Advanced Tab
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This section also includes the innocuous-looking button named Layout 
Options. If you click it, the already huge list of options shown on the 
Advanced tab expands to show more than 60 additional options that control 
how your document is laid out. These options let you revert specific features 
to the way they worked in previous versions of Word or in WordPerfect. I 
suggest that you avoid these options, if you can.

The Customize Ribbon and the 
Quick Access Toolbar Tabs

The Customize Ribbon tab and the Quick Access Toolbar tab let you custom-
ize Word’s user interface. For more information about working with this tab, 
read Chapter 1 of this minibook.

The Add-Ins Tab
On the Add-Ins tab, you manage global templates and other types of add-ins. 
For more information about working with this tab, turn to Book I, Chapter 3.

The Trust Center Tab
The Trust Center tab, shown in Figure 2-9, lets you access several security-
related features for Windows, Office, and Word. This tab includes links to 
several useful Web sites. In addition, you can click the Trust Center Settings 
button to reach the Trust Center dialog box, shown in Figure 2-10.

The Trust Center dialog box resembles the Word Options dialog box in that 
it has tabs that let you access specific security-related options. The tabs are

 ✦ Trusted Publishers: Identifies sources of add-ins that have been digitally 
signed and can therefore be trusted.

 ✦ Trusted Locations: Identifies file locations that contain files such as add-
ins and templates you trust.

 ✦ Trusted Documents: Specifies whether documents you have opened and 
allowed macros for should be trusted in the figure.

 ✦ Add-Ins: Holds various security options for add-ins. You should leave 
these options at their default settings.

The Customize Ribbon and the Quick Access Toolbar Tabs
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 ✦ ActiveX Settings: Holds security options for ActiveX controls. You 
should leave these options at their default settings.

 ✦ Macro Settings: Holds security options for macros. You should leave 
these options at their default settings.

 ✦ Protected View: Contains several options indicating that documents 
from suspicious locations (such as Web pages or e-mail attachments) 
should be opened in a special mode that doesn’t allow editing. The user 
(that’s you) must click a button that appears at the top of the screen to 
enable editing for the document. These options are turned on by default, 
but you can turn them off if you find the feature annoying.

 ✦ Message Bar: Lets you activate or deactivate the message bar, which 
notifies you when suspicious content has been blocked. You should 
leave these options at their default settings.

 ✦ File Block Settings: Prevents Word from opening or saving various types 
of file formats, such as older versions of Word or formats used by other 
word-processing programs.

 ✦ Privacy Options: Options that help protect your privacy. You should 
leave these options at their default settings.

 

Figure 2-9: 
The Trust 
Center tab.

 

The Trust Center Tab

46_487662-bk08ch02.indd   49346_487662-bk08ch02.indd   493 4/15/10   9:17 PM4/15/10   9:17 PM



494

 

Figure 2-10: 
The Trust 
Center 
dialog box.

 

The Trust Center Tab

46_487662-bk08ch02.indd   49446_487662-bk08ch02.indd   494 4/15/10   9:17 PM4/15/10   9:17 PM



Chapter 3: Working with Fields

In This Chapter
✓ Customizing documents with the date, number of pages, and other 

values

✓ Taking shortcuts to the fields

✓ Formatting fields

✓ Updating and not updating fields

✓ Checking out all Word fields

A field is a special placeholder code that tells Word to insert some-
thing (usually text of some sort) into the document. A date field, for 

example, tells Word to insert the current date into the document. No matter 
when you edit or print the document, the date field causes the document to 
contain the current date.

Fields are everywhere in Word. Many of the commands you’ve come to 
know and love rely on fields to do their business. Fields let you insert the 
page number into a header or footer, create a table of contents or an index, 
and print mail-merged letters. These fields are often inserted into your 
document without your knowledge, as a result of your using another feature 
such as footnotes or indexes.

This chapter shows you what you need to know to insert fields directly, 
using the Quick Parts button on the Insert tab. Word provides many differ-
ent types of fields (more than 70). At the end of this chapter is a table that 
lists them all.

Understanding Fields
A field is a code that Word translates into a result, usually text, which is 
then inserted into the document. When you insert a date field, for example, 
you’re saying to Word, “Insert the current date right here, and make sure 
that you get the date right. When I print this document, I want to see today’s 
date. If I print it tomorrow, I want to see tomorrow’s date. Next week, I want 
to see next week’s date. A year from now. . . .” Get the idea? A date field is 
like a placeholder for an actual date, which Word inserts automatically. 
Other fields work in a similar way.

47_487662-bk08ch03.indd   49547_487662-bk08ch03.indd   495 4/15/10   9:17 PM4/15/10   9:17 PM



496

The text that Word inserts in place of the field code is the result. For a date 
field, the result is the current date. For a page-number field, the result is the 
current page number. Other field types produce more complicated results, 
such as a table of contents or an index. For some fields, the result isn’t even 
text but is instead a picture or a chart.

When you print a document, you can’t distinguish between text you typed 
directly into the document and text that’s a field result. Consider, for exam-
ple, the following text you may use in a letter:

As of today, Sunday, November 29, 2010, you have been banished from 
Remulak and sentenced to live out the remainder of your existence 
among the Blunt Skulls of Earth.

You can’t tell that Sunday, November 29, 2010 is a field result.

When you edit a document in Word, you must have a way to distinguish 
between regular text and field results. Word normally displays field results 
so that the document appears onscreen just as it does when you print it. If 
the result isn’t quite what you expect, however, or if you want to make sure 
that you used the correct field to produce a result, you can switch the dis-
play to show field codes.

The preceding letter fragment with field codes displayed looks like this:

As of today, { TIME \@ “dddd, MMMM d, yyyy” }, you have been ban-
ished from Remulak and sentenced to live out the remainder of your 
existence among the Blunt Skulls of Earth.

The text marked by curly braces ({ }), which are field characters, comprises 
the field. Their purpose in life is to tell Word that a field lives there. Though 
they look just like the curly braces you can type with the keyboard, they’re 
not the same elements.

Sandwiched between the field characters is the field itself. Each field begins 
with a field type that tells you which type of field you have. In the preceding 
example, you’re looking at a TIME field, which provides the current date or 
time in many different formats.

Following the field type are instructions, which tell the field what to do. The 
TIME field in the preceding example contains an instruction that tells Word 
how to format the time: dddd, MMMM d, yyyy.

Understanding Fields
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Inserting a Field
Follow these steps to insert a field in your document:

 1. Move the insertion point to the spot where you want to insert the 
field.

 2. On the Insert tab on the Ribbon, click the Quick Parts button, found in 
the Text group. Then choose Field from the menu that appears.

  The Field dialog box appears, as shown in Figure 3-1.

 

Figure 3-1: 
The Field 
dialog box.

 

 3. Select the field type you want to insert.

  Because so many field types exist, Word breaks them down into cat-
egories so that you can find them more easily. First pick the category 
that contains the field you want to use. Then pick the field from the 
Field Names list box. If the field you want doesn’t appear, try a different 
category. If you’re not sure which category contains the field you want 
to insert, choose All as the category. This action lists all the Word field 
types in the Field Names list box.

 4. Use the other controls in the Field dialog box to add more instructions 
required by the field.

  I’d like to be more specific here, but I can’t. The appearance of the 
Field dialog box changes when you select a field because each type of 
field accepts a different combination of options. For example, Figure 
3-2 shows how the Field dialog box appears if you select Info field. The 
Field dialog box for an Info field includes a New Value text box, an Info 
Categories drop-down list, and a Format list.

Inserting a Field
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Figure 3-2: 
The Field 
dialog box 
changes 
when you 
select a 
field type.

 

 5. Click OK to insert the field.

You can add more options to a field by clicking the Field Codes button in 
the Field dialog box and then clicking the Options button. The Field Options 
dialog box appears, as shown in Figure 3-3. The options presented in the 
dialog box vary depending on the field.

 

Figure 3-3: 
The Field 
Options 
dialog box.

 

You can add options to the field codes by choosing an option you want to 
add in the list and then clicking the Add to Field button. Every time you click 
the Add to Field button, the selected option is added to the Field Codes text 
box. Also, a terse description of each field option appears at the bottom of 
the Field Options dialog box.

Inserting a Field
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When you insert a field, either the field code or the result is displayed, 
depending on whether the Field Codes view option is set. You can switch 
between field codes and field results by pressing Alt+F9 or by right-clicking 
the field and choosing the Toggle Field Codes command.

If you see a message such as Error! Unknown switch argument rather 
than the field result you expect, you made a mistake when you composed 
the field instructions. You have to edit the field directly by pressing Alt+F9 
to reveal the field codes and then clicking in the field and typing your correc-
tion. (Or, once again, right-click the field and choose the Toggle Field Codes 
command.)

Keyboard Shortcuts for Working with Fields
A bevy of specialized keyboard shortcuts are available for working with 
fields. Table 3-1 summarizes them for your convenience.

Table 3-1 Keyboard Shortcuts for Fields

Keyboard Shortcut What It Does

F9 Updates the selected field or fields.

Shift+F9 Switches the display between field codes and field 
results for the selected field or fields. You must place the 
insertion point in a field to use this command.

Alt+F9 Switches the display between field codes and field 
results for all fields in the document. You don’t have to 
select a field before using this command.

Ctrl+F9 Inserts a blank field into a document.

Ctrl+Shift+F9 Converts a field to text (unlinks the field).

F11 Finds the next field in the document.

Shift+F11 Finds the previous field in the document.

Ctrl+F11 Locks a field so that it cannot be updated.

Ctrl+Shift+F11 Unlocks a field.

Another Way to Insert Fields
If you’re a whiz at typing commands, you can insert a field by typing it 
directly in your document. Just follow these steps:

Another Way to Insert Fields
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 1. Position the insertion point where you want to insert the field.

 2. Type the field name and instructions for the field you want to insert.

  Don’t worry about the curly braces for now. Just type the field and its 
instructions.

 3. Select the text you typed in Step 2.

 4. Press Ctrl+F9.

Ctrl+F9 converts the selected text to a field by enclosing it in field codes: 
those curly little braces that look just like the curly braces you can type with 
the keyboard but aren’t the same thing at all.

 

If you prefer, you can reverse these steps: Position the insertion point where 
you want to place the field and press Ctrl+F9. An empty field appears, which 
you can select. Then you can type the field name and instructions within the 
braces. Or, you can right-click the empty set of braces and then choose Edit 
Field to open the Field dialog box. Then you can use the Field dialog box to 
choose the field name and the instructions.

Formatting Field Results with Switches
Word provides several switches you can use on almost any field to control 
the formatting applied to the field result. You don’t have to use any of these 
switches if you don’t want to. If you omit them, Word makes an educated 
guess about the format of the field result.

You can use four switches to format a field’s result:

 ✦ The Mergeformat switch (\* Mergeformat) tells Word to preserve the 
formatting you include.

 ✦ The Format switch (\*) tells Word whether to capitalize the field results 
and, for fields that produce numeric results, which type of numbers to 
create (Arabic or Roman numerals, for example).

 ✦ The Numeric Picture switch (\#) controls the format of numbers.

 ✦ The Date-Time Picture switch (\@) sets the format of dates and times.

Formatting Field Results with Switches
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Each of these switches has numerous options that you can mix and match to 
format the field in just about any way you want. I explain the various uses of 
these three switches in the following sections.

Preserving formatting when you update fields: 
The \* Mergeformat switch
When you update a field, Word usually removes any formatting, such as bold 
or italics, that you applied to a field result. If you want Word to keep this 
type of formatting, include the \* Mergeformat switch in the field. Preserving 
formatting is usually a good idea, so I recommend that you use this switch 
most of the time.

You can tell Word to automatically add a \* Mergeformat switch to a field 
by selecting the Preserve Formatting During Updates check box in the Field 
dialog box.

Capitalizing field results
Use the Format switch (\*) options I list in Table 3-2 to control capitalization 
in a field result. The following field, for example, inserts the name of the cur-
rent file in lowercase letters:

{ filename \* lower \* mergeformat }

Table 3-2 Capitalizing Field Results

Switch What It Means

\* caps The First Letter Of Each Word Is Capitalized.

\* firstcap The first letter of the first word is capitalized.

\* lower all letters are lowercase.

\* upper ALL LETTERS ARE UPPERCASE.

Setting the number format
Numbers are usually displayed with Arabic numerals. You can change the 
format of numbers in field results, however, by using the switches listed in 
Table 3-3.

Formatting Field Results with Switches
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Table 3-3 Setting the Number Format

Switch What It Means

\* alphabetic Converts numbers to lowercase letters. (1 becomes a, 2 
becomes b, and so on.)

\* ALPHABETIC Converts numbers to uppercase letters. (1 becomes A, 2 
becomes B, and so on.)

\* Arabic The usual number format (nothing special here).

\* CardText Spells out the number. (For example, 1994 becomes one 
thousand nine hundred ninety-four.)

\* DollarText Spells out a dollar amount the way you write it on a check. 
(289.95 becomes two hundred eighty-nine and 95/100.)

\* Hex A favorite of computer nerds; converts numbers from the 
normal Earth dweller base 10 numbering system to base 16. 
(For example, 492 becomes 1EC.)

\* Ordinal Adds the letters st, nd, or rd (or whatever is appropriate) to 
the end of the number. (For example, 307 becomes 307th.)

\* OrdText Spells out the number and adds the letters st, nd, or rd 
(or whatever is appropriate) to the end. (For example, 307 
becomes three hundred seventh.)

\* roman Converts the number to lowercase roman numerals. Film 
directors use this format to mark copyright dates. (For 
example, 1953 becomes mcmliii.)

\* ROMAN Converts the number to uppercase Roman numerals. (For 
example, 1953 becomes MCMLIII.)

Consider this text, for example:

This is the { page \* OrdText \* mergeformat } page.

This line produces a result like this:

This is the thirty-third page.

In this case, the \* OrdText switch spells out the page number.

 The capitalization used in the table doesn’t matter except for the Alphabetic 
and Roman formats. In that case, capitalization determines whether upper- 
or lowercase letters are displayed for the field value.

Formatting Field Results with Switches
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Creating custom number formats
If you don’t like the way Word displays numbers, you can create your own, 
custom number formats by using the Numeric Picture switch (\#). Numeric 
pictures are created by stringing together a bunch of pound signs, zeros, 
commas, decimal points, plus or minus signs, dollar signs, and other charac-
ters to show how you want numbers to appear. Table 3-4 lists the numeric 
picture switches you’re most likely to use.

Table 3-4 Sample Numeric Picture Switches

Picture Switch Type of Number It Prints

\# #,##0 Whole numbers with commas to separate groups of 
thousands (for example, 1,024 and 1,244,212).

\# #,##0.00 Numbers with commas to separate groups of thou-
sands and two decimal positions. Both decimal posi-
tions print even if one or both of them is zero (for 
example, 1,024.00 and 8.47).

\# $#,##0.00;($#,##0.00) Numbers as money: commas to separate groups of 
thousands, two decimal positions, and a leading dollar 
sign; for example, $1,024.00. Negative numbers are 
enclosed in parentheses; for example, ($97.38).

\# 0 Whole numbers without commas (for example, 38 and 
124873345).

\# 0% Whole numbers without commas, followed by a per-
cent sign (for example, 98%).

\# 0.00 Numbers without commas but with two decimal posi-
tions (for example, 1024.00 or 3.14).

\# 0.00% Numbers without commas, with two decimal positions, 
and followed by a percent sign (for example, 97.99%).

Creating custom date and time formats
When you insert a date field, you can click the Options button and choose from 
one of 17 different formats. If you don’t like any of the 17 formats, you can com-
pose your own, custom date format by using the Date-Time Picture switch (\@). 
You just string together the various components of the date or time by using 
combinations of characters, such as MMM to stand for the three-letter month 
abbreviation, and dddd to stand for the day of the week, spelled out.

Formatting Field Results with Switches
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You’d think with 17 date formats to choose from, you could always find the 
one you need. That’s not always the case, though. For example, if you want 
just the year (as in 2006), you have to create a custom date format using the 
switch \@ “yyyy”. Word doesn’t provide this seemingly basic date format 
among its 17 formats.

Updating a Field
When you first insert a field, Word calculates the field’s result. Thereafter, 
the field result might become out of date. To recalculate a field result to 
ensure that it’s up-to-date, follow one of these procedures:

 ✦ Click the File tab and then click Options and select the Display tab. Then 
select the Update Fields Before Printing check box and click OK. Word 
automatically updates all fields every time you print the document.

 ✦ To update a specific field, select the field and press F9. If you select sev-
eral fields, pressing F9 updates all of them. You can quickly update all 
fields in a document by pressing Ctrl+A to select the entire document 
and then pressing F9 to update the fields.

 ✦ If you point to a field with the cursor and right-click, a shortcut menu 
appears. Choose the Update Field command from this menu to update 
the field.

Preventing a Field from Being Updated
If you do not want to update a field, you can either lock the field or unlink the 
field. If you lock the field, Word prevents it from updating until you unlock 
the field. If you unlink the field, Word deletes the field code and replaces 
it with the result text. Locking a field temporarily prevents it from being 
updated; unlinking the field is permanent.

To lock, unlock, or unlink a field, first select it. Then use the keyboard short-
cuts I list in Table 3-5.

Table 3-5 Keyboard Shortcuts for Locking, Unlocking, 
 or Unlinking a Field

Keyboard Shortcut What It Does

Ctrl+F11 Locks the field

Ctrl+Shift+F11 Unlocks the field

Ctrl+Shift+F9 Unlinks the field (converts the field to results 
text)

Updating a Field
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Field Code Reference
Table 3-6 lists all field codes available in Word 2010, along with a brief 
description of what each one does. For more detailed information about 
each field code, check the information available by using the Insert Field 
Code dialog box.

Table 3-6 Word Field Codes

Field Code What It Does

= (Formula) Lets you insert formulas into your documents.

AddressBlock Inserts a mail-merge address block.

Advance Moves the text that follows the Advance field to the right or left 
or up or down or to a specific position. In most cases, adjusting 
the positioning by using the Font or Paragraph dialog box works 
better.

Ask Prompts for information from the user and stores the result in a 
bookmark. A separate dialog box appears and asks questions.

(continued)

How I learned to love the Seq field
Seq is one of my favorite fields because it lets 
me create a type of numbered list that I use all 
the time and that can’t be done easily using 
Word’s numbering feature. When I plan the 
table of contents for a book, I have to create a 
list that looks something like this:

 Part I: Basic PowerPoint 2010 Stuff

  Chapter 1: Opening Ceremonies

  Chapter 2: Editing Slides

  Chapter 3: Outlining Your Presentation

 Part II: Making Your Presentations Look 
Mahvelous

  Chapter 4: Fabulous Text Formats

  Chapter 5: Working with Pictures and Clip 
Art

  Chapter 6: A Slide of a Different Color

Do you see in this example how the chapters 
are numbered sequentially (1 through 6) and 
the parts also are numbered sequentially (I, II, 
and so on)? You can’t easily create this type of 
list by using Word’s built-in numbering feature. 
But you can do it if you use a Seq field. For the 
part numbers, use the Seq field like this:

  { seq part \* ROMAN \*mergeformat }

For chapter numbers, use the Seq field like this:

  { seq chapter \* mergeformat }

The words part and chapter in the fields let 
Word keep track of two separate lists at the 
same time.

Field Code Reference
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Table 3-6 (continued)

Field Code What It Does

Author Obtains author name from the document properties or sets the 
Author property to a new value.

AutoNum Automatically numbers the paragraph.

AutoNumLgl Automatically numbers heading paragraphs using legal or 
technical format — for example, 1.1, 1.2, and so on (but has 
been rendered obsolete by Word’s built-in numbered lists). 
Place an AutoNumLgl field at the beginning of each paragraph 
you want numbered.

AutoNumOut Automatically numbers heading paragraphs using outline form 
(but has been rendered obsolete by Word’s built-in lists). Place 
an AutoNumOut field at the beginning of each paragraph you 
want numbered.

AutoText Inserts an AutoText entry.

AutoTextList Creates a shortcut menu in the document that allows the user 
to select AutoText entries.

BarCode Inserts a postal bar code based on an address.

Bibliography Inserts a bibliography entry.

BidiOutline Reverses the direction of outline numbering in documents that 
mix languages reading from left to right, such as English, and 
from right to left, such as Hebrew or Arabic.

Citation Inserts a citation.

Comments Shows the contents of the comments field from the document’s 
properties and allows you to change the comments.

Compare Compares two expressions and returns a value of 1 if the com-
parison is true and 0 if false. It’s similar to the If field code.

CreateDate Inserts the document’s creation date.

Database Inserts the result of a database query into the document as a 
table.

Date Inserts the current date into the document. (Word gets the date 
from Windows. To reset the date if it looks wrong, double-click 
the date that appears on the right side of the Windows taskbar.)

DocProperty Retrieves a specified document property. Many of these docu-
ment properties are also available via their own field codes, 
such as Author and EditTime. Some are also available via the 
Info field.

DocVariable Inserts the value of a document variable into your text.

Field Code Reference
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Field Code What It Does

EditTime Inserts the total editing time in minutes since the document 
was created. Don’t be fooled into thinking that this number 
somehow reflects a meaningful measure of how long you spent 
working on the document, because the clock continues to run 
while a document is open whether or not you’re working on it. 
(If you’re paid based on this field, I recommend leaving your 
documents open overnight.)

Eq Creates rudimentary mathematical equations and is left over 
from the days before Word had built-in equations.

FileName Inserts the filename of the current document, with or without 
the complete path.

FileSize Inserts the size of the document file in bytes, kilobytes, or 
megabytes.

Fill-in Prompts the user for text and then inserts the text into the 
document as the field result. It is similar to the Ask field, except 
that Ask places the user’s input in a bookmark rather than in 
the document.

GoToButton Creates a button that moves the insertion point to a specified 
location when clicked.

GreetingLine Inserts the greeting line for a mail merge.

Hyperlink Inserts a hyperlink.

If Compares the results of two expressions and supplies one of 
two result values depending on the outcome of the comparison.

IncludePicture Inserts a picture into the document. Inserting a picture is much 
easier using the Insert tab (click Picture in the Illustrations 
group on the Insert tab), so this field is obsolete.

IncludeText Inserts another document into the current document.

Index Inserts an index. You must first mark entries to be included in 
the index with XE fields. Note that creating an index is much 
easier when you use the References tab.

Info Retrieves specified document information. Many of these docu-
ment properties are also available via their own field codes, 
such as Author or EditTime. Most are also available via the 
DocProperty field. The Info field also lets you set a new value 
for several of the properties.

Keywords Displays keywords from the document properties.

LastSavedBy Displays the name of the user who last saved the document.

Link Inserts into the document a file or portion of a file created by 
another application.

(continued)

Field Code Reference
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Table 3-6 (continued)

Field Code What It Does

ListNum Inserts an element in a list.

MacroButton Inserts a button that, when clicked, runs a macro.

MergeField Sets up a merge field that’s replaced by data from the data 
source when the mail merge is processed.

MergeRec Sets up a merge field that displays the number of the data 
record being processed during a mail merge.

MergeSeq Displays a count of the number of records that have been 
merged at that point during a mail merge.

Next Skips to the next record in the data source without starting a 
new merge document. Use this field if you want each merge 
document to include data from two or more records.

Nextlf Skips to the next merge record if the specified condition is true. 
The Mail Merge Wizard (on the Mailings tab) handles condi-
tional merging better.

NoteRef Allows you to refer to a footnote or endnote that’s already 
marked so that if the footnote or endnote changes, the refer-
ence changes along with it.

NumChars Inserts the number of characters in the document.

NumPages Inserts the number of pages in the document.

NumWords Inserts the number of words in the document.

Page Inserts the current page number. This field is inserted into the 
header or footer when you click the Page Number button.

PageRef Inserts the number of the page on which a specified bookmark 
appears.

Print Sends printer codes directly to the printer when the document 
prints. This field is left over from the days when printers were 
more primitive and you sometimes had to coerce the printer to 
work by sending special printer codes.

PrintDate Displays the date on which the document was last printed.

Private Holds information that’s stored when a document converts 
from one format to another. This field is intended for use only 
by document converters.

Quote Inserts text into a document.

Field Code Reference
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Field Code What It Does

RD Lets you create a table of contents or an index for a multifile 
project without dealing with Word’s master document feature. 
Unfortunately, this method doesn’t automatically number pages 
consecutively from one document to the next. Instead, you 
must manually set the page numbers and update any TOC, TOA, 
or Index fields in the separate documents.

Ref Inserts the contents of the specified bookmark. This field is the 
only one for which the field code itself is optional. As a result, 
you can cite only the name of the bookmark.

RevNum Inserts the number of times the document is saved. Thus, if 
you save a document ten times in the course of an hour (not an 
unreasonable rate), you produce ten revisions. Unfortunately, 
this result probably isn’t what you or I think of as a true revision 
number, because most users frequently save their work.

SaveDate Inserts the date on which the document was last saved.

Section Inserts the current section number.

SectionPages Inserts the total number of pages in the current section.

Seq Creates sequence numbers, such as a numbered list or chapter 
or heading numbers. For simple lists, use the Numbering button 
in the Paragraph group on the Home tab.

Set Lets you create a bookmark for text that isn’t visible in the 
document.

Skiplf Conditionally skips the next merge record during a mail merge, 
based on the results of a comparison. The Mailings tab on the 
Ribbon has better tools for handling conditional merging, so 
avoid using this field.

StyleRef Inserts text formatted in a particular style. This field is most 
useful for creating dictionary-style headers or footers that cite 
the first or last heading on the page.

Subject Inserts the document subject, taken from the document’s 
properties.

Symbol Inserts a symbol into the document. The result is far easier to 
accomplish by using the Symbol button in the Symbols group 
on the Insert tab.

TA Marks a citation to be included in a table of authorities. This 
field is inserted when you press Alt+Shift+I to mark a citation.

TC Marks an entry to be included in a table of contents. You can 
more easily compile tables of contents based on heading 
styles, but if you must do it the hard way, use TC fields instead.

(continued)

Field Code Reference
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Table 3-6 (continued)

Field Code What It Does

Template Inserts the filename of the template attached to the document.

Time Inserts the current time.

Title Inserts the document title taken from the document’s 
properties.

TOA Compiles a table of authorities based on TA fields inserted 
into the document. This field is inserted when you use the 
References tab on the Ribbon to insert a Table of Authorities.

TOC Compiles a table of contents. This field is inserted when you 
use the References tab to insert a table of contents.

UserAddress Inserts the user’s address taken from the Advanced tab of the 
Word Options dialog box. (Choose File➪Options to open the 
Word Options dialog box.)

UserInitials Inserts the user’s initials.

UserName Inserts the user’s name.

XE Marks an entry for inclusion in an index. XE fields insert when 
you press Alt+Shift+X.

Field Code Reference
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Chapter 4: Creating Custom Forms

In This Chapter
✓ Getting to know forms

✓ Making a form template

✓ Inserting a text field

✓ Inserting a check box field

✓ Adding a drop-down field

✓ Entering data into a form

✓ Adding help to a field

My guess is that Microsoft had a lucrative contract with the 
government — probably the military — to sell a million copies of 

Word to the government if the program provided a feature for creating 
and filling in forms, preferably in triplicate. So here I am, ready to write 
another chapter for this book. I’d really rather call it a day and maybe 
catch a quick round of golf, but — who knows? — maybe the government 
will buy a truckload of copies of this book at $913 apiece if I throw in a 
chapter about creating and filling in forms.

You might not realize it, but creating a form that you or someone else can 
fill out later qualifies as a type of programming. Therefore, you must adopt a 
bit of a programmer’s mentality, distasteful as that might seem. In this chap-
ter, the word user refers to the person — you or someone else — who fills 
out a form that you create, just to keep you alert.

Also, be aware that Word 2010 introduces a new type of form that’s 
designed to work with data stored in files in XML format. These types of 
forms are usually created by application developers who are intimately 
familiar with XML. The forms that I show you how to create in this book are 
simply documents that restrict the user’s input to specific parts of the docu-
ment and have nothing to do with XML.

Understanding Forms
A form is a special type of document in which parts of the document are 
protected from user modification. A user can enter information only in pre-
defined, fill-in-the-blank portions of the document, which are form fields.
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Figure 4-1 shows an example of a form I created in Word. Most of the text 
you see in the document is protected. The only parts of the document that 
the user can modify are the shaded parts: the name and address fields, the 
answers to the two questions, and the check boxes.

 

Figure 4-1: 
A Word 
form.

 

I provide the exact steps for creating and filling out a blank form later in this 
chapter, but the general idea goes something like this: First you create a new 
template. Then you add to the template any text that you want to appear in the 
form, and you add the form fields using buttons available in the Controls section 
of the Developer tab. When you finish the blank form, use the Restrict Editing 
command (on the Developer tab) to prevent the user from modifying any part of 
the document other than the form fields and, finally, save the template.

To fill in a form, you have to create a new document based on the form tem-
plate. Then fill in the blanks. Word doesn’t allow you to move the insertion 
point anywhere outside the form fields, so you don’t have to worry about 
accidentally messing up the form.

 ✦ Think of the template as a pile of blank forms. To fill out a form, first you 
have to grab a form from the pile by opening the template. After you fill 
out the form (the template), you can save it as a normal document. The 
saved document contains the form itself that’s copied from the tem-
plate, plus whatever information you typed into the form fields.

Understanding Forms
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 ✦ Although it’s not apparent in Figure 4-1, the form fields for the first two 
questions are drop-down list boxes. Rather than type a response to the 
question, the user selects one of several permissible responses. If, for 
example, the user clicks in the form field for the first question (“How 
would you rate Word 2010’s ease of use?”), the drop-down list shown in 
Figure 4-2 appears.

 

Figure 4-2: 
A drop-
down list.

 

 ✦ Microsoft offers several form templates for download at the Microsoft 
Office Online Web site (http://office.microsoft.com). To see 
what you can do with forms, try downloading a few of these templates.

Creating a Form Template
Before you can fill out a form, you must create a template. The template con-
tains any text and graphics that appear on the blank form as well as the form 
fields, in which the user enters information.

To create a form template, follow these steps:

 1. Choose File➪New to display the New page in Backstage view, and 
then select Blank Document and click Create.

  This action creates a new, blank document.

 2. Choose File➪Save As.

  The Save As dialog box appears.

 3. Select Word Template from the Save As Type drop-down list.

 4. If you want the template to be available from the File➪New command, 
navigate to your Templates folder.

  To discover the folder location, choose File➪Options, click the 
Advanced tab, scroll all the way to the bottom, and click File Locations. 
Then select User Templates and click the Modify button.

 5. Type a name for your new form template and click Save.

  The initial copy of the template is saved.

Creating a Form Template
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 6. Choose File➪Options.

  This step opens the Word Options dialog box.

 7. On the Customize Ribbon tab, select the Developer tab in the list box 
on the right. Then click OK.

  The Developer tab appears. It contains the commands you need in order 
to create a form, as shown in Figure 4-3.

 

Figure 4-3: 
The 
Developer 
tab.

 

 8. Create your form.

  Type text where you want text to appear, insert graphics where you 
want graphics to appear, and insert form fields where you want form 
fields to appear. (Much of the rest of this chapter is devoted to this 
task.)

  To insert form fields, click the Legacy Tools button in the Controls 
group on the Developer tab. This action reveals the menu of controls 
shown in Figure 4-4. The form controls are in the top row of this menu, 
labeled Legacy Forms. For more specific information on creating these 
fields, see the following three sections.

 

Figure 4-4: 
Legacy 
Forms 
menu.

 

 9. Click the Restrict Editing button, found in the Protect group of the 
Developer tab on the Ribbon.

  The Restrict Formatting and Editing task pane appears, as shown in 
Figure 4-5.

Creating a Form Template
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Figure 4-5: 
The Restrict 
Formatting 
and Editing 
task pane.

 

 10. Select the Allow Only This Type of Editing in the Document check box 
and then select Filling In Forms from the drop-down list.

  This action protects the document so that the user can enter data only 
in the form fields.

 11. Click the Yes, Start Enforcing Protection button in the Restrict 
Formatting and Editing task pane.

  The dialog box shown in Figure 4-6 appears.

 12. Type the password you want to use to protect the document in both 
text boxes and then click OK.

  Using a password helps ensure that only you can unprotect the form to 
make changes to the form’s layout. If you don’t care about password-
protecting the form, just click OK without typing a password.

 13. Choose File➪Save to save the template.

  That’s all. You’re done.

Creating a Form Template
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Figure 4-6: 
The Start 
Enforcing 
Protection 
dialog box.

 

Here are some suggestions for creating forms:

 ✦ If you’re converting a paper form to Word, create the Word form so that 
it looks as much like the current paper form as possible. Work in Print 
Layout view so that you can see how the form elements line up.

 ✦ If you want the form to be laid out on a grid with ruled lines and boxes, 
use tables, text boxes, borders, shading, and whatever other Word fea-
tures you can muster.

 ✦ If you’re creating a template for the first time, you may want to refer to 
Book I, Chapter 3 to make sure you know the ins and outs of working 
with templates.

 

✦ Creating a form is tedious work. You might not want to wait until the end 
of the process to save the template. In fact, you should press Ctrl+S to 
save your work every few minutes.

 ✦ If you protect the template by using the Restrict Editing command, you 
must unprotect the template if you need to change the layout of the 
form later. Click Restrict Editing (in the Protect group on the Developer 
tab) to open the Restrict Formatting and Editing task pane. Then click 
the Stop Protection button at the bottom of the task pane. If you used a 
password when you protected the document, you’re asked to enter the 
password to unprotect the document. Don’t forget to protect the form 
again when you finish!

Creating a Text Field
A text field is a form field in which a user can type information. You use text 
fields to provide a space on the form where the user can enter information, 
such as a name or an address. The form shown in Figure 4-1 uses four text 
fields: one for the name and three for the address lines.

Creating a Text Field
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To create a text field in a form, follow these steps:

 1. Position the insertion point on the template where you want the text 
field to appear.

  2. In the Controls group of the Developer tab, click Legacy Tools and 
then click the Text Form Field button.

  A text form field is inserted.

  There’s a similar control in the Controls group, but it doesn’t do the 
same thing. Be sure to use the control in the Legacy Controls drop-down 
menu.

You should type some sort of text into the template next to the field to tell 
the user what to type in the field. For example, in Figure 4-1, I typed Name: 
next to the text field that’s supposed to contain the name.

If you want to provide a default value for the text field — that is, a value that 
the field assumes if the user types nothing in the field — double-click the 
text field to summon the Text Form Field Options dialog box, as shown in 
Figure 4-7. Type a default value for the field in the Default Text box and then 
click OK.

 

Figure 4-7: 
The Text 
Form Field 
Options 
dialog box.

 

In the Text Form Field Options dialog box, you can also set the field type. 
Word lets you create six different types of text fields, as summarized in 
Table 4-1.

Creating a Text Field
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Table 4-1 Text Field Types

Text Field Type Description

Regular Text This field consists of ordinary text, such as a name or an 
address. The user can type anything in the field.

Number The user must type a number in the field.

Date The user must type a date in the field. The date must be in 
the month/day/year format (for example, 05/31/11 or 6-24-
11) or may include the month spelled out (as in March 28, 
2011).

Current Date Word automatically inserts the current date into the field. 
The user can’t type anything in the field.

Current Time Word automatically inserts the current time into the field. 
The user can’t type anything in the field.

Calculation The field contains a formula field (=) to calculate a result 
value, usually based on the value of one or more number 
fields. The user cannot type anything in this field.

If you deselect the Fill-In Enabled check box in the Text Form Field Options 
dialog box (see Figure 4-7), Word displays the text field, but the user can’t 
modify it. Use this field only if you plan to do some fancy macro program-
ming, in which a macro enables or disables the field at will. This kind of 
macro programming requires programming knowledge that is way beyond 
the realm of reasonable.

 

After you create a text field, you can open the Text Form Field Options 
dialog box by double-clicking the field or right-clicking the field and choos-
ing Properties from the shortcut menu that appears.

Creating a Check Box Field
A check box field is a field that the user can select or deselect to provide a 
Yes or No answer. Check box fields work just like regular check boxes in 
dialog boxes: You click them to select or deselect them.

Follow these steps to create or insert a check box field:

 1. Position the insertion point in the template where you want the check 
box field to appear.

  2. In the Controls group of the Developer tab, click Legacy Tools and 
then click the Check Box Form Field button.

  A check box form field is inserted.

Creating a Check Box Field
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  There’s a similar control in the Controls group, but it doesn’t do the 
same thing. Be sure to use the control in the Legacy Controls drop-down 
menu.

 3. If you want the check box to not be selected when the form is first 
displayed, you’re done. Otherwise, double-click the Check Box form 
field.

  The Check Box Form Field Options dialog box opens, as shown in 
Figure 4-8.

 

Figure 4-8: 
The Check 
Box Form 
Field 
Options 
dialog box.

 

 4. Select the Checked option.

  The check box is selected when the form is first displayed.

 5. Click OK.

The check box is now inserted in the document.

Here are some pointers for creating a check box field:

 

✦ Obviously, a check box by itself is of little worth. You want to place 
some text in the template right next to the check box so that the user 
knows what the check box field means.

 ✦ Unless you’re into writing macros, the only thing you can do with a 
check box is select it or deselect it. If you want to roll up your sleeves 
and do some heavy-duty macro programming, you can come up with all 
sorts of exotic uses for check box fields.

 ✦ If you want to change the default size of the check box field, select 
Exactly (at the top of the Check Box Form Field Options dialog box) and 
type the size of the check box in points.

Creating a Check Box Field
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 ✦ If you deselect the Check Box Enabled check box, Word displays the 
check box field, but the user can’t modify it. Use this field only if you 
plan to do some fancy macro programming, in which a macro enables 
the field if the user enters a certain value into another field. To reenable 
the check box, select the Check Box Enabled check box.

  Sounds like a scene from the movie Airplane, doesn’t it?

  Roger: Chuck, check the Check Box Enabled Check Box.

  Chuck: Roger, Roger. Now checking the Check Box Enabled check box. 
Chuck out.

  Roger: Check, Chuck.

 

✦ You can open the Check Box Form Field Options dialog box after you 
insert a check box field by double-clicking the field or by right-clicking 
the field (that is, pointing to it and clicking the right mouse button) and 
selecting Properties from the shortcut menu that appears.

Creating a Drop-Down Field
A drop-down field is similar to a text field, except that the user isn’t allowed 
to type text directly in the field. Instead, the user must select from a list of 
preset choices given in a list box. List boxes are helpful for fields such as 
marital status, shipping instructions, or gender (in other words, fields that 
have only a limited set of correct answers).

Follow these steps to create, or insert, a drop-down field:

 1. Position the insertion point in the template where you want the drop-
down list field to appear.

  2. In the Controls group of the Developer tab, click Legacy Tools and 
then click the Drop-Down Form Field button.

  A drop-down form field is inserted.

  There’s a similar control in the Controls group, but it doesn’t do the 
same thing. Be sure to use the control in the Legacy Controls drop-down 
menu.

 3. Double-click the drop-down form field.

  The Drop-Down Form Field Options dialog box appears, as shown in 
Figure 4-9.

Creating a Drop-Down Field
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Figure 4-9: 
The Drop-
Down 
Form Field 
Options 
dialog box.

 

 4. To add an item to the drop-down list, type some text in the Drop-Down 
Item box and then click the Add button.

  The text is added to the Items in Drop-Down List field.

 5. Repeat Step 4 for each item you want to include as a choice in the 
drop-down list.

 6. When you add all the items you want in the list, click OK.

  That’s it!

If you’re going to the trouble of creating drop-down list fields, keep the fol-
lowing hot tips in mind:

 ✦ The first item in the drop-down list is the default selection — that is, the 
item initially selected for the field.

 ✦ To rearrange items in the drop-down list, open the Drop-Down Form 
Field Options dialog box, select the item that you want to move to 
another position in the list, and click the up or down Move buttons.

 ✦ To delete an item from the list, select the item and click the Remove 
button.

 

✦ To correct a mistake in a list item, delete the incorrect item. Word 
copies the deleted item to the Drop-Down Item box, where you can cor-
rect the mistake and click the Add button to reinsert the item.

 ✦ If you deselect the Drop-Down Enabled check box, Word displays the 
drop-down list field but the user can’t modify it. Use this field only if you 
plan to do some fancy macro programming, in which a macro enables 
or disables the field on the fly. (Try to con a computer nerd friend into 
working this macro for you.)

 

✦ You can open the Drop-Down Form Field Options dialog box after you 
insert a drop-down field by double-clicking the field or right-clicking the 
field and selecting the Properties from the shortcut menu that appears.

Creating a Drop-Down Field
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Filling Out a Form
After you create a form template and protect it, it’s time to put the form to 
good use in collecting the vital information that you so carefully designed it 
to record. In other words, it’s time to fill out the form.

To fill out a form by using a form template that you or someone else created, 
follow these steps:

 1. Choose File➪New.

  The New page of Backstage view appears.

 2. Click My Templates and then select the correct form template from 
the list of templates.

 3. Click OK.

 4. Fill in the form fields.

  When you fill in the form fields, you can use any of the keyboard actions 
listed in Table 4-2. For the most part, you press the Tab key to move 
from field to field.

  The spell checker doesn’t work in form fields, so you have to be careful 
about your spelling when you work with a form.

 5. Print the document.

  Choose File➪Print and then click the Print button.

 6. Save the file, if you want.

  Choose File➪Save.

Table 4-2 Keys You Can Use When Filling Out a Form

Key What It Does

Enter, Tab, or ↓ Moves the insertion point to the next field

Shift+Tab, or ↑ Moves the insertion point to the previous field

Alt+↓ or F4 Displays a drop-down list

↑ or ↓ Moves up or down in a drop-down list

Spacebar or X Selects or deselects a check box field

F1 Displays Help text for a field

Ctrl+Tab Inserts a tab character into a text field

Filling Out a Form
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Adding Help to a Form Field
Word lets you add your own Help text to form fields. Then if you forget what 
a field is for when you’re filling out a form, the Help text reminds you.

You can create two types of Help text for each field. Status bar help informa-
tion appears on a single line of text on the status bar whenever the insertion 
point moves into the field. Word limits this Help text to 138 characters so 
that it fits in the space provided on the status bar. If the status bar help isn’t 
enough, you can supply as many as 256 characters of Help text, which the 
user can summon by pressing F1. Figure 4-10 shows an example of Help text.

 

Figure 4-10: 
Help text for 
a form field.

 

To create Help text for a field, follow these steps:

 1. Select the field to which you want to add Help text.

  Make sure that the form is unprotected. You can’t add Help text to a 
field while the form is protected.

 2. Double-click the field to open the Form Field Options dialog box.

 3. Click the Add Help Text button.

  The Form Field Help Text dialog box appears, as shown in Figure 4-11.

 

Figure 4-11: 
Adding help 
to a form 
field.

 

Adding Help to a Form Field
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 4. Type the status bar Help text on the Status Bar tab and the Help text 
on the Help Key (F1) tab.

 5. Click OK.

  The Help text is now attached to the field. The user can display it by 
pressing F1.

Using Preprinted Forms
If you’re creating an online form for a document for which you have pre-
printed forms to use with your printer, format the form template so that its 
fields align exactly with the form fields on the preprinted form. Then when 
you want to print to the preprinted form, choose File➪Options. In the Word 
Options dialog box, click the Advanced tab, scroll down to the When Printing 
This Document options, and then select the Print Only the Data from a Form 
option. Word prints just the data you enter into the form fields, not the form 
template itself. If your preprinted forms and your form template are lined up 
properly, the data fits snugly in the fields on the preprinted form.

Using Preprinted Forms
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Chapter 1: Recording and 
Using Macros

In This Chapter
✓ Recording a macro

✓ Running a macro

✓ Editing a macro

✓ Using auto macros

Amacro is a sequence of commands or keystrokes that Word records 
and lets you play back at any time. Macros allow you to create your 

own customized shortcuts for tasks you do repeatedly. For example, Word 
comes with built-in keyboard shortcuts to make text bold (Ctrl+B) or italic 
(Ctrl+I), but no built-in shortcut exists to make text bold and italic all at the 
same time. To perform that formatting task, you have to press Ctrl+B and 
then press Ctrl+I. If you do that a million times a day, pretty soon that extra 
keystroke becomes bothersome. Wouldn’t having a shortcut for bold-italic 
be nice? With Word’s macro recorder, you can create one.

This chapter shows you how to record and play back simple macros. It 
doesn’t show you how to create complex macros by using Word’s macro 
programming language, Visual Basic for Applications. That’s the topic of the 
remaining chapters in this minibook.

Where Do All the Macros Go?
You can store macros in documents or in templates. When you create a 
macro, you have three choices for where to store the macro:

 ✦ The current document: The best place to create macros that you will 
use in only a single document.

 ✦ The template that’s attached to the current document if it’s macro-
enabled: The best place to create macros that you want to use in a 
large number of similar documents. Then the macros are available to 
any document you create from the template.

 ✦ The Normal.dotm template: The place to create macros that you want 
to be available all the time, no matter which document you’re working on.
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Note: If the current document is based on Normal.dotm, you have only two 
choices — the current document or the Normal.dotm template.

 

When you create a macro, you need to think about when you’ll want to 
run the macro. If you need to run it only from within a specific document, 
create the macro in that document. If you want the macro to be available 
only to documents based on a particular template, create the macro in that 
template. But if you want the macro to always be available no matter which 
document you’re working on, store the macro in Normal.dotm.

 

You can also store macros in a global template, which is a useful place to 
create a library of macros that are available to all your documents. For more 
information about using global templates, turn to Book I, Chapter 3. Note: 

To create or edit macros in a global template, you must open the template. 
After you create macros in a template, you can close the template, attach it 
as a global template, and then run any macros it contains.

Doing the Macro Recorder Dance
The easiest way to create a macro is to use the macro recorder, which is kind 
of like a videocassette recorder. After you turn on the macro recorder, it 
follows you around and makes a precise record of everything you do until 
you turn off the recorder. Well, not everything — the Word macro recorder 
records only the stuff you do in Word. It doesn’t notice when you dribble 
coffee down your chin or sneeze on the monitor. But when you turn on the 
recorder, anything you do in Word — whether you’re typing text, applying 
formatting, calling up a command, or filling out a dialog box — is carefully 
recorded.

Then when you turn off the recorder, you can replay the recorded macro to 
repeat the exact sequence of steps that Word recorded in the macro.

 

About the only things that are not recorded by the macro recorder are 
mouse movements within the document. The macro recorder records but-
tons or Ribbon choices you click, but Word doesn’t let you navigate your 
document or select text with the mouse while the macro is recording. As a 
result, use the keyboard for navigating or selecting text while recording a 
macro.

To record a macro, follow these steps:

 1. Try to talk yourself out of it.

  Fiddling around with macros can be a bit of a time-waster. Ask your-
self whether you truly will use the macro after you go to the trouble of 
recording it. If not, go directly to Step 12.

Doing the Macro Recorder Dance
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 2. Think about what you’re going to do.

  Think through all the steps you have to follow to accomplish whatever 
task you want to automate with a macro. To create a macro that makes 
text bold and italic, for example, all you have to do is press Ctrl+B and 
then press Ctrl+I. That’s a simple macro, but other macros can be much 
more complex, involving dozens of steps. If necessary, rehearse the 
steps before you record them as a macro.

 3. Click the Developer tab on the Ribbon and then click the Record 
Macro button in the Code group.

  The Record Macro dialog box appears, as shown in Figure 1-1.

 

Figure 1-1: 
The Record 
Macro 
dialog box.

 

 

 If the Developer tab isn’t visible, choose File➪Options to summon the 
Word Options dialog box. Then click the Customize Ribbon tab and 
select the Developer check box in the Main Tabs list.

 4. Type the name of the macro you want to create in the Macro Name 
text box.

  The name can be anything you want, but it cannot include spaces, 
commas, or periods. When the Record Macro dialog box first appears, 
the macro name is set to something like Macro1 or Macro2 (or Macro783 
if you’ve been busy). Surely, you can come up with a better name. (I 
know: “Yes, I can, and stop calling me Shirley.”)

 5. To make your macro accessible from a toolbar or the keyboard, click 
the Button or Keyboard button.

  If you click the Keyboard button, the dialog box shown in Figure 1-2 
appears. Type the shortcut key combination you want to assign to the 
macro (in this case, I pressed Alt+Ctrl+B), click the Assign button, and 
then click Close.

Doing the Macro Recorder Dance
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Figure 1-2: 
Assigning 
a macro to 
a keyboard 
shortcut.

 

  If you click the Button button instead, the Word Options dialog box 
appears with the Quick Access Toolbar tab selected. Then you can 
create a button on the Quick Access toolbar to run the macro. For more 
information, refer to Book VIII, Chapter 1.

 6. Set the Store Macro In drop-down list to the location where you want 
to store the macro.

  The default setting stores the recorded macro in the Normal.dotm 
template so that it’s always available. The other choices available in this 
drop-down list are storing the macro in the document that you were 
working on when you started the macro recorder or storing the macro 
to the template that the document is based on (if it is based on a tem-
plate other than Normal.dotm).

 7. Type the keystrokes and click the Ribbon commands you want to 
record in the macro.

 8. Type the keystrokes and Ribbon commands you want to record in the 
macro.

  To record the BoldItalic macro, for example, press Ctrl+B and then 
press Ctrl+I.

  9. If you have to stop recording temporarily, click the Pause button. 
Click it again to resume recording.

  You might forget how to do something, for example, especially if you 
skipped Step 2. If you click the Pause button, you can call up Word’s Help 
command, look up and read the procedure for whatever task you forgot, 
dismiss Help, and click the Pause button again to resume recording.

  10. After you finish recording the macro, click the Stop Recording button.

  Word adds the macro to the template or document. You’re almost done.

Doing the Macro Recorder Dance
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 11. Test the macro.

  If you assigned the macro to a keyboard shortcut, use the shortcut now 
to see whether the macro works. Otherwise, follow the steps in the later 
section “Running a Macro.”

 12. You’re finished.

  Congratulate yourself.

 

If the function of the macro isn’t obvious from the macro name, type a more 
elaborate description of the macro in the Description field of the Record 
Macro dialog box. You’ll thank yourself later when you forget what the 
macro does.

Macro Recording Tips
Here are some tips to keep in mind as you record macros:

 ✦ You can open the Record Macro dialog box directly by clicking the 
Record Macro button on the status bar. It appears as a little red dot.

 ✦ If the macro doesn’t work, you might have made a mistake while record-
ing it. If the macro is short enough, the best thing to do is to record the 
macro again. If the macro is long and you have nothing important to do, 
try editing the macro to expunge the problem. See the section “Editing a 
Macro,” later in this chapter.

 ✦ Macros are normally stored in the global Normal.dotm template. To 
store a macro in the template attached to the current document, change 
the setting of the Record Macro dialog box’s Store Macro In drop-down 
list.

 

✦ Don’t make any assumptions about where the insertion point will be 
when you run the macro. If necessary, begin the macro with a position-
ing command by moving the insertion point to the beginning of the 
document, the beginning of the line, or the beginning of a word. (Not all 
macros require a positioning command. But if your macro depends in 
any way on the position of the insertion point, this step is a must.)

 ✦ Don’t use the mouse to select text or navigate the document. Word 
doesn’t record these mouse actions. You can use the mouse to select 
Ribbon commands but not to move the insertion point.

 ✦ Use Ctrl+Home or Ctrl+End to move to the beginning or end of a docu-
ment. Don’t use repeated Page Up or Page Down keys for this purpose. 
Pressing Page Up three times might move you to the top of your docu-
ment when you record the macro, but when you run the macro, it might 
not. Similarly, use the Home and End keys, rather than the left or right 
arrow keys, to move to the start or end of a line.

Macro Recording Tips
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 ✦ If you use the Find or Replace commands, be sure to move to the begin-
ning of the document first.

 ✦ Avoid any commands that depend on the contents of a document that’s 
active when you record the macro. If your macro is based on informa-
tion that will never be replicated, it’s a useless macro.

Running a Macro
If you assigned a macro to the Quick Access toolbar or a keyboard shortcut, 
you can run the macro by clicking the Quick Access Toolbar button or press-
ing the keyboard shortcut. If you didn’t, you can run it by following these 
steps:

 1. Select the Developer tab on the Ribbon and then click the Macros 
button in the Code group.

  The Macros dialog box, shown in Figure 1-3, appears.

 

 For a shortcut, you can press Alt+F8.

 2. If the macro you want to run isn’t already selected, select it now. If the 
macro you want doesn’t appear, try changing the Macros In setting.

  The macro might be in a different template.

 3. Click Run.

Sometimes a macro has unexpected side 
effects. Suppose that rather than record the 
keystrokes Ctrl+B and Ctrl+I for the BoldItalic 
macro, you decide to record these steps:

 1. Click the Font group button to display the 
Font dialog box.

 2. Choose Bold Italic as the font style.

 3. Click OK.

The macro seems to work, but sooner or later 
you discover that in addition to recording the 
Bold Italic font style, the macro recorded other 
character attributes — such as the font, size, 
and effects. If the text to which you applied the 

Font dialog box command when you recorded 
the macro was 10-point Times New Roman 
font, every time you apply the macro, the font 
switches to 10-point Times New Roman.

You can avoid these side effects in two ways:

 ✓ Avoid recording dialog boxes in macros 
whenever a keyboard shortcut or a Ribbon 
button can do the trick. Whenever you 
record a dialog box in a macro, you record 
all the dialog box settings.

 ✓ Fix the macro later by editing it and remov-
ing the extraneous information. See the 
later section “Editing a Macro.”

Avoiding unexpected side effects

Running a Macro
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Figure 1-3: 
The Macros 
dialog box.

 

Editing a Macro
If you make a mistake while recording a macro, you can abandon the record-
ing and start over. Or, you can finish the recording and edit the macro to 
correct the mistake. When you edit the macro, its commands appear in a 
separate window. You can delete or modify erroneous commands, you can 
insert new commands if you know how, or you can merely study the macro 
to try to figure out how it works.

When you edit a macro, you’re exposed to Visual Basic for Applications (VBA). 
VBA isn’t as deadly as the Ebola virus, but it can cause severe headaches and 
nausea if you’re not inoculated with the Programmer Vaccine. For more infor-
mation about VBA and its editor, turn to Chapter 2 of this minibook.

Here are the steps for editing a macro:

 1. Click the Macros button on the Developer tab on the Ribbon or on the 
status bar.

  The Macros dialog box appears. (Refer to Figure 1-3.)

 2. Select the macro you want to edit and click the Edit button.

  Word launches the Visual Basic editor, with the macro you selected vis-
ible in its own window. See Figure 1-4.

  Notice that the Visual Basic editor uses good old-fashioned menus 
instead of the newfangled Ribbon. Notice also that you may see addi-
tional macros other than the one you just recorded. For example, 
besides the BoldItalic macro, Figure 1-4 also shows a macro named 
StrikeThrough that was previously recorded.

Editing a Macro
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Figure 1-4: 
Editing a 
macro.

 

 3. Make whatever changes are necessary to the macro.

  Correct misspelled words, delete extraneous commands, and, if you’re 
brave, add more commands.

 4. Choose File➪Save Normal to save your changes.

  Note that if you are editing a macro in a template other than Normal, the 
name of the template will be listed in the Save command. For example, if 
the template is named MyTemplate, you will use the Save MyTemplate 
command to save your edits.

 5. Choose File➪Close and Return to Microsoft Word to close the macro 
window.

Simple Macro Edits That Don’t Require a PhD in VBA
Before you make massive changes to a macro, you need a good level of 
knowledge about VBA. However, you can make certain types of changes 
without knowing much about VBA. Here’s a sampling:

 ✦ Correct spelling errors. If you inserted text into a document and mis-
spelled it, don’t hesitate to edit the macro to correct misspellings. Text 

Simple Macro Edits That Don’t Require a PhD in VBA
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you insert into a document while recording a macro is included in a 
Selection.TypeText command, like this:

Selection.TypeText Text:=”This is some simple text.”

  You can correct any spelling mistakes or change the inserted text alto-
gether, as long as you take care not to remove either of the quotation 
marks that appear before and after the text. For example, you can cor-
rect the preceding line this way:

Selection.TypeText Text:=”This is some sample text.”

 ✦ Remove extraneous commands. If you inadvertently used a command 
while recording a macro, you can clean up your macro by removing the 
unnecessary command.

 ✦ Remove unwanted dialog box settings. If you record a dialog box in a 
macro, Word includes every setting in the dialog box. You can remove 
the settings that you don’t want the macro to change. For example, if 
you use the Font dialog box to format text in small caps, Word inserts 
the following commands into the macro:

With Selection.Font
    .Name = “Times New Roman”
    .Size = 9.5
    .Bold = False
    .Italic = False
    .Underline = wdUnderlineNone
    .UnderlineColor = wdColorAutomatic
    .StrikeThrough = False
    .DoubleStrikeThrough = False
    .Outline = False
    .Emboss = False
    .Shadow = False
    .Hidden = False
    .SmallCaps = True
    .AllCaps = False
    .Color = wdColorAutomatic
    .Engrave = False
    .Superscript = False
    .Subscript = False
    .Spacing = 0.3
    .Scaling = 100
    .Position = 0
    .Kerning = 0
    .Animation = wdAnimationNone
End With

  This command looks complicated at first, but if you study it, you see 
that it’s little more than a list of all dialog box controls that appear in 
the Font dialog box. The periods look strange appearing in front of each 
command argument as they do, but they’re required. You can safely 

Simple Macro Edits That Don’t Require a PhD in VBA
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delete the lines that specify the dialog box controls you don’t want to 
use so that the resulting command looks like this:

With Selection.Font
        .SmallCaps = True
End With

 

 With a little more VBA knowledge, you can also remove the With and 
End With commands and substitute just the following line:

Selection.Font.SmallCaps = True

Using Auto Macros
An auto macro runs automatically whenever a key event happens, such as 
when Word starts or a document closes. Word recognizes auto macros by 
name. For example, a macro named AutoNew automatically runs when you 
create a new document from a template, and a macro named AutoClose 
automatically runs when you close a document.

To create an auto macro, you simply create a macro by using one of these 
special macro names:

 ✦ AutoExec: Runs when Word starts. Store it in the Normal.dotm 
template.

 ✦ AutoExit: Runs when Word exits. Store it in the Normal.dotm template.

 ✦ AutoNew: Runs whenever a new document is created by using the tem-
plate that contains the AutoNew macro.

 ✦ AutoOpen: Runs whenever an existing document opens. You can create 
an AutoOpen macro in the Normal.dotm template or in the template 
that’s attached to the document or both.

 ✦ AutoClose: Runs whenever an open document closes. This macro can 
reside in Normal.dotm or in the template attached to the document.

 

You can prevent any auto macro from executing by holding down the Shift 
key while performing the action that otherwise triggers the macro. For exam-
ple, holding down the Shift key while creating a new document prevents the 
AutoNew macro from running.

Using Auto Macros
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Protecting Your Computer from Macro Viruses
 Computer viruses can exploit Word’s auto macro feature to infect your 

computer. As a result, you should take steps to protect yourself from the 
possibility of being hit by a macro virus. Here are some things you can do:

 ✦ Click the Macro Security button on the Developer Ribbon tab, and then 
set your macro security to Disable All Macros with Notification. You’re 
then prompted before running macros.

 ✦ Avoid opening documents from people you don’t know or trust, espe-
cially documents that arrive as attachments in unsolicited e-mail 
messages.

 ✦ Install an antivirus program. These programs sniff out and smash all 
known macro viruses, as well as other, more common types of viruses 
and worms.

Protecting Your Computer from Macro Viruses
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Chapter 2: Programming with VBA

In This Chapter
✓ Using variables, strings, and other VBA elements

✓ Working with objects, properties, and methods

✓ Executing macros with If, While, and Select Case

✓ Displaying information and obtaining input from the user

✓ Working with user-defined subroutines and macros

I cover the basics of recording and playing macros in Chapter 1 of this 
minibook. Chapter 1 touches on the subject of VBA programming just 

enough to whet your appetite and give you the skills needed to create and 
use the various macros that appear throughout this book. But I reserve 
the real meat of VBA programming for this chapter. Here, I show you VBA 
in-depth so that, with a little practice and a lot of trial and error, you can 
create VBA macros of your own.

 

This chapter is admittedly a bit of a whirlwind introduction to VBA program-
ming. If you have absolutely no programming experience, this chapter might 
be a bit overwhelming. Don’t let the details of VBA bog you down. Study the 
sample macros that appear in this chapter and in the remaining chapters 
in this book, experiment a lot, and keep your chin up. You’ll catch on soon 
enough. If you’re not sure about how to create and edit macros, check out 
Chapter 1 of this minibook before proceeding.

Examining the Basic Structure of VBA Macros
If you want to create a blank macro that you can then edit yourself, you can 
do so by summoning the Macros dialog box, typing a name for the macro 
you want to create, and clicking the Create button. Then Word switches you 
to the VBA editor and creates a skeleton of a macro for you, like this:

Sub BoldItalic()
‘
‘ BoldItalic Macro
‘
‘

End Sub
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540 Understanding the Basic Elements of VBA

The lines that begin with apostrophes are comments. VBA ignores them 
completely, but you can use them to remind yourself what the macro does 
or how it works. Comments can appear on lines all by themselves, or they 
can appear at the end of a line, like this:

Sub BoldItalic()  ‘The BoldItalic macro

The Sub and the End Sub statements mark the beginning and end of the 
macro’s main procedure. As you see later, a macro can call on other pro-
cedures or functions that you define elsewhere in your code. However, the 
simplest macros consist of these lines with some additional VBA statements 
between them.

For example, the following macro contains two VBA statements — one to 
make the selected text bold and the other to make it italic:

Sub BoldItalic()
    Selection.Font.Bold = wdToggle
    Selection.Font.Italic = wdToggle
End Sub

The net effect of this command is to make the selected text both bold 
and italic.

 Well, not quite. The effect of this macro is to change both the bold and italic 
attributes of the selected text. If the text isn’t already bold or italic, the 
macro makes it bold and italic. But if the text is already formatted as bold 
but not italic, the macro turns off the bold attribute and turns on italic. And, 
if no text is selected, the macro sets the bold and italic attributes for text 
you subsequently type.

So here, just a page into this chapter, you already have an example of the 
Undeniable Truth of VBA programming: Even simple macros sometimes 
don’t work the way you expect them to. The outcome of a macro often 
depends a great deal on whether text is selected, how the selected text (if 
any) is formatted, the view (Normal, Page Layout, or Outline), and many 
other factors. The moral of the story: Test everything.

Understanding the Basic Elements of VBA
The following sections present a whirlwind tour of some basic elements of 
writing VBA macros.

Rules for writing VBA statements
The normal way to write VBA statements is one per line. For example, here 
are two VBA statements, each on its own line:
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541Understanding the Basic Elements of VBA

Dim i As Integer
i = 100

If you want, you can “gang up” several statements on a single line by 
separating the statements with colons, as in this example:

Dim i As Integer : i = 100

However, your macros are easier to read if you stick to one statement 
per line.

You can indent lines to show the relationships among statements by using 
tabs or spaces. For example:

If Weekday(Now()) = 1 Then
    MsgBox “Time for football!”
End If

However, be aware that extra spaces aren’t required. The following lines 
have exactly the same meaning as the previous example:

If Weekday(Now()) = 1 Then
MsgBox “Time for football!”
End If

In addition, spacing within a VBA statement generally isn’t important. You 
can omit spaces when different elements of a statement are separated by a 
comma or colon or another punctuation symbol. However, the VBA editor 
often inserts spaces around those elements as you type them.

If you need to continue a statement onto two or more lines, end every line 
except the last one with an underscore character, like this:

MsgBox (“This is a really “ _
  & “long message.”)

The underscore character indicates to Word that the statement continues 
on the next line, so the successive lines are treated as a single statement.

Comments
As mentioned earlier in this chapter, comments are marked with apostro-
phes. When you use an apostrophe anywhere on a line, VBA completely 
ignores everything on the line after the apostrophe. This treatment allows 
you to place comments directly on the lines where they relate:

Sub BoldItalic()  ‘ This macro applies both bold and italic.
    Selection.Font.Bold = wdToggle    ‘Toggles Bold
    Selection.Font.Italic = wdToggle  ‘Toggles Italic
End Sub
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Projects, modules, procedures, and macros
At its simplest level, a macro is a single VBA procedure that you can run 
from an application such as Word. However, VBA lets you gather procedures 
to form modules and projects to help you organize your macros. The follow-
ing list describes each of these organizational units:

 ✦ Procedure: A named collection of VBA statements that’s contained 
between Sub and End Sub statements.

 ✦ Macro: A specific type of procedure that you can invoke directly from a 
Word document. You can run a macro from the Macros dialog box or by 
associating it with a customized Quick Access Toolbar button or a key-
board shortcut.

 ✦ Module: A named collection of procedures. All Word documents include 
a module named New Macros. When you create a macro from the 
Macros dialog box, the new macro is created in this module. If you’re 
working with a lot of macros, you can create additional modules to help 
keep them organized.

 ✦ Project: A collection of modules and other Word objects. Every docu-
ment and template is a project.

Working with Variables and Data
A variable is a name assigned to a bit of computer memory that is used to 
hold a value. Variables are key features of any programming language, and 
VBA is no exception. Variables play an important role in all but the most 
trivial VBA macros.

Using assignment statements
You use an assignment statement to assign values to variables. For example:

Pi = 3.14159
X = 0
MessageText = “Hello from Planet Earth”

In a concession to the 40-year-old legacy of BASIC programming, in VBA you 
can preface assignment statements with the keyword Let:

Let Pi = 3.14159
Let x = 0
Let MessageText = “Hello from Planet Earth”

The Let keyword isn’t required, however, and is considered quaint.
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543Working with Variables and Data

Declaring variables
You declare a variable by using a Dim statement, like this:

Dim i As Integer

This statement declares a variable named i. The type of the variable is 
Integer.

Variable names, which must start with a letter, can be as long as 40 charac-
ters and can contain only letters and numerals and the underscore (_). Also, 
you cannot use any VBA reserved words (such as function names) or names 
of VBA statements, for example.

You use the As keyword to specify the data type for variables. VBA provides 
a number of data types you can use for variables:

 ✦ Boolean: True or False values.

 ✦ Byte: Integers from 0 to 255.

 ✦ Integer: Integers from –32,768 to +32,768.

 ✦ Long: Large integers. Values can be from approximately –2 billion to +2 
billion.

 ✦ Currency: Decimal numbers with as many as 19 digits.

 ✦ Single: Single-precision, floating-point numbers, not used often in Word 
macros.

 ✦ Double: Double-precision, floating-point numbers, used even less often 
in Word macros.

 ✦ Date: A date or time value.

 ✦ String: A bit of text, such as “Humpty-Dumpty.”

 ✦ Object: Any object, such as a Word document or a window.

 ✦ Variant: A generic number or string.

If you omit the data type, Variant is assumed.

Placing your declarations
The normal place to declare variables is within a procedure before you need 
to use the variable. Some programmers like to place all variable declarations 
at the start of the procedure, but that isn’t necessary. You can declare a vari-
able at any time up to the first time you use the variable.
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You can also declare variables at the module level. Module-level variables 
are available to all procedures in the module. Place any module-level vari-
ables before the first procedure in the module.

Using static variables
A static variable is a variable whose value is preserved between executions 
of the procedure in which it’s declared. You can find many excellent uses for 
static variables in Word macros. For example, you may use a static variable 
to temporarily keep track of text entered by the user, to remember the loca-
tion in the document where an operation was performed, or to keep track of 
actions taken since the last time the macro was run.

To create a static variable, use the Static keyword rather than the Dim key-
word, like this:

Static iCaseCount As Integer

 You can use static variables only in procedures. You can’t create a static 
variable at the module level.

Using Option Explicit
Unlike in many other programming languages, such as Java or C#, you don’t 
have to define variables before you can use them in VBA. The first time you 
use a variable in a VBA macro, the variable is automatically defined.

 Most experienced programmers consider not having to define variables to 
be the major weakness in BASIC and all its dialects, including VBA and Visual 
Basic. The trouble is that you never know when you’ve misspelled a variable 
name, because if you misspell one, VBA assumes that you want to create 
a new variable. Suppose at the start of a macro you ask the user to enter a 
string value and you store the value entered by the user in a variable named 
InputString. Then later in the macro, you use the variable in a statement 
but misspell it InputStrign. Does VBA point out your error? No. It just 
assumes that you want to create a new variable named InputStrign. This 
InputStrign variable is given a default value of “” rather than the value 
entered by the user.

This type of problem is quite common in VBA programming. Whenever 
you’re faced with a macro that looks like it should work but doesn’t, care-
fully double-check all variable names for misspellings.

 

You can avoid the problem of misspelled variable names by adding the fol-
lowing line to the beginning of your VBA module:

Option Explicit
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545Using Strings

This line forces you to declare variables before you use them. Then if you 
use a variable that you haven’t declared, you see an error message.

Using Strings
A string is the most common data type for macros when working with Word 
documents. You need to know how to manipulate string data if you hope to 
accomplish anything meaningful in Word VBA.

For starters, you can create string literals, or strings that are simply quoted 
in your macro. To use a string literal, enclose a string value in quotation 
marks — full-fledged double quotes, not apostrophes. For example:

MessageText = “Hi there!”

In this example, “Hi there!” is a string literal whose value is assigned to 
the string variable named MessageText.

You can use an apostrophe within a string literal with no ill effects, as in the 
following example:

MessageText = “Hi y’all”

But you cannot include quotes within quotes. For example, the following line 
produces an error:

MessageText = “Say, “Cheeseburger!””

To include a quotation mark within a literal quoted with quotation marks, 
you must double the quotation marks, like this:

MessageText = “Say, “”Cheeseburger!”””

Concatenation
You can use the concatenation technique to join two or more strings, end to 
end, to make a single, larger string. For example:

Entre = “Cheese” & “burger”

This line results in the string “Cheeseburger” being assigned to the Entre 
variable. The ampersand (&) is used for this purpose. The spaces around the 
ampersand are optional; if you leave them out, Word adds them when you 
run the macro.
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Concatenation becomes quite useful when combined with string variables 
and, as you see in the following section, string functions. For example, con-
sider this statement:

Message = “Could not deliver message to “ & Recipient

In this line, a literal string value is concatenated with a variable string value. 
If the value of the Recipient variable is “Jimmy Hoffa”, the Message 
variable is set to “Could not deliver message to Jimmy Hoffa”.

The number of concatenations you can string together in a single statement 
has no limit.

String functions
VBA provides several built-in functions that work on strings. Table 2-1 sum-
marizes these functions. Most of them come in handy from time to time.

Table 2-1 VBA Functions for Manipulating Strings

Function What It Does

Chr(value) Generates the character that corresponds to the 
numeric (ANSI) code value. Common uses are:

Chr(9): Tab

Chr(11): New line

Chr(13): Carriage return

Chr(30): Nonbreaking hyphen

Chr(32): Space

Chr(160): Nonbreaking space

InStr([n,]string1, 
string2)

Returns the character position within string1 
at which string2 begins, or 0 if string2 is 
not found in string1. If n is used, the first n-1 
characters of string1 are ignored.

LCase(string) Converts string to lowercase.

Left(string,n) Returns the leftmost n characters of string.

Len(string) Returns the length of string.

LTrim(string) Removes leading spaces from string.

Mid(string,x,y) Returns y characters from string starting at 
character x.

Right(string,n) Returns the rightmost n characters of string.
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547Of Objects, Properties, and Methods

Function What It Does

Right(string,n) Returns the rightmost n characters of string.

RTrim(string) Removes trailing spaces from string.

Str(n) Converts the number n to a string variable. For 
example, Str(3.15) becomes the string 
“3.15”.

UCase(string) Converts string to uppercase.

Val(string) Returns the numeric value of string. For 
example, Val(“3.15”) becomes the numeric 
value 3.15.

One of the most commonly used string function is Len: It returns the 
number of characters in a string. For example:

Message = “Hello world!”
LengthOfMessage = Len(Message)

In this example, the LengthOfMessage variable is assigned the value 12, 
the number of characters in the string Message. Note: The Len function 
returns a number, not a string. And the quotation marks that indicate the 
start and end of string literals aren’t counted.

A final group of string functions you need are those used to clean up 
string values that may contain unnecessary leading or trailing spaces or 
unprintable characters. These functions include LTrim(), RTrim(), and 
CleanString(). For example, to remove spaces from the beginning and 
end of a string variable, use this statement:

TrimmedString = Trim(InputText)

Of Objects, Properties, and Methods
VBA is inherently object oriented, which means that it deals extensively with 
programming elements known as objects. Simply put (as though that’s pos-
sible), an object is a named entity that represents a component of a Word 
document. For example, a Document object represents an entire Word docu-
ment, whereas a Selection object represents the text that’s selected in a 
document.

Objects have three components:

 ✦ Property: Defines the data associated with an object. For example, the 
Selection object has a Text property that contains the text in the 
selection.
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548 Of Objects, Properties, and Methods

 ✦ Method: Defines actions that the object can perform. For example, the 
Selection object has a Copy method that copies the selection to the 
Clipboard.

 ✦ Event: Defines actions that an object can respond to. For example, when 
the user closes a document, the Document object raises a Close event. 
Then you can write a macro routine that is executed to add special pro-
cessing for the Close event.

Although events can be important in certain types of macros, most macros 
work with just the properties and methods of various Word objects.

Using objects
The basic trick for working with objects in VBA is that you use the period to 
separate the name of the object you want to work with from the name of the 
property or method you want to use. For example, Selection.Text refers 
to the Text property of the Selection object, and Range.Copy refers to 
the Copy method of the Range object.

One of the most important points about object-oriented programming is that 
the properties of an object can themselves be other objects that have prop-
erties and methods. For example, the Selection object has a Font property, 
which is itself a Font object. The Font object, in turn, has its own properties, 
such as Name and Size. So, you can refer to the Name property of the selec-
tion’s font like this: Selection.Font.Name.

Another key to understanding objects is knowing that you can create 
variables to refer to them. You specify the type of a variable with the As 
keyword. For example, the following line declares a variable named f that 
represents a Font object:

Dim f As Font

Then you can assign an object to the variable.

 You can’t use the normal assignment statement to assign objects, however. 
Instead, you must use a Set statement, like this:

Set f As Selection.Font

In this line, the Font variable f is set to the object referred to by the Font 
property of the Selection object.

You can then refer to properties of the object variable in the usual way. For 
example, f.Name refers to the Name property of the f object.
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549Of Objects, Properties, and Methods

Getting to know the object model
Much of the trick to writing VBA macros for Word is knowing Word’s object 
model — that is, the objects available in a Word macro and the properties 
and methods available for each type of object. You find out more about 
Word’s object model in Chapter 3 of this minibook.

One way to get to know the object model is to let the VBA editor tell you 
about it. When you type a period after an object name, the VBA editor pops 
up a helpful list of the properties and methods available for that object. 
Then you can scroll down to the property or method you want to use and 
press Tab to insert it into your macro. This way is one of the best to dis-
cover which properties and methods are available for any given object.

 

Another way to find out which objects, properties, and methods are 
available — perhaps the best way — is to record a macro that comes 
close to accomplishing what you want to do and then switch to the VBA 
editor to see the code that was generated for the macro. Suppose that you 
want to write a macro that marks index entries. If you record a macro and 
then press Alt+Shift+X to mark an index entry, Word generates VBA code 
similar to this:

ActiveDocument.Indexes.MarkEntry Range:=Selection.Range, Entry:= _
    “Object model”, EntryAutoText:=”Object model”, CrossReference:=””, 
    CrossReferenceAutoText:=””, BookmarkName:=””, Bold:=False, Italic:=False

In this example, you can tell that you use the MarkEntry method of 
ActiveDocument.Indexes to mark an index entry, and that this method 
takes several arguments: Range, Entry, EntryAutoText, CrossReference, 
CrossReferenceAutoText, BookmarkName, Bold, and Italic.

Using methods
A method is an action that an object can perform. When you call a method, 
the object performs the action associated with the method. For example, 
the following statement copies the contents of the current selection to the 
Clipboard:

Selection.Copy

Some methods require arguments, which supply data for the method to work 
with. For example, the Selection object’s InsertAfter method accepts 
a text string as an argument. The text string contains the text that’s inserted 
after the selection.

To use arguments, simply list the argument values you want to pass to the 
method, like this:

Selection.InsertAfter “Some text”
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In this line, Selection is an object, InsertAfter is a method, and “Some 
text” is an argument.

If a method requires two or more arguments, separate them with commas, 
like this:

Selection.StartOf wdParagraph, wdExtend

In this example, the arguments are positional because Word interprets the 
meaning of each argument based on the order in which you list them. In 
Word, you can also pass arguments by using argument names, as in this 
example:

Selection.StartOf Unit:=wdParagraph, Extend:=wdExtend

 

When you use methods that require arguments, the VBA editor displays tips 
that let you know which arguments the method expects.

In VBA, you can also enclose the arguments in parentheses, like this:

Selection.InsertAfter(“Some text”)

However, the parentheses aren’t required. Note that it’s okay to use both 
styles — with and without parentheses — within a macro.

Using the With statement
The With statement is a special VBA shortcut that lets you refer to an 
object in several statements without having to refer to the object every time. 
You simply list the object in the With statement. Then any statement that 
appears between the With and its corresponding End With statement and 
that begins with a period uses the object listed in the With statement.

Suppose that you want to set the Bold and Italic properties of the Font 
property of the Selection object for a document named Temp. You can 
use these lines:

Documents(“Temp”).ActiveWindow.Selection.Font.Bold = True
Documents(“Temp”).ActiveWindow.Selection.Font.Italic = True

Or, you can place these lines within a With/End With block, like this:

With Documents(“Temp”).ActiveWindow.Selection.Font
    .Bold = True
    .Italic = True
End With

Granted, the With statement adds two lines of code. But if the object refer-
ence is complicated, it can save you some typing even if you need to set only 
two property values.
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551Controlling Your Programs

Working with collections
A collection is a special type of object that holds one or more occurrences of 
another object. The Word object model, which I discuss further in the next 
chapter, has many collections that help organize the various objects used in 
Word. For example, you can store all open documents in a collection named 
Documents. And, you can access all paragraphs in a document via a collec-
tion named Paragraphs.

All collections have a Count property you can use to determine how many 
items are in the collection. For example, the following code displays the 
number of open documents:

MsgBox “There are currently “ & Documents.Count _
    & “ documents open.”

Many collections have an Add method that adds a new item to the collection. 
In many cases, the Add method creates a new object of the type appropriate 
for the collection, adds it to the collection, and returns the new object as its 
return value. For example, the following chunk of code creates a new docu-
ment and then displays the document’s name:

Dim d As Document
Set d = Documents.Add
MsgBox “The new document’s name is “ & d.Name

You can access the individual items in a collection by using an index 
number. For example, the following code displays the name of the first docu-
ment in the Documents collection:

MsgBox Documents(1).Name

In many cases, you can use the name of an item instead of an index. For 
example, this statement closes the document named TempDoc:

Documents(“TempDoc”).Close

 If no document is named TempDoc, the statement generates an error.

Controlling Your Programs
The simplest macros execute their statements one at a time, in the sequence 
in which the statements are listed in the macro, until they reach the End 
Sub statement.

More sophisticated macros need more control over the sequence in which 
statements are executed. For example, you might need to skip over some 
statements based on the result of a condition test. Or, you might need to 
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552 Controlling Your Programs

create a loop of statements that repeats itself a given number of times or 
until a certain condition — such as reaching the end of the document — 
is met.

The following sections describe the VBA statements that let you control the 
flow of execution in your macro.

The If statement
Do you remember the Robert Frost poem that begins, “Two roads diverged 
in a yellow wood. . . .”? That poem is an apt description of how the If 
statement works. The macro is rolling along, executing one statement after 
another, until it reaches an If statement. The If statement represents a 
fork in the road, and a choice must be made about which path to take.

Many macros need to make this type of decision as they execute. For exam-
ple, a macro that creates an index entry for text selected by the user has 
to first determine whether the user has indeed selected any text. If so, the 
macro proceeds to create the index entry. If not, the macro does nothing, 
or perhaps it displays an error message along the lines of “You didn’t select 
any text!” To handle this decision processing, the macro uses an If 
statement.

VBA’s If statement is remarkably flexible, with several formats to choose 
from. All these forms involve three basic parts:

 ✦ A condition test that is evaluated to yield a value of True or False

 ✦ A then part, which supplies one or more statements that execute only if 
the result of the condition test is True

 ✦ An else part, which supplies one or more statements that execute only if 
the result of the condition test is False

For example, consider these lines that may be used in an index-marking 
macro:

If Selection.Type = wdSelectionNormal Then
    ActiveDocument.Indexes.MarkEntry Range:=Selection.Range, 

Entry:=”index”
Else
    MsgBox (“Please select something to mark.”)
End If

In this example, the If statement begins with a condition test that 
checks to see whether the selection is a normal text selection. If so, the 
ActiveDocument.Indexes.MarkEntry statement executes to insert an 
index field code. If not, a message box is displayed.
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553Controlling Your Programs

 Each component of the If statement must fall on a separate line, as shown 
in the preceding example. In other words, you cannot place the statements 
on the same line as the Then or Else keywords.

The Else part of the If statement is optional. However, End If isn’t 
optional: Every If statement must have a corresponding End If. (The only 
exception to this rule is the single-line If format that I explain later, in the 
section “The single-line If.”)

 

Although indenting the statements isn’t strictly required, using such indenta-
tion makes the structure of the If statement much more apparent. Consider 
the preceding example with no indentation:

If Selection.Type = wdSelectionNormal Then
ActiveDocument.Indexes.MarkEntry Range:=Selection.Range, 
Entry:=”index”
Else
MsgBox (“Please select something to mark.”)
End If

Now imagine that instead of a single statement between the Then and Else 
lines, the macro has a dozen, with a dozen more lines between the Else and 
End If lines. Indentation is the only way to keep track of the overall struc-
ture of the If statement.

Nested If statements
You can nest If statements — that is, you can include one If statement 
within the Then or Else part of another. For example:

If expression Then
    If expression Then
        statements
    Else
        statements
    End If
Else
    If expression Then
        statements
    Else
        statements
    End If
End If

Nesting can be as complex as you want. Just remember that you need an 
End If for every If. Be certain to use indentation so that each set of match-
ing If, Else, and End If lines is properly aligned.
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The ElseIf structure
VBA supports a special type of If structure, using the ElseIf keyword. The 
ElseIf form is a shorthand notation that allows you to simplify If struc-
tures that follow this form:

If expression Then
    statements
Else
    If expression Then
        statements
    Else
        If expression Then
            statements
        End If
    End IF
End If

Using the ElseIf keyword, you can express the same structure like this:

If expression Then
    statements
ElseIf expression Then
    statements
ElseIf expression Then
    statements
End If

If this example is a little too abstract, consider a macro that displays one of 
three messages, depending on the day of the week. On Sunday, the macro 
displays “Time for Football!” On Saturday, it displays “Time to mow the 
lawn!!” And, on any other day, it displays “Time to go to work!!!”

Here’s how to code this macro by using ordinary If statements:

DayOfWeek=Weekday(Now())
If DayOfWeek = 1 Then
    MsgBox(“Time for football!”)
Else
    If DayOfWeek = 7 Then
        MsgBox(“Time to mow the lawn!!”)
    Else
        MsgBox(“Time to go to work!!!”)
    End IF
End If

Notice that the first Else clause contains a nested If statement. By using 
the ElseIf keyword, the second If statement is subsumed into the first, so 
a single If statement handles the whole thing:
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DayOfWeek=Weekday(Now())
If DayOfWeek = 1 Then
    MsgBox(“Time for football!”)
ElseIf DayOfWeek = 7 Then
    MsgBox(“Time to mow the lawn!!”)
Else
    MsgBox(“Time to go to work!!!”)
End If

In this example, only one End If line is required because it has only one 
If statement. In other words, the ElseIf keyword doesn’t require its own, 
matching End If.

 

In most cases, a Select Case statement implements If structures that 
require ElseIf clauses more easily, which I describe later in this chapter, in 
the section “The Select Case statement.”

The single-line If
In VBA, you can use a single-line form of the If statement, which looks like 
this:

If condition Then statement [Else statement]

To use this form of the If statement, you must code the condition, Then 
clause, and Else clause (if any) all on the same line. For example:

If x > 0 Then MsgBox(“X is “ & x)

This example displays the message X is n, where n is the value of x. But 
the message displays only if x is greater than zero.

You can include more than one statement in the Then part by separating 
the statements with colons. But if more than one statement is required, or if 
an Else part is required, I suggest that you use the basic multiline If form 
instead of the single-line form.

For/Next Loops
For/Next loops allow you to set up a basic looping structure in which a 
series of statements execute repeatedly, with the value of a counter variable 
increased by one (or more) each time until the counter variable reaches a 
certain value.

As a simple — if not quite practical — example, the following snippet inserts 
the numbers 1 through 100 in the current document, one number per line:
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For x = 1 to 100
    Selection.InsertAfter Str(x) & Chr(13)
Next x

This For/Next loop causes the InsertAfter statement it contains to 
execute 100 times. The first time through, the variable x is set to the value 1. 
The second time, x is 2; the third time, 3; and so on, all the way to 100.

The general form of a For/Next loop is

For counter-variable = start To end [Step increment]
    statements...
Next [counter-variable]

You can specify any starting and ending value you want for the counter 
variable. In addition, you can specify an increment value by using the Step 
clause. You can use Step to create For/Next loops that count by twos or 
threes or any other value you want. If you omit Step, the default is 1.

 The term iteration is often used to refer to each execution of a For/Next 
loop. For example, a For/Next loop that starts with the line For x = 1 To 
10 iterates ten times.

While/Wend loops
While/Wend loops provide a more sophisticated form of looping, in which 
the loop continues as long as a specified condition remains True. The gen-
eral form is

While condition
    statements
Wend

The While loop starts by evaluating the condition. If it’s True, the state-
ments in the loop execute. When the Wend statement is encountered, the 
condition is evaluated again. If it’s still True, the statements in the loop 
execute again. This cycle continues until the condition evaluates as False.

 At this point, you need to know just what it means to say that a condition 
is True: In VBA, False is defined as the numeric value 0, and any nonzero 
value is considered to be True. For example, consider this While loop:

x = 5
While x
    Selection.InsertAfter Str(x) & Chr(13)
    x = x - 1
Wend
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557For/Next Loops

This loop continues to execute as long as x is not zero. The moment x 
becomes zero, VBA considers the condition expression to be False and the 
loop terminates. As a result, this While loop displays five message boxes, 
showing the values 5, 4, 3, 2, 1, and then it terminates.

To continue a loop as long as an expression evaluates to False, use Not as 
part of the condition test. For example:

x = 0
While Not x = 5
    Selection.InsertAfter Str(x) & Chr(13)
    x = x + 1
Wend

In this example, the loop repeats as long as x is not equal to 5.

The Select Case statement
Life would be easy if it consisted entirely of either/or choices. But in the real 
world, you’re often faced with many alternatives to choose from. And so it is 
in VBA. More than a few VBA functions return more complicated results than 
a simple yes/no, true/false, or 0/1. For example, Selection.Style.Name 
returns the name of the style applied to the current selection. You can use 
this information to cause your macro to take a different action depending on 
which style is applied to the selected paragraph.

The Select Case statement is designed for just this type of situation. It 
lets you test an expression for various values, executing different statements 
depending on the result. Its general form is

Select Case expression
    Case case-condition
        statements
  [ Case case-condition
        statements ]
  [ Case Else
        statements ]
End Select

The Select Case statement starts by evaluating the expression. Then it 
compares the result with the case conditions listed in the Case clauses, 
one at a time. When it finds a match, it executes the statements listed for 
the Case clause that matches, and it skips the rest of the Select Case 
statement. If none of the case conditions match, the statements in the Case 
Else clause execute. The key point is that only one of the Case clauses is 
selected for execution.
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558 User Input and Output

For each Case clause, values can be any of the following:

 ✦ A single value, such as Case 4: The Case clause is selected if the 
expression is equal to the value.

 ✦ A list of expressions, such as Case 4, 8, 12, 16: The Case clause is 
selected if the expression equals any of the listed values.

 ✦ A range of values, separated with the keyword To, such as Case 4 to 
8: The Case clause is selected if the expression falls between the two 
values, inclusively.

 ✦ The word Is followed by a relational comparison, such as Is > 4: 
The relation is tested against the expression, and the Case clause is 
selected if the result of the comparison is True.

Here’s an example of a While loop that includes a Select Case statement 
to count the number of Heading 1, Heading 2, and Heading 3 styles from the 
current selection to the end of the document:

Dim Heading1Count As Integer
Dim Heading2Count As Integer
Dim Heading3Count As Integer
Dim s As Style
While Selection.Move(wdParagraph, 1)
    Select Case Selection.Style.NameLocal
        Case “Heading 1”
            Heading1Count = Heading1Count + 1
        Case “Heading 2”
            Heading2Count = Heading2Count + 1
        Case “Heading 3”
            Heading3Count = Heading3Count + 1
    End Select
Wend

In this example, the variables Heading1Count, Heading2Count, and 
Heading3Count count the number of headings for each level. The Select 
Case statement evaluates the NameLocal property of the selection’s 
Style object. Then the Case clauses check for the values “Heading 1”, 
“Heading 2”, and “Heading 3”. If the NameLocal property returns one 
of these three values, 1 is added to the appropriate counter variable.

 

You can use Case Else to handle any values that aren’t specifically men-
tioned in Case clauses.

User Input and Output
The following sections describe various methods of displaying information 
and obtaining input from the user.
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559User Input and Output

MsgBox
The MsgBox command allows you to display a dialog box containing an 
informative message. MsgBox temporarily halts the macro until the user 
closes the message dialog box.

The MsgBox command has the following form:

MsgBox message [,buttons [,title] ]

message is the text to display in the message, buttons is a constant that 
indicates the type of buttons to display, and title is the title displayed in 
the dialog box title bar.

To display a simple message, use a command such as this one:

MsgBox “It’s Saturday night!”

This command displays the dialog box shown in Figure 2-1.

 

Figure 2-1: 
MsgBox 
dialog box.

 

Here’s a MsgBox call that specifies the type of buttons and a title:

MsgBox “It’s Saturday night!”, vbOKCancel, “Live from New York!”

Its output is shown in Figure 2-2.

 

Figure 2-2: 
Adding a 
title and 
button style.

 

The buttons argument controls three items at a time:

 ✦ Buttons that appear in the dialog box

 ✦ The icon that appears in the dialog box

 ✦ The button that is the default
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(If you omit the default button argument, the first button is assumed to be 
the default.) Table 2-2 lists the values for these settings.

Table 2-2 MsgBox Type Values

Group Constant Meaning

Buttons vbOKOnly OK only

vbOKCancel OK and Cancel

vbAbortRetry
Ignore

Abort, Retry, and Ignore

vbYesNoCancel Yes, No, and Cancel

vbYesNo Yes and No

vbRetryCancel Retry and Cancel

Icon vbCritical Critical icon

vbQuestion A question mark

vbExclamation An exclamation mark

vbInformation Information only

Default 
button

vbDefault
Button1

First button (OK, Yes, or Abort)

vbDefault
Button2

Second button (Cancel, No, or Retry)

vbDefault
Button3

Third button (Cancel or Ignore)

 

You can put these constants together to create composite styles. For 
example, this MsgBox command displays OK and Cancel buttons and a Stop 
symbol and makes the Cancel button the default:

MsgBox “It’s Saturday night!”, vbOKCancel + vbExclamation + 
vbDefaultButton2, “Live from New York!”

Figure 2-3 shows the resulting dialog box.

 

Figure 2-3: 
Adding an 
icon and 
a default 
button.
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561User Input and Output

MsgBox returns a value that indicates which button was clicked, as 
described in Table 2-3.

Table 2-3 MsgBox Return Values

Constant Numeric Value Button That Is Clicked

vbOK 1 OK button

vbCancel 2 Cancel

vbAbort 3 Abort

vbRetry 4 Retry

vbIgnore 5 Ignore

vbYes 6 Yes

vbNo 7 No

InputBox
The VBA function InputBox displays a dialog box that includes a single text 
field in which the user can type a response. The user’s input is then returned 
to the macro as the function’s return value.

The InputBox function accepts three arguments:

InputBox(prompt [,title] [,default])

For example, the following InputBox function asks the user to enter a name:

Name=InputBox(“Type a name:”)

This example shows how to provide your own title for the input dialog box 
and display a default choice:

Name=InputBox(“Type a name:”, “The Name Game”, UserName)

The user’s response returns in the Name variable. Figure 2-4 shows the 
dialog box that’s displayed.

 

Figure 2-4:

Input dialog 
box with 
icon and 
default 
button.
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User-Defined Procedures and Functions
Most VBA macros consist of a single procedure. However, VBA lets you 
create additional procedures and functions that you can call from within 
the macro’s main procedure. Procedures and functions are useful when you 
have a series of VBA commands or a complex calculation that you need to 
call on several times in a macro. By placing these commands in a procedure 
or function, you can code them once and call on them as many times as 
needed.

Using procedures
To create a procedure, use a Sub/End Sub command pair outside the Sub/
End Sub command pair for the macro’s main procedure. The statements 
that make up the procedure go between the Sub and End Sub commands, 
and the Sub command supplies the name of the procedure and any argu-
ments that are passed to the subroutine. For example:

Sub SayHello
    BeepMsg “Hello World!”
End Sub
Sub BeepMsg(Message As String)
    Beep
    MsgBox Message
End Sub

In this example, the BeepMsg procedure displays a message and sounds 
a tone to get the user’s attention. In the macro’s main procedure (named 
SayHello), you can use BeepMsg as though it were a built-in VBA 
command.

Using functions
A function is similar to a subroutine, with one crucial difference: A function 
returns a value. Here’s an example:

Sub GetAnAnswer
    If GetYesNo(“Yes, or no?”) Then
        BeepMsg “You said yes.”
    Else
        BeepMsg “You said no.”
    End If
End Sub
Sub BeepMsg(Message As String)
    Beep
    MsgBox Message
End Sub
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563User-Defined Procedures and Functions

Function GetYesNo(Message As String) As Boolean
    If MsgBox(Message, vbYesNo) = vbYes Then
        GetYesNo = True
    Else
        GetYesNo = False
    End If
End Function

In this example, the GetYesNo function uses a MsgBox function to display 
a message box with Yes and No buttons. The return value from the MsgBox 
function determines which button the user pressed, and the return value of 
the GetYesNo function is set to True if the user clicked Yes or False if the 
user clicked No. Back in the Main routine, the GetYesNo function is used 
in an If statement to display You said yes if the user clicks Yes or You 
said no if the user clicks No.
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Chapter 3: More Programming: 
Using Word’s Object Model

In This Chapter
✓ Understanding the basic objects of Word’s object model

✓ Wrestling with documents

✓ Discovering selections and ranges

✓ Creating macros that manipulate text

✓ Creating macros that adjust text formatting

Word’s object model is the programming interface that lets you 
manipulate Word documents from VBA. The object model consists 

of a variety of different object types, such as documents, paragraphs, styles, 
tables, and so on. Each of these objects has its own properties and methods 
you can use from VBA. And many of these objects are contained in special 
collections.

The most difficult aspect of writing Word macros is dealing with this 
object model, in part because Word’s object model is huge. (The people at 
Microsoft who designed Word’s object model weren’t minimalists.)

However, after you wrap your brain around a few basic concepts, such as 
the difference between selections and ranges, the object model begins to 
make sense. So, without further ado, this chapter presents an overview of 
the most commonly used parts of Word’s object model.

An Overview of Important Word Objects
Word’s object model is far too complex to completely cover in a single 
chapter. All told, the object model has hundreds of different types of 
objects, collections, methods, and properties.

Fortunately, you don’t have to know about all the objects, methods, and 
properties that make up the complete object model to start writing useful 
VBA macros. To give you an idea for the overall structure of the Word 
object model, Table 3-1 summarizes the function of the 30 or so most 
commonly used Word objects and the collections that contain them. You 
find more details about many of these objects throughout the rest of this 
chapter.
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566 An Overview of Important Word Objects

 

Don’t let the sheer size of Table 3-1 overwhelm you. I include it here simply 
to familiarize you with the name and general purpose of Word’s most com-
monly used objects. Don’t feel like you have to memorize it or give it more 
than a casual glance for now. Just know that it’s available when you need it.

Also, notice that some of the objects listed in this table have a corresponding 
collection. For example, all bookmarks for a document are stored in a 
Bookmarks collection, with each individual bookmark represented by a 
single Bookmark object. Not every object in this table has a corresponding 
collection, however. For example, just one Application object exists, so 
there’s no need for a collection to store this object type.

 

By the way, AutoComplete can come in handy when you’re working with 
objects in your VBA macros. When you type an object name and then type a 
period, the AutoComplete feature displays a list of the methods and proper-
ties available for the object.

Table 3-1 Major Objects in the Word Object Model

Object Collection Description

Application The Microsoft Word application 
itself. This object is considered 
to be the start of the Word object 
model. Use the Application 
object to access other top-level 
objects. For example, use the 
ActiveDocument property to 
access the Document object for 
the current document.

Bookmark Bookmarks Used to access bookmarks. You can 
access the Bookmarks collection 
via a Document object.

Cell Cells Used to access cells in a table. You 
can access the Cells collection 
via a Row or Column object. You 
can also access an individual cell by 
using the Cell method of a Table 
object.

Column Columns Represents a column in a table. You 
can access the Columns collec-
tion via a Table object.

Diagram Shapes Represents a diagram. Diagrams 
are stored along with other shapes 
in a Shapes collection. You can 
access the Shapes collection via a 
Document object.
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567An Overview of Important Word Objects

Object Collection Description

Document Documents Represents a single document. The 
Documents collection (available 
via the Application object) con-
tains all open documents.

Email Represents the e-mail information 
for a document and is accessed 
via the Email property of a 
Document object.

Envelope Represents a document’s envelope 
and is accessed via the Envelope 
property of a Document object.

Field Fields Represents a field. The Fields 
collection is accessed via 
a Document, Range, or 
Selection object.

Find Provides the function of the Find 
command on the Home tab.

Font Represents a font. Accessed via the 
Font property of a Selection, 
Range, or Style object.

HeaderFooter HeaderFooters Represents a header or footer for a 
section of a document. The Header
Footers collection is accessed via 
the Headers or Footers property 
of a Section object.

List Lists Represents a list in a document. The 
Lists collection is accessed via a 
Document object.

Options Represents the settings in the Word 
Options dialog box.

Page Pages Represents the pages in a docu-
ment. The Pages collection is 
accessed via a Pane object, not 
a Document object, as you may 
expect. Go figure.

PageSetup Represents the page setup, including 
margins and columns. Accessed via 
a Document or Section object.

Pane Panes Represents an open window pane 
used to view a document. The 
Panes collection is accessed via a 
Window object.

(continued)
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568 An Overview of Important Word Objects

Table 3-1 (continued)

Object Collection Description

Paragraph Paragraphs Represents a paragraph. The 
Paragraphs collection is 
accessed via a Document, 
Selection, or Range object.

ParagraphFormat Represents the format for a 
Paragraph or Style object.

Range Represents a range of a document. 
Many Word objects have a Range 
property, including Document, 
Section, Paragraph, and 
Bookmark.

Replacement Provides the function of the Replace 
command on the Home tab.

Row Rows Represents a row in a table. The 
Rows collection is accessed via a 
Table object.

Section Sections Represents a document section. The 
Sections collection is accessed 
via a Document object.

Selection Represents the current selection 
and is accessed via a Selection 
or Range object.

Shape Shapes Represents a shape. The Shapes 
collection is accessed via a 
Document object.

Style Styles Represents a style. The Styles 
collection is accessed via a 
Document object.

Table Tables Represents a table. The 
Tables collection is accessed 
via a Document, Range, or 
Selection object.

Template Templates Represents a template. All 
available templates (normal, 
attached, and global) are avail-
able in the Templates collec-
tion, which you can access via 
the Application object. Use the 
AttachedTemplate property of 
a Document object to access the 
template attached to a document.
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569Using the Application Object

Object Collection Description

TextColumn TextColumns Represents a column. The 
TextColumns collection is 
accessed via a PageSetup object.

Variable Variables Represents a document variable. 
The Variables collection is 
accessed via a Document object.

View Represents the view settings, such 
as whether paragraph marks or field 
codes are visible. Accessed via a 
Window or Pane object.

Window Windows Represents an open window. The 
Application.Windows col-
lection has all open windows. The 
Windows collection for a Document 
object has just those windows that 
are open for the document.

Using the Application Object
The Application object is the starting point for Word’s object model. It 
represents the Word application itself. Here are a few of its more interesting 
properties:

 ✦ ActiveDocument: A Document object that represents the active 
document — that is, the document from which the user ran the macro.

 ✦ ActiveWindow: A Window object that represents the active window.

 ✦ Documents: A collection that contains all currently open documents.

 ✦ Options: An Options object that represents the current settings for 
Word. You can usually set the options via the Word Options dialog box, 
which you access by choosing File➪Options.

 ✦ ScreenUpdating: Controls whether the screen updates to reflect 
changes made to the document as a macro runs. Some macros run faster 
if you set ScreenUpdating to False.

 ✦ Selection: The text that’s selected in the active document.

 ✦ Templates: A Templates collection that contains all available 
templates.

 ✦ UserAddress: The user’s mailing address.

 ✦ UserInitials: The user’s initials.

 ✦ UserName: The user’s name.
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570 Working with Documents

 ✦ Version: The version of Word being used.

 ✦ Windows: A collection of Window objects that represents all open 
windows.

The Application object also has several methods that can be useful; in 
particular:

 ✦ CleanString: Removes nonprintable characters from a text string

 ✦ GoBack: Moves the insertion point back to previous locations where 
editing occurred

 ✦ GoForward: After using the GoBack method, moves forward to previous 
editing locations

 ✦ ListCommands: Creates a new document that lists all Word commands 
along with their keyboard shortcuts

 ✦ OnTime: Starts a timer that runs a macro at a specified time

 ✦ Quit: Quits Microsoft Word

 ✦ Repeat: Repeats the most recent editing action

 ✦ Run: Runs another macro

 ✦ ScreenRefresh: Updates the screen; useful if you’ve suppressed 
screen updating by setting the ScreenUpdating property to False

 ✦ ShowClipboard: Shows the Clipboard task pane

You can use many properties and methods of the Application object with-
out explicitly specifying Application. For example, the following two lines 
of code are equivalent:

Application.Options.AllowFastSave = True

Options.AllowFastSave = True

The Application object properties and methods you can use without 
specifying the Application object are global members.

Working with Documents
You use the Document object to access a document in Word. The Document 
object has many useful properties and methods. Here are a few of the more 
interesting properties:

 ✦ Name: The document’s name

 ✦ Path: The hard drive path for the document

 ✦ ReadOnly: The read-only status of the document
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571Working with Documents

 ✦ Saved: False if the document has changed since it was last saved

 ✦ Windows: Returns a Windows collection that contains all windows in 
which the document is open

 ✦ AttachedTemplate: Returns a Template object for the template that’s 
attached to the document

Here are some of the methods of the Document object:

 ✦ Activate: Makes the document the active document

 ✦ Close: Closes the document

 ✦ PrintOut: Prints all or part of the document

 ✦ Save: Saves the document and prompts the user for a name if the 
document has never been saved 

 ✦ SaveAs: Saves the file with a specified name and path

Accessing documents
If the document you want to access is the active document — the document 
from which the user ran the macro — you can just specify ActiveDocument 
to access its properties and methods. For example, the following statement 
saves the active document:

ActiveDocument.Save

You can access all documents that are open via the Documents collection. 
For example, the following code displays a message box that lists the name 
of each open document:

Dim msg As String
Dim d As Document
For Each d In Documents
    msg = msg & d.Name & VbCr
Next
MsgBox msg

You can use the Documents collection to access a document by name, like 
this:

Documents(“Document1”).Save

Creating a document
You can create a new document by using the Add method of the Documents 
collection. The Add method returns the document that was created. The 
following code creates a new document and then displays the document’s 
name in a message box:
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572 Working with Documents

Dim d As Document
Set d = Documents.Add
MsgBox d.Name

 Creating a document makes the new document the active document. If your 
macro needs to return to the original active document, it needs to save the 
active document’s name in a string variable and then use the variable later 
to return to that document; for example:

Dim s As String
s = ActiveDocument.Name
Dim d As Document
Set d = Documents.Add
Documents(s).Activate

In this example, the active document’s name is saved in the string named 
s. Then a new document is created, and the original active document is 
reactivated.

Opening a document
You might have noticed that the Document object has no Open method. 
However, the Documents collection does. The following example opens the 
document named QuarterlyReport.doc and assigns it to the Document 
variable named report:

Dim report As Document
Set report = Documents.Open(“QuarterlyReport.doc”)

When the Open method opens a document, it creates a Document object, 
adds it to the Documents collection, and makes the new document the 
active document. If the document specified by the string argument doesn’t 
exist, an error message is displayed.

Understanding stories
A Word document consists of one or more stories, which represent distinct 
areas of a document. All documents have a main story that contains the text 
displayed within the page margins. In addition, documents can have other 
stories, such as headers and footers, footnotes and endnotes, text that 
appears in frames, and comments.

If your macro works only with the contents of the main story, you don’t need 
to worry about stories, because the main story is the default story of the 
Document object. But if you want to create a macro that manipulates text 
in another story, such as the footnote story, you have to know how to get to 
the right story.
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573Working with Documents

To do that, you use the StoryRanges collection of the Documents object. 
One constant listed in Table 3-2 indexes this collection. For example, the 
following macro displays the number of paragraphs in the main story:

fr As Range
Set fr = ActiveDocument.StoryRanges(wdMainTextStory)
MsgBox fr.Paragraphs.Count

In this example, wdMainTextStory is used as the index for ActiveDocument.
StoryRanges to get the main story. Then the Paragraphs.Count property 
displays the number of paragraphs in the story.

 The Word object model doesn’t have a separate Story object. Instead, each 
item in the StoryRanges collection is a Range object. I further discuss 
Range objects in the next section.

Table 3-2 Constants for Story Types

Constant Description

wdCommentsStory Comments made by reviewers

wdEndnoteContinuationNotice
Story

Endnote continuation notices

wdEndnoteContinuation
SeparatorStory

Endnote continuation separators

wdEndnoteSeparatorStory Endnote separators

wdEndnotesStory Endnotes

wdEvenPagesFooterStory Footers for even pages

wdEvenPagesHeaderStory Headers for even pages

wdFirstPageFooterStory Footers for the first page

wdFirstPageHeaderStory Headers for the first page

wdFootnoteContinuation
NoticeStory

Footnote continuation notices

wdFootnoteContinuation
SeparatorStory

Footnote continuation 
separators

wdFootnoteSeparatorStory Footnote separators

wdFootnotesStory Footnotes

wdMainTextStory The main text of the document

wdPrimaryFooterStory Footers

wdPrimaryHeaderStory Headers

wdTextFrameStory Text that appears in frames
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574 Understanding Selection and Range Objects

Understanding Selection and Range Objects
One of the most confusing aspects of Word’s object model is that two dis-
tinct objects refer to portions of a document: Selection and Range. The 
Selection and Range objects are similar, with many overlapping features. 
However, selections can do some things that ranges can’t and vice versa.

In a nutshell, a Selection object refers to a portion of a document that is 
selected. The selection can be made by the user before running the macro or 
the macro itself can select text.

Like a selection, a range is a portion of a document. However, a range isn’t 
selected, so it isn’t highlighted in the document window. Ranges allow you 
to work on document text without drawing attention to the text.

A document can have only one selection at a time, unless the same docu-
ment is open in two or more windows or window panes. In that case, each 
window or pane can have its own selection in the document. However, you 
can create as many ranges for a document as you want. And the ranges can 
overlap. For example, you can create a Range object that refers to the entire 
document, another Range object that refers to a particular paragraph within 
the document, and a third Range object that refers to a single word within 
that paragraph.

Working with the Selection object
The Selection object refers to the portion of the document that’s selected. 
If you’re writing a macro that manipulates the text selected by the user, you 
most likely need to use the Selection object. For example, this statement 
copies the selection to the Clipboard:

Selection.Copy

And this code formats the selected text as both bold and italic:

Selection.Font.Bold = True
Selection.Font.Italic = True

You can access the text that’s contained in a selection by using the Text 
property. For example, the following statement displays the selected text in 
a message box:

MsgBox Selection.Text

Getting the right selection
When you refer to a Selection object by using just the word Selection, 
you’re accessing the selection in the active document window. This method 
is the most common way to use a Selection object. However, you can also 
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575Understanding Selection and Range Objects

refer to other Selection objects. You can display each open document 
in more than one window, and you can split each of those windows into 
two panes. Because you can select text in any window pane, Word’s object 
model lets you access a Selection object for each window pane. To access 
a selection in another document, use the Document object’s ActiveWindow 
property, like this:

Documents(“QuarterlyReport.doc”).ActiveWindow.Selection

This statement accesses the selection in the active pane of the active 
window for the QuarterlyReport document.

If the window is split into panes, you can use the Panes property to access 
the selection in either pane. For example, the following code displays a mes-
sage box that lists the text selected in both panes of the active window:

Dim msg As String
msg = ActiveWindow.Panes(1).Selection.Text + VbCr _
    + ActiveWindow.Panes(2).Selection.Text
MsgBox msg

Dealing with selection types
A user may make many different types of selections before running your 
macro. Any macro that works with the Selection object needs to first 
ensure that the right type of selection is made. You can do that by checking 
the Type property. For example, this bit of code checks to ensure that the 
user makes a normal selection before copying the selection to the Clipboard:

If Selection.Type = wdSelectionNormal Then
    Selection.Copy
End If

The Type property can have any of the constant values listed in Table 3-3.

Table 3-3 Constants for the Selection.Type Property

Constant What It Selects

wdNoSelection Nothing

wdSelectionBlock A vertical block, such as when the Alt key is 
used with the mouse

wdSelectionColumn A table column

wdSelectionFrame A frame

wdSelectionInlineShape An inline shape

wdSelectionIP An insertion point
(continued)
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576 Understanding Selection and Range Objects

Table 3-3 (continued)

Constant What It Selects

wdSelectionNormal A normal block of text

wdSelectionRow A table row

wdSelectionShape A drawing shape 

Working with Range objects
A Range object identifies a portion of a document. The range can be as short 
as a single character or as long as the entire document. Range objects let 
you access text from within a macro without selecting the text onscreen or 
affecting the text that’s selected.

Getting ranges
Many objects with the Word object model have a Range property you can 
use to create a range that represents a portion of the document. Suppose 
that you want to access the first paragraph of the active document as a 
range. To do so, you can use this bit of code:

Dim r As Range
Set r = ActiveDocument.Paragraphs(1).Range
MsgBox r.Text

In this example, the Paragraphs collection accesses the first paragraph in 
the active document.

The following table lists the objects that have a Range property:

Bookmark Hyperlink Selection

Cell InlineShape SmartTag

Comment List Subdocument

Endnote Paragraph Table

Footnote Revision TableOfAuthorities

Formfield Row TableOfContents

Frame Section TableOfFigures

HeaderFooter
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577Understanding Selection and Range Objects

Notice that among these objects is the Selection object. As a result, you 
can get a Range object that corresponds to the current selection, like this:

Dim r As Range
Set r = Selection.Range

 

Several properties of other objects also return Range objects. For example, 
the Document object has a Content property that returns a Range object 
representing the entire content of a document. For more ways to get ranges 
that represent portions of a document, see the section “Accessing text,” 
later in this chapter.

Getting a range from a bookmark
Book II, Chapter 1 explains how you can use bookmarks to assign names to 
portions of a document. In effect, a bookmark is simply a named range that’s 
saved along with the document. Bookmarks are commonly used in macros 
because they allow you to refer to a predefined area of text by name. If your 
macro needs to insert text into a document at predefined locations, book-
marks are the easiest way to do it.

To create a Range object for a bookmark, use code similar to this:

Dim r As Range
Set r = ActiveDocument.Bookmarks(“FromAddress”).Range

This code works fine if you’re certain that the bookmark is always there. If 
you can’t make that guarantee (and you can’t, really), check first to make 
sure the bookmark exists, like this:

If ActiveDocument.Bookmarks.Exists(“Customer”) Then
    Dim r As Range
    Set r =ActiveDocument.Bookmarks(“FromAddress”).Range
Else
    MsgBox “Missing bookmark!”
End If

Here, the Exists method of the Bookmarks collection determines whether 
the Customer bookmark exists before it’s accessed.

Creating a range from scratch
You can also create a Range object by using the Range method of the 
Document object. Note that I said the Range method, not the Range property. 
The Range method of the Document object creates a new range for the por-
tion of the document you specify. In the Range method, you must provide the 
starting and ending character position for the range. Here’s an example:
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578 Moving Selections and Ranges

Dim r As Range
Set r = ActiveDocument.Range(0, 100)

A Range object that includes the first 100 characters of a document is created.

Selecting a range
The Range object has a Select method you can use to make a range the 
current selection; for example:

Dim r As Range
Set r = ActiveDocument.Range(0, 100)
r.Select

A Range object is created for the first 100 characters of a document. Then 
the Range object is selected.

Moving Selections and Ranges
The Selection and Range objects both have Start and End properties 
that indicate the character position of the start of the section or range and 
the position of the end of the section or range. You can set these properties 
directly to change a selection or range. For example, to collapse the active 
selection, you can use this code:

Selection.End = Selection.Start

 The preceding statement leaves the insertion point at the start of the 
selection. If you want to collapse the selection and leave the insertion point 
at the end of the selection, use this code instead:

Selection.Start = Selection.End

You can also add or subtract values to the selection Start or End properties. 
For example, the following code extends the selection by one character:

Selection.End = Selection.End + 1

Methods for moving the selection
The Selection and Range objects sport several methods that let you move 
the start or end of the selection or range:

 ✦ Collapse: Makes the Start and End values the same. You can specify 
a direction as an argument to indicate in which direction the selection 
or range collapses. Specify wdCollapseStart to collapse to the start of 
the selection or range. Specify wdCollapseEnd to collapse to the end.
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579Moving Selections and Ranges

 ✦ EndOf, StartOf: Moves the start or end of the selection or range to the 
start or end of a specified unit. Table 3-4 lists the possible unit values, 
which are used in several other methods as well.

 ✦ Expand: Expands the selection to include the next unit.

 ✦ Move: Collapses the selection or range and then moves the selection or 
range the specified number of units.

 ✦ MoveStart, MoveEnd: Moves the start or end of the selection or range 
the specified number of units.

 ✦ MoveStartUntil, MoveEndUntil: Moves the start or end of the selec-
tion or range until a specified character is found.

 ✦ MoveStartWhile, MoveEndWhile: Moves the start or end of the selec-
tion or range until a character that isn’t a specified character is found.

 ✦ MoveUntil, MoveWhile: Similar to MoveStartUntil/MoveEndUntil 
and MoveStartWhile/MoveEndWhile, but collapses the selection or 
range first.

 ✦ Next, Previous: Moves the selection to the next or previous specified 
unit.

Table 3-4 Constants for Word Units

Constant Description

wdCharacter Character

wdWord Word

wdSentence Sentence

wdParagraph Paragraph

wdSection Section

wdStory Story

wdCell Table cell

wdColumn Table column

wdRow Table row

wdTable Table

A macro that moves the selection
To illustrate how you can move the selection in a macro, the following exam-
ple shows a macro that displays a message indicating how many times the 
font has changed in a selection:
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Sub CountFontChanges()
    Dim iCount As Integer
    Dim iEnd As Integer
    Dim sFont As String
    Dim r As Range
    Set r = Selection.Range
    iEnd = r.End
    r.Collapse
    sFont = r.Font.Name
    While r.Start < iEnd - 1
        Set r = r.Next(wdCharacter, 1)
        If r.Font.Name <> sFont Then
            iCount = iCount + 1
            sFont = r.Font.Name
        End If
    Wend
    MsgBox “The selected text has “ & iCount _
        & “ font changes.”
End Sub

This macro starts by assigning the selection to a Range object named r. It 
then saves the ending character position of the range in a variable named 
iEnd and collapses the range. Next, it saves the name of the font used 
for the first character in the selection in a variable named sFont. Then 
it launches into a While loop that continues until the start of the range 
reaches the character that was just before the last character of the original 
selection.

Within the loop, the Next method moves the range to the next character in 
the document. Then the font of this character is compared with the previ-
ously saved font name. If it’s different, the iCount variable is incremented 
to indicate that the font has changed and the name of the new font is saved 
in the sFont variable. When the loop finishes, the message box displays 
how many times the macro determined that the font changed.

 

You can accomplish this type of character-by-character movement through 
a selection or range in many different ways. For example, I could have coded 
the While loop like this:

While r.Start < iEnd - 1
    r.Start = r.Start + 1
    r.End = r.Start + 1
    If r.Font.Name <> sFont Then
        sFont = r.Font.Name
        iCount = iCount + 1
    End If
Wend

Also, as I discuss in the next section, you can code this macro by using the 
Characters collection of the Selection object.
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581Working with Text

Working with Text
The following sections describe various ways to work with text in a macro.

Accessing text
The Document, Selection, and Range objects have several properties 
you can use to access the contents of a selection or range. These properties 
work the same whether you’re using a Document, Selection, or Range 
object. The following paragraphs describe how they work:

 ✦ Text: Returns a string that contains the text marked by the selection or 
range.

 ✦ Characters: Returns a collection of Range objects, each representing 
one character of the selection or range. Note: There is no Character 
object. Instead, each character is represented by a separate Range 
object.

 ✦ Words: Returns a collection of Range objects, each representing one 
word of the selection or range. As with characters, no separate object 
exists for words. Instead, each word is represented by a Range object.

 ✦ Sentences: A collection of Range objects, each representing one sentence 
of the selection or range. Again, no separate object exists for sentences. 
Each sentence is represented by a Range object.

 ✦ Paragraphs: A collection of Paragraphs, each representing one 
paragraph of the selection or range. Once again, there is no — made 
you look! Word’s object model does have a separate Paragraph object. 
That’s because many formatting options, such as line spacing, indenta-
tion, and tabs, are applied to paragraphs via the Paragraph object.

 ✦ Sections: Returns a collection of Section objects, representing the 
sections in the selection or range.

You can easily implement the CountFontChanges macro that I present 
earlier in this chapter (in the section “A macro that moves the selection”) 
by using the Characters collection of the Selection object:

Sub CountFontChanges()
    Dim iCount As Integer
    Dim sFont As String
    Dim r As Range
    sFont = Selection.Characters(1).Font.Name
    For Each r In Selection.Characters
        If r.Font.Name <> sFont Then
            sFont = r.Font.Name
            iCount = iCount + 1
        End If
    Next
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    MsgBox “The selected text has “ & iCount _
        & “ font changes. “
End Sub

Here, the For Each loop accesses the characters in the selection one at 
a time, so the macro doesn’t have to keep track of the start and end of the 
range as it loops.

Inserting text
The Selection and Range objects offer the following methods for inserting 
text into your document:

 ✦ InsertAfter: Inserts the specified text after the selection or range. 
The selection or range expands to include the new text. For example, the 
following statement inserts text after the selection:

Dim s As String
s = “So let it be written, so let it be done.”
Selection.InsertAfter(s)

 ✦ InsertBefore: Inserts the specified text before the selection or range. 
The selection or range expands to include the new text. Here’s an 
example that writes text before the selection:

Selection.InsertBefore(“Listen up!”)

 ✦ InsertParagraph: Replaces the selection with an empty paragraph.

 ✦ InsertParagraphAfter: Inserts an empty paragraph after the 
selection or range. The selection or range expands to include the new 
paragraph.

 ✦ InsertParagraphBefore: Inserts an empty paragraph before the 
selection or range. The selection or range expands to include the new 
paragraph.

 

Rather than use the InsertParagraph methods, you can also use the special 
VBA constant vbCr to insert a paragraph mark. For example, the following 
code moves to the end of the current paragraph and then inserts the text 
Listen up! as a separate paragraph:

Selection.Move (wdParagraph)
Selection.InsertAfter (“Listen up!” & vbCr)

You can use a similar constant, vbTab, to insert tab characters; for example:

Dim s1, s2 As String
s1 = “Hello”
s2 = “There”
Selection.InsertAfter (s1 & vbTab & s2 & vbCr)
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583Working with Text

Here, the words Hello and There are inserted into the document, sepa-
rated by a tab.

Deleting text
My English teacher in the tenth grade said that any book report that con-
tained the words stupid, dumb, or boring would get an automatic F. Too bad, 
because I read a lot of books that were stupid, dumb, and boring. I probably 
would have passed the class if only I had a macro that automatically deleted 
those words from my book reports.

Here’s a macro that uses the Delete method of a Range object to delete 
those three words from an entire document, and then it displays a message 
to tell you how many words were deleted:

Dim iCount As Integer
Dim r As Range
For Each r in ActiveDocument.Words
    Select Case Trim(r.Text)
        Case “stupid”, “dumb”, “boring”
            r.Delete
            iCount = iCount + 1
    End Select
Next
MsgBox “Deleted “ & iCount & “ words.”

Here, any occurrence of the forbidden words is deleted from the document.

Copying, cutting, and pasting
Both the Selection object and the Range object support the standard 
copy, cut, and paste operations via the Clipboard. Not surprisingly, the 
methods are

 ✦ Copy: Copies the selection or range to the Clipboard.

 ✦ Cut: Cuts the selection or range to the Clipboard.

 ✦ Paste: Pastes the contents of the Clipboard into the selection or range. 
Use the Collapse method to collapse the selection or range if you don’t 
want the Clipboard contents to replace the contents of the selection or 
range.

For example, the following code copies the contents of the first paragraph in 
the document to the selection:

ActiveDocument.Paragraphs(1).Range.Copy
Selection.Collapse
Selection.Paste
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Note two things about this example: First, I had to use the Range property of 
the paragraph to get to the Copy method — because the Paragraph object 
doesn’t have a Copy method. Second, I collapsed the selection before past-
ing it so that the macro doesn’t overwrite any text.

 

You don’t always have to use the Clipboard to copy text to another location 
in the document. For example, the following code does the job without 
involving the Clipboard:

Dim r As Range
Set r = ActiveDocument.Paragraphs(1).Range
Selection.Collapse
Selection.InsertAfter (r.Text)

Formatting Text
All options for formatting text are available through objects you can access 
as properties of the Selection or Range objects. For example, to make the 
current selection bold, set Selection.Font.Bold to True.

The following paragraphs describe the formatting objects you can access via 
the properties of the Selection or Range objects:

 ✦ Borders: A collection of Border objects that define the borders for the 
selection or range.

 ✦ Font: A Font object that lets you set character formatting. For more 
information, see the later section “Using the Font object.”

 ✦ ParagraphFormat: A ParagraphFormat object that controls para-
graph formatting, such as line spacing, alignment, and indentation. For 
more information, see the section “Using the ParagraphFormat object.”

Two other formatting properties you might want to use are

 ✦ Style: Sets the name of the style for the selection or paragraph. For 
example, to set the selected paragraphs back to the Normal style, use 
this code:

Selection.Style = “Normal”

 ✦ TabStops: A collection of TabStop objects. This collection is available 
only from a Paragraph object. For example, this code accesses the first 
Tab stop for the first paragraph in a selection:

Dim t As TabStop
Set t = Selection.Paragraphs(1).TabStops(1)
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585Formatting Text

Using the Font object
The Font object gives you access to all the character formatting options 
available via the Font dialog box (which can be accessed via the dialog box 
launcher in the Font group of the Home tab). As a result, most of its proper-
ties look familiar. Table 3-5 lists the properties you’re most likely to use.

Although you must access most of these properties via the Font property of 
a Selection or Range object, the Range object has shortcuts to the Bold, 
Italic, and Underline properties. Thus, you can set a range to bold, 
italic, or underline without using the Font object. For example, this state-
ment sets the first sentence of the active document to bold:

ActiveDocument.Sentences(1).Bold

 The Sentences collection is a collection of Range objects, so Sentences(1) 
returns a Range object for the first sentence in the collection.

 

Many font properties can be set to True, False, or the special Word con-
stant wdToggle. The wdToggle constant changes the value of the property 
from whatever its current value is. So if the property is True, wdToggle 
changes it to False. If it’s False, wdToggle changes it to True. This con-
stant mimics the behavior of many formatting shortcut keys, such as Ctrl+B 
or Ctrl+I.

Table 3-5 Properties of the Font Object

Property Description

Bold Applies bold formatting

Color Sets the font color

DoubleStrikethrough Applies double-strikethrough formatting

Emboss Embosses the text

Engrave Engraves the text

Hidden Hides the text

Italic Applies italic formatting

Kerning Sets the smallest point size at which Word 
applies kerning

Name Sets the font name

Outline Applies outline formatting
(coninued)
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Table 3-5 (continued)

Property Description

Position Raises or lowers the text by the number of 
points specified

Shading Sets shading for the text

Shadow Applies a shadow effect

SmallCaps Applies small cap formatting

Strikethrough Applies strikethrough formatting

Subscript Applies subscript formatting

Superscript Applies superscript formatting

Underline Underlines the text

UnderlineColor Sets the color for the underline

Using the ParagraphFormat object
The ParagraphFormat object gives you access to all the paragraph 
formatting options available via the Paragraph dialog box. (You can access 
this dialog box by clicking the dialog box launcher in the Paragraph group 
on the Home tab.) As a result, most of its properties look familiar. Table 3-6 
lists the most commonly used properties of the ParagraphFormat object.

 

The properties that require a measurement value (such as 
FirstLineIndent) require the measurement in points. There are 72 points 
in an inch. But if you don’t want to do that calculation manually, you can use 
the InchesToPoints function to do the calculation for you. For example, 
this code sets the FirstLineIndent to 0.75 inches:

With Selection.ParagraphFormat
    .FirstLineIndent = InchesToPoints(0.75)
End With
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587Formatting Text

Table 3-6 Properties of the ParagraphFormat Object

Property What It Specifies

Alignment The alignment (most common values: wdAlign
ParagraphLeft, wdAlignParagraphCenter, 
wdAlignParagraph Right, and wdAlign
ParagraphJustify)

Borders Text borders

FirstLineIndent Indentation of first line, in points

KeepTogether Whether paragraph remains on one page

KeepWithNext Whether paragraph is on same page as next paragraph

LeftIndent Left indent in points

LineSpacing Line spacing in points

LineSpacingRule Type of line spacing (options: wdLineSpace1pt5, 
wdLineSpaceAtLeast, wdLineSpaceDouble, 
wdLineSpaceExactly, wdLineSpace
Multiple, and wdLineSpaceSingle)

PageBreakBefore Whether paragraph begins new page

RightIndent Right indent in points

Shading Paragraph shading

SpaceAfter Spacing after paragraph, in points

SpaceAfterAuto Whether Word automatically sets space that appears 
after paragraph

SpaceBefore Spacing before paragraph, in points

SpaceBeforeAuto Whether Word automatically sets the space that 
appears before paragraph

Style Name of style for paragraph

TabStops TabStops collection for paragraph
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Chapter 4: Creating UserForms

In This Chapter
✓ Adding a UserForm to a macro project

✓ Discovering labels and text boxes

✓ Fiddling with frames

✓ Carrying on with check boxes and option buttons

✓ Working with combo boxes

✓ Creating list boxes that allow multiple selections

This chapter shows you how to create macros that display customized 
dialog boxes known as UserForms, which are interactive, customizable 

forms in a Word document. Their reason for existence is to collect information 
from users and then perform actions based on that information. UserForms 
are crucial to creating sophisticated Word macros that automate routine 
tasks. But UserForms aren’t just for complicated macros. Sometimes, even 
a simple macro can benefit from a modest UserForm to gather a few critical 
items of data from the user before proceeding. You can find out more about 
macros in Chapter 1 of this minibook.

Understanding UserForms
UserForms help you obtain any kind of information you need from the user 
in a single interaction. Suppose that you need to know a person’s name, 
company, and e-mail address. You can use a series of InputBox statements, 
such as these:

Dim Name, Company, EmailAddress As String
Name=InputBox(“Name:”, “Info”, Name)
Name=InputBox(“Company:”, “Info”, Company)
Name=InputBox(“Email Address:”, “Info”, EmailAddress)

Wouldn’t simply displaying a single dialog box to gather all three items 
be more convenient for the user? Using UserForms, you can, as shown in 
Figure 4-1.
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590 Understanding UserForms

 

Figure 4-1: 
A custom 
UserForm.

 

UserForms aren’t as powerful as the forms you can create in a full-fledged 
programming language, such as Visual Basic or C#. However, you can create 
forms by using any of the dialog box controls described in Table 4-1.

Table 4-1 UserForm Controls

What It Looks Like Name What It Does

Label Displays text on the form

TextBox Lets the user enter text

ComboBox Displays a drop-down list

ListBox Displays a scrollable list

OptionButton Lets you select one of several 
alternative settings

CheckBox Supplies a yes/no or on/off setting

ToggleButton Lets you select yes/no values

Frame Creates a group of controls

CommandButton Invokes a Sub procedure when 
clicked

TabStrip Divides a form into multiple tabs

MultiPage Divides a form into multiple pages

ScrollBar Displays a scroll bar
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591Creating a UserForm

What It Looks Like Name What It Does

SpinButton Lets you select from a range of 
values by incrementing or decre-
menting the value

Image Displays a picture

Creating a UserForm
The VBA editor includes a form designer that lets you create UserForms by 
dragging and dropping controls from a toolbar to the form. You can then 
adjust the property settings for each control by using the Properties pane. 
Adjusting properties is the fun part of creating a UserForm. Figure 4-2 shows 
a UserForm being created in the form designer.

 

Figure 4-2: 
Creating 
a custom 
UserForm.
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592 Creating a UserForm

To create a UserForm, follow these steps:

 1. Select the project you want to add the UserForm to in Project Explorer.

  The Project Explorer window appears in the upper-left corner of the 
VBA editor. Each open document and template is listed as a project. If 
you want to create a UserForm in the Normal.dotm template so that 
it’s available to any document, you can just select Normal in Project 
Explorer. But if you want to create the UserForm in another template, 
you must first open that template by choosing File➪Open. If you simply 
open a document that’s attached to the template, the template is listed 
in Project Explorer, but you can’t access it.

 2. Choose Insert➪UserForm.

  A blank UserForm is created, as shown in Figure 4-3.

 

Figure 4-3: 
A blank 
UserForm 
awaiting 
your design.

 

Run button

 3. To add a control to the form, click the control you want to add in the 
Toolbox and then click the form where you want to add the control.

  You can add any of the controls listed earlier, in Table 4-1. I explain each 
of the controls later in this chapter.
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593Creating a UserForm

  After you add a control, you can drag it around the form to its final 
position. And, you can resize the control by clicking the control to select 
it and then dragging one of its size handles.

 4. To change a property, select the control you want to change and then 
use the Properties pane (in the lower-left part of the window) to set 
the property you want to change.

  To set a property for the form itself, click the form anywhere outside 
one of its controls. You find more information about setting properties 
for form control in the next section.

  You can also use the drop-down list that appears at the top of the 
Properties pane to choose a form or control.

 5. To see how your form will appear when run, click the Run button.

  Running the form from the VBA editor in this way is useful for ensuring 
that the form looks the way you want.

 6. When you’re satisfied, click the form’s Close button to close the form.

 7. Write whatever code is necessary to implement the form’s processing 
requirements.

  To add code that executes whenever the user clicks a button, double-
click the button in the form designer. This action opens the VBA editor 
and creates a Sub procedure that’s all set up to run when the user clicks 
the control.

  You might also want to write code that executes when the form is first 
displayed. To do that, switch to the code window by choosing View➪
Code. Then choose the form from the drop-down list at the top left of 
the code window and choose Initialize from the drop-down list at the 
top right of the code window. A Sub procedure automatically runs when 
the form is initialized. (One common use for the form Initialize 
procedure is to add items to a drop-down list or list box control.) For 
more information, see the sections “Using Combo Boxes” and “Using List 
Boxes,” later in this chapter.

Here are a few other points to ponder as you create UserForms:

 ✦ Be sure to save your work often by clicking the Save button in the VBA 
editor.

 ✦ To remove a control from the form, click the control to select it and 
press Delete.

 

✦ If your form requires several similar controls, create one of them first 
and adjust its properties the way you want. Then use good old Copy and 
Paste commands to duplicate it. (Select the control, press Ctrl+C, and 
then click the form to select it and press Ctrl+V.)
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 ✦ If you inadvertently double-click a control and the code window pops 
up, you can select and delete the Sub and End Sub statements that are 
generated. To return to the form designer, choose View➪Object.

 ✦ If the Toolbox disappears on you, you can restore it by choosing View➪
Toolbox.

 ✦ If you accidentally create the form in the wrong template, you can use 
the Project Explorer window to drag the form to the correct template.

 

✦ If you want the form to appear automatically whenever you create a 
new document based on the template that contains the form, create an 
AutoNew macro in the template. This macro can then call the form’s 
Show method to show the form. For example:

Sub AutoNew()
    UserForm1.Show
End Sub

 ✦ Even if you include an AutoNew macro to automatically call up the 
form when a new document is created, you might also want to provide 
another way for the user to access the form after the document opens. 
For example, you might want to create a macro similar to the preceding 
AutoNew macro to show the form. Then you can add a button to the 
Quick Access toolbar to call up the form.

Working with Controls
Most of the work of creating macros that use UserForms is setting up the 
controls that appear on the form. After you add a control to a form, you 
need to adjust the control’s properties. You can do that via the Properties 
pane. First, select the control whose properties you want to adjust. Then 
locate in the Properties pane the property you want to adjust and specify 
whatever settings you want to apply.

All controls have several properties in common. In particular:

 ✦ Name: Specifies the name of the control, which is used to access the 
control from code. Provide a meaningful name for every control you 
need to refer to in code. For controls, such as labels, that aren’t referred 
to in code, you can leave alone the default names (such as Label1).

  When you create a name for a control, begin with a short prefix to 
indicate its type. For example, give text boxes names such as txtName 
and txtEmail, and give buttons names such as btnOK and btnCancel.

 ✦ Caption: Sets the text that the control displays; not every control has 
a Caption property, but most do. The default value for the Caption 
property is the control’s name, so you almost certainly should change it 
to a more suitable name.
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595Using Command Buttons

 ✦ Accelerator: Specifies the letter that the user can use along with 
the Alt key to activate the control without using the mouse. The first 
occurrence of this letter is underlined in the control’s caption. For 
example, if you specify Proceed for the Caption property and “o” for 
the Accelerator property, the caption appears as Proceed on the 
control.

 ✦ TabStop: Indicates whether the user can move to the control by pressing 
the Tab key. Controls that accept input usually have this property set to 
True.

 ✦ TabIndex: Specifies the order in which the Tab key cycles through the 
controls. After you set up all the controls on a form, you can set the 
TabIndex property of each control to get the tab order right. For 
example, set the TabIndex to 1 for the control you want to be first in 
the tab order; 2 for the control you want to be second; and so on.

 ✦ Enabled: Indicates whether the control is enabled. If you set this 
property to False, the control is dimmed.

 ✦ ControlTip: Supplies text that’s displayed as a tip if the user hovers 
the cursor over the control for a few moments. You can use this prop-
erty to provide additional information about what the control does or 
what happens if the user clicks the control.

When you have a control’s properties set the way you want, you can add 
code for the control by double-clicking the control. Double-clicking opens 
the code window and creates a Sub procedure that executes if the user 
clicks the control. In most cases, you create a Sub procedure only for 
command button controls. However, you can create a procedure to handle 
clicks for any control on a UserForm, not just for command buttons.

Using Command Buttons
The command button is the workhorse of most UserForms. You usually 
need to set one property for a command button: Caption. Use the Caption 
property to specify the text you want to appear on the button. You might 
also want to set the Accelerator property for command buttons.

The hard part of working with command buttons is writing the code that is 
supposed to execute when the user clicks the button. To create this code, 
simply double-click the button in the form designer.

Creating a Cancel button
All forms need a Cancel button that lets the user bail out of the form without 
doing anything. The click procedure for the Cancel button typically looks 
like this:
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596 Using Command Buttons

Private Sub btnCancel_Click()
    Hide
End Sub

The Hide statement is a call to the Hide method of the current form, which 
closes the form and returns the user to the document. You can specify the 
form name on this statement, but the current form is assumed by default if 
you don’t, so just coding Hide is enough.

 

The Hide method doesn’t stop the macro from running. If your macro 
needs to do additional work after it closes the form, it can include additional 
statements after the Hide method call.

Creating an OK button
Most UserForms also contain a button that processes the data the user 
enters on the form. This button goes by various names, such as OK or Save, 
depending on what the form does. In many cases, the code behind this 
button extracts the data the user entered in the form and inserts it into the 
document, either at the location of the insertion point or at predefined 
locations marked by bookmarks.

For example, the following code shows the click procedure for the OK 
button in the form shown earlier (refer to Figure 4-1). In this example, the 
information from the three text boxes is inserted into the document after the 
selection:

Private Sub CommandButton1_Click()
    Selection.InsertAfter txtName.Text & vbCr
    Selection.InsertAfter txtCompany.Text & vbCr
    Selection.InsertAfter txtEmail.Text & vbCr
    Selection.Collapse wdCollapseEnd
    Hide
End Sub

After the text is inserted, the selection collapses and the form closes.

Suppose that you want to insert the text in an area of the document marked 
by a Customer bookmark rather than in the selection. In that case, use code 
similar to this:

Private Sub CommandButton1_Click()
    If ActiveDocument.Bookmarks.Exists(“Customer”) Then
        Dim r As Range
        Set r =ActiveDocument.Bookmarks(“Customer”).Range
        r.InsertAfter txtName.Text & vbCr
        r.InsertAfter txtCompany.Text & vbCr
        r.InsertAfter txtEmail.Text & vbCr
        Hide
    Else
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        MsgBox “Missing bookmark!”
    End If
End Sub

Using Labels
Label controls display text on the form. For plain, unexciting labels, just 
drag a label control from the Toolbox onto the form, set the label’s Caption 
property to the text you want to display, and be done with it. For fancier 
labels, you can set the following properties by using the Properties pane:

 ✦ Font: The font used for the Caption text. When you set the Font 
property in the Properties pane, a Font dialog box appears, allowing you 
to choose the font, style (such as bold or italic), and size.

 ✦ TextAlign: Lets you choose the text alignment: left, centered, or right.

 ✦ SpecialEffect: Lets you apply one of the four special effects shown in 
Figure 4-4.

 ✦ WordWrap: Indicates whether the text wraps onto multiple lines if the 
label isn’t wide enough to display it all.

 

Figure 4-4: 
Special 
effects 
for label 
controls.

 

Using Text Boxes
The text box is the main tool you use to gather text input from the user for 
your macro. The user’s input is available by using the Text property. The 
following code assigns the text entered into a text box named txtCompany 
to a variable named Company:

Company = txtCompany.Text

You can also use the Text property to assign an initial value to a text box. 
Then, if the user doesn’t change the value, the initial value is retained. You 
can set the initial text value with an assignment statement such as this 
example in the form’s Initialize procedure:

txtCompany.Text = “John Wiley & Sons, Inc.”
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Or, you can set the initial value in the Properties pane when you design 
the form.

Text boxes have a few other noteworthy properties:

 ✦ MaxLength: Limits the number of characters the user can enter. When 
the entry exceeds the MaxLength limit, anything else the user types is 
ignored.

 ✦ MultiLine: If set to True, allows the user to enter more than one line 
of text into the text box. The user must press Shift+Enter to create a new 
line. You usually increase the height of the text box to display the addi-
tional lines.

 ✦ PasswordChar: Allows you to create a password entry field. Rather 
than display the text entered by the user, the password entry field dis-
plays the password character. That way, nosey bystanders can’t see 
what the user typed.

Using Frames
A frame control is a container that lets you group controls on a form. A frame 
not only adds visual structure to the form but also helps out when you use 
option buttons, as I discuss in the next section.

To use a frame control, just drag a frame from the Toolbox onto the form 
and then resize it and position it however you want. Then you can drop 
other controls onto the frame.

The only property you’re likely to set for a frame control is the Caption 
property, which sets the text displayed in the margin of the frame. You 
might also want to experiment with the SpecialEffect property if you 
want to give the frame a nonstandard look.

Using Check Boxes and Option Buttons
Check boxes and option buttons allow the user to select options. For exam-
ple, Figure 4-5 shows a UserForm that gathers information needed to order 
a pizza. The user selects the size of the pizza from a group of option buttons 
and chooses toppings by selecting check boxes. (This UserForm also uses 
frames to provide nice borders around the Size and Toppings sections of the 
dialog box.)

When you create a check box or option button, you use the Caption prop-
erty to set the text that describes the option. Then, in your code, you can 
use the Value property to determine whether the check box or option 
button is selected.
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Figure 4-5: 
A pizza 
order form.

 

Grouping option buttons
The main difference between check boxes and option buttons is that check 
boxes are independent of one another. In contrast, option buttons travel in 
groups, and a user can select only one option button in a group at a time. To 
indicate which group an option button belongs to, you set the GroupName 
property. If a form has only one group of option buttons, you can leave this 
property blank. You can also ignore the GroupName property if you place 
each group of option buttons in a separate frame. But if you have two or 
more groups of option buttons and they’re not isolated in frames, you must 
set this property to indicate which group each option button belongs to.

Testing option button and check box values
You can test the setting of a check box or option button in code by testing 
the Value property for True or False. For example, the following code 
runs when the user clicks the OK button for the UserForm shown earlier, in 
Figure 4-5:

Private Sub btnOK_Click()
    Dim s As String
    s = “Pizza size: “
    If obtnSmall.Value = True Then
        s = s & “Small” & vbCr
    ElseIf obtnMedium.Value = True Then
        s = s & “Medium” & vbCr
    ElseIf obtnLarge.Value = True Then
        s = s & “Large” & vbCr
    ElseIf obtnGiant.Value = True Then
        s = s & “Giant” & vbCr
    End If
    s = s & “Toppings: “ & vbCr
    If chkPepperoni.Value = True Then
        s = s & vbTab & “Pepperoni” & vbCr
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    End If
    If chkSausage.Value = True Then
        s = s & vbTab & “Sausage” & vbCr
    End If
    If chkMushrooms.Value = True Then
        s = s & vbTab & “Mushrooms” & vbCr
    End If
    If chkOlives.Value = True Then
        s = s & vbTab & “Olives” & vbCr
    End If
    If chkGarlic.Value = True Then
        s = s & vbTab & “Garlic” & vbCr
    End If
    If chkAnchovies.Value = True Then
        s = s & vbTab & “Anchovies” & vbCr
    End If
    Selection.InsertAfter s
    Hide
End Sub

In this example, a string variable named s constructs the text that’s inserted 
into the document. First, the option buttons are checked in a series of If/
ElseIf statements to determine which size was selected. Then a series of 
separate If statements determine which toppings to include in the order. 
(For more information about string variables, refer to Chapter 2 of this 
minibook.)

Suppose that you run this form, select a large pizza, and select the 
Pepperoni, Garlic, and Anchovies check boxes. In that case, the following 
text is inserted into the document when you click OK:

Pizza size: Large
Toppings:
     Pepperoni
     Garlic
     Anchovies

You’d better be hungry because you’ll probably end up eating this one by 
yourself. You’d better have some breath mints handy, too.

Using Combo Boxes
A combo box displays a drop-down list that lists options from which the user 
can choose. Depending on how you configure the combo box, the user might 
also be able to type a selection if one of the items in the list isn’t suitable.

 

I discuss list boxes (which are similar to combo boxes) in the later section 
“Using List Boxes.”
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When you create a combo box, you can set the Style property to indicate 
the type of combo box you want to create. Your choices are

 ✦ DropDownCombo: The user enters a value in the text box part of the 
control.

 ✦ DropDownList: The user is forced to choose an item from the list.

To use a combo box in a macro, you have to know how to write code to do 
two things: load the items for the list into the combo box and determine 
which of the list items the user selected. I describe these coding techniques 
in the following sections.

Loading items into a combo box
To load items into a combo box, you use the AddItem method. The best 
time to use this method is when the form is initializing. For example, here’s 
an Initialize procedure for a form that loads a combo box withpossible 
sizes for the pizza:

Sub UserForm1_Initialize()
    cboSize.AddItem “Small”
    cboSize.AddItem “Medium”
    cboSize.AddItem “Large”
    cboSize.AddItem “Giant”
End Sub

And, here’s a For Each loop that loads the names of all available fonts into 
a combo box:

Dim FontName As Variant
For Each FontName in FontNames
    cboFonts.AddItem FontName
Next

Determining which item was selected
To determine which item the user has selected from a combo box, use the 
Value property. For example:

Dim Size As String
Size = cboSize.Value

If, for some reason, you’re interested in knowing the index number of the 
item chosen by the user, use the ListItem property instead. However, be 
aware that unlike most VBA indexes, the ListItem value for the first item in 
the combo box is 0, not 1.
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Setting the selected item
In some cases, you want to set the item that’s selected in a combo box from 
VBA. For example, you might want to force the first entry in the combo box 
to be selected when the form is initialized. You can use the ListIndex 
property to do that. For example:

cboSize.ListIndex = 0

In this example, the first item is selected.

 Combo boxes number their list items beginning with 0, not 1.

Using List Boxes
A list box is similar to a combo box, but it doesn’t have the same drop-down 
ability. Instead, a list box displays one or more items from the list, depending 
on the vertical size of the list box. If not all items fit, a scroll bar appears so 
that the user can scroll through the list.

In most cases, list boxes are much less useful than combo boxes. However, 
list boxes have one feature that combo boxes don’t have: the ability to let 
the user select more than one item from the list. For example, Figure 4-6 
shows a form with a list box that lets the user select several choices from a 
long list of pizza toppings.

 

Figure 4-6: 
Adding a 
list box and 
combo box.

 

To create the effect shown in the list box in Figure 4-6, I set two properties 
for the list box:

 ✦ MultiSelect: Set to Multi to allow more than one selection.

 ✦ ListStyle: Set to Option to display check boxes next to each item in 
the list.
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Loading items into a list box
You load items into a list box just like you load items into a combo box. For 
example, here’s some of the code from the form Initialize procedure for 
the form shown in Figure 4-6:

lbToppings.AddItem (“Pepperoni”)
lbToppings.AddItem (“Sausage”)
lbToppings.AddItem (“Salami”)
lbToppings.AddItem (“Linguica”)
lbToppings.AddItem (“Pastrami”)
lbToppings.AddItem (“Ground Beef”)
lbToppings.AddItem (“Chicken”)
lbToppings.AddItem (“Canadian Bacon”)

Dealing with multiple selections
Determining which items are selected in a multiselect list box is tricky. You 
need to use three properties of the list box to do this:

 ✦ ListCount: Indicates the number of items in the list

 ✦ List(index): Retrieves the specified item from the list

 ✦ Selected(index): Indicates whether the specified item was selected

Putting these three properties together, the following For/Next loop 
creates a string variable named msg that lists all toppings selected from the 
lbToppings list box:

Dim s As String
Dim i As Integer
For i = 0 To lbToppings.ListCount - 1
    If lbToppings.Selected(i) = True Then
        s = s & lbToppings.List(i) & vbCr
    End If
Next i

The If statement determines whether the item for the current index value is 
selected. If so, the item is appended to the string.
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Symbols 
& (ampersand), 545–546
’ (apostrophe), 541, 545
*(asterisk) characters, 150
{ and } curly braces, 496
” (quotation marks), 545
_ (underscore) character, 

150, 541

A
accelerators, 10
accounts, blogs, 330–333
actions, 29, 135, 222
ActiveX, Trust Center, 493
Add Templates dialog box, 

46–47
add-ins, 490, 492
Add-Ins tab, Word Options 

dialog box, 492
Address bar, 25–26, 32
address blocks, 435–438
address labels, 419–421
address lists, 433–435
Adjust List Indents dialog 

box, 205–206
Advanced tab, 33–34, 59–60, 

480–482
Align Left, 85
Align Right, 85
alignments

drawing objects, 242–243
indexes, 379
paragraph formatting, 85
table of contents, 360
table of fi gures, 366

Allow Background Save, 34
alpha channel, 246
Alt key, 10, 129
Always Create Backup 

Copy, 33
ampersand (&) character, 

545–546

anchors, 257, 477
animations, 485, 489
antivirus programs, 537
APA, bibliography format, 

386
apostrophe (’), 541, 545
Application object, 

569–570
Apply Styles dialog box, 

117–118
area, chart type, 261
arrow buttons, 70–71
arrow keys, 15, 26, 69
arrows, 235
art objects, 197–198
assignment statements, 542
Assistant box, 279
asterisk (*) characters, 150
Attach Template dialog 

box, 42–43
attachments, 427–428, 475
Author Name fi eld, 408
authoring software, 325
auto macros, 536
AutoClose, 536
AutoComplete, 483
AutoCorrect

AutoFormat, 147–148
versus AutoText, 154
spelling suggestions, 158
typing mistakes, 145–146
typo corrections, 102

AutoExec, auto macro, 536
AutoExit, auto macro, 536
AutoFit command, 239–294
AutoFormat, 146–152
AutoMark fi le, 382–383
automatic links, 489
automatic startup, 8
AutoNew, auto macro, 536
AutoOpen, 536
AutoRecover. 479–480
AutoRecover File Location, 

33

autosave, 18, 33
AutoShapes, drawing 

canvas, 482
AutoText, 153–154
AutoText Entries, 56
Avery labels, 420–421
axes, 260, 272
Axes group, 272
axis title, charts, 270

B
Back button, 65
background

charts, 272
page formatting, 195–198
printing, 59, 487
repagination, 489–490
saving work, 488

background colors, 58, 
88–90, 477, 485

Background group, 272
background images, 58, 

477, 485
background printing, 59, 487
Backspace key, 15, 131, 132
Backstage view

blog posts, 327–330
changing document 

template, 42–43
closing, 14, 21
Compatibility Mode, 22
default fi le location, 27–28
document creation, 23–25
document information, 14
document printing, 54–60
fi le list display settings, 

486
fi le save settings, 32–34
File tab, 10, 13, 21
form entry conventions, 

522
Help system access, 64
Info page information 

display, 21–22

Index
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Backstage view (continued)

New page, 24–25
online templates, 39–40
opening documents, 25–30
Permissions, 22
Prepare for Sharing, 22
Print Preview, 60–61
printer selections, 55
printing documents, 16, 

56–57
recently used document 

templates, 41
sample templates, 41
Versions, 22

backup copies, 488
backups, 33
banners, drawing, 225
bar, chart type, 261
bar tabs, 100
base styles, 123–124
basic shapes, drawing, 225
bevels, 236, 238–239, 254
bibliographies, 386, 388–389
Bing search, 163
bitmaps, 245–247
Blank Document icon, 

23–24
block arrows, drawing, 225
block quotes, 86–87
Blog Accounts dialog box, 

333
Blog Post icon, 24
blogs

account registration, 
330–333

authoring software, 325
e-mail publishing, 332
entry conventions, 326
entry editing, 330
hosting, 325, 326
hyperlinks, 334–335
post entry, 327–330
Post Title fi eld, 329–330
publishing posts, 334
readers, 325
styles, 329

body text, 400
bold formatting, 150

boldface, 81
book folds, 170, 173
booklets, printing, 173
Bookmark dialog box, 

74–75, 380–381
bookmarks

displaying, 485
document navigation, 

74–75
indexes, 380–381
Range object, 577

borders
AutoFormat, 151
page, 176, 197–198
paragraph, 90–94
pictures, 254
style formatting, 105

Borders and Shading dialog 
box, 91–94, 197–198

bottom margins, 169
boxes, 279
Breaks gallery, 186–187
brightness, 255
Bring Forward control, 242
browse control, 70, 72–73
Browse menu, 72–73
bubble, 261–262
bubbles, callouts, 311–312
Building Block entries, 38
Building Blocks, 46–48
bullet formats, 203–204
Bullet Library, 203–204
bullet lists

AutoFormat, 151
bullet formats, 203–204
Bullets button, 200–202
creating automatically, 

199–200
custom bullet, 206–208
formatting controls, 

205–206
Normal style, 483
organization charts, 278
paragraph formatting, 86
SmartArt diagrams, 

272–277
sorting, 87–88
style formatting, 105

Bullets button, 200–202
Bullets gallery, 206–208
buttons, macros, 529–530

C
Calibri, default font, 23
callouts, 225, 311–312
Cancel button, 595–596
capitalization, fi eld 

controls, 501
Caption dialog box, 

307–308, 365
caption labels, 366–367
captions, 306–308, 365
case matching, 139
cells, 131, 281–283, 291–292
Center alignment, 85
Change Chart Type button, 

264
Change Styles control, 

108–109
Changes group, 352
chapter numbers, 361
character formatting, 401
character styles, 105, 107, 

112–113, 116
characters

deletion, 131–132
drop caps, 315–316
optimizing, 487
text formatting, 77–80

Chart dialog box, 261–263
Chart Layout gallery, 

267–268
Chart Style gallery, 268–269
charts

area, 261
axes, 260
axis title, 270
backgrounds, 272
bar, 261
blog insertion, 334–335
bubble, 261–262
captions, 306–308
column, 261
data labels, 270–271
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data selections, 266–267
data tables, 271
datasheets, 260
document insertion, 

261–263
doughnut, 261–262
Draft mode, 487
embellishments, 269–272
Excel 2010, 260, 263–264
layouts, 260, 267–268
legends, 260, 270
line, 261
organization, 277–280
pie, 261
radar, 261–262
refreshing, 267
row/column switching, 

265–266
series, 260
source data editing, 267
stock, 261
styles, 260, 268–269
surface, 261–262
switching types, 264–265
titles, 269
types, 260
xy scatter, 261

check box fi elds, 518–520
Check Box Form Field 

Options dialog box, 
519–520

check boxes, 598–600
Check for Updates, 66
Chicago, bibliography, 386
circles, drawing, 224
citations

bibliography, 388
fi eld codes, 393–394
marking for table of 

authorities, 392–394
source, 388–389
source references, 

385–388
table of authorities, 395

Clear All button, 133
Clear Formatting button, 

84, 106–107

Click and Type, 483
clip art, 247–250, 334–335
Clip Art task pane, 248–250
Clipboard, 263–264, 

583–584
Clipboard task pane, 

132–134
Close button, 9
codes. See also fi eld codes

bullet lists, 200
citations, 393–394
displaying, 486
index marking, 377
indexes, 379
number lists, 200
sequence numbers, 217
table of authorities, 395

collated printing, 55–57
collections, VBA, 551
color depth, bitmap, 246
color palettes, text, 83
color schemes, 475
color tones, 255
colors

document backgrounds, 
196–197

highlighter, 82–83
page borders, 197–198
paragraph backgrounds, 

88–90
picture adjustments, 255
shape fi lls, 229–230
Shape Outline control 

settings, 235
text formatting, 83

Colors dialog box, 229–230
columns

adding to a table, 290–291
breaks, 193
chart editing, 265–266
chart type, 261
click and drag text, 129
indexes, 378
linked text boxes, 194
page formatting, 189–194
table element, 281–283
table selections, 131

table width, 292–293
vertical bars, 100
width, 192–193

Columns dialog box, 
191–192

Columns menu, 190
combo boxes, 600–602
command buttons. See also 

icons
Quick Access toolbar, 10, 

462–463
Ribbon tab groupings, 13
UserForms, 595–597

commands, removing from 
a macro, 535

comments, 344–348, 541
Communications group, 

337
Compare Documents dialog 

box, 352–353
Compatibility Mode, 22
concatenation, 545–546
concordance, 383
constants, 573, 575–584
Contact Microsoft, 66
contents

blog entries, 326
clearing all formatting, 84
document display 

settings, 485
fi le display view, 26–27
template element, 38

context-sensitive help, 63
contextual tabs, 12
Continue Numbering 

command, 210
Continuous, section breaks, 

186
contrast, picture, 255
controls, 590–591, 594–595
Convert button, 371
Convert Notes dialog box, 

371
Convert Table to Text 

command, 302
Convert Text to Table 

command, 301–302
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Copy command, 29, 483–484, 
583–584

Copy Remotely Stored Files 
onto Your Computer, 33

Cover Page gallery, 194–195, 
313–314

cover pages, 194, 313–315
crash recovery, 18
Create New Style from 

Formatting dialog box, 
112–113

Create Source dialog box, 
386–387

Crop button, 253
crop marks, 485
cross-references, index 

entries, 382
Ctrl key

click and drag text 
selections, 129

document navigation, 
69–70

drag-and-drop editing, 134
entire word deletion, 132
mouse wheel zooming, 71
opening multiple fi les, 26

curly braces { and }, 496
cursors, 130. See also 

insertion point
Curve tool, 228
curved lines, drawing, 228
curved shapes, 228
Custom Pages group, 338
custom toolbars, 466–467
customizations, 46–48
Customize Keyboard dialog 

box, 122–123, 467–468
Customize menu, 53–54
Customize Ribbon tab, 492
Cut command, 29, 483–484, 

583–584

D
dashes, 235
data labels, 270–271
data links, 58

data selections, 266–267
data sources, 430, 449–450
data tables, 271
databases, 433, 450–453
datasheets, 260
Date-Time Picture switch, 

500, 503–504
declarations, variables, 

543–544
Default File Location, 33
Defi ne New Bullet dialog 

box, 206–208
Defi ne New List Style dialog 

box, 214–215
Defi ne New Multilevel List 

dialog box, 213–216
Defi ne New Number Format 

dialog box, 208–210
Delete button, 291–292
Delete Cells dialog box, 292
Delete command, 29
Delete key, 27, 131–132
Demote button, 404
Design tab, 181–182
Desktop folder, 30
desktop icons, 8
details, fi le display view, 

26–27
Developer tab

adding to Ribbon, 43–44
fi elds, 518–521
form templates, 514
macros, 528–533, 537
text fi elds, 517–518

diagrams, 272–277
dialog boxes, 63, 535–536, 

561
dictionaries, 157–158
direct formatting, 46 
directories, 448
Display tab, 57–58, 475–478
Document object, 570–573
document libraries, 

338–339
document management 

servers, 480

document properties, 56, 
58, 475, 477

Document Template button, 
43–44

document windows, 485
documents. See also fi les

AutoMark fi le indexing, 
382–383

autosave settings, 18
backgrounds, 195–198
Backstage view, 14, 21–25
bookmarks, 74–75
browse control navigation, 

70, 72–73
changing existing 

template, 41–43
chart insertion, 261–263
closing, 19–20
comments, 344–348
comparing, 352–353
content display settings, 

485
converting to template, 

44–45
copying styles to 

template, 49–51
cover pages, 194–195, 

313–315
creating from template, 

39–41
creating on startup, 15
cut, copy, and paste 

settings, 483–484
default fi le location 

settings, 27–28
deleting, 27, 132
DOCX fi le extension, 38
drag-and-drop editing 

between, 134
e-mailing, 427–428
endnotes, 369–373
equation insertion, 

318–320
Extend mode, 131
facing, 425–427
fi le display views, 26–27
fi rst time save, 31–32
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font type settings, 80–81
footnotes, 369–373
global templates, 46–48
Go Back command 

navigation, 74
Go To command 

navigation, 71–72
hiding/displaying 

paragraph marks, 88
key combo navigation, 

69–70
keystroke navigation, 69
Line Numbers control, 

174–175
macro storage, 527
manual index marking 

method, 376–377
modifying an existing 

template, 46
mouse navigation 

techniques, 71
Navigation pane, 75–76
Normal.dotm 

characteristics, 23
Normal.dotm template, 

38–39
opening, 18–19, 25–30, 

341–342, 489
organization charts, 

277–280
Outline view, 400–401
page borders, 197–198
paragraph formatting, 

85–95
previous version save, 33
printing, 16, 53–60
protections, 353–354
recently used fi le list, 19
renaming, 27
replacing existing, 31
reverse order printing, 59
reviewing, 343–344
save format, 479
saving, 17–18, 41, 147, 

339–340
screenshots, 320–321

scroll bar navigation, 
70–71

selection bar, 130
SmartArt diagram 

insertion, 275–276
spell checking, 159–161
stories, 572–573
style area, 125–126
symbol insertion, 317–318
tab stops, 95–97
table of contents, 357–364
table of fi gures, 364–367
tables of authorities, 

392–397
template elements, 37–38
text box insertion, 

303–306
thumbnail navigation, 76
Trust Center settings, 492
uploading to SharePoint, 

341
watermarks, 195–196
whole document margin 

settings, 170
word count statistics, 163

Documents folder, 30
Documents library, 25–26
DOCX fi le extension, 38
DOTM fi le, 38
dots per inch (dpi), 246
DOTX fi le extension, 38
double strikethrough, 81, 

83–84
doughnut, 261–262
Downloads folder, 30
draft fonts, 486
Draft mode, 487
draft quality, 59, 487
Draft view

comment display, 348
draft fonts, 486
opening documents, 489
style area pane settings, 

486
tracked changes, 349
user interface, 9, 13

drag-and-drop, 134, 482
Draw Table command, 

284–286
Draw Text Box command, 

303
drawing canvas, 482
Drawing Grid dialog box, 

243
drawing objects, 58
Drawing Tools Format tab, 

223
drawings

alignments, 242–243
banners, 225
basic shapes, 225
block arrows, 225
callouts, 225, 311–312
circles, 224
curved lines, 228
curved shapes, 228
equation shapes, 225
fl ipping objects, 239–241
fl owchart symbols, 225, 

227
free-form shapes, 226–228
gridlines, 243
grouping/ungrouping 

objects, 244
layered objects, 241–242
lines, 224
ovals, 224
polygons, 226–228
printing, 477
rectangles, 224
rotating objects, 239–241
saving frequently, 222
shape effects, 235–239
shape fi lls, 229–235
Shape Outline control, 235
simple objects, 222–224
speech bubbles, 225
squares, 224
stars, 225
straight lines, 223
styling shapes, 229
tables, 284–286
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drawings (continued)

text box display, 485
text boxes, 225
undoing actions, 222
zoom factors, 221–222

Drop Cap dialog box, 316
drop caps, 315–316
drop-down fi elds, 520–521
Drop-Down Form Field 

Options dialog box, 
520–521

drop-down lists, 512
duplex printing, 60, 488

E
edge handles, 252–253
Edit Category dialog box, 

396–397
Edit Data button, 267
ElseIf statement, 554–555
em dash, 150, 318
e-mail, 427–428, 443–444, 

475
e-mail publishing, 332
Embed Fonts in the File, 

33, 474
emboss, text, 81, 83–84
en dash, 150, 318
End key, 70
endnotes, 370–371, 373
engrave, text, 81, 83–84
Enter key, 15, 101
Envelope Options dialog 

box, 445
envelopes, 417–419, 

444–446
Envelopes and Labels 

dialog box, 417–421
Envelopes command, 

417–419
Equation button, 318–320
Equation gallery, 318–320
equation shapes, 225
equations, 318–320
Escape key, 14, 21

Even Pages, 56, 186
events, VBA conventions, 

548
Excel 2010, 260, 263–264
Extend mode, 131
extraneous spaces, 101

F
Favorites bar, 29–30
fax modems, 426
fax services, 426, 427–428
faxes, 425–428
feedback, 489
fi eld codes. See also codes

displaying, 486
printing, 59, 488

Field dialog box, 497–498
Field Options dialog box, 

498
fi eld shading, 486
fi eld types, 496
fi elds

capitalization controls, 
501

curly braces { and }, 496
direct typing entry, 

499–500
fi eld types, 496
form, 511–512
inserting, 497–499
instructions, 496
keyboard shortcuts, 

499–500, 504
number formats, 501–503
placeholder codes, 

495–496
reference, 505–510
results, 496
Seq, 505
sequence numbers, 217
switches, 500–504
table of contents, 364
updating before printing, 

58, 478, 488, 504–505
fi le blocks, 493

fi le formats
bitmaps, 245–247
conversion confi rmation, 

489
Save As Type list, 32
saved document 

selections, 479
vector drawings, 247

File Locations, 474
File Locations dialog box. 

28, 490–491
File tab, 9–10, 13–14, 19, 21
fi les. See also documents

AutoMark, 382–383
autosave settings, 18
default location settings, 

27–28, 480
document views, 26–27
inserting pictures, 

251–252
location, 490–491
master document, 411–412
opening existing, 18–19
opening multiple, 26
password, 34–35
recently used list, 19
removing password, 35
renaming, 27
save settings, 32–34
saving, 17–18

fi lls, shapes, 229–235
Filter and Sort dialog box, 

449–450
fi lters, 450–453
Final:, comment view mode, 

347
Final: Show Markup, 347
Find and Replace dialog 

box, 71–72, 138–144
Find command, 136–137
Find Duplicates dialog box, 

454–455
fl oating format toolbar, 

95–96
fl owchart symbols, 225, 227
folders, 27, 45
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Folders pane, 25–26
Font dialog box, 83–84
font formatting, 141
Font object, 585–586
font size, 80–81
font styles, 80–81
fonts. See also TrueType 

fonts; typefaces
changing styles, 80–81
draft, 486
footnote style, 371–372
list formatting controls, 

205–206
overuse, 102
shared documents, 480
style formatting, 105
substitution, 486

footers, 176, 180–183
Footnote and Endnote 

dialog box, 370–371
Footnote Reference style, 

371–372
Footnote Text style, 

371–372
footnotes, 369–373
Form Field Options dialog 

box, 523–524
form fi elds, 511–512
Format button, 141
Format Data Labels dialog 

box, 270–271
Format Painter, 95
Format Paragraph dialog 

box, 94–95
Format Shape dialog box, 

233–234
Format switch, 500–501
Format Text Effects dialog 

box, 304–305
formats

bibliography, 386
custom label, 422–423
footnote reference 

numbers, 371
footnotes, 371–372
indexes, 379

table of authorities, 395
table of contents, 360
table of fi gures, 366–367

formatting marks, 477
formatting toolbar, 130
forms

check box fi elds, 518–520
data entry, 512–513
data only printing, 60
drop-down fi elds, 520–521
drop-down lists, 512
entry conventions, 522
form fi elds, 511–512
Help text, 523–524
navigation keys, 522
preprinted, 524
printing data only, 488
protections, 515–516
templates, 513–516
text fi elds, 516–518

Formula dialog box, 
299–301

formulas, 299–301
For/Next loops, 555–556
Forward button, 65
fractions, AutoFormat, 150
frame formatting, 141
frames, 598
free-form shapes, 226–228
Frequently Used Programs 

List, 8
Full Screen Reading view, 9, 

13, 475
functions

VBA conventions, 562–563
VBA strings, 546–547

G
GB7714, bibliography 

format, 386
General Options dialog box, 

34–35
General tab, 474–475
Get Training, 66

global templates
activating, 46, 48
duplicate element 

resolution, 49
macro storage, 528
macro support, 46–47
Normal.dotm, 38–39
temporarily disabling, 48

glows, 236–238, 254
Go Back command, 74
Go To command, 71–72, 373
GOST - Name Sort, 386
GOST - Title Sort, 386
gradients, 197, 231–232
grammar checking, 

156–161, 163
Grammar dialog box, 

156–159
graphics, 38, 76, 153–154
graphs. See charts
greeting lines, 435–438
gridlines, 243, 272, 283, 293
groups, 244, 463–466
gutters, 170

H
handles, 

picture sizing/stretching, 
252–253

rotating objects, 240–241
hardware graphics 

acceleration, 487
Header & Footer button, 

183
Header & Footer group, 184
header rows, 296–297
headers, 176, 180–183
heading styles

AutoFormat, 152
multilevel lists, 215–216
table of contents, 358–359

headings
built-in styles, 120
collapsing/expanding 

outline levels, 403–404
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headings (continued)

master document, 408–409
merging table cells, 296
numbering, 215–216
Outline view display, 400
promoting/demoting, 

404, 413
Help command, 64
Help system, 63–66, 480
Help text, 523–524
hidden text

display settings, 477
formatting, 81, 83–84
index entry display, 377
printing, 58, 478

highlighted text, 141
highlighter, 82–83, 476
Home key, 70
Home tab, Ribbon, 12
Homegroup, 30
horizontal ruler, 9, 11
horizontal scroll bar, 

71, 487
hosting software, 325, 326
HTML, pixels as measurement 

unit, 486
hyperlinks. See also links

AutoFormat, 150
blogs, 334–335
following, 482
subdocuments, 410–411
table of contents, 360

hyphenation, 176–178
Hyphenation Options 

command, 177–178
hyphens, 477

I
icons, 8, 26–27. See also 

command buttons
If statement, 552–553
images, 477, 484–485
indents

AutoFormat, 152
index subentries, 378–379, 

381–382

list formatting, 205–206
paragraphs, 86–87

Index dialog box, 378–379
indexes

alignments, 379
AutoMark fi le, 382–383
bookmarks, 380–381
columns, 378
cross-references, 382
deleting, 379
document placement, 378
fi eld codes, 379
formats, 379
generating, 378–379
hiding/displaying entries, 

377
languages, 379
manual marking, 376–377
marking methods, 376–377
page range marking, 

380–381
right aligned page 

numbers, 379
style selections, 378
subentries, 378, 381–382
tab leaders, 379
three-stage process, 

375–376
updating, 379

Info page, 22
InputBox function, 561
InputBox statements, 589
Insert Address Block dialog 

box, 436
Insert Caption button, 

307–308
Insert Cells dialog box, 291
Insert Citation button, 386
Insert Endnote button, 370
Insert Footnote button, 

369–370
Insert Greeting Line dialog 

box, 437
Insert group, 269
Insert Hyperlink dialog 

box, 335

Insert Index button, 378, 
383

Insert key, 15, 144, 482–483
Insert Merge Field dialog 

box, 437–438, 448
Insert Picture dialog box, 

231, 251–252
Insert Screenshot button, 

320–321
Insert tab, Ribbon, 12
Insert Table command, 

283–284
Insert Table of Authorities 

button, 394–395
insertion point. See also 

cursors
arrow key positioning, 15
character deletions, 132
document navigation, 

69–70
footnote reference 

number, 369–370
Go Back command, 74
index placement, 378
pasting items, 133
smart cursoring, 482
text box text, 303–304

instructions, 496
Internet

clip art resource, 249–250
e-mailing, 427–428
faxing services, 426–428
Microsoft online help, 66

Internet addresses, 150
Internet Explorer, 341–342
ISO 690 - First Element and 

Date, 386
ISO 690 - Numerical 

Reference, 386
italics, 81, 101, 150

J
JPEG format, 246–247
justifi cation, paragraph, 85
Justify alignment, 85
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K
Keep Original Formatting, 

395
Key Assignments, 56
keyboard buttons, 529–530
keyboard shortcuts. See 

also accelerators
character formatting, 

78–79
creating custom, 467–469
document navigation, 

69–70
fi elds, 499–500, 504
footnotes, 370
global templates, 46–48
index marking, 376
line spacing, 86
Outline view, 401–402
printing, 468–469
resetting to default, 468
versus Ribbon, 101
style application, 121
style assignments, 122–123
symbols, 317
table navigation, 289–290
table of contents, 358
text selections, 130–131

keyboards, 69–70, 130–131, 
522

L
Label Details dialog box, 

422–423
Label Options dialog box, 

447
labels

creating custom, 422–423
mail merge, 446–448
printing, 419–421
UserForms, 597

Labels button, 420–421
Labels group, 269–271
landscape orientation, 

57, 171
Language tab, 480

languages
indexes, 379
proofi ng language, 163
searches, 141
spell checking, 158
style formatting, 105
translations, 163

layered objects, 241–242
Layout command, 29
layouts

chart editing, 267–268
chart element, 260
organization charts, 280
page orientation, 57
Page Setup dialog box, 

173–176
template element, 38

leaders, tabs, 99–100
left margins, 170
Legacy Forms menu, 514
legends, chart, 260, 270
letter, paper size, 57
levels, 360, 403–404
Libraries, Windows 7 folder 

shortcuts, 30
Libraries group, 338
line numbers, 174–175
Line Numbers control, 

174–175
Line Numbers gallery, 

174–175
line of text, 130
line spacing, 86, 102
line thickness, 235
lines, 197–198, 223–224, 261
linked data, updating, 478
linked styles, 105, 112–113
linked text boxes, 194
links. See also hyperlinks

document e-mailing, 
427–428

master documents, 405
online help, 66
text boxes, 305–306
updating, 58, 489
Word Help window, 64

list boxes, 602–603
list items, 152

List of Markup, 56
List Paragraph style, 206
list styles, elements, 105
lists

AutoMark fi le, 382–383
bullet formats, 203–204
Bullets button, 200–202
creating automatically, 

199–200
directory creation, 448
fi le display view, 26–27
formatting controls, 

205–206
multilevel, 211–216
number formats, 203–204
Numbering button, 

202–203
numbering schemes, 

208–210
paragraph formatting, 86
sequence numbers, 217
sorting, 87–88
style formatting, 105
table of contents, 357–364

literals, VBA strings, 545
Live Preview, 81, 475
logos, Transform 

command, 310
loops
For/Next, 555–556
While/Wend, 556–557

M
macros

auto macros, 536
AutoClose, 536
AutoExec, 536
AutoExit, 536
AutoNew, 536
AutoOpen, 536
DOTM fi le extension, 38
editing, 533–534
extraneous command 

removal, 535
global templates, 46–48, 

528
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keyboard button, 529–530
modifying an existing 

template, 46
naming conventions, 529
recording, 528–532
running, 532–533
selection movement, 

579–580
side effects,  532
spelling corrections, 

534–535
storage, 527–528
template element, 38
toolbar button 

assignments, 529–530
Trust Center settings, 493
unwanted dialog box 

setting removal, 
535–536

VBA conventions, 542
VBA structure, 539–540
virus protections, 537

Macros dialog box, 532–534
Mail Merge Recipients 

dialog box, 433–434
Mail Merge Wizard

address block insertion, 
435–438

address list creation, 
433–435

body text entry, 431
directory creation, 448
document merge, 438–440
document type, 431
e-mail merge, 443–444
envelope mail merge, 

444–446
greeting line insertion, 

435–438
label mail merge, 446–448
main document, 430–432
previewing mail merges, 

438–439
starting from a template, 

431

mail merges 
combining fi les, 429–430
data sources, 430
e-mail merge, 443–444
envelopes, 444–446
fi ltering records, 450–451
labels, 446–448
Mailings tab control, 

440–441
main document, 430
sorting records, 449–450
weeding out duplicates, 

454–455
mailing addresss, 490
Mailings tab, 12, 440–441
main document, 430–432
manual marking, 376–377
Map Network Drive 

command, 29
margins

book folds, 170, 173
default settings, 23
page formatting, 168–171
print settings, 57
template element, 38

Mark Citation button, 393
Mark Citation dialog box, 

392–393
Mark Entry button, 377
Mark Index Entry dialog 

box, 376–377, 382
markers, table column 

width adjustments, 293
Master Document group, 

407
Master Document view, 406, 

408–411
master documents

assembly methods, 406
breaking into smaller 

subdocuments, 413
creating, 408–412
locking/unlocking 

subdocuments, 408
Master Document view, 

406

opening subdocuments, 
407

ownership tracking, 408
piecing together smaller 

documents, 405
promoting/demoting 

headings, 413
saving, 409
subdocument hyperlinks, 

410–411
subdocument sections, 

407
subdocuments, 405, 414

Maximize button, 11
measurement units, 486
Merge Cells command, 296
Merge to E-mail dialog box, 

444
Mergeformat switch, 

500–501
message bar, 493
message boxes, 559–561
methods
Application object, 570
Clipboard operations, 

583–584
Document object, 571–573
inserting text, 582–583
Selection object, 

478–580
VBA conventions, 548–550

Microsoft, online help, 66
Microsoft Graph, 260
Microsoft Paint, 245–247
Mini toolbar, 475
Minimize button, 9
mistakes

AutoCorrect, 145–146
redoing/undoing, 29
repeating/undoing/

redoing actions, 135
spell checking, 156–158

MLA, bibliography format, 
386

Modify Location dialog 
box, 28
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Modify Style dialog box, 
112–113, 294–295

modules, VBA, 542
More menu, Windows 

Vista, 30
More Symbols command, 

317
mouse

click and drag text, 
129–130

document navigation, 71
drag and drop, 134
table data selections, 290
text box creation, 303–304

movement keys, 15
MsgBox command, VBA, 

559–561
Multilevel List button, 212
Multilevel List gallery, 212
multilevel lists, 211–216
My Templates icon, 25, 45

N
navigation keys, 522
Navigation pane

documents, 75–76
Find command, 136–137
Windows 7, 29–30

nested If statement, 553
nested paragraphs, 86–87
Network, Windows 7 

shared network 
location access, 30

network paths, 150
networks

e-mailing documents, 
427–428

fi le save settings, 33
subdocument ownership 

tracking, 408
workgroup template fi le/

folder paths, 45
New Address List dialog 

box, 434

New command (Ctrl+N), 
23–25

New Comment button, 345
New From Existing icon, 25
New Label button, 422–423
New page, 24–25, 39–40
Next Page, breaks, 186
Normal style, 111, 121, 483
Normal.dotm template

default document, 38–39
default fi le path, 39
document, 23
macro storage, 527–528
prompt before saving, 488
reverting to default 

settings, 39
number formats, 203–204, 

301, 372–373, 501–503
number lists

AutoFormat, 151
breaking/continuing, 

210–211
continue numbering, 

210–211
creating automatically, 

199–200
formatting controls, 

205–206
Normal style, 483
number formats, 203–204
Numbering button, 

202–203
numbering schemes, 

208–210
paragraph formatting, 86
restart at 1, 210–211
Seq fi eld, 505
sequence numbers, 217
sorting, 87–88
style formatting, 105

Numbering button, 202–203
Numbering gallery, 208–210
Numbering Library, 204
numbering schemes, lists, 

208–210
Numeric Picture switch, 

500–503

O
object anchors, 477
object model

accessing text, 581–582
Application object, 

569–570
copying operations, 

583–584
cutting operations, 

583–584
deleting text, 583
Document object, 570–573
Font object, 585–586
inserting text, 582–583
moving selections, 

578–579
object listing, 566–569
ParagraphFormat 

object, 586–587
pasting operations, 

583–584
Range objects, 576–584
Selection object, 

574–584
selection macros, 579–580
text formatting, 584
VBA conventions, 549

objects
Application, 569–570
Document, 570–573
fl ipping, 239–241
Font, 585–586
layers, 241–242
object model listing, 

566–569
ParagraphFormat, 

586–587
Range, 576–584
rotating, 239–241
Selection, 574–584
VBA conventions, 547–549
WordArt, 308–310

Odd Page, 56, 186
Offi ce button, 10
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Offi ce Clipboard. See 
Clipboard task pane

Offi ce.com Templates icon, 
25, 39–40

OK button, 596–597
online documents, 196–197
online templates, 39–40
Only Print Even Pages, 56
Only Print Odd, 56
Open button, Quick Access 

toolbar, 25
Open dialog box

default fi le location 
settings, 27–28

deleting fi les/folders, 27
Favorites bar, 29–30
fi le display views, 26–27
modifying an existing 

template, 46
Navigation pane, 29–30
opening existing document, 

18–19, 25–30
Organize button 

commands, 29
renaming fi les/folders, 27
Tools button commands, 

29
option buttons, UserForms, 

598–600
Option Explicit, VBA, 

544–545
optional hyphens, 477
Options dialog box. See 

also Word Options 
dialog box

activating global 
templates, 46

default fi le location, 28
fi le save settings, 32–34
print settings, 57–60

order of precedence, 49
ordinals, AutoFormat, 150
organization charts, 

279–280
Organize menu, Windows 

Vista/Windows 7, 29

Organizer dialog box, 49–51
orientation, 57, 171
Original:, comment view 

mode, 347
Original: Show Markup, 347
Outline button, 400
Outline view 

body text display, 400
character formatting, 401
draft fonts, 486
heading display, 400
keyboard shortcuts, 

401–402
Outlining tab display, 400
showing/hiding, 402–403
style area pane, 486
switching from Print 

Layout view, 400
text editing, 401
text entry, 401
user interface, 9, 13

outlines 
collapsing/expanding 

levels, 403–404
multilevel lists, 211–216
printing, 404–405
promoting/demoting 

paragraphs, 404
showing/hiding formatting, 

402–403
text formatting, 83–84

Outlining tab, Ribbon, 400
ovals, drawing, 224
Overtype mode

enabling/disabling, 144
Insert key, 15, 482–483

P
page borders, 197–198
Page Color gallery, 196–197
page formatting

backgrounds, 195–198
borders, 176
columns, 189–194
cover pages, 194

footers, 176, 180–183
headers, 176, 180–183
landscape orientation, 171
line numbers, 164–175
margins, 168–171
page borders, 197–198
page numbers, 178–180
paper size, 171–173
paper source, 172–173
portrait orientation, 171
section breaks, 186–187
sections, 176, 183–188
text hyphenations, 

176–178
vertical alignments, 176
watermarks, 195–196

Page Layout tab, 12, 184
page layouts, 38, 57
Page Number Format dialog 

box, 179–180
page number formats, 

187–188
Page Number gallery, 

178–180
page numbers

indexes, 379
inserting, 178–180
subdocuments, 414
table of contents, 360
table of fi gures, 366

page ranges, 380–381
Page Setup dialog box

accessing, 57
layouts, 173–176
margin settings, 169–171
paper size, 171–172
paper source, 172

PageDown key, 70
pages, 76, 487
PageUp key, 70
paper size

content scaling, 488
letter setting, 57
page formatting, 171–173
print settings, 60

paper source, 172–173
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paper trays, 488
Paragraph dialog box, 87, 

94–95
paragraph formatting

alignments, 85
background colors, 88–90
borders, 90–94
bullet lists, 86
fl oating format toolbar, 

95–96
Format Painter, 95
indents, 86–87
line spacing, 86
number lists, 86
paragraph marks, 88
searches, 141
sorting lists, 87–88
Style Inspector, 119

paragraph marks, 85, 88, 477
Paragraph Marks and Tab 

Characters, 474
paragraph styles

default settings, 483
elements, 105
new style, 112–113
Styles pane, 116

ParagraphFormat, 
586–587

paragraphs
adding white space, 121
applying styles from Style 

gallery, 106–107
clearing styles, 106–107
click and drag text 

selections, 129
deletion methods, 132
drop caps, 315–316
Enter key creation, 15
Extend mode selections, 

131
justifi cation, 85
promoting/demoting 

outline levels, 404
selection bar, 130
smart selections, 482

style associations, 107
style formatting, 105
text formatting, 77

Password to Modify 
password, 34–35

Password to Open 
password, 34–35

passwords. See also 
protections

document protections, 
353–354

fi le protections, 34–35
Password to Modify, 

34–35
Password to Open, 34–35
removing, 35

Paste All button, 133
Paste command

copying/moving fi les, 29
document settings, 

483–484
object model operations, 

583–584
patterns

document backgrounds, 
197

shape fi lls, 233–235
PDF fi les, 427–428
Permissions, document 

information category, 22
Picture Bullet dialog box, 

208
Picture Styles group, 

253–255
pictures

anchors, 257
bevels, 254
bitmaps, 245–247
blog insertion, 334–335
borders, 254
captions, 306–308
clip art, 247–250
color adjustments, 255
cropping, 253
document backgrounds, 

197

glows, 254
inserting, 248–252
inserting Internet clip art, 

249–250
object fi lls, 231
placeholders, 485
preset effects, 254
refl ections, 254
screenshots, 320–321
shadows, 254
sizing, 252–253
SmartArt conversion, 255
soft edges, 254
stretching, 252–253
styles, 253–255
text wrapping, 255–257
3-D rotation, 254
vector drawing, 247

pie, chart type, 261
pilcrow, Styles pane, 116
pixels

bitmap pictures, 246
HTML measurement 

unit, 486
placeholders

fi eld codes, 495–496
pictures, 485

points, click and drag text 
selections, 129

polygons, drawing, 226–228
portrait orientation

page formatting, 171
page layout, 57

Post Title fi eld, blogs, 
329–330

posts
blog entry conventions, 

327–330
publishing, 334

PostScript, printing, 488
precedence order, queries, 

452
Prepare for Sharing, 

document information 
category, 22

Preview button, 27
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previews, fi le display 
view, 27

Print Background Colors 
and Images, 58

Print button, 53–54
Print Current Page, 56
Print Drawings Created in 

Word, 58
Print in Background, 474
Print Layout view

background image/color 
display, 485

selection bar display, 130
switching to Outline 

view, 400
user interface, 9, 13
vertical ruler display, 487

Print Markup, 56
Print One Sided, 57
Print page

document printing, 54–60
Print Preview, 60–61
printing documents from 

Backstage view, 16
Print Preview

index display, 378
previewing documents, 

60–61
Print Range, 56
Print Selection, 56
Print view, tracked changes, 

349
Printed Watermark dialog 

box, 196
printers

default tray settings, 60
switching between, 55

printing
background, 487
background colors, 477
background colors and 

images, 58
background enabling, 59
background images, 477
Backstage view, 54–60
booklets, 173

collate settings, 55–56
document portions, 56–57
document properties, 

58, 477
documents, 16
draft quality, 59, 487
drawing objects, 58
drawings, 477
duplex, 60
duplex printing, 488
envelopes, 417–419
fi eld codes, 59, 488
form data, 488
form data only, 60
hidden text, 58, 478
keyboard shortcuts, 

468–469
labels, 419–421
line numbers, 175
linked data, 478
multiple copies, 55–56
outlines, 404–405
pages in reverse order, 

487
PostScript, 488
Print Preview, 60–61
reverse order, 59
updating fi elds before 

printing, 478, 488
updating tracked change 

fi elds, 60
XML tags, 59, 488

privacy, Trust Center 
settings, 493

procedures, VBA, 542, 562
Project Explorer, creating 

UserForms, 592–594
projects, VBA conventions, 

542
Promote button, 404
Prompt Before Saving 

Normal Template, 33
proofi ng languages, spelling 

and grammar checking, 
163

Proofi ng tab, 478

properties
accessing text, 581
Application object, 

569–570
fi le display view, 27
Font object, 585–586
list box, 602–603
ParagraphFormat 

object, 587
printing document, 58
text formatting, 584
UserForm controls, 

594–594
VBA conventions, 547

Properties command, 29
Protected view, Trust 

Center settings, 493
protections. See also 

passwords
documents, 353–354
fi le passwords, 34–35
forms, 515–516
macro viruses, 537
removing passwords, 35

Publish Ad Blog Post 
command, 326–327

Publish button, 334
publishers, Trust Center 

settings, 492
publishing, blog posts, 334
punctuation, text searches, 

140
pushpin icon, Word Help 

window, 65

Q
queries, precedence order, 

452
question mark button, Help 

system access, 63
Quick Access toolbar

adding command buttons, 
10, 25

adding/removing buttons, 
462–463
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AutoFormat button, 
146–147

document printing, 53–54
Header & Footer button, 

183
new document, 23
Redo command, 135
relocating, 460–461
Save button, 17
Undo command, 135
user interface, 9–10
Word 2003 Styles drop-

down list, 119–120
Quick Access toolbar 

tab, 492
Quick Parts button, 497
Quick Print button, 54
quotation marks (”)

smart quotes, 149
string literals, 545

R
radar, chart type, 261–262
Range objects, object 

model, 576–584
Recent Places, 30
Recent Templates 

command, 41
Recent Templates icon, 24
Recently Changed, 

Windows Vista 
documents, 30

recently used fi le list, 19
recipients

duplicates, 454–455
fi ltering records, 450–451
Mail Merge Wizard, 

433–435
sorting lists, 449–450

Record Macro dialog box, 
528–531

records
fi ltering, 450–451
relational tests, 452–453
sorting, 449–450

Recover Unsaved 
Documents pane, 18

Rectangle button, 224
rectangles, drawing, 224
Redo command, 29, 135
reference marks, footnotes, 

372–373
reference numbers

Footnote Reference style, 
371–372

footnotes, 369–370, 373
References tab

AutoMark fi le indexing, 
383

citation source, 385–388
endnote insertion, 370
footnote insertion, 

369–370
index placement, 378
manual index marking, 377
Ribbon element, 12
section formatting, 184
table of authorities, 

394–395
updating a table of 

authorities, 396
updating an index, 379

refl ections
picture effects, 254
shape effects, 236, 237

Refresh Data button, 267
relationships, selection 

fi lters, 452–453
remote fi les, copying, 488
removable drives, 33
Remove Properties 

command, 29
Rename command, 29
Rename dialog box, Ribbon 

group, 464–466
repagination, 489–490
Repeat command, 135
Replace command, 142–144
Replace tab, Find and 

Replace dialog box, 
142–144

Research task pane
Bing search, 163
thesaurus display, 162

resolutions, bitmap 
pictures, 246

Restart at 1 command, 210
Restore button, title bar 

control, 9
Restrict Editing button, 

document protections, 
353–354

Restrict Formatting and 
Editing task pane, 
514–515

results, fi eld element, 496
reverse order, document 

printing, 59
Review tab

change tracking, 349–352
comments, 344–348
document protections, 

353–354
reviewing documents, 

343–344
Ribbon element, 12

Reviewing pane, comment 
display, 348

revisions, Go Back command 
navigation, 74

Ribbon
adding/removing groups, 

463–466
character formatting 

tools, 78–79
clearing all text 

formatting, 84
contextual tabs, 12
Developer tab addition, 

43–44
header & footer Design 

tab, 181–182
Help system access, 64
versus keyboard 

shortcuts, 101
Mailings tab, 440–441
Master Document group, 

407
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Ribbon (continued)

Outlining tab, 400
relocating the Quick 

Access toolbar, 460–461
renaming a group, 464–466
section formatting tabs, 

184
switching to Outline view, 

400
tab display, 12–13
user interface, 9–10

right margins, 170
Roman numerals, 372–373
Rotate button, 240
rotation handles

rotating objects, 240–241
text boxes, 305

rows
adding to a table, 290–291
chart editing, 265–266
repeating table headers, 

296–297
table element, 281–283
table selections, 131

Ruler
tab stops, 95–97
table column width 

adjustments, 293
hiding/displaying, 11
user interface, 9, 11
vertical, 487

S
Sample Templates, 

document creation, 41
Sample Templates icons, 

built-in template 
display, 24

saturation, picture 
adjustments, 255

Save As dialog box
converting a document to 

a template, 44–45
fi le saves, 30–32

fi rst time fi le save, 17
form templates, 513–515
saving a document to 

SharePoint, 339–340
Save as Type list

document to a template, 
44–45

fi le format selections, 32
Save AutoRecover Info 

Every n Minutes, 33
Save AutoRecover 

Information, 474
Save button, 17
Save Checked-Out Files To, 

SharePoint fi le location 
settings, 33

Save Files in This Format, 
33

Save tab
fi le save settings, 32–34
Word Options dialog box, 

479–480
Scale to Paper Size, print 

setting, 57
Screen Clipping control, 321
screenshots

blog insertion, 334–335
document insertion, 

320–321
ScreenTip bubble, Help 

system access, 64
ScreenTips

hiding/displaying, 475
language settings, 480
shortcut keys display, 486

scroll bars
displaying, 487
document navigation, 

70–71
scroll box, document 

navigation, 70
scroll wheels, 71
searches

Bing, 163
clip art, 248
directional searches, 138

duplicate recipients, 
454–455

Find and Replace dialog 
box, 138–144

Find command, 136–137
font formatting, 141
footnote references, 373
formatting styles, 141
frame formatting, 141
highlighted text, 141
ignoring punctuation 

characters, 140
ignoring white space, 140
languages, 141
paragraph formatting, 141
sounds like, 140
special characters, 

141–142
tab stops, 141
thesaurus, 162
whole words, 139
wildcards, 139–140
word forms, 140
Word Help window, 65–66

section breaks
creating, 186–187
margin settings, 170

section marks, hiding/
displaying, 185

sections
apply to whole document, 

185
master document 

subdocuments, 407
page formatting, 176, 

183–188
page number formats, 

187–188
section breaks, 186–187
selection application, 185
showing/hiding paragraph 

marks, 185
text formatting element, 

77–78
text selection application, 

185
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this point forward 
application, 185

this section only 
application, 185

Select All command, fi le/
folder selections, 29

Select Browse Object 
button

document navigation, 
72–73

footnote reference 
search, 373

Select Case statement, 
VBA conventions, 
557–558

Select Data button, 
charts, 266

Select Data Source dialog 
box, chart data, 
266–267

selected sections, margin 
settings, 170

selection bar, text, 130
Selection object, object 

model, 574–584
selections

character formatting 
application, 79–80

column of text, 129
entire paragraph, 129
entire sentence, 129
entire word, 482
Extend mode, 131
formatting toolbar, 130
hiding/showing the Mini 

toolbar, 475
keyboard shortcuts, 

130–131
moving, 578–579
printers, 55
printing part of a 

document, 56
replacing selected text, 

482
Select All command, 29
selection bar, 130

single word, 129
table cells, 131
table data, 289–290
text between two points, 

129
Send Backward control, 

layered objects, 242
Send Using E-mail 

command, document 
sharing, 427–428

sentences
click and drag text 

selections, 129
deletion methods, 132
Extend mode selections, 

131
spell checking entire 

documents, 160
seq code, sequence 

numbers, 217
Seq fi eld, number lists, 505
sequence numbers, 

number lists, 217
series, chart element, 260
Set All Levels dialog box, 

multilevel lists, 214
Set Numbering Value 

command, number 
lists, 210–211

shading
paragraph backgrounds, 

88–90
style formatting support, 

105
shadows

picture effects, 254
shape effects, 235, 236
text formatting, 81–82, 

83–84
Shape Effects button

bevels, 236, 238–239
glows, 236, 237–238
preset, 235
refl ections, 236, 237
shadows, 235, 236
soft edges, 236, 237–238
3-D rotation, 236, 238–239

Shape Fill control, 229–235
Shape Fill palette, color 

groups, 229
Shape Outline control, 235
Shape Styles, 229
shapes

blog insertion, 334–335
callouts, 311–312
fi lls, 229–235

Shapes buttons, callouts, 
311–312

Shapes gallery
banners, 225
basic shapes, 225
block arrows, 225
callouts, 225
equation shapes, 225
fl owchart symbols, 225
free-form shapes, 226–228
lines, 224
recently used shapes, 224
rectangles, 225
simple object drawings, 

223
speech bubbles, 225
stars, 225
text boxes, 225

shared documents
embedded fonts, 480
save controls, 489

SharePoint
Communications group, 

337
Custom Pages, 338
document libraries, 

338–339
fi le location settings, 33
Libraries, 338
opening a document, 

341–342
project sharing platform, 

337
saving a document, 

339–340
Tracking, 339
uploading documents, 341
WebParts, 337–338
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sharpness, picture 
adjustments, 255

Shift key
click and drag text, 129
drawing objects, 222
opening multiple fi les, 26
typing replaces selected 

text, 482
Show Level, outline, 

403–404
Show Text Formatting, 

Outline view, 402–403
Show This Number of 

Recent Documents, 474
single-line If 

statement, VBA 
conventions, 555

SIST02, bibliography 
format, 386

smart quotes, AutoFormat, 
149–150

SmartArt
blog insertion, 334–335
diagram insertion, 

275–276
diagram types, 272–273
organization charts, 

277–280
picture conversion, 255
style editing, 276–277

soft edges
picture effects, 254
shape effects, 236–238

solid color, shape fi lls, 
229–230

Sort button, table data, 298
Sort dialog box, table data, 

298–299
sorts

bullet lists, 87–88
number lists, 87–88
table data, 298–299

sounds, feedback, 489
sounds like, word searches, 

140
source data, chart editing, 

267

Source Manager dialog box, 
388–389

source references, 
citations, 385–388

spaces, display settings, 477
Special button, Find and 

Replace dialog box, 
141–142

special characters. See also 
symbols

bullet list, 200
custom bullet creation, 

206–208
display settings, 477
footnote reference marks, 

372–373
number list, 200
searches, 141–142
symbols, 317–318

speech bubbles, drawing, 
225

spell checking
as you type, 156–158
entire documents, 159–161
macros, 534–535
proofi ng languages, 163

Spelling and Grammar 
dialog box, 159–161

Split Table button, 297–298
squares, drawing, 224
Standard Colors, text 

formatting, 83
stars, drawing, 225
Start button, Word 2010 

startup, 8
Start Enforcing Protection 

dialog box, 515–516
Start menu, pinning Word 

2010, 8
Startup folder, global 

templates, 48
Startup group, Word 2010 

startup, 8
statements
ElseIf, 554–555
If, 552–553
InputBox, 589

nested If, 553
Select Case, 557–558
single-line If, 555
VBA conventions, 540–541
With, 550

static variables, VBA 
programming, 544

status bar
Overtype mode 

notifi cation, 144
user interface, 9, 11
word statistic display, 163

stock, chart type, 261
stories, Document object, 

572–573
straight lines, drawing, 223
strikethroughs, text 

formatting, 81, 83–84
strings

concatenation, 545–546
literals, 545
VBA conventions, 545–547
VBA functions, 546–547

Style area, displaying, 
125–126

style area pane, width 
settings, 486

Style for Following 
Paragraph, 125

Style for Following 
Paragraph fi eld, 121

Style Inspector pane, 
118–119

Style Pane Options dialog 
box, 116–117

style sets, switching to 
themes, 108–110

styles
adding space to a 

paragraph, 121
adding/removing from the 

gallery, 113–114
AutoFormat, 152
base styles, 123–124
bibliography formats, 386
blogs, 329
border formatting, 105
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bullet list formatting, 105
character, 105
chart editing, 268–269
chart element, 260
clearing, 106–107
copying from a document 

to a template, 49–51
cover pages, 313
create by example, 121
creating, 112–113
default document 

settings, 23
document protections, 

353–354
drop caps, 315–316
font formatting, 105
Footnote Reference, 

371–372
Footnote Text, 371–372
format information 

storage, 103–104
formatting, 102
headings, 120
index, 378
keyboard shortcuts, 121
language support, 105
linked, 105
list, 105
List Paragraph, 206
modifying an existing 

template, 46
multilevel list headings, 

215–216
next paragraph, 125
Normal style, 121
number list formatting, 

105
Offi ce Online downloads, 

121
page borders, 197–198
paragraph, 105
paragraph associations, 

107
paragraph formatting 

support, 105
partial text application, 

107

pictures, 253–255
printing part of a 

document, 56
redefi ning, 110–111
ScreenTips, 475
searches, 141
setting displayed styles, 

114–115
shading support, 105
shortcut key assignments, 

122–123
SmartArt, 276–277
Styles gallery, 106–107
switching between style 

sets and themes, 
108–110

tab formatting, 105
table, 105
table of authorities, 395
table of contents, 358, 

361–363
template element, 37
template storage, 126–127
tracking formatting, 483
update prompt, 483
updating, 483
updating the Normal 

style, 111
use benefi ts, 104–105, 120
Word 2003 list, 119–120
WordArt gallery, 309

Styles gallery
adding/removing styles, 

113–114
character styles, 107
creating a new style, 

112–113
redefi ning a style, 110–111
setting displayed styles, 

114–115
style naming conventions, 

107
style selections, 106

Styles pane
formatting description 

display, 116

launching, 115
pilcrow, 116
shortcut key assignments, 

122–123
style application, 116
style details display, 116

Styles submenu, 110–111
subdocuments

Author Name fi eld, 408
breaking documents into 

subdocuments, 413
creating a master 

document, 411–412
hyperlinks, 410–411
locking/unlocking, 408
master document links, 405
master document 

sections, 407
opening, 407
page numbers, 414

subentries, index entries, 
378, 381–382

subtitles, cover pages, 315
superscripts, AutoFormat 

ordinals, 150
surface, chart type, 261–262
Switch Row/Column 

control, charts, 
265–266

switches, fi eld formatting, 
500–504

Symbol dialog box
custom bullet creation, 

207
symbol selections, 317

symbols. See also special 
characters

blog insertion, 334–335
fl owchart drawings, 

225, 227
footnote reference marks, 

372–373
inserting, 317–318

synonyms, thesaurus 
suggestions, 161–162
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T
tab characters, 477
Tab key, indenting text, 15
tab leaders

indexes, 379
table of authorities, 395
table of contents, 360
table of fi gures, 366

tab stops
removing all, 98–99
searches, 141
setting, 95–97
tables, 294
Tabs dialog box, 97–98

tab styles, tables, 294–295
Table button, table creation 

method, 283
table of authorities

citation categories, 395
creating, 394–395
custom categories, 

396–397
deleting, 395
document placement, 394
fi eld codes, 395
formats, 395
Keep Original Formatting, 

395
marking citations, 392–394
styles, 395
tab leaders, 395
updating, 396
Use Passim, 395

Table of Authorities dialog 
box, 394–395

table of contents
adding text, 362
change editing, 360
chapter numbers, 361
creating, 357–361
deleting, 361
formats, 360
heading styles, 358–359
hyperlinks, 360
keyboard shortcuts, 358
levels, 360

number alignments, 360
page numbers, 360
shaded frame display, 359
styles, 358, 361–363
tab leaders, 360
updating, 361–362

Table of Contents button, 
65

Table of Contents dialog 
box, 359–360, 362–364

table of fi gures
alignments, 366
caption labels, 366–367
creating, 364–367
deleting, 367
formats, 366–367
tab leaders, 366

Table of Figures dialog box, 
366

Table Properties dialog box, 
293, 297

table styles, elements, 105
Table tools menu, 286–289
tables

AutoFit command, 
293–294

AutoFormat, 151–152
bar tabs, 100
blog insertion, 334–335
captions, 306–308
cell deletion, 291–292
cell insertion, 291
cell selections, 131
column addition, 290–291
column width, 292–293
creating from the Table 

button, 283
data selections, 289–290
data sorting, 298–299
drawing, 284–286
entire column, 131
entire row selections, 131
formulas, 299–301
headings, 296
index word list, 383
Insert Table command, 

283–284

merging cells, 296
moving, 289–290
navigation shortcuts, 

289–290
repeating header rows, 

296–297
row addition, 290–291
splitting, 297–298
structural elements, 

281–283
tab stops, 294
tab styles, 294–295
table of contents, 357–364
table of fi gures, 364–367
Table Tools context menu, 

286–289
text conversion, 301–302

tabs
adding/removing Ribbon 

groups, 463–466
leaders, 99–100
overuse, 101
Ribbon elements, 12–13
style formatting, 105
vertical bars, 100
Word Options dialog box 

display, 472–473
Tabs dialog box, 97–98
task panes, 11
taskbar

document display 
settings, 486

pinning Word 2010, 8
templates

adding the Developer tab 
to the Ribbon, 43–44

blogs, 328
changing an existing 

document, 41–43
copying styles, 49–51
creating from scratch, 45
document conversion, 

44–45
document creation, 24–25
document elements, 37–38
DOTM fi le extension, 38
DOTX fi le extension, 38
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duplicate element 
resolution, 49

element order of 
precedence, 49

fi le/folder paths, 45
forms, 513–516
global, 38–39, 46–48
macro storage, 527
Mail Merge Wizard, 431
modifying existing, 46
Normal.dotm, 23, 38–39
Offi ce Online styles, 121
online, 39–40
Organizer, 49–51
recently used document, 

41
recently used template 

display, 24
sample template 

document creation, 41
save settings, 33
saving document before 

changing, 41
style storage, 126–127
Trusted Locations, 45
Windows Vista template 

access, 30
workgroup, 45

Templates and Add-Ins 
dialog box

activating global 
templates, 46–47

changing existing 42
template attachments, 41

text
adding to a table of 

contents, 362
AutoText entries, 153–154
character formatting, 

78–80
deletion methods, 

131–132, 583
drag and drop, 134
Find and Replace dialog 

box searches, 138–144
Find command, 136–137

hyphenation controls, 
176–178

inserting with object 
methods, 582–583

marking formatting, 483
modifying an existing 

template, 46
replacing, 142–144
style application, 107
table conversion, 301–302
WordArt, 308–310

text access, 581–582
text animations, 485
text boundaries, 485
Text Box button, 303
text boxes

column creation, 194
creating, 303–304
drawing, 225
formatting, 304–305
links, 305–306
onscreen display, 485
reshaping to fi t text, 305
rotating text, 305
UserForms, 597–598
wrapping styles, 304
wrapping text in shape, 

305
text editing, 15
Text Effects button, 82
Text Effects menu, 310
text effects, appearance, 82
text entry, 15
text fi elds, forms, 516–518
Text Form Field Options 

dialog box, 517–518
text formatting

application methods, 
78–80

boldface, 81
characters, 77
clearing all, 84
colors, 83
emboss, 81, 83–84
engrave, 81, 83–84
Font dialog box, 83–84

font size, 80–81
font styles, 80–81
hidden, 81, 83–84
highlighter, 82–83
italics, 81
object model, 584
outline, 83–84
paragraphs, 77
sections, 77–78
selections, 79–80
shadows, 81–82, 83–84
showing/hiding in Outline 

view, 402–403
strikethrough, 81, 83–84
Style Inspector, 119
tab stops, 95–97
text effects, 82

text lines, selection bar, 130
text wrapping

around a picture, 255–257
document window 

display, 485
text boxes, 304

textual content, 38
textures

document backgrounds, 
197

shape fi lls, 233
Theme Colors, 83
themes

switching to style sets, 
108–110

template element, 38
Themes control, 109–110
thesaurus, 161–162
thought bubbles, 311–312
3-D rotation, 236, 238–239, 

254
thumbnails, 27, 76
tiles, fi le view, 26–27
times, autosave settings, 33
title bar, 9
titles, 269, 315
tones, pictures, 255
toolbar buttons, macro 

access, 529–530
toolbars, 466–467
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Tools menu, Windows 
XP, 29

tooltips, 476
top margins, 169
track changes

accepting/rejecting, 
351–352

document reviews, 
349–352

enabling/disabling, 
349–350

viewing, 350–351
Track Changes button, 

349–350
Track Changes dialog box, 

350–351
tracked change fi elds, 60
Tracking group, 338
Tracking menu, 351–352
Transform command, 310
Transform gallery, 310
translations, languages, 163
trays, default printer 

settings, 60, 488
true-color pictures, 246
TrueType fonts, 33. See also 

fonts
Trust Center, Trusted 

Locations, 45
Trust Center tab, 492–494
Trusted Locations, 45
Turabian, bibliography 

format, 386
typefaces. See also fonts

changing displayed font, 
80–81

default settings, 23
typographical errors, 

145–146

U
underlines, versus italics, 

101
underscore (_) character, 

541, 550

Undo command (Ctrl+Z), 
29, 134–135, 222

Update Field command, 379
Update Fields Before 

Printing, 474
Update Index button, 379
Update Table button, 396
Update Table of Contents 

dialog box, 361–362
Update the Remote File 

When Saving, 33
Upload Document dialog 

box, 341
Use Passim, table of 

authorities, 395
Use Smart Cut and Paste, 

Clipboard, 474
user input, 558–561
user interfaces, 475
user output, VBA conventions, 

558–561
user-defi ned procedures, 

VBA conventions, 562
UserForms

Cancel button, 595–596
check boxes, 598–600
combo boxes, 600–602
command buttons, 

595–597
controls, 590–591, 594–595
creating, 591–594
frames, 598
interactive forms, 589–590
label controls, 597
list boxes, 602–603
OK button, 596–597
option buttons, 598–600
text boxes, 597–598

users, document 
protections, 353–354

V
variables, VBA programming, 

542–545
VBA editor, creating a 

UserForm, 591–594

VBA programming
collections, 551
comment conventions, 541
concatenation, 545–546
ElseIf statement, 

554–555
events, 548
For/Next loops, 555–556
functions, 562–563
If statement, 552–553
InputBox function, 561
literal strings, 545
macro structure, 539–540
macros, 542
methods, 548, 549–550
modules, 542
MsgBox command, 

559–561
nested If statement, 

553
object model, 549
object oriented language, 

547
objects, 547–549
Option Explicit, 

544–545
procedures, 542, 562
projects, 542
properties, 547
Select Case statement, 

557–558
single-line If 

statement, 555
statement writing 

conventions, 540–541
string functions, 546–547
strings, 545–547
user input/output, 

558–561
user-defi ned procedures, 

562
variable placement, 

543–544
variables, 542–545
While/Wend loops, 

556–557
With statement, 550
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vector drawings, 247
versions

backward compatibility, 
490–491

document information 
category, 22

previous document, 33
vertical alignments, 176
vertical bars, 100
vertical ruler, 9–11, 487
vertical scroll bar, 487
view buttons, 9, 11
view modes, 347–348, 

350–351
View tab, Ribbon, 12
Views button, 26–27
viruses, macro protections, 

537

W
Watermark gallery, 195–196
watermarks, 195–196
Web Layout view, 9, 13
Web Options dialog box, 

490–491
Web sites

Microsoft, 66
Offi ce Online, 121
Wikipedia, 325
Windows Live, 330

WebParts, SharePoint 
groups, 337–338

weight, Shape Outline 
control settings, 235

When Selecting, 
Automatically Select 
Entire Word, 474

While/Wend loops, VBA 
conventions, 556–557

white space, 101, 121, 140, 
476

whole words, Find and 
Replace dialog box, 139

Wikipedia, 325
wildcards, 139–140

Windows 7
fi le/folder views, 26–27
Navigation pane, 29–30
Organize menu, 29
Windows Fax and Scan, 

426
Windows Explorer, Word 

2010 startup, 8
Windows Fax and Scan, 426
Windows Fax Services, 426
Windows Live Spaces, blog 

account, 330–333
Windows Vista

Favorites bar, 29–30
fi le/folder views, 26–27
Organize menu, 29
Windows Fax and Scan, 

426
Windows XP

browsing/navigating to 
fi le locations, 26

fi le/folder views, 27
Tools menu, 29
Windows Fax Services, 426

Wingdings font, custom 
bullet, 208

With statement, VBA 
conventions, 550

Word 2003, style list, 
119–120

Word 2010
basic document, 15
closing a document 

without exiting, 20
context-sensitive help, 63
exiting properly, 20
Help system, 63–66
opening existing 

documents, 18–19
pinning to the Start 

menu, 8
printing documents from 

Backstage view, 16
Recover Unsaved 

Documents pane, 18
saving fi les, 17–18

startup methods, 7–8
text editing, 15
text entry, 15
user interface, 9–13

Word Count dialog 
box,  163

word forms, searches, 140
Word Help window, 64–66
Word Options dialog box. 

See also Options 
dialog box

activating global 
templates, 46

Add-Ins tab, 492
Advanced tab, 480–492
changing an existing 

document template, 42
Customize Ribbon tab, 

492
default fi le location 

settings, 28
Display tab, 475–478
enabling/disabling 

Overtype mode, 144
fi le save settings, 32–34
General tab, 474–475
Language tab, 480
Proofi ng tab, 478
Quick Access Toolbar 

tab, 492
Save tab, 479–480
Trust Center tab, 492–494

WordArt
blog insertion, 334–335
logos, 310
text, 308–310

WordArt gallery, 309
words

adding to a spelling 
dictionary, 157

click and drag text 
selections, 129

Extend mode, 131
Find and Replace dialog 

box, 139
hyphenation controls, 

176–178
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language translations, 163
spell checking, 160
thesaurus suggestions, 

161–162
workgroup templates, 45
Wrap Text button, 255–257
wrapping

document window 
display, 485

text around a picture, 
255–257

text boxes, 304

X
x-axis, chart element, 260
XML tags, printing, 59, 488
XPS fi les, document 

e-mailing, 427–428
xy scatter, chart type, 261

Y
y-axis, chart element, 260

Z
zones, hyphenation 

controls, 177
Zoom control, 9, 11
Zoom Slider, 221–222
zooms, mouse wheels, 71

54_487662-bindex.indd   62854_487662-bindex.indd   628 4/15/10   9:19 PM4/15/10   9:19 PM



spine=1.3”

Start with FREE Cheat Sheets
Cheat Sheets include
 • Checklists
 • Charts
 • Common Instructions
 • And Other Good Stuff!

Get Smart at Dummies.com 
Dummies.com makes your life easier with 1,000s 
of answers on everything from removing wallpaper 
to using the latest version of Windows. 

Check out our
 • Videos
 • Illustrated Articles
 • Step-by-Step instructions

Plus, each month you can win valuable prizes by entering 
our Dummies.com sweepstakes. *

Want a weekly dose of Dummies? Sign up for Newsletters on
 • Digital Photography
 • Microsoft Windows & Office
 • Personal Finance & Investing
 • Health & Wellness
 • Computing, iPods & Cell Phones
 • eBay
 • Internet
 • Food, Home & Garden

Find out “HOW” at Dummies.com

*Sweepstakes not currently available in all countries, visit Dummies.com for official rules.

Get More and Do More at Dummies.com®

To access the Cheat Sheet created specifically for this book, go to 
www.dummies.com/cheatsheet/word2010aio

Mobile Apps

There’s a Dummies App for This and That
With more than 200 million books in print and over 1,600 unique 
titles, Dummies is a global leader in how-to information. Now 
you can get the same great Dummies information in an App. With 
topics such as Wine, Spanish, Digital Photography, Certification, 
and more, you’ll have instant access to the topics you need to 
know in a format you can trust.

To get information on all our Dummies apps, visit the following:

www.Dummies.com/go/mobile from your computer.

www.Dummies.com/go/iphone/apps from your phone.



Doug Lowe
with Ryan Williams

9 IN 1
BOOKSBOOKS

• What’s in a Word
• All About Editing
• All About Formatting
• Inserting Bits and Pieces
• Publish or Perish
• Using Reference Features
• Mailings
• Customizing Word
• Features for Developers

Word 2010Microsoft®

A L L - I N - O N E

Making Everything Easier!™

         Open the book and find:

•  Steps for working with templates

•  How to use all the editing features 

•  Strategies for formatting text

•  Techniques for inserting tables, 
pictures, and diagrams

•  How to collaborate with others 
online 

•  Tips for building a table of 
contents

•  Ways to create letters and 
envelopes

•  How to customize the user 
interface

Doug Lowe is a veteran author with more than 40 For Dummies

books to his credit. He has covered everything from Microsoft Office 

productivity with PowerPoint to networking to programming in 

ASP.NET. Ryan Williams has written several For Dummies titles. He 

is a frequent presenter at conferences and workshops.

$34.99 US / $41.99 CN / £24.99 UK

ISBN 978-0-470-48766-2

Desktop Applications/Word Processing

Go to Dummies.com®

for videos, step-by-step examples, 
how-to articles, or to shop!

Dive into the new features
of Word 2010 to create
sharper documents
Where do you want to go with Word today? Got mail to send 
to a group? Whether you want to compose simple letters or 
write 200-page novellas, this guide will help you get the most 
from Word 2010. Find out how to take advantage of all of 
the new features, including online editing and collaboration, 
improved templates, and more.

•  The ins and out of editing — discover basic Word tools as well as a 
variety of useful editing techniques

•  Get the lowdown on formatting — use themes and advanced 
features such as columns and lists to design great-looking pages

•  Say it with visuals — spice up your document by inserting 
pictures, clip art, drawing objects, charts, tables, and more 

•  Share your work — ensure that your work is noticed by following 
steps to use Word’s new blogging, collaboration, and reviewing 
features

•  Customizations made easy — make changes to the user interface, 
set options, insert fields, and create custom forms so that Word 
works the way you want

•  Dig deep into Word — learn how to write macros using Visual 
Basic for Applications (VBA), Word’s powerful programming 
language

W
ord 2010

A
L

L
-IN

-O
N

E

 M
icrosoft

® 

W
h

at’s in
 a W

o
rd

A
ll A

b
o

u
t Ed

itin
g

A
ll A

b
o

u
t Fo

rm
attin

g

In
sertin

g
 B

its an
d

 Pieces

Pu
b

lish
 o

r Perish

U
sin

g
 R

eferen
ce Featu

res

M
ailin

g
s

C
u

sto
m

izin
g

 W
o

rd

Featu
res fo

r D
evelo

p
ers

Lowe
Williams

spine=1.3


	Microsoft® Word 2010 All-In-One For Dummies®
	About the Authors
	Dedication
	Authors’ Acknowledgments
	Contents at a Glance
	Table of Contents
	Introduction
	About This Book
	How to Use This Book
	How This Book Is Organized
	Icons Used in This Book
	Where to Go from Here

	Book I: What’s in a Word?
	Contents at a Glance
	Chapter 1: Getting to Know Word 2010
	Starting Word
	What Is All This Stuff?
	Unraveling the Ribbon
	The View from Here Is Great
	Taking the Backstage Tour
	Creating a Basic Document
	Typing and Editing Text
	Printing Your Masterpiece
	Saving Your Work
	Opening a Document
	Closing a Document
	Exiting Word

	Chapter 2: Your Backstage Pass for Managing Documents
	Getting Information about Your Document
	Creating a New Document
	Opening Documents
	Using the Save As Command
	Save Options
	Password-Protecting Your Files

	Chapter 3: Working with Templates
	Understanding How Templates Work
	Getting to Know the Normal. dotm Template
	Creating a Document from an Online Template
	Creating a New Document Based on a Recently Used Template
	Using a Sample Template
	Changing the Template Attached to a Document
	Activating the Developer Tab on the Ribbon
	Creating Your Own Templates
	Using Global Templates
	How Word Resolves Duplicate Template Elements
	Using the Organizer

	Chapter 4: Printing Your Documents
	Printing the Quick Way
	Printing from Backstage View
	Using the Print Preview Feature

	Chapter 5: Help!
	Several Ways to Get Help
	Finding Your Way around the Help System
	Getting Help on the Internet


	Book II: All about Editing
	Contents at a Glance
	Chapter 1: Getting Around in Your Documents
	The Most Basic Way to Move Around in a Document
	Using the Scroll Bar
	Rolling Around with the Mouse Wheel
	Using the Go To Command
	Just Browsing
	Going Back. . . .
	Using Bookmarks
	Using the Navigation Pane
	Using Thumbnails

	Chapter 2: Basic Text Formatting
	Understanding Formatting
	Formatting Text
	Formatting Paragraphs
	All about Tabs
	The Ten Commandments of Formatting

	Chapter 3: Working with Styles
	Understanding Styles
	Applying Styles with the Styles Gallery
	Finding Your Own Style
	Stepping Beyond the Styles Gallery
	Better Living through Styles
	Neat Things to Do with Styles

	Chapter 4: Editing Techniques
	Selecting Text
	Deleting Text
	Using the Clipboard
	Dragging and Dropping
	Undoing and Repeating
	Finding and Replacing
	Searching the Old-Fashioned Way

	Chapter 5: All about AutoCorrect and Its Siblings
	Using AutoCorrect
	Using AutoFormat
	Setting AutoFormat Options
	Using AutoFormat As You Type
	Using AutoText

	Chapter 6: Spell-Checking and the Thesaurus
	Using the Spelling and Grammar Checker
	Using the Thesaurus
	Using Other Proofing Tools


	Book III: All about Formatting
	Contents at a Glance
	Chapter 1: Basic Page Formatting and Sections
	Formatting the Page
	Hyphenating Your Text
	Inserting Page Numbers
	Working with Headers and Footers
	Understanding Sections

	Chapter 2: Formatting Fancy Pages
	Creating Columns
	Adjusting the Column Width
	Forcing a Column Break
	Adding a Cover Page
	Creating a Background

	Chapter 3: Creating Lists
	Creating a List Automatically
	Creating a List the Button Way
	Formatting a List
	Creating Deviant Bullets
	Creating Crazy Numbering Schemes
	Breaking and Continuing a Numbered List
	Working with Lists with Two or More Levels
	Changing the Look of a List with Many Levels
	Using Fields to Create Sequence Numbers


	Book IV: Inserting Bits and Pieces
	Contents at a Glance
	Chapter 1: Drawing Shapes on Your Document
	Some General Drawing Tips
	Drawing Simple Objects
	Creating Other Shapes
	Drawing a Polygon or Free-Form Shape
	Drawing a Curved Line or Shape
	Styling Your Shapes
	Setting the Shape Fill
	Setting the Shape Outline
	Applying Shape Effects
	Flipping and Rotating Objects
	Drawing a Complicated Picture

	Chapter 2: Inserting Pictures and Clip Art
	Exploring the Many Types of Pictures
	Using Clip Art
	Inserting Pictures
	Inserting a Picture from a File
	Playing with Your Pictures
	Adding Style to Your Pictures
	Adjusting the Color and Such
	Wrapping Text around a Picture

	Chapter 3: Creating Charts and Diagrams
	Understanding Charts
	Adding a Chart to a Document
	Pasting a Chart from Excel
	Changing the Chart Type
	Working with Chart Data
	Changing the Chart Layout
	Changing the Chart Style
	Using the Layout Tab to Embellish Your Chart
	Understanding SmartArt
	Creating a SmartArt Diagram
	Tweaking a SmartArt Diagram
	Working with Organization Charts

	Chapter 4: Working with Tables
	Understanding and Creating Tables
	Using the Table Tools Tabs
	Editing Tables
	Using Tabs in a Table
	Using Table Styles
	Merging Cells to Create Headings
	Designating Header Rows That Repeat from Page to Page
	Splitting a Table
	Sorting a Table
	Using Table Formulas
	Converting Text to a Table (and Vice Versa)

	Chapter 5: Inserting Fancy Text
	Using Text Boxes
	Adding Captions to Your Pictures
	Creating Fancy Text with WordArt
	Drawing a Callout

	Chapter 6: Other Things You Can Insert in Your Documents
	Inserting a Cover Page
	Inserting a Drop Cap
	Inserting a Symbol
	Inserting an Equation
	Inserting a Screenshot


	Book V: Publish or Perish
	Contents at a Glance
	Chapter 1: Blogging with Word
	Introducing Word’s Blogging Features
	Creating and Editing Blog Posts
	Registering a Blog Account
	Publishing Blog Posts
	Inserting Hyperlinks and Stuff

	Chapter 2: Working with SharePoint
	Understanding How SharePoint Documents Are Organized
	Working with SharePoint Document Libraries
	Saving a Document to SharePoint
	Uploading a Document to SharePoint
	Opening a Document from SharePoint

	Chapter 3: Collaborating with the Review Tab
	Reviewing Documents
	Working with Comments
	Tracking Changes
	Comparing Documents
	Protecting a Document


	Book VI: Using Reference Features
	Contents at a Glance
	Chapter 1: Creating a Table of Contents or Table of Figures
	Understanding Tables of Contents
	Creating a Table of Contents
	Updating a Table of Contents
	Adding Text
	Beyond Heading Styles
	Creating a Table of Figures or Other Similar Tables

	Chapter 2: Working with Footnotes and Endnotes
	Adding a Footnote
	Changing the Footnote Format
	Changing the Reference Marks
	Finding a Footnote Reference

	Chapter 3: Indexing Your Masterpiece
	Mark Those Index Entries
	Creating an Index
	Updating an Index
	Marking a Range of Pages
	Creating Subentries
	See Also
	Isn’t There an Easier Way?

	Chapter 4: Citations and Bibliographies
	Creating References and Sources
	Creating a Bibliography
	Managing Your Sources

	Chapter 5: I Object! (To Tables of Authorities, That Is)
	Marking Citations
	Creating a Table of Authorities
	Updating a Table of Authorities
	Adding Your Own Categories
	Disclaimer of Warranties and Limit of Liability

	Chapter 6: Working with Outlines and Master Documents
	Working with Outlines
	Working with Master Documents


	Book VII: Mailings
	Contents at a Glance
	Chapter 1: Creating Envelopes and Labels
	Printing an Envelope
	Printing Labels
	Creating Custom Labels

	Chapter 2: Faxing and E-Mailing Documents
	Sending a Fax
	Sending a Document via E-Mail

	Chapter 3: Using the Mail Merge Wizard
	Understanding Mail Merge
	Using the Mail Merge Wizard
	Using the Mailings Tab on the Ribbon

	Chapter 4: Advanced Mail-Merge Tricks
	Other Types of Merges
	Fun Things to Do with the Data Source


	Book VIII: Customizing Word
	Contents at a Glance
	Chapter 1: Customizing the User Interface
	Customizing the Quick Access Toolbar
	Customizing the Ribbon
	Dealing with Old-Style, Custom Toolbars
	Creating Custom Keyboard Shortcuts

	Chapter 2: Opting for Options
	What’s with All the Options?
	The General Tab
	The Display Tab
	The Proofing Tab
	The Save Tab
	The Language Tab
	The Advanced Tab
	The Customize Ribbon and the Quick Access Toolbar Tabs
	The Add-Ins Tab
	The Trust Center Tab

	Chapter 3: Working with Fields
	Understanding Fields
	Inserting a Field
	Keyboard Shortcuts for Working with Fields
	Another Way to Insert Fields
	Formatting Field Results with Switches
	Updating a Field
	Preventing a Field from Being Updated
	Field Code Reference

	Chapter 4: Creating Custom Forms
	Understanding Forms
	Creating a Form Template
	Creating a Text Field
	Creating a Check Box Field
	Creating a Drop-Down Field
	Filling Out a Form
	Adding Help to a Form Field
	Using Preprinted Forms


	Book IX: Features for Developers
	Contents at a Glance
	Chapter 1: Recording and Using Macros
	Where Do All the Macros Go?
	Doing the Macro Recorder Dance
	Macro Recording Tips
	Running a Macro
	Editing a Macro
	Simple Macro Edits That Don’t Require a PhD in VBA
	Using Auto Macros
	Protecting Your Computer from Macro Viruses

	Chapter 2: Programming with VBA
	Examining the Basic Structure of VBA Macros
	Understanding the Basic Elements of VBA
	Working with Variables and Data
	Using Strings
	Of Objects, Properties, and Methods
	Controlling Your Programs
	For/Next Loops
	User Input and Output
	User-Defined Procedures and Functions

	Chapter 3: More Programming: Using Word’s Object Model
	An Overview of Important Word Objects
	Using the Application Object
	Working with Documents
	Understanding Selection and Range Objects
	Moving Selections and Ranges
	Working with Text
	Formatting Text

	Chapter 4: Creating UserForms
	Understanding UserForms
	Creating a UserForm
	Working with Controls
	Using Command Buttons
	Using Labels
	Using Text Boxes
	Using Frames
	Using Check Boxes and Option Buttons
	Using Combo Boxes
	Using List Boxes


	Index





